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webMethods Integration Cloud
Software AGCloud is the cloud-based, secure and reliable Platform-as-a-Service (PaaS) suite from
Software AG and addresses today’s business needs with unmatched speed, ease-of-use, and full
support for social and mobile collaboration.

webMethods Integration Cloud is the Integration Platform as a Service (iPaaS) offering from
SoftwareAG and is a part of the SoftwareAGCloud family of products. Integration Cloud enables
you to integrate your cloud-based Software as a Service (SaaS) applications, with other cloud-based
applications. It also integrates your SaaS applications with on-premises applications.

Integration Cloud provides service-based integration for faster development and deployment. It
enables cloud-to-any integration and connects cloud-based SaaS applications and on-premises
ESB implementations. Themulti-tenant environment scales elastically based on demand.Delivered
as a service, the solution empowers your subject matter experts and eliminates integration silos.
You can integrate applications hosted in public or private clouds, as well as applications hosted
on-premises, reduce the dependency on IT and integrate your SaaS applications faster.

Integration Cloud enables:

Lightweight integration on public and private clouds

Easy-to-configure cloud-to-cloud integrations

Secure and reliable hybrid integrations

Elastic scalability managed automatically based on usage

Integration Cloud also enables cloud deployment of on-premises integrations. You can build
integration projects in Software AG Designer, a full-featured Eclipse™-based environment, and
deploy new or existing projects directly into the cloud.

With Integration Cloud, you can use the same set of tools to develop, debug and test integrations
for the cloud as you do for on-premises integration. When you want to deploy your existing
integrations to the cloud, Integration Cloud combines powerful developer tooling with a SaaS
platform. You can select from a range of deployment landscapes, from simple to production-ready
configurations that include clustered webMethods Integration Servers, Universal Messaging and
Terracotta In-MemoryDataManagement. Your landscapewill be provisioned automatically—and
your integrations, APIs, and business logic deployed with it.

Develop integrations faster in Integration Cloud with:

Rich data mapping, a large collection of built-in services, and data and cloud applications

Easy conversion of Java® or flow services into APIs

Familiar debugging, version control and test tools, while deploying to a multi-function iPaaS

Integration to on-premises resources through VPN for secure data transmission

Dashboards to monitor solution health and flow service behavior

Integration Cloud 6.6.0 7
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Integration Cloud is intended for you if you have a requirement to integrate and synchronize data
between multiple SaaS applications, as well as integrate your existing on-premises applications
with cloud-based SaaS applications. This solution is delivered as a service, offered on a subscription
basis, and is available in multiple packages and price tiers.

8 Integration Cloud 6.6.0
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Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...

Integration Cloud 6.6.0 9
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Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://
documentation.softwareag.com. The site requires credentials for Software AG's Product Support
site Empower. If you do not have Empower credentials, you must use the TECHcommunity
website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

You can find product information on the Software AG Empower Product Support website at
https://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.asp and give us
a call.

Software AG TECHcommunity

You can finddocumentation and other technical information on the SoftwareAGTECHcommunity
website at http://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

Link to external websites that discuss open standards and web technology.

Integration Cloud 6.6.0 11
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Data Protection
SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Integration Cloud 6.6.0 13
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Integration Cloud and Cloud Deployment

Version 6.6.0 (August 2020)

Integration Cloud

DescriptionItem

You cannow share integrations anddocument types across
projects by clicking the vertical ellipses icon available on

“Support for sharing assets across
projects” on page 98

a project and selecting the Share Assets option. Asset
sharing allows you to use the same assets in other projects.

You can share assets with other projects only in the
Development stage and if you are assigned to the
Administrator Access Profile.

Smart mapping provides you with intelligent mapping
recommendations regarding which fields should be

“Support for Smart mapping
recommendations ” on page 406

mapped in the pipeline. You can enable the smartmapping
functionality by selecting the Settings > Preferences >
Publish Integration Mappings to Recommendations
Engine option.

AMachine Learning (ML) algorithm is applied to provide
the suggestions. This algorithm learns from themappings
you create and automatically provides suggestions tomap
similar fields.

If you do not select this option, you will not see the
Recommend Mappings check box while mapping the

16 Integration Cloud 6.6.0
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DescriptionItem

fields in the pipeline. For all trial tenants, the mapping
data is collected by default.

Note:
For paid tenants, only an Admin user who has access
profile ID 4, has the permission to enable this feature.
For trial tenants and Free Forever Edition, this is always
enabled and cannot be changed.

You can enable this option in the new Settings >
Preferences > Configure Tenant Preferences section.

“Capability to mark integrations as
Completed with Errors, if errors are
caught with try-catch blocks” on
page 58

Select this option to view on-screen messages when an
exception occurswhile executing an operation or a service
within an integration using a Try-Catch block.

When this option is enabled, if an exception occurswithin
a Try block, then the end result of the integration execution
is shown as completed with errors. Even if the error is
handled in the Catch block, the integration is shown as
completed with errors.

When this option is not selected, if an exception occurs
within a Try block, then the end result of the integration
execution is shown as integration completed successfully.

In earlier releases, when you loaded an XML or a JSON
file to create a document type from scratch, by default, all

“Support for creating a document type
with optional fields” on page 637

the fields were marked as mandatory. In this release, after
you click the Load JSON or Load XML options, you can

use the Required option to mark all the
fields as optional or mandatory. By default, all the fields
are marked as mandatory. If a field is mandatory, you
must pass a value for that field when running an
integration.

The following MIME services are now available in
Integration Cloud. You can use MIME services to create

“New Services” on page 524

MIME messages and extract information from MIME
messages.

addBodyPart

Integration Cloud 6.6.0 17
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addMimeHeader

createMimeData

getBodyPartContent

getBodyPartHeader

getContentType

getEnvelopeStream

getMimeHeader

getNumParts

getPrimaryContentType

getSubContentType

mergeHeaderAndBody

In earlier releases, while creating or updating a scope,
exposed integrations and REST resources available only

“OAuth 2.0 scope management” on
page 84

in the Default project were available for selection in the
Services panel.

In this release, the Services panel displays the exposed
integrations and REST resources available in all projects,
that is, in custom projects and in the Default project in the
selected stage.

You can now restart or resume an integration execution
from theMonitor > Dashboard page. You can also restart or

“Monitor page enhancements” on
page 662

resume an integration execution from theMonitor >
Execution Results page and from the Last 5 Execution Results
page.

18 Integration Cloud 6.6.0
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DescriptionItem

Performance, scalability, and availability of on-premises
connectivity for hybrid integration scenarios have now

Dedicated infrastructure support for
hybrid integration scenarios

been enhanced by having dedicated Software AG
UniversalMessaging (UM) nodes for each tenant. A tenant
can be associatedwith dedicatedUMsbased on the license.
Contact Software AG Global Support for assistance in
setting up the dedicated hybrid infrastructure.

If you are using hybrid connectivity andwhen you update
the on-premises settings for the first time after the v6.6.0
upgrade, restart the on-premiseswebMethods Integration
Server to resume hybrid connectivity.

If you have whitelisted the Cloud UM hostname or IP in
the firewall, then you have to also whitelist the new UM
hostname and IP along with the old ones. Click “here” on
page 323 for information on the IP addresses.

In this release, a performance improvement of 70 percent
is observed on integration execution throughput.

Performance improvement

The Active option is now removed from the Parameters
page while creating an operation for a REST Application

Parameters page changes

to improve the usability. All parameters are nowprovided
as part of the input signature.

Integration Cloud now supports encoding of URI context
parameters. For example, space is now encodedwith%20:

Support for encoding of URI context
parameters in custom REST
Applications POST

/pubapi/v1/fs-content/Shared/test2/Egnyte%20Logo.png
and # is encoded with %23: POST
/pubapi/v1/fs-content/Shared/test2/Egnyte%23Logo.png

You can now run and debug integrations generated from
SOAP APIs using WSDL and REST APIs using Swagger.

Support for executing or debugging
integrations generated from APIs

While selecting a field for the conditions, that is, while
using the If, or Loop, or Switch statements, you can now

Support for using the field element
inside an array list

click on the Select Field expression and choose a field in
the Pipeline Data dialog box to add its path to the
condition. If you want to use the field element inside an
array list, select the Add Index option to add the index
and use the indexed field path.

Integration Cloud 6.6.0 19
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While selecting a field for the iterations, that is, while using
the for-each statements, you can click now on the Select
Field expression and choose an array in thePipeline Data
dialog box to add its path to the iteration. If you want to
use the array element inside the array list, select the Add
Index option to add the index and use the indexed field
path.

The Help set now contains a new section, which provides
troubleshooting tips to some of the most common
questions on Account configurations.

“Troubleshooting tips on Account
configurations” on page 364

Version 6.1.0 (April 2020)

Integration Cloud

DescriptionItem

Integration workspace enhancements On the Integrationspage, you can now click the icon

to see the details of an Integration, click the ellipsis
icon to delete or copy an Integration, point to the
icon to view the scheduled status, scheduled type and
when is the next scheduled execution date and time,
and to the icon to view the request URL.

20 Integration Cloud 6.6.0
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DescriptionItem

The look and feel of the blocks have been enhanced
and the size of the blocks reduced to increase thework
space.

You can now copy a block from an integration and
paste that block in another integration across projects.
Currently, blocks cannot be pasted across different
browsers or across domains.

The icon has been removed from the blocks. The
Copy, Delete, Comment, Disable, and Duplicate options
are now available by right-clicking on a block.

TheModify Mapping ( ) option now opens the
pipeline datawindow formapping. Further,mapping
arrows have been removed from the source and target
fields in the mapping window.

Monitor page enhancements On the Dashboard page, you can now filter the
execution details of Integrations based on the
invocation channel, for example, Scheduler, User
Interface,HTTP Interface, RESTAPIs, SOAPAPIs, and
Listeners. The in-progress executions can also be
filtered based on the invocation channels.

You can now terminate multiple in-progress
integration executions from the Dashboard page by
selecting the in-progress integration executions and
clicking Terminate.

On the Execution Results page, you can now select the
Invocation channel for which you want to view the
integration execution results. You can select All
Invocations, All Projects, and All Integrations, if you
want to view the execution details of Integrations
based on all the invocation channels, for all
integrations, and in all projects in the active stage, for
the specified time period.

The performance and responsiveness of the Monitor
screen to high volume of data have been enhanced.

Integration Cloud now supports flat files that do not have
a record identifier. You can select the Yes or No options

Flat File enhancements

on the Flat File Definition page depending onwhether the
flat file contains or does not contain a record identifier.
The following options appears on the Flat File Definition
page if you select Yes:

Integration Cloud 6.6.0 21
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Start at position - Identifies the character position in the
record (counting fromzero)where the record identifier
is located.

Nth field - Identifies the field in the record (counting
from zero) that contains the identifier.

While editing anAccount in any stage, you can now select
a different Authentication Typewithout impacting any

Support for changing the
Authentication Type

integrations. So if an integration is using an Account with
a specified Authentication Type, the integration will now
run with the changed Account configuration.

Further, while editing or creating an Integration, after you
select the Operation, the Account field now lists all the
Accounts that are supported for the execution of the
selected Operation.

While testing the Operation, you can select another
Account createdwith a differentAuthentication Type, if the
Account is supported for the execution of the selected
Operation.

If the environment goes down while an integration is
running, the lock taken on the integration will not be

Support for clearing storage locks

automatically removed immediately, so any scheduled
executions for the same integration will be skipped. You
can now remove the locks from theMonitor > Clear Storage
Locks page.

Integration Cloud now allows you to export and import
SOAP APIs.

SOAP API enhancements

Recipes page enhancements You can now search a recipe by the recipe name.

If themain integration created out of a recipe does not
have Applications but has sub-integrations, and if the
sub-integrations have Applications, then the
Applications are nowpulled from the sub-integrations.
The logos of the Applications in the sub-integrations
will now appear on the Recipes page.

You can now see the details of a recipe when you click
Use. Further, the recipe configuration page now shows
only the Applications and not the Operations for each
Application. Also, now you do not have to configure
each integration and sub-integration individually.

22 Integration Cloud 6.6.0
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If you have already used a recipe, Integration Cloud
nowprompts you if an integrationwith the samename
already exists in your selected project and alsowhether
you want to overwrite the references and changes
made in the existing integration.

You can now set the following fields while configuring an
Account:

New Account Configuration fields

Block Timeout is the number of milliseconds that
IntegrationCloudwill wait to obtain a connectionwith
the SaaS provider before the connection times out and
returns an error.

Expire Timeout is the number of milliseconds that an
inactive connection can remain in the pool before it is
closed and removed from the pool, if connection
pooling is enabled.

Idle Timeout interval inmilliseconds defines the interval
for which a connection will be kept alive if it is not in
use.

Keep Alive Interval in milliseconds defines the interval
for which a connection will be kept alive, if the back
end does not respond with a Keep-Alive header.

You can nowmodify a REST resource even if the resource
has an operationwith a deleted integrationmapped to the
operation.

REST Resource Operation
enhancements

To create projects, you must now have the Administrator
Access Profile as well as the Developer project permission
assigned.

Project permission changes

New Applications webMethods Cloud Container: You can now use this
Application to invoke Java and Flow services for any
Cloud Container solution.

You can now click the Show Keyboard Shortcuts icon
available above the integration workspace area and view
the available shortcut keys.

Support for Keyboard shortcuts for
workspace and debug operations

For some Applications, for example, Salesforce CRM v44,
Integration Cloudwill now get an Access Token using the

JSONWeb Token support

JSONWeb Token (JWT) flow after you save the Account.
You can generate OAuth 2.0 tokens using either the

Integration Cloud 6.6.0 23
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Authorization Code flow or the JSONWeb Token (JWT)
flow approaches.

Version 6.0.0 (October 2019)

Integration Cloud

DescriptionItem

You can now view the pipeline and mapping details for
a previous version of an orchestrated integration by

Preview integrations

clicking the ShowHistory option in theDevelopment stage.
Pipeline preview is available in all stages of the Integration.
To view the pipeline and mapping details for a previous
version of an orchestrated integration in any stage other
than the Development stage, change the stage, select the
integration from the Integrations page, and then click
Preview. You will not be able to make any modifications
to the existing pipeline and mapping data.

You can now view or download the run counts of
integration usages for a specific stage and for the specified

Usage Reports

time frame. The report shows the count for the currently
active stage. The data you see on the Reports page depends
onwhen you view the data andwhen data collection ends,
and it displays data collected till the day before yesterday.

You can now copy Integrations, SOAP APIs, and REST
APIs between projects. Ensure that you create any account

Copy Integrations, REST APIs, and
SOAP APIs across projects

or reference data associated with the respective asset in
the target project.

StorageNew services

deleteStore - Deletes a data store and all its contents.

XML

xmlNodeToDocument - Converts an XML node to a
document.

xmlStringToXMLNode - Converts an XML document
(represented as a String, byte[ ], or InputStream) to an
XML node.

getXMLNodeType - Returns information about an
XML node.

24 Integration Cloud 6.6.0
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queryXMLNode - Queries an XML node.

New Applications Salesforce® CRM REST - Integration Cloud connects
to Salesforce® CRM REST using the REST API and
allows you to manage security for inbound requests,
log payloads, and specify run-time performance
conditions for consumers for outbound requests. It
also supports multiple authentication mechanisms.

Google Cloud Pub/Sub - Integration Cloud connects
to Google Cloud Pub/Sub and allows you to create,
get, delete, set policy, and get policy on topics and
subscription resources.

You can now set the locale information according to the
user's preference from theUsers > Locale tab. The value set

Locale information

by you here is the locale applicable for your user profile,
irrespective of the value set by a tenant administrator in
the Default Locale field in Company Information.

While running or debugging Integrations and testing
Operations, if the input has any duplicate keys, or if the

Support for duplicate keys

service returns an output with duplicate keys, you can
now view those keys.

End to EndMonitoring is a cloud offering by SoftwareAG
to monitor a business transaction from its start to end, as

End to End Monitoring

it passes through the various cloud platforms which
includes webMethods API Gateway, webMethods
Integration Cloud, and webMethods.io B2B. End to End
Monitoring allows you to identify any errors that occur
during a business transaction. It identifies the application
within the cloud platform where the error has occurred
and also provides details of the time at which the error
has occurred.

Cloud Deployment

DescriptionItem

You can nowupgrade runtimes likewebMethods Integration
Server, Universal Messaging, and Terracotta that are part of

Support upgrade to v10.5 fromv10.4
and v10.3

a solution from an earlier solution 10.3 or 10.4 version to the
latest 10.5 version.

Cloud Deployment now allows you to deploy GraphQL
assets which are developed using Software AG Designer

Support GraphQL in Cloud
Deployment

and on-premises webMethods Integration Server. You can
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choose from predefined solution landscapes to deploy your
GraphQL on-premises assets from Software AG Designer.

Hot fixes are now created for specific tenants. The Hot Fix
list box in the Solution page lists all available fixes that
include enhancements to the selected versions.

Support for tenant specific image

Cloud Deployment now supports creating solutions in any
stage, for example, in the development, test, live, and pre-live
stage.

Support for creating solutions in
non-development stage

You can now define that a cluster is stateless or stateful for
a solution in all stages. A stateless cluster of webMethods

Support for defining stateless or
stateful cluster for a solution in all
stages Integration Servers does not use a Terracotta Server Array.

Select Stateful to add the Terracotta section. The Terracotta
icons will be activated.

Version 5.6.0 (August 2019)
Integration Cloud Version 5.6.0

DescriptionItem

A project is an independent entity and corresponds to a
folder for organizing your assets. A project holds all the

Projects

assets created as a part of that project by the logged-in
user, along with the configurations associated with the
assets. Any asset, for example, Integrations, REST APIs,
SOAP APIs, Document Types, and Reference Data, is a
part of a project.

If you are an existing tenant, your assets will be available
in theDefaultproject. You cannot delete this default project.
If you are a new tenant, theDefault project is not available
and you need to create a new project.

Note:
Only Administrators can create new projects.

Project permissions are used to associate permissionswith
projects. The new Project Permissions page available under

Project Permissions

the Settings > Project Permissions tab allows you to associate
permissions. Permissions for the Default project are
assigned on the Administrative Permissions page in Access
Profiles.
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Assets are now categorized under Projects on the Deploy
page. If an asset is pulled and if the associated project is

Assets categorized under Projects

not present in the current stage, the project alongwith the
asset will be available in the current stage.

Administrative permissions under Access Profiles have
been regrouped under Global Permissions, Functional
Controls, and Project Permissions for Default Project.

Administrative permissions regrouped

If you are an existing tenant, your user's Access Profile
controls global permissions as well as permissions for the
Default project. If you are a new tenant, theDefault project
is not available and your user'sAccess Profile controls only
global permissions.

You can now select different authentication types for the
same Application while creating an Account. Currently,

Multi Authentication Support

you can select different authentication types, for example,
Credentials,OAuth V2.0 (Authorization Code Flow), orOAuth
V2.0 (JWT Flow) only for Salesforce CRM v44.

IntegrationCloud now supports Fixed length andVariable
length parsers when you use a sample file to define the
definition and structure of a Flat File Application.

Flat File enhancements

Integration Cloud allows you to manage an Integration
during the development life cycle by auto locking. When

Lock and unlock Integrations

you edit an Integration, it is automatically locked for you.
This restricts multiple users editing that Integration at the
same time. To unlock an Integration, from the Integrations
page, click the Integration link. The Integration Overview
page appears. From the Integration Overview page, click
Unlock.

Note:
Only the user who locked the Integration or an
Administrator can unlock the Integration.

You can now create and delete a document type built from
an XML Schema Definition (XSD).

Create document type from an XML
Schema Definition

While editing an Integration, you can nowview the version
change history of the Integration and also restore an earlier

Integration Versioning

or previous version of the Integration. Click the Show
history option available on the tool bar to view the version
change history of the Integration.
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Click on an earlier version to view that Integration version
and click theRestore option to restore the selected previous
version of the Integration.

If you have reverted to an earlier version and there is a
scheduled execution for the Integration, the reverted
version of the Integration will be run as per the defined
schedule.

The following user interface enhancements and changes
are made in this release:

User Interface enhancements

When you log in to Integration Cloud, you will now
reach the Projects page instead of the home page.

The new Notifications icon on the Integration Cloud
navigation bar allows you to viewupdate notifications,
when was the last login, and the list of enhancements
and changes in the current release.

The Orchestrated Integration workspace has been
enhanced to improve the usability. Icons on the
Orchestrated Integration workspace navigation bar
have been replaced with intuitive icons and the new
Show inline comments option allows you to view
comments entered for the blocks.

SSL account in the Database ApplicationDatabase Application enhancements

You can now create SSL account to the databases. To create
an SSL account, choose the respective certificate from the
Truststore Alias option available in the Account screen.

Pre-loaded driver support

You can nowuse driver groups likeMicrosoft JDBCDriver
for Microsoft SQL Server and PostgreSQL JDBC Driver
for PostgreSQL to create the connection.

Alert emails that come from Integration Cloud have the
FromEmail Address as noreply@webmethodscloud.*bydefault.

Custom From Email Address for alert
emails
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You can now request for a custom From email Address for
your tenant.

You can now request for a custom domain name for your
tenant. For example, if your company name is XYZ, you
can have the domain name as https://subdomain.xyz.com.

Custom Domain Name

You can now send simple key value parameters embedded
in the Request Body for POST or PUT requests. This uses

Support for form encoded parameter

the default web form encoding, which is
application/x-www-form-urlencoded.

While configuring anAccount for anApplication, you can
select the Enable SNI option if a SaaS provider offers

ServerName Indication (SNI) Support

SNI-based TLS connectivity, and if you want to connect
to an SNI enabled SaaS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

To explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the
host name is other than the host name specified in the
Server URL field, specify the host name value in the SNI
Server Name field.

You can now set the alert frequency period from the Alert
Rules page to send email messages.

Modify alert frequency period

The following new Applications are available in this
release:

New Applications

Simple Mail Transfer Protocol (SMTP) Application:
Integration Cloud allows you to connect to an SMTP
server using the SimpleMail Transfer Protocol (SMTP)
Application. The SendEmail predefined operation
sends an email to the specified recipient using SMTP.

Shopify: Integration Cloud connects to Shopify using
the Shopify RESTAPI and allows you to organize your
products, customize your storefront, accept credit card
payments, track, and respond to orders.

CloudStreams Connector for Microsoft Azure Data
Lake Store: Integration Cloud connects to
CloudStreams Connector for Microsoft Azure Data
Lake Store using the REST API and allows you to
manage File System resources through the Hadoop
Distributed File System (HDFS) API. You create
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directories, folders, and files in your Azure Data Lake
Store instance that can store and retrieve data.

ZuoraREST: IntegrationCloud connects toZuoraREST
using the Zuora REST API. Zuora allows you to
manage Zuora objects in the Zuora Business Object
Model, process revenue schedules, and perform other
financial operations.

Salesforce® CRM REST: Integration Cloud connects
to Salesforce® CRM REST using the REST API and
allows you to manage security for inbound requests,
log payloads and specifies run-time performance
conditions for consumers for outbound requests. It
also supports multiple authentication mechanisms.

webMethods.io B2B:

The webMethods.io B2B application allows you to:

Interact, accept requests, and build integrations
for the webMethods.io B2B product instance.

Exchange business documents between trading
partners.

Electronic Data Interchange (EDI):

This application provides predefined operations to
parse, validate, and transform EDI messages received
from thewebMethods.io B2B application anduse these
transformed messages to create orchestrations.

Cloud Deployment Version 5.6.0

DescriptionItem

You can now manage a solution, monitor the status of all
runtimes in a solution, promote assets from one stage to

Cloud Deployment Command Line
Interface (CLI)

another, and so on using the Cloud Deployment CLI. The
CLI supports Interactive and Normalmodes.

You can now add a MySQL database to your cloud
deployment subscription. This enables you to configure,

Database as a Service

store, andmonitor your database directly in the cloud instead
of using external systems. The database endpoint can be
shared by multiple solutions deployed by the tenant.
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You can now update any product in a solution to the
available higher version after you create the solution. The

Self-managed update management

Update Available option appears if a higher version is
available for any of the products in the solution. The latest
version will appear in the Version drop-down list.

You can now copy solutions in any stage. Copying solutions
allows you to have a back up of your solution before you

Copying solutions

make any changes. You can choose to make a copy of a
solution by either using the same configuration and services
in the solution landscape or bymodifying the configuration
and services in the solution landscape.

If you are currently using AppDynamics to trace end to end
business flows, the new tracing list box option available on

End to end monitoring using
AppDynamics

the Solution creation page allows you to trace logs after
creating or updating a solution for awebMethods Integration
Server runtime.

After deploying assets, you can go to theAsset explorer page
and click the API Details option to view the API details of

ViewingAPI signature of executable
services

the service such as the HTTPMethod, URL, Input structure,
and the parameters that are required to invoke the service
from an external system, for example, a REST client.

Note:
The API Details option appears only for executable
services.

You can now view Connectivity KPIs for both JDBC adapter
and CloudStreams connectors in the runtimes of solutions.
For connectors, listeners and connections data are displayed.

Monitoring support for JDBC
adapter and CloudStreams
connectors

webMethods Integration Server service execution for
solutions is now displayed by default for all services. There
is no need to enable audit logging.

webMethods Integration Server
service execution statistics

Version 5.5.0 (April 2019)
This section describes the enhancements and changesmade in Version 5.5.0 for IntegrationCloud:

DescriptionItem

You can now select the Validate input and Validate output
options to specify whether you want Integration Cloud to

Validate Input and Output

validate the input and output to the Integration, against the
service input or output signature.
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Some IntegrationCloudApplications, for example, Salesforce
CRM version 44, now support connectivity with streaming
APIs and processing of streaming API events.

Streaming support and replaying
Salesforce events

You can create a Salesforce CRM listener, select a subscription
channel, and specify the Integration to be invoked on the
incoming events. Additionally, you can configure the headers
and parameters as well as enable and disable the listener.
Once enabled, the listener receives the streamingAPI events
and processes the received events.

The Salesforce CRM listener can subscribe and listen to
Salesforce events. Salesforce stores standard-volume events
for 24 hours, so for versions of Salesforce later than v37.0,
you can retrieve the events if they are within the retention
window. You can replay the lost events by selecting the
following replay options:

New - Receive only new events that are broadcast after
subscription.

All - Receive new events including past events (last 24
hrs) that are within the retention window.

The Salesforce CRM listener can now subscribe and listen
to all event types, for example, Salesforce Push Topic Event,
Salesforce Platform Event, Salesforce Change Data Capture
Event, and Salesforce Generic Event.

You can now create a Flat File Application by defining a flat
file structure either manually or from a sample file. You can

Support for consuming and
producing Flat Files

then convert an inbound flat file to a document by invoking
the predefined convertFlatFileToDocument operation in an
Integration, or convert a document to an outbound flat file
by invoking the predefined convertDocumentToFlatFile
operation.

Integration Cloud allows you to write integration logic to
integrate different types of applications. This logic can now

Support for creating SOAP APIs

be exposed to the external world using SOAPAPIs. You can
create SOAP APIs by using an existing set of Integrations
(from scratch) or by using a WSDL file.

A SOAPAPI exposes one ormore Integrations asoperations,
so each operation in a SOAP API corresponds to an
Integration.

Using a SOAP client, you can invoke the SOAP operation
externally by using either Basic Authentication or 2-way SSL.
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When the SOAP operation is invoked, the associated
Integration gets executed.

You can now connect to a database using the new Database
Application and perform database operations with cloud
databases.

Connect to a database using the
Database Application

This section describes the enhancements and changesmade inVersion 5.5.0 forCloudDeployment:

DescriptionItem

You can now upgrade any product in a solution to the
available higher fix version after you create the solution. The

Upgrade products to a higher fix
version in a solution

Upgrade option appears if a higher fix version is available
for any of the products in the solution. The latest fix version
will appear in the Fix version drop-down list.

While creating a solution, after you select a fix version,
webMethods Integration Server packages such as

Enable packages during solution
creation

WmCloudStreams andWmJDBCAdapterwill appear in the
Packages group box based on the selected fix version. You
can select the packages that you want to enable.

Cloud Deployment capability is now enabled by default for
all tenants. As soon as you register, 3 CPU cores and 6 GB

Enable cloud deployment capability
for all tenants

memory are allocated for all tenants. Provisioning happens
if you access Cloud Deployment for the first time using the
application launcher. Solutions created using a trial account
are deactivated daily. After you log in, you need to reactivate
the solutions. All assets will be available after a short delay.

You can now deploy CloudStreams provider packages,
CloudStreams connector services, CloudStreams connection,

Deploy webMethods CloudStreams
assets

andCloudStreams connector listeners to a solution in Cloud
Deployment and view those assets. This is applicable only
if you have selectedWmCloudStreams as the package option
while creating the solution.

Within a tenant, you can nowpromote assets from a solution
to another solution, from a previous stage to the current

Promote assets from a solution to
another solution

stage, for the same runtime type. You can promote assets if
the source runtime version is lesser than or same as the target
runtime version.

When you run a service in Software AG Designer, you can
save the pipeline data as an XML document to your local

Load pipeline data for testing
services

file system. After you deploy the service in Cloud
Deployment, you can now click the Load Data option in the
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service editor in Cloud Deployment to load or update the
pipeline data and test the service.

You can now download user deployed packages and
configurations from theAssetspage. The assetswill be zipped
and downloaded to your local storage space.

Download user deployed packages
and configurations

From the Asset Repository page, you can either download
individual packages or download the whole repository for
each product. The assets includingACDLfileswill be zipped
and downloaded to your local storage.

Enhanced user interface for
Monitoring

The Alerts page now displays the Resolved On date for
all the resolved alerts.

On the Runtimes page, you can now click on the Adapter
KPI link to display the Adapters details in a pop-up
window.

On the landing page, a help icon is now added in the
Service Executions card.

From the Alerts card on the landing page, you can now
click Configure and go to the Alerts Configuration page.
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Registration

Note:
The registration page is not applicable if you have created your account using the Software AG
Cloud sign-up page.

Note:
If you have created your account using the Software AG Cloud sign-up page, you will receive
an email which contains the link to log in. After you log in, you can go to the SoftwareAGCloud
portal using the Application Launcher.

The Cloud Deployment option is available only if you are an existing tenant and have already
provisioned Cloud Deployment.

Registration is the process of creating a new Integration Cloud user account. You need to register
to create your instance of the platform in the cloud.

Your organization may have multiple members, for example, your organization may be an entire
company, an internal department, or just yourself. Similarly, your Integration Cloud account can
have multiple internal users who interact with the platform. The very first person to open the
IntegrationCloud account becomes the first SystemAdministrator for the tenant. TheAdministrator
can then create new users (internal users).

Creating an Account

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

Creating an account is the first step in the Registration Process.

To create a new User Account

1. On the Registration page, complete the following fields:

Note:
Required fields are marked with an asterisk on the screen.

36 Integration Cloud 6.6.0

2 Create and secure your account



DescriptionField

Type your first name.First Name

You can change the value after the user is created from the Settings 
> Users screen.

Type your last name.Last Name

You can change the value after the user is created from the Settings 
> Users screen.

Type your company name.Company

You can change that later from the Settings  > Company Information
screen.

Select your country from the drop-down list box.Country

You can change that later from the Settings  > Users screen.

Type your State or Province.State or Province

You can change that later from the Settings  > Users screen.

Type your phone number.Phone

You can change that later from the Settings  > Users screen.

Select your role in your current organization from the drop-down list
box.

Your Role

Select the number of employees range in your current organization
from the drop-down list box.

Company Size

Select at what stage is your current project from the drop-down list
box.

Is your interest
based on

Provide a unique sub-domain, typically your company name.Sub-Domain

For example, suppose you are at ABC Company and you decide to use
“abc” as your unique sub-domain. With that setting, you will access
your instance of the platform at https://abc.webmethodscloud.com.

Note:
You must log in with the correct sub-domain. Some functionalities
may not work properly if you log in with a generic sub-domain.

Type your work email address.Work Email
Address

The email field becomes both the user name and the email address for
the initial user. You can change the values after the user is created, from
the Settings  > Users screen.
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Type the twisted alphanumeric characters in the text input area as
shown in the image. You can click the refresh icon to view a new set
of characters.

Type the
characters shown
in the image

Select this option to agree to thewebMethods IntegrationCloud Terms
of Service.

I agree to the
Terms of Service

Select this option to acknowledge and accept the terms and conditions
of processing of personally identifiable information as per the General

I confirm that I
have

Data Protection Regulation (GDPR). GDPR sets guidelines on how toacknowledged
collect and process personally identifiable information. You must also
download and countersign the agreement.

and accepted the
terms of the
Data Processing
Agreement. I
further confirm
that I have
downloaded and
validly
countersigned
the Data
Processing
Agreement.

Enter a valid promotion code if you have one, for availing subscription
benefits.

Promo Code

Select this option if you want to receive information about products,
services, and events from Software AG. Software AGmay also contact

I opt-in to
hearing from
Software AG you by phone andmayprocess your personally identifiable information

for these purposes. You can unsubscribe and withdraw your consent
at any time.

2. Click Register to continue to the next step to activate and secure your account. After you click
Register and as soon as the registration process is complete, two different emails will be sent
to the email address you provided during registration. One email will contain the user ID and
the other email will contain the temporary password. Use the temporary password to log in.
You will be asked to change your password.

Note:
Your organization is a tenant in the platform. When you log in to the platform, you log into
your organization's tenancy.

Note:
If you have created your account using the Software AG Cloud sign-up page, you will
receive an email which contains the link to log in. After you log in, you can go to the Software
AG Cloud portal using the Application Launcher.
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Note:
If you are not able to login successfully after a few login attempts, Integration Cloud displays
twisted alphanumeric characters in the login page. Type the twisted alphanumeric characters
that appear in the text box. You can click the refresh icon to view a new set of characters.

If you have already configured SAML based single sign-on (SSO), the SSO Login option
appears in the login page. If you click the SSO Login option, Integration Cloud redirects you
to the Identity Provider (IdP) login page. After you provide the IdP login credentials, you will
be logged into Integration Cloud.

Securing your Account

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

Securing your account is the second step in the Registration process. When you login for the first
time, you are asked to change your password and also select a security question. The security
question and answer is associated with your user name. If you forget your password, this
information is used to verify the account ownership.

To secure your account

1. Type your new password, and then select a security question from the drop down list.
Optionally, you can select the option Write my own security question to compose a
personalized security question.

2. Provide an answer to the security question.

3. Click Submit.

Note:
If you forget your password, in the login page, click the Forgot Password? link, enter your
user name, type the distorted alphanumeric characters in the text box, and then clickChange
Password. An email is sent that contains a request to answer the Security Question you
chose when your account was created. When the email arrives, click the link to open the
Password Reset page. Provide the answer to your Security Question and enter a new
password. After you provide the correct answer, you can log inwith your changed password.
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Users

You can use the Users screen to create and manage administrators and other users. A User has a
login identity, password, email address, and other descriptive attributes.

From the main Users screen, you can search for users, create a new user, delete an existing user,
update existing user information, and reset a user’s password. If you have theUser Management
permission under Settings  > Access Profiles > Administrative Permissions > User and
Ownership Controls, you can either edit or delete users.

Note:
You cannot delete your own user profile. If a user is deleted, then the user cannot be recovered
and all assets created or modified by the user will appear in the Created By andModified By
columns as Unknown User{first two characters of the first name and last name}.

Click Reset Password to reset the user's password. As soon as the password is reset, two different
emails will be sent to the email address you provided during registration. One email will contain
the user ID and the other emailwill contain the temporary password.Use the temporary password
to log in. You will be asked to change your password.

Users who have the required access privileges under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls can edit user information.

Adding Users
If you have created your account using the Software AG Cloud sign-up page, that is, if you are a
Software AG Cloud tenant, you can perform certain user management tasks like adding users,
updating users, and resetting passwords only from the Software AG Cloud User Administration
page. Further, a new user is created in Integration Cloud when you log in for the first time using
the Software AG Cloud login page. The newly created user is associated with the Regular User
Access Profile if you have selected Integration Cloud-User in the Software AG Cloud User
Administration page, or the Administrator Access profile if you have selected
Cloud-Tenant-Administrator in the Software AG Cloud User Administration page.

You can delete users from the Users page in Integration Cloud. If you have created Users U1, U2,
andU3 in SoftwareAGCloud, the first timeU1 logs in to IntegrationCloud, user U1will be created
in Integration Cloud. Now if U1 is deleted from Software AG Cloud but still exists in Integration
Cloud, U1 will not be able to log in to Integration Cloud. If U1 is deleted from Integration Cloud
but still exists in Software AG Cloud, U1 will be created in Integration Cloud when you again log
in to Integration Cloud.

If you have not created your account using the Software AG Cloud sign-up page, you can add
users in Integration Cloud.

To add a user if you have not created your account using the Software AG Cloud sign-up
page

1. From the Integration Cloud navigation bar, go to Settings  > Users.
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2. From the upper right part of the Users screen, click Add New User.

3. On the Basic tab, complete the following fields. Required fields are marked with an asterisk
on the screen.

DescriptionField

User's first name as it should appear in the platform.First name

User's last name as it should appear in the platform.Last name

User's professional title.Title

The access profile assigned to the User. Each User is assigned
an access profile, which can be shared by other users. An

Access Profile

Access Profile specifies the network locations (IP addresses)
from where it is possible to login and administrative
permissions. Select one of the following Access Profiles:

Administrator - Provides permissions needed by the
System Administrator.

Regular User - Provides permissions that are more
appropriate for normal users.

By default, the system administrator can change the
Administrative Permissions associatedwith eachAccess Profile
(except the above mentioned Administrator Access Profile),
and can add additional Access Profiles, as needed.

Note:
By default, the Administrator and Regular User Access
Profiles are associated with the Development Stage. If you
have created a new Access Profile, ensure that the Access
Profile you have created is associatedwith theDevelopment
Stage. See “Adding orUpdatingAccess Profiles” on page 52
for more information and for information on API
Management Access Profiles and permissions.

Project permissions are used to associate permissions with
projects.

Project Permission

Any new project created is automatically associated with the
Developer project permission profile. If a project permission
profile is associated with a user on the user profile page, the
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DescriptionField

user can perform only the permitted tasks in the mapped
project. If you are an existing tenant, all existing user profiles
will be associatedwith theDeveloperproject permission profile.
If you are a new tenant, the Administrator will be associated
with theDeveloper project permission profile and can assign a
project permission profile to a new user. You can add more
project permission profiles to the user. See “Project
Permissions” on page 59 for more information.

Note:
A user must have the Administrator Access Profile and the
Developer project permission assigned to create projects.

Optional identification number for each employee.Employee Number

Email address of the user. User credentials will be sent to the
specified email address.

Email

As soon as you add a new user, two different emails will be
sent to the email address. One email will contain the user ID
and the other email will contain the temporary password. Use
the temporary password to log in. Youwill be asked to change
your password.

User name is a unique name associated with each user and is
required to log in. It can be an email address or an
alphanumeric text string.

User Name

Note:
If you are a Software AG Cloud user, you will not be able
to update the User Name.

Enter the Federation ID if your Identity Provider passes the
Federation ID for Single Sign-On. See the "Single Sign-On"

Federation ID

Help page for more information. The Federation ID acts as a
user's authentication across multiple IT systems or
organizations. A federated identity means linking a person's
electronic identity and attributes stored acrossmultiple distinct
identity management systems.

Select this option if the user is a Partner user. If Allow User
Interface Access permission available under Access Profile

Partner

> Administrative Permissions > Account Controls is not
enabled, a Partner User can still perform on-premises tasks.

Select this option to indicate that the user account is active.
You can use this option to reactivate a locked or disabled user
account.

Active
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4. On the Locale tab, complete the following fields:

DescriptionField

Choose a Time Zone Code from the drop down list.Time Zone

Choose a Date Format from the drop down list. “mm” is "Month",
“dd” is "Day", and “yyyy” is Year.

Date Format

Dates and Times are used throughout the platform, in
Appointments, as Start/End Dates in Tasks, Expected Close Date,
Estimated Start/EndDate, DateDue, and so on. Default formats are
specified under the Settings  > Company Information >
Advanced Information tab. Administrators and Users can change
the default selection in the Users screen.

This setting determines the language in which you will view the
application.

Locale

The value set by you here is the language applicable for your user
profile, irrespective of the value set by the administrator in the
Default Locale field of Company Information settings.

For example, if you set the value in the Locale field as Chinese and
the value set by the administrator in the Default Locale field of
Company Information settings is English, then you will view all
the application labels in the Chinese language.

Select a 12-hour clock (hh:mm a) with AM/PM, or a 24-hour clock
(HH:mm).

Time Format

5. On the Address and Contact tab, complete the following fields:

DescriptionField

Primary phone number for the user.Phone

Mobile phone number for the user.Mobile Phone

Fax number for the user.Fax

Street address for the user.Street Address

City for the user.City

State or province for the user.State/Province

Postal or ZIP Code for the user.Postal/Zip Code

Country for the user.Country
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6. Click Add if you are adding a User or Apply if you are editing any User information.

You can fill the Address and Contact section later or the Administrator can fill the details by
editing the record after the User has been added. The Address and Contact screen is also
available under  > My Profile > My Information tab.

Note:
A User can log in, and then go to  > My Profile > Edit to change the user details. The
Administrator who created the User can also edit the User details.

Updating Users

To edit or update the user information

Note:
If you have created your account using the Software AG Cloud sign-up page, that is, if you are
a SoftwareAGCloud tenant, you can perform certain usermanagement tasks like adding users,
updating users, and resetting passwords only from the SoftwareAGCloudUserAdministration
page.

1. From the Integration Cloud navigation bar, click Settings  > Users.

2. Select a user from the list, and then click Edit.

3. Make necessarymodifications. See “Adding Users” on page 42 for information on the relevant
fields. You can also enter or update the following information on the Address and Contact
tab. Required fields are marked with an asterisk on the screen.

Note:
If you are a Software AG Cloud user, you will not be able to update the User Name.

DescriptionField

Primary phone number for the user.Phone

Mobile phone number for the user.Mobile Phone

Fax number for the user.Fax

Street address for the user.Street Address

City for the user.City

State or province for the user.State/Province

Postal or ZIP Code for the user.Postal/Zip Code

Country for the user.Country
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4. Click Apply.

The default initial information comes from the  > Company Information page, but you can
modify it here.

Note:
Auser can log in and then go to  > My Profile to change the user details. The administrator
who created the user can also edit the user details.

Note:
If you have the User Management permission under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls, you can either update or
delete users. You cannot delete your own user profile. If a user is deleted, then the user
cannot be recovered and all assets created or modified by the user will appear in the Created
By andModified By columns as Unknown User{first two characters of the first name and last
name}.

Resetting Passwords

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

Note:
If you have created your account using the Software AG Cloud sign-up page, that is, if you are
a SoftwareAGCloud tenant, you can perform certain usermanagement tasks like adding users,
updating users, and resetting passwords only from the SoftwareAGCloudUserAdministration
page.

To reset a user's password if you have not created your account using the Software AGCloud
sign-up page

1. From the Integration Cloud navigation bar, go to Settings  > Users.

2. For the user whose password is to be reset, select the user and click Reset Password.

Integration Cloud sends two different emails to the email address you provided during
registration. One email will contain the user ID and the other email will contain the temporary
password. Use the temporary password to log in. You will be asked to change your password.

Integration Cloud 6.6.0 47

3 Settings



Note:
AUser can log in, and then go to  > My Profile to change the user details. The administrator
who created the User can also edit the User details.

User Profile

If you are on the My Information page  > My Profile > My Information, the page provides
profile information for the logged in user for the Integration Cloud instance.

If you are on any user profile page, (Settings  > Users > Click on the User Name link), the
page provides profile information for the selected user for the Integration Cloud instance.

You can view the Basic, Locale, and the Address and Contact information.

Click Edit to update the information.

Security Question

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

To update the Security Question and Answer

1. From the Integration Cloud navigation bar, go to  > My Profile > Security Question.

2. Select a Security Question and type a Security Answer. You can change the Security Question
associated with your Account Login/Password.

3. Click Submit.

Note:
The User name and Email address can differ, depending on the settings specified in the
> My Profile > My Information page.

Change Password

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

To change your password

1. From the Integration Cloud navigation bar, go to  > My Profile > Change Password.
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2. Type your current password in the Old Password field, your new password in the New
Password field, and again retype your new password in the Retype New Password field.

3. Click Submit. You will receive a confirmation email about your changed password.

My Certificate

Integration Cloud allows you to store client certificates and associate a certificate with a user
account. When a client presents one of these certificates, Integration Cloud logs in the client, as
the user mapped to the certificate. You can view the client certificate for the logged in user on the
My Certificate page.

To view the certificate

1. From the Integration Cloud navigation bar, click  > My Profile > My Certificate.

2. If a certificate is configured for the user, the View Certificate panel displays the configured
certificate. You can click Download to download the user certificate or click Delete to delete
the user certificate. The downloaded file is named as <username>.crt.

3. In the Upload New Certificate field, click Browse to upload a new client certificate signed
by a trusted Certificate Authority (CA).

4. In the Generate Private Key and Certificate field, click Generate if you want Integration
Cloud to generate a private key and a new IntegrationCloud signed client certificate. Integration
Cloud validates it against the issuer of the certificate. The generated certificate is named as
<username>.txt.

Capability

The Capability ( > Licensing) page allows you to view the status of some of the system
capabilities, based on your license offering.
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You can view the details of the following capabilities in Integration Cloud:

DescriptionField

Total number ofApplications that can be utilized by the tenant.Allowed application
count

If Yes, then on-premises applications can be uploaded from
on-premises systems.

On-premises
connection

Maximum number of active users allowed for the tenant.Max allowed users

Maximum number of staging environments allowed for the
tenant.

Allowed number of
stages

Integrations can be restarted and resumed.Integration restart
and resume

Integrations can be imported and exported.Integration import
and export

If Yes, then the account is a trial account.Trial account

The trial period end date. This field appears only if the account
is a trial account.

Trial end date

You can view the details of the following capabilities in Cloud Deployment:

DescriptionField

Maximum number of CPU cores allowed across all active
solutions and all stages for the tenant. You will not be able to
create additional solutions if you exceed this capability.

Max allowed cores

Maximummemory capacity allowed across all active solutions
and all stages for the tenant. You will not be able to create
additional solutions if you exceed this capability.

Max allowed memory

Maximum number of staging environments allowed for the
tenant.

Allowed number of
stages

If Yes, then the account is a trial account.Trial account

The trial period end date. This field appears only if the account
is a trial account.

Trial end date

Access Profiles

An Access Profile specifies a collection of permissions that can be applied to multiple users. Each
user is assigned an Access Profile, which can be shared by other users.

50 Integration Cloud 6.6.0

3 Settings



Users who have the required access privileges under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls can edit the Access Profiles
information.

An Access Profile specifies:

The network locations (IP addresses) from where it is possible to login.

Administrative permissions.

Container user groups

API Management permissions

See this article for information on Access Profiles, Project Permissions, and ACLs.

The default Access Profiles are:

Administrator, which provides permissions needed by the System Administrator.

Regular User, which provides permissions that are more appropriate for normal users.

Note:
The Integration Cloud User role in Software AG Cloud maps to the Regular User access
profile in Integration Cloud. Users assigned to the Integration Cloud User role have limited
permissions that are more appropriate for normal users.

API Gateway Administrators - By default, all API Management permissions are assigned to
the Administrators access profile and these privileges cannot be modified.

APIGateway Providers - By default, the following permissions are assigned to theAPIGateway
Providers access profile and these privileges cannot be modified:

Manage APIs

Manage Applications

Manage policy templates

Manage packages and plans

Publish to API Portal

Export assets

Execute service result cache APIs

Activate/Deactivate APIs/Packages

Manage aliases

Import assets

API Portal Administrators - The API Portal Administrator can perform all the functions in API
Portal.
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API Portal Providers - The API Portal Provider can manage APIs and packages in API Portal.

Note:
You can create and manage API Management Access Profiles provided you have the required
API Gateway Cloud and/or API Portal Cloud licenses.

By default, the system administrator can change the Administrative Permissions associated with
each Access Profile and can add additional Access Profiles, as needed.

To edit an existing Access Profile, select the profile and click Edit. To delete an Access Profile,
select the profile and click Delete. You will not be able to delete an Access Profile if it is used by
a user. To create a new Access Profile, click Add New Access Profile.

Note:
The Access Profile ID is needed while configuring Single Sign-On (SSO). You have to provide
the ID while configuring the Identity Provider (IDP), if you want to create a user if the user is
not present. The newly created user will be associated with the Access Profile represented by
the ID sent by the IDP in the SAML Response. The name of the SAML attribute that designates
the user's access profile must contain the ID of the Access Profile.

Adding or Updating Access Profiles

Use the Access Profiles screen to create or edit profiles assigned to users.

To add or update an Access Profile

1. From the Integration Cloud navigation bar, go to Settings  > Access Profiles.

2. ClickAdd New Access Profile to add a custom access profile or clickEdit tomodify an existing
Access Profile.

3. On theAdd New Access Profile orUpdate Access Profile > Access Profile Information tab,
complete the following fields. Required fields are marked with an asterisk on the screen.

DescriptionField

Provide a name for the Access Profile. You can reference the profile by
name when assigning it to a user.

Name

Provide a general description for the Access Profile.Description

4. On the Login IP Address Restrictions page, complete the following fields:

DescriptionField

For extra security, enter ranges of IP addresses from which users are
allowed to access the platform. If a user attempts to login from a

IP Address
Ranges
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DescriptionField

computer on a network outside of the specified range, access to the
platform is denied.

Note:
A maximum of 25 IP address ranges can be specified. You can add,
modify, and delete the entries. Accepted format is xxx.xxx.xxx.xxx
- yyy.yyy.yyy.yyy, where xxx and yyy are numbers in the range
0-255 and xxx.xxx.xxx.xxx is less than or equal to yyy.yyy.yyy.yyy.
To specify a single IP address, use the same IP address for the start
and endpoint of the range: 192.168.1.1 - 192.168.1.1

When a user attempts to log in, the IP address of the system the
request originated from is checked against the configured settings.
If the address is in the allowed range, the user can continue the login
process. Otherwise, login is denied. Access violations are recorded
in the audit log, identifying both the user and the IP address from
where the login attempt originated. Login restrictions do not apply
to Customer Support logins.

5. On the Administrative Permissions page, select the operations a user can perform in order to
access, view, create, update, upgrade, administer, execute, export, deploy, and delete and to
allow the user to customize selected aspects of the platform.

DescriptionField

Global Permissions

User Management - Select this option if you want to add, update,
delete users, or assign users to Access Profiles.

User and
Ownership
Controls

Access Control - Select this option if youwant to allow a user tomodify
Access Profiles, edit ACLs, specify user application access rights,
manage Access Profiles, specify the password policy, create, edit, and
delete OAuth 2.0 clients and scopes, and delete OAuth 2.0 tokens.

Manage Personal Setup - Select this option if youwant to allow a user
tomodify the personal information, and generate or edit the user's own
certificate.

Manage Company Capabilities - Select this option if youwant to allow
users to modify the company information.

Account Controls

Allow User Interface Access - Select this option if you want to allow
users to log in to Integration Cloud and access the user interface. Clear
this option if you want to deny users to access the user interface.
Further, even if you clear this option, all users can still interact with
Integration Cloud using REST interface calls.
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DescriptionField

Note:
If the Allow User Interface Access permission is not enabled for a
user but if the user is a Partner user, that user will still be able to
perform on-premises tasks.

Manage Audit Log - Select this option if you want to allow users to
view the Audit Log. If this option is enabled, the Audit Log page will

Data
Management
Controls be displayed. If not selected, the user will not be able to view the Audit

log page. To view the Audit Log screen, from the Integration Cloud
navigation bar, click Settings  > Audit Log.

Functional Controls

Select the required options underAssets, Stages,Advanced Security,
and Application. You must select the required permissions to deploy,
export, administer, upgrade, create, update, and delete those functions.

Project Permissions for Default Project

Here youwill manage the permissions for new and existing assets only
inside the Default project. See “Project Permissions” on page 59 for
information. Select the required options underAccounts,Operations,
Reference Data, Document Type, Integrations, REST APIs, SOAP
APIs, and Listeners.

Note:
If you are a new tenant, the Default project is not available, so this
section is not applicable. Your user's Access Profile controls only
global permissions.

6. On theContainer page, enter the names of thewebMethods Integration Server Access Control
List (ACL) groups separated by a comma, for example, Administrators, Developers, and so
on. Users who are assigned to this Access Profile will be now part of the webMethods
Integration Server container user group (s) and can perform tasks allowed for those user
groups. If you do not map an Access Profile to an webMethods Integration Server group, you
will not be able to invokewebMethods Integration Server services. For information about user
groups, see the Managing Users and Groups section in the webMethods Integration Server
Administrator’s Guide.

Note:
The Container tab and Container related Administrative permissions are available only if
you have the required license for Containers.

Note:
Integration Cloud Administrator profiles are not automatically assigned to the webMethods
Integration Server Administrators ACL group. If you do not enter any user groups in the
Container User Groupsfield, but have configuredwebMethods Integration Server in away
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such that it needs to verify the ACL groups you have entered in theContainer User Groups
field while invoking services, youwill not be able to run or invoke webMethods Integration
Server services from Integration Cloud.

7. The API Management tab displays the API management permissions.

Note:
Integration Cloud provides the user management capability for API Gateway. You can
create and manage API Management Access Profiles provided you have the required API
Gateway Cloud and/or API Portal Cloud licenses.

DescriptionField

User Management - Select this option if youwant to create andmanage
users.

User and
Ownership
Controls

Select the following Functional Controls based on your requirements:

DescriptionField

To create and manage APIs.Manage APIs

To activate, deactivate and manage APIs.Activate/Deactivate APIs

To publish assets to API Portal.Publish to API Portal

To create and manage applications and register applications
with the APIs. You cannot modify or delete an application if
you are not the owner of the application.

Manage Applications

To create and manage aliases.Manage aliases

To apply a global policy to all APIs or the selected set of APIs.Manage Global Policies

To activate and deactivate global policies.Activate/Deactivate
Global Policies

To apply one or more policy templates to an API.Manage Policy Templates

To prevent malicious attacks on applications that typically
involve large, recursive payloads, and SQL injections.

Manage Threat Protection
Policies

To create packages and plans, associate a planwith a package,
and associate APIs with a package. In addition, you can view

Manage Packages and
Plans

the list of packages, package details, APIs, and plans associated
with the package.

To activate and deactivate packages.Activate/Deactivate
Packages
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DescriptionField

To import already exported APIs, application, policies, and
aliases by selecting Username > Import in API Gateway.

Import Assets

To export assets to your local system.Export Assets

To create and manage administration configurations.Manage general
administration
configurations

To view administration configurations.View Administration
Configurations

To manage general configurations.Manage General
Configurations

To create and manage security configurations.Manage Security
Configurations

To publish events and performance metrics data to the
configured destinations.

Manage Destination
Configurations

To create and manage system settings.Manage System Settings

To purge and restore events from the API Gateway store by
setting the required date or duration in API Gateway.

Purge/Restore Runtime
Events

Tomanage caching of the results ofAPI invocations depending
on the caching criteria defined.

Manage Service Result
Cache

To add, modify, and delete API Gateway stages, or move API
Gateway assets from the source stage to one or more target

Manage Promotions

stages, or to rollback an asset promotion that is already
available in the target stage at any time.

To manage all API Portal administrative tasks.API Portal Administrator

To manage all API Portal provider tasks.API Portal Provider

8. The Solution Permissions page displays the webMethods Integration Server User Groups for
all the solutions. You canmapwebMethods Integration Server user groups to anAccess Profile.
Enter the names of the webMethods Integration Server User Groups separated by a comma,
for example, Administrators, Developers, and so on. IntegrationClouduserswho are assigned
to this Access Profile will then be a part of the webMethods Integration Server user group(s)
and can perform tasks allowed for those user groups. If you do not map an Access Profile to
a webMethods Integration Server user group, you will not be able to view, edit, or run
webMethods Integration Server services in a solution. For information about user groups, see
the Managing Users and Groups section in the webMethods Integration Server Administrator’s
Guide.
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Note:
Integration Cloud Administrator profiles are automatically assigned to the webMethods
Integration Server Administrators User Group.

Note:
To view and access webMethods Integration Server packages in Integration Cloud, you
must assign any custom user groups created in webMethods Integration Server, which are
assigned toAccess Profiles in the Solution Permissionspage, to the followingAccess Control
Lists in webMethods Integration Server: Administrators ACL, Developers ACL, and
Replicators ACL.

9. Click Apply.

The new Access Profile appears in the Access Profiles page.

10. Click on the Access Profile link in the Access Profiles page. In the Associated Users page,
you can view the active users associated with the selected Access Profile. In the Associated
ACLs page, you can view the Access Control Lists associated with the selected Access Profile.

Access Control Lists

You can use Access Control Lists (ACLs) to control the execution permission of an Integration.
ACLs provide you with another level of control over who can execute specific Integrations. An
ACL can be assigned to an Integration and a user can be associated with the ACL through the
Access Profile. Therefore using ACLs, you can control the users who can execute an Integration.

Example 1

You have three users U1, U2, and U3. U1 is assigned to Access Profile AP1, U2 is assigned to
Access ProfileAP2, andU3 is assigned toAccess ProfileAP3. Eachuser has the Integration execution
permission. There are also four Integrations IN1, IN2, IN3, and IN4 in your tenancy. Initially, U1,
U2, and U3 can run all the four Integrations IN1, IN2, IN3, and IN4. Now you want IN1 to be
executed only by U1 and not by U2 and U3. To do that, create an Access Control List, ACL1.
Associate ACL1 to IN1. Then associate ACL1 to AP1. As U1 has already been assigned to AP1,
IN1 can be executed by only U1. If you want IN1 to be executed also by U2, then associate ACL1
with AP2.

Integration Cloud provides you with a default ACL, Default, and this default ACL is associated
with all Integrations. You can change the ACL associated with an Integration in the Integration
Details page.

Example 2

You have three users U1, U2, and U3. U1 is assigned to Access Profile AP1, U2 is assigned to
Access ProfileAP2, andU3 is assigned toAccess ProfileAP3. Eachuser has the Integration execution
permission. There are also four Integrations IN1, IN2, IN3, and IN4 in your tenancy. Initially, U1,
U2, and U3 can run all the four Integrations IN1, IN2, IN3, and IN4. Now youwant U1 to run only
IN1 and not IN2, IN3, and IN4. To do that, create an Access Control List, ACL1. Associate ACL1
to IN1. Then associate ACL1 to AP1, AP2, and AP3. Now disassociate AP1 from the default ACL.
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AsAP1 is associatedwith onlyACL1, U1will be able to execute only those Integrations associated
with ACL1.

Userswhohave theAccess ControlpermissionunderSettings  > Access Profiles > Administrative
Permissions > User and Ownership Controls can edit the ACL information.

To edit an existing ACL other than the default ACL, select the ACL and click Edit. To delete an
existing ACL other than the default ACL, select the ACL and click Delete. If you delete an ACL,
the ACL will be removed from the associated Integration and the Integration will be associated
with the default ACL. To create a new ACL, click Add New Access Control List.

Adding or Updating Access Control Lists

Use the Access Control Lists page to create, edit, or delete Access Control Lists (ACLs). You can
also edit the default ACL, Default, but you cannot delete it.

To add or update an ACL

1. From the Integration Cloud navigation bar, go to Settings  > Access Control Lists.

2. Click Add New Access Control List to add an ACL or click Edit to modify an existing ACL.

3. On the Add New Access Control List or Update Access Control List page, complete the
following fields. Required fields are marked with an asterisk on the screen.

DescriptionField

Provide a name for the ACL. The name cannot be modified after you
save the ACL.

Name

4. On the Associate with Access Profiles tab, complete the following fields:

DescriptionField

Select the Access Profiles that you want to associate with the ACL. All
Access Profiles created in Integration Cloud appear in the panel. The

Select Access
Profiles

AdministratorAccess Profilewill always be associatedwith all theACLs,
therefore users associated with the Administrator Access Profile will
be able to execute all Integrations.

5. Click Apply.

Preferences

The Settings > Preferences screen allows you to provide the settings for the following:

58 Integration Cloud 6.6.0

3 Settings



Smart Mapping

Try-catch error display

Note:
Only the users with Administrator (Access Profile ID 4) privileges can edit the Preferences
screen.

DescriptionOption

Select this check box to enable the smartmapping feature. This provides
you mapping recommendations whenever you perform mapping. For
more information, see “Smart Mapping” on page 406.

Publish Integration
Mappings to
Recommendations
Engine

Note:
By enabling this feature, you are also providing us your consent to
collect your mapping information. For trial tenants, this feature is
enabled by default.

Select this check box to view on-screen messages when an exception
occurs while executing an operation or a service within an integration
using a Try-Catch block.

Mark Integration as
Completed with Errors,
if errors are caught with
try-catch blocks

When this check box is enabled, if an exception occurs within a Try
block, then the end result of the integration execution is shown as
completed with errors. Even if the error is handled in the Catch block,
the integration is shown as completed with errors.

When this check box is not selected, if an exception occurs within a Try
block, then the end result of the integration execution is shown as
integration completed successfully. It is the responsibility of the
integration developer to handle the error inside the Catch block.

For example, let us consider an integration that contains a divideInts
Math service within a Try-Catch block. While doing the division, if we
enter a string value instead of an integer and execute this integration
and if this check box is not selected, then you will see the message
Integration completed successfully. If the check box is selected, then
you will see the message Integration completed with errors.

Project Permissions

Aproject is an independent entity and corresponds to a folder for organizing your assets. A project
holds all the assets created as a part of that project by the logged-in user, along with the
configurations associated with the assets. Project permissions are used to associate permissions
with projects.

You associate permissions with projects from the Settings  > Project Permissions > Add New
Project Permission page.
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Integration Cloud provides a system-generated Developer project permission profile in your
tenant. Any newproject created is automatically associatedwith theDeveloper project permission
profile. This profile has permissions to create, update, delete, and execute all assets. You cannot
edit or delete this system-generated project permission profile. If a project permission profile is
associated with a user on the user profile page, the user can perform only the permitted tasks in
the mapped project.

If you are an existing tenant:

Your user's Access Profile controls global permissions as well as permissions for the Default
project.

Your user's Project Permissions profile control permissions for other projects.

All existing user profiles will be associated with the Developer project permission profile.

All projects created have the Developer project permission profile associated with it.

All existing assets will be available in the Default project.

Manage the permissions for existing assets inside the Default project from the Project
Permissions for Default Project section under Settings  > Access Profiles > Administrative
Permissions.

Manage the permissions for new assets created inside the Default project from the Project
Permissions for Default Project section under Settings  > Access Profiles > Administrative
Permissions.

If you create a new project, you have to assign the project permissions from the Settings  >
Project Permissions > Add New Project Permission page.

If you are a new tenant:

The Default project is not available. There are no existing assets. Your user's Access Profile
controls only global permissions.

The Administrator will be associated with the Developer project permission profile and can
assign a project permission profile to a new user.

All projects created have the Developer project permission profile associated with it.

If you create a new project, you have to assign the project permissions from the Settings  >
Project Permissions > Add New Project Permission page.

Once you log in, from the IntegrationCloudnavigation bar, click Settings  > Project Permissions

> Add New Project Permission. Select a project and then click the add icon to add the project
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in the panel. Then assign the relevant permissions to the selected project . You can select another
project and assign the permissions to the selected project. Click Add.

Note:
Integration Execute permission available as part of Project Permissions are applicable only
for top-level projects. For example, if you have the Integration Execute permission for project
B but not for project A, and have shared assets of project Awith project B, thenwhen you execute
an integration of project B which has an integration of project A, the integration execution will
be successful.

Note:
If you associate the project permission profile to a user on the user profile page, the user can
perform only the permitted tasks in each mapped project.

Example 1

Auser is assigned to two project permission profilesA and B in the user profile. Project permission
profile A has the Execute Integration permission in Project X but Project permission profile B does
not have the Execute Integration permission for the same Project X. The user will still be able to
execute the Integration.

Example 2

In this example, we will see how you will allow an existing user U1 to create, update, delete, and
execute Integrations for the Project P1 but not for Project P2.

1. You must have the Access Control permission under Access Profiles > Administrative
Permissions.

2. Create Project P1 and Project P2.

3. Create a new Project Permission profile PP1 under Settings > Project Permissions > Add
New Project Permission.

4. On the Add New Project Permission page, add Project P1 in the mapped projects list. Assign
the create, update, delete, and execute Integration permissions to the mapped Project P1.

5. Do not map Project P2.

6. Go to the Basic tab of user U1 and select only PP1.

So when U1 logs in, U1 will only be able to create, update, delete, and execute Integrations for the
Project P1 but not for Project P2.
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Single Sign-On

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

Single sign-on is a process that allows users to access all authorized network resources without
having to log in separately to each resource.

Security Assertion Markup Language 2.0 (SAML 2.0) is a standard for exchanging authentication
and authorization data between security domains. SAML 2.0 is an XML-based standard that uses
security tokens containing assertions to pass information about a principal (usually an end user),
between a SAML authority, that is, an identity provider (IdP), and a SAML consumer, that is, a
service provider. Using SAML, a service provider can contact an identity provider to authenticate
users who are trying to access secure content.

Note:
Currently, only SAML 2.0 is supported.

Integration Cloud supports single sign-on (SSO) that allows users to authenticate themselves
against an Identity Provider (IdP) rather than obtaining and using a separate username and
password. Under the SSO setup, Integration Cloud works as a Service Provider through SAML.
You can put the IdP you already trust in charge of authentication, while your users can access
Integration Cloud without another password to manage.

The following actions take place while logging into Integration Cloud using SAML 2.0:
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Service Provider: Integration Cloud

Identity Provider (IdP): Microsoft Azure, Okta, Oracle Access Manager

1. User logs into a web application and clicks on the SAML SSO link to access Integration Cloud.

2. Integration Cloud generates a SAML authentication request and posts the request to the user’s
browser.

3. The browser sends the SAML request to the Identity Provider for authentication. The SAML
request contains user information, Identity Provider URL, and the assertion response URL.

4. The Identity Provider decodes the SAML request, extracts the URL, authenticates the user,
generates a SAML response, and posts the SAML response to the browser.

5. The browser sends the SAML response to Integration Cloud.

6. IntegrationCloud checks if the Identity Provider authenticationwas successful, that is, verifies
the SAML response, and redirects the user to the appropriate home page or the error message
page.

Note:
IntegrationCloud SSO capability has been tested toworkwithMicrosoft AzureActiveDirectory
(Azure), Oracle Access Manager (OAM), and Okta as Identity Providers.
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You can click Edit to configure SAML 2.0 settings for single sign-on or click Export SAML 2.0
Metadata if you want to export the Integration Cloud SAML metadata.

See Configuring SAML Settings for Single Sign-On on how to configure SAML settings for single
sign-on.

Note:
If you have already configured SAMLbased single sign-on (SSO), the SSO Login option appears
in the login page. If you click the SSO Login option, Integration Cloud redirects you to the
Identity Provider (IdP) login page. After you provide the IdP login credentials, you will be
logged into Integration Cloud.

Note:
You can access or edit the single sign-on configuration page only if you can edit the Company
Information, that is, have the Manage Company Capabilities permission under Settings  >
Access Profiles > Administrative Permissions > Account Controls.

Configuring SAML Settings for Single Sign-On

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

The Single Sign-On Configuration screen allows you to configure SAML 2.0 settings for single
sign-on (SSO). To prevent modifications to the SSO configurations, the SSO settings may not be
enabled in your organization.

Note:
You can access or edit the single sign-on configuration page only if you can edit the Company
Information, that is, have the Manage Company Capabilities permission under Settings  >
Access Profiles > Administrative Permissions > Account Controls.

Note:
If you have configured SSO, the SSO Login option appears in the login page. You can click the
SSO Login option to log in to IntegrationCloudwithout providing yourUsername andPassword.

To configure SAML 2.0 settings for single sign-on

1. From the Integration Cloud navigation bar, click Settings  > Single Sign-On.

2. Click Edit.

3. On the Update Single Sign-On Configuration screen, select SAML 2.0 in the Sign-On Using
field and make the necessary modifications. Required fields are marked with an asterisk on
the screen.
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DescriptionField

Choose Single Sign-On Type

Select the sign-on type from the drop-down list. Default is None.Sign-On Using

Security Assertion Markup Language 2.0 (SAML 2.0) is an
XML-based standard for exchanging authentication and
authorization data between security domains. Integration Cloud
(Service Provider) must enroll with an Identity Provider (IdP) and
obtain an Identity Provider URL.

Requestor Details

This URL is the SAML SSO link and is used to trigger the SAML
based single sign-on. Use this link to login to Integration Cloud
using your Identity Provider.

Authentication
Service URL

To login to API Gateway Cloud, add done=apiGatewayUIHome
parameter to the Authentication Service URL.

To login toAPI Portal Cloud, add done=apiPortalUIHomeparameter
to the Authentication Service URL.

This is the URL which consumes the SAML response from the
Identity Provider. You need to apply this URL in the relevant field
in the Identity Provider SAML configuration page.

Assertion Consumer
Service URL

For Oracle Access Manager (OAM), apply it in the Assertion
Consumer Service URL field.

For Microsoft Azure, apply it in the Reply URL field.

For Okta, apply it in the Single sign on URL field.

RelayState is a parameter used by SAMLprotocol implementations
to identify the specific resource at the resource provider, in an

RelayState for Identity
Provider initiated SSO

Identity Provider initiated single sign-on scenario. In an Identity
Provider initiated single sign-on scenario, you must set the
RelayState value in the Identity Provider. Test the Identity Provider
initiated SSO only after configuring the RelayState.

For Oracle Access Manager (OAM), apply the RelayState value as
the Return URL in the Identity Provider initiated URL.

For Microsoft Azure, send the RelayState value to Microsoft Azure
AD to configure the RelayState for your application instance. See
Microsoft Azure website for more information.

For Okta, apply it in the Default RelayState field.

Identity Provider Configuration
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DescriptionField

This is the Integration Cloud (Service Provider) URL used to access
this tenant. This URL acts as the Service Provider ID.

SAMLRequest Issuer
URL

ForOracleAccessManager (OAM), apply it in the Provider IDfield.

For Microsoft Azure, apply it in the Identifier field.

For Okta, apply it in the Audience URI (SP Entity ID) field.

Specify how you want to define the Identity Provider details.Identity Provider
Details

Select Enter Manually if you want to manually enter the URL that
uniquely identifies Integration Cloud in your SAML Identity
Provider in the Issuer field.

Select Load From Identity Provider Metadata and select the
metadata file to upload the IdP details.

A URL that uniquely identifies Integration Cloud in your SAML
Identity Provider. IntegrationCloud (Service Provider)must enroll
with an Identity Provider and obtain an Issuer URL.

Issuer

If you have selected Enter Manually for Identity Provider Details,
copy the URL provided by the IdP here after setting up Integration
Cloud configuration in the IdP.

If you have selected Load From Identity Provider Metadata for
Identity Provider Details and uploaded the IdP file, the Issuer field
will be automatically populated.

For Microsoft Azure, copy the URL from the Issuer URL field.

ForOracleAccessManager (OAM), copy theURL from the Provider
Id field under Federation Settings.

For Okta, copy the URL from the Identity Provider Issuer field.

This is the authentication certificate (a valid x509 issuer certificate)
issued by your Identity Provider and is required to sign and verify
SAML messages.

Identity Provider
Certificate

If you have selected Enter Manually for Identity Provider Details,
selectBrowse and upload a file that contains the Identity Provider’s
certificate.

If you have selected Load From Identity Provider Metadata for
Identity Provider Details and uploaded the IdP file, the IdP
certificate will be automatically uploaded.

This is the URL used to log in to the Identity Provider.Identity Provider
Login URL
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If you have selected Enter Manually for Identity Provider Details,
type the URL that will be used to log in to the Identity Provider.

If you have selected Load From Identity Provider Metadata for
Identity Provider Details and uploaded the IdP file, the IdP login
URL will be automatically populated.

ForOracleAccessManager (OAM), theURL is http://<oamserverhost
name>:14100/oamfed/idp/samlv20.

For Microsoft Azure, copy the URL from the Single sign-on service
URL field.

For Okta, copy the URL from the Identity Provider Single Sign-On
URL field.

Determines the type of identifier.User ID Type

Assertion contains user's Integration Cloud username - Select this
option if your Identity Provider passes the username >User Profile
> Basic tab) in the SAML assertion to identify the user.

Assertion contains the Federation ID from the User Object - The
Federation ID acts as a user's authentication across multiple IT
systems or organizations. A federated identity means linking a
person's electronic identity and attributes stored across multiple
distinct identity management systems. Select this option if your
Identity Provider passes the Federation ID ( >User Profile > Basic
tab), to identify the user. You can add the Federation ID ( > User
Profile > Basic tab) to each user’s profile after you have configured
single sign-on.

Specifies an attribute tag that defines the location of the User ID.
This is the location in the assertion where a user should be
identified.

User ID Location

Select Subject if the User ID is located in the <Subject> statement
of the assertion.

Select Attribute if the User ID is specified in an <AttributeValue>,
located in the <Attribute> of the assertion. If you have selected
Attribute, specify the attribute that contains the User ID in the
Attribute for User ID field. If the User ID attribute is empty or does
not match an existing user, then either login fails or a new user is
created, depending on the Create Users setting.

This field appears if you have selected Attribute in the User ID
Location field. Specify the attribute that contains the User ID. If the

Attribute for User ID

User ID attribute is empty or does not match an existing user, then

Integration Cloud 6.6.0 67

3 Settings



DescriptionField

either login fails or a new user is created, depending on the Create
Users setting.

Select this option to create a new user when the User ID is not
recognized. When selected, additional options appear where you

Create Users

can specify the attribute to use for the FirstName, LastName, Email,
and Access Profile.

Attribute for First Name - The name of the SAML attribute that
designates the user's first name.

Attribute for Last Name - The name of the SAML attribute that
designates the user's last name.

Attribute for Email - The name of the SAML attribute that
designates the user's email address.

Default Access Profile - This field is used to specify the default
Access Profile for the created user.

Attribute for Access Profile - The name of the SAMLattribute that
designates the user's access profile. The attribute must contain the
ID of the Access Profile. You can get the ID of the Access Profile
from the Access Profiles screen (Settings  > Access Profiles).

Note:
Youmust select EmailAddress as theNameIDFormat in the Identity Provider SSOConfiguration
screen.

Company Information

This screen displays your company information. Users who have the Manage Company
Capabilities permission under Settings  > Access Profiles > Administrative Permissions >
Account Controls can edit the company information.

See “Updating Company Information” on page 68 for information on the fields.

Click Edit to update the company information.

Updating Company Information
You can view and update the company information and use them across all applications in the
platform.

To update the Company Information
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1. From the Integration Cloud navigation bar, go to Settings  > Company Information.

2. Click Edit.

3. In theBasic section, complete the following fields. Required fields aremarkedwith an asterisk
on the screen.

DescriptionField

This is the unique ID assigned to your organization's tenancy on the
platform.

Tenant ID

Note:
This field cannot be edited and appears in view only mode under
the Basic tab.

This is the unique sub domain that you specified during registration.
A sub domain is a domain that is part of a main domain. For example,

Sub Domain

suppose you are at ABCCompany and you decide to use “abc” as your
unique sub domain. With that setting, you will access your instance of
the platform at https://abc.webmethodscloud.com.

Note:
This field cannot be edited and appears in view only mode under
the Basic tab.

The name of the company. This field accepts only alphanumerics,
spaces, and hyphens (-). The company name is automatically populated
from the Registration screen.

Company Name

The street address of the company.Street

The city where the company is located.City

The state or Province where the company is located. The state or
province name is automatically populated from theRegistration screen.

State/Province

The postal or zip code for the company.Postal/Zip Code

The country where the company is located. The country name is
automatically populated from the Registration screen.

Country

Enter an address or comma-separated email addresses to receive system
notifications. Such notifications can occur, for example, when a

System
Notification
Email Addresses connection to the system mailbox fails after repeated attempts. This

field displays the information from the Registration screen but you
can change that later using the Edit button.

4. In the Advanced Information section, complete the following fields:
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Choose your time zone from the drop down list.Time Zone

Choose a time format from the dropdown list. You can choose a 12-hour
clock with AM/PM or a 24-hour clock.

Time Format

hh:mm a - 12-hour clock - 3:30 AM, 3:30 PM

HH:mm - 24-hour clock - 3:30, 15:30

Choose a date format from the drop down list.Date Format

mm is "Month", dd is "Day", yyyy is Year and the delimters are:(/) slash
or stroke(-) dash or hyphen(.) period, dot, or full stop.

This setting determines the language for the tenant.Default Locale

Note:
Userswithin a tenant can set their preferred language from theUsers
> Locale tab.

For example, if you set the value here as English and the user for
this tenant sets the value as Chinese in the Locale field, then the user
will see all the application labels in the Chinese language.

For more information, see “Adding Users” on page 42.

This field displays the date and time when the company information
record was last updated. This field cannot be edited and appears in
view only mode.

Last Modified

Password Policy

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page. Password policies are defined in the Software AG Cloud User Administration
page.

A Password Policy defines password requirements and login protections. Users who have the
Access Control permission under Settings  > Access Profiles > Administrative Permissions
> User and Ownership Controls can edit the Password Policy information.

You can view the password policies for the IntegrationCloud instance in this screen. See “Updating
Password Policy Settings” on page 71 for information on the fields.

Click Edit to modify the password policy information.
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Updating Password Policy Settings

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page. Password policies have to be defined in the Software AG Cloud User
Administration page.

You can set password policies for users on the Update Password Policy page.

To update the Password Policy

1. From the Integration Cloud navigation bar, click Settings  > Password Policy.

2. Click Edit.

3. On the Update Password Policy page, make the necessary modifications.

DescriptionField

Select the minimum number of characters in the password.Minimum Length

This option defines the level of security for passwords, which can
be simple and allow any character combination, or very secure,

Required Character
types

requiring upper and lower case characters, as well as special
characters.

Select the number of days the password will remain valid before
the user will be prompted to change it.

Expires in

By default, no user is exempt from the Password Policy. You can
specify a user to be excluded from the password expiration policy
by selecting Never.

Select the users for whom the password will never expire. Only
active users appear in the list. You can make an user account active

Password Never
Expires for

by selecting the Settings  > Users > Update User > Basic tab
> Active option.

Thenewpassword cannotmatch the number of previouspasswords.New Password
cannot match

Select the number of days that must pass before a user can change
passwords.

Minimum Age

Select the length of time the session will remain active without any
user activity. The session will end when it reaches the selected
timeout. The user will need to log in again.

Session Timeout
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Select the number of login attempts before the account is locked
out.

Account Lockout
Threshold

The login limit defines the number of failed attempts allowed before
a user account is disabled or locked for a specified time. When a
user attempts to login and fails (because of an incorrect password),
each attempt counts against the login limit. When the login limit is
achieved, the account is disabled or locked for a specified time,
according to the parameters set in the Account Lockout Duration
field. The login limit is defined by the Password Policy.

Select the length of time that an account is locked out.Account Lockout
Duration

For audit purposes, the following information is displayed after
you save the record:

Record Information

Last Modified By <username> on {date} <time> Created by System.

4. Click Apply.

Client Certificate

Secure Sockets Layer (SSL) is a means of securing communications over a network so that only
the sender and receiver have access to the sensitive data.

In a one-way SSL connection, an anonymous client authenticates the credentials of a server in
preparation for setting up a secure transaction. In most cases, the server knows nothing about the
client's identity because verification of its credentials is not required. When desired, the client can
be authenticated using basic authentication by providing a username and password. This type of
authentication typifies connectionswhere a browser establishes a connection to a server to perform
a secure transaction, for example, viewing a savings account, or buying items with a credit card.
The client must authenticate the server's credentials before initiating the transaction, but it is not
necessary for the server to authenticate and keep a record of every possible client (browser). This
type of connection is typically one where a partner application or resource needs to verify the
authenticity of the server without itself needing to be authenticated.

Two-way SSL authentication refers to two parties authenticating each other by verifying the
provided digital certificate so that both parties are assured of the others' identity. It refers to a
client (web browser or client application) authenticating itself to a server and the server
authenticating itself to the client by verifying the public key certificate or digital certificate issued
by the Certificate Authorities (CAs).

Integration Cloud supports two-way SSL for inbound connections. The request for an SSL
connection originates from a client. During the SSL handshake process, the entity acting as the
SSL server responds to the request for a connection by presenting its SSL credentials (an X.509
certificate) to the requesting client. If those credentials are authenticated by the client, either:
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An SSL connection is established and information can be exchanged between the client and
server.

- or -

The next phase of the authentication process occurs, and the server requests the SSL credentials
of the client. If the server verifies those credentials, that is, the client's identity, an SSL connection
is established and information exchange takes place.

Note:
When a client or partner application submits a request to Integration Cloud using HTTPS on
port 8443, and a two-way SSL connection is established, the client acts as the SSL client and
Integration Cloud acts as the SSL server.

The following table provides a high-level roadmap for configuring SSL.

NotesActivitiesTask

Two-way SSL connection
requires a valid client
certificate.

Create keys and
certificates

Generate a public key/private key pair.

Generate a certificate signing request
(CSR) and send it to the certificate
authority (CA) for signing.

Receive validated certificate from the
CA.

Required for two-way SSL
connections.

Upload the CA signed client certificate for
the user in the Client Certificate page or
generate a private key and a new Integration
Cloud signed client certificate.

Upload client certificate
or generate a certificate

Integration Cloud support
two-way SSL on port 8443.

Configure the REST client with the private
key and certificate. Optionally you can also
pass the basic authentication credentials.

Connect to Integration
Cloud using the client
certificate.

Users who have the User Management permission under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls can generate or edit any client
certificate. Users who have the Manage Personal Setup permission under Settings  > Access
Profiles > Administrative Permissions > User and Ownership Controls can generate or edit the
user's own certificate.

See “Adding Client Certificates” on page 73 for information on how to add client certificates.

Adding Client Certificates
Integration Cloud allows you to store client certificates and associate a certificate with a user
account. You can add client certificates for users on the Client Certificate page. When a client
presents one of these certificates, Integration Cloud logs in the client, as the user "mapped" to the
certificate.
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To add a client certificate

1. From the Integration Cloud navigation bar, click Settings  > Client Certificate.

2. In the User field, select a user. Only active users are listed in the User field.

3. In the Upload New Certificate field, click Browse to upload a new client certificate signed
by a trusted certificate authority (CA). If a certificate is configured for a user, the Certificate
Details panel displays the configured certificate. You can click Download to download the
user certificate or click Delete to delete the user certificate. The downloaded file is named as
<username>.crt.

4. In the Generate Private Key and Certificate field, click Generate if you want Integration
Cloud to generate a private key and a new IntegrationCloud-signed client certificate. Integration
Cloud validates it against the issuer of the certificate. The generated certificate is named as
<username>.txt which contains the private key and the client certificate.

Executing Integrations using Two-way SSL

Summary

Two-way SSL authentication, also referred to as client ormutual authentication or certificate-based
authentication, refers to two parties authenticating each other by verifying the provided digital
certificate, so that both the parties are assured of the other's Identity.

Two-way SSL authentication involves the following steps:

1. Client (Postman, SoapUI) requests access to protected resources of server (webMethods
Integration Cloud).

2. Server presents its certificate to the client.

3. Client validates the server's certificate.

4. Client sends its certificate to the server.

5. Server verifies the client’s certificate.

6. If successful, the server grants access to the protected resources requested by the client.

In this tutorial, we will create an integration in webMethods Integration Cloud, expose the
integration over HTTP (exposing the integration over HTTP allows the integration to be executed
froman outside environment), and then execute the integration using two-way SSL authentication
by using a REST Client (Postman). You can also use the same technique for SOAP APIs, REST
APIs, or any other exposed APIs.
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Actors

Integration developers who develop and expose the integrations over HTTPS in Integration
Cloud.

Integration executors who runs integrations.

Before you begin

You must have the permissions to create and execute integrations in Integration Cloud under
Settings  > Access Profiles > Administrative Permissions > Functional Controls >
Integrations.

Basic Flow

1. Log in to Integration Cloud.

2. Create an Integration (testApp) in Integration Cloud.

3. On the Integrations page, click the integration link, and on the integration Overview page,
select the Enable Integration to be invoked over HTTP option.

4. Click Settings  > Client Certificate.

5. Select the User. You can either upload a certificate to the user if there are any available
CA-signed certificates, or you can generate and assign a certificate to the user. Click Browse
to upload a certificate if youwant to use the user's own certificate or clickGenerate to generate
and download the private and public key for the user.
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After downloading the file, copy the private key to a file and name it as
{privateKeyFileName}.key and the public key to a file and name it as {publicKeyFileName}.crt.

6. Open the Postman REST client and click Settings > Certificates. Then click Add Certificate.

7. The Add Certificate page appears. Now configure the certificate and private key in Postman.
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8. As shown in the above figure, specify theHost name and the port number as 8443. Specify the
location of the key files, that is, the CRT file (certificate) and the KEY file (private key). Click
Add to save the two-way SSL configuration.

9. Open a new tab in Postman and add the request details you have obtained from Integration
Cloud. The request details are available after you select the Enable Integration to be invoked
over HTTP option.
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10. To execute the Integration, configure a POST request in Postman as shown below and click
Send. Change the port to 8443 of your service. URL is
https://mydomain.webmethodscloud.com:8443/<Your service URL>.

Exceptions

The following errors may occur in the REST Client when there is a certificate mismatch between
what is specified in Integration Cloud with what is sent from the REST Client.

The server could not send a response.

Self-signed SSL certificates are blocked.
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Visual Model

OAuth 2.0

About OAuth 2.0

Note:
This page is not applicable if you have created your account using the Software AG Cloud
sign-up page.

The OAuth 2.0 Authorization Framework facilitates the sharing of private resources (data or
services) with a third-party client application (client). In an OAuth session, private resources are
stored on a resource server and the owner of the resources, or resource owner, grants the client
application permission to access them. The resource owner is typically a person; however, in some
cases it could be an application.When a resource owner grants permission, theOAuth authorization
server issues an access token to the client application. When the client application passes the access
token to the resource server, the resource server communicates with the authorization server to
validate the token and, if valid, provides access to the resources.

The following example illustrates the roles involved with an OAuth session. In the example, Bob
is the resource ownerwhowants to access and print his photos stored on the PhotoStoragewebsite
(the resource server) using the PhotoPrint service (the client application). PhotoPrint supplies Bob
with an application that runs on his device (phone or laptop). Bob uses that application to initiate
the process. PhotoPrint sends a request to the PhotoStorage authorization server. The authorization
server requests authorization from Bob and issues a token to PhotoPrint. PhotoPrint can then
access Bob's photos on PhotoStorage.
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Integration Cloud services can be accessed through REST APIs from any REST client. In OAuth
2.0, the client obtains an access token issued by an authorization server on approval of the resource
owner. The client uses the access token to access the protected resources.

Note:
Integration Cloud acts both as a Resource server and as an Authorization server.

An in-depth description of OAuth is beyond the scope of this guide but is available elsewhere.
For information about the OAuth protocol, see the OAuth 2.0 Authorization Framework.

Configuring OAuth 2.0
Before you can invoke services using OAuth 2.0 tokens, you must define clients, scopes, associate
scopes to clients, and generate OAuth 2.0 tokens. The following table describes how to configure
OAuth 2.0.

DescriptionSteps

Define the clients that are authorized to invoke
services in Integration Cloud. Specify the client

“Define Clients” on page 81

name, version number of the client, client type,
redirection URLs, allowed grants, expiration
interval, and the refresh count. See “Registering
Clients” on page 81 for more information.

A scope defines the services the client can access on
behalf of the resource owner. A scope consists of a

“Define Scopes” on page 84

name and one or more services. If access is granted
for a scope, then access is granted for all the services
in that scope.

80 Integration Cloud 6.6.0

3 Settings



DescriptionSteps

Associate defined scopeswith the registered clients.
When you associate scopes, you authorize the scopes
that each client can access.

“Associate scopes to a client” on
page 81

Generate tokens (Access Token and Refresh Token)
by using a RESTClient. See “Generating Tokens” on

“Generate Tokens” on page 86

page 86 for more information. Integration Cloud
supports the Authorization Code Grant, Implicit
Grant, Client Credentials Grant, and the Resource
Owner Password Credentials Grant to generate the
access tokens. Clients use the tokens to execute REST
URLs for running the Integrations. After you
generate the tokens, the tokens are available in the
Token Management page in Integration Cloud.

Registering Clients
Before a client can request access to a protected resource, it should registerwith IntegrationCloud.
When you register a client, you identify the client as a confidential client or a public client, select
the grant types the client can use, and specify the token expiration and refresh information. The
Client Registration page lists the clients registered with Integration Cloud.

See “About OAuth 2.0” on page 79 for information on the high-level steps for configuring OAuth
2.0.

Note:
When you delete a client, Integration Cloud also deletes all the access tokens and refresh tokens
for the client. When you deactivate a client by clearing the Active option while updating the
client, all the access tokens and refresh tokens for the client become invalid. You can activate a
deactivated client.

Note:
Users who have the Access Control permission under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls can create, edit, and delete clients.

To add a Client

1. From the Integration Cloud navigation bar, go to Settings  > OAuth 2.0 > Client
Registration > Add New Client.

2. On the Add New Client page, complete the following fields. Required fields are marked with
an asterisk on the screen.
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DescriptionField

Type the name of the client. You cannot create
clients with the same Name and Version

Name

combination. You cannot modify the client name
after the client is saved. Client names are not
case-sensitive.

Type a description of the client.Description

TheClient IDfield appears onlywhen youupdate
a client. This is a client identifier issued to the

Client ID

client to identify itself to the authorization server,
and is used while generating tokens.

The Client Secret field appears only when you
update a client. This is a secret matching to the

Client Secret

client identifier and is used while generating
tokens. It will not be generated if the Client Type
is Public.

View the authorization URL that has to be
provided while generating tokens. See the
Generating Tokens section for more information.

Authorization Endpoint

View the Access Token URL that has to be
provided while generating tokens. See the
Generating Tokens section for more information.

Token Endpoint

View the Refresh Token URL that has to be
providedwhile refreshingAccess Tokens. See the

Refresh Token Endpoint

Refreshing Access Tokens Using Refresh Tokens
section for more information.

Type the version number of the client. You cannot
create clients with the same Name and Version
combination.

Version

Select the type of the client according to its ability
to communicate with Integration Cloud.

Type

Confidential - Select Confidential when the
OAuth session uses the following grants:

Authorization Code Grant

Client Credentials Grant

ResourceOwner PasswordCredentialsGrant

This client is capable of maintaining secure client
authentications. When you select client type as
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Confidential, IntegrationCloud generates a client
secret. This client secret will be required by
IntegrationCloudwhen the clientmakes requests
to the OAuth services.

Public - Select Public when the OAuth session
uses the Implicit Grant type. This client is not
capable of maintaining secure client
authentications.

Specify the URLs that Integration Cloud will use
to redirect the resource owner's browser during
the grant process.

Redirection URLs

You can add more than one redirection URL.

If you select the Authorization Code Grant or the
Implicit Grant types, you must enter at least one
Redirection URL for the client.

Select the type of grant flow required by the client.Allowed Grants

Select the length of time (in seconds) that the
access token is valid.

Expiration Interval

Never Expires - Indicates that the access token
never expires. The Token Management page
displays Lifetime for that token.

Expires In - Specify the number of seconds the
access token is valid.

Select the number of times the access token can
be refreshed.

Refresh Count

Unlimited - Refresh the access token an unlimited
number of times using the refresh token. The
Token Management page displays Unlimited for
that refresh token.

Limited - Specify the number of times to refresh
the access token. The Token Management page
will display the Refresh Count for that refresh
token. If you specify 0 or leave the field empty, a
refresh token will not be issued.

Note:
Tokens can be refreshed only when using the
Authorization Code Grant flow.
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DescriptionField

This option appears only when you update a
client. Clear this option to deactivate the client.

Active

When you deactivate a client, all the access tokens
and refresh tokens for the client become invalid.

3. Click Add to add the client in the Client Registration page.

4. On the Client Registration page, if you want to associate scopes with a client, select a client
and then click Associate Scopes. The Associate Scopes with <ClientName(Version)> page
appears. The Associate Scopes with <ClientName(Version)> page displays the already
associated scopes with the selected client.

a. On theAssociate Scopes with <ClientName(Version)> page, to associate existing scopes
with the client, select Associate Existing Scopes.

b. On the Select Scopes to Associate dialog box, select the existing scopes to associate with
the client and then select Associate Scopes. The newly associated scopes will appear in
the Associate Scopes with <ClientName(Version)> page.

c. To create a new scope and associate it with the selected client, selectAssociate New Scope.
Create the new scope as described in the “Managing Scopes” on page 84 section. The new
scope will be associated with the selected client.

d. To disassociate a scope from a client, select the scope on the Associate Scopes with
<ClientName(Version)> page and then click Disassociate.

Managing Scopes
A scope defines the services the client can access on behalf of the resource owner. A scope consists
of a name and one or more services. If access is granted for a scope, then access is granted for all
the services in that scope. When a request is made, Integration Cloud verifies that the scope is
defined for a client. The client is allowed to access only the service URLs that are specified for the
scope. If the requested scope is not defined, Integration Cloud returns an error indicating that the
scope is invalid.

Note:
You cannot delete a scope that is used by a client. Also, a scope cannot be deleted if it is associated
with an existing token.

Note:
Users who have the Access Control permission under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls can create, edit, anddelete scopes.

See “About OAuth 2.0” on page 79 for information on the high-level steps for configuring OAuth
2.0.
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To add a scope

1. From the Integration Cloud navigation bar, go to Settings  > OAuth 2.0 > Scope
Management > Add New Scope.

2. On theAdd New Scope page, complete the following fields. Required fields are markedwith
an asterisk on the screen.

DescriptionField

Type a unique name for the scope. You cannot
modify the scope name after a scope is saved.
Scope names are not case-sensitive.

Name

Type a description of the scope.Description

Specify the list of services that the client can access
on behalf of the resource owner for executing the

Services

integrations. Click Select Services and in the
Services dialog box, select the exposed
Integrations or REST Resources that you want to
add as Service URLs from the listed projects in
the selected stage.

The Services dialog box displays the exposed
integrations and REST Resources available in all
projects, that is, in custom projects and in the
Default project in the selected stage.

Note:
You can search by the project name, integration
name, or by the REST API name. The search
functionworks for integrations andRESTAPIs
only after you have expanded the integrations
or REST API nodes in that project. It is
recommended to first search for the project and
then search for the integrations andRESTAPIs
in that project.
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DescriptionField

In the Services dialog box, select the exposed
integrations and REST Resources that you want
to add as Service URLs, and then click Add or
Update to add or update the respective service
URLs to that scope.

This field appears once you have added the
exposed Integrations and REST Resources and
shows the selected services.

Service URLs

Service URL is a relative URL and it must start
with /integration. For example, if the absoluteURL
is
https://<sub-domain>.webmethodscloud.com/integration/rest/external/integration/run/development/restintegration,
then the Service URL is
/integration/rest/external/integration/run/development/restintegration.

3. See the “Registering Clients” on page 81 section on how to associate scopes with a client.

Generating Tokens
You can generate tokens (Access Token and Refresh Token) by using a REST Client. Integration
Cloud supports the Authorization Code Grant, Implicit Grant, Client Credentials Grant, and
Resource Owner Password Credentials Grant to generate the access tokens. Clients use the access
tokens to invoke REST URLs for running the Integrations.

See “About OAuth 2.0” on page 79 for information on the high-level steps for configuring OAuth
2.0.

The following example shows how to generate tokens using Postman

1. Add the Postman extension to your Google Chrome web browser.
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2. Open the Postman application.

3. On the Postman Authorization page, select the Type as OAuth 2.0, and then click Get New
Access Token. The Get New Access Token page appears.

4. On the Get New Access Token page, complete the following fields to request a new access
token.
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DescriptionField

Specify the redirection URL added during client
registration.

Callback URL

Provide a token name.Token Name

Provide the Authorization Endpoint URL
available on the Client page in the following
format:

Auth URL

https://abc.webmethodscloud.com/integration/rest/oAuth/authorize

Provide the Access Token Endpoint URL
available on the Client page in the following
format:

Access Token URL

https://abc.webmethodscloud.com/integration/rest/oAuth/getToken

Specify the client ID available on the Client page.Client ID

Specify the client secret available on the Client
page.

Client Secret

Specify the scope associated with the client.Scope (Optional)

Select Authorization Code or Implicit.Grant Type

5. Click Request Token.

Integration Cloud login page appears.

6. Login to Integration Cloud with your credentials.

An approval page appears. The approval page is an HTML page Integration Cloud sends to
the resource owner, after a client submits a request for access to its private resources. The
resource owner uses the page to accept or deny the request.

7. Select the scopes you want to grant access and then click Approve.

On approval, an access token will be generated. A refresh token may also be generated
depending on the Refresh Count configured for your client, and also if your grant type is
Authorization Code Grant.

Refreshing Access Tokens Using Refresh Tokens
You can refresh Access Tokens using Refresh Tokens.

To refresh access tokens using Postman
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1. Add the Postman extension to your Google Chrome web browser.

2. Open the Postman application.

3. Make a HTTP POST call with the following details:

DescriptionField

Provide the following URL:Post URL

https://abc.webmethodscloud.com/integration/rest/oAuth/getToken

Provide the following query parameters:Query Parameters

grant_type - The Grant Type value will be
refresh_token

refresh_token is the refresh token obtained while
generating the tokens.

Example of anHTTPPOST request for refreshing
an access token:

https://abc.webmethodscloud.com/integration/rest/oAuth/getToken?grant_type=refresh_token&refresh_token=
<refresh_token_id>

Note:
In Postman, select Basic Auth as the Authorization type and specify Client ID and
Client Secret as the Username and Password while refreshing the token.

4. An access token will be generated which can be used to invoke the service URLs. The Refresh
Count value will decrease by 1.

Managing Tokens
You can use this page to delete the active tokens issued by Integration Cloud. Client applications
use these tokens to access the resources on Integration Cloud. When you delete the tokens, the
client application can no longer access the resources owned by the resource owners. See the
“Generating Tokens” on page 86 section on how to generate tokens (Access Token and Refresh
Token) by using a RESTClient. See “AboutOAuth 2.0” on page 79 for information on the high-level
steps for configuring OAuth 2.0.

Note:
Users who have the Access Control permission under Settings  > Access Profiles >
Administrative Permissions > User and Ownership Controls can delete tokens.

For expired Access Tokens, the Expiry Time displays Expired. If the Refresh Count is also 0, then
the row in the Token Management page is removed.
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To delete a token

1. From the Integration Cloud navigation bar, go to Settings  > OAuth 2.0 > Token
Management.

2. Select a token and click Delete.

When you delete a token from the list of active tokens, Integration Cloud deletes both the
access token and the refresh token. To prevent a client from accessing resources, you can delete
the client.

Running Services Using OAuth 2.0

To invoke service URLs using Postman

1. Add the Postman extension to your Google Chrome web browser.

2. Open the Postman application.

3. Type the Request URL and change the HTTP method to POST.

4. On the Headers tab, add Authorization as the Key and Bearer <token ID> as the Value.

5. Click Send to run the Integration.

Audit Log

Audit Log allows you to access logs related to additions, deletions, updations, export, schedule,
skip, login, logout, password changes, record access attempts, access violations, deployments,
restart Integration executions, resume Integration executions, and so on for a user.

To view the Audit Log, from the Integration Cloud navigation bar, click Settings > Audit Log.

Note:
The Audit Log page can be viewed only by administrators and users who have the Manage
Audit Log permission under Settings  > Access Profiles > Administrative Permissions >
Data Management Controls.

90 Integration Cloud 6.6.0

3 Settings



By default, the Audit Log page displays the current day’s log entries, with the most recent entries
listed on top. You can sort the log to view the latest log entries. You can also search the Audit Log
for User, Type, or Operation.

Activity Date refers to the date and time when the event occurred. User refers to the name of the
logged in user when the event occurred. Type refers to the type of log entry, for example, User,
Login/Logout, Reference Data, Stage, Account, Application, Integration, License Agreement,
Password Policy, Access Profile, Company, and so on. Operation refers to the action performed,
for example, Export, Execute, Terminate, Add, Delete, Update, Login, Logout, and so on.
Description refers to a summary of the action performed.

Click Modify Retention Period and specify the number of days to retain the Audit Log entries.
Logs whose age exceeds the specified retention period are deleted.

ClickDownload Audit Log if youwant to download and export log entries for a specified period.
You can download Audit logs only up to 30 days.
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Projects

Aproject is an independent entity and corresponds to a folder for organizing your assets. A project
holds all the assets created as a part of that project by the logged-in user, along with the
configurations associated with the assets. Any asset, for example, integrations, REST APIs, SOAP
APIs, Document Types, and Reference Data, is a part of a project.

If you are an existing tenant, your assets will be available in the Default project. You cannot delete
this default project. If you are a new tenant, the Default project is not available and you need to
create a new project.

Note:
Youmust have theAdministrator access profile and theDeveloperproject permission assigned
to create projects. Project permissions are used to associate permissionswith projects. See “Project
Permissions” on page 59 for information on how to assign permissions to projects.

Creating projects

Once you log in, click Projects > + New Project to create a new project.

In the New Project dialog box that appears, enter a suitable name for the project that you want
to create and then click Create. This will create a new project. You can now start creating
integrations inside this project. You can create as many projects as you want.

Deleting projects

To delete a project, locate the project that you want to delete. Then click on the vertical ellipsis
icon (or three tiny dots) at the lower-right corner of your project and click Delete. Confirm the
delete action to permanently delete the project. You cannot delete the Default project.

Sharing assets across projects
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You can share integrations and document types across projects by clicking the vertical ellipses
icon available on a project and selecting the Share Assets option. Click “here” on page 98 for
more information.

Asset Types specific to a project or is shared across all projects

The following table lists the asset types and identifies whether the asset type is specific to a project
or is shared across all projects.

Note:
On-premises applications are stored globally when uploaded to Integration Cloud. They can
be referenced by any project while creating integrations. The same global principle applies to
predefined applications, predefined operations, and recipes. REST Applications, SOAP
Applications, Flat FileApplications and theAccounts andOperations created for theApplications
are contained within a project.

RemarksLocationAsset Type

Shared across all projectsGlobalPredefined Applications

Project specificProjectREST Applications

Shared across all projectsGlobalOn-Premises Applications

Project specificProjectSOAP Applications

Project specificProjectFlat File Applications

Project specificProjectAccounts

Project specificProjectOperations - Custom

Shared across all projectsGlobalOperations - Predefined

Project specificProjectKeys & Certificates

Project specificProjectSFTP Application

Project specificProjectFTP Application

Project specificProjectIntegrations

Project specificProjectDocument types
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RemarksLocationAsset Type

Project specificProjectREST APIs

Project specificProjectSOAP APIs

Project specificProjectReference data

Shared across all projectsGlobalRecipes

Project Permissions

Aproject is an independent entity and corresponds to a folder for organizing your assets. A project
holds all the assets created as a part of that project by the logged-in user, along with the
configurations associated with the assets. Project permissions are used to associate permissions
with projects.

You associate permissions with projects from the Settings  > Project Permissions > Add New
Project Permission page.

Integration Cloud provides a system-generated Developer project permission profile in your
tenant. Any newproject created is automatically associatedwith theDeveloper project permission
profile. This profile has permissions to create, update, delete, and execute all assets. You cannot
edit or delete this system-generated project permission profile. If a project permission profile is
associated with a user on the user profile page, the user can perform only the permitted tasks in
the mapped project.

If you are an existing tenant:

Your user's Access Profile controls global permissions as well as permissions for the Default
project.

Your user's Project Permissions profile control permissions for other projects.

All existing user profiles will be associated with the Developer project permission profile.

All projects created have the Developer project permission profile associated with it.

All existing assets will be available in the Default project.

Manage the permissions for existing assets inside the Default project from the Project
Permissions for Default Project section under Settings  > Access Profiles > Administrative
Permissions.
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Manage the permissions for new assets created inside the Default project from the Project
Permissions for Default Project section under Settings  > Access Profiles > Administrative
Permissions.

If you create a new project, you have to assign the project permissions from the Settings  >
Project Permissions > Add New Project Permission page.

If you are a new tenant:

The Default project is not available. There are no existing assets. Your user's Access Profile
controls only global permissions.

The Administrator will be associated with the Developer project permission profile and can
assign a project permission profile to a new user.

All projects created have the Developer project permission profile associated with it.

If you create a new project, you have to assign the project permissions from the Settings  >
Project Permissions > Add New Project Permission page.

Once you log in, from the IntegrationCloudnavigation bar, click Settings  > Project Permissions

> Add New Project Permission. Select a project and then click the add icon to add the project
in the panel. Then assign the relevant permissions to the selected project . You can select another
project and assign the permissions to the selected project. Click Add.

Note:
Integration Execute permission available as part of Project Permissions are applicable only
for top-level projects. For example, if you have the Integration Execute permission for project
B but not for project A, and have shared assets of project Awith project B, thenwhen you execute
an integration of project B which has an integration of project A, the integration execution will
be successful.

Note:
If you associate the project permission profile to a user on the user profile page, the user can
perform only the permitted tasks in each mapped project.

Example 1

Auser is assigned to two project permission profilesA and B in the user profile. Project permission
profile A has the Execute Integration permission in Project X but Project permission profile B does
not have the Execute Integration permission for the same Project X. The user will still be able to
execute the Integration.

Example 2
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In this example, we will see how you will allow an existing user U1 to create, update, delete, and
execute Integrations for the Project P1 but not for Project P2.

1. You must have the Access Control permission under Access Profiles > Administrative
Permissions.

2. Create Project P1 and Project P2.

3. Create a new Project Permission profile PP1 under Settings > Project Permissions > Add
New Project Permission.

4. On the Add New Project Permission page, add Project P1 in the mapped projects list. Assign
the create, update, delete, and execute Integration permissions to the mapped Project P1.

5. Do not map Project P2.

6. Go to the Basic tab of user U1 and select only PP1.

So when U1 logs in, U1 will only be able to create, update, delete, and execute Integrations for the
Project P1 but not for Project P2.

Sharing Assets across Projects

You can share integrations and document types available in one project with other projects from
the Projects page. Sharing of assets allows you to use the same assets in other projects.

Note:
Sharing assets with other projects is allowed only in the Development stage. If an integration
in a shared project has applications, then you can configure the account only in that shared
project. You must have the Administrator access profile privileges to share assets.

You can share assets available in a project by clicking the vertical ellipses icon on a project and
then clicking the Share Assets option as shown.

In the Share Assets of project name dialog box, after you select the project Z and add the project,
the assets of Project is shared with Z after you click Apply.
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While creating an integration, the Integrations category available on the left panel lists all the
shared projects and the integrations available in the shared projects alongwith the integrations
available in the same project.

While creating an integration and defining the input and output signature by clicking the I/O
icon, you can select the shared project in the Project drop-down list in the Define Input and
Output Signature dialog box. All document types available in the shared project appear in
the Document Reference drop-down list.

While adding a new field with Type as Document Reference, in the Document Reference
dialog box, you can select the shared project.

While creating a new document type from scratch, in the Field Properties panel, if you select
the Type asDocument Reference, then in theDocument Referencedialog box you can select
the shared project.

While mapping fields in the pipeline, in the Field Properties panel, if you select the Type as
Document Reference, then in the Document Reference dialog box you can select the shared
project.

Let us see how asset sharing works and its behavior with the help of an example. In this example,
we will share assets of project A with project B.

1. In the Development stage, go to the Projects page. Project A has only one integration.
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The name of the integration in project A is testA.

2. If you want to share testA with project B, click the vertical ellipses icon on project A, and then
click Share Assets.

3. On the Share assets of A dialog box, select project B from the drop-downmenu, click the add

icon , and then click Apply.
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4. After you click Apply, go to project B and create an integration in project B. Project A appears
under the Integrations category on the left panel along with its shared asset testA.

The display format is project name integration name .
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5. While creating an integration in project B, to define the input and output signature, click the
I/O icon and in the Define Input and Output Signature dialog box, select project A. All
document types available in project A appear in the Document Reference drop-downmenu.

102 Integration Cloud 6.6.0

4 Projects, Permissions, Sharing Assets



6. While adding a new field, select the Type as Document Reference. Select project A. All
document types available in project A appear in the Document Reference drop-downmenu.

7. While mapping fields in the pipeline, add a new field. In the Field Properties panel, select
the Type as Document Reference. Then in the Document Reference dialog box, select the
shared project A.

8. While creating a new document type from scratch, in the Field Properties panel, if you select the
Type as Document Reference, then in the Document Reference dialog box, select project A.
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9. Project B has an integration testB. Click the Show Advanced View option to view the Uses
column. The Uses column displays the references in the format project name/referenced asset
name that are used to create the integration.

Click the icon to view the Overview page.

On the Overview page, click the Uses icon .
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The Uses window displays the shared project A and the integration testA in the project
name/integration name format.

Also, on the integrations list page, click Show Advanced View to view theUses column,which
displays the references that are used to create the integration in the format project name/referenced
asset name.

10. If you use integration testA of projectA in the integration testB of project B, and if you deploy
the integration testB to another stage, then projectA along with integration testA is deployed
to that stage.

Note:
IntegrationExecute permission available as part ofProject Permissions (Settings > Project
Permissions) are applicable only for top-level projects. For example, if you have the
integration Execute permission for project B but not for project A, but have shared assets
of project A with project B, then when you execute an integration of project B which has an
integration of project A, the integration execution will still be successful.
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Overview

Integration Cloud allows you to create and govern Integrations between Software as a Service
(SaaS) or on-premises applications. A set of predefined and configurableApplications are provided,
for example, Salesforce, StrikeIron, ServiceNow, and so on. Applications allow you to connect to
the particular SaaS providers.

You create REST, SOAP, Flat File, FTP/FTPS, SFTP, and SMTP Applications from this page. To
create a REST Application, click Projects > <Select a Project> > Applications > REST
Applications > Add New Application.To create a SOAP Application, click Projects > <Select a
Project> > Applications > SOAP Applications > Add New Application. To create a Flat File
Application, click Projects > <Select a Project> > Applications > Flat File Applications > Add
New Application. FTP/FTPS, SFTP, and SMTP Applications are available under Predefined
Applications that allow Integration Cloud to connect to FTP/FTPS, SFTP, and SMTP servers.

On-Premises Applications loaded from on-premises systems are also listed in the Applications >
On-Premises Applications page but you will not be able to create Accounts or Operations for
on-premises Applications. Those can be uploaded only from webMethods Integration Server.
Further, when you upload services as part of an Application from on-premises webMethods
Integration Server towebMethods IntegrationCloud, the comments field of the service is uploaded
and displayed in the webMethods Integration Cloud Application. This field will be displayed if
present and cannot be edited. See the Configuring On-Premise Integration Servers for webMethods
Cloud document for more information.

From theApplication category page, you can create Accounts and Operations for an Application
and Integrations between different SaaS applications. For an Application, click Accounts,
Operations, or Integrations if you want to create or edit them for that Application. For REST
Applications, the Documents Types link appears and allows you to create newDocument Types.
Document Types created for a REST Application appear only in the Document Types panel for
the selected REST Application.

If you have the required access privileges under Settings  > Access Profiles > Administrative
Permissions > Functional Controls > Application, you can upgradeApplication assets (Accounts,
Operations, and the associated Integrations) from a lower version to a higher version by clicking
the Upgrade button.
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To use an Application, you are required to agree to the summary of terms. Click I agree to use
the Application. Click I do not agree if you disagree with the summary of terms and do not want
to use the Application. Click Cancel to go back to the Applications page.

Note:
Users who have the required project permissions under Settings  > Project Permissions can
create, update, delete and execute the Integrations, Accounts, Operations, Reference Data,
Document Type, and Listeners information.

Predefined Applications

Aset of predefined and configurableApplications are provided, for example, Salesforce, StrikeIron,
ServiceNow, and so on. These Applications allow you to connect to the particular SaaS providers.

Note:
It is recommended to use secured protocols such as HTTPS and FTPS for securing the data
transmitted over the network.

Applicability Statement 2 (AS2)
Applicability Statement 2 (AS2) is a communication protocol developed by the Internet Engineering
Task Force (IETF) for the exchange of business-to-business (B2B) transactions over the Internet
securely. The AS2 application uses the HTTP transport protocol alongwithMultipurpose Internet
Mail Extensions (MIME). The AS2 application governs the means of connection and exchange of
data securely and reliably. Besides the advanced security features, the AS2 application offers the
following additional benefits:

Privacy

Authentication

Nonrepudiation of origin and receipt of the message

Data integrity

The AS2 application provides a medium to exchange business data with partners by configuring
an account in Integration Cloud. The application supports the AS2 protocol versions 1.1 and 1.2.

DescriptionField

The endpoint URL of the recipient.Recipient Endpoint

The type of HTTP authorization scheme to use for the
connection. You can choose one of the following options:

Authorization Type

none: No additional authorization schemewill be executed
at run time. For example, when you specify a user name
and password, but do not specify a value for the
authorization type, the user credentials are not inserted into
an authorization header.

Integration Cloud 6.6.0 109

5 Applications



DescriptionField

basic:When the application requires or supportsHTTPbasic
authentication for user name and password.

The AS2 ID of the sender.From

The AS2 ID of the recipient.To

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back end.

Response Timeout

In case the network is slow or the back end processing takes
longer than usual, increase the Response Timeout value. It is
recommended to specify a value other than 0. If you specify 0,
Integration Cloud will wait indefinitely for a response.

The number of times Integration Cloud attempts to connect to
the back end to read a response if the initial attempt fails. If an

Retry Count on Response
Failure

I/O error occurs, it will retry only if you have selected the Retry
on Response Failure option.

Whether IntegrationCloud should attempt to resend the request
when the response has failed, even though the request was sent

Retry on Response Failure

successfully. Select this option if you want to re-establish the
connection.

Select the alias name of the Integration Cloud trust store
configuration from the list. The trust store contains trusted

Trust store Alias

certificates used to determine trust for the remote server peer
certificates. SelectAdd New Truststore to add a new trust store
from this list.

Select the alias for the Integration Cloud keystore configuration.
This is a text identifier for the keystore alias. A keystore file

Keystore Alias

contains the credentials (private key/signed certificate) that a
client needs for authentication. Select Add New Keystore to
add a new keystore from this list.

Alias to the private key in the keystore file specified in the
Keystore Alias field. The outbound connections use this key to

Client Key Alias

send client credentials to a remote server. To send the client’s
identity to a remote server, you must specify values in both,
Keystore Alias and Client Key Alias fields.

Select a hostname verifier implementation for guards against
man-in-the-middle (MITM) attacks from the list. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier. This enables
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier from the
list to disable hostname verification.
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DescriptionField

The name of the user account that the AS2 connection will use
to connect to the AS2 provider.

Username

The password for the user name provided in the Username
field.

Password

Select this option to compress an outbound AS2 message.Compression

Select this option to sign an outbound AS2 message.Sign Message

The signing algorithm to use for an outbound AS2 message.
The available options are:

Signing Algorithm

MD5

SHA-1

SHA-256

SHA-384

SHA-512

The keystore aliases and the key aliases in the keystore to use
for signing an outbound AS2 message.

Signing Keystore and Key
Aliases

Select this option to receive a signed inbound AS2 message. If
you select this option and the incoming AS2 message is not

Receive Signed Message

signed, then an Insufficient message security error is
encountered and shared with the sender if MDN is requested
by the sender.

The certificate to use for verifying an inbound signed AS2
message.

Signature Verification
Certificate

Select this option to encrypt an outbound AS2 message.Encrypt Message

The encryption algorithm to use for an outboundAS2message.
The available options are:

Encryption Algorithm

RC2 40

RC2 64

RC2 128

DES

TripleDES

AES 128

AES 192
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DescriptionField

AES 256

The certificate to use for encrypting an outboundAS2message.Encryption Certificate

Select this option to receive an encrypted inboundAS2message.
If you select this option and the incoming AS2 message is not

Receive Encrypted Message

encrypted, then an Insufficient message security error is
encountered and shared with the sender if MDN is requested
by the sender.

The keystore aliases the key aliases in the keystore to use for
decrypting an inbound AS2 message.

Decryption Keystore and Key
Aliases

Whether youwant the recipient to return anMDN to the sender.Request MDN

You can select one of the following options:

None: The recipient of the AS2 message does not return an
MDN to the sender.

Synchronous: The recipient of the AS2 message returns an
MDN to the sender through the sameHTTP connection used
to send the original AS2 message.

Asynchronous: The recipient of the AS2 message returns
anMDN to the sender through a differentHTTP connection
instead of the one used to send the original AS2 message.

Select this option if youwant the recipient to sign anAS2MDN.Request Signed MDN

Ensure that you also select an option in the Request MDN field
if you want the recipient to sign and return an AS2 MDN.

Type your endpoint URL that accepts an inbound AS2 MDN if
you selected the Asynchronous option for Request MDN.

Asynchronous MDN Endpoint

Select the AS2 protocol version to use from the list.AS2 Version

ServerName Indication (SNI) is an extension to the TLS protocol
by which a client indicates which host name it is attempting to

Enable SNI

connect to at the start of the handshaking process. Enable this
option if the SaaS provider offers SNI-based TLS connectivity,
and if you want to connect to an SNI enabled SAAS provider
to send the host name specified in the Server URL field, as part
of the TLS SNI Extension server_name parameter.

If you want to explicitly specify a host name to be included as
a part of the SNI extension server_name parameter, in case the

SNI Server Name

host name is other than the host name specified in the Server
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DescriptionField

URL field, specify the host name value in the SNI Server Name
field.

AS2 Predefined Operations

The following predefined Applicability Statement 2 (AS2) operations are available:

receive

Receives an AS2 message from a recipient.

You can perform the following configurations in the AS2 application using the receive service.

“Configuring the Auto Detect Option” on page 117

“Creating an Endpoint URL” on page 117

Input Parameters

Object Receives an AS2 message of content type other than
application/xml.

contentStream

Object Optional. Receives an AS2 message of content type
application/xml only.

node

Output Parameters

String Status of an inbound message.status

String Processing status of an inbound message.statusMessage

Document Receives the raw stream, extracted payload, and attachments of an
inbound message.

request

Object Raw output stream received by an application.stream

Document AS2 message headers.headers

String AS2 ID of the recipient.AS2-To

String AS2 ID of the sender.AS2-From

StringMessage ID of the inbound message.Message-ID

String AS2 protocol version used for the
inbound message.

AS2-Version
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StringMIME content type of the inbound
message.

Content-Type

String Optional features supported by the
application.

EDIINT-Features

String Optional. Sender's asynchronous
MDN endpoint URL.

Receipt-

Delivery-Option

String Optional. Acknowledgment request
for the inbound message.

Disposition-

Notification-To

String Optional. Acknowledgment request
to be signed for the inbound message.

Disposition-

Notification-Options

Document Extracted payload that you receive.payload

Object Extracted payload stream.stream

StringContent type assigned to the payload.contentType

DocumentHeaders assigned to the payload.headers

Document Array Optional. Attachments you receive with an
inbound message, if any.

attachments

Object Output stream of the attachment.stream

String Content type assigned to the
attachment.

contentType

DocumentHeaders assigned to the
attachment.

headers

Document Sent MDN or received asynchronous MDN response.response

String Status of the sent or received MDN.status

String Status message of the sent or received MDN.statusMessage

Document Optional. Sent or received MDN.receipt

ObjectObject stream of the sent or received
MDN.

stream

DocumentHeaders of the sent or received
MDN.

headers

String AS2 ID of the
recipient.

AS2-To

String AS2 ID of the sender.AS2-From
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StringMessage ID of the
inbound or outbound MDN.

Message-ID

String AS2 protocol version
used for the inbound or
outbound MDN.

AS2-Version

StringMIME content type of
the inbound or outbound
message.

Content-Type

send

Sends an AS2 message to a recipient's defined endpoint.

Input Parameters

Document Payload you want to send.data

Object java.io.InputStream object you want map
from EDI or XML data.

stream

String Content type to assign to an outbound
message. The following options are available by
default:

contentType

application/edi-x12

application/edifact

application/xml

You can also type a custom value.

Document Optional. key and value strings of the
header for an outbound message.

otherHeaders

Document Array Optional. Attachments for a message, if any.attachments

Object java.io.InputStream object you want add
to the attachment.

stream

String Content type of the attachment. For
example, application/zip if the attachment is a
.zip file.

contentType

Document Optional. key and value strings of the
header you want to add to the attachment.

otherHeaders

DocumentOptional. Customheaders youwant to include in anAS2message.customHeaders
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String Key for the custom header.key

String Value for the customer header.value

Output Parameters

String Status of an outbound message.status

String Processing status of an outbound message.statusMessage

Document AS2 message sent to a recipient.request

Object AS2 message stream.stream

Document Optional. AS2 message headers.headers

String AS2 ID of the recipient.AS2-To

String AS2 ID of the sender.AS2-From

StringMessage ID of the outbound
message.

Message-ID

String AS2 protocol version used for the
outbound message.

AS2-Version

StringMIME content type of the outbound
message.

Content-Type

String Optional features supported by the
application.

EDIINT-Features

String Optional. Recipient's asynchronous
MDN endpoint URL.

Receipt-

Delivery-Option

StringOptional. Acknowledgment request
for the outbound message.

Disposition-

Notification-To

StringOptional. Acknowledgment request
to be signed for the outbound message.

Disposition-

Notification-Options

Document Received MDN response.response

String Status of the received MDN.status

String Status message of the received MDN.statusMessage

Document Optional. Received MDN.receipt

ObjectObject stream of the receivedMDN.stream
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Document Optional. Headers of the
received MDN.

headers

String AS2 ID of the
recipient.

AS2-To

String AS2 ID of the
sender.

AS2-From

StringMessage ID of
the inbound MDN.

Message-ID

String AS2 protocol
version used for the
inbound MDN.

AS2-Version

StringMIME content
type of the inbound
message.

Content-Type

Configuring the Auto Detect Option

You can select theAuto Detect option for theAS2 application to automatically identify an account
based on the AS2-From and AS2-To headers of an inbound message.

This option enables the AS2 application to compare an account configured with From and To
fields with theAS2-From andAS2-To headers of an inboundmessage and vice versa. In addition,
specifying this option allows the use of an individual endpoint URL with multiple partners.

Note:
Auto Detect option is supported only for the receive operation.

Important:
Configuring multiple accounts with identical values for the From and To fields might generate
unpredictable results. This happens when the application uses the account that matches the
first AS2-From and AS2-To headers of an inbound message. Therefore, if you have multiple
accounts configured with identical values for the From and To fields, then do not select the
Auto Detect option.

Creating an Endpoint URL

Asender requires a recipient's endpointURL to transferAS2messages. Youmust create an endpoint
URL and share it with your partner to send AS2 messages to the endpoint URL.

To create an endpoint URL

1. Create an orchestrated integration. For instructions, see “Orchestrated Integrations” onpage 387.
Ensure that you specify a signature with contentStream and node as input parameters of type
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Object. For instructions, see “Pipeline and Signatures” on page 400. Ensure you specify a name
for the integration.

Alternatively, you can define a Document Type as a signature with contentStream and node as
input parameters of typeObject. For instructions, see “Creating Document Types from
Scratch” on page 637.

2. Configure the AS2 application with the receive operation to work with a new or existing
account, or select the Auto Detect option for the application. For information about accounts
and configuring an account using theAuto Detect option, see “Adding or EditingAccounts” on
page 362 and “Configuring the Auto Detect Option” on page 117 respectively.

3. Map the contentStream and node parameters of the Pipeline Input signature defined in step 1
with the AS2 application's receiveInput parameter. For more information, see “Pipeline and
Signatures” on page 400.

4. Select the Enable Integration to be invoked over HTTP option for the integration. For more
information, see “Integration Details” on page 408.

An endpoint URL for this integration is generated. Share this endpoint URLwith your partner
to enable the partner to send AS2 messages.

Alfabet
Integration Cloud connects to Alfabet using the Interface for RESTful Web Services and supports
working with the various object types as defined in Alfabet. You can use it to query, retrieve,
create, update, and delete objects of any type, and also manage relations between the objects.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. This is the native provider endpoint target for the Account

Server URL

configuration. The URL depends on where the required instance of
Alfabet is installed. It is possible to either include or omit the endpoint
suffix “/Alfabet/api/vXX” in the URL. For example, both these options
are equivalent:

https://myalfabet.com

https://myalfabet.com/Alfabet/api/v1

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.
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The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

The Alfabet Authorization Token as defined in the web.config file of
theAlfabetWebApplication on the server side, under the <alfaSection>
element.

Authorization
Token

Note:
See the Authorization chapter in the Alfabet Interface for RESTful
Web Services reference manual for required configurations in the
server side for Alfabet and for details about the different
authorization modes.

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.
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If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

The keep alive interval in milliseconds defines the interval for which
a connection will be kept alive, if the back end does not respond with

Keep Alive
Interval

a Keep-Alive header. A value > 0 keeps the connection alive for the
specified value. The default value of -1 implies that the connection will
be kept alive until a request fails due to a connection error.

The idle timeout interval in milliseconds defines the interval for which
a connection will be kept alive if it's not in use. A value > 0 keeps the

Idle Timeout

connection alive for the specified value. The default value of -1 implies
that the connection will be kept alive until a request fails due to a
connection error.

The encoding to use for theHTTPmessage components, such as request
line and headers.

Element
Character Set

The number of milliseconds that the client connection should wait for
a 100 Continue response from the server when the Expect/Continue
handshake is used.

Wait For
Continue Time

Whether the connection validates theHTTP Transfer Encoding header.Strict Transfer
Encoding

Valid values:

true: The connection validates the Transfer Encoding header and returns
an error when the header is invalid.

false: The connection does not validate the Transfer Encoding header.

Amazon DynamoDB
Integration Cloud connects to Amazon DynamoDB using the REST interface and allows you to
create a database table that can store and retrieve any amount of data, and serve any level of
request traffic.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://dynamodb.<instance>.amazonaws.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
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value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

This is a username. It is an alphanumeric text string that uniquely
identifies the user who owns the account. No two accounts can have
the same Access Key.

Access Key

This key plays the role of a password. It is called secret because it is
assumed to be known only by the owner. When you type the secret
key, it is displayed as an asterisk or dots.

Secret Key

An area specific value.Region

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
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the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Amazon Kinesis
Amazon Kinesis is a managed service that scales elastically for real-time processing of streaming
big data. Themost commonAmazonKinesis use case scenario is rapid and continuous data intake
and aggregation.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://kinesis.<Region>.amazonaws.com.

Server URL

This is a username. It is an alphanumeric text string that uniquely
identifies the user who owns the account. No two accounts can have
the same Access Key.

Access Key

This key plays the role of a password. It is called secret because it is
assumed to be known only by the owner. When you type the secret
key, it is displayed as an asterisk or dots.

Secret Key

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
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org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

An area specific value.Region

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Amazon Simple Storage Service (S3)
Integration Cloud connects to Amazon Simple Storage Service (S3) using the REST interface and
provides read, write, and delete access to the Amazon S3 buckets and objects within the Amazon
instance.
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Provide the login endpoint to initiate communicationwith
the SaaS provider. Example: https://s3.amazonaws.com/.

Server URL

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back

Response Timeout

end. In case the network is slow or the back end processing
takes longer than usual, increase the Response Timeout
value. It is recommended to specify a value other than 0.
If you specify 0, Integration Cloud will wait indefinitely
for a response.

If enabled, additional processing is performed to test if the
socket is still functional each time the socket is used.

Use Stale Checking

This field is used in conjunction with the Use Stale
Checkingfield to control the period of inactivity afterwhich

Validate After Inactivity

persistent connections must be revalidated prior to being
leased. This field is considered only if the Use Stale
Checking field is enabled, else this field is ignored.

The number of times IntegrationCloud attempts to connect
to the back end to read a response if the initial attempt fails.

Retry Count on Response
Failure

If an I/O error occurs, it will retry only if you have selected
the Retry on Response Failure option.

Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure

requestwas sent successfully. Select this option if youwant
to re-establish the connection.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which
will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore alias.

Keystore Alias

Akeystore file contains the credentials (private key/signed
certificate) that a client needs for authentication. You can
also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the
Keystore Alias field. The outbound connections use this

Client Key Alias

key to send client credentials to a remote server. To send
the client’s identity to a remote server, you must specify
values in both the Keystore Alias and the Client Key Alias
fields.
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Whether to use the Expect/Continue HTTP/1.1 handshake
and send the Expect request header. When the client sends

Use Expect Continue

the Expect request header, the client waits for the server to
confirm that it will accept the request, before the client
sends the request body. Enable this option to use the
Expect/Continue handshake.

Enable this option if you want to send or receive a large
binary stream with a chunk size of 8192 bytes. This is

Use Chunking

applicable only if the back end supports HTTP/1.1
chunking.

This is a username. It is an alphanumeric text string that
uniquely identifies the userwho owns the account. No two
accounts can have the same Access Key.

Access Key

This key plays the role of a password. It is called secret
because it is assumed to be knownonly by the owner.When

Secret Key

you type the secret key, it is displayed as an asterisk or
dots.

An area specific value.Region

Explicitly select the signing algorithm, for example,
HMAC-SHA1 Signatures used to sign the message.

Signing Algorithm

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it is

Enable SNI

attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If youwant to explicitly specify a host name to be included
as a part of the SNI extension server_name parameter, in

SNI Server Name

case the host name is other than the host name specified in
the Server URL field, specify the host name value in the
SNI Server Name field.

Amazon Simple Notification Service(SNS)
Integration Cloud connects to Amazon SimpleNotification Service (Amazon SNS) using the REST
interface and allows you to publishmessages anddeliver them to subscribers and other applications.
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The endpoint to connect with AWS SNS. Prefix the endpoint with
https://, for example, https://sns.(Region).amazonaws.com. This is the
native provider endpoint target for the Account configuration.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

AccessKey obtained fromAWS Identity andAccessManagement (IAM)
Console. This is a username. It is an alphanumeric text string that

Access Key

uniquely identifies the user who owns the account. No two accounts
can have the same Access Key.

Secret key obtained fromAWS Identity andAccessManagement (IAM)
Console. This key plays the role of a password. It is called secret because

Secret Key

it is assumed to be known only by the owner.When you type the secret
key, it is displayed as an asterisk or dots.

An area specific value. The region is different for different users.Region
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Explicitly select the signing algorithm, for example, HMAC-SHA1
Signatures used to sign the message.

Signing
Algorithm

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Amazon Simple Queue Service (SQS)
Integration Cloud connects to Amazon Simple Queue Service (SQS) using the REST interface and
provides access to the SQS objects within the Amazon instance.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://sqs.us-east-1.amazonaws.com/.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure
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Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

This is a username. It is an alphanumeric text string that uniquely
identifies the user who owns the account. No two accounts can have
the same Access Key.

Access Key

This key plays the role of a password. It is called secret because it is
assumed to be known only by the owner. When you type the secret
key, it is displayed as an asterisk or dots.

Secret Key

An area specific value.Region

Explicitly select the signing algorithm, for example, HMAC-SHA1
Signatures used to sign the message.

Signing
Algorithm

Note:
This field is not applicable for Amazon SQS Version 4.

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name
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DescriptionField

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

CloudStreams Connector for Anaplan
®

Using the REST interface, CloudStreams Connector for Anaplan® allows you to interact with data
in yourmodels and securely upload files, download files, import and export data, and run actions
programmatically.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL would be of the format:
http://host:port.

Server URL

Replace < host:port > with your actual JIRA instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

The name of the user account on the SaaS provider that the connection
will use to connect to the SaaS provider.

Username

The password for the user name provided in the Username field.Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header.

If you enter the username and password, then set the authorization
type as basic . Basic refers to HTTP Basic Authentication. This option
can be used if the Application requires or supports HTTP Basic
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DescriptionField

authenticationusing ausername andpassword. Select theAuthorization
Type as basic.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Apache Solr Search
Solr is an open source enterprise search platform built on Apache Lucene. Solr is a standalone
enterprise search server with a REST-like API. You can place documents in it (called "indexing")
using JSON, XML, CSV, or binary over HTTP. You can query it using HTTP GET and receive
JSON, XML, CSV, or binary results. Integration Cloud connects to Apache Solr using the REST
API Version 6.1 and allows you to execute search operations over the indexed data.
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Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL would be of the format:
https://<hostName>.

Server URL

Replace <hostName> with your actual back end system server URL
hosting Apache Solr as the search engine.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Username received from the back end system hosting Apache Solr as
the search engine.

Username

This is the password received from the back end systemhostingApache
Solr as the search engine.

Password

Apache Solr REST APIs use Basic Authentication. The Username and
Password is passed when you invoke any of the REST API endpoints.

Authorization
Type

This is the type ofHTTP authorization scheme to use for the connection.
If you select none, no additional authorization schemewill be executed
at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic.
Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
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DescriptionField

hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Avalara AvaTax
Integration Cloud connects to Avalara AvaTax using the Avalara SOAP API and allows you to
calculate taxes, modify documents, and validate addresses.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://<instance_name>.avalara.net, where
<instance_name> represents the actual instance name.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.
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The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SaaS provider that the Account
will use to connect to the SaaS provider.

Username

Provide a password for the user name provided in the Username field
to initiate communication with the SaaS provider.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic.
Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password.

Client application name and version. This should uniquely identify the
software client that is calling the AvaTax service.

clientname

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
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server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Atlassian Jira
Integration Cloud connects to JIRA using the Interface for RESTful Web Services. You can use it
for bug tracking, issue tracking, and project management functions.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL would be of the format:
http://host:port.

Server URL

Replace < host:port > with your actual JIRA instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

User name of the JIRA account.Username

Password of the JIRA account.Password
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The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic .
Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password. Select the Authorization Type as basic.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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Cloud Deployment and webMethods Cloud Container
Use this Application to invoke Java and Flow services for any Cloud Deployment solution.

DescriptionField

Select the user name you want Integration Cloud to use while running
the cloud deployment service. Integration Cloud runs the service as if

Run As

the user you specify is the authenticated user that invoked the service.
If the service is governed by an Access Control List, be sure to specify
a user that is allowed to invoke the service.

Note:
You must map the selected user's Access Profile to a webMethods
Integration Server user group (Settings  > Access Profiles > Select
an Access Profile > Solution Permissions), else youwill not be able
to view, edit, or run webMethods Integration Server services in a
solution.

Select the stage where the cloud deployment services are available.Stage

webMethods Cloud Container

Use this Application to invoke Java and Flow services for any Cloud Container solution.

DescriptionField

The cloud server URLwhere your on-premises assets are
deployed, for example,
https://{sub-domain}.{domain-name}.{domain-suffix}.

Server URL

User name for the account on the cloud server.User Name

The password for the specified user.Password

The number of milliseconds Integration Cloud waits for
a response before canceling its attempt to connect to the

Response Timeout

back end. In case the network is slow or the back end
processing takes longer than usual, increase the Response
Timeout value. It is recommended to specify a value other
than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

Cloud Deployment Operations

Integration Cloud Integrations can invoke Cloud Deployment solution webMethods Integration
Server Java and Flow services for the same tenant, by using the “Cloud Deployment” on page 136
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Application. You can use these services along with other Integrations and services, both in
Orchestration and Point-to-Point Integrations.

Note:
The Cloud Deployment Application appears under the Predefined Applications category.

To import CloudDeployment solutionwebMethods Integration Server services, do the following:

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Applications
> Predefined Applications > Cloud Deployment. TheCloud DeploymentApplication details
page appears.

2. SelectAccounts > Add New Account to create a new“CloudDeployment account” onpage 136.

3. Click Operations.

4. Click Import Operations if you want to import multiple Java or Flow services. If any of the
services have a Document Reference in its input/output signature, then those services will not
be imported. To import those services, select Add new Operation and import those services
individually.

5. If you click Import Operations, the Import Operations windowwill appear. Select the cloud
deployment account, and then select the services that youwant to import in IntegrationCloud.

6. Click Import. The services will appear on the Operations list page for the Cloud Deployment
Application.

Note:
Importing will copy the metadata of the services in Integration Cloud. After import, you
can use the operation in an Integration. The operation execution happens on the Cloud
Deployment solution webMethods Integration Server.

CloudStreams Connector for Microsoft Azure Cosmos DB
Integration Cloud connects to Microsoft Azure Cosmos DB and provides access to Microsoft's
fully managed NoSQL database. You can use this Application to create, query, and manage
resources in a NoSQL database.

DescriptionField

The login endpoint to initiate communication with the SaaS provider.
For example, for the CloudStreams Connector for Microsoft Azure

Server URL

Cosmos DB, the end point URL will be of the format:
https://<accountName>.documents.azure.com:443/.

Replace <accountName>with the nameof yourMicrosoftAzureCosmos
DB account.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
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increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

The Access key token that contains the secret of the account required
by the SaaS provider.

Access Key

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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webMethods CloudStreams Connector for Microsoft Azure Data
Lake Store
Integration Cloud connects to CloudStreamsConnector forMicrosoft AzureData Lake Store using
the REST API and allows you to manage File System resources through the Hadoop Distributed
File System ( HDFS) API. You can create directories, folders, and files in your Azure Data Lake
Store instance that can store and retrieve data.

DescriptionField

Provide the login endpoint to initiate communication with
the SaaS provider. For example, the end point URL is of the

Server URL

format:
https://<yourstorename>.azuredatalakestore.net/webhdfs/v1.
Replace <yourstorename>with your actualMicrosoft Azure
Data Lake Store account.

Also referred to as the Client ID, this is a client identifier
issued to the client to identify itself to the authorization
server.

Consumer ID

This token is used for authentication and is issued by the
Authorization Server. To get the Access Token, you first

Access Token

need to have an Azure subscription. Then create an Azure
Active Directory native application. See End-user
authentication with Data Lake Store using Azure Active
Directory on how to create it. Successful authenticationwill
provide an access token and a refresh token. The access
token gets attached to each requestmade toData Lake Store
and is valid for one hour by default. The refresh token can
be used to obtain a new access token and is valid for two
weeks by default, if used regularly.

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back

Response Timeout

end. In case the network is slow or the back end processing
takes longer than usual, increase the Response Timeout
value. It is recommended to specify a value other than 0. If
you specify 0, Integration Cloud will wait indefinitely for
a response.

The number of times Integration Cloud attempts to connect
to the back end to read a response if the initial attempt fails.

Retry Count on Response
Failure

If an I/O error occurs, it will retry only if you have selected
the Retry on Response Failure option.

Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure
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DescriptionField

request was sent successfully. Select this option if you want
to re-establish the connection.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore alias.

Keystore Alias

A keystore file contains the credentials (private key/signed
certificate) that a client needs for authentication. You can
also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the
KeystoreAlias field. The outbound connections use this key

Client Key Alias

to send client credentials to a remote server. To send the
client’s identity to a remote server, you must specify values
in both the Keystore Alias and the Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which
will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification.

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it is

Enable SNI

attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If you want to explicitly specify a host name to be included
as a part of the SNI extension server_name parameter, in

SNI Server Name

case the host name is other than the host name specified in
the Server URL field, specify the host name value in the SNI
Server Name field.

Enable this option if you want to send or receive a large
binary stream with a chunk size of 8192 bytes. This is
applicable only if the back end supportsHTTP/1.1 chunking.

Use Chunking

Also referred to as the Client Secret, this is a secretmatching
to the client identifier.

Consumer Secret

A token used by the client to obtain a new access token
without involving the resource owner.

Refresh Token

This is the provider specificURL to refresh anAccess Token.Refresh URL
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CloudStreams Connector for Microsoft Azure Storage
Integration Cloud connects to Microsoft Azure Storage and allows you to store, load, and query
data. It includes a set of storage services, such as, Blob storage (object storage) for unstructured
data, File storage for SMB-based cloud file shares, Table storage for NoSQL data, and Queue
storage to reliably store messages.

DescriptionField

The login endpoint to initiate communication with the SaaS provider.
For example, for the CloudStreams Connector for Microsoft Azure

Server URL

Storage, the end point URL will be of the format:
https://<accountName>.

Replace <accountName>with the nameof yourMicrosoftAzure Storage
account.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.
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DescriptionField

Microsoft Azure Storage RESTAPIs use SharedKey for authentication.
Type the Access key that contains the secret of your Microsoft Azure
Storage account.

Access Key

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

CloudStreams Connector for NetSuite
TM

Integration Cloud connects to NetSuiteTM SuiteTalk platform using the SuiteTalk web services.
It provides programmatic access to NetSuiteTM data related to accounting, order
management/inventory, CRM,professional services automation (PSA), and eCommerce applications
through operations like addList, get, updateList, upsertList, and deleteList.

The NetSuite SOAP Web Service Application for v2018_2 uses the Token Based authentication
mechanism.With each request, Integration Cloud calculates the signature, and the token passport
details are sent as part of the request headers.

DescriptionField

Provide the login endpoint to initiate communication
with the SaaS provider. This is the native provider

Server URL

endpoint target for the Account configuration. You
may need to specify the correct URL for your exact
instance, for example,
https://webservices.netsuite.com/services/NetSuitePort_2018_2.

The number of milliseconds Integration Cloud waits
for a response before canceling its attempt to connect

Response Timeout

to the back end. In case the network is slow or the back
end processing takes longer than usual, increase the
Response Timeout value. It is recommended to
specify a value other than 0. If you specify 0,
IntegrationCloudwill wait indefinitely for a response.
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The number of times Integration Cloud attempts to
connect to the back end to read a response if the initial

Retry Count on Response Failure

attempt fails. If an I/O error occurs, it will retry only
if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend
the requestwhen the response has failed, even though

Retry on Response Failure

the request was sent successfully. Select this option if
you want to re-establish the connection.

The user email account that the connection will use
to connect to the SaaS provider.

Email

The password of the user email account.Password

This is the type of HTTP authorization scheme to use
for the connection. If you select none, no additional

Authorization Type

authorization scheme will be executed at run time.
For example, when you specify a Username and
Password, but do not specify a value for the
Authorization Type, the user credentials are not
inserted into an Authorization header. If you enter
the username andpassword, then set the authorization
type as basic. Basic refers to HTTP Basic
Authentication. This option can be used if the
Application requires or supports HTTP Basic
authentication using a username and password.

The Account ID or Account number received from
NetSuiteTM.

Account Id

Consumer Key received from NetSuite.Consumer Key

Consumer Secret received from NetSuite.Consumer Secret

Token received from NetSuite.Token Id

Token Secret received from NetSuite.Token Secret

Specify the role with which you want to execute the
web services, for example, Administrator.

Role

When you create the NetSuiteTM Account, it sends a
login request to the back end using email, password,

ApplicationID

Account, and the Application Id. Application Id is
required for requests using end point 2015.2 or later.
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Enable this option if you want to send or receive a
large binary stream with a chunk size of 8192 bytes.

Use Chunking

This is applicable only if the back end supports
HTTP/1.1 chunking.

Select the alias name of the Integration Cloud trust
store configuration. The trust store contains trusted

Trust store Alias

certificates used to determine trust for the remote
server peer certificates. You can also add a new
Truststore from this field.

Select a hostname verifier implementation. Guards
against man-in-the-middle (MITM) attacks. The

Hostname verifier

default is
org.apache.http.conn.ssl.DefaultHostnameVerifier,
which will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier
to disable hostname verification.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore

Keystore Alias

alias. A keystore file contains the credentials (private
key/signed certificate) that a client needs for
authentication. You can also add a newKeystore from
this field.

Alias to the private key in the keystore file specified
in theKeystoreAlias field. The outbound connections

Client Key Alias

use this key to send client credentials to a remote
server. To send the client’s identity to a remote server,
you must specify values in both the Keystore Alias
and the Client Key Alias fields.

Server Name Indication (SNI) is an extension to the
TLS protocol by which a client indicates which host

Enable SNI

name it is attempting to connect to at the start of the
handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if
youwant to connect to an SNI enabled SAASprovider
to send the host name specified in the Server URL
field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be
included as a part of the SNI extension server_name

SNI Server Name

parameter, in case the host name is other than the host
name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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Concur
Integration Cloud connects to Concur using the Concur API and allows you to manage expenses
and travel requests. It includes the Expense and Travel Request services.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL is of the format:

Server URL

https://<instance>/api. Replace <instance> with your actual Concur
instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID
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DescriptionField

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server. Concur REST APIs use OAuth 2.0. The Access Token is passed
when you invoke any of the REST API endpoints.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Coupa
Integration Cloud connects to Coupa using the Coupa API and allows you to create, update, and
query individual entries (records) within Coupa. It manages indirect purchases, invoices, and
expenses in real time and provides executive dashboards and expense management.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, for Coupa, the end point URL would be of the
format: https://<instance>.com.

Server URL

Replace <instance> with your actual Coupa instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure
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DescriptionField

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

The API Key received from the user account.X-COUPA-API-KEY

Coupa REST APIs authentication requests require a unique API key
generated inCoupa.All API requestsmust pass anX-COUPA-API-KEY
headerwith anAPI key. A key can be created from theAPI Keys section
of the Administration tab by an administrator. The key is a 40-character
long case-sensitive alphanumeric code. The API key is associated with
an API user who is the equivalent of an administrator in Coupa. Any
changes to resources through the API are attributed to the API user.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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Cumulocity
IntegrationCloud connects to Cumulocity and allows you tomanage assets and Internet of Things
(IoT) devices.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, for Cumulocity, the end point URL would be
of the format: https://<instance>.

Server URL

Replace <instance> with your actual Cumulocity instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SaaS provider that the Account
will use to connect to the SaaS provider.

Username

Provide a password for the user name provided in the Username field
to initiate communication with the SaaS provider.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic.
Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.
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DescriptionField

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Database
IntegrationCloud allows you to connect to a database using theDatabaseApplication. TheDatabase
Application allows you to perform database operationswith cloud databases using a JDBC driver.

Complete the following fields to create a new account:

DescriptionField

Select the supported database.Database

Select the driver group to connect to the database.Driver Group

You can upload a new JDBC driver through theAdd Driver option
from the drop-down list box. You can upload only certified jars.
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DescriptionField

Select the transaction type for transaction support for the account.
The following are the supported transaction types:

Transaction Type

NO_TRANSACTION: The connection automatically commits
operations.

LOCAL_TRANSACTION: The connectionuses local transactions.
With this transaction type, all of the operations on the same
account in a single transaction boundary are either committed
or rolled back together.

Select the DataSource class.DataSource Class

This field specifies the name of the JDBC driver's DataSource class.

Type the name of the server that hosts the database.Server Name

Note:
If the tenant cannot connect to the cloud database, then check
the security settings of the cloud database.

Type the user name that the connection uses to connect to the
database.

User

Type the password for the user name specified in User.Password

Type the database name to which the connection connects to.Database Name

Type the port number that the connection uses to connect to the
database.

Port Number

Select the alias name of the Integration Cloud truststore
configuration. The truststore contains trusted certificates that are

Truststore Alias

used to determine the trust for the remote server peer certificates.
You can also add a new Truststore from this field.

Indicates the name of the network protocol that the connection uses
when connecting to the database.

Network Protocol

Type TCP or TCPS to indicate the network protocol.

Select or type the property name. Also, enter the value for the
corresponding property in the input text field.

Other Properties

Note:
Properties listed for you to select from the drop-down list box
are driver-dependent.

Example: Use this field to choose a property such as TableFilter.
You can either select or type the TableFilter property in the
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drop-down list box and enter the ‘<current
catalog>'.‘Accounting' in the input text field.

Use {} to configure a combination of multiple key-value pairs.

Example,

connectionProperties={oracle.jdbc.V8Compatible=true,
includeSynonymns=true
}

By default, the loginTimeout is set to 60. This value specifies the
login timeout in seconds that a connectionwaitswhile attempting
to connect to a database.

The <current catalog> represents the default catalog associated with an account.

The <current schema> represents the default schema associated with an account.

PostgreSQL Database

When you configure an operation to select a table, youmust always select the table under <current
catalog>.

MariaDB

If you configure an operation for MariaDB using the driver versions greater than or equal to 2.4.0,
select the table under <current catalog>.

Database Application Operations

To useDatabaseApplication, youmust create operations. Database operations allowyou to connect
to the database and initiate an operation on the database from Integration Cloud.

You call database operations from Integration to perform database operation on tables, views, or
synonyms. The database operations are performed by calling JDBC APIs.

Operations are based on templates providedwithDatabaseApplication. Each template represents
an SQL statement for doing an operation on a database. For example, use Select operation to
retrieve specified information from the database tables.

Creating a new operation from a template is straightforward. You will have to create an account
using which you can create a new operation. During this process, select the operation template
and configure the operation using the operation wizards.

Database Application provides the following operation templates:
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DescriptionOperation

Inserts new information into a database table. Use this
operation when you insert a large volume of data into
a single table.

Batch Insert

Updates the existing information in a database table.
Use this operation when you update a large volume
of data in a single table.

Batch Update

Executes customSQL to perform a database operation.Custom SQL

Deletes rows from a database table.Delete

Inserts new information into a database table.Insert

Retrieves specified information from thedatabase table.Select

Calls a stored procedure. It obtains the stored
procedure's input/output parameters by introspecting
when you configure the operation.

Stored Procedure

Updates the existing information in a database table.Update

Advanced Options

The following options provide additional capabilities for Database operations:

DescriptionParameter

Select the checkbox to suppress the
duplicate rows in the query output.

Select DISTINCT

Note:
This option is applicable only for
Select operation.

Select the checkbox to convert the
fields with input or output data type

Convert all to STRING

to java.lang.String. The fields which
are already added to the table gets
automatically converted to a String
data type. It does not impact the fields
which cannot be converted to String
data type.

Note:
This option is applicable for Select,
Insert, Update, Delete, Batch Insert,
and Batch Update operations.
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Use the following formats to provide
SQL expressions:

Use SQL Expression (Advanced)

For table columns use
tableAlias.columnName.

For valid database functions use
databaseFunction(tableAlias.columnName).

For example,
upper(tableAlias.columnName).

Note:
This option is applicable for Select,
Update, Delete, and Batch Update
operations.

Configuring the Parameter Values

Custom SQL Operation

You can configure the following parameters for Custom SQL operation:

DescriptionParameter

Type or Select the query time out value in
seconds.

Query Time Out

This field specifies the number of seconds
the database connection will wait for a SQL
statement.

Note:
Select No Timeout if you do not want to
specify the Query Time Out.

Type the number of rows to be retrieved from
a database table.

Maximum Row

Note:
Select No Limit to indicate no limit on the
number of rows retrieved.

Type the field name of the Row Count Field.Row Count Field Name
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This field specifies the name of the output
field whose value contains the number of
affected rowswhile executing an SQL query.

Select the data type of the Row Count Field.Row Count Field Type

Select Operation

You can configure the following parameters for Select operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a Statement to execute.

Note:
SelectNo Timeout if you do not want to specify the
Query Time Out.

Type the number of rows to be retrieved from a
database table.

Maximum Row

Note:
Select No Limit to indicate no limit on the number
of rows retrieved.

Type the field name of the Row Count Field.Row Count Field Name

This field specifies the name of the output field whose
value contains the number of affected rows while
executing a Select SQL query.

Select the data type of the Row Count Field.Row Count Field Type

Update Operation

You can configure the following parameters for Update operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a SQL statement to execute.
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Note:
SelectNo Timeout if you do not want to specify the
Query Time Out.

Type the field name of the Row Count Field.Row Count Field Name

This field specifies the name of the output field whose
value contains the number of affected rows while
executing an Update SQL query.

Select the data type of the Row Count Field.Row Count Field Type

Insert Operation

You can configure the following parameters for Insert operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a SQL statement to execute.

Note:
SelectNo Timeout if you do not want to specify the
Query Time Out.

Type the field name of the Row Count Field.Row Count Field Name

This field specifies the name of the output field whose
value contains the number of affected rows while
executing a SQL statement.

Select the data type of the Row Count Field.Row Count Field Type

Delete Operation

You can configure the following parameters for Delete operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a SQL statement to execute.

Note:
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SelectNo Timeout if you do not want to specify the
Query Time Out.

Type the field name of the Row Count Field.Row Count Field Name

This field specifies the name of the output field whose
value contains the number of affected rows while
executing a SQL statement.

Select the data type of the Row Count Field.Row Count Field Type

Stored Procedure Operation

You can configure the following parameters for Stored Procedure operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a SQL statement to execute.

Note:
SelectNo Timeout if you do not want to specify the
Query Time Out.

Batch Insert Operation

You can configure the following parameters for Batch Insert operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a SQL statement to execute.

Note:
SelectNo Timeout if you do not want to specify the
Query Time Out.

Type the output name of the Batch Result Output
Name.

Batch Result Output Name

The output of the batch operation is a string list.
Elements in the list appear in the order in which you
add the Insert SQL queries for execution in the batch
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mode. Depending on the JDBC driver you use, the
elements in the list contains one of the following values:

A number greater than or equal to 0. This indicates
the insert SQL query is successfully executed and
returns the number of rows affected in the
database.

A value of -2. This indicates that the insert SQL
query was executed successfully but the number
of rows affected is unknown.

Batch Update Operation

You can configure the following parameters for Batch Update operation:

DescriptionParameter

Type or Select the query time out value in seconds.Query Time Out

This field specifies the number of seconds the database
connection will wait for a SQL statement to execute.

Note:
SelectNo Timeout if you do not want to specify the
Query Time Out.

Type the output name of the Batch Result Output
Name.

Batch Result Output Name

The output of the batch operation is a string list.
Elements in the list appear in the order in which you
add the Update SQL queries for execution in the batch
mode. Depending on the JDBC driver you use, the
elements in the list contains one of the following values:

A number greater than or equal to 0. This indicates
theUpdate SQL query is successfully executed and
returns the rows affected in the database.

A value of -2. This indicates that the commandwas
processed successfully but the number of rows
affected is unknown.

JDBC Data Type to Java Data Type Mappings
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Each column in the database table is assigned a SQL type. The JDBC driver maps each SQL data
type to a JDBC data type. Database Application then maps each JDBC data type to one or more
Java data types that are used as the input or output of the database operation.

The following table shows the JDBC data type to Java data type mappings. You can map each
JDBC data type to a set of Java data types by choosing one from the set. The JDBC data type you
select during configuration will then map to the input or output of the database operation.

For a list of data types for which Database Application has some constraints, see “JDBCData Type
to Java Data Type Mapping Constraints” on page 163.

Note:
Database Application does not support the TIMESTAMPWITHTIMEZONE and TIMESTAMP
WITH LOCAL TIME ZONE data types in Oracle 10g.

Note:
Database Application does not support user-defined data types, Oracle PL/SQL collections, or
Oracle PL/SQL records.

Note:
UROWID data type is not supported for Oracle database.

Note:
If the DATE JDBC type contains String as Java type, then the date format which Database
Application accepts is YYYY-MM-DD.

Java Data TypeJDBC Data Type

java.sql.ArrayARRAY

java.lang.Object

java.lang.BooleanBIT

java.lang.String

java.lang.Object

java.lang.ByteTINYINT

java.lang.Integer

java.lang.String

java.lang.Object

SetAsString

java.lang.ShortSMALLINT

java.lang.Integer

java.lang.String
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Java Data TypeJDBC Data Type

java.lang.Object

java.lang.IntegerINTEGER

java.lang.String

java.lang.Object

java.lang.LongBIGINT

java.lang.String

java.lang.Object

java.lang.DoubleFLOAT

java.lang.String

java.lang.Object

java.math.BigDecimal

SetAsString

java.lang.FloatREAL

java.lang.String

java.lang.Object

java.math.BigDecimal

java.lang.BooleanBOOLEAN

java.lang.String

java.lang.Object

java.lang.DoubleDOUBLE

java.lang.String

java.lang.Object

java.math.BigDecimal

SetAsString

java.math.BigDecimalNUMERIC

java.lang.String

java.lang.Object

java.math.BigDecimalDECIMAL
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Java Data TypeJDBC Data Type

java.lang.String

java.lang.Object

java.lang.StringCHAR

java.lang.Character

java.lang.Object

java.lang.StringVARCHAR

java.lang.Object

java.lang.StringLONGVARCHAR

java.lang.Object

java.sql.DateDATE

java.util.Date

java.lang.String

java.lang.Object

*SetAsString

java.sql.TimeTIME

java.util.Date

java.lang.String

java.lang.Object

SetAsString

java.sql.TimestampTIMESTAMP

java.util.Date

java.lang.String

java.lang.Object

SetAsString

TIMESTAMPWITH TIME ZONE

TIMESTAMPWITH LOCAL TIME ZONE

byte array (byte [])BINARY

java.lang.Object
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Java Data TypeJDBC Data Type

byte array (byte[])VARBINARY

java.lang.Object

byte array (byte[])LONGVARBINARY

java.lang.Object

java.lang.StringLONGNVARCHAR

java.lang.Object

java.lang.StringNCHAR

java.lang.Object

java.lang.StringNULL

java.lang.Object

java.lang.StringNVARCHAR

java.lang.Object

java.sql.ClobCLOB

java.lang.String

java.io.Reader

java.lang.Object

java.sql.BlobBLOB

byte array

java.io.InputStream

java.lang.Object

java.lang.ObjectORACLECURSOR

java.lang.StringORACLEFIXED_CHAR

java.sql.StructSTRUCT

java.lang.Object

java.lang.ObjectOTHER

java.lang.String

java.sql.Struct

java.sql.Array
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Important Considerations When Using BLOB and CLOB Data Types

When passing large CLOB or BLOB data, use the Java data types java.io.Reader for CLOB and
java.io.InputStream for BLOB to prevent Database Application from running out of memory.
When using these data types, Database Application streams the data into bytes thus allowing
to pass large data. The data types java.io.Reader and java.io.InputStream are supported only
for the Oracle database using the Oracle driver.

When using the CLOB data with java.io.Reader as input data type, it is recommended that
you use the InputStreamReader implementation of java.io.Reader with the correct encoding
parameter.

When IntegrationCloud executes a SELECToperation that has its output type set to java.sql.Blob
for a BLOB data type, Integration Cloud issues a java.io.NotSerializableException error. The
work around for this issue is to use with Integration.

Important Considerations When Using the Array and Struct Database Specific Data Types

In database operation, when using the java.lang.Object as the output field type for a database
column of typeARRAYor STRUCT,DatabaseApplication returns the data as a java.lang.Object
array, provided that theARRAYor STRUCTdata in the database table is composed of primitive
data types.

When using the java.sql.Array or java.sql.Struct as the output field type for a database column
of type ARRAY or STRUCT, Database Application returns the java.sql.Array and the
java.sql.Struct objects, respectively, as returned by the driver. However, when serializing the
data across the JVMs, this returned data may not be serializable and may result into a
java.io.NotSerializableException. Therefore, before serializing the data across the JVMs, it is
important that you use Integration to process the java.sql.Struct and java.sql.Array objects as
required, and then drop them from the pipeline.

Note:
The java.sql.Struct and java.sql.Array data types are available only for Database Application
operations.

Using the SetAsString Data Type in Database Application

The SetAsString data type is a dummy string data type. When using this data type, Database
Application does not try to convert the input data into the equivalent JDBC data type, but passes
the data to the underlying database driver as a string data type. Thus, you have the flexibility to
specify the format of the equivalent JDBC data type by using a database specific function.

For example, you can specify the format for date, time, or timestamp using the to_date function
or a similar database function for Oracle database. Database Application treats the input data as
a string data type and does not convert it to the equivalent JDBC data type. The to_date function
then uses the string data to provide the required format of the date, time or timestamp.

If your database has native database specific functions that can convert string data type to any
other data type, you may use the SetAsString data type.
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Note:
The SetAsString data type is available only for database operations.

JDBC Data Type to Java Data Type Mapping Constraints

Database Application has some constraints when mapping JDBC data types to Java data types.

If you select one of the following Java data types, the data typewillmap exactly to the Input/Output
of operation:

java.lang.String

java.lang.Byte

java.lang.Boolean

java.lang.Character

java.lang.Double

java.lang.Float

java.lang.Integer

java.lang.Long

java.lang.Short

java.util.Date

java.math.BigDecimal

java.math.BigInteger

java.lang.Object

Those data types not included in this list will map to java.lang.Object. In these cases, if the JDBC
data type you specify is for input, you will need to pass in the object with the selected Java data
type. If the JDBC type is for output, you can cast the object to the selected Java data type.

Driver Management

The Driver Management screen is available only for Database Application. This screen lists all
the available drivers uploaded for Database Application. It also gives you an option to upload a
custom driver jar for a particular database. This uploaded driver can be used when you create an
account. You can add or delete a driver jar from this screen.

Pre-bundled driver jars are provided to connect to the databases likeMicrosoft SQL Server, Oracle,
PostgreSQL. You cannot delete these pre-bundled driver group. The below table shows the driver
groups and supported databases.
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VersionSupported DatabasesDriver Group

5.1.4Microsoft SQL Server, OracleProgress® DataDirect®.

4.0.0Microsoft SQL ServerMicrosoft JDBC Driver for SQL Server

42.2.5PostgreSQLPostgreSQL JDBC Driver

Note:
If you use Progress® DataDirect® driver to create a Non-SSL connection for Microsoft SQL
Server database, then set the Other Properties with

validateservercertificate=false;encryptionmethod=ssl.

Note:
ForOracle database, if you are using Progress®DataDirect® driver group to create a connection
for Stored Procedure operation, then the Stored Procedure operation cannot fetch the metadata
for SYS_CURSOR data type.

To add a new driver

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Applications
> Predefined Applications.

2. Select Database and then click Driver Management.

3. From the Driver Management page, click Add Driver.

4. Select the supported  Database.

5. Type or select the driver from the Driver Group. Browse the jar in the Select the Driver field
for a particular database.

The driver jar gets uploaded for the corresponding database.

Note:
You can upload only the certified jars.

Note:
The uploaded driver jars can be used across the projects in the tenant.

Driver Management Fields

You can configure the following fields for Driver Management:

DescriptionParameter

Select the supported database.Database
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DescriptionParameter

Type a new driver group name or select the
existing group name from the drop-down

Driver Group

The uploaded JDBC driver jars are referred
by the given name when you create an
account.

Browse and select the driver jar for a
particular vendor. Youmust select the driver
jars which are certified by Software AG.

Select the Driver

Certified Databases and JDBC Driver Jars

You can upload only the following list of certified driver jars:

Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

Oracle
11.2.0.4

5ojdbc5.jar

Download Path

11.2.0.4Oracle

https://www.oracle.com/technetwork/

documentation/jdbc-112010-090769.html

Oracle
11.2.0.4

6,7,8ojdbc6.jar

Download Path

11.2.0.4

https://www.oracle.com/technetwork/

documentation/jdbc-112010-090769.html

Oracle
11.2.0.4

6,7xdb6.jar

Download Path

11.2.0.4

https://www.oracle.com/technetwork/

documentation/jdbc-112010-090769.html

Oracle
11.2.0.4

NAxmlparserv2-11.2.0.4.jar

Download Path

11.2.0.4

https://www.oracle.com/content/secure/

maven/content/com/oracle/jdbc/xmlparserv2/
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

11.2.0.4/xmlparserv2-11.2.0.4.jar

Oracle
11.2.0.4,
12.1.0.1

6ojdbc6.jar

Download Path

https://www.oracle.com/technetwork/

12.1.0.1

database/features/jdbc/

jdbc-drivers-12c-download-1958347.html

Oracle
11.2.0.4,
12.1.0.1

7,8ojdbc7.jar

Download Path

https://www.oracle.com/technetwork/

12.1.0.1

database/features/jdbc/

jdbc-drivers-12c-download-1958347.html

Oracle
11.2.0.4,
12.1.0.1

6,7xdb6.jar

Download Path

https://www.oracle.com/technetwork/

12.1.0.1

database/features/jdbc/

jdbc-drivers-12c-download-1958347.html

Oracle
11.2.0.4,
12.1.0.1

NAxmlparserv2-12.1.0.1.jar

Download Path

https://www.oracle.com/content/secure/

12.1.0.1

maven/content/com/oracle/jdbc/

xmlparserv2/12.1.0.1/xmlparserv2-12.1.0.1.jar

Oracle
11.2.0.4,

6ojdbc6.jar

Download Path

12.1.0.2

12.1.0.1,
12.1.0.2https://www.oracle.com/technetwork/

database/features/jdbc/default-2280470.html
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

Oracle
11.2.0.4,

7,8ojdbc7.jar

Download Path

12.1.0.2

12.1.0.1,
12.1.0.2https://www.oracle.com/technetwork/

database/features/jdbc/default-2280470.html

Oracle
11.2.0.4,

6,7xdb6.jar

Download Path

12.1.0.2

12.1.0.1,
12.1.0.2https://www.oracle.com/technetwork/

database/features/jdbc/default-2280470.html

Oracle
11.2.0.4,

NAxmlparserv2-12.1.0.2.jar

Download Path

12.1.0.2

12.1.0.1,
12.1.0.2https://www.oracle.com/content/secure/

maven/content/com/oracle/jdbc/

xmlparserv2/12.1.0.2/xmlparserv2-12.1.0.2.jar

Oracle
11.2.0.4,

8ojdbc8.jar

Download Path

12.2.0.1

12.1.0.1,
https://www.oracle.com/technetwork/ 12.1.0.2,

12.2.0.1
database/features/jdbc/jdbc-ucp-122-3110062.html

Oracle
11.2.0.4,

7,8xdb6.jar

Download Path

12.2.0.1

12.1.0.1,
https://www.oracle.com/technetwork/database/ 12.1.0.2,

12.2.0.1
features/jdbc/jdbc-ucp-122-3110062.html

Oracle
11.2.0.4,

NAxmlparserv2-12.2.0.1.jar

Download Path

12.2.0.1

12.1.0.1,
https://www.oracle.com/content/secure/ 12.1.0.2,

12.2.0.1
maven/content/com/oracle/jdbc/

xmlparserv2/12.2.0.1/xmlparserv2-12.2.0.1.jar
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

MySQL
8.0, 5.7, 5.6,
5.5

8mysql-connector-java-8.0.16. jar

Download Path

https://downloads.mysql.com/archives/c-j/

8.0.16MySQL

MySQL
8.0, 5.7, 5.6,
and 5.5

8mysql-connector-java-8.0.17.jar

Download Path

https://dev.mysql.com/downloads/connector/j/

8.0.17

Note:
If you are unable to find the driver jar for
the specified version, then download the
driver from the archived version's
download link as shown below:

https://downloads.mysql.com/archives/c-j/

Microsoft
SQL Server

7sqljdbc41.jar

Download Path

4.1Microsoft SQL
Server

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=841533 2014, 2016,

and Azure
SQL
Database

Microsoft
SQL Server

7sqljdbc41.jar

Download Path

4.2

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=841534 2014, 2016,

and Azure
SQL
Database

Microsoft
SQL Server

8sqljdbc42.jar

Download Path

4.2

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=841534 2014, 2016,

and Azure
SQL
Database

Microsoft
SQL Server

7sqljdbc41.jar

Download Path

6.0

2008, 2012,
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

https://go.microsoft.com/fwlink/?LinkId=245496 2014, 2016
and Azure
SQL
Database

Microsoft
SQL Server

8sqljdbc42.jar

Download Path

6.0

2008, 2012,
https://go.microsoft.com/fwlink/?LinkId=245496 2014, 2016,

and Azure
SQL
Database

Microsoft
SQL Server

7mssql-jdbc-6.2.2.jre7.jar

Download Path

6.2.2

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=852460 2014, 2016,

2017, and
Azure SQL
Database

Microsoft
SQL Server

8mssql-jdbc-6.2.2.jre8.jar

Download Path

6.2.2

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=852460 2014, 2016,

2017 and
Azure SQL
Database

Microsoft
SQL Server

7mssql-jdbc-6.4.0.jre7.jar

Download Path

6.4.0

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=868290 2014, 2016,

2017, and
Azure SQL
Database

Microsoft
SQL Server

8mssql-jdbc-6.4.0.jre8.jar

Download Path

6.4.0

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=868290 2014, 2016,

2017, and
Azure SQL
Database
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

Microsoft
SQL Server

8mssql-jdbc-7.0.0.jre8.jar

Download Path

7.0.0

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=2063159 2014, 2016,

2017, and
Azure SQL
Database

Microsoft
SQL Server

8mssql-jdbc-7.2.1.jre8.jar

Download Path

7.2.2

2008, 2012,
https://go.microsoft.com/fwlink/?linkid=2063159 2014, 2016,

2017, and
Azure SQL
Database

Aurora
PostgreSQL

6postgresql-42.2.5.jre6.jar

Download Path

42.2.5PostgreSQL

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

7postgresql-42.2.5.jre7.jar

Download Path

42.2.5

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

8postgresql-42.2.5.jar

Download Path

42.2.5

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

6postgresql-42.2.6.jre6.jar

Download Path

42.2.6

(Compatible
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

https://jdbc.postgresql.org/download.html with
PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

7postgresql-42.2.6.jre7.jar

Download Path

42.2.6

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

8postgresql-42.2.6.jar

Download Path

42.2.6

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

8postgresql-42.2.7.jar

Download Path

42.2.7

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

6postgresql-42.2.7.jre6.jar

Download Path

42.2.7

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

7postgresql-42.2.7.jre7.jar

Download Path

42.2.7

(Compatible
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Supported
DB
Versions

Java
Version

Driver Jar NameDriver
Version

Database

https://jdbc.postgresql.org/download.html with
PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Aurora
PostgreSQL

8postgresql-42.2.8.jar

Download Path

42.2.8

(Compatible
https://jdbc.postgresql.org/download.html with

PostgreSQL
9.6.8, 9.6.9,
10.4, 10.5,
10.6)

Tibero 6NAtibero6-jdbc.jar6.0Tibero

Download Path

The driver jar is available in the Tibero 6
installation directory,

($TB_HOME/client/lib/jar).

MariaDB
10.3.8

8mariadb-java-client-2.3.0.jar

Download Path

2.3.0MariaDB

http://downloads.mariadb.com/Connectors/java/

Note:
For MySQL driver, ensure that you download the Platform Independent variant.

Samples Accounts

The following are the sample accounts created for secured and non secured connection for various
databases:

Microsoft SQL Server

The following are the fields to be configured for a non-secure Microsoft SQL Server account:
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Note:
For a secured connection using Microsoft SQL database, edit the following fields:

Select Truststore Alias from the drop-down. If this option is not available in the drop-down,
then upload your certificate using Add New Truststore.
Set the Other Properties to loginTimeout=60;encrypt=true.

Oracle

The following are the fields to be configured for a non-secure Oracle account:

Note:
For a secured connection using Oracle database, edit the following fields:
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Select Truststore Alias from the drop-down. If this option is not available in the drop-down,
then upload your certificate using Add New Truststore.
Type tcps for Network Protocol

Note:
By default, 2484 is the tcps port.

PostgreSQL

The following are the fields to be configured for a non-secure PostgreSQL account:

Note:
For secured connection using PostgreSQL, you need to select the Truststore Alias from the
drop-down. If this option is not available in the drop-down, then upload your certificate using
Add New Truststore.

Note:
The Network Protocol field is not mandatory for PostgreSQL account.

MySQL

The following are the fields to be configured for a non-secure MySQL account:
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k

Note:
For secured connection using MySQL database, you need to select the Truststore Alias from
the drop-down. If this option is not available in the drop-down, then upload your certificate
using Add New Truststore.

MariaDB

The following are the fields to be configured for a non-secure MariaDB account:

Note:
For secured connection using MariaDB, select the Truststore Alias from the drop-down list. If
this option is not available in the drop-down list, then upload your certificate using Add New
Truststore.

Tibero

The following are the fields to be configured for a non-secure Tibero account:
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Supported Cloud Databases

The following table lists the supported cloud databases:

Database VersionCloud Database

Microsoft SQL Azure (RTM) - 12.0.2000.8Microsoft Azure

Oracle 12c, Version 12.1.0.2Amazon RDS Oracle

SQL Server 2016 SP1 CU7 13.00.4466.4, releasedAmazon RDS MS SQL
Server

Aurora PostgreSQL 10.6AWSAurora PostgreSQL

Aurora MySQL 5.7.12AWS Aurora MySQL

MariaDB 10.3.8Amazon RDS MariaDB

Tibero 6Tibero on Amazon EC2

How to use the Insert and Select operations using the Database Application

What is a Database Application?

The  Database Application allows you to perform database operations with cloud databases. All
the database operations are performed using JDBC Driver provided by the database vendor.

You can create an integration with any cloud databases using the Database Application which
supports operations such as Insert, Select, Delete, Update, and so on. All the operations in the
Database Application share similar user interfaces and design approaches.
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Actors

Administrator

User who creates integration to the database

Preconditions

Knowledge to create and execute an operation

Basic knowledge of Database and SQL queries

An existing database with appropriate permissions

A valid tenant that contains IntegrationCloud subscriptionwith access toDatabaseApplication

Basic Flow

1. Login to Integration Cloud with the tenant credentials.

2. You can create a new project or use an existing project to create an account, operation, and so
on using the below screen:

3. Click Applications and find the Database application as shown below:
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4. You can now create an account, operation, and integration using the below screen:

5. Let us assume that you want to insert a row into an EMPLOYEE table using the INSERT
operation and then select the inserted row using the SELECT operation. The sample structure
for the Employee table can be as shown below:
EMP_NO NUMBER(4)
EMP_NAME VARCHAR2(10)
JOB VARCHAR2(9)
MANAGER NUMBER(4)
HIRE_DATE DATE
SALARY NUMBER(7,2)
COMM NUMBER(7,2)
DEPT_NO NUMBER(2)

6. Do the following to insert a row into the Employee table:

a. Add a JDBC driver.

Navigate to the particular project where you want to create the operation Then, go to
Applications > Database > DRIVER MANAGEMENT > Add Driver. Provide values as
shown below and click Add.

Note:
The Database Application also provides pre-bundled JDBC drivers. If you want to use
a pre-bundled JDBC driver, you need not add a new JDBC driver.

b. Create a new account.

Navigate to the particular project where you have already added the JDBC driver. Then
go to Applications > Database > ACCOUNTS > Add New Account.

Provide the values for each field as shown below and save the account details:
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Note:
The Truststore Alias field is used only when you create a secure connection.

c. Configure the Insert operation.

Navigate to the particular project where you have created the account.

Then go to Applications > Database > OPERATIONS > Add New Operation.

Follow the below steps to configure the Insert operation:

a. On the Account screen, provide the name of the operation, description and choose the
account to create the operation as shown below:

b. On theOperation screen, select the Insert operation from the list of operation templates:

c. For Tables, click Add Table, and select the Employee table as shown below:

d. For Insert Values, click Add Fields, and select the table columns:
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Note:
The default value for the Expression field is ?, which specifies to provide the value
for that particular column when you execute the Insert operation.

e. The Summary displays the operation details such as the name of the Operation,
Account, and SQL query formed. Click Finish or Save.

d. Execute the Insert operation and provide values for the selected columns.

7. To select a row from the Employee table, do the following:

a. Add a JDBC Driver.

The JDBC Driver is already added while creating the Insert operation.

b. Create a new account.

The account is already created while creating the Insert operation.

c. Configure the Select operation.

To configure, navigate to the respective project where you have created the account.

Later navigate to Applications > Database > OPERATIONS > Add New Operation.

Do the following to configure the Select operation:

a. On theAccount screen, provide the name of the operation, description, and choose the
account to create the operation as shown below:

b. On the Operation screen, choose the Select operation from the list of operation
templates as shown below:

c. For Tables, click Add Table and select the Employee table as shown below:
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d. If you select multiple tables, select Joins to configure the joins for those tables. You can
skip this option if you have selected a single table.

e. For Data Fields, click Add Fields, and select the table columns as shown below:

f. In the Conditions screen, configure the WHERE clause of the SQL query as shown
below:

Note:
The default value for the Expression field is ?, which specifies to provide the value
for that column when you execute the Select operation.

g. The Summary displays the operation details such as the name of the operation, account,
and SQL query formed. Click Finish or  Save.

d. Execute the Select operation.

DocuSign
Integration Cloud connects to DocuSign using the DocuSign API. It provides electronic signature
technology and digital transaction management services for facilitating electronic exchanges of
contracts and signed documents.
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DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, for the DocuSign connector version 2, the end
point URL is of the format: https://demo.DocuSign.net/restapi.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server. DocuSignRESTAPIs useOAuth 2.0. TheAccess Token is passed

Access Token

when you invoke any of the REST API endpoints. The Access Token is
valid in all future API calls to authenticate the user, until the token is
revoked. It is not affected by password changes.
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DescriptionField

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Electronic Data Interchange
Use the predefined operations in the Electronic Data Interchange (EDI) application to parse,
validate, and transform EDI messages received from the webMethods.io B2B application. Use
these transformed messages to create orchestrations.

This application requires you to have access to the webMethods.io B2B product instance.

Note:
Only the documents you add in the webMethods.io B2B product tenant appear on the EDI
application page of the corresponding Integration Cloud tenant. And these documents are
available across all projects.

Predefined Operations

The following predefined operations are available for EDI application:

addGroupEnvelope

Adds a functional group header to an EDI message according to the UN/EDIFACT, ANSI X12,
UCS, or VICS standards.

Input Parameters

String EDI messages to which a group envelope is added.ediMessages

Either X12/UCS/VICS or UN/EDIFACT.documentType
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String Functional ID Code of the EDI document.functionalIDcode

String EDI ID qualifier for the sender ID. It is used with sender.senderQual

String Identifies sender in the group envelope. For example, if you specify
01 for senderQual (indicating a D-U-N-S number), specify the D-U-N-S
number for sender.

sender

String EDI ID qualifier for the receiver ID. It is used with receiver .receiverQual

String Receiver to be identified in the group envelope. For example, if you
specify 01 for receiverQual (indicating a D-U-N-S number), specify the
D-U-N-S number for receiver .

receiver

String Group control number of the EDI document.grpCtlNumber

String Responsible agency code as per EDI standard: T (default) or X.agencyCode

String EDI standard version and release code. For example, 4010, 3040.verCode

DocumentWhen the document type is UN/EDIFACT, assign values to
the following parameters:

UN/EDIFACT

DescriptionKey

String Syntax version of the envelope level.syntaxVersion

String EDI message standard release code. For
example, 96A, 97b.

releaseCode

String EDI message standard assigned code. For
example, OD, EN.

assignedCode

String The recipient transmission reference
password.

password

Document Delimiters used in the EDI document:delimiters

DescriptionKey

String Segment terminator for the EDI document.
For example, \u000a.

segment

Default  New line character

String Field separator for each EDI segment. For
example, exclamation mark (!).

field

Default  *

String Separator for composite elements. For
example, caret (^).

subfield

Default  :
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String Release character for composite elements.
For example, caret (^).

release

Default  ?

Output Parameters

String Contains the ediMessage.ediMessage

String Status code based on success or failure.statusCode

String Status message after executing the operation.statusMessage

addInterchangeEnvelope

Adds an interchange control header to an EDImessage according to the UN/EDIFACT, ANSI X12,
UCS, or VICS standards.

Input Parameters

String EDI messages to which a group envelope is added.ediMessages

Either X12/UCS/VICS or UN/EDIFACT.documentType

String EDI ID qualifier for the sender ID. It is used with sender.senderQual

String The sender to be identified in the group envelope. For example, if you
specify 01 for senderQual (indicating a D-U-N-S number), specify the D-U-N-S
number for sender.

sender

String EDI ID qualifier for the receiver ID. It is used with receiver.receiverQual

String The receiver to be identified in the group envelope. For example, if you
specify 01 for receiverQual (indicating a D-U-N-S number), specify the D-U-N-S
number for receiver.

receiver

String The interchange control number of the EDI document.ctlNumber

String Indicates whether to request an acknowledgment for this interchange:ackRequested

MeaningValue

Do not request an acknowledgment.false

Default False

Requests an acknowledgment.true

Document Delimiters used in the EDI document.delimiters
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DescriptionKey

String Segment terminator for the EDI
document. For example, \u000a.

segment

Default  \

String Field separator for each EDI segment.
For example, exclamation mark (!).

field

Default  *

String Separator for composite elements. For
example, caret (^).

subfield

Default  :

StringRelease character for composite elements.
For example, caret (^).

release

Default  ?

String Decimal character for composite
elements. For example, caret (^). If

decimal

UN/EDIFACT > unaSegmentRequired is true, the
decimal delimiter is used.

Default  .

If UN/EDIFACT > unaSegmentRequired is false,
decimal is ignored.

DocumentWhen the document type is X12/UCS/VICS, assign values to the
following parameters:

X12/UCS/VICS

DescriptionKey

String Authorization qualifier for the
interchange envelope.

authQual

String Authorization information for the
interchange envelope.

authInfo

String Security qualifier for the interchange
envelope.

securityQual

String Security information for the interchange
envelope.

securityInfo

String Version of the EDI standard used, with
a 00 prefix. For example, if version is 4010,
specify 004010.

ctlVersion
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String (ANSI X12 only) Adds leading zeros to
the interchange control number to make it a
nine-digit number.

addLeadingZerosToCtlNumber

MeaningValue

Do not add leading zeros
to the interchange control
number.

false

Default  false

Add leading zeros to the
interchange control

true

number to make it a nine
digit number. For
example, 12 becomes
000000012.

StringA separator for the repeated occurrences
of a simple data element or a composite data
structure. Field length: 1

repSeparator

Note:
The repSeparatormust be different from the
record, field, or subfield delimiters.

String Aligns the messages.messageAlignment

DescriptionValue

Left justify.left

Right justify.right

No justification.none

Default

DocumentWhen the document type is UN/EDIFACT, assign values to the
following parameters:

UN/EDIFACT

DescriptionKey

String Syntax identifier.syntaxID

String Syntax version of the envelope level.syntaxVersion

String Recipient transmission reference
password.

password

String Recipient reference password qualifier.passwordQual

String Application reference.applReference
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String Processing priority code.priority

String Interchange agreement identifier.agreementID

String Adds a UNA segment to the resulting
final message.

unaSegmentRequired

DescriptionValue

Create UNA segment.true

Do not create UNA
segment.

false

String Type the directory version number in
the UNB01/S00103 subfield of the EDIFACT
envelope interchange header.

directoryVersionNumber

String Type the character encoding in the
UNB01/S00104 subfield of the EDIFACT
envelope interchange header.

characterEncoding

String Type the syntax release number in the
UNB01/S00105 subfield of the EDIFACT
envelope interchange header.

syntaxReleaseNumber

String Type the sender's internal ID in the
UNB02/S00203 subfield of the EDIFACT
envelope interchange header.

senderInternalId

String Type the sender's internal sub ID in the
UNB02/S00204 subfield of the EDIFACT
envelope interchange header.

senderInternalSubId

String Type the receiver's internal ID in the
UNB03/S00203 subfield of the EDIFACT
envelope interchange header.

receiverInternalId

String Type the receiver's internal sub ID in the
UNB03/S00204 subfield of the EDIFACT
envelope interchange header.

receiverInternalSubId

Output Parameters

String Contains the ediMessage.ediMessage

String Status code based on success or failure.statusCode

String Status message after executing the operation.statusMessage
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convertDocumentToEDIMessage

Converts a document to an EDI message. When creating an orchestration with
ConvertDocumentToEDIMessage, you must select the appropriate document type. This is for
the structure of an ediDocument to appear in the pipeline data when you map with another
ediDocument during orchestration.

Input Parameters

Document The ediDocument you want to convert to an EDI message.ediDocument

EitherDefault or TRADACOMS.documentType

String The type of encoding used to write a message to the output file.encoding

Default  UTF-8

Document Delimiters used in the outbound EDI document.delimiters

Note:
This parameter is not applicable to TRADACOMSmessages.

DescriptionKey

String Segment terminator character to be appended
at the end of each record in the output string.

segment

String Field separator to be inserted between each
field for each segment.

field

String Separator for composite elements.subfield

String Release character to use as the escape
character for composite elements.

release

String Aligns the messages.messageAlignment

DescriptionValue

Left justify.left

Right justify.right

No justification.none

Default

String Indicateswhether to remove empty trailing fields from the output.noEmptyTrailingFields

DescriptionValue
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Removes empty trailing fields from the output. For
example, AAA*01*02! (where ! is the segment
terminator).

true

This does not remove empty trailing fields. Instead
it uses the field separator to denote an empty field.

false

For example, AAA*01*02********!(where * is the
field separator and ! is the segment terminator).

Output Parameters

String Contains the EDI message.ediMessage

String ListErrormessages describing the errors encountered during conversion.
If there are no errors, then error[] is null.

errors[]

String The number of segments in the ediMessage.segmentCount

String Status code based on success or failure.statusCode

String Status message after executing the operation.statusMessage

convertEDIMessageToDocument

Converts an EDImessage that is stream or string into a document.When creating an orchestration
with ConvertEDIMessageToDocument, you must select the appropriate document type. This is
for the structure of an ediDocument to appear in the pipeline data when you map with another
ediDocument during orchestration.

Input Parameters

String The ediMessage you want to convert to a document.ediMessage

InputStreamThe ediMessage streamyouwant to convert to a document.edistream

EitherDefault or TRADACOMSdocumentType

String The encoding of the message passed into an ediMessage or
edistream.

encoding

Document Delimiters to parse the input message. If no delimiters are
specified, then the parameter uses the default delimiter defined for the
flat file schema.

delimiters

Note:
This parameter is not applicable to TRADACOMSmessages.

DescriptionKey
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String Segment terminator used in the input message.segment

String Field separator used in the input message.field

String Subfield separator used in the input message.subfield

String Release character used in the input message.release

String Validates the ediMessage.validate

DescriptionValue

Return errors describing how the given ediMessage
violates the constraints described in the flat file schema.

true

Do not return error messages describing how the
ediMessage differs from the specified flat file schema.
This is the default value.

false

String Processes the segments one at a time or process all input data
at one time. Specify true or false.

processOnlyTopLevelRecord

MeaningValue

Starts processing segment structures with a top-level
record as defined by the flat file schema. The parameter

true

returns to the caller when it encounters another
top-level record in the input data.

Processes all input data at one time. This is the default
value.

false

String Ignoreswhite space from the beginning of the segments. Specify
true or false.

ignoreSpaces

MeaningValue

Ignore white spaces. This is the default value.true

Use the segments as they are. Specify falsewhen the
data contains positional data records.

false

String Inserts field separator between repeating fields of an EDI
document.

repeatingFieldSeparator

Note:
This parameter is not applicable to TRADACOMSmessages.

Output Parameters

Document The Document representation of the input ediMessage.ediDocument
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String Checks the validity of ediMessage.isValid

DescriptionValue

validate input parameter was set to true and no
errors were found.

true

validate input parameter was set to true and errors
were found.

false

Document List The validation errors, if any, that were found in
edimessage.Validation errors are returned in errors only if validate is set to true

errors[]

and returnErrors is set to asArray or both. The list includes the path of the
errors.

String Status code based on success or failure.statusCode

String Status message after executing the operation.statusMessage

processEnvelope

Accepts and processes the envelope of an ANSI X12/UN/EDIFACT/UCS/VICS/EANCOM EDI or
TRADACOMSmessage and converts the envelope header segments to a document.When creating
an orchestration with processEnvelope, you must select the appropriate document type. This is
for the structure of an ediDocument to appear in the pipeline data when you map with another
ediDocument during orchestration.

Input Parameters

String Processes the input EDI message. Input must not have manual line
breaks.

ediMessage

StringWhether to validate the envelopes against a predefined flat file
schema.

validate

DescriptionValue

Validate the envelopes against a predefined
flat file schema.

true

Does not validate the envelope.false

String Performs a compliance check against the interchange.complianceCheck

Note:
This parameter is not applicable to TRADACOMSmessages.

DescriptionValue
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Perform a compliance check. The parameter
stops executing after encountering the first
error. This is the default value.

true

Does not perform the compliance check.false

Output Parameters

Document Resulting EDI envelope document.ediEnvelopeDocument

String The standard to which the EDI document adheres. For example, X12
or UNEDIFACT.

standard

StringWhether the validation or compliance check resulted in error.hasError

DescriptionValue

If the validate is true, validation errors are
retrieved from errorArray.Otherwise, it
indicates errors from the compliance check.

false

No errors.true

Document List Validation errors, if any, that were found in
edimessage.Validation errors are returned in errors only if validate is set to

errors[]

true -AND- returnErrors is set to asArray or both. The list includes the path
of the errors.

String Status code based on success or failure.statusCode

String Status message after executing the operation.statusMessage

createTradacomsMessage

Creates a TRADACOMSmessage containing the STX header segment, payload, and the END
segment. When the validate parameter is set to true, EDI application validates the content of the
message.

Input Parameters

Document The document representation ofTRADACOMS STX segment.STX

StringWhether the service creates an RSGRSG (reconciliation) message
in the output message.

includeRSGRSG

DescriptionValue

Creates an RSGRSG message in the output
message. This is the default value.

true
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Does not create an RSGRSG message.false

String Optional. The encoding format to use in the message.encoding

String The TRADACOMS payload.tradacomsMessages

DocumentThe document representation ofTRADACOMSEND segment.END

String Validates the tradacomsMessages.validate

DescriptionValue

Returns errors describing how the given
tradacomsMessages violates the constraints
described in the flat file schema.

true

Does not return errormessages describinghow
the tradacomsMessagesdiffers from the specified
flat file schema. This is the default value.

false

Output Parameters

String Contains the EDI message.ediMessage

String List Validation errors, if any, that are found in tradacomsMessages.
Validation errors are returned only if validate is set to true.

errors[]

String Checks the validity of tradacomsMessages.isValid

DescriptionValue

If the validate is set to true and no errors are
found.

true

If the validate is set to true and there are errors.false

String Status code based on success or failure.statusCode

String Status message after performing the operation.statusMessage

File Transfer Protocol (FTP/FTPS)
Integration Cloud connects to an FTP server using the FTP protocol and provides operations to
list, download, upload, and delete files. It also supports FTPS (FTP over SSL).

Note:
FTP is not a secure file transfer protocol and it has security vulnerabilities. It does not provide
any encryption for data transfer. It is recommended to use secured protocols such as HTTPS
and FTPS for securing the data transmitted over the network.

Note:
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See this video on how to create an Account for an FTP Application and test the connection.

DescriptionField

Host name or IP address or the domain name of the FTP server.Host

FTP port defined on the FTP server.Port

Valid user name on the FTP server.User

Password of the FTP user.Password

SSL Configuration - Select this option for secured FTP connection.

Select True to secure the data channel.Secure Data

Select False if you do not want to secure the data channel.

Alias to the keystore that contains the private key used to connect to
the host securely. You can also add a new Keystore from this field.

Keystore Alias

Note:
Users who have the Administer permission under Settings  >
Access Profiles > Administrative Permissions > Functional
Controls > Advanced Security can add, edit, and delete Keystores.

Alias to the key in the keystore that contains the private key used to
connect to the host securely. The key must be in the keystore specified
in the Keystore Alias field.

Key Alias

The alias for the truststore, which contains the trusted root of a
certificate or signing authority (CA). You can also add a newTruststore
from this field.

Truststore Alias

Note:
Users who have the Administer permission under Settings  >
Access Profiles > Administrative Permissions > Functional
Controls > Advanced Security can add, edit, and delete Truststores.

FTP Predefined Operations

The following predefined FTP operations are available:

getFile

Retrieves a file from a remote FTP server.
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Input Parameters

StringName of the remote file.remoteFile

String FTP file transfer mode (ASCII or binary). The default is ASCII.transferType

Output Parameters

Object A java.io.InputStream object.contentStream

String Standard FTP protocol status code.statusCode

String Standard FTP protocol status message.statusMessage

listFiles

Returns a list of file names in a specified remote directory. If path is not specified, the operation
retrieves the file listing of the current remote directory. The operation also retrieves additional
details such as permissions and ownership information.

Input Parameters

StringOptional. Absolute or relative path of the remote directory. If remotepath
is not specified, the listFiles operation retrieves the directory listing of the
current remote directory.

remotePath

You can use the wildcard characters asterisk (*) and question mark (?) after
the last slash mark (/) to view all remote directories that match the specified
path.

String Optional. Filter that specifies the names of the files to include in the
list (for example, *.txt).

listFilter

Output Parameters

String List List of file names matching listFilter.fileList []

String Standard FTP protocol status code.statusCode

String Standard FTP protocol status message.statusMessage

deleteFiles

Delete file(s) from a remote FTP server.

196 Integration Cloud 6.6.0

5 Applications



Input Parameters

String Optional. Absolute or relative path of the remote directory. If remotepath
is not specified, the deleteFiles operation deletes the directory listing of the current
remote directory.

remotePath

You can use the wildcard characters asterisk (*) and question mark (?) after the
last slash mark (/) to view all remote directories that match the specified path.

String Optional. Filter that specifies the names of the files to be deleted (for
example, *.txt).

deleteFilter

Output Parameters

String List List of deleted files that match the deleteFilter.filesDeleted []

String List List of files not deleted.filesNotDeleted []

String Standard FTP protocol status code.statuscode

String Standard FTP protocol status message.statusmsg

putFile

Transfers a file to a remote FTP server.

Input Parameters

String The name of the remote file.remoteFile

String FTP file transfer mode (ascii or binary). The default is ascii.transferType

StringOptional. Indicateswhether to send a STORor a STOU (Store asUnique
File) command to the remote FTP server. Set to:

writeOption

true to send a STOU (Store as Unique File) command.

false to send a STOR command. This is the default.

java.io.InputStream, byte[ ], or String Data to be transferred to the remote
file.

contentStream

Output Parameters

String Standard FTP protocol status code.statusCode

String Standard FTP protocol status message.statusMessage
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Usage Notes

Some FTP servers do not support “putting” a unique file. When using the putFile operation to put
a unique file to an FTP server that does not support putting a unique file, you may encounter the
following error:
com.wm.app.b2b.server.ServiceException: 500 'STOU': command not understood.

renameFile

Renames a file on a remote FTP server.

Input Parameters

String Fully qualified name of the file you want to rename (for example,
temp/oldfilename.txt).

oldFileName

String Fully qualified name of the new file (for example, temp/newfilename.txt).newFileName

Output Parameters

String Standard FTP protocol status code.StatusCode

String Standard FTP protocol status message.StatusMessage

Google Analytics
Integration Cloud connects to Google Analytics using the API for Management services. You can
use Management services to retrieve, create, update, and delete analytics configuration data
(accounts, metrics, dimensions, and custom data sources).

Integration Cloud also connects to Google Analytics using the API v4 for Core Reporting services.
You can use Reporting services to generate customized reports based on dimensions, date range,
and metrics.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.googleapis.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.
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DescriptionField

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Example: https://www.googleapis.com/oauth2/v4/token.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
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DescriptionField

to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google Apps Admin
Integration Cloud connects to Google Apps Admin and supports the functionality to create and
list users.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.googleapis.com/admin.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.
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DescriptionField

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Example: https://www.googleapis.com/oauth2/v4/token.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google BigQuery
Integration Cloud connects to Google BigQuery using the Google BigQuery API and allows you
to create, update, and delete data sets and tables. You can also load, copy, extract, and query data
from BigQuery's Bigtable.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.googleapis.com/admin.

Server URL
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DescriptionField

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token
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DescriptionField

This is the provider specific URL to refresh an Access Token.Refresh URL

Example: https://www.googleapis.com/oauth2/v4/token.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google Calendar
Integration Cloud connects to Google Calendar using Google Calendar APIs. It enables you to
manage calendar data such as Secondary Calendars, Events, and Quick Event Add.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.googleapis.com/calendar/v3.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
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DescriptionField

org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google Contacts
Integration Cloud connects to Google Contacts using Google Contacts APIs. It enables you to
manage a user's contact list. The contacts are usually stored in the user's Google Account.
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DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.google.com/m8/feeds.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

Integration Cloud 6.6.0 205

5 Applications



DescriptionField

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token.

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google Drive
Integration Cloud connects to Google Drive using the Google Drive API. It provides functionality
of file storage and access to list, upload, and delete files.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.googleapis.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier
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DescriptionField

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token.

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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Google Cloud Pub/Sub
Integration Cloud connects to Google Cloud Pub/Sub and allows you to create, get, delete, set
policy, and get policy on topics and subscription resources.

DescriptionField

Provide the login endpoint to initiate communication with Google
Cloud Pub/Sub, for example, https://pubsub.googleapis.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID
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DescriptionField

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Applicable when you select the OAuth 2.0 JWT Token Flow as the
Authentication Type. This is the Client ID, or Identifier, or name of the
server or system issuing the JWT token.

Issuer

Applicable when you select the OAuth 2.0 JWT Token Flow as the
Authentication Type. This is the identifier or the name of the user this
token represents.

Subject

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization

Access Token

Server. Google Cloud Pub/Sub REST APIs use OAuth 2.0. The Access
Token is passed when you invoke any of the REST API endpoints. The
Access Token is valid for 1 hour. It is not affected by password changes.
The client application is responsible for storing and protecting this
token.

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token.

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google Cloud Storage
Integration Cloud connects to Google Cloud Storage using the Google Cloud Storage API and
allows you to create and manage Buckets, Objects, and AccessControls.
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DescriptionField

Provide the login endpoint to initiate communication with Google
Cloud Storage. Example: https://www.googleapis.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token
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DescriptionField

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token.

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Google Prediction
Integration Cloud connects to Google Prediction using the Google Prediction API. It includes the
HostedModel and TrainedModel services that are used to predict data by usingmachine learning.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://www.googleapis.com/prediction/v1.6.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier
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DescriptionField

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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Google Sheets
IntegrationCloud connects toGoogle Sheets and allows you to create, update, and get a spreadsheet,
as well as append values to a spreadsheet.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://sheets.googleapis.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Also referred to as the Client ID, specify the Client ID you obtained
from the Google Developer Console. This is a client identifier issued
to the client to identify itself to the authorization server.

Consumer ID
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DescriptionField

Also referred to as the Client Secret, specify the Client Secret you
obtained from theGoogle Developer Console. This is a secretmatching
to the client identifier.

Consumer Secret

Specify the access token you obtained from the OAuth Playground.
This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://www.googleapis.com/oauth2/v4/token.

Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

IBM Watson Tone Analyzer
Integration Cloud connects to IBMWatson Tone Analyzer using the REST interface to detect
emotional, social, and language tones in written text. You can use the Application to learn the tone
of your customer's communications and to respond to each customer appropriately, or to
understand and improve customer conversations.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.
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DescriptionField

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

IBM Bluemix Watson username.Username

IBM Bluemix Watson password.Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic .
Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password. Select the Authorization Type as basic.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
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DescriptionField

provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Magento eCommerce Platform
Integration Cloud connects to Magento using the Magento REST API. You can use it to manage
customers, customer addresses, sales orders, inventory, products, and so on, without having to
directly work on Magento.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: http://<yourhost>/api/rest.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.
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Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A secret used by the Consumer to establish ownership of a givenAccess
Token.

Access Token
Secret

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Marketo
Integration Cloud connects to Marketo using the Marketo REST API and allows you to create,
retrieve, and remove entities and data stored within Marketo.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL is of the format:

Server URL

https://<instance>.mktorest.com. Replace <instance> with your actual
Marketo instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
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increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
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the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Microsoft Dynamics CRM

Integration Cloud connects to Microsoft Dynamics CRM using the Microsoft Dynamics CRM
SOAPAPI. You canmanage CRMdata and accessmetadata that defines the specific CRM instance
to which you are connecting.

DescriptionField

Provide the login endpoint to initiate communication
with the SaaS provider. For example, the end point

Server URL

URL is of the format:
https://<organization>.api.crm.dynamics.com/

XRMServices/2011/Organization.svc, where
<organization> must be replaced with your actual
Microsoft Dynamics CRM organization.

The number of milliseconds Integration Cloud waits
for a response before canceling its attempt to connect

Response Timeout

to the back end. In case the network is slow or the back
end processing takes longer than usual, increase the
Response Timeout value. It is recommended to specify
a value other than 0. If you specify 0, IntegrationCloud
will wait indefinitely for a response.

The number of times Integration Cloud attempts to
connect to the back end to read a response if the initial

Retry Count on Response Failure

attempt fails. If an I/O error occurs, it will retry only if
you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend
the request when the response has failed, even though

Retry on Response Failure

the request was sent successfully. Select this option if
you want to re-establish the connection.

This is the user account name on the SaaS provider that
the Account will use to connect to the SaaS provider.

Username
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The Account will use this credential to connect to the
SaaS provider.

Provide a password for the user name to initiate
communication with the SaaS provider.

Password

This is the type of HTTP authorization scheme to use
for the connection. If you select none, no additional

Authorization Type

authorization schemewill be executed at run time. For
example,when you specify aUsername andPassword,
but do not specify a value for the Authorization Type,
the user credentials are not inserted into an
Authorization header. If you enter the username and
password, then set the authorization type as basic.
Basic refers to HTTP Basic Authentication. This option
can be used if the Application requires or supports
HTTP Basic authentication using a username and
password.

Enable this option if youwant to send or receive a large
binary stream with a chunk size of 8192 bytes. This is

Use Chunking

applicable only if the back end supports HTTP/1.1
chunking.

Select the alias name of the Integration Cloud trust
store configuration. The trust store contains trusted

Trust store Alias

certificates used to determine trust for the remote server
peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards
againstman-in-the-middle (MITM) attacks. The default

Hostname verifier

is org.apache.http.conn.ssl.DefaultHostnameVerifier,
which will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to
disable hostname verification.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore

Keystore Alias

alias. A keystore file contains the credentials (private
key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from
this field.

Alias to the private key in the keystore file specified in
the KeystoreAlias field. The outbound connections use

Client Key Alias

this key to send client credentials to a remote server.
To send the client’s identity to a remote server, you
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must specify values in both the Keystore Alias and the
Client Key Alias fields.

Microsoft Dynamics CRM 365

Integration Cloud connects to Microsoft Dynamics CRM 365 using the OData API Version 4.0
and allows you to manage CRM data and access metadata that defines the specific CRM instance
to which you are connecting. This Application performs standard CRUD operations on business
objects by connecting to the OData service endpoint.

DescriptionField

Provide the login endpoint to initiate communication with
the SaaS provider. For example, for Microsoft Dynamics
CRM365, the end point URL is theOData service endpoint.

Server URL

Also referred to as the Client ID, this is a client identifier
issued to the client to identify itself to the authorization
server.

Consumer ID

Also referred to as the Client Secret, this is a secretmatching
to the client identifier.

Consumer Secret

A token used by the client to obtain a new access token
without involving the resource owner.

Refresh Token

This is the provider specificURL to refresh anAccess Token.Refresh URL

This token is used for authentication and is issued by the
Authorization Server.

Access Token

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back

Response Timeout

end. In case the network is slow or the back end processing
takes longer than usual, increase the Response Timeout
value. It is recommended to specify a value other than 0. If
you specify 0, Integration Cloud will wait indefinitely for
a response.

The number of times Integration Cloud attempts to connect
to the back end to read a response if the initial attempt fails.

Retry Count on Response
Failure

If an I/O error occurs, it will retry only if you have selected
the Retry on Response Failure option.

Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure

request was sent successfully. Select this option if you want
to re-establish the connection.
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Enable this option if you want to send or receive a large
binary stream with a chunk size of 8192 bytes. This is
applicable only if the back end supportsHTTP/1.1 chunking.

Use Chunking

Select this option if you want the Application to cache the
back end metadata. Caching of the metadata significantly

Caching

increases the performance of a request sent. By default, the
cache will be refreshed every 12 hours. It is recommended
to enable the cache to increase the performance.

Select the alias name of the Integration Cloud trust store
configuration. The trust store contains trusted certificates

Trust store Alias

used to determine trust for the remote server peer
certificates. You can also add a new Truststore from this
field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which
will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore alias.

Keystore Alias

A keystore file contains the credentials (private key/signed
certificate) that a client needs for authentication. You can
also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the
KeystoreAlias field. The outbound connections use this key

Client Key Alias

to send client credentials to a remote server. To send the
client’s identity to a remote server, you must specify values
in both the Keystore Alias and the Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it is

Enable SNI

attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If you want to explicitly specify a host name to be included
as a part of the SNI extension server_name parameter, in

SNI Server Name

case the host name is other than the host name specified in
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the Server URL field, specify the host name value in the SNI
Server Name field.

OData v2.0
Integration Cloud connects to any cloud application that exposes its services using the OData
Version 2.0 Specification. It supports only those OData providers, which strictly adhere to the
OData Version 2.0 Specification and allows you to perform standardCRUDoperations on business
objects by connecting to the OData service endpoint.

DescriptionField

This is the OData service endpoint to initiate communication with the
OData provider.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the OData provider that the Account
will use to connect to the OData provider.

Username

Provide the password for the user name provided in the Username
field.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example,when you specify aUsername andPassword,
and also select none, you do not specify a value for the Authorization
Type, so the user credentials are not inserted into an Authorization
header. If you enter the Username and Password, then set the
authorization type as basic. Basic refers to HTTP Basic Authentication.
This option can be used if the Application requires or supports HTTP
Basic authentication using a username and password. If you enter the
username and password, then set the authorization type as basic.
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Select this option if you want the OData v2.0 Application to cache the
backendmetadata. Caching of the metadata significantly increases the

Caching

performance of a request sent. By default, the cache will be refreshed
every 12 hours. It is recommended to enable the cache to increase the
performance.

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.
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OData v4.0
Integration Cloud connects to any cloud application that exposes its services using the OData
Version 4.0 Specification. It supports only those OData providers, which strictly adhere to the
OData Version 4.0 Specification and allows you to perform standardCRUDoperations on business
objects by connecting to the OData service endpoint.

DescriptionField

This is the OData service endpoint to initiate communication with the
OData provider.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select this option if you want the OData v4.0 Application to cache the
back endmetadata. Caching of themetadata significantly increases the

Caching

performance of a request sent. By default, the cache will be refreshed
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every 12 hours. It is recommended to enable the cache to increase the
performance.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Salesforce

Salesforce CRM

Integration Cloud connects to Salesforce using the Partner SOAP API. It supports all business
objects (for example, Account) and operations including any customizations done on the Salesforce
instance. It also supports Salesforce analytics using wave.

Note:
Click “here” on page 364 for answers to some of the most common questions on Account
configuration.
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Provide the login endpoint to initiate communication
with the SaaS provider. Example:
https://login.salesforce.com/services/Soap/u/44.0.

Server URL

This is the user account name on the SaaS provider that
the Account will use to connect to the SaaS provider.

Username

The password for the user name provided in the
Usernamefield.When you access Salesforce fromoutside

Password

your company’s trusted networks, you must append a
security token (provided by Salesforce) to your password.
Your security tokenmay have been emailed to youwhen
you had set up your Salesforce account or if you had
reset your password. For example, if your password is
abc and your security token is xxxx, then you must enter
abcxxxx. For more information about logging in to
Salesforce, see the Salesforce documentation.

The keystore used to encrypt the JWT payload.JWT Keystore

Use the same keystore which contains the private key of
the certificate (Public keys) uploaded in your Integration
in Adobe Experience Platform.

This alias is the value that is used to sign the outgoing
request from Integration Cloud to the authentication

JWT Key Alias

server. It is auto-populated based on the keystore selected
in the JWT Keystore field. This field lists all the aliases
available in the chosen keystore. Youmust provide a key
alias to sign the JWT payload.

Expiration Time (mins) is the time after which the JWT
token expires. The generated access tokenmight be valid
post expiration time as well.

Expiration Time(mins)

This token is used for authentication and is issued by the
Authorization Server. The access token is passed when

Access Token

you invoke any of the REST API endpoints. The client
application is responsible for storing and protecting this
token.

Integration Cloud will get an Access Token using the
JSONWebToken (JWT) Flow after you save theAccount.

The type of HTTP authorization scheme to use for the
connection. If you select none, no additional

Authorization Type

authorization scheme will be executed at run time. For
example, when you specify a Username and Password,
but do not specify a value for the Authorization Type,
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the user credentials are not inserted into anAuthorization
header. If you enter the username and password, then
set the authorization type as basic. Basic refers to HTTP
Basic Authentication. This option can be used if the
Application requires or supports HTTP Basic
authentication using a username and password.

The number of minutes you want Integration Cloud to
wait before terminating an idle session. The value should

Session Timeout (min)

be equal to the session time-out value specified at the
SaaS provider back end.

The number of milliseconds Integration Cloud waits for
a response before canceling its attempt to connect to the

Response Timeout

back end. In case the network is slow or the back end
processing takes longer than usual, increase the
Response Timeout value. It is recommended to specify
a value other than 0. If you specify 0, Integration Cloud
will wait indefinitely for a response.

The number of milliseconds a connection waits before
canceling its attempt to connect to the resource. If you

Connection TimeOut

specify 0, the connection waits indefinitely. It is
recommended that you specify a value other than 0 to
avoid using a socket with no timeout.

The number of times the system should attempt to
initialize the connection at startup if the initial attempt
fails.

Connection Retry Count

The system retries to establish a connectionwhen an I/O
error occurs while sending the request message to the
back end. If an I/O exception occurs when the system is
reading a response back from the back end, the system
will only retry if Retry on Response Failure is enabled.

Applicablewhen you select theOAuth V2.0 (JWT Flow)
as the Authentication Type. This is the Client ID, or

Issuer

Identifier, or name of the server or system issuing the
JWT token.

Applicablewhen you select theOAuth V2.0 (JWT Flow)
as the Authentication Type. This is the identifier or the
name of the user this token represents.

Subject

Applicable when you select the OAuth V2.0
(Authorization Code Flow) as the Authentication Type.

Consumer ID

Also referred to as the Client ID, this is a client identifier

228 Integration Cloud 6.6.0

5 Applications



DescriptionField

issued to the client to identify itself to the authorization
server.

Applicable when you select the OAuth V2.0
(Authorization Code Flow) as the Authentication Type.

Consumer Secret

Also referred to as the Client Secret, this is a secret
matching to the client identifier.

Applicable when you select the OAuth V2.0
(Authorization Code Flow) as the Authentication Type.

Refresh Token

A token used by the client to obtain a new access token
without involving the resource owner.

Applicable when you select the OAuth V2.0
(Authorization Code Flow) as the Authentication Type.

Refresh URL

This is the provider specific URL to refresh an Access
Token.

The number of times Integration Cloud attempts to
connect to the back end to read a response if the initial

Retry Count on Response
Failure

attempt fails. If an I/O error occurs, it will retry only if
you have selected theRetry on Response Failure option.

Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure

request was sent successfully. Select this option if you
want to re-establish the connection.

Select the alias name of the Integration Cloud trust store
configuration. The trust store contains trusted certificates

Trust store Alias

used to determine trust for the remote server peer
certificates. You can also add a new Truststore from this
field.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore

Keystore Alias

alias. A keystore file contains the credentials (private
key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from
this field.

Alias to the private key in the keystore file specified in
the Keystore Alias field. The outbound connections use

Client Key Alias

this key to send client credentials to a remote server. To
send the client’s identity to a remote server, you must
specify values in both the Keystore Alias and the Client
Key Alias fields.
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Select a hostname verifier implementation. Guards
against man-in-the-middle (MITM) attacks. The default

Hostname verifier

is org.apache.http.conn.ssl.DefaultHostnameVerifier,
which will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to
disable hostname verification.

Enable this option if you want to send or receive a large
binary stream with a chunk size of 8192 bytes. This is

Use Chunking

applicable only if the back end supports HTTP/1.1
chunking.

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it

Enable SNI

is attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect
to an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If you want to explicitly specify a host name to be
included as a part of the SNI extension server_name

SNI Server Name

parameter, in case the host name is other than the host
name specified in the Server URL field, specify the host
name value in the SNI Server Name field.

Select this option if you want to enable connection
pooling for a connection.

Enable Connection Pooling

Integration Cloud includes a connection management
service that dynamically manages connections and
connection pools based on configuration settings that
you specify for the connection. A connection pool is a
collection of connections with the same set of attributes.
Connection pools improve performance by enabling
Integrations to reuse open connections instead of opening
new connections for every service request.

When you enable connection pooling, IntegrationCloud
creates the number of connection instances you specified
in the connection's Minimum Pool Size field. Whenever
an Integration needs a connection, Integration Cloud
provides a connection from the pool. If no connections
are available in the pool, and the Maximum Pool Size
has not been reached, Integration Cloud creates one or
more newconnections (according to the number specified
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in the Pool Increment Size field) and adds them to the
connection pool.

If the pool is full (as specified in theMaximum Pool Size
field), the requesting service will wait for Integration
Cloud to obtain a connection till one sec, until a
connection becomes available. Periodically, Integration
Cloud inspects the pool and removes inactive connections
that have exceeded the expiration period of one sec.

Theminimumnumber of connection objects that remain
in the connection pool at all times, if connection pooling

Minimum Pool Size

is enabled.When the connector creates the pool, it creates
this number of connections.

The maximum number of connection objects that can
exist in the connection pool if connection pooling is

Maximum Pool Size

enabled. When the connection pool has reached its
maximum number of connections, the connector will
reuse any inactive connections in the pool, or, if all
connections are active, it will wait for a connection to
become available.

The number of connections by which the pool will be
incremented, up to themaximumpool size, if connection
pooling is enabled and connections are needed.

Pool Increment Size

The keep alive interval in milliseconds defines the
interval for which a connection will be kept alive, if the

Keep Alive Interval

back end does not respond with a Keep-Alive header. A
value > 0 keeps the connection alive for the specified
value. The default value of -1 implies that the connection
will be kept alive until a request fails due to a connection
error.

Specify the grant type through which applications can
gain Access Tokens and by which you grant limited

Grant Type

access to your resources to another entity without
exposing credentials. TheAuthorizationCode grant type
is used by confidential and public clients to exchange an
authorization code for an access token. The Refresh
Token grant type is used by clients to exchange a refresh
token for an access token when the access token has
expired.

The idle timeout interval in milliseconds defines the
interval for which a connection will be kept alive if it's

Idle Timeout

not in use. A value > 0 keeps the connection alive for the
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specified value. The default value of -1 implies that the
connection will be kept alive until a request fails due to
a connection error.

The number of milliseconds that Integration Cloud will
wait to obtain a connectionwith the SaaS provider before
the connection times out and returns an error.

Block Timeout (msec)

For example, you have a pool with Maximum Pool Size
of 20. If you receive 30 simultaneous requests for a
connection, 10 requests will be waiting for a connection
from the pool. If you set the Block Timeout to 5000, the
10 requestswill wait for a connection for 5 seconds before
they time out and return an error. If the services using
the connections require 10 seconds to complete and
return connections to the pool, the pending requestswill
fail and return an error message stating that no
connections are available.

If you set the Block Timeout value too high, you may
encounter problems during error conditions. If a request
contains errors that delay the response, other requests
will not be sent. This setting should be tuned in
conjunction with the Maximum Pool Size to
accommodate such bursts in processing.

Default: 1000 msec

The number of milliseconds that an inactive connection
can remain in the pool before it is closed and removed
from the pool, if connection pooling is enabled.

Expire Timeout (msec)

The connection pool will remove inactive connections
until the number of connections in the pool is equal to
the Initial Pool Size. The inactivity timer for a connection
is reset, when the connection is used by the Application.

This setting should be tuned in conjunction with the
Initial Pool Size to avoid excessive opening and closing
of connections during normal processing.

The general recommendation is to keep the Expire
Timeout value equal to the Session Timeout value.

Default: 1000 msec
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Salesforce Bulk Data Loader

IntegrationCloud connects to Salesforce using the Salesforce BulkAPI and supports Job and Batch
resources. You can use it to create, update, delete, query jobs and batches, and operate on large
number of records asynchronously by submitting batches which are processed in the background
by Salesforce.

Note:
Click “here” on page 364 for answers to some of the most common questions on Account
configuration.

DescriptionField

Provide the login endpoint to initiate communication with
the SaaS provider. Example:
https://login.salesforce.com/services/Soap/u/31.0.

Server URL

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back

Response Timeout

end. In case the network is slow or the back end processing
takes longer than usual, increase the Response Timeout
value. It is recommended to specify a value other than 0. If
you specify 0, Integration Cloud will wait indefinitely for
a response.

Applicable when you select the OAuth V2.0 (JWT Flow)
as the Authentication Type. This is the Client ID, or

Issuer

Identifier, or name of the server or system issuing the JWT
token.

Applicable when you select the OAuth V2.0 (JWT Flow)
as the Authentication Type. This is the identifier or the
name of the user this token represents.

Subject

The keystore used to encrypt the JWT payload.JWT Keystore

Use the same keystore which contains the private key of
the certificate (Public keys) uploaded in your Integration
in Adobe Experience Platform.

This alias is the value that is used to sign the outgoing
request from IntegrationCloud to the authentication server.

JWT Key Alias

It is auto-populated based on the keystore selected in the
JWT Keystore field. This field lists all the aliases available
in the chosen keystore. Youmust provide a key alias to sign
the JWT payload.

Expiration Time (mins) is the time after which the JWT
token expires. The generated access token might be valid
post expiration time as well.

Expiration Time(mins)
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The number of milliseconds a connection waits before
canceling its attempt to connect to the resource. If you

Connection TimeOut

specify 0, the connection waits indefinitely. It is
recommended that you specify a value other than 0 to avoid
using a socket with no timeout.

The number of times the system should attempt to initialize
the connection at startup if the initial attempt fails.

Connection Retry Count

The system retries to establish a connection when an I/O
error occurs while sending the request message to the back
end. If an I/O exception occurs when the system is reading
a response back from the back end, the system will only
retry if Retry on Response Failure is enabled.

This token is used for authentication and is issued by the
Authorization Server. The access token is passedwhen you

Access Token

invoke any of the REST API endpoints. The client
application is responsible for storing and protecting this
token.

Integration Cloudwill get anAccess Token using the JSON
Web Token (JWT) Flow after you save the Account.

Applicablewhen you select theOAuth V2.0 (Authorization
Code Flow) as the Authentication Type. Also referred to

Consumer ID

as the Client ID, this is a client identifier issued to the client
to identify itself to the authorization server.

Applicablewhen you select theOAuth V2.0 (Authorization
Code Flow) as the Authentication Type. Also referred to

Consumer Secret

as the Client Secret, this is a secret matching to the client
identifier.

Applicablewhen you select theOAuth V2.0 (Authorization
Code Flow) as the Authentication Type. A token used by

Refresh Token

the client to obtain a new access token without involving
the resource owner.

Applicablewhen you select theOAuth V2.0 (Authorization
Code Flow) as theAuthentication Type. This is the provider
specific URL to refresh an Access Token.

Refresh URL

The number of times IntegrationCloud attempts to connect
to the back end to read a response if the initial attempt fails.

Retry Count on Response
Failure

If an I/O error occurs, it will retry only if you have selected
the Retry on Response Failure option.
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Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure

request was sent successfully. Select this option if youwant
to re-establish the connection.

This is the user account name on the SaaS provider that the
Account will use to connect to the SaaS provider.

Username

The password for the user name provided in theUsername
field. When you access Salesforce from outside your

Password

company’s trusted networks, you must append a security
token (provided by Salesforce) to your password. Your
security token may have been emailed to you when you
had set up your Salesforce account or if you had reset your
password. For example, if your password is abc and your
security token is xxxx, then you must enter abcxxxx. For
more information about logging in to Salesforce, see the
Salesforce documentation.

The type of HTTP authorization scheme to use for the
connection. If you select none, no additional authorization

Authorization Type

scheme will be executed at run time. For example, when
you specify a Username and Password, but do not specify
a value for the Authorization Type, the user credentials are
not inserted into an Authorization header. If you enter the
username and password, then set the authorization type
as basic. Basic refers to HTTP Basic Authentication. This
option can be used if the Application requires or supports
HTTPBasic authenticationusing a username andpassword.

The number ofminutes youwant IntegrationCloud towait
before terminating an idle session. The value should be

Session Timeout (min)

equal to the session timeout value specified at the SaaS
provider back end.

Specify the grant type throughwhich applications can gain
Access Tokens and by which you grant limited access to

Grant Type

your resources to another entity without exposing
credentials. The Authorization Code grant type is used by
confidential and public clients to exchange an authorization
code for an access token. The Refresh Token grant type is
used by clients to exchange a refresh token for an access
token when the access token has expired.

Enable this option if you want to send or receive a large
binary stream with a chunk size of 8192 bytes. This is

Use Chunking

applicable only if the back end supports HTTP/1.1
chunking.
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Select the alias name of the Integration Cloud trust store
configuration. The trust store contains trusted certificates

Trust store Alias

used to determine trust for the remote server peer
certificates. You can also add a new Truststore from this
field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which
will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification.

The keep alive interval in milliseconds defines the interval
for which a connection will be kept alive, if the back end

Keep Alive Interval

does not respond with a Keep-Alive header. A value > 0
keeps the connection alive for the specified value. The
default value of -1 implies that the connection will be kept
alive until a request fails due to a connection error.

The idle timeout interval inmilliseconds defines the interval
for which a connection will be kept alive if it's not in use.

Idle Timeout

A value > 0 keeps the connection alive for the specified
value. The default value of -1 implies that the connection
will be kept alive until a request fails due to a connection
error.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore alias.

Keystore Alias

A keystore file contains the credentials (private key/signed
certificate) that a client needs for authentication. You can
also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the
Keystore Alias field. The outbound connections use this

Client Key Alias

key to send client credentials to a remote server. To send
the client’s identity to a remote server, you must specify
values in both the Keystore Alias and the Client Key Alias
fields.

Select this option if you want to enable connection pooling
for a connection.

Enable Connection Pooling

Integration Cloud includes a connection management
service that dynamically manages connections and
connection pools based on configuration settings that you
specify for the connection. A connection pool is a collection
of connections with the same set of attributes. Connection
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pools improve performance by enabling Integrations to
reuse open connections instead of opening new connections
for every service request.

When you enable connection pooling, Integration Cloud
creates the number of connection instances you specified
in the connection's Minimum Pool Size field. Whenever an
Integration needs a connection, IntegrationCloud provides
a connection from the pool. If no connections are available
in the pool, and the Maximum Pool Size has not been
reached, Integration Cloud creates one or more new
connections (according to the number specified in the Pool
Increment Size field) and adds them to the connection pool.

If the pool is full (as specified in the Maximum Pool Size
field), the requesting servicewill wait for IntegrationCloud
to obtain a connection till one sec, until a connection
becomes available. Periodically, IntegrationCloud inspects
the pool and removes inactive connections that have
exceeded the expiration period of one sec.

The minimum number of connection objects that remain
in the connection pool at all times, if connection pooling is

Minimum Pool Size

enabled.When the connector creates the pool, it creates this
number of connections.

The maximum number of connection objects that can exist
in the connection pool if connection pooling is enabled.

Maximum Pool Size

When the connection pool has reached its maximum
number of connections, the connectorwill reuse any inactive
connections in the pool, or, if all connections are active, it
will wait for a connection to become available.

The number of connections by which the pool will be
incremented, up to the maximum pool size, if connection
pooling is enabled and connections are needed.

Pool Increment Size

The number of milliseconds that Integration Cloud will
wait to obtain a connection with the SaaS provider before
the connection times out and returns an error.

Block Timeout (msec)

For example, you have a pool with Maximum Pool Size of
20. If you receive 30 simultaneous requests for a connection,
10 requests will be waiting for a connection from the pool.
If you set the Block Timeout to 5000, the 10 requests will
wait for a connection for 5 seconds before they time out
and return an error. If the services using the connections
require 10 seconds to complete and return connections to
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the pool, the pending requests will fail and return an error
message stating that no connections are available.

If you set the Block Timeout value too high, you may
encounter problems during error conditions. If a request
contains errors that delay the response, other requests will
not be sent. This setting should be tuned in conjunction
with the Maximum Pool Size to accommodate such bursts
in processing.

Default: 1000 msec

The number ofmilliseconds that an inactive connection can
remain in the pool before it is closed and removed from the
pool, if connection pooling is enabled.

Expire Timeout (msec)

The connection poolwill remove inactive connections until
the number of connections in the pool is equal to the Initial
Pool Size. The inactivity timer for a connection is reset,
when the connection is used by the Application.

This setting should be tuned in conjunction with the Initial
Pool Size to avoid excessive opening and closing of
connections during normal processing.

The general recommendation is to keep the Expire Timeout
value equal to the Session Timeout value.

Default: 1000 msec

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it is

Enable SNI

attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If youwant to explicitly specify a host name to be included
as a part of the SNI extension server_name parameter, in

SNI Server Name

case the host name is other than the host name specified in
the Server URL field, specify the host name value in the
SNI Server Name field.
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Salesforce
®

 Bulk v2 Data Loader
Using the Bulk API 2.0, Salesforce supports Job resource, and allows you to create, update, delete,
upsert jobs, and operate on large number of records asynchronously by submitting jobs which are
processed in the background.

Note:
Click “here” on page 364 for answers to some of the most common questions on Account
configuration.

DescriptionField

Provide the login endpoint to initiate communication with
the SaaS provider. For example,

Server URL

https://<instance>.salesforce.com. Replace <instance> with
your actual Salesforce instance.

Also referred to as the Client ID, this is a client identifier
issued to the client to identify itself to the authorization
server.

Consumer ID

The keystore used to encrypt the JWT payload.JWT Keystore

Use the same keystorewhich contains the private key of the
certificate (Public keys) uploaded in the Digital Certificate
section on your Connected Apps in Salesforce.

This alias is the value that is used to sign the outgoing
request from Integration Cloud to the authentication server.

JWT Key Alias

It is auto-populated based on the keystore selected in the
JWT Keystore field. This field lists all the aliases available
in the chosen keystore. Youmust provide a key alias to sign
the JWT payload.

Expiration Time (mins) is the time afterwhich the JWT token
expires. The generated access token might be valid post
expiration time as well.

Expiration Time(mins)

This token is used for authentication and is issued by the
Authorization Server. Salesforce RESTAPIs use OAuth 2.0.

Access Token

The access token is passedwhen you invoke any of the REST
API endpoints and is valid for one hour. It is not affected
by password changes. The client application is responsible
for storing and protecting this token. You can manage the
Salesforce REST connection by enabling the connection pool
and session management.
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If you have selected the OAuth V2.0 (JWT Flow) as the
Authentication Type, Integration Cloud will get an Access
Token using the JWT flow after you save the Account.

Also referred to as the Client Secret, this is a secretmatching
to the client identifier.

Consumer Secret

A token used by the client to obtain a new access token
without involving the resource owner.

Refresh Token

This is the provider specificURL to refresh anAccess Token,
for example,
https://<instance>.salesforce.com/services/oauth2/token.

Refresh URL

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back

Response Timeout

end. In case the network is slow or the back end processing
takes longer than usual, increase the Response Timeout
value. It is recommended to specify a value other than 0. If
you specify 0, Integration Cloud will wait indefinitely for
a response.

The number of times Integration Cloud attempts to connect
to the back end to read a response if the initial attempt fails.

Retry Count on Response
Failure

If an I/O error occurs, it will retry only if you have selected
the Retry on Response Failure option.

Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure

request was sent successfully. Select this option if you want
to re-establish the connection.

The number ofminutes youwant Integration Cloud towait
before terminating an idle session. The value should be

Session Timeout (min)

equal to the session timeout value specified at the SaaS
provider back end.

Select the alias name of the Integration Cloud trust store
configuration. The trust store contains trusted certificates

Trust store Alias

used to determine trust for the remote server peer
certificates. You can also add a new Truststore from this
field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which
will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification.
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Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore alias.

Keystore Alias

A keystore file contains the credentials (private key/signed
certificate) that a client needs for authentication. You can
also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the
KeystoreAlias field. The outbound connections use this key

Client Key Alias

to send client credentials to a remote server. To send the
client’s identity to a remote server, you must specify values
in both the Keystore Alias and the Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it is

Enable SNI

attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If you want to explicitly specify a host name to be included
as a part of the SNI extension server_name parameter, in

SNI Server Name

case the host name is other than the host name specified in
the Server URL field, specify the host name value in the SNI
Server Name field.

The keep alive interval in milliseconds defines the interval
for which a connection will be kept alive, if the back end

Keep Alive Interval

does not respond with a Keep-Alive header. A value > 0
keeps the connection alive for the specified value. The
default value of -1 implies that the connection will be kept
alive until a request fails due to a connection error.

Specify the grant type throughwhich applications can gain
Access Tokens and by which you grant limited access to

Grant Type

your resources to another entity without exposing
credentials. The Authorization Code grant type is used by
confidential and public clients to exchange an authorization
code for an access token. The Refresh Token grant type is
used by clients to exchange a refresh token for an access
token when the access token has expired.

The number ofmilliseconds that IntegrationCloudwill wait
to obtain a connection with the SaaS provider before the
connection times out and returns an error.

Block Timeout (msec)
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For example, you have a pool with Maximum Pool Size of
20. If you receive 30 simultaneous requests for a connection,
10 requests will be waiting for a connection from the pool.
If you set the Block Timeout to 5000, the 10 requests will
wait for a connection for 5 seconds before they time out and
return an error. If the services using the connections require
10 seconds to complete and return connections to the pool,
the pending requests will fail and return an error message
stating that no connections are available.

If you set the Block Timeout value too high, you may
encounter problems during error conditions. If a request
contains errors that delay the response, other requests will
not be sent. This setting should be tuned in conjunctionwith
the Maximum Pool Size to accommodate such bursts in
processing.

Default: 1000 msec

The number ofmilliseconds that an inactive connection can
remain in the pool before it is closed and removed from the
pool, if connection pooling is enabled.

Expire Timeout (msec)

The connection pool will remove inactive connections until
the number of connections in the pool is equal to the Initial
Pool Size. The inactivity timer for a connection is reset, when
the connection is used by the Application.

This setting should be tuned in conjunction with the Initial
Pool Size to avoid excessive opening and closing of
connections during normal processing.

The general recommendation is to keep the Expire Timeout
value equal to the Session Timeout value.

Default: 1000 msec

The idle timeout interval inmilliseconds defines the interval
for which a connection will be kept alive if it's not in use. A

Idle Timeout

value > 0 keeps the connection alive for the specified value.
The default value of -1 implies that the connection will be
kept alive until a request fails due to a connection error.

Salesforce® CRM REST
Integration Cloud connects to Salesforce® CRM REST using the REST API and allows you to
manage security for inbound requests, log payloads and specify run-time performance conditions
for consumers for outbound requests. It also supports multiple authentication mechanisms.
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Note:
Click “here” on page 364 for answers to some of the most common questions on Account
configuration.

DescriptionField

Provide the login endpoint to initiate communication with
the SaaS provider. For example,

Server URL

https://<instance>.salesforce.com. Replace <instance> with
your actual Salesforce instance.

Applicable when you select the OAuth V2.0 (JWT Flow)
as the Authentication Type. This is the Client ID, or

Issuer

Identifier, or name of the server or system issuing the JWT
token.

Applicable when you select the OAuth V2.0 (JWT Flow)
as theAuthentication Type. This is the identifier or the name
of the user this token represents.

Subject

Also referred to as the Client ID, this is a client identifier
issued to the client to identify itself to the authorization
server.

Consumer ID

Also referred to as the Client Secret, this is a secretmatching
to the client identifier.

Consumer Secret

A token used by the client to obtain a new access token
without involving the resource owner.

Refresh Token

This is the provider specificURL to refresh anAccess Token,
for example,
https://login.salesforce.com/services/oauth2/token.

Refresh URL

The keystore used to encrypt the JWT payload.JWT Keystore

Use the same keystorewhich contains the private key of the
certificate (Public keys) uploaded in the Digital Certificate
section on your Connected Apps in Salesforce.

This alias is the value that is used to sign the outgoing
request from Integration Cloud to the authentication server.

JWT Key Alias

It is auto-populated based on the keystore selected in the
JWT Keystore field. This field lists all the aliases available
in the chosen keystore. Youmust provide a key alias to sign
the JWT payload.

Expiration Time (mins) is the time afterwhich the JWT token
expires. The generated access token might be valid post
expiration time as well.

Expiration Time(mins)
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This token is used for authentication and is issued by the
Authorization Server. Salesforce RESTAPIs use OAuth 2.0.

Access Token

The access token is passedwhen you invoke any of the REST
API endpoints and is valid for one hour. It is not affected
by password changes. The client application is responsible
for storing and protecting this token. You can manage the
Salesforce REST connection by enabling the connection pool
and session management.

If you have selected the OAuth V2.0 (JWT Flow) as the
Authentication Type, Integration Cloud will get an Access
Token using the JWT flow after you save the Account.

The number of milliseconds Integration Cloud waits for a
response before canceling its attempt to connect to the back

Response Timeout

end. In case the network is slow or the back end processing
takes longer than usual, increase the Response Timeout
value. It is recommended to specify a value other than 0. If
you specify 0, Integration Cloud will wait indefinitely for
a response.

The number of times Integration Cloud attempts to connect
to the back end to read a response if the initial attempt fails.

Retry Count on Response
Failure

If an I/O error occurs, it will retry only if you have selected
the Retry on Response Failure option.

Whether Integration Cloud should attempt to resend the
request when the response has failed, even though the

Retry on Response Failure

request was sent successfully. Select this option if you want
to re-establish the connection.

The number ofminutes youwant Integration Cloud towait
before terminating an idle session. The value should be

Session Timeout (min)

equal to the session timeout value specified at the SaaS
provider back end.

Select the alias name of the Integration Cloud trust store
configuration. The trust store contains trusted certificates

Trust store Alias

used to determine trust for the remote server peer
certificates. You can also add a new Truststore from this
field.

Select this option if you want to enable connection pooling
for a connection.

Enable Connection Pooling

Integration Cloud includes a connection management
service that dynamically manages connections and
connection pools based on configuration settings that you
specify for the connection. A connection pool is a collection
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of connections with the same set of attributes. Connection
pools improve performance by enabling Integrations to
reuse open connections instead of opening new connections
for every service request.

When you enable connection pooling, Integration Cloud
creates the number of connection instances you specified
in the connection's Minimum Pool Size field. Whenever an
Integration needs a connection, IntegrationCloud provides
a connection from the pool. If no connections are available
in the pool, and the Maximum Pool Size has not been
reached, Integration Cloud creates one or more new
connections (according to the number specified in the Pool
Increment Size field) and adds them to the connection pool.

If the pool is full (as specified in the Maximum Pool Size
field), the requesting servicewill wait for IntegrationCloud
to obtain a connection till one sec, until a connection
becomes available. Periodically, Integration Cloud inspects
the pool and removes inactive connections that have
exceeded the expiration period of one sec.

The minimum number of connection objects that remain in
the connection pool at all times, if connection pooling is

Minimum Pool Size

enabled.When the connector creates the pool, it creates this
number of connections.

The maximum number of connection objects that can exist
in the connection pool if connection pooling is enabled.

Maximum Pool Size

When the connectionpool has reached itsmaximumnumber
of connections, the connector will reuse any inactive
connections in the pool, or, if all connections are active, it
will wait for a connection to become available.

The number of connections by which the pool will be
incremented, up to the maximum pool size, if connection
pooling is enabled and connections are needed.

Pool Increment Size

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which
will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification.

Select the alias for the Integration Cloud key store
configuration. This is a text identifier for the keystore alias.

Keystore Alias

A keystore file contains the credentials (private key/signed

Integration Cloud 6.6.0 245

5 Applications



DescriptionField

certificate) that a client needs for authentication. You can
also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the
KeystoreAlias field. The outbound connections use this key

Client Key Alias

to send client credentials to a remote server. To send the
client’s identity to a remote server, you must specify values
in both the Keystore Alias and the Client Key Alias fields.

The number of milliseconds a connection waits before
canceling its attempt to connect to the resource. If you

Connection TimeOut

specify 0, the connection waits indefinitely. It is
recommended that you specify a value other than 0 to avoid
using a socket with no timeout.

The number of times the system should attempt to initialize
the connection at startup if the initial attempt fails.

Connection Retry Count

The system retries to establish a connection when an I/O
error occurs while sending the request message to the back
end. If an I/O exception occurs when the system is reading
a response back from the back end, the system will only
retry if Retry on Response Failure is enabled.

The keep alive interval in milliseconds defines the interval
for which a connection will be kept alive, if the back end

Keep Alive Interval

does not respond with a Keep-Alive header. A value > 0
keeps the connection alive for the specified value. The
default value of -1 implies that the connection will be kept
alive until a request fails due to a connection error.

Specify the grant type throughwhich applications can gain
Access Tokens and by which you grant limited access to

Grant Type

your resources to another entity without exposing
credentials. The Authorization Code grant type is used by
confidential and public clients to exchange an authorization
code for an access token. The Refresh Token grant type is
used by clients to exchange a refresh token for an access
token when the access token has expired.

The idle timeout interval inmilliseconds defines the interval
for which a connection will be kept alive if it's not in use. A

Idle Timeout

value > 0 keeps the connection alive for the specified value.
The default value of -1 implies that the connection will be
kept alive until a request fails due to a connection error.

The number ofmilliseconds that IntegrationCloudwill wait
to obtain a connection with the SaaS provider before the
connection times out and returns an error.

Block Timeout (msec)
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DescriptionField

For example, you have a pool with Maximum Pool Size of
20. If you receive 30 simultaneous requests for a connection,
10 requests will be waiting for a connection from the pool.
If you set the Block Timeout to 5000, the 10 requests will
wait for a connection for 5 seconds before they time out and
return an error. If the services using the connections require
10 seconds to complete and return connections to the pool,
the pending requests will fail and return an error message
stating that no connections are available.

If you set the Block Timeout value too high, you may
encounter problems during error conditions. If a request
contains errors that delay the response, other requests will
not be sent. This setting should be tuned in conjunctionwith
the Maximum Pool Size to accommodate such bursts in
processing.

Default: 1000 msec

The number ofmilliseconds that an inactive connection can
remain in the pool before it is closed and removed from the
pool, if connection pooling is enabled.

Expire Timeout (msec)

The connection pool will remove inactive connections until
the number of connections in the pool is equal to the Initial
Pool Size. The inactivity timer for a connection is reset, when
the connection is used by the Application.

This setting should be tuned in conjunction with the Initial
Pool Size to avoid excessive opening and closing of
connections during normal processing.

The general recommendation is to keep the Expire Timeout
value equal to the Session Timeout value.

Default: 1000 msec

Server Name Indication (SNI) is an extension to the TLS
protocol by which a client indicates which host name it is

Enable SNI

attempting to connect to at the start of the handshaking
process. Enable this option if the SaaS provider offers
SNI-based TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host name
specified in the Server URL field, as part of the TLS SNI
Extension server_name parameter.

If you want to explicitly specify a host name to be included
as a part of the SNI extension server_name parameter, in

SNI Server Name

case the host name is other than the host name specified in
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DescriptionField

the Server URL field, specify the host name value in the SNI
Server Name field.

SAP Cloud for Customer(C4C) OData v2.0
Integration Cloud connects to SAPCloud for Customer (C4C) including SAPCloud for Sales, SAP
Cloud for Service, and SAP Cloud for Social Engagement solutions using the REST interface, and
allows you to do standardCRUDoperations on business objects by connecting to theOData Service
endpoint.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. This is the OData service endpoint to initiate communication
with the SAP C4C OData provider.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SAP C4COData provider that the
Account will use to connect to the SaaS provider. The Account will use
this credential to connect to the SaaS provider.

Username

Provide the password for the user name provided in the Username
field to initiate communication with the SaaS provider.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example,when you specify aUsername andPassword,
and also select none, you do not specify a value for the Authorization
Type, so the user credentials are not inserted into an Authorization
header. If you enter the Username and Password, then set the
authorization type as basic. Basic refers to HTTP Basic Authentication.
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This option can be used if the Application requires or supports HTTP
Basic authentication using a username and password.

Select this option if you want the SAP C4C Application to cache the
backendmetadata. Caching of the metadata significantly increases the

Metadata
Caching

performance of a request sent through SAP C4C. If this option is
selected, the cachewill be refreshed every 12 hours. It is recommended
to enable the metadata cache to increase the performance.

To prevent cross site request forgery, SAP C4C protects its resources
by using a CSRF token. Select this option if youwant IntegrationCloud

Use CSRF Token

to use the CSRF token key, received in the response from SAP C4C, to
perform any state changing requests on SAPC4C. By default, the CSRF
token is enabled by the SAPC4C back end. Youmust enable this option
particularly when the entity state changing operation is invoked.

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
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the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

SAP S/4HANA Marketing Cloud
Integration Cloud connects to SAP S/4HANAMarketing Cloud using the OData based REST
interface, which allows you to do only bulk imports. You can create or update Interaction Contacts,
Interactions, Interests, Corporate Accounts, Product Categories, Products, and so on.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. This is the OData service endpoint to initiate communication
with the SAP S/4HANAMarketing Cloud provider.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SAP S/4HANAMarketing Cloud
provider that the Account will use to connect to the SaaS provider. The
Account will use this credential to connect to the SaaS provider.

Username

Provide the password for the user name provided in the Username
field to initiate communication with the SaaS provider.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example,when you specify aUsername andPassword,
and also select none, you do not specify a value for the Authorization
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Type, so the user credentials are not inserted into an Authorization
header. If you enter the Username and Password, then set the
authorization type as basic. Basic refers to HTTP Basic Authentication.
This option can be used if the Application requires or supports HTTP
Basic authentication using a username and password.

Select this option if you want the SAP S/4HANAMarketing Cloud
Application to cache the back end metadata. Caching of the metadata

Metadata
Caching

significantly increases the performance of a request sent through SAP
S/4HANAMarketing Cloud. If this option is selected, the cache will be
refreshed every 12 hours. It is recommended to enable the metadata
cache to increase the performance.

Whether to validate the $metadata xml during edm object creation.
Select this option to enable the metadata validation.

Validate
Metadata

To prevent cross site request forgery, SAP S/4HANAMarketing Cloud
protects its resources by using a CSRF token. Select this option if you

Use CSRF Token

want Integration Cloud to use the CSRF token key, received in the
response from SAP S/4HANAMarketing Cloud, to perform any state
changing requests on SAP S/4HANAMarketing Cloud. By default, the
CSRF token is enabled by the SAP S/4HANAMarketing Cloud back
end. You must enable this option particularly when the entity state
changing operation is invoked.

Enable this option if you want to send or receive a large binary stream
with a chunk size of 8192 bytes. This is applicable only if the back end
supports HTTP/1.1 chunking.

Use Chunking

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
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server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Secure File Transfer Protocol (SFTP)
The SSH File Transfer Protocol (SFTP) is a network protocol that is based on the Secure Shell
protocol (SSH). SFTP facilitates secure file access, file transfer, and file management over any
reliable data stream. The Secure File Transfer Protocol (SFTP) Application downloads files from
or uploads files to an SFTP-enabled server using the secure file transport channel.

Integration Cloud connects to an SFTP server using the SSH File Transfer Protocol (SFTP) and
provides operations to retrieve, transfer, rename, and delete files or directories in the SFTP server.
You can also change the permission or ownership of files in the SFTP server.

You can configure Integration Cloud to connect to an SFTP server to perform the following tasks
using the SFTP protocol:

Transfer files between Integration Cloud and the SFTP server. You can get a file from the SFTP
server or upload a file to the SFTP server.

Access files in the SFTP server. You can view the directories and files in the SFTP server and
also view their permissions and ownership information.

Manage directories or files in the SFTP server. You can create, rename, or delete files or
directories in the SFTP server. You can also change the permissions or ownership of files in
the SFTP server.

Specify...For this parameter...

The host name or IP address of the SFTP server.Host Name or IP
Address

The port number of the SFTP server. The port number must be within the
range of 1 and 65535 (inclusive).

Port Number
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Specify...For this parameter...

The public key of the SFTP server. Select Auto Retrieve if you want
IntegrationCloud to automatically retrieve the public key of the SFTP server.

Host Public Key

Select Upload if you have the public key of the SFTP server. Integration
Cloud will use the uploaded public key.

The host public key fingerprint of the SFTP server.Finger Print

Note:
This field is visible only after you have established a connection to an
SFTP server.

Before establishing a connection, the SFTP server sends an encrypted
fingerprint of its host public keys to ensure that the SFTP connection will
be exchanging datawith the correct server. Save the fingerprint information
locally. This enables you to check the fingerprint information against the
data you have saved every time you establish a new connection.

The user name for the SFTP user account.User Name

The type of authentication Integration Cloud uses to authenticate itself to
the SFTP server. Client authentication can be either by password or by public

Authentication
Type

and private keys. Select Password if you want to use password
authentication. If you are using password authentication, enter the password
for the specified user to connect to the SFTP server. Select Public Key if you
want to authenticate Integration Cloud by using public and private keys.
To use this authentication type, the SFTP server and Integration Cloudmust
each have access to their own private key and each other's public key.

If you selected Public Key as the authentication type, select the private key
file of the specified SFTP user.

Private Key

If you selected Public Key as the authentication type and if the private key
you specified requires a passphrase, enter the passphrase for the private key
file of the specified user.

PassPhrase

Advanced Options

The number of times Integration Cloud attempts to connect to the SFTP
server. The maximum allowed value is 6. The minimum allowed value is 1.

Maximum Retries

The amount of time (measured in seconds) Integration Cloud waits for a
response from the SFTP server before timing out and terminating the request.

Response Timeout

Avalue of 0 indicates that the sessionwill never time out. In case the network
is slow or the back end processing takes longer than usual, increase the
Response Timeout value.

The number of minutes you want Integration Cloud to wait before
terminating an idle session. The session timeout value must be within the
range of 10 and 60 minutes.

Session Timeout
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Specify...For this parameter...

The algorithms that Integration Cloud presents to the SFTP server for key
exchange. You can specify the order in which Integration Cloud presents

Preferred Key
Exchange
Algorithms the algorithms to the SFTP server by moving the available algorithms up or

down by clicking Move Up or Move Down. The SFTP server has its own
set of preferred algorithms configured. At the time of key exchange, one of
the algorithms supported by both Integration Cloud and the SFTP server
will be chosen.

Whether or not to compress the data to reduce the amount of data that is
transmitted. IntegrationCloud supports compression using the compression

Compression

algorithm zlib. You can use compression only if the SFTP server that you
are connecting to supports compression. Select None if you do not want to
compress the data. Select zlib if you want to compress the data that is
transmitted between the SFTP server and Integration Cloud.

The compression level to use if you selected the compression algorithm zlib
in the Compression field. The minimum allowed value is 1 (fast, less
compression) and themaximumallowedvalue is 9 (slow,most compression).

Compression Level

SFTP Predefined Operations

The following predefined SFTP operations are available:

cd

Changes the working directory on the remote SFTP server.

Input Parameters

String Absolute or relative path of the directory that you want as the working
directory on the remote SFTP server.

path

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

chgrp

Changes the group ownership of one or more remote files.

254 Integration Cloud 6.6.0

5 Applications



Input Parameters

StringNumeric group identifier of the group to which you want to transfer
ownership of the remote files.

groupId

String Absolute or relative path of the remote files.path

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

chmod

Changes permissions of one or more remote files.

Input Parameters

String The permission mode to apply to the remote file (for example, 777).mode

String Absolute or relative path of the remote files.path

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

chown

Changes the owning user of one or more remote files.

Input Parameters

StringNumeric user ID of the new owning user of the file.uid

String Absolute or relative path of the remote files.path

Output Parameters

String Standard SFTP protocol return code.returnCode
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String Text message describing the return code.returnMsg

get

Retrieves a file from a remote SFTP server.

Input Parameters

String Absolute or relative path of the remote file.remoteFile

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

Object A java.io.InputStream object.contentStream

ls

Retrieves the remote directory listing of the specified path. If path is not specified, the ls service
retrieves the file listing of the current remote directory. The ls service also retrieves additional
details such as permissions and ownership information.

Input Parameters

String Optional. Absolute or relative path of the remote directory. If no path
is specified, the ls service retrieves the directory listing of the current remote
directory.

path

You can use the wildcard characters asterisk (*) and question mark (?) after
the last slash mark (/) to view all remote directories that match the specified
path.

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

Document List of directories matching the pattern specified in the path
parameter. This document has the following parameters:

dirList

fileName: String Specifies the name of the remote file. .
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fileSize: String Specifies the size of the remote file.

permissions: String Specifies the access permission of the file (read, write,
or execute).

lastAccessTime: String Specifies the time when the file was last accessed.

lastModifiedTime: String Specifies the time when the file was last modified.

uid: String Specifies the user ID of the file owner.

gid: String Specifies the group ID associated with the file.

longName: String Specifies the long name of the ls entry. It contains all the
parameters separated by a space.

mkdir

Creates a new remote directory.

Input Parameters

String Absolute or relative path of the remote directory where you want to
create a new directory.

path

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

put

Transfers a file to a remote SFTP server.

Input Parameters

java.io.InputStream Data to be transferred to the remote file.contentStream

StringAbsolute or relative path of the remote file to which the contentStream
would be written based on the mode.

remoteFile

StringOptional. Specifies how the local file is to be transferred to the remote
SFTP server. Set to:

mode

overwrite to overwrite the contents of the remote file with the contents
of the contentStream. This is the default.
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append to append the entire contents of the contentStream to the remote
file.

resume to resume writing the contents of the contentStream to the remote
file from the point thewritingwas stoppedduring previous SFTP sessions.

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

pwd

Displays the remote working directory in the SFTP server.

Input Parameters

None.

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

String Absolute or relative path of the working directory on the remote SFTP
server.

path

rename

Renames a file or directory on a remote SFTP server.

Input Parameters

String Fully qualified name of the file you want to rename (for example,
temp/oldname.txt).

oldPath

StringNew fully qualified name for the file (for example, temp/newname.txt).newPath

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg
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rm

Deletes one or more remote files on the SFTP server.

Input Parameters

String Absolute or relative path of the file you want to delete.path

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

rmdir

Deletes one or more remote directories on the SFTP server.

Input Parameters

String Absolute or relative path of the directory you want to delete.path

Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

Usage Notes

The remote directories that you want to delete must be empty.

symlink

Creates a symbolic link between the old path and the new path of a file.

Input Parameters

String Old path of the file for which you want to create a symbolic link.oldPath

StringNew path of the file to which the symbolic link should point.newPath
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Output Parameters

String Standard SFTP protocol return code.returnCode

String Text message describing the return code.returnMsg

ServiceNow Enterprise Service Management
Integration Cloud connects to different areas (Incident, Problem, and Change management) of
ServiceNowusing the Geneva version of the ServiceNowAPI. You can create incidents, get details
of created incidents, and update and delete them. Similar operations are available for problem
and change management cloud applications.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://<instance_name>.service-now.com, where
<instance_name> represents the actual instance name.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SaaS provider that the Account
will use to connect to the SaaS provider.

Username

Provide a password for the user name provided in the Username field
to initiate communication with the SaaS provider.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic.
Basic refers to HTTP Basic Authentication. This option can be used if
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DescriptionField

the Application requires or supports HTTP Basic authentication using
a username and password.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Shopify
Integration Cloud connects to Shopify using the Shopify REST API and allows you to organize
your products, customize your storefront, accept credit card payments, track, and respond to
orders.
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Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL is of the format:

Server URL

https://<my-store>.myshopify.com.Replace <my-store>with your actual
Shopify store.

This token is used for authentication and is issued by theAuthorization
Server. The Access Token is passed when you invoke any of the REST

Shopify Access
Token

API endpoints. Shopify REST APIs authentication requests require a
unique API key generated in Shopify. All API requests must pass an
X-Shopify-Access-Token header with an API key.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
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to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Siemens MindSphere
Integration Cloud connects to Siemens MindSphere using the API version 2.0 and allows you to
create aspects and post data into a MindSphere asset.

Note:
The fields displayed may vary according to the version of the Application.

DescriptionField

Provide the login endpoint to initiate
communication with the SaaS provider. For

Server URL

example,
https://mindconnectcom.apps.mindsphere.io/

The number of milliseconds Integration Cloud
waits for a response before canceling its attempt

Response Timeout

to connect to the back end. In case the network
is slow or the back end processing takes longer
than usual, increase the Response Timeout
value. It is recommended to specify a value other
than 0. If you specify 0, Integration Cloud will
wait indefinitely for a response.

The number of times IntegrationCloud attempts
to connect to the back end to read a response if

Retry Count on Response Failure

the initial attempt fails. If an I/O error occurs, it
will retry only if you have selected the Retry on
Response Failure option.

Whether Integration Cloud should attempt to
resend the request when the response has failed,

Retry on Response Failure

even though the request was sent successfully.
Select this option if you want to re-establish the
connection.

Select the alias for the Integration Cloud key
store configuration. This is a text identifier for

Keystore Alias
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DescriptionField

the keystore alias. A keystore file contains the
credentials (private key/signed certificate) that
a client needs for authentication. You can also
add a new Keystore from this field.

Alias to the private key in the keystore file
specified in the Keystore Alias field. The

Client Key Alias

outbound connections use this key to send client
credentials to a remote server. To send the
client’s identity to a remote server, you must
specify values in both the Keystore Alias and
the Client Key Alias fields.

Select a hostname verifier implementation.
Guards against man-in-the-middle (MITM)

Hostname verifier

attacks. The default is
org.apache.http.conn.ssl.DefaultHostnameVerifier,
which will enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier
to disable hostname verification.

MindSphere Unit (MSU) limit for an asset. MSU
is the basis for fees invoiced monthly per asset
and as per a used application.

MSU Limit

The type of security profile/algorithm used for
token generation. Default is SHARED_SECRET.

Security Profile

The ID of the agent managing a MindSphere
asset.

Agent Id

Schemas used by the MindSphere platform.
Default is urn:siemens:mindsphere:v1.

Schemas

Initial access token for agent onboarding.IAT

The tenant ID of the onboarded agent.Tenant

Links returned upon successful agent
onboarding.

Links

The JSONWeb Token (JWT) signing algorithm.
Default is HS256 (HMAC with SHA 256).

JWT Signing Algorithm

The JWT token expiration time in milliseconds.
Default is 600000.

JWT Token Expiration (msec)

The JWT Audience. Default is MindSphere AS.JWT Audience
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DescriptionField

Server Name Indication (SNI) is an extension to
the TLS protocol by which a client indicates

Enable SNI

which host name it is attempting to connect to
at the start of the handshaking process. Enable
this option if the SaaS provider offers SNI-based
TLS connectivity, and if you want to connect to
an SNI enabled SAAS provider to send the host
name specified in the Server URL field, as part
of the TLS SNI Extension server_nameparameter.

If you want to explicitly specify a host name to
be included as a part of the SNI extension

SNI Server Name

server_name parameter, in case the host name is
other than the host name specified in the Server
URL field, specify the host name value in the SNI
Server Name field.

Simple Mail Transfer Protocol (SMTP)
IntegrationCloud allows you to connect to an SMTP server using the SimpleMail Transfer Protocol
(SMTP). This Application provides the “sendEmail” on page 273 predefined operation to send
emails to specified recipients. You can attach one or more files to the message.

DescriptionField

Host name or IP address or the domain name
of the SMTP server.

Host

SMTP port defined on the SMTP server. This is
the number of the port onwhich the SMTP host
listens.

Port

Valid user name on the SMTP server. This is the
user name used to connect with themail server.

User

Password of the SMTP user. This is the
password to connect with the mail server.

Password

The email address of the sender, that is, the
person that is going to send the messages.

From

E-mail address of the receiver. If you specify
multiple addresses, separate themwith commas
without any spaces.

To

The number of milliseconds Integration Cloud
waits for a response before canceling its attempt

Response Timeout
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DescriptionField

to connect to the SMTP server. In case the
network is slow or the SMTP server processing
takes longer than usual, increase this value.

The number ofmilliseconds inwhich Integration
Cloud must read a response message from the
SMTP server.

Read Timeout

Socket write timeout value in milliseconds.Write Timeout

SSL configuration details

Type of security protocol IntegrationClouduses
when communicating with the SMTP server
port. Set to:

Transport Layer Security

none to use a non-secure mode when
communicating with the port on the SMTP
server. This is the default.

explicit to use explicit security when
communicating with the port on the SMTP
server. With explicit security, Integration
Cloud establishes an un-encrypted
connection to the email server, and then
switches to the secure mode.

implicit to use implicit security when
communicating with the port on the SMTP
server. With implicit security, Integration
Cloud always establishes an encrypted
connection to the email server.

This is the alias for the truststore that contains
the list of certificates that IntegrationCloud uses

Truststore Alias

to validate the trust relationship. Integration
Cloud uses the default truststore if you do not
specify a truststore alias. You can add a new
truststore from this field.

Note:
Users who have the Administer permission
under Settings  > Access Profiles >
Administrative Permissions > Functional
Controls > Advanced Security can add, edit,
and delete truststores.

Using the SMTP Application to send emails
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Summary

In this tutorial, we will create an integration that queries Salesforce accounts and create
opportunities inMarketo, and then sends an email containing the total number of records queried
from Salesforce and inserted into Marketo.

Before you begin

A valid Gmail account as we will use the Gmail SMTP server to send emails.

Using the SMTP Application to send emails

1. Log in to Integration Cloud.

2. Click Projects > Select a Project> Applications > Predefined Applications > Simple Mail
Transfer Protocol (SMTP).

3. Click Add New Account.

4. Configure the Gmail SMTP settings as shown below. For information on the Account
Configuration fields, see “ SimpleMail Transfer Protocol (SMTP)” on page 265. You can specify
the From and To addresses either at the Account level here or while executing the operation.
If you provide them at both places, Integration Cloud will use the addresses provided by you
when you execute the operation. Further, as shown below, set the Transport Layer Security
to Implicit to connect to SSLport 465. IntegrationCloud internally sets the mail.smtp.ssl.enable
property to true.
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If you want to connect to Gmail SMTP server TLS Port (587), specify the mandatory account
configuration fields. Also, as shown below, specify the Transport Layer Security as Explicit.

If Transport Layer Security is set as  Explicit, Integration Cloud adds the
mail.smtp.tls.required property as true by default, while executing the operation. Also,
IntegrationCloud connects to the SMTP server and issues STARTTLS to change the unencrypted
connection to an encrypted connection.
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5. After you have provided the above account configuration values, click Test on the Account
Configuration page as shown below to test the SMTP server configuration.
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6. Click Send to send the test email to the recipient. You can also click Test on the Operations
page to test the SMTP server configuration.

7. After you click Test on the Operations page, add the input values as shown below, and then
click Run.

Note:
You can add attachments only while creating an Integration.

8. Use the SMTP Application to create the Orchestrated Integration as shown below. See
“Orchestrated Integrations” on page 387 on how to create an Orchestrated Integration.

Do the following:
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Add the QueryAccounts operation from Salesforce.

Add the createOpportunities operation from Marketo.

Map the queried Salesforce accounts to Marketo createOpportunities.

Add the sizeOfList service from the List category.

Map the queried Salesforce accounts to the sizeOfList service to get the total number of
accounts queried.

Add the “sendEmail” on page 273 operation from the SMTP Application.

9. Map input and output.

10. Click subject and set a value. Then click body.
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11. Set a value for the body, that is, type the email body. Wrap the dynamic fields which are in the
pipeline with % and click Perform pipeline variable substitution.

12. Click Apply, save the integration, and then run the Integration.

An email is sent to the recipients specified in the To field on the SMTP Account Configuration
page.
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Exceptions

Timeout errorsmay occurwhile executing the “sendEmail” on page 273 operation.Do the following
as remedial actions:

Check if the host and port details are configured correctly.

Increase the Response Timeout value on the Account Configuration page.

SMTP Predefined Operation

sendEmail

Sends emails to specified recipients. You can attach one or more files to the message.

Input Parameters

String Optional. E-mail address of the sender.from

StringOptional. E-mail address of the receiver. If you specify
multiple addresses, separate them with commas.

to

String Subject of the message.subject

String The content of the message.body

String Optional. E-mail addresses of additional receivers. If
you specify multiple addresses, separate themwith commas.

cc:

String Optional. E-mail addresses of additional receivers. If
you specify multiple addresses, separate themwith commas.

bcc:

StringOptional. The character set used to encode the subject.
Default: UTF-8.

subjectCharSet:

String Optional. The character set used to encode the email
message. Default: UTF-8.

bodyCharSet:

Document List Attachments to the email message.attachments

DescriptionKey

String Content type of the
attachment. For example:
application/pdf.

contenttype

byte[ ], String, or
java.io.InputStream Content of
the attachment.

content
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StringName to assign to the
attachment.

filename

String Encoding of the
attachment, for example, base64

encoding

or 7bit. If encoding is not
specified, 7bit is used.

StringCharacter set encoding of
the attachment. If charset is not

charset

specified, then UTF-8 encoding
is used.

Output Parameters

String Final status of the operation.status

Usage Notes

You must define the from and to fields either in the Account Configuration section or while
executing the operation.

If you are using filename to attach a file to the message and the file is not a plain text file, you
must set the contenttype and encoding.

Slack
Integration Cloud connects to Slack using the Slack REST API. You can use it to collaborate in
your teamwithin persistent chat rooms, private groups, and directmessaging,where all the content
is searchable.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider.

Server URL

The URL for Slack REST Application depends on the team name:
https://YOURTEAM.slack.com

Example: https://exampleteam.slack.com

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.
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DescriptionField

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

The token used for authentication and issued by the Authorization
Server.

Access Token

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

StrikeIron Contact Verification
Integration Cloud connects to StrikeIron using the StrikeIron Contact Verification APIs, and
provides access to email verification and hygiene services, along with the North America address
verification service.
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DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://ws.strikeiron.com/StrikeIron.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SaaS provider that the Account
will use to connect to the SaaS provider. The Account will use this
credential to connect to the SaaS provider.

Username

Provide a password for the user name provided in the Username field
to initiate communication with the SaaS provider.

Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header. If you enter
the username and password, then set the authorization type as basic.
Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.
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DescriptionField

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

SuccessFactors HCM
Integration Cloud connects to SuccessFactors using the SuccessFactors web service SFAPI, and
performs SuccessFactors operations (Create, Read,Update, Delete, Fetch, Insert, Query, queryMore,
andUpsert) overHTTPusing synchronous SOAPprotocols. ThisApplication has been testedwith
the following business objects: GOAL$1, GOAL$2, GOAL$3, GoalMilestone$2, GoalMilestone$3,
GoalTask$2, GoalTask$3, MatrixManager, and CustomManager.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://api.successfactors.com/sfapi/v1/soap

Server URL

https://<instance_name>.successfactors.com, where <instance_name>
represents the actual instance name.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.
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DescriptionField

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SaaS provider that the Account
will use to connect to the SaaS provider. The Account will use this
credential to connect to the SaaS provider.

Username

Provide a password for the user name to initiate communication with
the SaaS provider.

Password

The type of HTTP authorization scheme to use for the Account. The
SuccessFactors Application does not use Authorization headers.

Authorization
Type

If you specifynone, no additional authorization schemewill be executed
at run time. If you specify a Company ID, Username, and Password,
but do not specify a value for Authorization Type, the user credentials
are not inserted into anAuthorization header. If you enter the username
and password, then set the authorization type as basic. Basic refers to
HTTP Basic Authentication. This option can be used if the Application
requires or supports HTTP Basic authentication using a username and
password.

The company ID that SuccessFactors provided, when your company
registered with them.

Company ID

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.
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DescriptionField

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

SugarCRM
Integration Cloud connects to SugarCRM using the Interface for RESTful Web Services v10 and
manages the CRMdata. You can use it to retrieve, query, create, update, and delete business objects
of any type.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL is of the format:

Server URL

https://<instance>/rest/v10. Replace <instance> with your actual
SugarCRM instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure
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DescriptionField

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server. SugarCRM REST APIs use OAuth 2.0. The Access Token is
passed when you invoke any of the REST API endpoints.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name
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DescriptionField

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Twilio
Using the REST interface, Twilio allows you to programmatically make and receive phone calls
and send and receive text messages.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL would be of the format:

Server URL

https://api.twilio.com/2010-04-01

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed

Authorization
Type

at run time. For example, when you specify aUsername and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header.

If you enter the username and password, then set the authorization
type as basic . Basic refers to HTTP Basic Authentication. This option
can be used if the Application requires or supports HTTP Basic
authenticationusing ausername andpassword. Select theAuthorization
Type as basic.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

The name of the user account on the SaaS provider that the connection
will use to connect to the SaaS provider.

Username

The password for the user name provided in the Username field.Password
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DescriptionField

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

webMethods.io B2B
The webMethods.io B2B application allows you to:

Interact, accept requests, and build integrations for the webMethods.io B2B product instance.

Exchange business documents between trading partners.

webMethods.io B2B account configuration

You must configure an account in the webMethods.io B2B application for you to utilize its
predefined operations in Integration Cloud to build orchestrations.
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Note:
webMethods.io B2B application on Integration Cloud requires you to have access to the
webMethods.io B2B product instance.

DescriptionField

Connects to the webMethods.io B2B product instance within
your environment.

B2B Environment

Note:
You can only create one account in thewebMethods.io B2B application. To create a new account,
youmust delete the existing account. If the existing account has integrations, then the integrations
must be updated with the new account details.

Predefined Operations

The following predefined operations are available for webMethods.io B2B application:

changeUserStatus

Changes the user status of a specified transaction.

Input Parameters

String Transaction ID of the document in exchange.transactionID

String The user status for a transaction. For example, New, Open, or Fixed.
Character length limit is 255.

userStatus

Output Parameters

String Indicates if the operation changed the user status of a
transaction.

isUpdated

true. The operation changed the user status of the transaction.

false. The operation has not changed the status of the
transaction.

parseContent

Parses request content passed by the processing rule Call an integration action as bytes or string
data type. For more information on Call an integration, see webMethods B2B Cloud Help
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Input Parameters

String Content passed in the integration request.inputContent

String Data type in which outputContent field value is passed.loadContentAs

bytes. outputContent is generated as bytes.

string. outputContent is generated as a string.

String Type of character set used for encoding inputContent value. This
can be any IANA registered character set.

encoding

Default  UTF-8

Output Parameters

Object Content data corresponds to the data type option set for the
loadContentAs field.

outputContent

generateResponse

Generates a response for the processing rule Call an integration action.

Input Parameters

ObjectContent data sent as part of integration response after encoding.inputContent

String Data type in which inputContent field value is passed.readContentAs

bytes. inputContent is read as bytes.

string. inputContent is read as a string.

String Content-Type passed corresponds to inputContent field. For
example, application/EDI, application/x12, text/plain and so on.

contentType

String Value of error code passed as part of integration response.errorCode

String Value of error message passed as part of integration response.errorMessage

String Type of character set used for encoding inputContent value.
This can be any IANA registered character set.

encoding

Default  UTF-8
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Output Parameters

Document Response is a composite object containing the parameters:response

DescriptionKey

String Encoded in Base64. Value is specified in
encoding.

content

String Value specified in contentType.type

String Type of encoding used to encode the
inputContent. Value is specified in encoding.

encoding

Document Error is a composite object containing the fields:error

DescriptionKey

String Error code received from the input.
Value is specified in errorCode.

code

StringErrormessage associatedwith the input.
Value is specified in errorMessage.

message

submit

Submits the business documents to webMethods.io B2B product instance.

webMethods.io B2B recognizes the type of document and process it. Every document that you
submit through this service is created as a new transaction in webMethods.io B2B.

Input Parameters

Object Content to submit to webMethods.io B2B product instance for
processing.

inputContent

String Data type in which inputContent field value is passed.readContentAs

bytes. inputContent is read as bytes.

string. inputContent is read as string.

String Specifies the type of content.contentType

text/xml. Content is read as an XML input.

application/EDIStream. Content is read as an EDI InputStream.

application/EDI. Content is read as EDI input.

application/x12. Content is read as X12 input.

Integration Cloud 6.6.0 285

5 Applications



application/UNEDIFACT. Content is read as UNEDIFACT input.

Note:
This field is case sensitive. Additionally, if you provide a type other
than the one mentioned above, webMethods.io B2B identifies the
document as unknown.

String Type of character set used for encoding inputContent value. This
can be any IANA registered character set.

encoding

Default:  UTF-8

Document A document that provides parameters to govern how
webMethods.io B2B recognizes and processes a document.

params

For XML documents, you can optionally add the following fields:

DoctypeName - String The name of the document type. This field is
case sensitive.

The DoctypeName field identifies the webMethods.io B2B document
type to use, thus bypassing document recognition and eliminating
the overhead of searching for thewebMethods.io B2Bdocument type.

processingRuleName - The name of the processing rule. This field is
case sensitive.

The processingRuleName field identifies the processing rule to use,
thus bypassing the processing rule lookup and eliminating the
overhead of searching for a processing rule.

$bypassRouting - Indicates whether webMethods.io B2B uses a
processing rule to process the document. Valid values are:

true. Disables the processing rule routing.

false. Enables the processing rule routing

pipelineMatching - Allows you to pass the key-value pair defined in
an XML document. These variables are used to identify
webMethods.io B2B document type for processing. For more
information on pipeline matching, see the product help for
webMethods.io B2B.

Output Parameters

Document Contains the following information about the transaction created
in webMethods.io B2B product instance.

transaction

DescriptionKey
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String Transaction ID of the document created in
webMethods.io B2B product instance.

transactionID

String Sender ID of the document.senderID

String Receiver ID of the document.receiverID

String Internal ID of the document type in the
webMethods.io B2B product instance.

documentTypeID

String User-defined status of the document.userStatus

String Status of the transaction submitted in the
webMethods.io B2B product instance.

transactionStatus

Document Extracted custom attributes from
inputContent. Key is the attribute name and value is the
attribute value.

customAttributes

Document A document that contains parameters that webMethods.io B2B
uses to recognize and process a document.

params

getAddresses

Retrieves all addresses of a partner.

Input Parameters

StringThe internal identifier of the partner forwhich youwant to retrieve
the addresses.

partnerID

Output Parameters

Document list List of addresses, each containing the following details:addresses

DescriptionKey

String The first line of the address.addressLine1

String The second line of the address.addressLine2

String The third line of the address.addressLine3

String The city specified for the address.city

String The country for the address.country

String The ZIP code or postal code for the address.zipCode

String The state or province for the address.stateProvince
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StringType of address. For example, corporate or contact
address of the partner.

addressType

String The internal identifier of the partner.partnerID

Document list The extended fields for the address. Each extended field is in
the following structure:

extendedFields

Note:
If there are no extended fields for the group, then this field appears blank.

String The name of the extended field.name

String The value of the extended field.value

getContacts

Retrieves all contacts of a partner.

Input Parameters

StringThe internal identifier of the partner forwhich youwant to retrieve
the contacts.

partnerID

Output Parameters

Document listList of contact details each containing the following information:contacts

DescriptionKey

String The first name of the contact.firstName

String The last name of the contact.lastName

String The role of the contact in the organization.role

StringThe type of contact. For example, technical contact
or administrative contact.

type

String The e-mail address of the contact.email

String The facsimile number of the contact.faxNumber

String The telephone extension of the contacttelephoneExtension

String The telephone number of the contact.telephone

String The internal identifier of the partner.partnerID
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Document listThe address of the contact. For the various
address fields, see “getAddresses ” on page 287.

address

Document list The extended fields for contacts . Each extended field is in the
following structure:

extendedFields

Note:
If there are no extended fields for the group, then this field appears blank.

String The name of the extended field.name

String The value of the extended field.value

getCorporation

Retrieves the corporation information of a partner.

Input Parameters

StringThe internal identifier of the partner forwhich youwant to retrieve
the corporate information.

partnerID

Output Parameters

Document list Contains the following corporate information of a partner:corporate

DescriptionKey

String The name of the corporation.corporationName

String The name of the organizational unit within the
corporation.

orgUnitName

String The status of the partner in your webMethods.io
B2B. This value can be Active or Inactive.

status

Boolean Indicates if the partner profile represents the
enterprise profile. Valid values are:

isEnterprise

true. It is an enterprise profile.

false. It is not an enterprise profile.

String The internal identifier of the partner.partnerID

Document list The extended fields for the corporation. Each extended field
has the following structure:

extendedFields

Note:
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If there are no extended fields for the group, then this field appears blank.

String The name of extended field.name

String The value of the extended field.value

getPartnerIdentities

Retrieves all external IDs of a partner.

Input Parameters

StringThe internal identifier of the partner forwhich youwant to retrieve
the identities.

partnerID

Output Parameters

Document list Contains the following details of the identities of the partner.identities

DescriptionKey

String The type of identity. For example, Duns, Duns+4.type

String The value of identity.value

String The code for the type of the identity. For example,
1, 2 , 3.

code

String The internal identifier of the partner.partnerID

Document list The extended fields for the identities . Each extended field has
the following structure:

extendedFields

Note:
If there are no extended fields for the group, then this field appears blank.

StringName of extended field to use in the criteria.name

String The extended fields to match.value

getExtendedFields

Retrieves a set of extended fields for a partner.

Extended fields are custom fields that you can define to maintain additional information about
you partners. For example, you might want to define extended fields for preferred shipping
method, cost centers, or customer codes.
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Input Parameters

StringThe internal identifier of the partner forwhich youwant to retrieve
the extended fields.

partnerID

String (Optional) The group forwhich youwant to retrieve the extended
fields. Specify the name of the field group associated with the extended

groupName

fields to retrieve. You can specify one of the following standard field
groups:

Corporation. Retrieves Corporation extended fields.

Contact. Retrieves Contact extended fields.

Delivery. Retrieves Delivery extended fields.

ExternalID. Retrieves IDs extended fields.

Address. Retrieves Addresses extended fields.

Custom. Retrieves Custom extended fields.

Note:
Apart from the above standard field groups, you can also specify the
groups created under the Field Groups section inwebMethods.io B2B.

Output Parameters

Document list The extended field group details of the extended fields. Each
extended field group is in the following format:

groups

String The group name for the extended field.name

String The id of the group.id

Document list The list of extended fields within the
group. Following are the fields:

fields

name. String The name of the extended field.

value. String The value of the extended field.

Note:
If the group you selected has no extended fields, then
this field appears blank.

queryPartners

Creates a query for partner profiles and returns the first batch of matching results.

Integration Cloud 6.6.0 291

5 Applications



Note:
A user can execute 15 queries concurrently.

Input Parameters

String (Optional) Themaximumnumber of profiles present in each batch.
You can provide a value between 20 and 500. The default is 100.

batchSize

Note:
If you provide a value outside the specified range, thenwebMethods.io
B2B displays an error message.

Document (Optional) The criteria to filter the query results. Provide the
following details:

criteria

isOrQuery. StringWhether the join condition for the filter criteria
that you specify in between the fields variable is true (OR) or false
(AND). Default is false.

fields. Document list

The criteria to filter the results for fields such as corporationName,
orgUnitName. Each field can have multiple criteria. For example,
orgUnitName IS NOT NULL AND orgUnitName = ABC*, where
orgUnitName is the field name, IS NOT NULL and '=' are the operators,
AND is the join condition (isOrQuery), and ABC* is the value. With this
criteria, webMethods.io B2B will select all the profiles for which the
organization unit name is not null and the name starts with ABC.

fieldName - String The name of the field for which you specify
the filter criteria in the criteria variable. Valid values are:
corporationName , orgUnitName , status.

isOrQuery - StringWhether the join condition for the filter criteria
in the criteria variable is AND or OR. Valid values are true (OR)
or false (AND). The default value is false.

criteria - String The filter criteria for fieldName.

Each document in the document list contains the following
variables:

operator - String The operator for the filter criteria. Valid
values are: IS NULL, IS NOT NULL, =, and <> (not equal to).

value - String The value for the filter criteria. You can use the
wildcard * in searches to match one or more characters, or
the wildcard ? to match one character. For example, to search
for data ending with abc, specify the value as *abc. Similarly,
to search for data starting with ab and ending with cwith
length 4, specify the value as ab?c.
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Document list (Optional) The field name by which the results must be
sorted. Each document in the document list contains the following
variables:

sortOrder

fieldName - String The field name for sorting.

corporationName

orgUnitName

status

isAscending - Document The order by which the result set must be
sorted (ascending or descending). The valid values are ASC (ascending)
or DESC (descending).

String list (Optional) The list of fields in the result set. Valid values are:resultFields

corporationName

orgUnitName

status

If the field is left blank, then webMethods.io B2B returns all the above
fields including the isEnterprise and partnerID fields. For details on
these values, see “getCorporation ” on page 289

By default, the query results contain isEnterprise and partnerID fields.

Output Parameters

String The ID of the executed query for which results are retrieved. It is used
in queryMorePartners operation to retrieve subsequent sets of records from

queryLocator

the query results when the value of done is false. Similarly, it is also used in
resetQueryPartners operation to release the queryLocator.

Boolean Indicates whether the query has additional rows to retrieve. This is
used in the queryMorePartners operation. Valid values are:

done

true. There are no additional rows to retrieve.

false. There are additional rows to retrieve.

String The total number of rows retrieved in the query result. The value is
equal to the total number of records that webMethods.io B2B returns.

size

List The list of partner profiles.records

Based on the values set in the resultField, you can view the following
information:
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corporationName. StringName of the corporation.

orgUnitName. String The name of the organizational unit within the
corporation.

status. String The status of the partner in your webMethods.io B2B. This
value can be Active or Inactive.

isEnterprise. Boolean Indicates if the partner profile represents the
Enterprise profile. The values are true or false, indicating an enterprise
or non-enterprise respectively.

partnerID. String The internal identifier of the partner.

queryMorePartners

Loops over the data cached from the queryPartners operation and returns the batchSize of data.

Input Parameters

String The ID of the query. You can use this ID to view the query results.
You obtain this ID from the queryPartners operation.

queryLocator

Output Parameters

Boolean Indicates whether the query has additional rows to retrieve. Valid
values are:

done

true . There are no additional rows to retrieve.

false. There are additional rows to retrieve.

String The total number of records retrieved in the query result.size

List The list of partner profiles.records

Based on the values set in the resultField, you can view the following
information:

corporationName. StringName of the corporation.

orgUnitName. String The name of the organizational unit within the
corporation.

status. String The status of the partner in your webMethods.io B2B. This
value can be Active or Inactive.

isEnterprise. Object Indicates if the partner profile represents the
Enterprise profile.
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partnerID. String The internal identifier of the partner.

resetQueryPartners

Resets the queryLocatormaking it available for the next concurrent execution.

Note:
The queryLocator reset involves clearing the cached results. If you do not reset a queryLocator, it
remains active for 15 minutes. After which, webMethods.io B2B automatically resets it.

Input Parameters

String The ID of the query obtained from the queryPartners operation.
You obtain this ID from the queryPartners operation.

queryLocator

Output Parameters

Boolean Indicates whether reset is complete or not.status

log

Adds an entry into the activity log.

Input Parameters

String (Optional) The type of activity log entry. The supported types are:
ERROR,WARNING, andMESSAGE.

type

String (Optional) The category for the activity log entry. webMethods.io
B2B supports either the following categories or any custom value:

category

General. Any unspecified error messages and warnings.

Processing. Processing a document using a processing rule to be
used .

StringAbriefmessage for the activity log entry. The value can be a string
with maximum of 240 characters.

message

Note:
webMethods.io B2B displays an error message when you exceed the
character limit.
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String (Optional) A detailed message about the reason for adding the
activity log entry. The value can be a string with maximum of 1024
characters.

details

Note:
If thewebMethods.io B2B displays an errormessagewhen you exceed
the character limit.

String The transaction ID of the document created in webMethods.io
B2B product instance related to this activity log entry.

transactionID

String (Optional) The internal ID of the partner related to this activity
log entry.

partnerID

Object (Optional) The payload content for the activity log. Themaximum
size of the content is 2 MB.

content

Note:
If the content size exceeds 2MB,webMethods.io B2B displays an error
message.

String (Optional) Data type in which content field value is passed.readContentAs

bytes. content is read as bytes.

string. content is read as a string.

String (Optional) The character set in which the value of the content is
encoded. Specify an IANA-registered character set. For example,UTF-8
and ISO-8859-1. Default is UTF-8.

encoding

Output Parameters

Boolean Indicateswhether the activity log is added for the provided transaction
ID. Valid values are:

success

true. Indicates that the activity log entry is added successfully.

false. Indicates that the addition of activity log entry has failed.

Workday
Integration Cloud connects to Workday using the SOAP API and allows you to interact with
Workday web services to manage Workday objects.

DescriptionField

This is the login endpoint to initiate communication with the SaaS
provider.

Server URL
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DescriptionField

Specify the URL for your exact instance, for example:
https://<instance>.workday.com/ccx/service/<tenantID>/.

For example, wd2-impl-services1 is the instance and softwareag_pt1
is the tenantID.

User name for theWorkday tenant to log in toWorkday. Enter the user
name appended with the Workday Tenant ID, for example,
username@tenantID.

Username

The password of the Workday account.Password

The type of HTTP authorization scheme to use for the connection. If
you select none, no additional authorization scheme will be executed
at run time.

Authorization
Type

If you specify a Username and Password and also select none, you do
not specify a value for the Authorization Type, so the user credentials
are not inserted into anAuthorization header. If you enter theUsername
and Password, then set the authorization type as basic.

Basic refers to HTTP Basic Authentication. This option can be used if
the Application requires or supports HTTP Basic authentication using
a username and password. If you enter the username and password,
then set the authorization type as basic.

The Workday instance, for example, wd2-impl-services1.Instance

The Workday tenant ID that you want to access, for example,
softwareag_pt1.

Tenant ID

SOAP API version of Workday. The version value is obtained from the
soapbind:address location in the WSDL file. For example, if the

Version

soapbind:address location is
https://wd2-impl-services1.workday.com/ccx/service/softwareag_pt1/Staffing/v31.1,
then the version is v31.1.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.
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DescriptionField

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

The keep alive interval in milliseconds defines the interval for which
a connection will be kept alive, if the back end does not respond with

Keep Alive
Interval

a Keep-Alive header. A value > 0 keeps the connection alive for the
specified value. The default value of -1 implies that the connection will
be kept alive until a request fails due to a connection error.

The idle timeout interval in milliseconds defines the interval for which
a connection will be kept alive if it's not in use. A value > 0 keeps the

Idle Timeout

connection alive for the specified value. The default value of -1 implies
that the connection will be kept alive until a request fails due to a
connection error.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name
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DescriptionField

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Zendesk
Integration Cloud connects to Zendesk using the Zendesk API v2. It includes ticketing system,
self-service options, and customer support features, and allows you to create, update, and solve
customer support tickets and also track problems and questions.

DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. For example, the end point URL is of the format:

Server URL

https://<domain>.zendesk.com. Replace <domain> with your actual
Zendesk instance.

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
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DescriptionField

org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server. Zendesk RESTAPIs use OAuth 2.0. The Access Token is passed
when you invoke any of the REST API endpoints.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token.Refresh URL

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Zuora
Zuora

IntegrationCloud connects to Zuora using the Zuora SOAPAPI. You can use it to connect to Zuora
and automate billing, commerce, and financial operations.

Zuora REST

IntegrationCloud connects to Zuora REST using the Zuora RESTAPI. Zuora allows you tomanage
Zuora objects in the Zuora Business Object Model, process revenue schedules, and perform other
financial operations.
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DescriptionField

Provide the login endpoint to initiate communication with the SaaS
provider. Example: https://api.zuora.com/apps/services/a/76.0. For
Zuora REST: https://rest.<your_tenant_name>.zuora.com.

Server URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the Response Timeout value. It is recommended to specify a
value other than 0. If you specify 0, Integration Cloud will wait
indefinitely for a response.

The number of times Integration Cloud attempts to connect to the back
end to read a response if the initial attempt fails. If an I/O error occurs,

Retry Count on
Response Failure

it will retry only if you have selected the Retry on Response Failure
option.

Whether Integration Cloud should attempt to resend the request when
the response has failed, even though the request was sent successfully.
Select this option if you want to re-establish the connection.

Retry on
Response Failure

This is the user account name on the SaaS provider that the Account
will use to connect to the SaaS provider. The Account will use this

Username

credential to connect to the SaaS provider.When you use a SOAP based
ZuoraApplication, it is not recommended to usemore than oneAccount
with the same user name.

Provide a password for the user name provided in the Username field
to initiate communication with the SaaS provider. When you access

Password

Zuora from outside your company’s trusted network, you must add a
security token (provided by Zuora) to your password. For more
information about logging on Zuora, see the Zuora documentation.

The type of HTTP authorization scheme to use for the Account. The
Zuora Application does not use Authorization headers. If you select

Authorization
Type

none, no additional authorization schemewill be executed at run time.
For example, when you specify a Username and Password, but do not
specify a value for the Authorization Type, the user credentials are not
inserted into an Authorization header. If you enter the username and
password, then set the authorization type asbasic. Basic refers toHTTP
BasicAuthentication. This option can be used if theApplication requires
or supportsHTTPBasic authentication using a username andpassword.

Select the alias name of the Integration Cloud trust store configuration.
The trust store contains trusted certificates used to determine trust for

Trust store Alias

the remote server peer certificates. You can also add a new Truststore
from this field.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname
verifier
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DescriptionField

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will enable
hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable hostname
verification.

Select the alias for the Integration Cloud key store configuration. This
is a text identifier for the keystore alias. A keystore file contains the

Keystore Alias

credentials (private key/signed certificate) that a client needs for
authentication. You can also add a new Keystore from this field.

Alias to the private key in the keystore file specified in the Keystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a remote
server, you must specify values in both the Keystore Alias and the
Client Key Alias fields.

Server Name Indication (SNI) is an extension to the TLS protocol by
which a client indicates which host name it is attempting to connect to

Enable SNI

at the start of the handshaking process. Enable this option if the SaaS
provider offers SNI-based TLS connectivity, and if youwant to connect
to an SNI enabled SAAS provider to send the host name specified in
the Server URL field, as part of the TLS SNI Extension server_name
parameter.

If you want to explicitly specify a host name to be included as a part
of the SNI extension server_name parameter, in case the host name is

SNI Server Name

other than the host name specified in the Server URL field, specify the
host name value in the SNI Server Name field.

Also referred to as the Client ID, this is a client identifier issued to the
client to identify itself to the authorization server.

Consumer ID

Also referred to as the Client Secret, this is a secret matching to the
client identifier.

Consumer Secret

This token is used for authentication and is issued by theAuthorization
Server. The Access Token is passed when you invoke any of the REST
API endpoints.

Access Token

A token used by the client to obtain a new access token without
involving the resource owner.

Refresh Token

This is the provider specific URL to refresh an Access Token. Example:
https://rest.apisandbox.zuora.com/oauth/token.

Refresh URL
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REST Applications

REST (Representational State Transfer) is an architectural style that requires web applications to
support the HTTP GET, POST, PUT, and DELETE methods and to use a consistent,
application-independent interface.

Endpoint URL

The endpoint of an API is an unique URL, which represents an object or collection of objects. The
endpoint is a reference to a URI that accepts web requests. It is the login endpoint URL to initiate
communication with the SaaS provider. To get the endpoint, go through the SaaS provider
documentation available on the internet. For example, https://api.twitter.com/1.1/ is the Twitter
endpoint.

Authentication Type

Every back end provides its own Authentication mechanism to provide authorized access to its
APIs. You need to get the authentication details from the SaaS provider documentation. For
example, for Twitter, go to https://apps.twitter.com, create a new application, and then get the
credentials. For Twitter, the authentication is OAuth V1.0a, which you can get from
https://apps.twitter.com.

Resource

A resource refers to some object or set of objects that are exposed at an API end point. It is a
representation of a thing (a noun) on which the REST APIs (verbs) operate. A resource has a type,
one or more parameters, and some standard operations that allow you to manipulate or retrieve
it from a remote location if you know its endpoint URL. Each resource derives its path from the
namespace of the resource. For example, if the REST resource is namedmyREST.myRESTResource,
the path is “/myREST.myRESTResource”.

Action

Actions are tasks that act on a Resource. You must create at least one Action for a Resource after
you have created the Resource. You can add aMethod, Request Parameters, Request andResponse
Headers, and a Request and Response body to an Action.

HTTPMethod

The primary or most-commonly-used HTTP verbs (or methods, as they are properly called) are
POST, GET, PUT, and DELETE. These correspond to create, read/retrieve, update, and delete (or
CRUD) operations, respectively. Youuse the followingHTTPmethods tomap theCRUDoperations
to HTTP requests. In a REST request, the resource that you are working with is specified in the
URL – Uniform Resource Locator. The URL is a special case of the URI – Uniform Resource
Identifier.

GET - Used to read or retrieve a representation of a resource. For example, GET
<endpointurl>/addresses/2 will retrieve an address with an ID of 2.

POST - Creates a resource. For example, POST <endpointurl>/addresses will create a new
address.
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PUT - Updates an existing resource. For example, PUT <endpointurl>/addresses/3 will modify
the address with an ID of 3.

DELETE - Used to delete a resource identified by a URI. For example, DELETE
<endpointurl>/addresses/4 will delete an address with an ID of 4.

DELETEPOSTPUTGETResource

Deletes a
collection.

Creates a new item
in the collection.

Replaces the entire
collection.

Lists details and
perhaps URIs of the
resources in this
collection.

http://example.com/

api/resource/

Deletes an item
from the
collection.

Creates a new item
in the collection.

Updates the item in
the collection and
possibly creates an
item if it does not
exist.

Retrieves a specific
item in the collection.

http://example.com/

api/resource/123/

Headers and Parameters

REST is not a standard in itself but instead makes use of the HTTP standard. HTTP headers allow
the client and the server to pass additional information with the request or the response. For
example, the Accept and Content-Type HTTP headers can be used to describe the content being
sent or requested within an HTTP request. The client may set Accept to application/json if it is
requesting a response in JSON or application/xml if it is requesting a response in XML, that is,
when sending data, setting the Content-Type to application/xml tells the client that the data being
sent in the request is XML.

REST calls (requests) and responses are sent over the HTTP protocol, hence REST requests are in
the form of URLs that point to the resource(s) on the server. Required parameters are attached to
the end of the URL. For example, in the resource URL http://<name>.com/user/789, user is the
resource and 789 is the parameter that is passed to the URL of the resource. You can use any REST
client to make REST calls.

REST parameters specify the variable parts of your resources, that is, the data that you areworking
with. QUERY parameters are the most common type of parameters, which is appended to the
path of the URI when submitting a request. For example, https://api.twitter.com/1.1/users/
show.json?screen_name=twitterdev is an example of aQUERYparameter URIwhere screen_name
is the name of the parameter and twitterdev is the value of the parameter.

HTTP Status Codes

HTTP Status Codes indicate the status of the HTTP response:

1XX - Informational

2XX - Success

3XX - Redirection

4XX - Client error
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5XX - Server error

Creating and updating REST Applications
These screens allow you to define a REST Application, define Resources and Actions, and then
create a REST Application. See “REST Applications” on page 303 for conceptual information on
REST Resources, HTTP Methods, HTTP Status Codes, HTTP Headers, and Parameters.

To create a REST Application

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Applications
> REST Applications > Add New Application.

2. In the Define Application Details page, complete the following fields. Required fields are
marked with an asterisk on the screen.

DescriptionField

Type a name for the REST Application.Name

Type an optional description for the REST
Application. The description you enter here will
appear in the Applications page.

Description

Specify the Endpoint for the Application. It is the
login endpoint URL to initiate communicationwith

Default Endpoint URL

the SaaS provider. To get the end point, see the back
end documentation available on the internet for the
SaaS provider.

Every back end provides its own authentication
mechanism. Get the authentication details from the

Authentication Type

back end documentation and select the supported
Authentication Type from the drop-down list.

Click Browse and select another icon for the REST
Application, if necessary.

Application Icon

3. Click Next.

The Define Resources and Actions page appears.

4. In theDefine Resources and Actionspage, clickAdd Resource to create a newRESTResource.

TheAdd Resourcedialog box appears. In theAdd Resourcedialog box, complete the following
fields:
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DescriptionField

Type the Resource name.Name

Type the path to the Resource. The Resource path is
relative to the endpoint specified. Each REST

Path

Resource derives its path from the namespace of the
REST Resource. For example, if the REST Resource
is named myREST.myRESTResource, the path is
“/myREST.myRESTResource”.

You can define dynamic parameters in the resource
path by enclosing each parameterwithin { } brackets.
For example, to get the employee data corresponding
to a dynamic parameter called employeeID, specify
the resource path as /employee/{employeeID}. To
get item information from a particular department
in a store, specify the resource path as
/store/{departmentID}/{itemID}.

Note:
While adding an Action, if your Resource path
contains { } brackets, for example, /user/{userID},
you must add a request parameter having the
same name, that is, "userID", and set the
Parameter Type to URI_CONTEXT.

5. Click Add to create the Resource. You can Edit or Delete the Resource from the Define
Resources and Actions page.

6. In the Define Resources and Actions page, select the Resource and click Add Action.

Note:
Every Resource must have an Action associated with it.

In the Add Action to Resource dialog box, complete the following fields:

DescriptionField

Select an HTTP Method.Method

GET - Reads or retrieves a representation of a
resource. For example, GET
<endpointurl>/addresses/2 will retrieve an
address with an ID of 2.

PUT - Updates an existing resource. For example,
PUT <endpointurl>/addresses/3 will modify the
address with an ID of 3.
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DescriptionField

POST - Creates a resource. For example, POST
<endpointurl>/addresses will create a new
address.

DELETE - Deletes a resource identified by anURI.
For example, DELETE <endpointurl>/addresses/4
will delete an address with an ID of 4.

Type an optional description for the Action.Description

You can set parameters that become part of the
outgoing request. Parameters specify the variable

Request Parameter

parts of your resources. ClickAdd Parameter to add
a parameter to the request. Complete the following
fields:

Name - Type the parameter name.

Value - Type a value for the parameter.

Parameter Type - Select the parameter's type, which
determines how the parameter should be used.

f you select an AWS authentication type, then you
must add a mandatory request parameter in all the
Actions you create. The parameter name must be
aws.service and the parameter type must be
CFG_PARAM. Type the service name in the endpoint
URL as the parameter value. For example, if the
endpoint URL is https://<instance>.s3.com/, type the
parameter value as s3.

REST services rely on HTTP methods (GET, POST,
PUT, and DELETE) to make requests to a SaaS
provider. Thus the parameters are closely tied to these
HTTPmethods, as they are sent as part of theseHTTP
method requests. The parameters are part of the
HTTPURI.CFG_PARAM is an internal configuration
parameter.

URI_CONTEXT parameters are passed as the path
component of a REST Resource URI, and the
parameter names correspond to theURI path variable
names specified in the {} annotation. For example, if
the URI is https://api.twitter.com/1.1/users/{id}, the
Resource path will be /users/{id}, the parameter type
will be uriContext, the parameter name will be id,
and the value could be the user id, for example, either
1, or 2, or 3.
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DescriptionField

QUERYSTRING_PARAM parameters are passed as
the query component of a REST resource invocation
request. For example, if the URI is
https://api.twitter.com/

1.1/users/show.json?screen_name=twitterdev, the
resource path will be /users/show.json, screen_name
is the name of the parameter, twitterdev is the value
of the parameter, and the parameter type is query.

FORM_ENCODED_PARAM - Define a parameter of
type FORM_ENCODED_PARAMif youwant to send
the parameter as part of the Request body.
FORM_ENCODED_PARAM allows you to send
simple key value parameters embedded in the
Request body for POST or PUT requests. This uses
the default web form encoding, which is
application/x-www-form-urlencoded.

Note:
For passing parameters of
FORM_ENCODED_PARAM type, youwill not be
able to define the Request body for a Resource, as
the generated parameter key value string will be
automatically embedded in the Request body.

Required - Select this option if you want this
parameter to be made mandatory while creating an
Integration.

HTTP headers allow the client and the server to pass
additional information with the request or the
response.

Request Header

Note:
Do not add an authorization header if you use
credentials as the mode of authentication.

Click Add Header to add a request HTTP header. In
the Add Header dialog box, complete the following
fields:

Name - Type the Header name.

Value - Type a value for the Header.

Required - Select this option if youwant this Header
to bemademandatorywhile creating an Integration.
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DescriptionField

In the Request Body pane, complete the following
fields:

Request Body

Content Type If the documentation of the SaaS
provider specifies that the content type of the request
body is JSON, select application/json as the content
type. If the documentation of the SaaS provider
specifies that the content type of the request body is
XML, select application/xml as the content type. If
the documentation of the SaaS provider specifies that
the content type of the request body is binary, select
Binary as the content type. These options allow you
to control the content in an HTTP request body.

Document Type - Select a Document Type for the
request body or click Create Document Type to
create a new Document Type. See “Creating
Document Types from Scratch” on page 637.

Note:
Document Types created for a REST Application
do not appear in theDevelop > Document Types
screen but appears only in the Document Types
panel for the selected REST Application.

If the request payload is an array of object, then first
create a document type resembling the content of the
object, and then select the Array option.

In the Response Header pane, click Add Header to
add a Response HTTP header.

Response Header

Note:
Do not add an authorization header if you use
credentials as the mode of authentication.

Complete the following fields:

Name - Type the Header name.

Value - Type a value for the Header.

Required - Select this option if youwant this Header
to bemademandatorywhile creating an Integration.

In the Response Body pane, complete the following
fields:

Response Body
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DescriptionField

HTTP Code - Type a single HTTP status code or a
code range to indicate the status of the response. Valid
values are 100, 101, 102...599 or a range from 100-599.

Content Type If the documentation of the SaaS
provider specifies that the content type of the
response body is JSON, select application/json as the
content type. If the documentation of the SaaS
provider specifies that the content type of the
response body is XML, select application/xml as the
content type. If the documentation of the SaaS
provider specifies that the content type of the
response body is binary, select binary as the content
type. These options allow you to control the content
in an HTTP response body.

Document Type - Select a Document Type for the
Response Body or click Create Document Type to
create a new Document Type. See “Creating
Document Types from Scratch” on page 637.

Note:
Document Types created for a REST Application
do not appear in theDevelop > Document Types
screen but appears only in the Document Types
panel for the selected REST Application.

7. Click Save.

The Action appears in the Define Resources and Actions page. You can Edit or Delete the
Action from the Define Resources and Actions page.

Note:
Do not edit or delete an Action if it is already used in an Operation. If the Action is edited
or deleted, the Operations that are dependent on the Action including the Integrations that
are dependent on the affected Operations, will not function properly.

8. Click Next.

The Confirm REST Application page appears.

9. Click Finish to create the REST Application.

The new REST Application appears in the REST Applications page.

10. To edit the RESTApplication, click the RESTApplication link and then click Edit Application.
You can change the Description and Application Icon. After you click Finish, the Update

310 Integration Cloud 6.6.0

5 Applications



REST Application window appears, which provides a summary of the impacted Accounts,
Operations, and Integrations. Click Update to update the REST Application. To delete the
REST Application, click Delete Application.

REST Applications - Account Configuration Details
Integration Cloud allows you to create custom REST Applications. REST (Representational State
Transfer) is an architectural style that requires web applications to support the HTTP GET, POST,
PUT, and DELETE methods and to use a consistent, application-independent interface.

DescriptionField

This is the login Endpoint URL you have specified in the Define
Application Details page while creating the REST Application.

Server URL

The type of HTTP authorization scheme to use for the connection.
If you enter the username andpassword, then set the authorization

Authorization Type

type as basic. Basic refers to HTTP Basic Authentication. This
option can be used if the Application requires or supports HTTP
Basic authentication using a username and password. If you select
none, no additional authorization schemewill be executed at run
time. For example, when you specify a Username and Password,
but do not specify a value for the Authorization Type, the user
credentials are not inserted into an Authorization header.

The number ofmilliseconds IntegrationCloudwaits for a response
before canceling its attempt to connect to the back end. In case the

Response Timeout

network is slow or the back end processing takes longer than
usual, increase the Response Timeout value. It is recommended
to specify a value other than 0. If you specify 0, Integration Cloud
will wait indefinitely for a response.

The number of times Integration Cloud attempts to connect to the
back end to read a response if the initial attempt fails. If an I/O

Retry Count on
Response Failure

error occurs, it will retry only if you have selected the Retry on
Response Failure option.

Whether Integration Cloud should attempt to resend the request
when the response has failed, even though the request was sent

Retry on Response
Failure

successfully. Select this option if you want to re-establish the
connection.

Also referred to as the Client ID, in OAuth 2.0, this is a client
identifier issued to the client to identify itself to the authorization

Consumer ID

server. ForAuth 1.0a, it is the ConsumerKey issued by the Service
Provider and used by the consumer to identify itself to the Service
Provider.
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DescriptionField

This token is used for authentication and is issued by the
Authorization Server. For OAuth 1.0a, it is a value used by the

Access Token

Consumer to gain access to the Protected Resources on behalf of
the User, instead of using the User's Service Provider credentials.

A secret used by the Consumer to establish ownership of a given
Access Token. For OAuth 1.0a, it is the secret used by the
Consumer to establish ownership of a given Access Token.

Access Token Secret

The provider specific URL to refresh an Access Token.Refresh URL

The maximum number of minutes a session can remain active, in
other words, how long you want the server to wait before

Session Timeout (min)

terminating a session. The value should be equal to the session
timeout value specified at the SaaS provider back end.

The username credentials for the current Account configuration.Username

The password credentials for the current Account configuration.Password

Select the alias name of the Integration Cloud trust store
configuration. The trust store contains trusted certificates used to

Trust store Alias

determine trust for the remote server peer certificates. You can
also add a new Truststore from this field. This option is available
only if Credentials is selected as the Authentication Type while
creating the Application.

Select a hostname verifier implementation. Guards against
man-in-the-middle (MITM) attacks. The default is

Hostname verifier

org.apache.http.conn.ssl.DefaultHostnameVerifier, which will
enable hostname verification. Select
org.apache.http.conn.ssl.NoopHostnameVerifier to disable
hostname verification. This option is available only ifCredentials
is selected as the Authentication Type while creating the
Application.

Server Name Indication (SNI) is an extension to the TLS protocol
by which a client indicates which host name it is attempting to

Enable SNI

connect to at the start of the handshaking process. Enable this
option if the SaaS provider offers SNI-based TLS connectivity, and
if you want to connect to an SNI enabled SAAS provider to send
the host name specified in the Server URL field, as part of the TLS
SNI Extension server_name parameter.

If you want to explicitly specify a host name to be included as a
part of the SNI extension server_name parameter, in case the host

SNI Server Name

name is other than the host name specified in the Server URL field,
specify the host name value in the SNI Server Name field.
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DescriptionField

Select the alias for the Integration Cloud key store configuration.
This is a text identifier for the keystore alias. A keystore file

Keystore Alias

contains the credentials (private key/signed certificate) that a client
needs for authentication. You can also add a new Keystore from
this field. This option is available only if Credentials is selected
as the Authentication Type while creating the Application.

Alias to the private key in the keystore file specified in theKeystore
Alias field. The outbound connections use this key to send client

Client Key Alias

credentials to a remote server. To send the client’s identity to a
remote server, youmust specify values in both the Keystore Alias
and the Client Key Alias fields. This option is available only if
Credentials is selected as theAuthentication Typewhile creating
the Application.

Also referred to as the Client Secret, this is a secret matching to
the client identifier. For Auth 1.0a, it is the secret used by the
Consumer to establish ownership of the Consumer Key.

Consumer Secret

Issued with the OAuth v2.0 access token only. A token used by
the client to obtain a new access token without having to involve
the resource owner.

Refresh Token

Options for sending the parameters in the Access Token refresh
request. The options are Body Query String, URL Query String,
and Custom Integration.

Refresh URL Request

Body Query String - The refresh request parameters, for example,
refresh_token, grant_type, and so on, and their values are sent as
query strings in the body of the POST request.

URL Query String - The refresh request parameters, for example,
refresh_token, grant_type, and so on, and their values are sent as
query strings in the URL of the POST request.

Custom ESB Service - Use this option if the back end requires
refresh requests in a custom format. If you select this option, you
must specify the name of your Integration in the Refresh Custom
ESB Service field. You can also create an Integration by clicking
the link.

To refresh the access tokens for accounts which use the OAuth 2.0
protocol, you can specify a call-back Integrationwhichwill execute
when the access token expires.

Refresh Custom ESB
Service

This is a user implemented service for refreshing the OAuth 2.0
Access Token. This option allows you to create an Integration,
which will be executed when the Access Token has expired or is
not valid.
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DescriptionField

To create this Integration, create a custom REST Application with
an Operation that invokes the back end to fetch the refresh token.
You canuse this customRESTApplication alongwith itsOperation
to create this Integration.

Click the Integration link to create a new Integration.

The Integrationmust have a specificationwhose input parameters
are:

and the output parameters are:

Note:
The integration will be pre-populated with the input/output
adhering to the above mentioned specification.

The newly created Integration will generate an access token that
is mapped to the access token field in the output signature.

Note:
While editing the Account, this new Integration appears in the
Refresh Custom ESB Servicefield in theAccountConfiguration
page.

Tweet the status on Twitter using the REST Application

Summary

In this tutorial, we will see how to create a REST Application using the Twitter REST API and use
that REST Application to post a tweet on Twitter.

Before you begin

Permissions to create Operations and Integrations for a project in Integration Cloud.
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An email account ID, for example, twitapplication@gmail.com.

A Twitter account. You can create one using your email ID.

Steps

1. Log in to Twitter, go to https://developer.twitter.com/en/apps, and click Create an app to
create a Twitter app.

2. Create an application by filling the form and click Create.

Note:
See
https://developer.twitter.com/en/docs/tweets/post-and-engage/api-reference/post-statuses-update
for information on POST statuses/update.
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3. Log in to Integration Cloud and go to Projects > <Select a Project> > Applications > REST
Applications > Add New Application. Fill in the details as shown below in the Define
Application Details screen and then click Next.

Note:
Default Endpoint URL should not contain the path of the endpoint. For example, if the
complete endpoint URL is https://api.twitter.com/1.1/statuses/update.json, then
https://api.twitter.com/1.1 is the Default Endpoint URL. Rest of the path /statuses/
update.jsonwill be used as the Resource Path while adding a Resource later.

4. On the Define Resources and Actions page, click Add Resource.
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5. Let us add the postTweet Resource. Click Add.

6. Select the postTweet Resource and click Add Action.

7. On the Add Action to Resource page, select POST as the Method. In our example, we are
considering a POST request which needs a Request PARAMETER and a Response BODY.
Click Add Parameter to add the Request PARAMETER.

8. Specify the PARAMETER name exactly as it is in the API documentation
(https://developer.twitter.com/en/docs/tweets/post-and-engage/api-reference/post-statuses-update).
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9. Now let us add the Response Body. Click Response > BODY > Add Response Body.

318 Integration Cloud 6.6.0

5 Applications



10. In the Document Type drop-down list, click Create Document Type and then click Load
JSON in the Add New Document Type window.

11. Copy the Example Response from the Twitter API Documentation page
(https://developer.twitter.com/en/docs/tweets/post-and-engage/api-reference/post-statuses-update),
paste it in the text area of the page as shown below, and click Load. Note that there is a known
issue in the response section of the Twitter API Documentation. As a workaround, while
pasting, omit the record starting with the string source. After loading, click Save and thenAdd
to add the Response BODY.

12. Click Add to add the Action.
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13. The Actions column displays the POST action.

14. ClickNext and then click Finish to create the RESTApplication TweetOnTwitter. Then create
a new Account by clicking Accounts as shown below.

15. Then click Add New Account, fill in the Account configuration details obtained from the
Twitter app (Consumer API Keys and Access Tokens) as shown below, and click Save.
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16. Now click OPERATIONS > Add New Operation. Provide all the details and create the
Tweetop operation.

17. Select the operation, click Test, and then Run the operation.

18. You will see that running the operation has triggered a tweet on your Twitter account.
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19. You can also trigger the REST Application from an integration. Click INTEGRATIONS > Add
New Integration, and select the Orchestrate two or more applications option.

20. Setup the Integration as shown below using the REST Application, and then click Save.

21. Run and test the Integration. This will tweet as Hello World Once Again.

Next Steps

Whenever you execute the Integration, youwill see a new tweet on the user's Twitter account with
your message.
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On-Premises Applications

On-Premises applications uploaded from on-premises systems are listed in the On-Premises
Applications page, but you will not be able to create Accounts or Operations for on-premises
applications. Those can be uploaded only from webMethods Integration Server. Further, when
you upload services as part of an application from the on-premiseswebMethods Integration Server
to webMethods Integration Cloud, the comments field of the service is uploaded and displayed
in thewebMethods IntegrationCloud application. This fieldwill be displayed if present and cannot
be edited. See the Configuring On-Premise Integration Servers for webMethods Cloud document for
more information.

If you select an Account for an on-premises Application and click Test Connection, the screen
displays the status of the connection. If you have configured the Account details incorrectly in
any stage, the state appears in red color in the Connectivity Status column. If an Account is
configured correctly in a particular stage, the state appears in green color and if an Account is not
configured in a particular stage, the state appears in white color. For on-premises Applications,
you can use the Account to execute services on the on-premises webMethods Integration Server.

Performance, scalability, and availability of on-premises connectivity for hybrid integration
scenarios have been enhanced by having dedicated SoftwareAGUniversalMessaging (UM) nodes
for each tenant. A tenant can be associated with dedicated UMs based on the license. Contact
Software AG Global Support for assistance in setting up the dedicated hybrid infrastructure. If
you are using hybrid connectivity andwhen you update the on-premises settings for the first time
after the upgrade, restart the on-premises webMethods Integration Server to resume hybrid
connectivity. If you have whitelisted the Cloud UM hostname or IP in the firewall, then you have
to also whitelist the new UM hostname and IP along with the old ones. Click “here” on page 323
for information on the IP addresses.

Note:
The maximum message size, that is, the hard limit for message sizes that can be transported
between on-premiseswebMethods Integration Server and Integration Cloud is 20MB (20971520
bytes). This is the hard limit on the size of messages that can be transported over Software AG
Universal Messaging between Integration Cloud and on-premises webMethods Integration
Server. Overloading the Software AG Universal Messaging cluster with large payloads may
adversely impact performance. If you need to transport larger volumes of data, consider an
alternative approach that is better suited for file transfers, such as, webMethods ActiveTransfer.

Dedicated infrastructure support for hybrid integration scenarios
Performance, scalability, and availability of on-premises connectivity for hybrid integration
scenarios have now been enhanced by having dedicated Software AGUniversal Messaging (UM)
nodes for each tenant. A tenant can be associatedwith dedicatedUMs based on the license. Contact
Software AG Global Support for assistance in setting up the dedicated hybrid infrastructure.

If you are using hybrid connectivity and when you update the on-premises settings for the first
time after the upgrade, restart the on-premises webMethods Integration Server to resume hybrid
connectivity. If you have whitelisted the Cloud UM hostname or IP in the firewall, then you have
to also whitelist the new UM hostname and IP along with the old ones. See the following table for
information on the IP addresses.
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Hybrid Connectivity IP AddressesNAT Gateway IP AddressesZones

um.webmethodscloud.com52.39.87.1US, Oregon

34.214.4.7952.39.97.85

52.24.188.207

um.webmethodscloud.de35.157.214.174DE, Germany

18.159.91.23352.57.210.55

18.158.241.179

um.webmethodscloud.eu52.209.82.145EU, Ireland

54.228.75.6152.16.34.106

63.33.112.226

UM IP AddressesUM Host NameZones

52.27.56.188um-01-142ebc71-a.webmethodscloud.comUS, Oregon

52.27.70.226um-02-142ebc71-a.webmethodscloud.com

52.27.83.194um-03-142ebc71-a.webmethodscloud.com

52.57.68.150um-01-e8c55c80-a.webmethodscloud.deDE, Germany

52.28.72.223um-02-e8c55c80-b.webmethodscloud.de

52.59.84.12um-03-e8c55c80-a.webmethodscloud.de

52.212.8.149um-01-76de9912-a.webmethodscloud.euEU, Ireland

52.51.244.127um-02-76de9912-a.webmethodscloud.eu

52.50.237.197um-03-76de9912-a.webmethodscloud.eu

Uploading on-premises services to Integration Cloud

Summary

In this tutorial, we will see how to upload on-premises services from webMethods Integration
Server to Integration Cloud.

Actors

On-premises webMethods Integration Server user

Integration Cloud instance to upload the on-premises application
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Integration Cloud user

Before you begin

SoftwareAGUniversalMessaging installed and running on-premises alongwithwebMethods
Integration Server. Software AGUniversal Messaging is required for communication between
on-premises webMethods Integration Server and Integration Cloud.

Note:
Themaximummessage size, that is, the hard limit for message sizes that can be transported
between on-premises webMethods Integration Server and Integration Cloud is 20 MB
(20971520 bytes). This is the hard limit on the size of messages that can be transported over
SoftwareAGUniversalMessaging between IntegrationCloud and on-premiseswebMethods
Integration Server. Overloading the Software AG Universal Messaging cluster with large
payloads may adversely impact performance. If you need to transport larger volumes of
data, consider an alternative approach that is better suited for file transfers, such as,
webMethods ActiveTransfer.

Your Access Profile must have the permission to create Accounts, Operations, Applications,
and Integrations.

Your Access Profile must have the administer stages permission.

Basic Flow

Update Settings and create Account and Application in webMethods Integration Server.

1. Log in to the webMethods Integration Server instance, for example, http://<hostName>:5555/.

Note:
Software AG Universal Messaging should be running.

2. Go to webMethods Cloud > Settings.

3. Enter your IntegrationCloudURL, for example, https://{instanceName}.webmethodscloud.com,
user name, password, and click Update Settings.
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4. Go to webMethods Cloud > Accounts and click Create On-Premise Account.

5. Enter the details as shownbelowon theCreate Accountpage and click Test Account Settings.
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Note:
The Alias Name is the name of the account that will appear on Integration Cloud and the
Stage is the stage where you want to expose the webMethods Integration Server services.

6. Click Save Changes and check if the account is enabled.

7. Go towebMethods Cloud > Applications and clickDefine webMethods Cloud Application.

8. Select the webMethods Integration Server services that you want to expose on Integration
Cloud, provide a Display Name for the service, and Save your changes.

Note:
Services that have wrapper type fields, for example, fields of type other than String and
IData in its Input or Output signature, cannot be exposed to Integration Cloud and they
will not be available in the Package/Services column.
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9. Go to webMethods Cloud > Applications and click the upload icon.

10. Select the account and click Upload. The Application will be uploaded to Integration Cloud.

11. Log in to your Integration Cloud instance and go to Projects > <Select a Project> >
Applications > On-Premises Applications. The on-premises Application appears in the list.
Use the operations of the on-premises Application to create Integrations.
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SOAP Applications

The SOAP Application enables you to access third party Web Services hosted in the cloud. The
SOAP Application uses a WSDL to create consumer operations.

The following features are supported for SOAP Applications:

A SOAP Application implementation follows the WS-I Basic Profile 1.1 specification.

SOAP Applications can be created by uploading a WSDL file or by using a valid WSDL URL
that can be accessed over a network.

SOAP Applications can be created with WSDLs that are annotated with WS-Security
Policy/Policies.

SOAP Applications with SOAP version 1.1 and 1.2 and Style/Use as Document/Literal and
RPC/Literal (RPC/Encoded model is not supported for SOAP version 1.2).

The following SOAP Binding types are supported:

SOAP over HTTP.

SOAP over HTTPS.

Authentication type: HTTP Basic Token.

SOAP Applications have the following restrictions:

TheWSDL and associated schema(s)must be accessible through a publicly or locally accessible
URL.

Only WSDLs with WS-Security policies are supported. Any other policies, for example,
WS-Addressing, WS-Reliable Messaging, and so on, are not supported. If you create SOAP
Applications with WSDLs having non-WS-Security Policies, exceptions may appear while
executing Integrations.

Manual addition of WS-Security Policies in a SOAP Application is not supported. SOAP
Applications with WS-Security can be created with only policy-annotated WSDLs, that is,
WSDLs that already have WS-Security Policies annotated in them.

SOAP over JMS is not supported.

Only Basic Authentication is supported. Other authentication types such as Digest, NTLM,
and Kerberos are not supported.

You will not be able to attach or upload a file while executing an Integration.

To add a SOAP Application

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Applications
> SOAP Applications > Add New Application.
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2. Provide a name and description of your SOAP Application. The description you enter here
will appear in the SOAP Applications page. Required fields are marked with an asterisk on
the screen.

3. Click Browse next to theApplication Icon if you want to select a different icon for your SOAP
Application. The icon must be a PNG file and the size cannot exceed 50 KB, else the default
image is displayed.

4. Click Next and specify the WSDL Source.

SelectURL if youwant to specify the URL of theWSDL. The URL should begin with http://
or https://. The URL is used to retrieve the WSDL for the SOAP Application.

Select File and then clickBrowse if youwant to select theWSDL fromyour local file system.
The size of the WSDL cannot exceed 5 MB. You can click the icon beside the Browse
button if you want to add separate elements of a service definition after import, such as
WSDLs or XSDs, to the primary WSDL.

Note:
Ensure that you add the primaryWSDL as the first WSDL, and then add separate elements
of the service definition, for example, dependent WSDLs and XSDs to the primary WSDL.

5. Enter the user name and password in the Authentication section if authentication is required
to access the WSDL URL.

6. Click Next to review the details you have entered.

7. Click Finish to create the SOAP Application.

Editing SOAP Applications

From the SOAP Applications page, click the SOAP Application link, and then click Edit
Application. You can change the Description and the Application Icon.

In the Application details page,Update WSDL section, selectNo, keep existing WSDL if you
do not want to modify the WSDL URL or the WSDL file. Select Yes, override WSDL if you
want to specify a newWSDL URL or upload a newWSDL file in the WSDL Source section.

Confirm the updated Application. After you click Finish, the Update SOAP Application
window appears, which provides a summary of the impacted Accounts, Operations, and
Integrations. Click Update to update the SOAP Application. Updating the WSDL may result
in addition or removal of Operations or fields in the Input/Output signature of an Operation.
This may lead to incorrect mappings if you have used that Operation in an Integration. To
delete a SOAP Application, click Delete Application.
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SOAP Applications - Account Configuration Details
Integration Cloud allows you to create Custom SOAP Applications. Custom SOAP Applications
enable you to access third party web services hosted in the cloud or on-premises environment.
TheCustomSOAPApplication uses aWSDL that is accessible through publicly or locally accessible
URLs.

DescriptionField

Select the bind address from the drop-down list, that is, the concrete
protocol and data format specification for the web service.

Port Binding

This is the URL for the web service. You can edit the URL to specify a
different web service endpoint.

URL

The number of milliseconds Integration Cloud waits for a response
before canceling its attempt to connect to the back end. In case the

Response
Timeout

network is slow or the back end processing takes longer than usual,
increase the response timeout value. It is recommended to specify a
value other than 0.

If you specify 0, Integration Cloudwill wait indefinitely for a response.

If you do not specify a timeout, Integration Cloud will consider 5
minutes as the response timeout.

If the connection to the host provider ends before Integration Cloud
receives a response, the web service operation ends with an exception
and a status code of 408.

User name used to authenticate the consumer at the HTTP or HTTPS
transport level on the host server.

User

The password used to authenticate the consumer on the host server.Password

Alias to the keystore that contains the private key used to connect to
the Web Service host securely. You can also add a new Keystore from
this field.

Keystore Alias

Note:
Users who have the Administer permission under Settings  >
Access Profiles > Administrative Permissions > Functional
Controls > Advanced Security can add, edit, and delete Keystores.

Alias to the key in the keystore that contains the private key used to
connect to the Web Service host securely. The key must be in the
keystore specified in the Keystore Alias field.

Key Alias

Show Advanced Options - WS-Security properties are used by the SOAP processor to
provide security information in the WS-Security header of the SOAP message.
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DescriptionField

Security Credentials

Name to includewith theUsernameToken, if theWeb Service's security
policy requires one.

User Name

The password to includewith theUsernameToken (must be plain text).Password

Keystore / Truststore

The alias for the keystore, which contains private keys and certificates
associated with those private keys. You can also add a new Keystore
from this field.

Keystore Alias

Note:
Users who have the Administer permission under Settings  >
Access Profiles > Administrative Permissions > Functional
Controls > Advanced Security can add, edit, and delete Keystores.

The text identifier for the private key associated with the Keystore
Alias.

Key Alias

The alias for the truststore, which contains the trusted root of a
certificate or signing authority (CA). You can also add a newTruststore
from this field.

Truststore Alias

Note:
Users who have the Administer permission under Settings  >
Access Profiles > Administrative Permissions > Functional
Controls > Advanced Security can add, edit, and delete Truststores.

The file that contains the partner's self-signed certificate. You can also
add a new Partner Certificate from this field.

Partner
Certificate Alias

Note:
Users who have the Administer permission under Settings  >
Access Profiles > Administrative Permissions > Functional
Controls > Advanced Security can add, edit, and delete Partner
Certificates.

Timestamp

Whether the timestampplaced in the Timestamp element of the security
header of an outbound message is precise to seconds or milliseconds.

Timestamp
Precision

If the precision is set to milliseconds, the timestamp format
yyyy-MM-dd'T'HH:mm:ss:SSS'Z' is used. If the precision is set to
seconds, the timestamp format yyyy-MM-dd'T'HH:mm:ss'Z' is used.

The time-to-live value for an outboundmessage in seconds. This value
is used to set the expiry time in the Timestamp element of outbound

Timestamp TTL
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DescriptionField

messages. The timestamp precision value is used only when
WS-Security is implemented through a WS-Policy.

Themaximumnumber of seconds that theWeb Services client and host
clocks can differ so that the timestamp expiry validation does not fail.

Timestamp Max
Skew

The timestamp precision value is used only when WS-Security is
implemented through a WS-Policy. The inbound SOAP message is
validated only if the creation timestamp of the message is less than the
sum of the timestamp maximum skew value and the current system
clock time.

SOAP Signature
All SOAPApplication operations have an identical input and output signature with the exception
of the variables used to represent the input and output messages. For information about how a
SOAP Application operation represents the input and output messages in the signature, see How
a SOAP Application Operation represents the Input and Output Messages.

How a SOAP Application Operation represents the Input and Output Messages

How a SOAP Application operation represents the contents of the input and output message in
the signature depends on the style/use of the binder for the SOAP Application operation.

For a SOAP Application operation that uses a style/use of Document/Literal:

The input signature contains an optional document reference to a document type created
to represent the operation input message. At run time, if you do not specify any input for
the document reference variable or any of its child variables, Integration Cloud sends an
empty SOAP body in the SOAP message.

The output signature contains a document reference to a document type created to represent
the operation outputmessage. This document reference is conditional and is only returned
by the SOAPApplication operation if the SOAPApplication operation executes successfully.
If returned at run time, this document reference contains the response from a successful
invocation of a SOAP Application operation. If the SOAP Application operation receives
a SOAP fault, it is converted to an exception that can be caught with the try catch block in
an Orchestrated Integration.

For a SOAP Application operation that uses a style/use of RPC/Encoded or RPC/Literal:

The input signature contains variables that represent the top-level elements in the operation
input message. All of these variables are optional. At run-time, if you do not specify any
input for the variable (or variables) that represent the input message, Integration Cloud
sends an empty SOAP body in the SOAP message.

The output signature contains variables that represent the top-level elements in the operation
output message. All of these variables are conditional and are only returned by the SOAP
Application operation if the SOAPApplication operation executes successfully. If returned,
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these variables contain the response from a successful invocation of a SOAP Application
operation.

Input Parameters

Document Optional. Transport-specific header fields that you want to
explicitly set in the request. Specify a key in transportHeaders for each header

transportHeaders

field that you want to set, where the key’s name represents the name of the
header field and the key’s value represents the value of that header field.

The names and values supplied to transportHeadersmust be of type String.
For information about using transportHeaderswith HTTP/S requests
including a description of the default behavior, see Setting Transport Headers
for HTTP/S.

Output Parameters

Document Conditional. Headers from response and request messages.transportInfo

The contents of the transportInfo vary depending on the actual transport
(HTTP or HTTPS) used.

transportInfo contains the following keys:

ValueKey

Document Conditional. Header fields from the request
message. The contents of the requestHeaders document are

requestHeaders

not identical to transportHeaders used as input. The
transport can add, remove, or alter specific headers while
processing the request.

Whether or not the SOAP Application operation returns
the requestHeaders parameter depends on the success or
failure of the operation. In the case of failure, the point at
which the failure occurs determines the presence of the
requestHeaders parameter. For more information, see
Transport and Exceptions Returned by a SOAP Application
Operation.

For the HTTP or HTTPS transports, the requestHeaders
parameter will not contain any HTTP headers that the
transport mechanism added or modified when sending
the request.

Document Conditional. Header fields from the response.
Each key in responseHeaders represents a field (line) of the

responseHeaders

response header. Key names represent the names of header
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fields. The keys' values are Strings containing the values
of the fields.

Whether or not the SOAP Application operation returns
the responseHeaders parameter depends on the success or
failure of the operation. In the case of failure, the point at
which the failure occurs determines the presence of the
responseHeaders parameter. For more information, see
Transport and Exceptions Information Returned by a SOAP
Application Operation.

For the HTTP or HTTPS transports, the responseHeaders
parameter contains any HTTP/HTTPS headers present in
the response.

StringConditional. Status code from the request, returned
by the underlying transport.

status

For more information about status codes and status
messages returned by a SOAP Application operation, see
Transport and Exceptions Information Returned by a SOAP
Application Operation.

StringConditional. Description of the status code returned
by the transport.

statusMessage

For more information about status codes and status
messages returned by a SOAP Application operation, see
Transport and Exceptions Information Returned by a SOAP
Application Operation.

Setting Transport Headers for HTTP/S

When creating a service that executes a SOAPApplication operation, you can pass transport header
information directly into the SOAP Application operation by passing name/value pairs in to the
transportHeaders input parameter. When creating the SOAP request, Integration Cloud adds a
transport header for each name/value pair.

Keep the following information in mind when setting transportHeaders for an HTTP/S request:

Specify a key in transportHeaders for each header field that you want to set, where the key’s
name represents the name of the header field and the key’s value represents the value of that
header field.

The names and values supplied to transportHeadersmust be of type String. If a transport header
has a name or value that is not of type String, the header will not be included in the message.

For any header name/value pair supplied in transportHeaders for anHTTP/S request, Integration
Cloud simply passes through the supplied headers and does not perform any validation for
the headers beyond verifying that the name and value are of type String.
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If you do not set transportHeaders or do not specify the following header fields in
transportHeaders, IntegrationCloud adds and specifies values for the following standard header
fields:

Accept

Authorization

Connection

Content-Type

SOAPAction (Added when soapProtocol is SOAP 1.1 only)

User-Agent

Note:
Pass in the preceding headers to transportHeaders only if you are an experienced SOAP
Application developer. Incorrect header values can result in failure of the request.

For a SOAP Application operation, Integration Cloud sets the value of the Host header and
overwrites any supplied value.

If you specify Authorization in transportHeaders, the values specified for the auth/transport
document and its children will not be used in the Authorization header.

If you specify Content-Type in transportHeaders and the SOAPProtocol is SOAP 1.2, Integration
Cloud ignores the value of soapAction obtained from the WSDL used to create the SOAP
Application operation.

If you specify the SOAPAction header in transportHeaders and the SOAP Protocol is SOAP 1.1,
Integration Cloud ignores the value of SOAPAction obtained from theWSDL used to create the
SOAP Application operation.

Integration Cloud sets the value of Content-Length automatically and overwrites any value
passed in to transportHeaders.

Integration Cloud automatically adds the Cookie header to the HTTP header and supplies any
cookies established between IntegrationCloud and theHTTP serverwithwhich it is interacting.
If you supply the Cookie header to transportHeaders, Integration Cloud prepends the values
you supply to the already established Cookie header value.

The following headers are considered to be standard and require the specified capitalization:
Accept, Authorization, Connection, Content-Type, Cookie, Host, SOAPAction, User-Agent.

Important:
Using capitalization other than that which is specified results in undefined behavior.

Important:
Supplying duplicate entries for any standard header results in undefined behavior.

Transport and Exceptions Returned by a SOAP Application Operation
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The transport information, such as headers, status codes, and statusmessages, returned by a SOAP
Application operation varies depending on the following:

The transport used to send and receive the SOAP message

The success or failure of the SOAP Application operation

The point at which failure occurs

The message exchange pattern (MEP) for the operation

Note:
Transport information is returned in the transportInfo output parameter.

If the SOAP Application operation receives a SOAP fault, it is converted to an exception that can
be caught with the try catch block in an Orchestrated Integration.

Flat File Applications

You can use the Flat File Application to translate documents into and from flat file formats. To set
up the translation, you create the definition and structure of the Flat File Application, which is called a
flat file schema. The schema also contains the instructions for parsing or creating the flat file and
defines how to identify individual records within a flat file and what data is contained in each of
those records.

What is a flat file definition and structure?

The definition and structure of a flat file Application contains the instructions for parsing or
creating a flat file. It details the structure of the document, including delimiters, records, and
repeated record structures. It also acts as the model against which you can validate an inbound
flat file. A flat file structure consists of hierarchical elements that represent each record, field, and
subfield in a flat file.

What are the different approaches to create a flat file Application?

You can create a flat file Application using any one of the following approaches:

“Create manually” on page 338: In this approach, you define the definition and structure of a
flat file Application and then manually add the elements or properties.

“Use a sample file” on page 350: In this approach, you use a sample file to define the definition
and structure of a flat file Application. Here, you use the automated wizards to create the
structure of the flat file.

What are the high-level steps to create a flat file Application?

Define the Application details. In this stage, you define the Application details and
the approach. You can create the flat file Application either manually or by using a
sample file.

Step 1

Define the record parser and specify a record identifier. In this stage, you associate
a record parser with the flat file Application that will process flat files inbound to

Step 2
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Integration Cloud. You also specify how you want the record to be identified after it
is parsed.

Define the flat file structure. If you are creating the flat file Application manually,
in this stage, you specify the hierarchical structure of the flat file by creating and
nesting the record definitions.

Step 3

Invoke Operations.

After creating the flat file Application, create an Orchestrated Integration, select the Flat File
Application created, and invoke the following predefined operations:

“convertFlatFileToDocument” on page 355 - Converts the flat file to a document (inbound)

“convertDocumentToFlatFile” on page 357 - Converts a document to a flat file (outbound)

Creating a flat file Application manually
Integration Cloud can process flat files in which:

The records in the flat file are defined using one of the following methods:

DescriptionProperty

Each record in the flat file is separated by a delimiter.Delimiter

Each record is a fixed number of bytes (for example,mainframe
punch or print records).

Fixed length

Each record is preceded by two bytes that indicate the length
of the record. Records in the flat file can have different lengths.

Variable length

If the flat file contains record identifiers, the record identifiers must be located in the same
location in all records in the file.

Integration Cloud can then identify fields in these records based on:

Fixed position - Each field is defined by 1) the number of bytes from the beginning of the
record and 2) the field length. This can be used regardless of whether a field delimiter has been
specified.

Delimiters - Each field is separated by a delimiter, and you can specify theNth delimited field
in a record to represent the record identifier. This can be used onlywhen a field delimiter (and,
if necessary, subfield delimiter) has been specified.

To create a flat file Application manually

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Flat File
Applications > Add New Application.
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2. Type a name and description of the flat file Application and select the creationmode asCreate
manually.

3. Click Next and in the Flat File Definition page, configure the Record parser and the Record
identifier.

4. In the Record parser section, to configure a delimited record parser, select Delimiter in the
Record parser area and specify the following fields.

For a record delimiter, you can specify a character (for example, !) or character representation
(for example, \r\n for carriage return).

Use the Delimiter record parser for the Flat File Application when each record is separated
by a delimiter.

DescriptionRecord typeDelimiter

Character that separates records in a flat
file document.

CharacterRecord

--OR--

Starting from the beginning of the
document and counting from zero (0), the

Character Position

character position at which the record
delimiter for this document is located.

Note:
For example, if you specify 3 as the
character position, you have indicated
that the record delimiter appears in the
fourth character position from the
beginning of the document.

DescriptionField or composite
type

Delimiter

Character that separates fields in a
flat file document.

CharacterField or composite

--OR--

Starting from the beginning of the
document and counting from zero

Character
position

(0), the character position at which
the field delimiter for this
document is located.

Note:
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DescriptionField or composite
type

Delimiter

For example, if you specify 4 as
the character position, you have
indicated that the field delimiter
appears in the fifth character
position from the beginning of
the document.

DescriptionSubfield typeDelimiter

Character that separates subfields in a flat
file document. The default is a period “.”.

CharacterSubfield

--OR--

Starting from the beginning of the document
and counting from zero (0), the character

Character position

position at which the subfield delimiter for
this document is located.

Note:
For example, if you specify 5 as the
character position, you have indicated
that the subfield delimiter appears in the
sixth character position from the
beginning of the document.

DescriptionQuoted release
character type

Delimiter

Character used to enable a section of text
within a field to be represented as its literal

CharacterQuoted release
character

value. Any delimiter characters that appear
within this section will not be treated as
delimiters.

Note:
For example, your field delimiter is (,) and
your release character is “.When youwant
to use (,) within a field as text, you must
prefix it with your quoted release
character. When using the
convertFlatFileToDocument operation to create
the strings Doe, John and Doe, Jane, the
recordwould appear as “Doe, John”,“Doe,
Jane”. When using the
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DescriptionQuoted release
character type

Delimiter

convertDocumentToFlatFile operation to create
“Doe, John”,“Doe, Jane”, the value of the
recordwould be Doe, John and Doe, Jane.
When using the convertDocumentToFlatFile
operation, if you have specified both the
Release Character and theQuoted Release
Character, the Quoted Release Character
will be used.

--OR--

Starting from the beginning of the document
and counting from zero (0), the character

Character
position

position atwhich the quoted release character
for this document is located.

Note:
For example, if you specify 5 as the
character position, you have indicated that
the quoted release character appears in the
sixth character position from the beginning
of the document.

DescriptionRelease character
type

Delimiter

Character used to enable a delimiter
to be used for its intended, original

CharacterRelease character

meaning. The character following the
release character will not be treated
as a delimiter.

Note:
For example, your field delimiter
is + and your release character is
\. When using + within a field as
text, you must prefix it with your
release character. When using the
convertFlatFileToDocument operation
to create the strings a+b+c and
d+e+f, the record would appear as
a\+b\+c+d\+e\+f.Whenusing the
convertDocumentToFlatFile operation
to create a\+b\+c+d\+e\+f, the
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DescriptionRelease character
type

Delimiter

value of the recordwould be a+b+c
and d+e+f.

--OR--

Starting from the beginning of the
document and counting from zero

Character position

(0), the character position at which
the field delimiter for this document
is located.

Note:
For example, if you specify 5 as the
character position, you have
indicated that the field delimiter
appears in the sixth character
position from the beginning of the
document.

Next, set the record identifier.

5. Use a Fixed Length record parser type when each record is of a fixed length (for example,
mainframepunch or print records). This parser splits a file into records of the samepre-specified
length. To configure a fixed length record parser, in the Record Parser Type area, select Fixed
Length.

Specify the following fields:

DescriptionField or composite
type

Fixed Length

Character that separates fields or
composites in a flat file document.

CharacterField or composite

--OR--

Starting from the beginning of the
document and counting from zero (0), the

Character position

character position at which the field
delimiter for this document is located.

Note:
For example, if you specify 4 as the
character position, you have indicated
that the field delimiter appears in the
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DescriptionField or composite
type

Fixed Length

fifth character position from the
beginning of the document.

DescriptionSubfield typeFixed Length

Character that separates subfields in
a flat file document.

CharacterSubfield

--OR--

Starting from the beginning of the
document and counting from zero

Character position

(0), the character position at which
the subfield delimiter for this
document is located.

Note:
For example, if you specify 5 as
the character position, you have
indicated that the subfield
delimiter appears in the sixth
character position from the
beginning of the document.

DescriptionQuoted release
character type

Fixed length

Character used to enable a section of text
within a field to be represented as its

CharacterQuoted release
character

literal value. Any delimiter characters
that appear within this section will not
be treated as delimiters.

Note:
For example, your field delimiter is (,)
and your release character is “. When
you want to use (,) within a field as
text, you must prefix it with your
quoted release character. When using
the convertFlatFileToDocument operation
to create the strings Doe, John and Doe,
Jane, the record would appear as
“Doe, John”,“Doe, Jane”.Whenusing
the convertDocumentToFlatFile operation
to create “Doe, John”,“Doe, Jane”, the
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DescriptionQuoted release
character type

Fixed length

value of the record would be Doe,
John and Doe, Jane.When using the
convertDocumentToFlatFile operation, if
you have specified both the Release
Character and the and the Quoted
ReleaseCharacter, theQuotedRelease
Character will be used.

--OR--

Starting from the beginning of the
document and counting from zero (0),

Character
position

the character position at which the
quoted release character for this
document is located.

Note:
For example, if you specify 5 as the
character position, you have indicated
that the quoted release character
appears in the sixth character position
from the beginning of the document.

DescriptionRelease
character type

Fixed length

Character used to enable a delimiter to
be used for its intended, original

CharacterRelease character

meaning. The character following the
release character will not be treated as
a delimiter.

Note:
For example, your field delimiter is +
and your release character is \.When
using + within a field as text, you
must prefix it with your release
character. When using the
convertFlatFileToDocument operation to
create the strings a+b+c and d+e+f, the
record would appear as
a\+b\+c+d\+e\+f. When using the
convertDocumentToFlatFile operation to
create a\+b\+c+d\+e\+f, the value of
the recordwould be a+b+c and d+e+f.

344 Integration Cloud 6.6.0

5 Applications



DescriptionRelease
character type

Fixed length

--OR--

Starting from the beginning of the
document and counting from zero (0),

Character
position

the character position at which the field
delimiter for this document is located.

Note:
For example, if you specify 5 as the
character position, youhave indicated
that the field delimiter appears in the
sixth character position from the
beginning of the document.

DescriptionFixed length

In the Record Length field, enter the length, in
characters, of each record in the flat file. Record length
cannot be empty.

Record length

Next, set the record identifier.

6. The Variable Length record parser type expects each record to be preceded by two bytes that
indicate the length of the record. Each record may be a different length.

To configure a variable length record parser, in theRecord Parser area, selectVariable length,
and specify the following fields:

DescriptionField or composite
type

Variable Length

Character that separates fields or
composites in a flat file document.

CharacterField or
composite

--OR--

Starting from the beginning of the
document and counting from zero (0), the

Character position

character position at which the field
delimiter for this document is located.

Note:
For example, if you specify 4 as the
character position, you have indicated
that the field delimiter appears in the

Integration Cloud 6.6.0 345

5 Applications



DescriptionField or composite
type

Variable Length

fifth character position from the
beginning of the document.

DescriptionSubfield
type

Variable length

Character that separates subfields in a flat
file document.

CharacterSubfield

--OR--

Starting from the beginning of the document
and counting from zero (0), the character

Character
position

position at which the subfield delimiter for
this document is located.

Note:
For example, if you specify 5 as the
character position, you have indicated that
the subfield delimiter appears in the sixth
character position from the beginning of
the document.

DescriptionQuoted
release
character
type

Variable length

Character used to enable a section of text
within a field to be represented as its literal

CharacterQuoted release
character

value. Any delimiter characters that appear
within this section will not be treated as
delimiters.

Note:
For example, your field delimiter is (,) and
your release character is “. When you want
to use (,) within a field as text, you must
prefix it with your quoted release character.
When using the convertFlatFileToDocument
operation to create the strings Doe, John and
Doe, Jane, the recordwould appear as “Doe,
John”,“Doe, Jane”. When using the
convertDocumentToFlatFile operation to create
“Doe, John”,“Doe, Jane”, the value of the
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DescriptionQuoted
release
character
type

Variable length

record would be Doe, John and Doe,
Jane.When using the convertDocumentToFlatFile
operation, if you have specified both the
Release Character and the and the Quoted
Release Character, the Quoted Release
Character will be used.

--OR--

Starting from the beginning of the document
and counting from zero (0), the character

Character
position

position at which the quoted release character
for this document is located.

Note:
For example, if you specify 5 as the character
position, you have indicated that the quoted
release character appears in the sixth
character position from the beginning of the
document.

DescriptionRelease
character type

Variable length

Character used to enable a delimiter to be used
for its intended, original meaning. The character

CharacterRelease
character

following the release character will not be treated
as a delimiter.

Note:
For example, your field delimiter is + and your
release character is \. When using + within a
field as text, youmust prefix itwith your release
character. When using the
convertFlatFileToDocument operation to create the
strings a+b+c and d+e+f, the record would
appear as a\+b\+c+d\+e\+f. When using the
convertDocumentToFlatFile operation to create
a\+b\+c+d\+e\+f, the value of the recordwould
be a+b+c and d+e+f.

Starting from the beginning of the document and
counting from zero (0), the character position at

Character
position
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DescriptionRelease
character type

Variable length

which the field delimiter for this document is
located.

Note:
For example, if you specify 5 as the character
position, you have indicated that the field
delimiter appears in the sixth character position
from the beginning of the document.

Next, set the record identifier.

7. Specifying a Record Identifier

When parsing a file, Integration Cloud looks at a record and extracts an identifier out of the
data and uses that identifier to connect the record definition with a particular record in the
flat file. The name of the record definition must match the value obtained by the record
identifier.

To set the record identifier for a definition, if the flat file contains a record identifier, select Yes
in the Record identifier area, and set the record identifier to one of the following values.

DescriptionValueRecord
identifier

Identifies the character position in the record
(counting from zero) where the record identifier

Start at position

is located. Start at position record identifiers
compare the value that occurs in the record, at
the specified offset, to all the record names
defined in the flat file structure. Note that the
Start at position identifier cannot distinguish
between all types of record names.

Note:
For example, if you name records “Rec1” and
“Rec,” some instances of “Rec1” may be
identified as “Rec,” because “Rec1” begins
with “Rec.”

Identifies the field in the record (counting from
zero) that contains the identifier. Nth field

Nth field

identifiers use the value of the specified field as
the record identifier. These identifiers count from
zero (0).

Note:
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DescriptionValueRecord
identifier

For example, if 2 is specified, the third field is
used as the record identifier.

Select No if the flat file does not contain a record identifier.

8. Click Next to define the Flat File Structure. Use the Flat File Structure page to add records
to the flat file structure and define the hierarchical relationships between them.

The application receiving the flat file uses the structure to read the flat file. This structural
information identifies the parent-child relationships between different records in the flat file.
By nesting record elements in the flat file structure (adding record elements to a record), you
can represent the hierarchical structure of the data in the flat file.

To add the first record, click the Add new element icon and in the Element type field, select
Record Definition. Specify a name for the record definition and click Finish.

9. To add aComposite Definition after you have added a record definition, specify the following:

DescriptionExtractor type

Field number in the record that contains the composite
you want to extract. This pulls the subfield data from the

Nth field

composite. If you leave this property empty, the composite
will not be extracted.

To add a Field Definition after you have added a record definition, specify the following:

DescriptionExtractor type

Counting from zero (0), indicates a fixed number of bytes to
be extracted from a record.

Fixed Position

Type the first byte to extract from the
record. Type the first byte that is not

Position

included in the extraction. If you enter
a negative number (for example, –1), the
extractor returns all bytes from the byte
specified in Start to the last byte in the
record or composite.

Counting from zero (0), indicates the field that you want to
extract from the record.

Nth field

Extractor
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DescriptionExtractor type

Type a value to indicate the position of the field that you want
to extract from the record. This value cannot be null and must
be an integer greater than or equal to zero (0).

Note:
For example, if you type 1, the second fieldwill be extracted.

This option is available only if you specified a field delimiter
when configuring the definition and structure of the Flat File
Application. This extractor returns the field as a key–value pair.
The key is the name of the field. The value is the String value
of the field.

10. Click Finish to create the flat file Application.

After creating the flat file Application, create an Orchestrated Integration, select the Flat File
Application created, and invoke the following predefined operations:

“convertFlatFileToDocument” on page 355 - Converts the flat file to a document (inbound)

“convertDocumentToFlatFile” on page 357 - Converts a document to a flat file (outbound)

Creating a flat file Application from a sample file
When you create a flat file Application from a sample file, ensure that the format of the sample
file is *.txt.

To create a flat file Application from a sample file

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Flat File
Applications > Add New Application.

2. Type a name and description of the flat file Application and select the creationmode asCreate
from a sample file.

3. Click Browse and select the sample file from your computer. The Preview pane displays the
sample file.

4. Click Next and in the Record Parser panel, select one of the following to indicate how the
data in the sample file is formatted:

DescriptionRecord Parser

Use this parser when each record is separated by a delimiter.Delimiter
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DescriptionRecord Parser

Use a fixed length record parser when each record is of a fixed
length (for example, mainframe punch or print records). This
parser splits a file into records of the same pre-specified length.

Fixed length

This parser expects each record to be preceded by two bytes
that indicate the length of the record. Each record may be of
different length.

Variable length

If you selectDelimiter as the parser type, specify the parser properties in the record parser
panel. Integration Cloud updates the Preview contents based on your selections. Use the
following table to specify the delimiters used in the sample file.

DescriptionProperty

Character that separates records in a flat file document.Record

Note:
If a new line character (\n) exists at the end of each record
and the Record delimiter is not ending with \n, then
Integration Cloud cannot render the records properly
under the Preview pane.

Character that separates fields in a flat file document.Field or composite

Character that separates subfields in a flat file document.Subfield

Character used to enable a section of text within a field to
be represented as its literal value. Any delimiter characters

Quoted release character

that appear within this section will not be treated as
delimiters.

Note:
For example, your field delimiter is (,) and your quoted
release character is “. When you want to use (,) within a
field as text, you must prefix it with your quoted release
character. When using the convertFlatFileToDocument
operation to create the strings Doe, John and Doe, Jane,
the record would appear as “Doe, John”,“Doe, Jane”.
Whenusing the convertDocumentToFlatFile operation to create
“Doe, John”,“Doe, Jane”, the value of the record would
be Doe, John and Doe, Jane. When using the
convertDocumentToFlatFile operation, if you have specified
both the Release Character and the Quoted Release
Character, the Quoted Release Character will be used.
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DescriptionProperty

Character used to enable a delimiter to be used for its
intended, original meaning. The character following the
release character will not be treated as a delimiter.

Release character

Note:
For example, your field delimiter is + and your release
character is \. When using + within a field as text, you
must prefix it with your release character. When using
the convertFlatFileToDocument operation to create the strings
a+b+c and d+e+f, the record would appear as
a\+b\+c+d\+e\+f.Whenusing the convertDocumentToFlatFile
operation to create a\+b\+c+d\+e\+f, the value of the
record would be a+b+c and d+e+f.

If you select Fixed length as the parser type, specify the parser properties in the record
parser panel. Integration Cloud updates the Preview contents based on your selections.
Specify the position of each field in Field separators. The Field separatorsmust be
comma separated integer values, for example, 5, 10, 15. You can set a value for Record
length to adjust the record so that it appears correctly under the Preview pane. Record
length supports only positive integer values between one and total number of characters
in the file. and cannot be empty.

If you selected Variable length as the parser type, specify the parser properties in the
Record Parser panel. Integration Cloud updates the Preview contents based on your
selections. Use the following table to specify the delimiters used in the sample file.

DescriptionProperty

Character that separates fields in a flat file document.Field

Character that separates subfields in a flat file document.Subfield

Character used to enable a section of text within a field to be
represented as its literal value. Any delimiter characters that
appear within this section will not be treated as delimiters.

Quoted release character

For example, your field delimiter is (,) and your quoted release
character is “. When you want to use (,) within a field as text,
you must prefix it with your quoted release character. When
using the convertToValues service to create the strings Doe, John
and Doe, Jane, the recordwould appear as “Doe, John”,“Doe,
Jane”. When using the convertToString service to create “Doe,
John”,“Doe, Jane”, the value of the recordwould be Doe, John
and Doe, Jane. When using the convertToString service, if you
have specified both the Release Character and the Quoted
Release Character, the Quoted Release Character will be used.
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DescriptionProperty

Character used to enable a delimiter to be used for its intended,
originalmeaning. The character following the release character

Release character

will not be treated as a delimiter. For example, your field
delimiter is + and your release character is \. When using +
within a field as text, you must prefix it with your release
character. When using the convertToValues service to create the
strings a+b+c and d+e+f, the record would appear as
a\+b\+c+d\+e\+f. When using the convertToString service to
create a\+b\+c+d\+e\+f, the value of the record would be
a+b+c and d+e+f.

5. Specifying a Record Identifier

When parsing a file, Integration Cloud looks at a record and extracts an identifier out of the
data and uses that identifier to connect the record definition with a particular record in the
flat file. The name of the record definition must match the value obtained by the record
identifier.

To set the record identifier for a definition, if the flat file contains a record identifier, select Yes
in the Record identifier area, and then set the record identifier to one of the following values.

DescriptionValueRecord
identifier

Identifies the character position in the record
(counting from zero) where the record identifier

Start at position

is located. Start at position record identifiers
compare the value that occurs in the record, at
the specified offset, to all the record names
defined in the flat file structure. Note that the
Start at position identifier cannot distinguish
between all types of record names.

Note:
For example, if you name records “Rec1” and
“Rec,” some instances of “Rec1” may be
identified as “Rec,” because “Rec1” begins
with “Rec.”

Identifies the field in the record (counting from
zero) that contains the identifier. Nth field

Nth field

identifiers use the value of the specified field as
the record identifier. These identifiers count from
zero (0).

Note:
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DescriptionValueRecord
identifier

For example, if 2 is specified, the third field is
used as the record identifier.

Select No if the flat file does not contain a record identifier.

6. Click Next to view the Flat File Structure. You can add records to the flat file structure and
define the hierarchical relationships between them. The application receiving the flat file uses
the structure to read the flat file. This structural information identifies the parent-child
relationships between different records in the flat file. By nesting record elements in the flat
file structure (adding record elements to a record), you can represent the hierarchical structure
of the data in the flat file. To add a record, click the Add new element icon and select Record
Definition from the Element type field. Specify a name for the record definition and click
Finish.

7. To add a Composite Definition after you have added a record definition, click the Add new
element icon and select Composite Definition from the Element type field. Specify a name
for the record definition and click Finish.

DescriptionExtractor type

Field number in the record that contains the composite
you want to extract. This pulls the subfield data from the

Nth field-Extractor

composite. If you leave this property empty, the composite
will not be extracted.

To add a Field Definition after you have added a record definition, click theAdd new element
icon and select Field Definition in the Element type field.

DescriptionExtractor Type

Counting from zero (0), indicates a fixed number of bytes
to be extracted from a record.

Fixed Position

DescriptionExtractor

Type the first byte to extract from
the record. Type the first byte that is

Position

not included in the extraction. If you
enter a negative number (for
example, –1), the extractor returns
all bytes from the byte specified in
Start to the last byte in the record or
composite.
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DescriptionExtractor Type

Counting from zero (0), indicates the field that you want to
extract from the record.

Nth Field

Type a value to indicate the position
of the field that you want to extract

Extractor

from the record. This value cannot
be null and must be an integer
greater than or equal to zero (0).

Note:
For example, if you type 1, the
second field will be extracted.

This option is available only if you
specified a field delimiter when
configuring the definition and
structure of the flat file Application.
This extractor returns the field as a
key–value pair. The key is the name
of the field. The value is the String
value of the field.

8. Click Finish to create the flat file Application.

After creating the flat file Application, create an Orchestrated Integration, select the flat file
Application created, and invoke the following predefined operations:

“convertFlatFileToDocument” on page 355 - Converts the flat file to a document (inbound)

“convertDocumentToFlatFile” on page 357 - Converts a document to a flat file (outbound)

Flat File Predefined Operations
The following predefined Flat File operations are available:

convertFlatFileToDocument

Converts a flattened flat file data into a structured data, which will conform to the document type
associated with the flat file Application.

Input Variables

String The flat file input with type of String.ffDataString

Object The flat file input with type of InputStream or ByteArray. If both ffData
and ffDataString are parsed, ffDataString takes precedence.

ffData
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Object Optional. An object that encapsulates and keeps track of the input data
during processing. It is used only when the iterate variable has been set to true.

ffIterator

StringOptional. The encoding of the InputStreampassed in to ffData. The default
encoding is UTF–8.

encoding

Document Optional. A document object that contains the segment terminator
and the field and subfield separators. If the delimiter is null, it will be located

delimiters

using the information defined in the definition and structure of the Flat File
Application. To specify a delimiter, you can specify:

One character or character representation (for example, *, \n for line
terminator, \t for tab)

The space character

DescriptionVariable

String Character used to separate records. If you want to specify
the two–character carriage return line feed (CRLF) characters,
specify \r\n.

record

String Character used to separate fields.field

String Character used to separate subfields.subfield

String Character used to ignore a record, field, or subfield delimiter
in a field. If a release character occurs in a field or subfield before
the delimiter, it will be prefixed with the release.

release

StringCharacter to use to ignore a record, field, or subfield delimiter
in a field. If a quoted release character occurs in a field or subfield

quotedRelease

before the delimiter, it will be prefixed with quotedRelease before
beingwritten to the output string. The string is pre- and appended
with the quoted release character.

For example, if * is a delimiter, the field value is a*b, and the quoted
release character is “, the string appears as “a*b”.

String Optional. Whether you want to process the input all at one time.iterate

String Optional. Whether to create the document object if all the fields are null.createIfNull

StringOptional.Whetherwhite space at the beginning of recordswill be ignored.skipWhiteSpace

String Optional. Whether to return the parsed data.keepResults

StringOptional.Whether to return errormessages that describe how ffDatadiffers
from the definition and structure of the Flat File Application.

validate

String Optional. Whether to return the validation errors.returnErrors

String Optional. The maximum number of errors that can be returned from one
record. When the flat file parser encounters more than the maximum number of

maxErrors
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errors within a record, the parser will stop parsing and return the parsed data
and errors processed up until that point.

StringOptional. Flags that you can set to govern convertFlatFileToDocument options.flags

DescriptionVariable

StringWhether you want the operation to add an additional field
(@record–count) to each parsed record in the resulting document
object.

addRecordCount

StringWhether you want detailed conditional validation error
information.

detailedErrors

StringWhether you want the operation to wait until it finds the
first valid record before reporting invalid records as errors.

skipToFirstRecord

StringWhether youwant the operation to delete any blank spaces
at the beginning of fields, at the end of fields, or both.

trimWhitespace

StringWhether you want the operation to return the document
object that represents the input flat file data as a document reference
that can be mapped to the document types generated.

resultAsArray

Output Variables

Document The name of the output document will be
flatfile_application_name_dt, where flatfile_application_name is the name

<flatfile_application_name>_dt

of the flat file Application. For example, if the Application name is
test, then the name of the output document will be test_dt. The
structure of the output document will be similar to what you have
defined in your Flat File Application.

StringWhether flat file contains validation errors.isValid

String Optional. An array containing the validation errors, if any,
that were found in ffData or ffDataString.

errors

convertDocumentToFlatFile

Converts a structured data conforming to the given document type structure associated with the
Application, to the flattened flat file data.

Input Variables

Document Structure conforming to theDocument type created
for the corresponding application of this operation.

<flatfile_application_name>_dt
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String Optional. How to position the records in the flat file.spacePad

StringWhether to create errors in the output.signalError

StringWhether trailing empty fields are to be removed from
the output. Used onlywith records that have delimited fields.

noEmptyTrailing Fields

StringWhether trailing empty subfields are to be removed
from the output. Used only with records that have delimited
fields.

noEmptyTrailing SubFields

If no value is specified for the noEmptyTrailingSubFields
parameter, Integration Cloud uses the value set for the
noEmptyTrailingFields parameter.

Document Optional. The separator characters used to
construct the output string. To specify a delimiter, you can
specify:

delimiters

One character or character representation (for example, *,
\n for line terminator, \t for tab)

DescriptionValue

String Character to use to separate
records. If you want to specify the

record

two–character carriage return line feed
(CRLF) characters, specify \r\n.

StringCharacter to use to separate fields.field

String Character to use to separate
subfields.

subfield

StringCharacter to use to ignore a record,
field, or subfield delimiter in a field. If a

release

release character occurs in a field or
subfield before the delimiter, it will be
prefixedwith release before beingwritten
to the output string.

StringCharacter to use to ignore a record,
field, or subfield delimiter in a field. If a

quotedRelease

quoted release character occurs in a field
or subfield before the delimiter, it will be
prefixed with quotedRelease before being
written to the output string. The string is
pre- and appended with the quoted
release character.
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For example, if * is a delimiter, the field
value is a*b, and the quoted release
character is “, the string appears as “a*b”.

Document Any values mapped to the
FormatInfo variable will be passed

FormatInfo

unmodified to all format operations
invoked by convertDocumentToFlatFile and
convertFlatFileToDocument.

String Optional. If you want the output returned in a file
instead of in the string output variable, provide the name of
the file you want created as a result of this operation.

outputFileName

String The type of encoding used to write data to the output
file. The default encoding is UTF–8.

Encoding

String Optional. Whether you want the operation to sort the
input records to match the definition and structure of the Flat
File Application.

sortInput

Returns the document as a string or as a byte array instead of
a string.

returnAsBytes

Output Variables

String Data that represents the flat file document.string

Object If the input variable returnAsBytes is true, returns the output as
a byte array encoded using the specified encoding. The string value is
not returned.

bytes

Object String array containing messages pertaining to errors that
occurred during conversion.

errorArray

Usage Note

When the convertDocumentToFlatFile operation executes, the field that is defined to start after the end
of the fixed length record will not be included in the output data if the following conditions are
met:

The definition and structure of the Flat File Application uses a fixed length record delimiter.

The definition and structure of the Flat File Application contains a fixed position field that
begins beyond the defined length of the fixed length record.

The input to the convertDocumentToFlatFile operation contains a value for the fixed position field
that begins beyond the defined length of the fixed length record.
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Accounts

This screen lists all the available Accounts created for an Application.

If you select an Account for an FTP, SFTP, custom SOAP, or on-premises Application and click
Test Connection, the screen displays the status of the connection. If you have configured the
Account details incorrectly in any stage, the status appears in red color in theConnectivity Status
column. If an Account is configured correctly in a particular stage, the status appears in green
color and if an Account is not configured in a particular stage, the status appears in white color.

For on-premise Applications, the Account can be used to execute services on the on-premises
webMethods Integration Server. See the Configuring On-Premise Integration Servers for webMethods
Cloud document for information on how to configure webMethods Integration Server as an
on-premise server for use with Integration Cloud.

Note:
Only enabled or active Accounts are listed in the drop down list of the Operation wizard,
Integration wizard, Look up Transformer, and Manage Stages page.

You can create, edit, or delete an Account for a particular application from this screen.

Note:
Users who have the required permissions under Settings  > Project Permissions can create,
update, or delete the Accounts information.

To create or edit an Account

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Applications
> <Application category>.

2. Select an Application from the Application category page and then click Accounts.

To use an Application, you are required to agree to the summary of terms. Click I agree to
use the Application. Click I do not agree if you disagree with the summary of terms and do
not want to use the Application. Click Cancel to go back to the Applications page.

3. From the Accounts screen, click Add New Account to add an Account or click Edit to update
an existing Account.

Adding or Editing Accounts

Use theAccounts page to add, edit, or delete Accounts. The options available may vary according
to the selected Application.

Note:
See the “Predefined Applications” on page 109 section for information on the Account
configuration fields for each Application.
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To add or edit an Account

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Applications
> <Application category>.

2. Select an Application from the page, and then click Accounts.

To use an Application, you are required to agree to the summary of terms. Click I agree to
use the Application. Click I do not agree if you disagree with the summary of terms and do
not want to use the Application. Click Cancel to go back to the Applications page.

3. From the Accounts page, click Add New Account to add an Account or click Edit to change
any field in an existing Account.

4. On the New Account or Edit Account page, complete the following fields. Required fields
are marked with an asterisk on the page.

Note:
Based on the Application you had selected, applicable fields are displayed.

DescriptionField

Provide a valid name for the Account. This field is
common for all Applications. Names can contain

Save As

alphanumeric characters, underscores (_), and hyphens
(-). The name must not be null and cannot be an empty
string.

Provide a description for the Account. This field is
common for all Applications.

Description

Every back end provides its own authentication
mechanism.Here you can select different authentication

Authentication Type

schemes for the sameApplication.Get the authentication
details from the back end documentation for the
Application and select the supported Authentication
Type from the drop-down list. The Account
Configuration Fieldsmay vary according to the selected
authentication type.

Note:
The Authentication Type field may not be available
for all Applications.

Credentials: Basic authentication credentials.

OAuth V2.0 (Authorization Code Flow): Authorization
by OAuth v2.0.
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DescriptionField

OAuth V2.0 (JWT Flow): Authorization by a signed
JWT.

Note:
While editing anAccount in any stage, you can select
a differentAuthentication Typewithout impacting any
integrations. So if an Integration is using an Account
with a specified Authentication Type, the integration
will run with the changed Account configuration.
Further, while editing or creating an Integration, after
you select the Operation, the Account field will list
all the Accounts that are supported for the execution
of the selected Operation.

The Account Configuration Fields section allows you
to provide details to connect with the Application. The
fields available may vary according to the selected
Application. See the “Predefined Applications” on
page 109 section for information on the Account
configuration fields for each predefined Application.

Note:
Click “here” on page 364 for answers to some of the
most common questions on Account configuration.

5. Click Save or Update to save your settings.

A new Account will be created.

Troubleshooting tips on Account configurations
Find answers to some of the most common questions on Account configurations.

Connection Reset

I see connection reset errors. What is the root cause of these errors?

The root cause of connection reset errors is stale connections. It is recommended to set the Keep
Alive Interval to two minutes.

Time Out Exceptions

I see a transaction has failed with the following exception:
ERROR_INVOKING_CLOUD_SERVICE: An IO or timeout exception is encountered for
invoke “xxx” method. What is the root cause and the resolution?
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The root causemay be linked to stale connections or a low response timeout value. To handle stale
connections, set the Keep Alive Interval to two minutes. To handle receipt of large payloads or a
slownetwork impacting the responsiveness of the back end, increase theResponse Timeout value,
for example, to five minutes or higher.

Session Expired or Invalid Session ID

I am using the Salesforce Credential based account configuration and I see the following
invalid_session_id errors while executing operations. How can I prevent an invalid session
time out?

INVALID_SESSION_ID: Invalid Session ID found "message": "Session expired or invalid", "errorCode":
INVALID_SESSION_ID"

Salesforce operation execution fails sometime with Invalid Session ID found error

Invalid Session ID found in SessionHeader: Illegal Session. Session not found. This error usually occurs
after a session expires or a user logs out. Decoder: DataInDbSessionKeyDecoder

These errors are observed if the client (Integration Cloud Account) and the server (for example,
Salesforce) session time out values are not in sync. Based on the Salesforce back end session timeout
value, set a Session Timeout (min) value in the Integration Cloud Account configuration screen.
This value should be less than the Salesforce back end session timeout value so that the token is
refreshed before Salesforce invalidates it. For corner case scenarios, specify a value that is one
minute less than the Salesforce back end session timeout value. For example, if on the server side
(Salesforce), you have configured the session timeout value to 15 minutes, then on the client side
(Integration Cloud Account), ensure that the session time out value is less than the server
(Salesforce) session time out value, that is 14 minutes.

Disabled Connection Issue

Sometimes integrations start failing and I see the following cloud connection disabled
errors. Why do they appear and what is the resolution?

DISABLED_CLOUD_CONNECTION: Connection xxx is disabled

INVALID_LOGIN: Invalid username, user not active

Connection disabled errors may appear due to the following reasons:

Salesforce back end account password has been changed or has expired.

In this case, check if the password is still valid.

Salesforce login limit is breached.

If 3600 login calls are sent to Salesforce in 15 minutes, then depending on the configured Lockout
effective period in Salesforce, the integration fails, and theDISABLED_CLOUD_CONNECTION:
Connection xxxmessage appears. For example, If 3600 login calls are sent to Salesforce in 15 mins,
and you have set the Lockout effective period to 60 minutes, then from the 16th minute till the
60th minute, all integrations will fail.
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Usually credentials based connections get disabled once the Salesforce login limit is breached. You
may have reached the login limit quota for the back end.

How to minimize your login calls to Salesforce

Salesforce allows 3600 logins per hour. In Integration Cloud, select  Enable Connection Pooling
to enable the connection pooling option. Also adjust the Minimum Pool Size, Maximum Pool
Size, and the Expire Timeout (msec) values. Expire Timeout will ensure that a connection in the
Integration Cloud Account pool is kept alive for the configured time interval after the Account is
created. In the absence of the Expire Timeout configuration, the connection will be invalidated
immediately to maintain the Minimum Pool Size as one. The intention is to limit the number of
login requests, so the recommendation is to keep the Expire Timeout value equal to the Session
Timeout value, because the connection is anyways invalidated after Session Timeout. For example,
if the session timeout in Salesforce back end is configured to two hours, specify the Expire Timeout
and the Session Timeout values in the Integration Cloud Account Configuration screen to be
slightly less than two hours.

ValueAccount Configuration Fields

Slightly less than the Salesforce back end session timeout
settings. For example, 119 minutes, if the Salesforce back
end session timeout value is 120 minutes.

Session Timeout

Two minutes.Keep Alive Interval

Five minutes.Response Timeout

Do the following if your Salesforce login limit is breached

If your Salesforce logins have exceeded 3600 logins/hour, then your Salesforce account gets disabled.
This is usually observed in the case of credentials-based authentication connection with the back
end. In this scenario, login to your Salesforce back end account, go to Setup > Manage User >
Users, select the User profile, go to the Password Policies section, and check the time configured
for the Lockout effective period field. The Lockout effective period is the time for which the
Salesforce back end account will be locked once the login limit is breached. You can either wait
till the time specified in the Lockout effective period field has passed or you can configure a
different lockout value as per your need.

Why do I see the UNABLE_TO_RETRIEVE_CONNECTION_FROM_POOL error while
enabling Accounts or executing Operations?

Increase the Maximum Pool Size or the Block Timeout values. Regarding the maximum pool
size, when the connection pool has reached its maximum number of connections, the connector
will reuse any inactive connections in the pool, or if all connections are active, it will wait for a
connection to become available. Increasing the Block Timeout value increases the time Integration
Cloudwill wait to obtain a connectionwith the SaaS provider before the connection times out and
returns an error. For example, if you have a pool withMaximum Pool Size of 20 and if you receive
30 simultaneous requests for a connection, 10 requests will be waiting for a connection from the
pool. Now if you set the Block Timeout to 5000 msec, the 10 requests will wait for a connection
for 5000 msec or 5 seconds before they time out and return an error. If the services using the
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connections require 10 seconds to complete and return connections to the pool, the pending requests
will fail and return an error message stating that no connections are available.

I see integrations failing with the DISABLED_CLOUD_CONNECTION: Connection xxx
error but the Account shows enabled in the User Interface.

Do the following to resolve this issue:

1. Go to the stage where the Account is found disabled.

2. On the Projects page, select the Default project.

3. Edit any asset in the same stage. For example, click the Reference Data tab, select a reference
data, update the reference data description, and then save the reference data.

4. Wait for a minute. This will trigger an update andwill resolve the disabled Account issue. The
integration will now run successfully.

Operations

Integration Cloud provides pre-configured applications. The Applications contain SaaS
provider-specific information that enables you to connect to a particular SaaS provider. Further,
each Application uses an Account to connect to the provider's back end and perform Operations.

Note:
Users who have the required permissions under Settings  > Project Permissions can create,
update, or delete Operations.

Each application comes with a predefined set of Operations. You can also create your own custom
Operations and also edit/delete those customOperations. This page lists all the availableOperations
for a selected application including predefined Operations.

See “FTP Predefined Operations” on page 195 for information on the FTP operations.

See “SFTP Predefined Operations” on page 254 for information on the SFTP operations.

See “AS2 Predefined Operations” on page 113 for information on the Applicability Statement 2
(AS2) operations.

See “Database Application Operations” on page 151 for information on the Database operations.

See “Cloud Deployment Operations” on page 136 for information on how to import Cloud
Deployment services.

To create or edit a custom Operation

1. From the IntegrationCloudnavigation bar, clickProjects > <Select a Project> > Applications.

2. Select an Application category and then click Operations.
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To use an Application, you are required to agree to the summary of terms. Click I agree to
use the Application. Click I do not agree if you disagree with the summary of terms and do
not want to use the Application. Click Cancel to go back to the Applications page.

3. From the Operations page for the selected Application, click Add New Operation to create a
new Operation or select an Operation and click Edit to update an existing Operation. You can
clickDelete to delete an existingOperation, click Show Signature to view the input and output
signature of theOperation, or click Test to test theOperation. TheAdd New Operation option
is not available for some Applications. While testing an Operation, you can select another
Account created with a different Authentication Type, if the Account is supported for the
execution of the selected Operation.

Select an Operation and click Show Signature to view the input and output signature of the
operation. The input and output fields cannot be edited. This option is available for all
predefined and customoperations. Click the input and output fields to view the field properties.

From the Input or Output pane, click the icon to copy a field. Depending on the context,
you can either paste the field or the field path.

Click the Test option and in the test dialog box, specify the Account name and the Input data.
If an operation does not have an input signature, the input fields are not displayed. The Test
option is available for all predefined and custom operations.

Click Run to test the Operation and view the test results in the test results window. Click the

icon beside Result if you want to go back to the test dialog box and enter another set of
values. The last 5 test results are also displayed and are applicable only for the same test
operation run, that is, if you close the test results window, you will not be able to view the test
results later. Further, a test result appears in red color if the test run is unsuccessful and appears
in green color for a successful test run.

Adding or Editing Operations

Use the Operations page to add, edit, or delete custom operations.

To add or edit a custom operation

1. From the IntegrationCloudnavigation bar, clickProjects > <Select a Project> > Applications.

2. Select an Application from an Application category and then select Operations.

To use an Application, you are required to agree to the summary of terms. Click I agree to
use the Application. Click I do not agree if you disagree with the summary of terms and do
not want to use the Application. Click Cancel to go back to the Applications page.

3. From the Operations page for the selected Application, click Add New Operation to add a
customoperation or clickEdit to update an existing customoperation. TheAdd New Operation
option is not available for some Applications.
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4. On the Select your <...> account page, complete the following fields. Required fields are
marked with an asterisk on the page.

DescriptionField

Provide a name for the custom operation.Save as

Provide a description for the custom operation.Description

Select an Account created for the Application from the
drop-down list. Only active or enabled Accounts are listed
in the drop-down list.

Select account

Note:
If you select an Account with a different Authentication
Type, existing Integrations that are using this Accountmay
not work.

Select the Application service from the drop-down list.Select functional area

Note:
This option is available only for certain Applications.

For REST Application operations, you can now provide
account configurations at runtime during integration

Enable dynamic account
configuration at runtime

execution. Select theEnable dynamic account configuration
at runtime check box and then clickConfigure Fields to run
the operation by passing authentication details that may be
different from the authentication details configured in the
Account configuration page. Dynamic authentication
overwrites the Account configuration details.

For example, suppose you have configured authentication
details X for Account A. You can use different authentication
details Y to run the service, by overwriting the authentication
details X of Account A.

Note:
Enable dynamic account configuration at runtime is
currently supported only for custom REST Applications.
Further, the option is enabled only after you have selected
an Account in the Select account field.

While creating an operation, if you select theEnable dynamic
account configuration at runtime check box and click
Configure Fields, the Dynamic Account Configuration
Fieldswindow appears. Select the fields youwant to include
in the operation input signature. When you select the fields,
the operation input signature will be automatically updated
based on your selections. Only the fields that are part of the
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DescriptionField

signature getsmapped as the input request. You can override
the field values at run time. Default Account configuration
values will be used for other fields while creating the
operation.

Note:

You cannot clear encrypted fields like Access Token
and Consumer Secret. Further, you cannot enter a
value for encrypted fields. You can enter the values
for encrypted fields onlywhile running the operation.
While running the operation, if you have provided
details in both the Account configuration page and in
the Dynamic Account Configuration Fields dialog
box, Integration Cloud reads the data from the
Account configuration page andmerges the datawith
the data provided in the Dynamic Account
Configuration Fields dialog box. Existing Account
configuration details will not be modified.
Details specified in the Dynamic Account
Configuration Fieldsdialog box take precedence over
the details specified in theAccount configurationpage.
If you pass incorrect values in the Dynamic Account
Configuration Fields dialog box, service execution
will fail while running the operation.

5. Click Next.

The Select the Operation page appears. If you do not want to addHeaders and Parameters,
skip to Step 9.

6. For a REST-based Application, select an operation and click Headers to add input Headers,
if required. Integration Cloud displays the default HTTP transport headers for the operation,
along with their default values. At run time, while processing the headers, Integration Cloud
substitutes the values as necessary. In order to customize the headers, do the following:

a. Click Add Header to add a custom Header. Specify the Header name. To specify an
optional default value for the header variable, click the Default Value box and type or
paste the new value. If the variable is null in the input pipeline, this value will be used at
run time. If the variable already has an existing default value defined, this value will
overwrite the existing value at run time.

b. If headers appear in the signature, select Active to activate the headers in the signature.

c. To delete a custom header that you have added, select the header and click Delete.

Note:
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You cannot delete the required headers.

7. For a REST-based Application, select an operation and click Parameters. To customize the
parameters, do the following:

a. Review the operation parameter details. Integration Cloud displays the parameter Name
and Description, the Data Type used to represent the kind of information the parameter
can hold, the parameterization Type of the request, and the default value needed to access
the operation.

b. To specify a default value for the parameter, click the Default Value box and then type or
paste the default value. The default value is used at run time.

You cannot add or delete request parameters. You can only modify the default value of a
parameter. All parameters appear in the signature.

8. For some Applications and Operations, for example, for the CloudStreams Connector for
Salesforce(R) Bulk v2 Data Loader Application and Create Job and Upload Job Data Operation,
Integration Cloud supports multipart request body. For example, if you want to create a user
as well as upload a photo, the request has to be a multipart request where one part is an image
file while the other part is a JSON request body.

Though application/x-www-form-urlencoded is a more natural way of encoding, it becomes
inefficient for encoding binary data or text containing non-ASCII characters. The media type
multipart/form-data is the preferredmedia type for request payloads that contain files, non-ASCII,
and binary data. Integration Cloud supports this media type using which you can embed
binary data such as files into the request body.

Amultipart/form-data request body contains a series of parts separated by a boundarydelimiter,
constructed using Carriage Return Line Feed (CRLF), "--", and also the value of the boundary
parameters. The boundary delimiter must not appear inside any of the encapsulated parts.

Each part has the Type, Name, Content-Type, and Part ID fields.

Example of a multipart request
--BOUNDARY
Content-Type: application/json
Content-Disposition: form-data; name="job"
{
"object":"Contact",
"contentType":"CSV",
"operation":"insert"

}
--BOUNDARY
Content-Type: text/csv
Content-Disposition: form-data; name="content"; filename="content"
(Content of your CSV file)
--BOUNDARY—

Part Configuration
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ThePart Configurationwindow lists all the configured parts to be sent to the service provider.
To view the Part Configuration window, on the Select the Operation page, select
Attachments.

The configured parts appear in the input signature.

Name - The Name field displays the name of the file part as documented in the SaaS
provider API documentation.

Content Type - The Content Type field displays the content type of the file you are
uploading.

Type -Document - Some back ends expect application/json or application/xml content in
the part body. This represents a part where the content of the part is of type application/json
or application/xml. File - Represents a binary part of amultipart/form-data payloadwhere
the content of the part is binary or the content of the file itself. For file upload kind of use
cases, this part is the main or mandatory part required by the service provider.

9. On the Select the Operation page, select the operation to be performed and then click Next.
Depending on whether the operation is Complex, Simple, or Dynamic, the Business Object
or the Interactions page appears. Examples of Business Objects are Contact, Account, and
so on and examples of Interactions are Create, Update, Upsert, Delete, and so on.

Note:
For some operations, Integration Cloud displays appropriate Business Object pages, for
example, for the createMultiple and updateMultiple operations in the Salesforce v42
Application, or Interactions (sub-operations) pages, for example, for the Batch andChangeSet
operations in the OData 4.0 Application, depending on whether the selected operation
requires metadata, such as a business object, fields, and data types of fields. You can add
or edit multiple business objects in a single request. You can also add or edit interactions
and then associate those interactions with business objects in a single request. Interactions
or multiple business objects will be executed in the same sequence as they appear in the
table. You can drag and drop the interactions or multiple business objects to change the
order in which they will be executed.
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Different pages appear based on the scenarios mentioned in the following Single or Multiple
Interactions with Single or Multiple Business Objects with dependencies section.

Single orMultiple Interactionswith Single orMultiple BusinessObjectswith dependencies

Single operation has a single Business Object - An operation has only a single business
object. The operation has neither multiple interactions nor has records. An example of a
single operation and a single object can be a "create" operation that contains only the
"contact" business object.

Single operation has multiple Business Objects - A single operation hasmultiple business
objects. An example of a single operation with multiple business objects can be a "create"
operation that contains two business objects, "contact" and "account".

Single operation has multiple Business Objects with dependencies - A single operation
has multiple business objects and some of the business objects may have dependencies on
other business objects.

Multiple Interactions have multiple Business Objects -Multiple Interactions havemultiple
business objects. For example, the "create" and "update" Interactions can act on the "account"
and "contact" business objects respectively.

Multiple Interactions have multiple Business Objects with dependencies - Multiple
Interactions have multiple business objects and some of the business objects may have
dependencies on other business objects. For example, the "create" and "update" Interactions
can act on the "account" and "contact" business objects respectively.

Further, for some operations, for example, for theRetrieve ContainedOrDerived Entity operation
in the OData 4.0 Application, Integration Cloud displays nested, hierarchical, or multi-level
business objects if the operation is designed to support nested business objects. You can expand
the nested business objects to display the child-level objects.

10. Select the BusinessObject to be associatedwith the operation you have selected in the previous
step and then click Next. For some operations, you must select the Interaction and then the
Business Object. Business Objects and Interactions appear only for certain Applications and
operations.

11. In the Data Fields page, select the data fields for the Business Object you have chosen in the
previous step and then click Next. Data fields appear only for certain Applications and
operations. Mandatory data fields for the Business Object are selected by default and cannot
be cleared.

Note:
For some operations of certain Applications, for example, Coupa, you can add your own
fields. Such fields are called custom fields. Custom fields are marked by custom on the page.
You can add, edit, or delete only custom fields. Click the icon to add a custom field. The
icon appears only if you are allowed to add customfields for the selected operation. After

you have added a custom field, you can click on the custom field to edit the field properties.

Simple fields appear with a check box while complex fields appear with a check box followed
by an arrow mark. The following states are observed for complex fields:
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Unchecked - For unchecked complex fields, only the mandatory child fields are selected
but those fields will not be added to the signature, unless you select the parent field.

Checked - If a complex field is selected by default, then only the mandatory child fields
are selected. You can select the optional fields, if required. If you select a complex field,
then all the child fields are selected.

Note:
For some Applications, for example, Microsoft Dynamics CRM, you can choose the way a
query can be executed in the Confirm operation page. Choose the operation and then click
Finish.

12. In the Confirm Operation page, verify the details. You can click the Data Fields link to view
the data fields you have added. For some operations, you can click the Business Object link to
view the data fields added.

13. Click Finish to create the custom operation.

After you click Finish or Save, if there are any Business Parameters, you will be asked to
configure the Business Parameters.

Listeners

Some IntegrationCloudApplications nowsupport connectivitywith streamingAPIs andprocessing
of streaming API events. You can use Integration Cloud Accounts to connect to streaming APIs.
While creating an Integration Cloud listener, you select a subscription channel from a list of
available channels for an endpoint and select the Integration that will be invokedwhen the events
are received. Additionally, you can configure transport or communication related parameters for
an Integration Cloud listener as well as enable and disable the listener. A listener receives the
streaming API events and processes the received events.

Note:
Currently, only some Integration Cloud Applications support streaming API capability, for
example, the Salesforce CRM version 44 Application. Salesforce trial accounts have restrictions
on the maximum number of concurrent subscribers. See PushTopic Streaming Allocations for
information. So if you create multiple listeners using the same trial account details, due to the
high availability nature of Integration Cloud, some active listeners may not work properly.

Creating and updating listeners

To add a listener

1. From the Integration Cloud navigation bar, click Projects > <Select a Project > Applications
> Predefined Applications.

Note:
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You must have the required project permissions under Settings  > Project Permissions
to create, update, and delete listeners. Further, to create a Listener and also invoke the
associated Integration when events are received, you must have the Listeners Create
permission and the Integration Execute permission.

2. Select a predefined Application and click Listeners.

To use an Application, you are required to agree to the summary of terms. Click I agree to
use the Application. Click I do not agree if you disagree with the summary of terms and do
not want to use the Application. Click Cancel to go back to the Applications page.

The Listeners page appears for the selected Application.

Note:
Listeners option appears only for Applications that have streaming API capability.

3. On the Listeners page, click Add New Listener to add a listener or click Edit to update a
listener.

4. On theConfigure the Listener page, complete the following fields. Required fields aremarked
with an asterisk on the screen.

DescriptionField

Provide a valid name for the listener. Names can contain
alphanumeric characters, underscores (_), and hyphens

Save As

(-). The name must not be null and cannot be an empty
string.

Provide a description for the listener.Description

Specify the endpoint of the streaming provider. When
configuring a Salesforce streaming endpoint, specify

Streaming API Endpoint URL

the URL in the following format:
https://<Salesforce_Instance>/cometd/<Salesforce API
version>

Example: https://ap5.salesforce.com/cometd/44.0

The Integration Cloud listener for Salesforce can
subscribe and listen to Salesforce events. This allows

Select replay option

the Integration Cloud listener to establish a persistent
connection with Salesforce. This connection remains
open while transmitting the events until either side
closes the connection. Through this established
connection, events are streamed to the listener. If the
connection is lost due to a network failure or any other
reason, you can retrieve the standard-volume events
that are within Salesforce's 24-hour retention window.
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DescriptionField

You can retrieve Salesforce events only if you are using
Salesforce v37.0 or later versions.

Each Salesforce event is assigned an opaque ID which
is unique for each event. This ID is contained in the
replayId field of the event object. The replayId field
value which is populated by Salesforce when the event
is delivered to subscribers, refers to the position of the
event in the event stream. For consecutive events,
replayId values may have a break between them, for
example, the event with ID 110 may follow the event
with ID 101.

Example of an event object that Salesforce sends to its
subscribed clients
{

"clientId":"a1ps4wpe52qytvcvbsko09tapc",
"data":{

"event":{

"createdDate":"2016-03-29T19:05:28.334Z",
"replayId":55
},

"payload":"This is a message."
},

"channel":"/u/TestStreaming"
}

To replay events, Salesforce provides away to configure
the replayId while subscribing to a particular channel.
You can replay the events by specifying the replay
option and can use it on a resubscription, to retrieve
events that are within the retention window.

New - Receive new events that are broadcast after
the client subscribes and replay only the new events
from the time the listener is enabled.

All - Receive all events including past events that
are within the retention window including new
events. Replay all the events for the last 24 hours.

Select an account to connect to the Application. The
streaming functionality will leverage the existing

Select account

authentication, timeouts, truststore, keystore, and host
name verification configurations from the referenced
Account selected in the Select account drop-down list
box.
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DescriptionField

Select a channel from the list of available subscription
channels, that is, select the subscriber you want the
listener to connect.

Select subscription

5. Click Next.

The Parameters and Headers page appears.

6. In the Parameters section, Integration Cloud displays the pre-configured parameters for the
selected subscription.

a. Review the details about the parameters. Integration Cloud displays the parameter name
and description, the data type used to represent the kind of information the parameter can
hold, and the parameterization type for the subscription request.

b. To specify the default value for the parameter, select the pre-configured parameter and
click Edit. In the Parameter Properties dialog box, type the default value. For example,
for Salesforce, type the Topic Name. The Active option includes the parameter as part of
the subscription request.

7. In theHeaders section, IntegrationCloud displays the pre-configuredHTTP transport headers
for the selected subscription.

a. To specify a value for a pre-configured header variable, click Edit and then in the Header
Properties dialog box, type the new default value.

b. To add a header, click Add Header. Type a name for the header, select the Active check
box to include the header as part of the subscription request, and provide a default value.

c. To delete a header that you have added, select the header and click Delete.

Note:
You cannot delete required headers.

8. Click Next.

The Event page appears.

9. On the Event page, specify the event action configuration for the listener subscriber. You can
invoke an Integration based on your configuration.

a. In the Integration Name field, select the Integration that will be invoked when the events
are received. In theRun As Userfield, select the IntegrationClouduser youwant Integration
Cloud to use when running the Integration. Integration Cloud runs the Integration as if
the user you specify is the authenticated user that invoked the Integration. If the Integration
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is governed by an Access Control List (ACL), ensure that you specify a user that is allowed
to invoke the Integration.

Note:
You must manually run the Integration before you map that Integration to the listener, else
the listener will not execute the mapped Integration.

10. Click Next, review the Summary details, and then click Finish to create the listener.

The new listener appears on the Listeners page.

11. To enable the new listener, move the slider under the Status column.

The listener will be enabled after a short delay. Once the listener is enabled, connection with
the streamingAPI is established, and incoming eventswill be processedwhenever the streaming
provider triggers the events. As an example, for Salesforce CRM version 44, say you have
created a topic using the following sample query.
Sample Query
PushTopic testCvent = new PushTopic();
testCvent.ApiVersion = 42.0;
testCvent.Name = 'TestContact';
testCvent.Description = 'All records for the Contact object';
testCvent.Query = 'SELECT Id, Email, Phone, FirstName, LastName, Title, Salutation

FROM Contact';
insert testCvent;
System.debug('Created new PushTopic: '+ testCvent.Id);

After that you have subscribed to that topic by creating a listener in Integration Cloud. Now
whenever the Contact object ismodified in Salesforce, the Integration Cloud listener is notified.
To use the streaming data as an input to an Integration, ensure that you create a JSONdocument
type that has the same fields inside sobject as that of the query parameters of the topic.
Sample Document
{

"data":{
"event":{

"createdDate":"",
"replayId":"",
"type":""

},
"sobject":{

"Email":"",
"Phone":"",
"FirstName":"",
"Title":"",
"LastName":"",
"Id":"",
"Salutation":"",

}
},
"channel":"/topic/TestContact2"

}
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Note:
If a listener L1 is using an Integration IN1 and if IN1 uses an Operation OP1 which triggers
L1 through a Salesforce Topic, then whenever OP1 is run, L1 will be triggered. L1 will again
execute IN1 and IN1 will again execute OP1, thereby creating Integration execution loops.
Therefore ensure that loops are not created in an Integration, which is mapped to a listener.
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Overview

An integration is an orchestration of a source and a target Operation with appropriate data
mappings and transformations.

Note:
Users who have the required project permissions under Settings  > Project Permissions can
create, update, delete, and execute integrations.

Integrations page

The Integrations page lists Point to Point and Orchestrated integrations created for cloud-based
SaaS applicationswith other cloud-based applications and also SaaS applicationswith on-premises
applications.

The Name column in the Integrations page displays the name of the integration. You can select
an integration and click the integration name link under theName column tomodify the integration.
The integrations list page by default shows a basic view of all the integrations. Click Show
Advanced View to view the Uses column, which displays the references that are used or utilized
to create the integration in the format project name/referenced asset name. The Invocation column
also appears once you clickShow Advanced View. It shows the invocation channel used (Scheduler,
User Interface, HTTP Interface, REST APIs, SOAP APIs, and Listeners) to invoke the integration.
Click the icon to view the scheduled status, scheduled type, andwhen is the integration execution
next scheduled. To view the last five execution results for an integration, select an integration,
click the icon, and select Last 5 Execution Results tab in the integration details page. You can

also point to the icon to view the request URL and click the icon to delete or copy an
integration.

Create, Modify, Delete, and Copy Integrations

To create an integration:

On the Integrations page, click Add New Integration.

To create a Point to Point integration, select Synchronize two applications. To create an
Orchestrated integration, select Orchestrate two or more applications.

To modify an integration:
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Select the integration you want to modify.

Click the integration name link under the Name column to modify the integration. The
integration opens up for editing in the workspace. You can also edit the integration from the
integration details page. To do that, click the icon, and select Edit on the Overview page.

To delete an integration:

Select the integration you want to delete.

Click on the ellipsis icon and select Delete. The integration is permanently deleted and you
cannot recover it. You can also delete the integration from the integration details page. To do
that, click the icon, and select Delete on the Overview page.

To copy an integration:

Select the integration you want to copy.

Click on the ellipsis icon and select Copy. You can make a copy of the integration within
the same project or in another project.

In the Select Project field, the currently open project is set as the default option. To copy to
another project, select the project from the drop-down list as shown in the following example:

Provide a different name in the Copy As field

ClickCopy. The system creates a copy of this integrationwith the newname in the integrations
page of the target project.

Note:
You must create the account or reference data associated with this integration in the target
project. Further, you can copy a block from an integration and paste that block in another
integration across projects.

Export and Import integrations

To export an integration, select the integration, and then click Export. See “ Export Integrations” on
page 420 for more information.

Note:
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Userswho have the required permissions under Settings  > Access Profiles > Administrative
Permissions > Functional Controls > Assets can deploy and export assets.

To import integrations, select the integration, and then click Import Integrations. See “ Import
Integrations” on page 421 for more information.

Note:
If assets used by an integration are deleted, you will not be able to deploy the integration into
subsequent stages or export the integration. See “Deploy Assets” on page 696 for information
on how to deploy assets.

Point-to-Point Integrations

Integration Cloud enables you to integrate your cloud-based Software as a Service (SaaS)
applications with other cloud-based SaaS applications. It also integrates your SaaS applications
with on-premises applications.

Integration between two cloud providers includes the following steps:

Invoking a source Operation on an application, which fetches data from it

Invoking a target Operation on an application, which uploads data into it

Filtering the data fetched from an application, before it is passed on to the target application

Mapping the data fetched from an application, to the structure needed by the target application
to which you want to upload the data.

To add or edit an existing Point-to-Point Integration

1. From the Integration Cloud navigation bar, click Projects. The Projects screen appears.

2. Select a project in which you want to create the Integration. You can also create a new project.
See “Projects” on page 94 for more information.

3. To edit an existing Integration, select an Integration from the Integrations screen and click
Edit.

4. To create a new point-to-point Integration, from the Integrations screen, click Add New
Integration, select Synchronize two applications, and click OK. See “Orchestrated
Integrations” on page 387 for information on how to create an orchestrated Integration.
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5. Provide a name anddescription of your Integration. Required fields aremarkedwith an asterisk
on the screen.

6. Drag and drop your applications to the Source and Target sections. You can also double-click
an Application to move it to the required section. To use an Application, you are required to
agree to the summary of terms. Click I agree to use the Application. Click I do not agree if
you disagree with the summary of terms and do not want to use the Application. ClickCancel
to go back to the Applications page.

7. Select an Account, and then select a custom or a predefined Operation in both the Source and
Target sections. Only active or enabled Accounts are listed in the drop down list.

Note:
If you had already done the mapping for a source and target Operation, and you want to
change any of the source and target Operations, all themappings you had performed before
will be removed.

8. Click Next to filter the data fetched by the application selected in the source section, before it
is passed on to the application selected in the target section. Click Load Data to preview the
data as well as view the data filters. The source Operation fetches the data and displays a
sample of the data in the preview pane. Out of all the records fetched, youmaywant to upload
only selected records. To do this, you can have a selection or a filter criteria so that you can
view only a few records. A sample preview of only a few records can be viewed to analyze
the kind of data that exists in the system. After you analyze the records, you can set filters, to
upload, for example only Accounts that are based out of California to the target application.
After you set the filters, whenever you run the Integration, all records will be fetched from the
source application, but only the filtered records will be moved to the target application after
mapping and transformation.

9. Click Next to map the data fetched by the application selected in the source section, to the
structure needed by the application selected in the target section.
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Select a field from the source section and drag and drop it on to a relevant field in the target
section. Select a mapping and then click theUnmap icon to unmap only the selectedmapping.
Click the Clear All icon to unmap all the mapped elements, values set for fields, and
transformers. To view only the mapped fields, select the Show Only Mapped Fields option.

You can select a field in the target Operation table, and then choose to set a new value of the
selected field in the target Operation. You can assign a value to a field when the field is not
linked or when the field is only implicitly linked to another value in the pipeline. You cannot
assign values to fields that are explicitly linked to another value in the pipeline or fields that
have been dropped from the pipeline.

You can copy a field from the fields panel by clicking the icon. Depending on the context,
you can either paste the field or the field path. For example, if you copy a field and paste the
field in the Set Value window in an Integration (double-click a field to set a value), the field
path will be pasted. If you copy an array item, the path that is pasted includes the item index.
For example, if the item that is copied is A/B/C[10], then the pasted path will also include the
item index [10]. But if it is pasted in the document tree, it will appear as an array, like A[ ]. If
there are multiple fields with the same name in a document, and one of the occurrences of
such a field is copied, then the pathwhenpastedwill contain the occurrence number in brackets,
for example, the pathwill be A/B/C(5) if the copied element C is the 5th occurrence under field
B.

Note:
The paste option is not applicable for Point-to-Point Integrations.

Click the Add Transformer icon to add a transformer in the Transform Data page. This page
allows you to transform the source Operation data, for example, concatenate two strings and
map it to a single field. Severalbuilt-in services specifically designed to translate values between
formats are provided. You can transform time and date information fromone format to another,
perform simple arithmetic calculations (add, subtract, multiply, and divide) on integers and
decimals contained in String fields, or transform String values in variousways. ReferenceData
is also available while transforming the data.

The Transform Data screen also allows you to look up and use data from another source

Operation to transform the data. After adding a transformer, you can click the icon and
select Edit Transformer or Delete Transformer to either modify the transformer or delete it.

10. Click Next to review your Integration.

11. Click Save and then click Finish to create your Integration.

The new Integration appears in the Integrations page.
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Orchestrated Integrations

Orchestrated Integration is the process of integrating two ormore applications together, to automate
a process, or synchronize data in real-time. Orchestrated Integration enables you to integrate
applications and provides a way to manage and monitor your integrations.

Integration Cloud supports advanced integration scenarios involving multiple application
endpoints, complex routing, and Integrations involving multiple steps. Using a graphical drag
and drop tool, you can create complex, orchestrated integrations and run them in the Integration
Cloud environment.

To create an orchestrated integration

1. From the Integration Cloud navigation bar, click Projects. The Projects screen appears.

2. Select a project in which you want to create the Integration. You can also create a new project.
See “Projects” on page 94 for more information.

3. To create a new Integration, from the Integrations screen, click Add New Integration.

4. Select Orchestrate two or more applications, and then click OK.

The user interface consists of a tool bar and a workspace. The tool bar holds all the available
categories with blocks. You can browse through the menu of blocks and can set up your own
Integration by plugging blocks together in the workspace. The menu of blocks comes with a
large number of predefined blocks from Applications, Services, Integrations, conditions to
looping structures. You can drag relevant blocks from the tool bar and drop them at the anchor
point.

Note:
Click the Show Keyboard Shortcuts icon available above the integration workspace area to
view the available shortcut keys.
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The tool bar has a large number of blocks for common instructions and the blocks are divided
into the following categories:

Applications

Predefined Applications

REST Applications

SOAP Applications

On-Premises Applications

Flat File Applications

Integrations

Services

Control Flow

Expressions

Note:
You can copy a block from an integration and paste that block in another integration across
projects.

DescriptionIconsBlock category

Displays the Application categories available in
Integration Cloud.

Applications

Use the Service blocks (date, math, string, and so on) to
specify the service that will be invoked at run time.

Services
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DescriptionIconsBlock category

Related services are grouped in blocks. You can sequence
services and manage the flow of data among them.

Note:
For information on the different services, see Built-In
Services.

TheReference Data block appears only if a Reference
Data service is available at the Projects > <Select a
Project> > Reference Data page. See Add Reference
Data for more information.

Displays the list of Integrations created in Integration
Cloud. You can invoke an Integration from another

Integrations

Integration. When copying integrations from one stage
to another, all the referred Integrations and their
dependents will also be copied.

The Integrations category also lists all the shared projects
and the integrations available in the shared projects.
Integrations available in the same project are also listed.
The display format for a shared asset is <project name>

<integration name> , where A is the name
of the project and testA is the name of the integration in
the project A. See “Sharing Assets across Projects” on
page 98 for more information.

Click the icon if you want to view or modify an
Integration after it is dropped at the anchor point. The
Integration will open up for editing in a new tab.

Click the icon and select Modify Mapping if you
want tomap the input of the operation from the Pipeline
and also map the output of the operation into the
pipeline.

Right-click on a block to add Comments for the block.
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DescriptionIconsBlock category

Click Duplicate to repeat the block, click Delete to
remove the block from theworkspace, clickCopy to copy
the block from theworkspace, or clickDisable to disable
a block. If you disable blocks, those blocks will not be
considered for execution, test, or debug operations. Click
the Show Inline Comments option available at the
top-right corner of the workspace to view the comments
entered for the block.

Conditional expressions, looping structures, and
transform pipeline.

Control Flow

Conditional expressions performdifferent computations
or actions depending on whether a specified boolean
condition evaluates to true or false.The if block is used
to evaluate a boolean condition and if the condition is
true, statements inside the if block are executed. The if
statement can be followed by an optional else statement,
which executes when the boolean expression is false.

The if statements are executed from the top towards the
bottom. You can use one if or else if statement inside
another if or else if statement(s). You cannot have
multiple else statements.

Switch allows a variable to be tested for equality against
a list of values. Each value is called a case, and the
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DescriptionIconsBlock category

variable being switched on is checked for each case, that
is, Switch evaluates a variable and skips to the value that
matches the case. For example, if the Switch variable
evaluates as "A", then case "A" is executed. A switch
statement can have an optional default case, whichmust
appear at the end of the switch. The default case can be
used for performing a task when none of the cases are
true. You cannot insert multiple default statements.

Note:
You can include case steps that match null or empty
switch values. A switch value is considered to be null
if the variable does not exist in the pipeline or is
explicitly set to null. A switch value is considered to
be an empty string if the variable exists in the pipeline
but its value is a zero length string.

Note:
Switch executes the first case that matches the value,
and exits the block.

The try catch block is used to handle errors and
exceptions. If you have a statement in the try block that
has thrown an error, the error will be caught in the catch
statement.

Note:
If an error is thrown inside the catch section of the try
catch block, the error will be ignored and the next
statements in the Integration will be executed.

Loops execute a set of steps multiple times based on the
block you have chosen. It repeats a sequence of child
steps once for each element in an array that you specify.
For example, if your pipeline contains an array of
purchase-order line items, you could use a Loop to
process each line item in the array. Loop requires you to
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DescriptionIconsBlock category

specify an input array that contains the individual
elements that will be used as input to one or more steps
in the Loop. At run time, the Loop executes one pass of
the loop for each member in the specified array. For
example, if youwant to execute a Loop for each line item
stored in a purchase order, youwould use the document
list in which the order’s line items are stored as the
Loop’s input array.

The while loop is used to iterate a part of the program
several times. If the number of iterations are not fixed,
it is recommended to use the while loop.

The do-until loops are similar except that they repeat
their bodies until some condition is true.

The for-each block traverses items in a collection. Unlike
other for loop constructs, for-each loops usuallymaintain
no explicit counter: they essentially say “do this to
everything in this set”, rather than “do this x times”.

While selecting a field for the conditions, that is, while
using the If, or Loop, or Switch statements, you can click
on the Select Field expression and choose a field in the
Pipeline Data dialog box to add its path to the condition.
If you want to use the field element inside the array list,
select theAdd Index option to add the index and use the
indexed field path.
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DescriptionIconsBlock category

While selecting a field for the iterations, that is, while
using the for-each statements, you can click on the Select
Field expression and choose an array in the Pipeline
Data dialog box to add its path to the iteration. If you
want to use an array element inside the array list, select
the Add Index option to add the index and use the
indexed field path.

TheExit Integration signaling success block allows you
to successfully terminate and exit from the currently
running Integration. You cannot attach child blocks to
the Exit Integration signaling success block.

The Exit Integration signaling failure "…" block
abnormally terminates the currently running integration
with an error message. You can specify the text of the
error message that is to be displayed. If you want to use
the value of a pipeline variable for this error message,
type the variable name between% symbols, for example,
%mymessage%. The variable you specifymust be a String.
You cannot attach child blocks to the Exit Integration
signaling failure "…" block.

The Throw error "..." block can be attached inside any
block except the catch section of the try catch block, and
allows you to explicitly throw an exceptionwith a custom
error message. If it is used inside the try section of the
try catch block, the error will be caught in the catch
section. If youwant to use the value of a pipeline variable
for this custom error message, type the variable name
between % symbols, for example, %mymessage%. The
variable you specify must be a String. You cannot attach
child blocks to the Throw error "..." block.

Note:
If you add a Throw error "..." block inside a try catch
block, any changes done to the pipeline variables
inside the try blockwill be reset to the previous values
existing in the pipeline.

TheBreak out of loop block should be used onlywithin
a loop and allows you to break out of the containing loop,
that is, it allows you to break the program execution out
of the loop it is placed in. You cannot attach child blocks
to the Break out of loop block.
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DescriptionIconsBlock category

A Loop takes as input an array field that is in the
pipeline. It loops over the members of an input array,
executing its child steps each time through the loop. For
example, if you have a Integration that takes a string as
input and a string list in the pipeline, use Loops to invoke
the Integration one time for each string in the string list.
You identify a single array field to use as input when
you set the properties for the Loop. You can also
designate a single field for the output. Loop collects an
output value each time it runs through the loop and
creates an output array that contains the collected output
values.

Use the Transform Pipeline block to make pipeline
modifications. See Pipeline and Signatures for more
information.

Logical operations, comparisons, and values.Expressions

The six comparison operators are: equal to, not equal
to, less than, less than or equal to, greater than, greater
than or equal to. Each takes two inputs and returns true
or false depending on how the inputs comparewith each
other.

The and block will return true only if both of its two
inputs are also true. The or blockwill return true if either
of its two inputs are true. The not block converts its
Boolean input into its opposite.

You can also type a text value, select a field on which to
build an expression (Select field), or select a block with
no inputs.

The Field exists block allows you to check if a variable
exists or not and can be used with other Control Flow
blocks, for example, the if block. The Field exists block
validates the existence of a particular field in the pipeline.

Note:
It is recommended not to leave an input empty.

5. Provide a valid name and description for the Integration.

6. Click Applications. The list of supported Applications appears.

7. Drag and drop an Application to the root block anchor point.
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8. To select the Operation and Account for the Application, click

While editing an Account in any stage, you can select a different Authentication Typewithout
impacting any integrations. So if an Integration is using an Account with a specified
Authentication Type, the integrationwill runwith the changedAccount configuration. Further,
while editing or creating an Integration, after you select the Operation, the Account field will
list all the Accounts that are supported for the execution of the selected Operation.

The following table depicts the block interactions:

Action/DescriptionApplicable for...Icons

Inline comments for all blocks. Click the
Show Inline Comments option to view
the comments entered for the blocks.

Comments for blocks

Define Input and Output SignatureApplications, Services,
Integrations, and the Root block

Click the Define Input and Output

Signature icon to define the input
and output signature of an Integration.
You can declare the input and output
parameters for an Integration using the
Input and Output tabs. Input and
output parameters are the names and
types of fields that the Integration
requires as input and generates as
output. These parameters are also
collectively referred to as a signature.
For example, an Integration can take two
string values, an account number
(AcctNum ) and a dollar amount
(OrderTotal ) as inputs and produces an
authorization code (AuthCode ) as the
output. On the Output tab, specify the
fields that you want the Integration to
return.

You can use a Document Reference to
define the input or output parameters
for an Integration. If you have multiple
Integrations with identical input
parameters but different output
parameters, you can use a Document
Type to define the input parameters
rather than manually specifying
individual input fields for each
Integration. When you assign a
Document Type to the Input or Output
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Action/DescriptionApplicable for...Icons

side, you cannot add, modify, or delete
the fields on that part of the tab.

You can select a Document Type from
the Document Reference drop-down
list. To create a Document Type, from
the Integration Cloud navigation bar,
select Projects > <Select a Project> >
Document Types > Add New
Document Type. See “Overview” on
page 636 for more information.

You can create pipeline variables as
document references, create document
types comprising of document
references, and also define the signature
of Integrations comprising of document
references.

You can also copy a field from the fields

panel by clicking the icon.
Depending on the context, you can
either paste the field or the field path by

clicking the icon. For example, if you
copy a field and paste the field in the
Set Value window in an Integration,
(double-click a field to set a value), the
field path will be pasted.

See Creating Document Types from
Scratch for more information.

Note:
You cannot modify or paste the child
fields of a Document Reference.

Select the Validate input and Validate
output options if you want to validate
the input and output to the Integration,
against the service input or output
signature.

Select Business Data to Log

Integration Cloud allows you to log
select business data from the Operation
and Integration signatures either always,

396 Integration Cloud 6.6.0

7 Integrations



Action/DescriptionApplicable for...Icons

or only when errors occur. Values of
logged fields can be viewed in the Only
Business Data section in the Execution
Results screen. You can also create
aliases for the logged fields.

Note:
User specific data which may be
considered as personal data will be
stored and retained till the retention
period defined in Execution Results.

To select input or output fields for
logging, click the Select Business Data

to Log icon , and in the Select
Business Data to Log dialog box,
choose whether you want to log
business data only when errors occur
(On Failure) or choose (Always) to
always log business data. The default
setting is On Failure. Then expand the
Input Fields andOutput Fields trees to
display the fields available in the
signature, and select the check boxes
next to the fields you want to log. If you
want to define an alias for a field, type
an alias name beside the field. The alias
defaults to the name of the selected field,

but it can be modified. Click the
icon to clear the selections.

When selecting fields for logging, you
can create the same alias for more than
one field, but this is not recommended.
Having the same alias might make
monitoring the fields at run time
difficult.

Map Input and Output

Map the input of the operation from the
Pipeline and also map the output of the
operation into the pipeline.
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Action/DescriptionApplicable for...Icons

You can copy a field from the fields

panel by clicking the icon.
Depending on the context, you can
either paste the field or the field path by

clicking the icon. If you copy an array
item, the path that is pasted includes the
item index. For example, if the item that
is copied is A/B/C[10], then the pasted
path will also include the item index
[10]. But if it is pasted in the document
tree, it will appear as an array, like A[ ].
If there aremultiple fieldswith the same
name in a document, and one of the
occurrences of such a field is copied,
then the path when pasted will contain
the occurrence number in brackets, for
example, the pathwill beA/B/C(5) if the
copied element C is the 5th occurrence
under field B.

Make pipeline modifications. Edit data
mapping, add Transformer, clear all

Control Flow > Modify Mapping

mappings, add, delete, edit, or discard
a field, set a value for a field and
performpipeline variable substitutions.

Account and an Operation for the
Application is configured.

Applications

The block is not configured. Select an
Operation and an Account for the
Application.

Applications

The block is not configured. Select a
service.

Services

Click to view ormodify anOrchestrated
Integration after it is moved to the

Orchestrated Integrations

workspace. TheOrchestrated Integration
will open up for editing in a new tab.

An Orchestrated Integration has been
modified or newly created but not
saved.

Orchestrated Integrations

9. Create the Integration using the available constructs by inserting the blocks, setting properties,
declaring the input and output parameters, setting values, performing pipeline variable
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substitutions (if you want to replace the value of a pipeline field at run time), and mapping
the pipeline data.

10. Click the icon and then select Modify Mapping to map the Pipeline Input to the Input
Signature.

11. To view only themapped fields, select the Show Only Mapped Fields option.Map theOutput
Signature to the Pipeline Output in the Pipeline Data window, and then click Finish.

12. Use the Transform Pipeline block under the Control Flow category to adjust the pipeline at
any point in the Integration andmake pipelinemodifications.Within this step, you can discard
or remove an existing pipeline input field, (once you discard a field from the pipeline, it is no
longer available subsequently), restore the discarded field, add a field, set a new value or
modify the existing value of a selected field, map selected fields, remove the selected map
between the fields, or perform value transformations by inserting transformers.

13. Click Save to save your Integration or click Save All to save all modified Integrations. The
new Integration appears in the Integrations page. Click on the Integration link in the
Integrations page to view the Integration details.

Note:
While running or debugging Integrations and testing Operations, if the input has any
duplicate keys, or if the service returns an output with duplicate keys, you can view those
keys.

14. After saving the Integration, in the edit Integration page, click the Run Integration icon
to run and test the Integration execution in real time and view the execution results on the
Test Results panel.

The Test Results panel displays up to 25 test entries and the most recent test entry is located

at the top of the panel. Click the icon on the Test Results panel header and click Remove
All to delete the test results permanently or click Close to close the test results panel.
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Point to a previous test result entry, click the icon, and click Download Result to save the
entry locally in JSON format. Click Remove Result to remove the selected entry. Click Pin
Result if you want to prevent a previous result from getting deleted as more results fill the
test results panel. Click Unpin Result to move the result to the Previous Results panel.

Pipeline and Signatures

The pipeline is the general term used to refer to the data structure in which input and output
values are maintained for an Integration. The pipeline starts with the input to the Integration and
collects inputs and outputs from subsequent Applications and services in the Integration. When
an operation of an Application or an Integration executes, it has access to all data in the pipeline
at that point.

Input and output parameters are the names and types of fields that the Integration requires as
input and generates as output. These parameters are also collectively referred to as a signature.

For example, an Integration that takes two string values—an account number (AcctNum) and a
dollar amount (OrderTotal)—as input and produces an authorization code (AuthCode) as output,
has the following input and output parameters:

Output ParametersInput Parameters

Data TypeNameData TypeName

StringAuthCodeStringAcctNum

StringOrderTotal
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Although you are not required to declare input and output parameters for an Integration,
(Integration Cloud will execute an Integration regardless of whether it has a specification or not),
there are good reasons to do so:

Declaring parameters makes the Integration’s input and outputs visible in the user interface.
Without declared input and output parameters, you cannot:

Link data to and/or from the Integration using the Pipeline view.

Assign default input values to the Integration on the Pipeline view.

Run the Integration and enter initial input values.

Declaring parameters makes the input and output requirements of your Integration known
to other developers who may want to call your Integration from their programs.

For these reasons, it is strongly recommended that you make it a practice to declare a signature
for every Integration that you create.

Integration Cloud supports several data types for use in Integrations. Each data type supported
by Integration Cloud corresponds to a Java data type and has an associated icon. When working
in the editor, you can determine the data type for a field by looking at the icon next to the field
name.

The input side describes the initial contents of the pipeline. In other words, it specifies the fields
that this Integration expects to find in the pipeline at run time. The output side identifies the fields
produced by the Integration and returned to the pipeline.

Guidelines for specifying input parameters

When you define the input parameters for an Integration, keep the following points in mind:

Specify all inputs that a calling programmust supply to this Integration. For example, if an
Integration invokes two other Integrations, one that takes a field called AcctNum and another
that takes OrderNum, you must define both AcctNum and OrderNum as input parameters for
the Integration.

Note:
The purpose of declaring input parameters is to define the inputs that a calling program or
client must provide when it invokes this Integration. You do not need to declare inputs that
are obtained fromwithin the Integration itself. For example, if the input for one Integration
is derived from the output of another Integration, you do not need to declare that field as
an input parameter.

Whenpossible, use variable names thatmatch the names used by the Integrations.Variables
with the same name are automatically linked to one another in the pipeline. (Remember that
variable names are case sensitive.) If you use the same variable names used by Integration’s
constituent services, you reduce the amount of manual data mapping that needs to be done.
When you specify names that do not match the ones used by the constituent Integrations, you
must use the Pipeline view to manually link them to one another.
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Avoid using multiple inputs that have the same name. Although the user interface permits
you to declaremultiple input parameters with the same name, the fieldsmay not be processed
correctly within the Integrations or by other Integrations that invoke this Integration.

Ensure that the variables match the data types of the variables they represent in the
Integration. For example, if an Integration expects a document list called LineItems, define that
input variable as a document list.

Declared input variables appear automatically as inputs in the pipeline.When you select
the TransformPipeline step in an Integration, the declared inputs appear under Pipeline Input.

Guidelines for specifying output parameters

On the output side of the Input/Output tab, you specify the variables that youwant the Integration
to return to the calling program or client. The guidelines for defining the output parameters are
similar to those for defining input parameters:

Specify all of the output variables that you want this Integration to return to the calling
program or client.

Ensure that the names of output variables match the names used by the Integrations that
produce them. Like input variables, if you do not specify names that match the ones produced
by the Integration’s constituent services, youmust use the Pipeline view tomanually link them
to one another.

Avoid using multiple outputs that have the same name.Although the user interface permits
you to declaremultiple output parameterswith the same name, the fieldsmay not be processed
correctly within the Integration or by other Integrations that invoke this Integration.

Ensure that the variables match the data types of the variables they represent in the
Integration. For example, if an Integration produces a String called AuthorizationCode, ensure
that you define that variable as a String.

Declared output variables appear automatically as outputs in the pipeline.When you select
the Transform Pipeline step in an Integration, the declared output variables appear under
Pipeline Output.

Declaring Input and Output Parameters

Click theDefine Input and Output Signature icon to define the input and output parameters.
On the Input tab, you define the variables that the Integration requires as input. On the Output
tab, you define the variables the Integration returns to the client or calling program.
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For an Integration, the input side describes the initial contents of the pipeline. In other words, it
specifies the variables that this Integration expects to find in the pipeline at run time. The output
side identifies the variables produced by the Integration and returned to the pipeline.

Note:
You can create pipeline variables as document references, create document types comprising
of document references, and also define the signature of Integrations comprising of document
references.

You can declare a signature in one of the following ways:

Reference a document type. You can use a document type to define the input or output
parameters for an Integration. When you assign a document type to the Input or Output side,
you cannot add, modify, or delete the variables on that half of the tab.

Manually insert input and output variables. Click the icon to manually insert variables to
the Input or Output sides.

Using a Document Type to specify Integration input or output parameters

You can use a document type as the set of input or output parameters for an Integration. If you
have multiple Integrations with identical input parameters but different output parameters, you
can use a document type to define the input parameters rather thanmanually specifying individual
input fields for each Integration. When a document type is assigned to the input or output of an
Integration, you cannot add, delete, or modify the fields on that tab.

Default Pipeline Rules for Linking to and from Array Variables

When you create links between scalar and array variables, you can specify which element of the
array variable you want to link to or from. Scalar variables are those that hold a single value, such
as String, Document, andObject. Array variables are those that holdmultiple values, such as String
List, Document List, and Object List. For example, you can link a String to the second element of
a String List. If you do not specify which element in the array variable that you want to link to or
from, default rules in the Pipeline view are used to determine the value of the target variable. The
following table identifies the default pipeline rules for linking to and from array variables.

Then…To…If you link…

The link defines the length of the array
variable; that is, it contains one element

An array variable that is empty
(the variable does not have a
defined length)

A scalar variable

and has length of one. The first (and only)
element in the array is assigned the value
of the scalar variable.
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Then…To…If you link…

The length of the array is preserved and
each element of the array is assigned the
value of the scalar variable.

An array variable with a defined
length

A scalar variable

Then…To…If you link…

The scalar variable is assigned the first
element in the array.

A scalar variableAn array variable

Then…To…If you link…

The link defines the length of the target
array variable; that is, it will be the same

An array variable that does not
have a defined length

An array variable

length as the source array variable. The
elements in the target array variable are
assigned the values of the corresponding
elements in the source array variable.

Then…To…If you link…

The length of the source array variable
must equal the length of the target array

An array variable that has a
defined length

An array variable

variable. If the lengths do not match, the
link will not occur. If the lengths are
equal, the elements in the target array
variable are assigned the values of the
corresponding elements in the source
array variable.
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Then…To…If you link…

No link occurs.

A source variable that is the child of a Document List is treated like an array because there is one
value of the source variable for each Document in the Document List. For example:

To…If you link…

Then the value of StringList1 is…Where the value ofDocumentList1 is...

Indexed Mapping

You can add an indexed item to a String List, Document List, Document Reference List, or Object
List and alsomap the indexed item. You can delete the selected indexed itemprovided the indexed
item or none of its child fields are mapped.

When you link to an array variable or from an array variable (String List, Document List, Document
Reference List, or Object List), you can specify which element in the array you want to link to or
from. Click on the Add Array Item icon to get an index value for the array item. Then map the
indexed item to the target. For example, you can link the second element in a String List to a String
or link the third Document in a Document List to a Document variable.

For example, suppose that a buyer’s address information is initially stored in a String List. However,
the informationmight be easier to work with if it is stored in a Document. Tomap the information
in the String List to a Document, click on the Add Array Item icon to get an index value for the
String List. Thenmap each indexed item to the address fields. In the following pipeline, the elements
in buyerAddress String List are mapped to the address Document.
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Suppose a String List has length 3 and if you link index 4 of the String List, at run time the String
List length is increased from 3 to 5.

When you link a Document or Document List variable to another Document or Document List
variable, the structure of the source variable determines the structure of the target variable.

Smart Mapping

Overview

Smart mapping provides you with recommendations while mapping the pipeline data. You can
use the available services while creating orchestrations. A Machine Learning (ML) algorithm is
applied to provide the suggestions. This algorithm learns from the mappings you create and
provides suggestions automatically to map similar fields.

The mapping recommendations are not tenant specific. So the mapping inputs from one tenant
maybe used to make recommendations for another tenant.

Note:
Whenyouperformmapping, the data collecteddoes not reflect immediately as a recommendation
for another user. The information is recorded and is processed by our database at specified
intervals.

Preconditions

Smart mapping feature is available only to those tenants who provide their consent to share their
mapping information. For all trial tenants, the mapping data is collected by default. The machine
learning algorithm benefits from having more data from more number of users. The mapping
information collected continues to remain in the database even after a user disables this feature.
However, once you disable this feature, the systemdoes not collect any newmapping information.

Note:
For paid tenants, only an Admin user who has access profile ID 4, has the permission to enable
this feature. For trial tenants and Free Forever Edition, this is always enabled and cannot be
changed.

To provide your consent to share the mapping information, do the following:
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1. Go to Settings > Preferences.

2. On the Configure Tenant Preferences page, click Edit.

3. Select the check box for Publish Integration Mappings to Recommendations Engine.

4. Click Save.

Basic Flow

You can use the smart mapping feature as follows:

1. Select the integration for which you want to perform smart mapping.

2. Click the Modify Mapping icon.

3. On the Pipeline Data screen, select Recommend Mappings. You will see a list of all the
recommended mappings that are color coded based on their likelihood as shown:

Themapping recommendations include the following based on the level ofmapping confidence:

- These have the highest probability.

- These have medium probability.

- These have the least probability.
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4. You can clear the relevantMapping Confidence check boxesHigh,Medium, or Low, depending
on the recommendations that you want to view.

5. To hard map any of the recommendations, choose from the following actions:

When all themapping recommendations are visible, click to select all the recommended

mappings and then click to accept the recommendations.

Filter the mappings based on the likelihood by selecting the relevant check box and then

click , followed by . For example, select High and clear the other two check boxes.

When you have only the mappings with the highest confidence level, click and then

click .

Select the individual mapping recommendations that you want to hard map, and then

click .

6. To unmap any of the hard maps, select the hard map and then click to unmap. The
recommendation disappears. To view this recommendation again, select Recommend
Mappings again.

Integration Details

This page allows you to view when the Integration was created or last modified, who created or
last modified the Integration, references used in the Integration, and whether the Integration is
scheduled. You can also edit, delete, or run the Integration, enable the Integration to be invoked
over HTTP and view and add OAuth Scopes containing the exposed Integration URL, enable
Integration executions to be restartable, associate another Access Control List (ACL) with the
Integration, and also view the last five execution results.

To view the Integration details screen, select an Integration from the Integrations page, and then
click the Integration details icon .
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DescriptionOption

This page allows you to view the components used to create the
Integration by clicking the uses icon,when the Integrationwas created

Overview

or last modified, who created or last modified the Integration, and
whether the Integration is scheduled. You can edit, delete, or run the
Integration, enable the Integration to be invoked over HTTP and view
and addOAuth Scopes containing the exposed IntegrationURL, enable
Integration executions to be restartable, and associate another Access
Control List (ACL) with the Integration.

Click this tab to view the last five execution results panel. This screen
allows you to view the audit trail of the executions that happened in

Last 5 Execution Results

the current stage. See Execution Results for information on the Last 5
Execution Results table columns.

You can restart or resume integrations from the Last 5 Execution Results
page.

View the pipeline and mapping details for a previous version of an
orchestrated integration in a higher stage. You will not be able to make
any modifications to the existing pipeline and mapping data.

Preview

Displays the components used to create the Integration. This field will
appear only if the selected Integration has components.

Uses
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DescriptionOption

Note:
If assets used by an Integration are deleted, you will not be able to
pull the Integration into subsequent stages or export the Integration.

Displays the date and time when the Integration was created.Created on

Displays the user who created the Integration.Created by

Click this option to modify the Integration.Edit

Click this option to delete the Integration from the active stage.Delete

Click this option to submit the Integration for execution. You can provide
inputs to the Integration based on the defined input signature.

Run Now

When and by whom was the Integration last modified.Last modified/Last modified
by

If the Integration in the active stage is scheduled, the status of the
Integration displays Scheduled, else it appears as Not Scheduled. The
Status appears as Paused if the Integration has been paused.

Scheduled status

Click this option to define a schedule. Select Run Once if you want to
schedule the Integration to run just once immediately or run once at a
specified date and time.

Schedule

Select Run Recurrently if you want to define a recurrence pattern. You
can define a recurrence pattern daily, weekly, monthly, and in hours.
Select the frequency (Hourly, Daily, Weekly, Monthly) with which the
pattern recurs, and then select the options for the frequency. Click the
icon to repeat the execution for daily, weekly, andmonthly schedules.

Click the icon to delete the selected execution time for daily, weekly,
and monthly schedules. Select Prevent concurrent executions to skip
the next scheduled execution if the previous scheduled execution is still
running except when the previous scheduled execution is running for
more than 3 hours. In this case, the next scheduled execution will start
even if the previous scheduled execution is still running. If you do not
select this option, the next scheduled execution will start, even if the
previous scheduled execution has not yet completed.

ClickDelete if youwant to permanently remove the current recurrence
schedule.

Click Next to provide inputs to the Integration based on the defined
input signature.

Click this option to change the existing schedule.Modify Schedule

Click this option to pause the Integration that was scheduled.Pause
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DescriptionOption

Click this option to start the scheduled Integration that was paused.Resume

Displays the Access Control List (ACL) associatedwith the Integration.
Integration Cloud associates the default ACL,Default, to an Integration

Associated Execute Access
Control List

when the Integration is created. Click Permissions to associate the
Integration with another ACL.

Note:
The ACL will be enforced only if an Integration acts as a top-level
Integration. For example, if Integration A has Integration B and
Integration C as sub-Integrations, then the ACL if associated, will be
enforced only on Integration A.

For an orchestrated Integration, select the Enable executions to be
restartable option if you want to enable Integration executions to be

Enable executions to be
restartable

restartable or resumable. If an operation fails, you can resume the
Integration execution from the point where it had failed from the
Execution Results page (Resume option). Resuming an execution does
not execute the previous successful operations but executes only the
failed operations and operations that are not yet executed.

You can also restart an execution from the Execution Results page
(Restart option).When an Integration is restarted, the execution occurs
from the beginning of an Integration.

Note:
TheRestart/Resume capability is available only if you have the required
license for restarting and resuming Integrations. You must also have
the Integration execution (Execute) permission if you want to restart
or resume an execution.

Note:
You cannot resume successful Integrations but can only restart them.
If an Integration has referenced Integrations, then those referenced
Integrations can also be restarted or resumed. Only top level
Integrations are displayed in the Execution Results page and the
referenced Integrations are displayed in the Execution Details page
of that top level Integration execution. The Audit Log will display
the "Restart" and "Resume" entries.

Note:
User specific data which may be considered as personal data will be
stored and retained till the retention period defined in Execution
Results.

See Execution Results for more information.
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DescriptionOption

Note:

Enabling this option will increase the execution time of this
Integration.

Once the Integration is updated, you cannot restart or resume its
executions that have occurred before the update.

Integrations using Operations and other Integrations, which have
fields of type “Object” in their signature, may not execute properly
when restarted or resumed.

Select the Enable Integration to be invoked over HTTP option if you
want to trigger the execution of an Integration from an external system.

Enable Integration to be
invoked over HTTP

This option provides you with one more way to trigger Integration
executions from a software application, for example, a REST client, apart
from manual and scheduled integrations from the user interface.

Once the Integration is enabled to be invoked over HTTP, the HTTP
request URL appears. Click the Show Advanced Options link to view
the HTTP Method, sample JSON input, and the parameters that are
required to invoke this Integration from an external system.

You need to provide the HTTPURL,Method, required JSON body, and
necessary header parameters in the external program, including the
required security credentials (user name and password) for invoking
the Integration. After the Integration is executed, the response will
contain the pipeline data.

Synchronous Request URL

You can execute integrations synchronously using the run URL:

https://<sub-domain>.<domain>/integration/rest/external/
integration/run/<stagename>/<integrationname>run - Integrationwill
be executed and the response will contain the pipeline data.

sub-domain is a domain that is part of the primary domain.

run - Integration will be executed and the response will contain the
pipeline data.

stagename is the name of the active stage.

integrationname is the name of the Integration.

Note:
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DescriptionOption

You must provide your user name and password to execute the
Integration from the external program, else you may encounter the
401 - Unauthorized User Error.

Asynchronous Request URL

You can execute integrations asynchronously using the submit URL:

https://<sub-domain>.webmethodscloud.com/integration/

rest/external/integration/submit/<stagename>/<integrationname>

submit - Integration has been submitted for execution and the response
will contain a status indicating whether the Integration has been
submitted for execution. When the request is submitted for execution
using the submit option, the response will contain a reference to the
execution result identifier so that a new HTTP call can be made later to
get the execution results.

Application Status Codes for submit:

0 - SUCCESS: Successfully submitted the Integration for execution.

-1 - ERROR: Problemwhile submitted the Integration for execution.

To get the execution results, construct the URL of the new HTTP call
from the URI field available in the Response section.

To construct the URL of the new HTTP call, add the response URI
obtained from resultReference in the Response section to:
https://<sub-domain>.<domain>.com

Response URI format:

https://<sub-domain>.webmethodscloud.com/integration/

rest/external/integration/execution/result?resultReference

=76 5733-6a21-4b02-864f-e958f698373

HTTP Status Codes

200 - OK

500 - Internal Server Error

401 - Unauthorized User Error

Note:
You must provide your user name and password to execute the
Integration from the external program, else you may encounter the
401-Unauthorized User Error. Further, if the query response HTTP
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DescriptionOption

status code is 404 - Not Found, it means that either the Integration is
not yet run or the resultReference is not correct.

A “scope” on page 84 defines the services the client can access on behalf
of the resource owner and consists of one or more services. If access is

OAuth Scopes containing the
exposed Integration URL

granted for a scope, then access is granted for all the services in that
scope.When a request ismade, Integration Cloud verifies that the scope
is defined for a client. The client is allowed to access only the service
URLs that are specified for the scope.

The OAuth Scopes containing the exposed Integration URL option
appears when you select the Enable Integration to be invoked over
HTTP check box. Click OAuth Scopes to view the OAuth scopes that
contain the exposed URL of the selected Integration.

In the OAuth Scopes dialog box, click Add URL to Another Scope. In
the Add Exposed URL to OAuth Scope dialog box, select Add To
Existing Scope to add the exposed IntegrationURL to an existing scope
or select Add New Scope to create a new scope and add the exposed
Integration URL to that new scope.

Versioning of Integrations

Integration Cloud allows you to view the version change history of an Integration. Click the Show

history option available on the tool bar panel to view the version
change history.

While editing the Integration, you can restore an earlier version of the Integration. To restore an
earlier version of an Integration, select the earlier version of the Integration, and then click the
Restore option to restore that previous version of the Integration. If you have reverted to an earlier
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version and there is a scheduled execution for the Integration, the reverted version of the Integration
will be run as per the defined schedule.

Note:
If an Integration references any other Integration, then the input/output mapping of the
referenced Integrationwill be restored to that particular version. But if the input/outputmapping
of the referenced Integration has been modified in a later version, the modifications will break
the mappings and the Integration execution may not be successful.

Note:
If you delete an Integration and then create another Integrationwith the same name, the version
history of the deleted Integration will be available.

Preview Integrations

Integration Cloud allows you to view the pipeline and mapping details for a previous version of
an orchestrated integration.

To view the pipeline and mapping details in the Development stage, select the Integration from
the Integrations page and click the Integration name link. Then click the Show History option
available on the tool bar panel to view the version change history for the integration. On the version
change history panel, select a previous version of the integration. When you select an Integration
version, you will notice that options to configure accounts and operations are not available. You
will not be able to make any modifications to the existing pipeline and mapping data.

Click to view the Pipeline Data window, which shows all the mappings that are part of this
Integration.
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Note:
In the pipeline preview, none of the action buttons are available. Also, you cannot modify the
existing pipeline or the mapped data.

To view the pipeline and mapping details for a previous version of an orchestrated integration in
any stage other than the Development stage, change the stage, select the integration from the
Integrations page, click the icon, and then click Preview on the Integration Overview page.

Debug Integrations

You can debug an orchestrated Integration and can inspect the data flow during the debugging
session. You can debug an orchestrated Integration only in the Development stage and after the
Integration has been saved.

You can do the following in debug mode:

Start an Integration in debug mode, specify the input values, and inspect the results.

Examine and edit the pipeline data before and after executing the individual blocks.

Monitor the execution path, execute the blocks one at a time, or specify breakpoints where you
want to halt the execution.

To start the Debug mode, from the Integrations page. click the Integration name link to modify

the Integration, and then click the Debug Integration icon .
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The following table describes the options available in the Debug panel:

Action/DescriptionApplicable for...Icons

A breakpoint is a point in an
Integration where you want

Inserting Breakpoints

processing to halt when you
debug that Integration.
Breakpoints can help you isolate
a section of code or examine data
values at a particular point in the
execution path. For example,
you might want to set a pair of
breakpoints before and after a
particular block so that you can
examine the pipeline before and
after that block executes.

Breakpoints are recognized only
when you execute an Integration
in debug session. To insert a
breakpoint, in debugmode, click
the top-left corner of the block.
To remove a breakpoint, click on
the inserted breakpoint.

When you execute an
Integration that contains a
breakpoint, the Integration is
executed up to, but not
including the designated
breakpoint. At this point,
processing stops and the debug
session suspends. To resume
processing, selectResume. After
you resume the debug session,
the Integration flow stops at the
next breakpoint.

Ignores all breakpoints inserted
in the Integration blocks. You

Ignore All Breakpoints

cannot insert breakpoints for
variables in the Expressions
category.
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Action/DescriptionApplicable for...Icons

Executes the current block.
Integration Cloud suspends the

Stepover

debug session immediately
before executing the next block
in the Integration.

The debug session resumes but
suspends at the next breakpoint.

Resume

Terminates the debug session.Stop

A debug session may also stop
by itself for the following
reasons:

The Integration that you are
debugging executes to
completion (error or
success).

You select Stepover for the
last step in the Integration.

You Exit the Integration.

Removes all breakpoints
inserted in the Integration.

Clear All Breakpoints

Modifying the current pipeline data while debugging

During debugging, you canmodify the contents of the pipeline. The changed valueswill be applied
when you perform a Stepover or Resume.

While modifying the pipeline, keep the following points in mind:

You can modify the pipeline data only during an active debug session.

When you modify values in the pipeline, the changes apply only to the current debugging
session. The Integration is not permanently changed.

You can only modify existing variables. You cannot add new variables to the pipeline.

Lock and Unlock Integrations

An Integration is an orchestration of a source and a target Operation with appropriate data
mappings and transformations.

Note:
Users who have the required project permissions under Settings can create, update, delete,
and execute Integrations.
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Integration Cloud allows you to manage an Integration during the development life cycle by auto
locking. When you edit an Integration, it is automatically locked for you. This restricts multiple
users editing that Integration at the same time.

After you edit an Integration and save the changes, you can exit the edit mode to unlock the
Integration andmake it available for other users. If you have locked the Integration and if another
user opens the Integration in the preview mode, then that user gets notified when the lock gets
released.

Note:
Only the user who locked the Integration or an Administrator can unlock the Integration. To
unlock an Integration, from the Integrations page, click the Integration link. The Integration
Overview page appears. From the Integration Overview page, click Unlock.

View the status of a locked Integration
If an integration is locked, the lock status messages tells you who owns the lock.

You can view the lock status of an integration in the workspace.

If the integration is already locked and if the current owner of the lock exits the integration, the
integration screen notifies that the selected integration is ready for editing.
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Export Integrations

Integration Cloud allows you to export Integrations from the Integrations page. The export
capability is available only if you have the required license for exporting Integrations. You can
export Integrations from one tenant and import those Integrations to another tenant. Ensure that
you have the Export Integration permission to export Integrations.

To export Integrations

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Integrations.
The Integrations page appears.

2. Select the Integrations from the Integrations page and click Export. If the Integrations you
are exporting use Reference Data, Document Types, SOAP, or REST Applications, then those
Applications including the Reference Data and Document Types will also be exported along
with the Integrations.

The Confirm Export dialog box appears.

3. Click Export to export the Integrations. The Integrations will be downloaded as a zip file to
your default download folder. The zip file size must not be greater than 50MB. Do not modify
the contents of the exported zip file. If you modify the contents of the zip file, the Integrations
cannot be imported back to Integration Cloud.
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Exporting Integrations having on-premises Applications

After exporting an Integration that has an on-premises Application, if you want to import the
Integration, then before importing the Integration, ensure that youupload the same on-premises
Application to Integration Cloud. Else, you will not be able to import the Integration.

Import Integrations

Integration Cloud allows you to import Integrations from the Integrations page. You can import
Integrations from a zip file that was earlier exported from Integration Cloud. You can export
Integrations from one tenant and import those Integrations to another tenant. You can import
Integrations provided you have the Create Integration permission.

Note:
If you want to import an Integration that has an on-premises Application, before importing the
Integration, ensure that you upload the same on-premises Application to Integration Cloud.
Else, you will not be able to import the Integration.

To import Integrations

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Integrations.
The Integrations page appears.

2. Click Import Integrations.

The Import Integrations page appears.

3. Click Browse and select the zip file that contains the exported Integrations. The zip file size
must not be greater than 50 MB. The Integrations available in the zip file appears in the pane.

4. Click Preview to view an Integration or click Import to import an Integration.

5. In the Configure Project and Applications screen, select the Account for each Application or
create a new Account, and then click Next.

Note:
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If the Integrations you are importing use SOAP or REST Applications and if those
Applications do not exist in your system, youwill not be able to create Accounts at this step.
Continue importing the Integrations. The Applications will also be imported alongwith the
Integrations. After importing, create the Accounts and then configure them in the imported
Integrations.

Note:
If an Integration you are importing uses an on-premises Application and if the Application
does not exist in your system, you will not be able to select the Account at this step. The
Account will appear only after you have uploaded the on-premises Application. See the
Configuring On-Premise Integration Servers for webMethods Cloud document for information
on how to upload on-premises Applications.

The Overview and Save Integration screen appears.

6. In the Overview and Save Integration screen, provide a name and description for your
Integration. By default, the Integration name and description appears.

7. Click Finish. If you have existing references (Reference Data, Document Types, and custom
Operations) with the same name in the development stage, the Copy References screen
appears. Click Cancel to go back to the Overview and Save Integration screen. By default,
all references are selected in the Copy References screen.

8. Deselect the references that you do not want to replace and then click Continue to replace or
overwrite all the selected references from the Integration in the development stage.

The Integration details screen appears for the newly created Integration.
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How to upgrade assets

You can upgrade assets, for example, Accounts, Operations, and the associated Integrationswhich
uses those assets, from a lower version to a higher version. When an upgrade is available for a
version, the upgrade notification text Upgrade available for this version, appears beside the relevant
Application on the Applications screen, else the message This is the latest version appears.

Note:
Users who have the Application Upgrade permission under Settings  > Access Profiles >
Administrative Permissions > Functional Controls > Application can perform the upgrade
task.

If an upgrade is available for a version, and if you click the Add New Account button on the
Application specific Accounts screen, a dialog box appears where you can either select Upgrade
to start the asset upgrade process or select Skip to add a new Account.

If you click the Upgrade button, the upgrade confirmation screen appears which displays the
number of assets (Accounts, Operations, and the associated Integrations) that will be upgraded.
The screen also displays details of all the conflicting assets. Conflicting assets are those assets that
exist in the higher version with the same name.

On the upgrade confirmation screen, select Skip if you do not want to upgrade the conflicting
assets to the higher version. You can also select to Overwrite if you want the conflicting assets in
the higher version to be replaced with the lower version assets. Here, the higher version assets
will be deleted and will be replaced with the lower version assets.

Note:
The upgrade process upgrades Accounts from a lower version to a higher version only in the
Development stage. If you want to reflect the upgraded Accounts in other stages in the higher
version, you must manually configure the Accounts in the different stages from the Account
configuration screen, and then Pull the Integration in the respective stages.

Integration Cloud performs the following tasks if you clickUpgrade on the upgrade confirmation
page:

Migrates all the Accounts from the lower version to the higher version only in the development
stage.

Migrates all the custom Operations and predefined Operations to the latest version.

Updates those Integrations which uses the upgraded Accounts and Operations.

Updates Integrations only in the development stage.

Displays the upgradedAccounts, Operations, and Integrations in the Integration CloudAudit
Log.

Displays the upgrade results along with a list of all the modified Accounts, Operations, and
Integrations.
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Displays a message in case of an upgrade failure and performs rollback of the Accounts,
Operations, and Integrations in case of an error in the upgrade process.
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How to view and use Recipes

Recipes are pre-built Orchestrated or Point-to-Point Integration templates that can be used to
create an Integration. Recipes are based on themost common integration needs and can significantly
reduce the effort required to build an Integration. A recipe includes associated assets, for example
Applications, Operations, Reference Data, and so on, that are used to create an Integration. A
detailed description of the recipe along with its assets are available for preview, which helps you
to select the right recipe. All Integrations created from recipes are initially copied to the development
stage. The Recipes page is paginated to identify the sequential order of the pages. You can also
select the number of recipes to be viewed per page.

To view and use recipes

1. From the Integration Cloud navigation bar, click Recipes. The Recipes page appears. By
default, recipes for all Applications and for all Integration types (Orchestrated and
Point-to-Point) appears. You can search Recipes by Application names, name of the recipe,
and for a specific Integration type. The Recipes page also displays the number of times you
have used a recipe to create Integrations and the Applications referenced in the recipe. If the
main integration created out of a recipe does not have Applications but has sub-integrations,
and if the sub-integrations have Applications, then the Applications are pulled from the
sub-integrations. The logos of the Applications in the sub-integrations will appear on the
Recipes page. The Recipes page is paginated to identify the sequential order of the pages. You
can also select the number of recipes to be viewed per page.

2. Click Preview to see a view-only mode of the Integration details of the recipe. Click the Show

Inline Comments icon to view the inline comments.
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3. Click Details to view a detailed description of the recipe and the references in the Recipe
Details page.

4. From the Recipes or Recipe Details page, click Use if you want to apply the recipe to create
a new Integration. The Configure Project and Applications page appears.

5. In theConfigure Project and Applications page, select the project where youwant to use this
recipe. If an integrationwith the same name already exists in your selected project, all references
and changes made in the existing integration will be overwritten and cannot be recovered.

6. Select the Account for each Application or create a new Account, and then click Apply.

7. If you have existing references (Reference Data, Document Types, and custom Operations)
with the same name in the development stage, the Copy References window appears. By
default, all references are selected in the Copy References page.
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8. Deselect the references that you do not want to replace and then click Continue to replace or
overwrite all the selected references from the recipe in the development stage.

The Integration is available in the selected project.

Marketo Lead to SAP C4C Contact Data Sync

This section describes the recipe for the data sync betweenMarketo Lead business object and SAP
Cloud for Customer Contact business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract updatedMarketoContact records and update
them in SAP Cloud for Customer.

Custom Fields

Contact can be linked to some owner or Employee and Account, hence it is always recommended
to sync the Employee and Account objects before syncing the Contacts to Marketo. This recipe
syncs the Contact object in Marketo with the following custom fields.
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CommentsOn SAP C4C

Custom field in SAP C4C for Contact records to
hold the Marketo Contact records id.

MKTOContactID

Customfield having the lead score for a Contact.ZLeadScore

Custom field having the acquisition program id
for a Contact.

ZAcquisitionProgram

Custom field having the acquisition date for a
Contact.

ZAcquisitionDate

Custom field having the source of a Contact.ZSource

CommentsOn Marketo

Custom field in Marketo to hold the house
number for SAP C4C Contact.

contactHouseNumber

Custom field in Marketo for Contact records to
hold the SAP C4C Contact records id.

c4CContactID

Custom field in Marketo for Contact records to
hold the SAP C4C Contact object id.

c4CContactObjectID

Custom field inMarketo to indicate that record
has been obsoleted in SAP C4C.

isDeleted

Product Compatibility

The recipe is tested for the SAP Cloud for Customer product version 1908.04.0006. Hence the
recipe is compatible to run for the tested and also older versions of the product.

Marketo to SAP C4C Contact Sync Flow

This is designed to run for ongoing sync. For the Contact records synced into Marketo from
SAPC4C, if an update activity is performed, then the updated data is synced back to SAP C4C.
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Operations Used

This recipe has a sub flow to handle the obsolete contact record in SAP C4C, that is,
updateDeletedSAPC4CContactsToMkto.

DescriptionApplicationOperation Name

Queries Marketo
Contact record ids

MarketogetMarketoLeadChangesActivity

which have been
synced from SAP
C4C and updated
later in Marketo.
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DescriptionApplicationOperation Name

Queries Marketo
Contact records data
using ids.

MarketoqueryMarketoLeadRecords

Updates theMarketo
Contact data to SAP
C4C.

SAP C4CpatchSAPC4CMultipleContact

Gets list of State
codes for Contact

SAP C4CgetContactBusinessAddressStateCode

object defined in SAP
C4C.

Gets list of Country
codes for Contact

SAP C4CgetContactBusiness

AddressCountryCode object defined in SAP
C4C.

Gets list of Salutation
codes for Contact

SAP C4CgetContactSalutation

object defined in SAP
C4C.

Gets list of
Department codes
for Contact

SAP C4CgetContactDepartmentCodes

object defined in SAP
C4C.

Usage Notes

In order to add new standard or custom fields to the integration, copy the required field and
add it to the filteredLeads list while making the upsert API call to Marketo.

In order to change or remove standard or custom fields from the integration, remove the
required field mapping and change or remove the field from the filteredLeads list while
making the upsert API call to Marketo.

Marketo to SAP C4C Activities Data Sync

This section describes the recipe for the data sync between Marketo Activity business object and
SAP Cloud for Customer Activity business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.
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Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract Marketo Activity records and create those in
SAP Cloud as Custom object records.

Custom Business Object

Login to SAP C4C CRM and create one custom Business Object with the fields mentioned in the
field mapping table.

Custom OData Service

Once custom object is created, create a customOData service in SAP C4C. Refer the above created
custom object and then activate the service.

Account Creation

Create a new Account in Integration Cloud providing the Server URL of the above customOData
service and credentials. Then use this Account details in the integration.

Product Compatibility

The recipe is tested for the SAP Cloud for Customer product version 1908.04.0006. Hence the
recipe is compatible to run for the tested and also older versions of the product.

Data Sync Flow

This integration "MarketoToSAPC4CActivitiesDataSync" is designed to run for ongoing sync. As
part of the sync, for the newly created activities in Marketo corresponding records will be created
as the custom objects in the SAP Cloud for Customer for the provided date range.

Below flow diagram gives representation of creating activities in SAP C4C from the lead activities
in Marketo:
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Input Parameters

DescriptionParameterSl.No

'Interesting Moment' and 'Filled out form' activity types
are supported currently.

ActivityType1

The sync interval can be entered either in
hours/minutes/seconds or all of them and corresponding
pattern & timezone if required.

syncInterval2

The log status of each record processed. It can either be
true or false.

logRecordStatusFlag3

Integration Cloud 6.6.0 435

9 Recipes



Operations Used

DescriptionApplicationOperation
Type

Operation NameSL.No

Retrieves paging
token to page

MarketoPre-definedgetPagingToken1

through results, or
retrieve data
updated relative to
a given data.

Returns a list of
available activity

MarketoPre-definedgetActivityTypes2

types in theMarketo
instance.

Returns a list of
activities for the

MarketoPre-definedgetLeadActivities3

provided activity
type.

Creates multiple
Marketo activity

SAP C4CCustomcreateMultipleMktoActivity4

records in SAP C4C
in the customobject.

Marketo to SAP C4C Leads Data Sync

This section describes the recipe for the data sync betweenMarketo Lead business object and SAP
Cloud for Customer Lead business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.
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Business Use Case

The business purpose of this integration is to extract a qualified Lead (based on the Lead Score)
from Marketo and sync the Lead into SAP Cloud for Customer.

Configuring Smart campaign and Webhooks in Marketo

1. Webhooks

a. Once logged in to Marketo, go to Admin->Webhooks to see the below page:

b. Click New Webhook and fill the required fields.

For URL, enter
https://<<ICInstance>>/integration/rest/external/integration/submit/<<StageOfIntegration>>/<<IntegrationName>>
and select Request Type as "POST".

c. Under Template, paste the following content:
{"createLead":"true","LeadID":"{{lead.id}}","C4C_Contact_ID":"
{{lead.c4CContactID}}","CompanyInfo":{"CompanyName":"{{company.Company Name}}",
"CompanyID":"{{company.externalCompanyId}}","CompanyNotes":"
{{company.companyNotes}}","ExternalSalesPersonID":"{{company.externalSalesPersonId}}"
,"MainPhone":"{{company.mainPhone}}","Website":"{{company.website}}",
"AccountHouseNumber":"{{company.accountHouseNo}}","NumberOfEmployees":"
{{company.numberOfEmployees:default=0}}","CompanyCity":"{{company.billingCity}}",
"ID":"{{company.id:default=0}}","CompanyCountry":"{{company.billingCountry}}",
"CompanyPostalCode":"{{company.billingPostalCode}}","CompanyState":"
{{company.billingState}}","CompanyStreet":"{{company.billingStreet}}",
"CompanyIndustry":"{{company.industry}}"},"LeadDescription":"{{lead.leadDescription}
}","lastName":"{{lead.Last Name}}","firstName":"{{lead.First Name}}"}

d. Select Request Token Encoding as None, and select Response type as JSON.

e. Click Create.

The following image is a screen shot of the Create Webhook page:
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2. Smart Campaign

a. Navigate to Marketing Activities and click New Smart Campaign.

b. Select a folder and enter the Name, Description, and click Create.

The following image displays the WebhookTestCampaign window:

c. Click Smart List tab and on the right pane select Score is Changed trigger, and drop it
under the Smart List tab.
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For the default Score Name constraint, select condition as is and enter the value as Person
Score.

d. Click Add Constraint menu, to add a New Score constraint.

Under New Score, select the condition as greater than and the value as 60.

A sample screenshot is shown below:

e. Click on the Flow tab.

On the right side pane, selectCall Webhook under Integration and drop it under the Flow
tab.

f. Select the web hook created in 2.1.1. A sample screen shot is shown below:

g. Click on the Schedule tab and click Activate:

Product Compatibility

The recipe is tested for the SAP Cloud for Customer product version 1908.04.0006. Hence the
recipe is compatible to run for the tested and also older versions of the product.
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Data Sync Flow

This integration "MarketoToSAPC4CLeadsDataSync" is designed to run for real-time sync using
Webhooks and Smart Campaigns inMarketo. Based on the Lead input fromMarketo, appropriate
Accounts, Contacts, and Leads should be created in SAP C4C.

The following flow diagram represents the same:

Operations Used

1. SAP C4C

NotesQueryDescriptionOperation NameSL.NO

AccountID eq
'%C4C_Account_ID%'

Query SAP

C4C Accounts

queryAccounts_

MarketoLeadTo

1

Name eq
'%CompanyName%'SAPC4CLea

.

ContactID eq
'%C4C_Contact_ID%'

Query Contacts

from SAP C4C

queryContacts_

MarketoLeadTo

2
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NotesQueryDescriptionOperation NameSL.NO

FirstName eq
'%firstName%'

SAPC4CLea

and LastName eq
'%lastName%'

LastName eq
'%lastName%'

NACreate a LeadcreateLeanLead_3

in SAP C4CMarketoLeadTo

SAPC4CLe

NAPatch Contact topatchContact_4

a Particular Account in SAP
C4C

MarketoLeadTo

SAPC4CLead

CachingNAGet list of CountrygetCorporateAccount5

enabledcodes for Account object
defined

CountryCode

in SAP C4C

CachingNAGet list of Industry CodesgetCorporateAccount6

enabledfor Account object defined in
SAP C4C

IndustrialSecCode

CachingNAGet list of State codesgetCorporateAccount7

enabledfor Account object defined in
SAP C4C

StateCode

CachingNAGet list of Country codesgetContactBusiness8

enabledfor Contact object defined in
SAP C4C

AddressCountryCode

CachingNAGet list of State codesgetContactBusiness9

enabledfor Contact object defined in
SAP C4C

AddressStateCode

CachingNAGet list of Status codesgetContactStatusCode10

enabledfor Contact object defined in
SAP C4C

CachingNAGet list of Salutation codesgetContactSalutation11
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NotesQueryDescriptionOperation NameSL.NO

enabledfor Contact object defined in
SAP C4C

CachingNAGet list of DepartmentgetContactDepartment12

enabledcodes for Contact object
defined in SAP C4C

Codes

NACreate Contact increateContact_13

SAP C4CMarketoLeadToSAPC4CLea

NALink a Contact to acreateCorporateAccount14

DepartmentHasContactPers

NALink Person notes to acreateContact15

ContactTextCollection

NACreate a Prospect increateAcc_MarketoLeadTo16

SAP C4CSAPC4CLeads

NALink Company notescreateCorporateAccount17

to an AccountTextCollection

NALink a SalesPersonIDcreateCorporate18

to Owner in an AccountAccountTeam

Marketo

QueryDescriptionParameterSL.No

NAGet Lead information forgetLeadById_1

a matching ID.MarketoLeadToSAPC4CLeads

NAUpdate a Marketo Lead/PersonupsertLead_2

with created Contact in SAP C4CMarketoLeadToSAPC4CLeads

SAP C4C to Marketo Appointment Activity Data Sync

This section describes the recipe for the data sync between SAP Cloud for Customer Apointment
business object and Marketo custom object for Appointment records
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SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAPCloud for CustomerAppointment records
and upserts them into Marketo Custom object for Appointment records.

Custom Fields

When the Appointment record gets synced in Marketo, it needs to be created or updated with the
below mentioned custom fields.

CommentsOn Marketo

Custom field needs to be created in the Marketo custom object
for Appointment record.

c4CAppointmentID

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.
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Data Sync Flow

This integration "SAPC4CToMarketoActvtyAppoinDataSync" is designed to run for initial as well
as ongoing sync. As part of the initial sync, all the Customer Appointment records present in SAP
C4C will be synced to Marketo. On the other hand, as part of the ongoing sync, the updated or
newly created Customer Appointment records will be synced to Marketo for the provided date
range.

Below flow diagram gives representation of creating or updating an appointment activity in
Marketo from SAP C4C:

Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of
ongoing sync(true/false).

isInitialSync1
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DescriptionParameterSl.No

The sync interval can be entered either in
hours/minutes/seconds or all of them and corresponding
pattern & timezone if required.

syncInterval2

The log status of each record processed. It can either be
true or false.

logRecordStatusFlag3

Operations Used

This recipe has a sub flow to handle the obsolete contact record in SAP C4C, that is,
updateDeletedSAPC4CContactsToMkto.

QueryDescriptionApplicationOperations UsedSl.No

LastChangeDateTimeQuery SAP C4CC4CqueryAppointments1

ge datetimeoffset'%Appointments.

fromDateString%'

NAUpsert Appointments inMarketoupsertAppointme_2

Marketo.SAPC4CAct_to_MktoAct

SAP C4C to Marketo CBO Lead Data Syn

This section describes the recipe for the data sync between SAPCloud for Customer Lead business
object and Marketo Lead business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.
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Business Use Case

The business purpose of this integration is to extract SAP Cloud for Customer Lead records and
upsert those to Marketo as Custom object records.

Custom Fields

Login toMarketo CRMand create one custombusiness object "mKTO_C4C_Leads"with the fields
mentioned in the field mapping table. The custom field "c4CLeadObjectID" should be marked as
Dedupe Field, else the delete scenario will not work.

446 Integration Cloud 6.6.0

9 Recipes



Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Lead Sync Flow

This integration "SAPC4CToMarketoCBOLeadDataSync" can be run for initial as well as ongoing
sync. As part of initial sync, all the Lead records having AccountID and ContactID present in SAP
C4C will be synced to Marketo. On the other hand, as part of the ongoing sync, the updated or
newly created Lead records will be synced to Marketo for the provided date range.

Below flow diagram gives representation of creating a CBO Lead in Marketo from a Lead in SAP
C4C:
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Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of
ongoing sync(true/false).

isInitialSync1

The sync interval can be entered either in
hours/minutes/seconds or all of them and corresponding
pattern and time zone if required.

syncInterval2

The log status of each record processed. It can either be true
or false.

logRecordStatusFlag3
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Operations Used

DescriptionApplicationOperations UsedSl.No

Queries SAP C4C Lead.SAP C4CquerySAPC4CLeads1

Used to get the Contact custom field
MKTOContactID data to sync.

SAP C4CqueryC4CContacts2

Upsert Leads in Marketo as custom object
records.

MarketoupsertMKToCBOLeads3

1. querySAPC4CLeads

Input Filter parameter

Filter to query records from SAPConditionSl.No

No filter required.IsInitialSync = True1

LastChangeDateTime ge
datetimeoffset'%fromDateString%' and

IsInitialSync = False2

LastChangeDateTime le
datetimeoffset'%toDateString%

2. queryC4CContacts

Used to get the Contact custom field  MKTOContactID data.

3. upsertMKToCBOLeads

Field Mapping

MKTO -
mKTO_C4C_Leads

SAP Lead

CustomFieldc4CLeadIDStandardID

CustomFieldc4CLeadObjectIDStandardObjectID

CustomFieldnameStandardName

CustomFieldaccountPartyIDStandardAccountPartyID

CustomFieldcontactIDStandardContactID

CustomFieldqualificationLevelCodeStandardQualificationLevelCode

CustomFieldstatusStandardUserStatusCode

CustomFieldresultReasonCodeStandardResultReasonCode
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MKTO -
mKTO_C4C_Leads

SAP Lead

CustomFieldorginTypeCodeStandardOriginTypeCode

CustomFieldpriorityCodeStandardPriorityCode

CustomFieldstartDateStandardStartDate

CustomFieldendDateStandardEndDate

CustomFieldcampaignIDStandardCampaignID

CustomFieldgroupCodeStandardGroupCode

CustomFieldownerPartyIDStandardOwnerPartyID

CustomFieldnoteStandardNote

CustomFieldmKTOLeadIDCustomFieldContact - MKTOContactID

CustomFieldreferenceDocumentIDStandardLeadBusinessTransactionDocument
- ID

Usage Notes

In order to add new standard or custom fields to the integration, copy the required field and
add it to the C4CLeadOutput document while making the upsert API call to Marketo.

In order to change or remove standard or custom fields from the integration, remove the
required fieldmapping, and change or remove the field fromC4CLeadOutput documentwhile
making the upsert API call to Marketo.

Custom field “c4CLeadObjectID” should be created as Dedupe Field.

If the Lead is associated to just an account, contact will not be synced to Marketo.

SAP C4C to Marketo Event Notification for Delete Sync

This section describes themaster recipe consisting of SalesPerson, Company, Lead andOpportunity
recipes for the data sync between SAPCloud for Customer business objects andMarketo business
objects respectively.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.
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Business Use Case

The business purpose of this integration is to delete the records fromMarketo for the corresponding
records deleted from SAP Cloud for Customer.

Configure Event Notification in SAPC4C

Enable the integration to be invoked over HTTP and copy the REST service URL as follows:

Login to SAPC4C and navigate to Administrator -> General Settings -> Event Notification.

Configure Delete event notification using the REST service URL copied for the integration, add
basic authentication details and then activate it.

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Delete Sync Flow

This integration "SAPC4CToMarketoDeleteSync" is designed to run in the background triggered
by event notification fromSAPC4Candnomanual execution required. The delete sync is performed
for the deletion of records of the following business objects Opportunity, CBO Lead, Phone Call,
Task, Appointment activities.

This recipe is a wrapper and consisting of the below five sub-integrations:

deleteCBOLeadEventNotification

deletePhoneCallEventNotification

deleteTaskEventNotification

deleteAppointmentEventNotification
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deleteOpportunityEventNotification

SAP C4C to Marketo Master Data Sync

This section describes themaster recipe consisting of SalesPerson, Company, Lead, andOpportunity
recipes for the data sync between SAPCloud for Customer business objects andMarketo business
objects respectively.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAPCloud for Customer Employee, Account,
Contact, and Opportunity records and upserts those to Marketo. For every SAP contact, a
corresponding Lead / person record is created in Marketo which then will have the respective 1)
SAPEmployee synched as salesperson 2)Account as Company and 3)Opportunity asOpportunity
of the Marketo Lead / person.

Business Object Relationship

One or all of the 4 types of records (Employee, Account, Contact, and Opportunity) needs to be
created or updated in the source SAP C4C systems.

In the real world scenarios an explicit relationship ismaintained between these records or business
objects, that is, anAccountwill have an Employee associatedwith it asOwner. Further, theAccount
will have onemore Contact associatedwith it. In otherwords, every contact is part of some account
(company). Lastly, one or more opportunities for the given contact is created with a distinct
role/authority within the respective contact.
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Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Master Sync Flow

ThisMaster integration "SAPC4CToMarketoMasterDataSync" is awrapper consisting of fourmain
sub-integrations which were built to sync records of particular business objects only.

The four integrations are as follows:

SAPC4CToMarketoSalesPersonDataSync

SAPC4CToMarktoCompanyDataSync

SAPC4CContactToMarketoLeadDataSync

SAPC4CToMarketoOpportunityDataSync

Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of
ongoing sync(true/false).

isInitialSync1

The sync interval can be entered either in
hours/minutes/seconds or all of them and corresponding
pattern and time zone if required.

syncInterval2

The log status of each record processed. It can either be true
or false.

logRecordStatusFlag3

Usage Notes

See the respective usage notes of the four main sub-integrations as a part of the Master Sync
integration.

SAP C4C to Marketo Phone Activity Data Sync

This section describes the recipe for the data sync between SAP Cloud for Customer Phone Call
business object and Marketo Phone Call business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.
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Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAP Cloud for Customer Phone Call records
and upsert them into Marketo Custom object for Phone Call records.

Custom Fields

When the Phone call record gets synced in Marketo, it need to be created or updated with the
below mentioned custom fields.

CommentsOn Marketo

Custom field needs to be created in the Marketo custom object
for Phone call record.

c4CPhoneCallID

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Data Sync Flow

This integration "SAPC4CToMarketoActvtyPhoneDataSync" is designed to run for initial as well
as ongoing sync. As part of the initial sync, all the Customer Phone Calls records present in SAP
C4C will be synced to Marketo. On the other hand, as part of the ongoing sync, the updated or
newly created Customer Phone Calls records will be synced to Marketo for the provided date
range.

454 Integration Cloud 6.6.0

9 Recipes



Belowflowdiagramgives representation of creating or updating a phone activity inMarketo from
SAP C4C:

Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of
ongoing sync (true/false).

isInitialSync1

The sync interval can be entered either in
hours/minutes/seconds or all of them and
corresponding pattern & time zone if required.

syncInterval2

The log status of each record processed. It can either
be true or false.

logRecordStatusFlag3
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Operations Used

QueryDescriptionApplicationOperations UsedSl.No

LastChangeDateTime ge
datetimeoffset'%fromDateString%'

Query SAP C4C Phone
calls.

C4CqueryPhoneCalls1

NAUpsert phone calls in
Marketo.

MarketoupsertPhnCal_SAPC4CAct_

to_MktoAct_Ph

2

SAP C4C to Marketo Task Activity Data Sync

This section describes the recipe for the data sync between SAPCloud for Customer Task business
object and Marketo Task business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAP Cloud for Customer Tasks records and
upserts them into Marketo Custom object for Task records.
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Custom Fields

When the Task record gets synced in Marketo, it needs to be created or updated with the below
mentioned custom fields.

CommentsOn SAP C4C

Custom field needs to be created in the
Marketo custom object for Task record.

c4CTaskID

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Data Sync Flow

This integration "SAPC4CToMarketoActvtyTasksDataSync" is designed to run for initial as well
as ongoing sync. As part of the initial sync, all the Customer Tasks records present in SAP C4C
will be synced to Marketo. On the other hand, as part of the ongoing sync, the updated or newly
created Customer Tasks records will be synced to Marketo for the provided date range.

Below flow diagram gives representation of creating or updating a task activity in Marketo from
SAP C4C:
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Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of ongoing
sync(true/false).

isInitialSync1

The sync interval can be entered either in hours/minutes/seconds
or all of them and corresponding pattern and time zone if required.

syncInterval2

The log status of each record processed. It can either be true or false.logRecordStatusFlag3

Operations Used

QueryDescriptionApplicationOperation NameSl.No

LastChangeDateTime ge
datetimeoffset'%fromDateString%'

Query SAP C4C
Tasks

C4CqueryTasks1
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QueryDescriptionApplicationOperation NameSl.No

NAUpsert tasks in
Marketo

MarketoupsertTasks_SAPC4CAct_

to_MktoAct_Tas

2

SAP C4C Account to Marketo Company Data Sync

This section describes the recipe for the data sync between SAP Cloud for Customer Account
business object and Marketo Company business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAP Cloud for Customer Account records
and upsert those to Marketo as Company records.

Custom Fields

Account can be linked to some owner or Employee, hence it is recommended to sync Employee
objects before syncing the Accounts to Marketo.

The Account object need to be created or upserted in SAP C4C with the belowmentioned custom
fields.

Similarly when the Account object gets synced in Marketo, it need to be created or updated with
the below mentioned custom fields.

CommentsOn SAP C4C

Customfield in SAPC4C forAccount records
in SAP C4C to hold the Marketo Company
records id.

MKTOCompanyID
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CommentsOn SAP C4C

Custom field having the number of
employees for an Account.

NumberofEmployees

CommentsOn Marketo

Custom field in Marketo to hold the house
number for the SAP C4C Account.

AccountHouseNumber

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Account Sync Flow

This integration "SAPC4CToMarktoCompanyDataSync" is designed to run for initial as well as
ongoing sync. As part of this initial sync, all the accounts linked to Employees present in SAP C4C
will be synced to Marketo. On the other hand, as part of the ongoing sync, the newly created or
updated account records will be synced to Marketo for the provided date range. Once the record
is successfully created in Marketo, it syncs back the Marketo Company ID in the corresponding
SAP C4C Account record (Custom Field: MKTOCompanyID).

The following diagram represents creating a Company in Marketo from an Account in SAP C4C:
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Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of
ongoing sync (true/false).

isInitialSync1

The sync interval can be entered either in
hours/minutes/seconds or all of them and
corresponding pattern and time zone if required.

syncInterval2

The log status of each record processed. It can either
be true or false.

logRecordStatusFlag3
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Operations Used

This recipe has a sub-flow to handle the obsolete contact record in SAP C4C, that is,
updateDeletedSAPC4CContactsToMkto.

DescriptionApplicationOperations UsedSl.No

Queries SAP C4C Accounts.SAP C4CquerySAPC4CAccount1

Upserts Account in Marketo as Company
records and if Account is obsolete in SAP

MarketoupsertMarketoLeads2

C4C then it updates the obsoleteinC4C flag
to the Company record in Marketo.

Once records are successfully created in
Marketo, it updates the Marketo Company

SAP C4CpatchMultipleAccount3

ID in the corresponding SAP C4C Account
record in the  MKTOCompanyID custom
field.

1. querySAPC4CAccount

Input Filter parameter

Filter to query records from SAPConditionSl.No

No filter required.IsInitialSync = True1

ChangedOn ge datetimeoffset'%fromDateString%'IsInitialSync = False2

ChangedOn le datetimeoffset'%toDateString%'

2. upsertMarketoCompanies

Field Mapping

MKTO-COMPANYSAP Account

StandardexternalCompanyIdStandardAccountID

StandardbillingCityStandardCity

StandardbillingCountryStandardCountryCodeText

StandardbillingPostalCodeStandardStreetPostalCode

StandardbillingStateStandardStateCodeText

StandardbillingStreetStandardStreet

StandardcompanyStandardName
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MKTO-COMPANYSAP Account

StandardcompanyNotesStandardContactText

StandardexternalSalesPersonIdStandardEmployeeID

StandardindustryStandardIndustrialSectorCodeText

StandardmainPhoneStandardPhone

StandardwebsiteStandardWebSite

CustomFieldaccountHouseNoStandardHouseNumber

StandardstateStandardNumberofEmployees

3. patchMultipleAccount

OnceAccount records are successfully created inMarketo asCompany records, updateMarketo
Company ID to the corresponding SAPC4CAccount record in theMKTOCompanyID custom
field.

SAP - ACCOUNTMKTO - PERSON

CustomFieldMKTOCompanyIDStandardID

StandardNameStandardName

StandardRoleCodeStandardRoleCode

StandardObjectIDStandardObjectID

Usage Notes

In order to add new standard or custom fields to the integration, copy the required field and
add it to accList_NullMktoID, accList_WithMktoID, delAccList_WithMktoID, and the
delAccList_NullMktoID list while making the upsert API call to Marketo.

In order to change or remove standard or custom fields from the integration, remove the
required field mapping and change or remove the field from accList_NullMktoID,
accList_WithMktoID, delAccList_WithMktoID, and delAccList_NullMktoID list whilemaking
the upsert API call to Marketo.

SAP C4C Contact to Marketo Lead Data Sync

This section describes the recipe for the data sync between SAP Cloud for Customer Contact
business object and Marketo Lead business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Integration Cloud 6.6.0 463

9 Recipes



Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAP Cloud for Customer Contact records
and upsert them to Marketo as Person records.

Custom Fields

Contact can be linked to some owner or Employee and Account, hence it is always recommended
to sync Employee and Account objects before syncing the Contacts to Marketo.

This recipe syncs Contact object in Marketo with the below mentioned custom fields.

CommentsOn SAP C4C

Customfield in SAPC4C for Contact records
to hold the Marketo Contact records id.

MKTOContactID

Custom field having the lead score for a
Contact.

ZLeadScore

Customfield having the acquisition program
id for a Contact.

ZAcquisitionProgram

Custom field having the acquisition date for
a Contact.

ZAcquisitionDate

Customfield having the source of a Contact.ZSource
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CommentsOn Marketo

Custom field in Marketo to hold the house
number for SAP C4C Contact.

contactHouseNumber

Custom field in Marketo for Contact records
to hold the SAP C4C Contact records id.

o c4CContactID

Custom field in Marketo for Contact records
to hold the SAP C4C Contact object id.

c4CContactObjectID

Custom field in Marketo to indicate that
record has been obsoleted in SAP C4C.

isDeleted

Required recipes to run before Opportunity

CommentsRequired FieldsMarketoSAP C4C

If employee is synched in
Marketo, then only the

externalSalesPersonIDSalesPersonEmployee

Opportunity owner will be
updated atMarketo fromSAP
C4C.

If account is synced in
Marketo, then only the

externalCompanyID (SAP
ProspectPartyID)

CompanyAccount

Opportunity companywill be
updated atMarketo fromSAP
C4C.

If contact is synced in
Marketo, then only the

c4CContactID (SAP
PrimaryContactPartyID)

LeadContact

Opportunity will be upserted
at Marketo from SAP C4C.

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Contact Sync Flow

This integration "SAPC4CContactToMarketoLeadDataSync" is designed to run for initial as well
as ongoing sync. As part of the initial sync, all the active and obsolete Contact records present in
SAP C4C will be synced to Marketo. On the other hand, as part of the ongoing sync, the updated
and newly created and obsolete Contact records will be synced to Marketo for the provided date
range. Once the record is successfully created in Marketo, it syncs back the Marketo Contact ID
in the corresponding SAP C4C Contact record. (Custom Field: MKTOContactID).
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Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of ongoing
sync(true/false).

isInitialSync1

The sync interval can be entered either in
hours/minutes/seconds or all of them and corresponding
pattern and time zone if required.

syncInterval2

The log status of each record processed. It can either be true
or false.

logRecordStatusFlag3
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Operations Used

This recipe has a sub flow to handle the obsolete contact record in SAP C4C, that is,
updateDeletedSAPC4CContactsToMkto.

DescriptionApplicationOperations UsedSl.No

Queries SAP C4C Contacts.SAP C4CquerySAPC4CContact1

Upserts Contact in Marketo and if
Contact is obsolete in SAP C4C, it

MarketoupsertMarketoLeads2

updates isDeleted flag to Contact
record in Marketo.

Once record is successfully created in
Marketo, it updates the Marketo

SAP C4CpatchSAPC4CMultipleContact3

Contact ID in the corresponding SAP
C4C Contact record in the
MKTOContactID custom field.

Retrieves the Employee/Owner id for
the provided UUID.

SAP C4CreadMultipleEmployees4

1. querySAPC4CContact

Input Filter parameter

Filter to query records from SAPConditionSl.No

SAPC4CContact_To_MarketoLead :
StatusCode ne '4'

IsInitialSync = True1

updateDeletedSAPC4CContactsToMkto
: StatusCode eq '4'

SAPC4CContact_To_MarketoLead :
StatusCode ne '4' and ChangedOn ge
datetimeoffset'%fromDateString%'

IsInitialSync = False2

updateDeletedSAPC4CContactsToMkto
: StatusCode eq '4' and ChangedOn ge
datetimeoffset'%fromDateString%'

2. upsertMarketoLeads

Field Mapping

MKTO-PERSONSAP Contact

CustomFieldobsoleteinC4CStandardStatusCode
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MKTO-PERSONSAP Contact

StandardsalutationStandardTitleCodeText

StandardfirstNameStandardFirstName

StandardmiddleNameStandardMiddleName

StandardlastNameStandardLastName

StandardemailStandardEmail

StandardphoneStandardPhone

StandardmobilePhoneStandardMobile

StandardfaxStandardFax

StandardtitleStandardJobTitle

StandarddateOfBirthStandardBirthDate

StandardaddressStandardStreet

StandardcityStandardCity

StandardstateStandardStateCodeText

StandardcountryStandardCountryCodeText

StandardpostalCodeStandardStreetPostalCode

StandardunsubscribedStandardConsentEmail

StandarddonotcallStandardConsentTelephone

CustomFieldmktoPersonNotesStandardContactTextCollection - Text

StandarddepartmentStandardDepartmentCodeText

(Relation -
CorporateAccountHas

ContactPerson)

StandardexternalSalesPersonIdStandardEmployeeID (Employee)

CustomFieldcontactHouseNumberStandardHouseNumber

StandardleadScoreCustomFieldZLeadScore

StandardacquisitionProgramIdCustomFieldZAcquisitionProgram

StandardmktoAcquisitionDateCustomFieldZAcquisitionDate

StandardleadSourceCustomFieldZSource
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MKTO-PERSONSAP Contact

CustomFieldc4CContactIDStandardContactID

3. patchMultipleContact

Once Contact records are successfully created in Marketo, update the Marketo ID to the
corresponding SAP C4C Contact record in the MKTOContactID custom field.

SAP - CONTACTMKTO - PERSON

CustomFieldMKTOCompanyIDStandardLeadID

4. readMultipleEmployees

If any contact has any owner/Employee, then we have to associate the same owner to the
Contact record in Marketo as well. Now as we query Contact records from SAP C4C, we get
the Owner UUID instead of the ID. Hence this operation gets us the Owner ID for the
corresponding UUID and then maps it to the Marketo Upsert Lead call to associate it to the
proper SalesPerson.

Usage Notes

In order to add new standard or custom fields to the SAPC4CContact_To_MarketoLead
integration, copy the required field and add it to contactList_NullMKTOID,
contactList_WithMKTOID, contactList_WithOwner, and notSyncedcontactList_withOwner
list while making the upsert API call to Marketo.

In order to change or remove standard or custom fields from the
SAPC4CContact_To_MarketoLead integration, remove the requiredfieldmapping and change
or remove the field from contactList_NullMKTOID, contactList_WithMKTOID,
contactList_WithOwner, and notSyncedcontactList_withOwner lists while making the upsert
API call to Marketo.

In order to add new standard or customfields to theupdateDeletedSAPC4CContactsToMkto
integration, copy the required field and add it to contactList_NullMKTOID,
contactList_WithMKTOID, contactList_WithOwner, and notSyncedcontactList_withOwner
lists while making the upsert API call to Marketo.

In order to change or remove standard or custom fields from the
updateDeletedSAPC4CContactsToMkto integration, remove the required fieldmapping and
change or remove the field from contactList_NullMKTOID, contactList_WithMKTOID,
contactList_WithOwner, and notSyncedcontactList_withOwner lists while making the upsert
API call to Marketo.

SAP C4C to Marketo Opportunity Data Sync

This section describes the recipe for the data sync between SAP Cloud for CustomerOpportunity
business object and Marketo Opportunity business object.
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SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract SAPCloud for CustomerOpportunity records
and upsert them into Marketo as Opportunity records with related Company and Salesperson
and then create Marketo Opportunity Contact Role records with a dependency onMarketo Lead,
based on the associated Contact of SAP Cloud for Customer.

Custom Fields

The Opportunity object needs to be created or upserted in SAP C4C with the below mentioned
customfields. Similarly, when theOpportunity object gets synced inMarketo, it needs to be created
or updated with the below mentioned custom fields. The required custom fields are as follows:

CommentsOn SAP C4C

Customfield needs to be created in SAPC4C
to hold theAmount forMarketoOpportunity
record.

zTotalNegotiatedValueConvertedcontent

Customfield needs to be created in SAPC4C
to hold the ExpectedRevenue for Marketo
Opportunity record.

zWeightedValueConvertedcontent

Customfield needs to be created in SAPC4C
to hold the FiscalQuarter for Marketo
Opportunity record.

ZFiscalQuarter

Customfield needs to be created in SAPC4C
to hold the FiscalYear for Marketo
Opportunity record.

ZFiscalYear
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CommentsOn SAP C4C

Customfield needs to be created in SAPC4C
to hold the Fiscal for Marketo Opportunity
record.

Fiscal

CommentsOn Marketo

Custom field in Marketo for Opportunity
record to hold the SAP C4C Opportunity
record ID.

c4COpptID

Custom field in Marketo for Opportunity
record to hold the SAP C4C Opportunity
record ObjectID

opportunityObjectID

Required recipes to run before Opportunity

CommentsRequired FieldsMarketoSAP C4C

If employee is synched in
Marketo, then only the

externalSalesPersonIDSalesPersonEmployee

Opportunity ownerwill be
updated at Marketo from
SAP C4C.

If account is synced in
Marketo, then only the

externalCompanyID (SAP
ProspectPartyID)

CompanyAccount

Opportunity companywill
be updated at Marketo
from SAP C4C.

If contact is synced in
Marketo, then only the

c4CContactID (SAP
PrimaryContactPartyID)

LeadContact

Opportunity will be
upserted at Marketo from
SAP C4C.

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

Data Sync Flow

This integration "SAPC4CToMarketoOpportunityDataSync" is designed to run for initial as well
as ongoing sync. As part of the initial sync, all the Opportunity records present in SAP C4C will
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be synced toMarketo. On the other hand, as part of the ongoing sync, the updated or newly created
Opportunity records will be synced to Marketo for the provided date range.

The following diagram represents creating aOpportunity inMarketo from anOpportunity in SAP
C4C:

Input Parameters

DescriptionParameterSl.No

Set to true in case of initial sync and to false in case of
ongoing sync (true/false).

isInitialSync1
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DescriptionParameterSl.No

The sync interval can be entered either in
hours/minutes/seconds or all of them and corresponding
pattern and time zone if required.

syncInterval2

The log status of each record processed. It can either be
true or false.

logRecordStatusFlag3

Operations Used

DescriptionApplicationOperations UsedSl.No

Query SAP C4C Opportunity.SAP C4CQueryOpportunity1

Query Lead from Marketo.MarketoqueryLead2

Query Employee from SAP C4C.SAP C4CqueryEmployee3

Upsert opportunities in Marketo.MarketoupsertOpportunities4

Upsert Opportunity Roles in Marketo.MarketoupsertMarketoOpportunityRoles5

1. QueryOpportunity

Input Filter parameter

IsInitialSync = True: ProspectPartyID ne null and MainEmployeeResponsiblePartyID ne
null

IsInitialSync = False: ProspectPartyID ne null and MainEmployeeResponsiblePartyID ne
null and ETag ge datetimeoffset'%fromDateString%'

Note:
Pagination will be done based on this operation. 100 records per API Call.

2. queryLead

QueryLead based on c4CCustomerID(CustomField) Identifier. This operationwill provide
relatedMarketo Lead(id),whichwill bemapped to leadId in upsertOpportunities operation.

QueryLead based on c4CCustomerID(CustomField) Identifier. This operationwill provide
related Marketo Lead(id), which will be mapped to leadId in
upsertMarketoOpportunitiesRoles operation.

3. queryEmployee

queryEmployee based on filter constructed with BusinessPartnerIDs to obtain Employee ID
in SAP C4C. This operation will provide the related Employee ID, which will be mapped to
externalSalesPersonId in upsertOpportunities operation.

Note:
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The required response data of queryOpportunity, queryLead, and queryEmployee will be
stored in toList[].

a. upsertOpportunities

Field Mapping

Field TypeMKTO -

OPPORTUNITY

Field TypeSAP - OPPORTUNITY

Source (ToList)

StandardexternalCreatedDateStandardCreationDate

StandardcloseDateStandardExpectedProcessingEndDate

StandardexternalOpportunityIdStandardID

Customc4COpptIDStandardID

StandardStageStandardLifeCycleStatusCodeText

StandarddescriptionStandardName

StandardexternalCompanyIdStandardProspectPartyID

StandardprobabilityStandardProbabilityPercent

StandardfiscalCustomFiscal_KUT

StandardfiscalQuarterCustomZFiscalQuarter_KUT

StandardamountCustomzTotalNegotiatedValue

Convertedcontent_KUT

StandardexpectedRevenueCustomzWeightedValue

Convertedcontent_KUT

StandardisClosedTransformed fromisClosed

standard field

StausCodeText

StandardisWonTransformed fromisWon

standard field

StausCodeText

StandardfiscalYearCustomZFiscalYear_KUT

StandardexternalSalesPersonIdMapped fromexternalSalesPersonId

/queryLeadOutput/leads/
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Field TypeMKTO -

OPPORTUNITY

Field TypeSAP - OPPORTUNITY

Source (ToList)

externalSalesPersonId

StandardforecastCategoryNameStandardSalesForecastCategoryCodeText

CustomopportunityObjectIDStandardObjectID

Note:
Pagination will be done based on this operation. 100 records per API Call.

4. QueryOpportunity

UpsertMarketoOpportunity is a very important step in syncing opportunities as opportunities
will appear on Marketo UI only if contact roles are synced. Without this operation, the
relationship between lead and opportunity is not defined.

One opportunity can be related to many contacts with different or same roles.

One opportunity will have only one primary contact and can be related to same contact
with multiple roles.

One opportunity can be related to contacts with or without roles. In cases where roles are
not defined in the SAP C4C side, those records will be skipped while creating the
opportunity role.

In an opportunity, for every contact role, there will be a new entry of opportunityrole
(Opportunity Info tab. See activities logs for further clarification at Marketo side.)

Note:
The required response data of queryOpportunity/$expand and queryLead will be stored in
toList[].

FileMapping

Field TypeMKTO - OPPORTUNITY

Role

Field TypeSource (ToList)

StandardisPrimaryStandardOpportunityPartyContact

MainIndicator

StandardexternalOpportunityIdStandardOpportunityId

StandardleadIdStandardLeadID

StandardroleStandardRoleCodeTest
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Usage Notes

In order to add new standard or custom fields to the integration, copy the required field to the
respective toList array, and proceed with mapping from the respective toList array to the
desired field.

In order to change or remove standard or custom fields from the integration, remove the
required field mapping and change or remove the field from the respective toList array.

SAP C4C Employee to Marketo Sales Person Data Sync

This section describes the recipe for the data sync between SAP Cloud for Customer Employee
business object and Marketo Sales Person business object.

SAP Cloud for Customer (C4C) is a cloud solution to manage customer sales, customer service,
and marketing activities efficiently and is one of the key SAP solutions to manage customer
relationships.

Marketo provides software platforms and technologies designed for marketing departments such
as account-based marketing, which includes email, mobile, social, digital ads, web management,
and analytics.

Business Use Case

The business purpose of this integration is to extract the SAP Cloud for Customer Employee
records and upsert them in Marketo as the records for Salesperson.
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Custom Fields

When the Employee object gets synced in Marketo, it needs to be created or updated with the
custom fields mentioned below.

CommentsOn SAP C4C

The custom field needs to be created for
Employee records in SAP C4C to hold the
Marketo Sales Person records id.

MKTOEmployeeID

Product Compatibility

The recipe is tested for SAP Cloud for Customer product version 1908.04.0006. Hence the recipe
is compatible to run for the tested and older versions of the product.

SAP C4C Employee to Marketo Sales Person Sync Flow

This integration "SAPC4CToMarketoSalesPersonDataSync" is designed to run for initial as well
as ongoing sync. As part of initial sync, all the employee records present in SAPC4Cwill be synced
to Marketo. On the other hand, as part of ongoing sync, the newly created or updated Employee
records will be synced to Marketo for the provided date range. Once the record is successfully
created in Marketo, it syncs back the Marketo Salesperson ID in the corresponding SAP C4C
Employee record (Custom Field: MKTOEmployeeID).

The following diagram represents creating a Salesperson in Marketo from an Employee in SAP
C4C:

Integration Cloud 6.6.0 477

9 Recipes



Operations Used

This recipe has a sub flow to handle the obsolete contact record in SAP C4C, that is,
updateDeletedSAPC4CContactsToMkto.

DescriptionApplicationOperation Name

Queries SAP C4C Employee.SAP C4CquerySAPC4CEmployees

Upserts Employee in Marketo as
SalesPerson records.

MarketoupsertMarketoSalesPerson

Once records are successfully
created in Marketo, it updates

SAP C4CpatchSAPC4CMultipleContact

Marketo SalesPerson ID in the
correspondingSAPC4Cemployee
record in the MKTOEmployeeID
custom field.

1. querySAPC4CEmployees
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Input Filter parameter

Filter to query records from SAPCondition

No filter required.IsInitialSync = True

ChangedOn ge datetimeoffset'%fromDateString%'IsInitialSync = False

Note:
Pagination is taken care in the recipe where it fetches 100 records per API Call.

2. upsertMarketoSalesPerson

Field Mapping

MKTO - SALES PERSONSAP - EMPLOYEE

StandardexternalSalesPersonIDStandardEmployeeID

StandardemailStandardEmail

StandardfaxStandardFaxNumber

StandardfirstNameStandardFirstName

StandardlastNameStandardLastName

StandardmobilePhoneStandardMobilePhoneNumber

StandardphoneStandardOfficePhoneNumber

StandardtitleStandardJobName

3. patchMultipleEmployee

Once Employee records are successfully created inMarketo as SalesPerson records, then update
Marketo SalesPerson ID to the corresponding SAP C4C employee record in the
MKTOEmployeeID custom field.

SAP - EMPLOYEEMKTO-SALESPERSON

CustomFieldMKTOEmployeeIDStandardID

StandardCountryCodeStandardCountryCode

StandardFirstNameStandardFirstName

StandardLastNameStandardLastName

StandardObjectIDStandardObjectID
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Usage Notes

In order to add new standard or custom fields to the integration, copy the required field and
add it to empList_NullMKTOID list and empList_WithMKTOID list while making the upsert
API call to Marketo.

In order to change or remove standard or custom fields from the integration, remove the
required field mapping and change or remove the field from empList_NullMKTOID list and
empList_WithMKTOID list while making the upsert API call to Marketo.
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Overview

Services are method-like units of logic that clients can invoke. Integration Cloud has an extensive
library of built-in services for performing common integration tasks such as transforming data
values, performing simple mathematical operations, and so on. Related services are grouped in
blocks. Input and output parameters are the names and types of fields that the service requires as
input and generates as output and these parameters are collectively referred to as a signature.

Built-In Services

Services will be invoked at run time and related services are grouped together. While creating an
Integration, you can sequence services and manage the flow of data among them.

Date Services

Use Date services to generate and format date values.

Pattern String Symbols -Many of theDate services require you to specify pattern strings describing
the data's current format and/or the format to which you want it converted. For services that
require a pattern string, use the symbols in the following table to describe the format of your data.
For example, to describe a date in the January 15, 1999 format, you would use the pattern string
MMMMM dd, yyyy. To describe the format 01/15/99, you would use the pattern string MM/dd/yy.

ExamplePresentationMeaningSymbol

ADTextera designatorG

1996 or 96Numberyeary

July or Jul or 07Text or Numbermonth in yearM

10Numberday in monthd

12Numberhour in am/pm (1-12)h

0Numberhour in day (0-23)H

30Numberminute in hourm

55Numbersecond in minutes

978NumbermillisecondS

Tuesday or TueTextday in weekE

189Numberday in yearD

2 (2nd Wed in July)Numberday of week in monthF

27Numberweek in yearw
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ExamplePresentationMeaningSymbol

2Numberweek in monthW

PMTextam/pm markera

24Numberhour in day (1-24)k

0Numberhour in am/pm (0-11)K

Pacific Standard Time or PST
or GMT-08:00

Texttime zonez

-0800 (offset from GMT/UT)NumberRFC 822 time zone (JVM1.4
or later)

Z

Delimiterescape for text'

'Literalsingle quote' '

Time Zones - When working with date services, you can specify time zones. The Earth is divided
into 24 standard time zones, one for every 15 degrees of longitude. Using the time zone including
Greenwich, England (known as Greenwich Mean Time, or GMT) as the starting point, the time is
increased by an hour for each time zone east of Greenwich and decreases by an hour for each time
zone west of Greenwich. The time difference between a time zone and the time zone including
Greenwich, England (GMT) is referred to as the raw offset.

The following table identifies the different time zones for the Earth and the raw offset for each
zone from Greenwich, England. The effects of daylight savings time are ignored in this table.

Note:
Greenwich Mean Time (GMT) is also known as Universal Time (UT).

NameRaw OffsetID

Midway Islands Time-11MIT

Hawaii Standard Time-10HST

Alaska Standard Time-9AST

Pacific Standard Time-8PST

Phoenix Standard Time-7PNT

Mountain Standard Time-7MST

Central Standard Time-6CST

Eastern Standard Time-5EST

Indiana Eastern Standard Time-5IET
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NameRaw OffsetID

Puerto Rico and U.S. Virgin Islands Time-4PRT

Canada Newfoundland Time-3.5CNT

Argentina Standard Time-3AGT

Brazil Eastern Time-3BET

Greenwich Mean Time0GMT

European Central Time+1ECT

Central Africa Time+2CAT

Eastern European Time+2EET

(Arabic) Egypt Standard Time+2ART

Eastern African Time+3EAT

Middle East Time+3.5MET

Near East Time+4NET

Pakistan Lahore Time+5PLT

India Standard Time+5.5IST

Bangladesh Standard Time+6BST

Vietnam Standard Time+7VST

China Taiwan Time+8CTT

Japan Standard Time+9JST

Australian Central Time+9.5ACT

Australian Eastern Time+10AET

Solomon Standard Time+11SST

New Zealand Standard Time+12NST

Examples - You can specify timezone input parameters in the following formats:

As a full name. For example:

America/Los_AngelesAsia/Tokyo

You can use the java.util.TimeZone.getAvailableIDs() method to obtain a list of the valid full name
time zone IDs that your JVM version supports.
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As a custom time zone ID, in the format GMT[+ | -]hh[ [:]mm]. For example:

All time zones 2 hours east of Greenwich (that is, Central Africa Time, Eastern
European Time, and Egypt Standard Time)

GMT+2:00

All time zones 3 hours west of Greenwich (that is, Argentina Standard Time
and Brazil Eastern Time)

GMT-3:00

All time zones 9.5 hours east of Greenwich (that is, Australian Central Time)GMT+9:30

As a three-letter abbreviation from the table above. For example:

Pacific Standard TimePST

Note:
Because some three-letter abbreviations can represent multiple time zones, for example, "CST"
could represent bothU.S. "Central Standard Time" and "China Standard Time", all abbreviations
are deprecated. Use the full name or custom time zone ID formats instead.

Notes on Invalid Dates - The dates you use with a date service must adhere to the
java.text.SimpleDateFormat class.

If you use an invalid date with a date service, the date service automatically translates the date to
a legal date. For example, if you specify 1999/02/30 as input, the date service interprets the date
as 1999/03/02 (two days after 2/28/1999).

If you use 00 for the month or day, the date service interprets 00 as the last month or day in the
Gregorian calendar. For example, if you specify 00 for the month, the date service interprets it as
12.

If the pattern yy is used for the year, the date service uses a 50-year moving window to interpret
the value of yy. The date service establishes the window by subtracting 49 years from the current
year and adding 50 years to the current year. For example, if you are running Integration Cloud
in the year 2000, the moving window would be from 1951 to 2050. The date service interprets
2-digit years as falling into this window (for example, 12 would be 2012, 95 would be 1995).

The following Date services are available:

DescriptionService

Calculates the difference between two dates and returns
the result as seconds, minutes, hours, and days.

calculateDateDifference

Compares two dates and returns the result as integer.compareDates

Returns the current time returned by the most precise
system timer, in nanoseconds.

currentNanoTime

Builds a date String using the specified pattern and the
specified date services.

dateBuild
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DescriptionService

Builds a date/time string using the specified pattern and
the specified date services.

dateTimeBuild

Converts date/time (represented as a String) string from
one format to another.

dateTimeFormat

Calculates the time elapsed between the current time and
the given time, in nanoseconds.

elapsedNanoTime

Formats a Date object as a string.formatDate

Returns the current date as a Date object.getCurrentDate

Returns the current date as a String in a specified format.getCurrentDateString

Increments a date by a specified period.incrementDate

calculateDateDifference
Calculates the difference between two dates and returns the result as seconds, minutes, hours,
and days.

Input Parameters

String Starting date and time.startDate

String Ending date and time.endDate

String Format in which the startDate parameter is to be specified (for
example, yyyyMMdd HH:mm:ss.SSS). For pattern-string notation, see
the “Pattern String Symbols” section.

startDatePattern

String Format in which the endDate parameter is to be specified (for
example, yyyyMMdd HH:mm:ss.SSS). For pattern-string notation, see
the “Pattern String Symbols” section.

endDatePattern

Output Parameters

StringThedifference between the startingDateTimeand endingDateTime,
truncated to the nearest whole number of seconds.

dateDifferenceSeconds

StringThedifference between the startingDateTimeand endingDateTime,
truncated to the nearest whole number of minutes.

dateDifferenceMinutes

StringThedifference between the startingDateTimeand endingDateTime,
truncated to the nearest whole number of hours.

dateDifferenceHours
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StringThedifference between the startingDateTimeand endingDateTime,
truncated to the nearest whole number of days.

dateDifferenceDays

Usage Notes

Each output value represents the same date difference, but in a different scale. Do not add these
values together. Make sure your subsequent Integration steps use the correct output, depending
on the scale required.

compareDates
Compares two dates and returns the result as an integer.

Input Parameters

String Starting date to compare against endDate.startDate

String Ending date to compare against startDate.endDate

String Format in which the startDate parameter is specified
(for example, yyyyMMddHH:mm:ss.SSS). For pattern-string
notation, see the "Pattern String Symbols" section.

startDatePattern

String Format inwhich the endDateparameter is specified (for
example, yyyyMMdd HH:mm:ss.SSS). For pattern-string
notation, see the "Pattern String Symbols" section.

endDatePattern

Output Parameters

StringCheckswhether startDate is before, the same, or after the endDate.result

Indicates that...A value of...

The startDate is after the endDate.+1

The startDate is the same as the
endDate.

0

The startDate is before the endDate.-1

Usage Notes

If the formats specified in the startDatePattern and endDatePattern parameters are different,
Integration Cloud takes the units that are not specified in the startDate and endDate values as 0.
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That is, if the startDatePattern is yyyyMMdd HH:mm and the startDate is 20151030 11:11 and if the
endDatePattern is yyyyMMdd HH:mm:ss.SSSand the endDate is 20151030 11:11:55:111, then the
compareDates service considers start date to be before the end date and will return the result as -1.

To calculate the difference between two dates, use the calculateDateDifference service.

currentNanoTime
Returns the current time returned by the most precise system timer, in nanoseconds.

Input Parameters

None.

Output Parameters

java.lang.Long Current time returned by the most precise system timer, in
nanoseconds.

nanoTime

dateBuild
Builds a date String using the specified pattern and the specified date services.

Input Parameters

String Pattern representing the format in which you want the date returned.
For pattern-string notation, see the “Pattern String Symbols” section. If you

pattern

do not specify pattern, dateBuild returns null. If pattern contains a time zone and
timezone is not specified, the default time zone is used.

String Optional. The year expressed in yyyy or yy format (for example, 01 or
2001). If you do not specify year or you specify an invalid value, dateBuild uses
the current year.

year

StringOptional. Themonth expressed as a number (for example, 1 for January,
2 for February). If you do not specify month or you specify an invalid value,
dateBuild uses the current month.

month

String Optional. The day of the month expressed as a number (for example,
1 for the first day of the month, 2 for the second day of the month). If you do

dayofmonth

not specify dayofmonth or you specify an invalid value, dateBuild uses the current
day.

String Optional. Time zone in which you want the output date and time
expressed. Specify a time zone code as shown in the “Time Zones” section,
for example, EST for Eastern Standard Time.

timezone
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If you do not specify timezone, the value of the server's "user timezone" property
is used. If this property has not been set, GMT is used.

String Optional. Locale in which the date is to be expressed. For example, if
locale is en (for English), the pattern EEE d MMM yyyywill produce Friday 23

locale

August 2002, and the locale of fr (for French) will produce vendredi 23 août
2002.

Output Parameters

String The date specified by year, month, and dayofmonth, in the format of
pattern.

value

dateTimeBuild
Builds a date/time string using the specified pattern and the specified date services.

Input Parameters

String Pattern representing the format in which youwant the time returned. For
pattern-string notation, see the “Pattern String Symbols” section. If you do not

pattern

specify pattern, dateTimeBuild returns null. If pattern contains a time zone and the
timezone parameter is not set, the default time zone is used.

String Optional. The year expressed in yyyy or yy format (for example, 01 or
2001). If you do not specify year or you specify an invalid value, dateTimeBuild uses
the current year.

year

String Optional. The month expressed as a number (for example, 1 for January,
2 for February). If you do not specify month or you specify an invalid value,
dateTimeBuild uses the current month.

month

String Optional. The day of the month expressed as a number (for example, 1
for the first day of the month, 2 for the second day of the month). If you do not

dayofmonth

specify dayofmonth or you specify an invalid value, dateTimeBuild uses the current
day.

String Optional. The hour expressed as a number based on a 24-hour clock. For
example, specify 0 for midnight, 2 for 2:00 A.M., and 14 for 2:00 P.M. If you do

hour

not specify hour or you specify an invalid value, dateTimeBuild uses 0 as the hour
value.

StringOptional. Minutes expressed as a number. If you do not specifyminute or
you specify an invalid value, dateTimeBuild uses 0 as the minute value.

minute

String Optional. Seconds expressed as a number. If you do not specify second or
you specify an invalid value, dateTimeBuild uses 0 as the second value.

second
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StringOptional. Milliseconds expressed as a number. If you do not specifymillis
or you specify an invalid value, dateTimeBuild uses 0 as the millis value.

millis

String Optional. Time zone in which you want the output date and time
expressed. Specify a time zone code as shown in the “Time Zones” section, for
example, EST for Eastern Standard Time.

timezone

If you do not specify timezone, the value of the server's "user timezone" property
is used. If this property has not been set, GMT is used.

StringOptional. Locale inwhich the date is to be expressed. For example, if locale
is en (for English), the pattern EEE d MMM yyyywill produce Friday 23 August
2002, and the locale of fr (for French) will produce vendredi 23 août 2002.

locale

Output Parameters

String Date and time in format of pattern.value

dateTimeFormat
Converts date/time (represented as a String) string from one format to another.

Input Parameters

String Date/time that you want to convert.inString

Important:
If inString contains a character in the last position, that character is
interpreted as 0. This can result in an inaccurate date. For information
about invalid dates, see the “Notes on Invalid Dates” section.

String Pattern string that describes the format of inString. For pattern-string
notation, see the “Pattern String Symbols” section.

currentPattern

String Pattern string that describes the format in which you want inString
returned. For pattern-string syntax, see the “Pattern String Symbols” section.

newPattern

StringOptional. Locale in which the date is to be expressed. For example, if
locale is en (for English), the pattern EEE d MMM yyyywill produce Friday 23

locale

August 2002, and the locale of fr (for French) will produce vendredi 23 août
2002.

String Optional. A flag indicating whether an exception will appear if the
inString value does not adhere to the format specified in currentPattern
parameter. Set to:

lenient

true to perform a lenient check. This is the default.
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In a lenient check, if the format of the date specified in the inString
parameter does not match the format specified in the currentPattern
parameter, the date in the format specified in the currentPatternparameter
will be interpreted and returned. If the interpretation is incorrect, the
service will return an invalid date.

false to perform a strict check.

In a strict check, an exception will appear if the format of the date
specified in the inString parameter does not match the format specified
in the currentPattern parameter.

Output Parameters

String The date/time given by inString, in the format of newPattern.value

Usage Notes

As described in the “Notes on Invalid Dates" section, if the pattern yy is used for the year,
dateTimeFormat uses a 50-year moving window to interpret the value of the year.

If currentPattern does not contain a time zone, the value is assumed to be in the default time zone.

If newPattern contains a time zone, the default time zone is used.

elapsedNanoTime
Calculates the time elapsed between the current time and the given time, in nanoseconds.

Input Parameters

java.lang.Long Time in nanoseconds. If nanoTime is less than zero, then
the service treats it as zero.

nanoTime

Output Parameters

java.lang.Long The difference between the current time in nanoseconds
and nanoTime. If nanoTime is greater than the current nano time, the service
returns zero.

elapsedNanoTime

String The difference between the current time in nanoseconds and
nanoTime. The difference is expressed as a String, in this format:

elapsedNanoTimeStr

[years] [days] [hours] [minutes] [seconds] [millisec] [microsec] <nanosec>

If nanoTime is greater than the current nano time, the service returns zero.
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formatDate
Formats a Date object as a string.

Input Parameters

java.util.Date Optional. Date/time that you want to convert.date

String Pattern string that describes the format in which you want the date
returned. For pattern-string notation, see the Pattern String Symbols section.

pattern

String Optional. Time zone in which you want the output date and time
expressed. Specify a time zone code as shown in the Time Zones section, for
example, EST for Eastern Standard Time.

timezone

If you do not specify timezone, the user's time zone is used, else GMT is used.

String Optional. Locale in which the date is to be expressed. For example, if
locale is en (for English), the pattern EEE d MMM yyyywill produce Friday 23

locale

August 2002, and the locale of fr (for French) will produce vendredi 23 août
2002.

Output Parameters

String The date/time given by date in the format specified by pattern.value

getCurrentDate
Returns the current date as a Date object.

Input Parameters

None.

Output Parameters

java.util.Date Current date.date

getCurrentDateString
Returns the current date as a String in a specified format.
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Input Parameters

String Pattern representing the format in which you want the date returned.
For pattern-string notation, see the “Pattern String Symbols” section.

pattern

String Optional. Time zone in which you want the output date and time
expressed. Specify a time zone code as shown in the “Time Zones” section, for
example, EST for Eastern Standard Time.

timezone

If you do not specify timezone, the value of the server's "user timezone" property
is used. If this property has not been set, GMT is used.

String Optional. Locale in which the date is to be expressed. For example, if
locale is en (for English), the pattern EEE d MMM yyyywill produce Friday 23

locale

August 2002, and the locale of fr (for French) will produce vendredi 23 août
2002.

Output Parameters

String Current date in the format specified by pattern.value

incrementDate
Increments a date by a specified amount of time.

Input Parameters

String Starting date and time.startDate

String Format inwhich the startDate parameter is specified (for
example, yyyyMMdd HH:mm:ss.SSS). For pattern-string
notation, see the "Pattern String Symbols" section.

startDatePattern

StringOptional. Pattern representing the format in which you
want the endDate to be returned. For pattern-string notation,
see the "Pattern String Symbols" section.

endDatePattern

If no endDatePattern is specified, the endDatewill be returned
in the format specified in the startDatePattern parameter.

StringOptional. Number of years to add to startDate. The value
must be an integer between -2147483648 and 2147483647.

addYears

String Optional. Number of months to add to startDate. The
valuemust be an integer between -2147483648 and 2147483647.

addMonths
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StringOptional. Number of days to add to startDate. The value
must be an integer between -2147483648 and 2147483647.

addDays

StringOptional. Number of hours to add to startDate. The value
must be an integer between -2147483648 and 2147483647.

addHours

String Optional. Number of minutes to add to startDate. The
valuemust be an integer between -2147483648 and 2147483647.

addMinutes

String Optional. Number of seconds to add to startDate. The
valuemust be an integer between -2147483648 and 2147483647.

addSeconds

String Optional. Number of milliseconds to add to startDate.
The value must be an integer between -2147483648 and
2147483647.

addMilliSeconds

String Optional. Time zone in which you want the endDate to
be expressed. Specify a time zone code, for example, EST for
Eastern Standard Time.

timezone

If you do not specify timezone, the value of the server's "user
timezone" property is used. If this property has not been set,
GMT is used.

StringOptional. Locale inwhich the endDate is to be expressed.
For example, if locale is en (for English), the pattern EEE d MMM

locale

yyyywill produce Friday 23 August 2002, and the locale of fr
(for French) will produce vendredi 23 août 2002.

Output Parameters

String The end date and time, calculated by
incrementing the startDatewith the specified

endDate

years, months, days, hours, minutes, seconds,
and/or milliseconds. The endDatewill be in the
endDatePattern format, if specified. If no
endDatePattern is specified or if blank spaces are
specified as the value, the endDatewill be
returned in the format specified in the
startDatePattern parameter.

Usage Notes

The addYears, addMonths, addDays, addHours, addMinutes, addSeconds, and addMilliSeconds input
parameters can take positive or negative values. For example, If startDate is 10/10/2001,
startDatePattern is MM/dd/yyyy, addYears is 1, and addMonths is -1, endDatewill be 09/10/2002.
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If you specify only the startDate, startDatePattern, and endDatePattern input parameters and do not
specify any of the optional input parameters to increment the period, the incrementDate service just
converts the format of startDate from startDatePattern to endDatePattern and returns it as endDate.

Note:

The format of the date specified in the startDate parameter must match the format specified in
the startDatePattern and the format of the date specified in the endDate parameter must match
the endDatePattern format.

Document Services

Use Document services to perform operations on documents.

The following Document services are available:

DescriptionService

Searches a set of documents for entries matching a set of
Criteria.

findDocuments

Inserts a new document in a set of documents at a specified
position.

insertDocument

Deletes the specified documents from a set of documents.deleteDocuments

Constructs a document from a document list by generating
key/value pairs from the values of two elements that you
specify in the document list.

documentListToDocument

Expands the contents of a document into a list of documents.documentToDocumentList

Each key/value pair in the source document is transformed
to a single document containing two keys (whose names
you specify). These two keys will contain the key name and
value of the original pair.

Groups a set of documents based on specified criteria.groupDocuments

Converts a document to an array of bytes.documentToBytes

Converts an array of bytes to a document.bytesToDocument

Searches a set of documents for entries matching a set of
Criteria.

searchDocuments

Sorts a set of input documents based on the specified
sortCriteria.

sortDocuments
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findDocuments
Searches a set of documents for entries matching a set of criteria.

Input Parameters

Document List Set of documents fromwhich the documentsmeeting the retrieve
criteria are to be returned.

documents

Document Criteria on which the documents in the documents parameter are to
be matched. Parameters for matchCriteria are:

matchCriteria

path: Name of the element in documentListwhose value provides the value for
the search text. The value for key can be a path expression. For example,
"Family/Chidren[0]/ BirthDate" retrieves the birthday of the first child from the
input Family document list.

compareValueAs: Optional. Allowed values are string, numeric, and datetime.
The default value is string.

datePattern: Optional. Pattern will be considered only if compareValueAs is of
type datetime. Default value is MM/dd/yyyy hh:mm:ss a.

joins: List of join criteria. Each join criteria consists of:

operator: Allowed values are equals, doesNotEqual, greaterThan,
greaterThanEqual, lessThan, lessThanEqual, equalsIgnoreCase, contains,
doesNotContain, beginsWith, doesNotBeginWith, endsWith, doesNotEndWith.

value: Optional. Allowed values are string, numeric, and datetime. The default
value is string.

joinType: Specifies the way two joins can be linked. Values are “and” or “or”.
Default value is “and”.

Output Parameters

Document List List of documents that match the retrieve criteria.result documents

insertDocument
Inserts a new document in a set of documents at a specified position.

Input Parameters

Document List Set of documents inwhich a newdocument is to be inserted.documents
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DocumentThenewdocument to be inserted to the set of documents specified
in the documents parameter.

insertDocument

String Optional. The position in the seat which the document is to be
inserted.

index

The index parameter is zero-based. if the value for the index parameter is not
specified, the document will be inserted at the end of the document list
specified in the documents parameter.

Output Parameters

Document List Document list after inserting the new document.documents

deleteDocuments
Deletes the specified documents from a set of documents.

Input Parameters

Document List Set of documents that contain the documents you want to
delete.

documents

String List Index values of documents to be deleted from the documents
parameter document list.

indices

Output Parameters

Document List List of documents whose indices do notmatch the values
in indices parameter.

documents

Document List List of deleted documents.deletedDocuments

Usage Notes

The deleteDocuments service returns an error if the indices parameter value is less than zero or more
than the number of documents in the documents input parameter.

documentListToDocument
Constructs a document from a document list by generating key/value pairs from the values of two
elements that you specify in the document list.
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Input Parameters

Document List Set of documents that you want to transform into a single
document.

documentList

Note:
If the documentList parameter contains a single document instead of a
Document List, the documentListToDocument service does nothing.

StringNameof the element in the documentListparameterwhose value provides
the name of each key in the resulting document.

name

Important:
The data type of the element that you specify in the name parameter must
be String.

StringName of the element in the documentList parameter whose values will
be assigned to the keys specified in name. This element can be of any data type.

value

Output Parameters

Document Document containing the key/value pairs generated from the
documentList parameter.

document

Usage Notes

The following example illustrates how the documentListToDocument servicewould convert a document
list that contains three documents to a single document containing three key/value pairs. When
you use the documentListToDocument service, you specify which two elements from the source list
are to be transformed into the keys and values in the output document. In the following example,
the values from the pName elements in the source list are transformed into key names, and the
values from the pValue elements are transformed into the values for these keys.

A documentList containing these three documents:

ValueKey

cx_timeoutpName

1000pValue

ValueKey

cx_maxpName

2500pValue
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ValueKey

cx_minpName

10pValue

Would be converted to a document containing these three key:

ValueKey

1000cx_timeout

2500cx_max

10cx_min

documentToDocumentList
Expands the contents of a document into a list of documents.

Each key/value pair in the source document is transformed to a single document containing two
keys (whose names you specify). These two keys will contain the key name and value of the
original pair.

Input Parameters

Document Document to transform.document

StringName to assign to the key that will receive the key name from the
original key/value pair. In the example above, this parameter was set to pName.

name

StringName to assign to the key that will receive the value from the original
key/value pair. In the example above, this parameter was set to pValue.

value

Output Parameters

Document List List containing a document for each key/value pair in the
document parameter. Each document in the list will contain two keys, whose

documentList

names were specified by the name and value parameters. The values of these
two keys will be the name and value (respectively) of the original pair.

Usage Notes

The following example shows how a document containing three keys would be converted to a
document list containing three documents. In this example, the names pName and pValue are
specified as names for the two new keys in the document list.

Integration Cloud 6.6.0 499

10 Built-In Services



A document containing these three keys:

ValueKey

1000cx_timeout

2500cx_max

10cx_min

Would be converted to a document list containing these three documents:

ValueKey

cx_timeoutpName

1000pValue

ValueKey

cx_maxpName

2500pValue

ValueKey

cx_minpName

10pValue

groupDocuments
Groups a set of documents based on specified criteria.

Input Parameters

Document List Set of documents to be grouped based on the specified
criteria.

documents

Document ListThe criteria onwhich the input documents are to be grouped.
Valid values for the groupCriteria parameter are:

groupCriteria

key. Key in the pipeline. The value for key can be a path expression. For
example, "Family/Chidren[0]/BirthDate" retrieves the birthday of the
first child from the input Family document list.

compareStringsAs. Optional. Valid values for compareStringsAs are string,
numeric, and datetime. The default value is string.
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pattern. Optional. patternwill be considered only if the compareStringsAs
parameter is of type datetime.

Note:
If key is not found in all the input documents, the documents that do
not match the groupCriteria are grouped together as a single group.

Output Parameters

Document List List of documents where each element represents a set of
documents grouped based on the criteria specified.

documentGroups

Usage Notes

The following example illustrates how to specify the values for the groupCriteria parameter:

patterncompareStringsAskey

stringname

numericage

yyyy-MM-dddatetimebirthdate

The input documents will be grouped based on name, age, and birth date.

documentToBytes
Converts a document to an array of bytes.

Input Parameters

Document Document to convert to bytes.document

If document is null, the service does not return an output or an error
message.

If document is not a document, the service throws an exception.

If document contains no elements, the service produces a zero-length byte
array.

Output Parameters

ObjectAserialized representation of the document as an array of bytes (byte[]).documentBytes
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Usage Notes

Use the documentToBytes service with the bytesToDocument service, which converts the byte
array created by this service back into the original document.

The documentToBytes service is useful when you want to write a document to a file, an input
stream, or a cache.

In order for the document-to-bytes-to-document conversion to work, the entire content of the
document must be serializable. Every object in the document must be of a data type known to
Integration Cloud, or it must support the java.io.Serializable interface. If Integration Cloud
encounters an unknown object in the document that does not support the java.io.Serializable
interface, that object's value will be lost. Integration Cloud will replace it with a string containing
the object's class name.

bytesToDocument
Converts an array of bytes to a document. This service can only be used with byte arrays created
by executing the documentToBytes service.

Input Parameters

Object An array of bytes (byte[]) to convert to a document.documentBytes

If documentBytes is null, the service does not return a document or an
error message.

If documentBytes is not a byte array, the service throws an exception.

If documentBytes is zero-length, the service produces an empty document.

Output Parameters

Document A document.document

Usage Notes

Use this service with the documentToBytes service, which converts a document into a byte array.
You can pass the resulting byte array to the bytesToDocument service to convert it back into the
original document.

In order for the document-to-bytes-to-document conversion to work, the entire content of the
document must be serializable. Every object in the document must be of a data type known to
Integration Cloud, or it must support the java.io.Serializable interface.

Note:
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If Integration Cloud encounters an unknown object in the document that does not support the
java.io.Serializable interface, that object's value will be lost. It will be replaced with a string
containing the object's class name.

searchDocuments
Searches a set of documents for entries matching a set of Criteria.

Input Parameters

Document List Set of documents from which the documents meeting the
search criteria are to be returned.

documents

Document Criteria on which the documents in the documents parameter
are to be searched.

searchCriteria

Valid values for searchCriteria parameters are:

key. Name of the element in documentList whose value provides the
value for the search text. The value for key can be a path expression.
For example, "Family/Chidren[0]/BirthDate" retrieves the birthday of
the first child from the input Family document list.

value. Optional. Any search text. If no value is specified, the service
searches for null in the document list.

compareStringsAs. Optional. Allowed values are string, numeric, and
datetime. The default value is string.

pattern. Optional. patternwill be considered only if the compareStringsAs
value is of type datetime. For information about using patterns, see
the Time Zones section.

StringOptional. The value of the sorted parameter is true if the document
list is already sorted based on the search criteria and same search key;
otherwise false.

sorted

If the value for the sorted parameter is set to true, the required documents
are searched faster.

Output Parameters

Document ListList of documentswhich arematching the search criteria.resultdocuments

String List Positions of search documents in the document list.documentListIndices

Document List List of documents that were input.documents
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Usage Note

For example, if you want to search a set of documents for documents where BirthDate is 10th
January 2008, the values for the searchCriteria parameter would be:

patterncompareStringsAsvaluekey

yyyy-MM-dddatetime2008-01-10Birthdate

sortDocuments
Sorts a set of input documents based on the specified sortCriteria.

Input Parameters

Document List Set of documents that are to be sorted.documents

Document List Criteria based on which the documents in the documents
parameter are to be sorted.

sortCriteria

Valid values for sortCriteria parameters are:

key. Name of the element in documentList whose value provides the value
based on which the documents are to be sorted. The value for key can be a
path expression. For example, "Family/Chidren[0]/BirthDate" retrieves
the birthday of the first child from the input Family document list.

order. Optional. Allowed values are ascending and descending. The default
value is ascending.

compareStringsAs. Optional. Allowed values are string, numeric, and
datetime. Default value is string.

pattern. Optional. The value for patternwill be considered only if the
compareStringsAs value is of type datetime.

Note:
If key is not found in all the input documents, the sorted list of documents
appears at the end or start of the list based on the order specified. If the
order is ascending, then all the documents that do not match the sort
criteria appears at the top of the list, followed by the sorted list. If the
order is descending, the sorted list will appear at the top, followed by
the documents that do not match the sort criteria.
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Output Parameters

Document List The documents sorted based on the sort criteria specified in
the sortCriteria parameter.

documents

Usage Notes

For example, if you want to sort a set of documents based on name, age, and then on birth date,
the values for sortCriteria parameter would be:

patterncompareStringsAsorderkey

stringascendingName

numericdescendingAge

yyyy-MM-dddatetimeascendingBirthdate

List Services

Use List services to retrieve, replace, or add elements in an Object List, Document List, or String
List, including converting String Lists to Document Lists.

The following List services are available:

DescriptionService

Adds an item or a list of items to a java.util.Vector object.addItemToVector

Adds documents to a document list.appendToDocumentList

Adds Strings to a String list.appendToStringList

Returns the number of elements in a list.sizeOfList

Converts a String list to a document list.stringListToDocumentList

Converts a java.util.Vector object to an array.vectorToArray

addItemToVector
Adds an item or a list of items to a java.util.Vector object.
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Input Parameters

java.util.Vector Optional. The vector object to which you want to add
an item or list of items. If no value is specified, the service creates a new
java.util.Vector object to which the item(s) will be added.

vector

Object Optional. Item to be added to the vector object.item

Note:
You can use either item or itemList to specify the input object. If both
item and itemList input parameters are specified, the item as well as
the list of items will be added to the vector object.

Object[ ] Optional. List of items to be added to the vector object.itemList

StringOptional. Specifies whether a null item can be added to the vector
object. Set to:

addNulls

false to prevent null values from being added to the vector object.
This is the default.

true to allow null values to be added to the vector object.

Output Parameters

java.util.Vector Updated vector object with the list of items added or an
empty vector in case no items are added.

vector

Usage Notes

Either of the optional input parameters, item or itemList, is required.

appendToDocumentList
Adds documents to a document list.

Input Parameters

Document ListOptional. List to which you want to append documents.
If you do not specify toList, the service creates a new list.

toList

Document List Optional. Documents you want to append to the end of
toList.

fromList
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DocumentOptional. Document you want to append to the end of toList.
If you specify both fromList and fromItem, the service adds the document
specified in fromItem after the documents in fromList.

fromItem

Output Parameters

Document List The toList document list with the documents in fromList
and fromItem appended to it.

toList

Usage Notes

The documents contained in fromList and fromItem are not actually appended as entries to toList.
Instead, references to the documents in fromList and fromItem are appended as entries to toList.
Consequently, any changesmade to the documents in fromList and fromItem also affect the resulting
toList.

appendToStringList
Adds Strings to a String list.

Input Parameters

String List Optional. List to which you want to append Strings. If the
value of toList is null, a null pointer exception error is thrown. If you do
not specify toList, the service creates a new list.

toList

String List Optional. List of Strings to add to toList. Strings are added
after the entries of toList.

fromList

String Optional. String you want to append to the end of toList. If you
specify both fromList and fromItem, the service adds the String specified
in fromItem after the Strings specified in fromList.

fromItem

Output Parameters

String ListThe toList String listwith the Strings from fromList and fromItem
appended to it.

toList

Usage Notes

The Strings contained in fromList and fromItem are not actually appended as entries to toList. Instead,
references to the Strings in fromList and fromItem are appended as entries to toList. Consequently,
any changes made to the Strings in fromList and fromItem also affect the resulting toList.
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sizeOfList
Returns the number of elements in a list.

Input Parameters

Document List, String List, or Object ListOptional. List whose size you
want to discover. If fromList is not specified, the service returns a size of
0.

fromList

Output Parameters

StringNumber of entries in fromList.size

Document List, String List, or Object List Original list.fromList

Usage Notes

For example, if fromList consists of:

fromList[0] = "a"

fromList[1] = "b"

fromList[2] = "c"

The result would be:

size="3"

stringListToDocumentList
Converts a String list to a document list.

Input Parameters

String ListOptional. List of Strings (a String[ ]) that you want to convert
to a list of documents. If fromList is not specified, the service returns a
zero length array for toList.

fromList

String Optional. Key name to use in the generated document list.key

Output Parameters

Document List Resulting document list.toList
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Usage Notes

Creates a document list containing one document for each element in the fromList. Each document
will contain a single String element named key.

For example, if fromList consists of:

fromList[0] = "a"

fromList[1] = "b"

fromList[2] = "c"

key = "myKey"

The result would be:

vectorToArray
Converts a java.util.Vector object to an array.

Input Parameters

java.util.Vector The object to be converted to an array.vector

String Optional. If this option is specified, the service expects all items
in the vector to have the same Java type as the first non-null item in the
vector. If the service detects an item of a different type, an error appears.

stronglyType

Set to:

false to convert the vector to an object array. This is the default.

true to convert the vector to a strongly typed array holding the same
type of objects.

Output Parameters

Object[ ] Converted object array.array
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Math Services

Use Math services to perform mathematical operations on string-based numeric values. Services
that operate on integer values use Java's long data type (64-bit, two's complement). Services that
operate on float values use Java's double data type (64-bit IEEE 754). If extremely precise calculations
are critical to your application, you shouldwrite your own Java services to performmath functions.

The following Math services are available:

DescriptionService

Adds one java.lang.Number object to another and returns the
sum.

addObjects

Divides one java.lang.Number object by another (num1/num2)
and returns the quotient.

divideObjects

Returns the smallest number from a list of numbers.min

Multiplies one java.lang.Number object by another and returns
the product.

multiplyObjects

Subtracts one java.lang.Number object from another and returns
the difference.

subtractObjects

Converts a string to numeric data type.toNumber

Returns the absolute value of the input number.absoluteValue

Adds a list of floating point numbers (represented in a string list)
and returns the sum.

addFloatList

Adds one floating point number (represented as a String) to
another and returns the sum.

addFloats

Adds a list of integers (represented in a String list) and returns
the sum.

addIntList

Adds one integer (represented as a String) to another and returns
the sum.

addInts

Divides one floating point number (represented as a String) by
another (num1/num2) and returns the quotient.

divideFloats

Divides one integer (represented as a String) by another
(num1/num2) and returns the quotient.

divideInts

Returns the largest number from a list of numbers.max

Multiplies a list of floating point numbers (represented in a String
list) and returns the product.

multiplyFloatList
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DescriptionService

Multiples one floating point number (represented as String) by
another and returns the product.

multiplyFloats

Multiplies a list of integers (represented in a String list) and
returns the product.

multiplyIntList

Multiplies one integer (represented as a String) by another and
returns the product.

multiplyInts

Returns the next pseudorandom, uniformly distributed double
between 0.0 and 1.0.

randomDouble

Returns a rounded number.roundNumber

Subtracts one floating point number (represented as a String)
from another and returns the difference.

subtractFloats

Subtracts one integer (represented as a String) from another and
returns the difference.

subtractInts

addObjects
Adds one java.lang.Number object to another and returns the sum.

Input Parameters

java.lang.NumberNumber to add. See the Usage Notes for supported sub-classes.num1

java.lang.NumberNumber to add. See the Usage Notes for supported sub-classes.num2

Output Parameters

java.lang.Number Sum of the numeric values of num1 and num2.value

Usage Notes

This service accepts the following sub-classes of java.lang.Number: java.lang.Byte, java.lang.Double,
java.lang.Float, java.lang.Integer, java.lang.Long, java.lang.Short.

This service applies the following rules for binary numeric promotion to the operands in order:

If either operand is of type Double, the other is converted to Double.

Otherwise, if either operand is of type Float, the other is converted to Float.

Otherwise, if either operand is of type Long, the other is converted to Long.
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Otherwise, both operands are converted to type Integer.

These promotion rules mirror the Java rules for numeric promotion of numeric types.

divideObjects
Divides one java.lang.Number object by another (num1/num2) and returns the quotient.

Input Parameters

java.lang.NumberNumber that is the dividend. See the Usage Notes for supported
sub-classes.

num1

java.lang.NumberNumber that is the divisor. See the Usage Notes for supported
sub-classes.

num2

Output Parameters

java.lang.Number Quotient of num1 / num2.value

Usage Notes

This service accepts the following sub-classes of java.lang.Number: java.lang.Byte, java.lang.Double,
java.lang.Float, java.lang.Integer, java.lang.Long, java.lang.Short.

This service applies the following rules for binary numeric promotion to the operands in order:

If either operand is of type Double, the other is converted to Double.

Otherwise, if either operand is of type Float, the other is converted to Float.

Otherwise, if either operand is of type Long, the other is converted to Long.

Otherwise, both operands are converted to type Integer.

These promotion rules mirror the Java rules for numeric promotion of numeric types.

min
Returns the smallest number from a list of numbers.

Input Parameters

String List List of numbers from which the smallest number is to be returned.numList
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Output Parameters

String Smallest number from the list of numbers.minValue

multiplyObjects
Multiplies one java.lang.Number object by another and returns the product.

Input Parameters

java.lang.NumberNumber to multiply. See the Usage Notes for supported
sub-classes.

num1

java.lang.NumberNumber to multiply. See the Usage Notes for supported
sub-classes.

num2

Output Parameters

java.lang.Number Product of num1 and num2.value

Usage Notes

This service accepts the following sub-classes of java.lang.Number: java.lang.Byte, java.lang.Double,
java.lang.Float, java.lang.Integer, java.lang.Long, java.lang.Short.

This service applies the following rules for binary numeric promotion to the operands in order:

If either operand is of type Double, the other is converted to Double.

Otherwise, if either operand is of type Float, the other is converted to Float.

Otherwise, if either operand is of type Long, the other is converted to Long.

Otherwise, both operands are converted to type Integer.

These promotion rules mirror the Java rules for numeric promotion of numeric types.

subtractObjects
Subtracts one java.lang.Number object from another and returns the difference.

Input Parameters

java.lang.NumberNumber. See the Usage Notes for supported sub-classes.num1
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java.lang.NumberNumber to subtract from num1. See the UsageNotes for supported
sub-classes.

num2

Output Parameters

java.lang.Number Difference of num1 - num2.value

Usage Notes

This service accepts the following sub-classes of java.lang.Number: java.lang.Byte, java.lang.Double,
java.lang.Float, java.lang.Integer, java.lang.Long, java.lang.Short.

This service applies the following rules for binary numeric promotion to the operands. The following
rules are applied in order:

If either operand is of type Double, the other is converted to Double.

Otherwise, if either operand is of type Float, the other is converted to Float.

Otherwise, if either operand is of type Long, the other is converted to Long.

Otherwise, both operands are converted to type Integer.

These promotion rules mirror the Java rules for numeric promotion of numeric types.

toNumber
Converts a string to numeric data type.

Input Parameters

StringNumber (represented as a string) to be converted to numeric format.num

StringOptional. Specifies the Java numeric data type to which the num parameter
is to be converted.

convertAs

Valid values for the convertAs parameter are java.lang.Double, java.lang.Float,
java.lang.Integer,java.math.BigDecimal,java.math.BigInteger, java.lang.Long.
The default value is java.lang.Double.

Output Parameters

java.lang.Number Converted numeric object.num
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absoluteValue
Returns the absolute value of the input number.

Input Parameters

StringNumber whose absolute value is to be returned.num

Output Parameters

String Absolute value of the input number.positiveNumber

addFloatList
Adds a list of floating point numbers (represented in a string list) and returns the sum.

Input Parameters

String ListNumbers (floating point numbers represented in a string list) to add.numList

Output Parameters

String Sum of the numbers in numList. If a sum cannot be produced, value contains
one of the following:

value

DescriptionValue

The computation produces a positive value that overflows the
representable range of a float type.

Infinity

The computation produces a negative value that overflows the
representable range of a float type.

-Infinity

The computation produces a value that underflows the representable
range of a float type (for example, adding a number to infinity).

0.0

The computation produces a value that cannot be represented as a
number (for example, any operation that uses NaN as input, such as
10.0 + NaN = NaN).

NaN

Usage Notes

Make sure the strings that are passed to the service in numList are in a locale-neutral format (that
is, using the pattern -####.##). Passing locally formatted strings may result in unexpected results.
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For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will result in
the value 357, not 3.57 or 3,57.

addFloats
Adds one floating point number (represented as a String) to another and returns the sum.

Input Parameters

StringNumber to add.num1

StringNumber to add.num2

String Optional. Number of decimal places to which the sum will be rounded. The
default value is null.

precision

Output Parameters

String Sum of the numbers in num1 and num2. If a sum cannot be produced, value
contains one of the following:

value

DescriptionValue

The computation produces a positive value that overflows the
representable range of a float type.

Infinity

The computation produces a negative value that overflows the
representable range of a float type.

-Infinity

The computation produces a value that underflows the representable
range of a float type (for example, adding a number to infinity).

0.0

The computation produces a value that cannot be represented as a
number (for example, any operation that uses NaN as input, such as
10.0 + NaN = NaN).

NaN

Usage Notes

Make sure the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

addIntList
Adds a list of integers (represented in a String list) and returns the sum.
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Input Parameters

String ListNumbers (integers represented as Strings) to add.numList

Output Parameters

String Sum of the numbers in numList.value

Usage Notes

Make sure the strings that are passed to the service in numList are in a locale-neutral format (that
is, using the pattern -####.##). Passing locally formatted strings may result in unexpected results.
For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will result in
the value 357, not 3.57 or 3,57.

addInts
Adds one integer (represented as a String) to another and returns the sum.

Input Parameters

StringNumber (integer represented as a String) to add.num1

StringNumber (integer represented as a String) to add.num2

Output Parameters

String Sum of num1 and num2.value

Usage Notes

Ensure that the result of your calculation is less than 64 bits in width (the maximumwidth for the
long data type). If the result exceeds this limit, it will generate a data overflow.

Ensure that the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

divideFloats
Divides one floating point number (represented as a String) by another (num1/num2) and returns
the quotient.
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Input Parameters

StringNumber (floating point number represented as a String) that is the dividend.num1

StringNumber (floating point number represented as a String) that is the divisor.num2

String Optional. Number of decimal places to which the quotient will be rounded.
The default value is null.

precision

Output Parameters

String The quotient of num1 / num2. If a quotient cannot be produced, value contains
one of the following:

value

DescriptionValue

The computation produces a positive value that overflows the
representable range of a float type.

Infinity

The computation produces a negative value that overflows the
representable range of a float type.

-Infinity

The computation produces a value that underflows the representable
range of a float type (for example, dividing a number by infinity).

0.0

The computation produces a value that cannot be represented as a
number (for example, the result of an illegal operation such as dividing

NaN

zero by zero or any operation that uses NaN as input, such as 10.0 +
NaN = NaN).

Usage Notes

Make sure the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

divideInts
Divides one integer (represented as a String) by another (num1/num2) and returns the quotient.

Input Parameters

StringNumber (integer represented as a String) that is the dividend.num1

StringNumber (integer represented as a String) that is the divisor.num2
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Output Parameters

String The quotient of num1 / num2.value

Usage Notes

Make sure the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

max
Returns the largest number from a list of numbers.

Input Parameters

String List List of numbers from which the largest number is to be returned.numList

Output Parameters

String Largest number from the list of numbers.maxValue

multiplyFloatList
Multiplies a list of floating point numbers (represented in a String list) and returns the product.

Input Parameters

String ListNumbers (floating point numbers represented as Strings) to multiply.numList

Output Parameters

String Product of the numbers in numlist. If a product cannot be produced, value
contains one of the following:

value

DescriptionValue

The computation produces a positive value that overflows the
representable range of a float type.

Infinity
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The computation produces a negative value that overflows the
representable range of a float type.

-Infinity

The computation produces a value that underflows the representable
range of a float type (for example, multiplying a number by infinity).

0.0

The computation produces a value that cannot be represented as a
number (for example, the result of an illegal operation such as

NaN

multiplying zero by zero or any operation that usesNaN as input, such
as 10.0 + NaN = NaN).

Usage Notes

Make sure the strings that are passed to the service in numList are in a locale-neutral format (that
is, using the pattern -####.##). Passing locally formatted strings may result in unexpected results.
For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will result in
the value 357, not 3.57 or 3,57.

multiplyFloats
Multiples one floating point number (represented as String) by another and returns the product.

Input Parameters

StringNumber (floating point number represented as a String) to multiply.num1

StringNumber (floating point number represented as a String) to multiply.num2

StringOptional. Number of decimal places to which the product will be rounded.
The default value is null.

precision

Output Parameters

String Product of the numeric values of num1 and num2. If a product cannot be
produced, value contains one of the following:

value

DescriptionValue

The computation produces a positive value that overflows the
representable range of a float type.

Infinity

The computation produces a negative value that overflows the
representable range of a float type.

-Infinity

The computation produces a value that underflows the representable
range of a float type (for example,multiplying a number by infinity).

0.0
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The computation produces a value that cannot be represented as a
number (for example, the result of an illegal operation such as

NaN

multiplying zero by zero or any operation that uses NaN as input,
such as 10.0 + NaN = NaN).

Usage Notes

Make sure the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

multiplyIntList
Multiplies a list of integers (represented in a String list) and returns the product.

Input Parameters

String ListNumbers (floating point numbers represented as Strings) to multiply.numList

Output Parameters

String Product of the numbers in numList.value

Usage Notes

Make sure the result of your calculation is less than 64 bits in width (the maximum width for the
long data type). If the result exceeds this limit, it will generate a data overflow.

Make sure the strings that are passed to the service in numList are in a locale-neutral format (that
is, using the pattern -####.##). Passing locally formatted strings may result in unexpected results.
For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will result in
the value 357, not 3.57 or 3,57.

multiplyInts
Multiplies one integer (represented as a String) by another and returns the product.

Input Parameters

StringNumber (integer represented as a String) to multiply.num1

StringNumber (integer represented as a String) to multiply.num2

Integration Cloud 6.6.0 521

10 Built-In Services



Output Parameters

String Product of num1 and num2.value

Usage Notes

Make sure the result of your calculation is less than 64 bits in width (the maximum width for the
long data type). If the result exceeds this limit, it will generate a data overflow.

Make sure the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

randomDouble
Returns the next pseudorandom, uniformly distributed double between 0.0 and 1.0.

Random number generators are often referred to as pseudorandom number generators because
the numbers produced tend to repeat themselves over time.

Input Parameters

None.

Output Parameters

String Generated random number.number

roundNumber
Returns a rounded number.

Input Parameters

StringNumber to be rounded.num

String Specifies the number of digits towhich youwant to round the number.numberOfDigits

String Optional. Specifies the rounding method.roundingMode

Valid values for the roundingMode parameter are RoundHalfUp, RoundUp,
RoundDown, RoundCeiling, RoundFloor, RoundHalfDown, and RoundHalfEven. The
default value is RoundHalfUp.
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Output Parameters

String The rounded number.roundedNumber

subtractFloats
Subtracts one floating point number (represented as a String) from another and returns the
difference.

Input Parameters

StringNumber (floating point number represented as a String).num1

StringNumber (floating point number represented as a String) to subtract from
num1.

num2

StringOptional. Number of decimal places towhich the differencewill be rounded.
The default value is null.

precision

Output Parameters

StringDifference of num1 - num2. If a difference cannot be produced, value contains
one of the following:

value

DescriptionValue

The computation produces a positive value that overflows the
representable range of a float type.

Infinity

The computation produces a negative value that overflows the
representable range of a float type.

-Infinity

The computation produces a value that underflows the representable
range of a float type (for example, subtracting a number from infinity).

0.0

The computation produces a value that cannot be represented as a
number (for example, the result of an illegal operation such as

NaN

multiplying zero by zero or any operation that uses NaN as input,
such as 10.0 - NaN = NaN).

Usage Notes

Make sure the strings that are passed to the service in num1andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.
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subtractInts
Subtracts one integer (represented as a String) from another and returns the difference.

Input Parameters

StringNumber (integer represented as a String).num1

StringNumber (integer represented as a String) to subtract from num1.num2

Output Parameters

String Difference of num1 - num2.value

Usage Notes

Make sure the result of your calculation is less than 64 bits in width (the maximum width for the
long data type). If the result exceeds this limit, it will generate a data overflow.

Make sure the strings that are passed to the service in num1 andnum2 are in a locale-neutral format
(that is, using the pattern -####.##). Passing locally formatted strings may result in unexpected
results. For example, calling addFloats in a German locale with the arguments 1,23 and 2,34will
result in the value 357, not 3.57 or 3,57.

MIME Services
Use MIME services to create MIME messages and extract information from MIME messages.

The following MIME services are available:

FunctionService

Adds a body part (header fields and content) to a
specified MIME object.

addBodyPart

Adds one or more header fields to a specified MIME
object.

addMimeHeader

Creates a MIME object.createMimeData

Retrieves the content (payload) from the specified
MIME object.

getBodyPartContent

Returns the list of header fields for the specified body
part.

getBodyPartHeader

524 Integration Cloud 6.6.0

10 Built-In Services



FunctionService

Returns the value of the Content-Typemessage header
from the specified MIME object.

getContentType

Generates an InputStream representation of a MIME
message from a specified MIME object.

getEnvelopeStream

Returns the list of message headers from a specified
MIME object.

getMimeHeader

Returns the number of body parts in the specified
MIME object.

getNumParts

Returns the top-level portion of a MIME object's
Content-Type value.

getPrimaryContentType

Returns the sub-type portion of a MIME object's
Content-Type value.

getSubContentType

Concatenates the contents of the header and body
mapped to the input.

mergeHeaderAndBody

addBodyPart
Adds a body part (header fields and content) to a specified MIME object.

Input Parameters

DocumentMIMEobject towhich youwant to add a body part.
(This IData object is produced by createMimeData).

mimeData

java.io.InputStream or Object Content that you want to add
to the MIME object. content can be an InputStream or another

content

MIME object. Use an InputStream to add an ordinary payload.
Use a MIME object to add a payload that is itself a MIME
message.

String Flag that specifies whether content is to be treated as a
MIME entity.

isEnvStream

Important:
This parameter is only used if content is an InputStream.

Set this parameter to one of the following values:

yes to treat content as a MIME entity. addBodyPartwill strip
out the header fields from the top of content and add them
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to mimeData as part headers. The remaining data will be
treated as the payload.

Note:addBodyPart assumes that all data up to the first blank
line represents the entity's header fields.

no to treat content as an ordinary payload.

Document Specifies the part headers that youwant to addwith
this body part. Key names represent the names of the header

mimeHeader

fields. The values of the keys represent the values of the header
fields.

For example, if you wanted to add the following header fields:
X-Doctype: RFQ
X-Severity: 10

You would set mimeHeader as follows:

ValueKey

RFQX-Doctype

10X-Severity

Be aware that the following MIME headers are automatically
inserted by getEnvelopeStream when it generates the MIME
message:
Message-ID
MIME-Version

Additionally, you use the content, encoding, and description
parameters to set the following fields:
Content-Type
Content-Transfer-Encoding
Content-Description

If you set these header fields in mimeHeader and you create a
single-part message, the values in contenttype, encoding, and
description, if specified, will override those in mimeHeader. See
usage notes.

StringOptional. The value of the Content-Type header for this
body part. For single-part messages, this value overrides the

contenttype

Content-Type value in mimeHeader, if one is present. Defaults
to text/plain.

See usage notes.

String Optional. Specifies how the body part is to be encoded
for transport and sets the value of the

encoding
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Content-Transfer-Encoding header. For single-part messages,
this value overrides the Content-Transfer-Encoding value in
mimeHeader, if one is present. Defaults to 7bit.

See usage notes.

Note:
This parameter determines how the payload is to be encoded
for transport.When you add a payload tomimeData, it should
be in its original format. The getEnvelopeStream servicewill
perform the encoding (as specified by encoding) when it
generates the final MIME message.

Set to:

7bit to specify that content is 7-bit, line-oriented text that
needs no encoding. This is the default.

8bit to specify that content is 8-bit, line-oriented text that
needs no encoding.

Note:
This encoding value is not recommended for messages
that will be transported via SMTP over the Internet,
because the data can be altered by intervening mail
servers that can't accommodate 8-bit text. To safely
transport 8-bit text, use quoted-printable encoding
instead.

binary to specify that content contains binary information
that needs no encoding.

Note:
This encoding value is not recommended for messages
that will be transported via SMTP over the Internet,
because the data can be altered by intervening mail
servers that can't accommodate binary data. To safely
transport binary data, use base64 encoding instead.

quoted-printable to specify that content contains 7 or 8-bit,
line-oriented text that you want to encode using the
quoted-printable encoding scheme.

base64 to specify that content contains an arbitrary sequence
of octets that youwant to encode using the base64 encoding
scheme.

uuencode to specify that content contains an arbitrary
sequence of octets that you want to encode using the
uuencode encoding scheme.
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StringOptional. Specifies the value of the Content-Description
header for this body part.

description

StringOptional. Flag that determines how addBodyPart behaves
if mimeData already contains one or more body parts.

multipart

By default, addBodyPart simply appends a new body part to
mimeData if it already contains a payload. (This allows you to
construct multi-part messages.) However, you can override
this behavior if youwant to either replace the existing payload
with the new body part or throw an exception under these
circumstances (see replace parameter, below).

Set to:

yes to append a new body part to mimeData. This is the
default.

no to replace the existing payload with the new body part.
(Depending on the value of replace, this setting may cause
addBodyPart to throw an exception.)

StringOptional. Flag that specifieswhether addBodyPart replaces
the existing payload or throws an exception when it receives

replace

a mimeData that already contains a payload. This parameter is
only used when multipart is set to no.

Set to:

yes to replace the existing payloadwith the new body part.
This is the default.

no to throw an exception.

Output Parameters

DocumentMIME object to which the body part was added.mimeData

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

The way in which the contenttype and encoding parameters are applied depends on whether the
finished message is single-part or multipart.

For single-part messages:

contenttype specifies the Content-Type for the entire MIME message. It overrides any value
assigned to the Content-Type header in mimeHeader. If Content-Type is not specified in
contenttype or mimeHeader, the value of the Content-Type header defaults to text/plain.
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encoding specifies the Content-Transfer-Encoding for the entire MIME message. It overrides
any value assigned to the Content-Transfer-Encoding header in mimeHeader. If
Content-Transfer-Encoding is not specified in encoding or mimeHeader, the value of the
Content-Transfer-Encoding header defaults to 7bit.

For multipart messages:

contenttype specifies the Content-Type for an individual body part. The Content-Type for the
entire MIME message is automatically set to multipart/mixed, or to multipart/subType if a
subtype was specified when the MIME object was created. See createMimeData.

encoding specifies the Content-Transfer-Encoding for an individual body part. The
Content-Transfer-Encoding header in mimeHeader, if present, specifies the encoding for the
entire MIME message. If Content-Transfer-Encoding is not specified in mimeHeader, or if the
specified value is not valid for amultipartmessage, the value of the Content-Transfer-Encoding
header defaults to 7bit. (7bit, 8bit, and binary are the only encoding values valid for multipart
messages.)

addMimeHeader
Adds one or more header fields to a specified MIME object.

Input Parameters

DocumentMIME object to which you want the header fields added.
(This IData object is produced by createMimeData.)

mimeData

DocumentHeader fields that you want to add to the MIME object. Key
names represent the names of the header fields. The values of the keys

mimeHeader

represent the values of the header fields. For example, to add the
following header fields:
X-Doctype: RFQ
X-Severity: 10

You would set mimeHeader as follows:

DescriptionKey

RFQX-Doctype

10X-Severity

Be aware that the following MIME headers are automatically inserted
by getEnvelopeStream when it generates the MIME message:
Message-ID
MIME-Version

If you set these values inmimeHeader, getEnvelopeStreamwill overwrite
them at run time.
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Output Parameters

DocumentMIME object to which the header fields were added.mimeData

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

If you add MIME headers before you add multiple body parts, the header fields will be added to
each of the body parts. If you do not want this behavior, either dropmimeHeader from the pipeline
immediately after you execute addMimeHeader, or invoke addMimeHeader after you've added all body
parts to the MIME object.

Be aware that the contenttype and encoding parameters used by the addBodyPart service will
override any Content-Type or Content-Transfer-Encoding settings in mimeData. Moreover, in
certain cases, the getEnvelopeStream will override these settings when it generates a multipart
message. For information about how the Content-Type or Content-Transfer-Encoding headers are
derived at run time, see the Usage Notes under addBodyPart.

createMimeData
Creates a MIME object.

If no input parameter is passed to this service, the service creates an emptyMIMEobject. Otherwise,
the service creates a MIME object containing the elements (header fields and content) from the
MIME message in input.

If you are building a MIME message, you use this service to create an empty MIME object.
You populate the empty MIME object with header fields and content, and then pass it to
getEnvelopeStream, which produces the finished MIME message.

If you are extracting data from a MIME message, you use this service to parse the original
MIME message into a MIME object so that you can extract its header fields and content using
other services.

Input Parameters

java.io.InputStream Optional. MIME entity you want to parse.
If input is not provided, createMimeData creates an empty MIME
object.

input

DocumentOptional. Specifies header fields that youwant to add
to theMIMEobject. Key names represent the names of the header

mimeHeader

fields. The values of the keys represent the values of the header
fields.

Note:
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This parameter is ignoredwhen input is passed to this service.

For example, if you wanted to add the following header fields:
X-Doctype: RFQ
X-Severity: 10

You would set mimeHeader as follows:

ValueKey

RFQX-Doctype

10X-Severity

Be aware that the following MIME headers are automatically
inserted by getEnvelopeStream when it generates the MIME
message:
Message-ID
MIME-Version

If you set these values in mimeHeader, getEnvelopeStream will
overwrite them at run time.

String Optional. String that specifies the subtype portion of the
Content Type header, when the message is a multipart message

subType

and \you want something other than the default value of mixed.
For example, if you want the Content Type header to be
multipart/related in the resulting message, set subType to
related.

subType is ignored if the resulting message is not a multipart
message.

StringOptional. Specifies how theMIMEheader is to be decoded.decodeHeaders

Set to:

" "(empty String) to decode headers based on the value of
the global watt property watt.server.mime.decodeHeaders.
This is the default.

NONE to specify that the MIME header or body part headers
do not need decoding.

ONLY_MIME_HEADER to decode the MIME header only.

ONLY_BODY_PART_HEADERS to decode the body part headers
only.

BOTH to decode the MIME header and the body part headers.
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Output Parameters

DocumentMIME object. If inputwas passed to createMimeData,
mimeDatawill contain the parsed MIME message. If inputwas
not passed to createMimeData, mimeDatawill be empty.

mimeData

String Conditional. Indicates whether input was an encrypted
message. This parameter is not presentwhen the service creates
a new, empty MIME object. A value of:

encrypted

true indicates that the message is encrypted (the original
message stream is in stream).

false indicates that the message is not encrypted.

String Conditional. Flag whose value indicates whether input
was a signed message. This parameter is not present when the
service creates a new, empty MIME object. A value of:

signed

true indicates that the message is signed (the original
message stream is in stream).

false indicates that the message is not signed.

String Conditional. Flag whose value indicates whether input
contained only digital certificates. This parameter is not present

certsOnly

when the service creates a new, empty MIME object. A value
of:

true indicates that the message contains only certificates.

false indicates that themessage contains a regular payload.

java.io.InputStream Conditional. InputStream containing the
original MIME message from input. This parameter is present
only when input is an S/MIME message.

stream

Usage Notes

All of the other MIME services operate on the mimeData IData object produced by this service.
They do not operate directly on MIME message streams.

Important:
You can examine the contents of mimeData during testing and debugging. However, because
the internal structure of mimeData is subject to change without notice, do not explicitly set or
map data to/from these elements in your service. To manipulate or access the contents of
mimeData, use only the MIME services that is provided.
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getBodyPartContent
Retrieves the content (payload) from the specified MIME object.

You use this service for both single-part and multi-part messages.

To retrieve content from amulti-partmessage, you set the index (to select the part by index number)
or contentID (to select the part by contentID value) parameter to specify the body partwhose content
youwant to retrieve. To get the content from a single-partmessage, you omit the index and contentID
parameters or set index to 0.

Input Parameters

DocumentMIME object whose content you want to retrieve. (This IData
object is produced by createMimeData.)

mimeData

StringOptional. Index number of the body part whose content youwant
to retrieve (if you want to retrieve the content from a specific body part).
The first body part is index number zero.

index

Note:
If contentID is specified, index is ignored.

String Optional. Value of the Content-ID header field of the body part
whose content you want to retrieve (if you want to retrieve the payload
from a specific body part).

contentID

Output Parameters

IData The payload of the specified body part.content

String Flagwhose value indicateswhether content is an encryptedMIME
message. A value of:

encrypted

true indicates that content is an encrypted message.

false indicates that content is not an encrypted message.

String Flag indicating whether content is a signed MIME message. A
value of:

signed

true indicates that content is a signed MIME message.

false indicates that content is not a signed MIME message.

String Flag whose value indicates whether content is a certs-only MIME
message. A value of:

certsOnly

true indicates that content is a certs-only message.
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false indicates that content is not a certs-only message.

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

If you omit index or contentIDwhen retrieving content from amulti-partmessage, getBodyPartContent
returns the payload from the first body part. If you use index or contentID to select a body part that
does not exist in mimeData, contentwill be null.

getBodyPartHeader
Returns the list of header fields for the specified body part.

Input Parameters

DocumentMIME object whose message headers you want to retrieve.
(This IData object is produced by createMimeData).

mimeData

StringOptional. Index number of the body part whose header fields you
want to retrieve. The first body part is index zero.

index

Note:
If contentID is specified, index is ignored.

String Optional. Value of the Content-ID header field of the body part
whose header fields you want to retrieve.

contentID

String Conditional. Flag whose value indicates whether to decode
encoded headers in the MIME object. Set to:

decodeHeaders

true to indicate that the headers should be decoded.

false to indicate that the headers should not be decoded. This is the
default.

Output Parameters

Document IData object containing the message headers. Key names
represent the names of the header fields. The value of a key represents
the value of that header field.

mimeHeader

For example, if the original message contained the following message
header fields:
Content-Type: text/xml
X-Doctype: RFQ
X-Severity: 0
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get Body Part Headerwould return the following IData object:

ValueKey

text/xmlContent-Type

RFQX-Doctype

0X-Severity

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

If you omit index or contentID, getBodyPartHeader returns the message headers from the first body
part. If you use index or contentID to select a body part that does not exist inmimeData, contentwill
be null.

getContentType
WmPublic. Returns the value of the Content-Typemessage header from the specifiedMIMEobject.

Input Parameters

DocumentMIMEobjectwhose Content-Type youwant to discover. (This
IData object is produced by createMimeData..

mimeData

Output Parameters

String Value of the MIME object's Content-Type header field. Note that
this service returns only themedia type and subtype portion of this header

contentType

field's value. It does not return any parameters the value may include.
For example, if the message's Content-Type header were:
Content-Type: text/plain;charset=UTF8

contentTypewould contain:
text/plain

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

getEnvelopeStream
Generates an InputStream representation of a MIME message from a specified MIME object.
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Input Parameters

DocumentMIME object from which you want to generate the
MIME message. (This IData object is produced by
createMimeData.)

mimeData

String Optional. Index number of the body part for which you
want to generate the MIME message (if you want to generate

index

the message from a specific body part). The first body part is
index number zero.

String Optional. Value of the Content-ID header field of the
body part fromwhich youwant to generate theMIMEmessage
(if youwant to generate the message from a specific body part).

contentID

Note:
If index is specified, contentID is ignored.

String List Optional. Names of header fields that are to be
omitted frommessage. You can use this option to exclude header

suppressHeaders

fields that getEnvelopeStream generates by default, such as
Content-Type and content-encoding.

StringOptional. Specifies whether a multipart message is to be
created, even if mimeData contains only one body part. Set to:

createMultipart

yes to create a multipart message (Content-Type message
header is set to "multipart/mixed").

no to create a message based on the number of body parts
in mimeData. This is the default.

If the message contains only one body part,
Content-Type is set according to the contenttype setting
specified when that body part was added to mimeData.

If the message contains multiple body parts,
Content-Type is automatically set to "multipart/mixed."

Output Parameters

java.io.InputStream The MIME message as an InputStream.envStream

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

536 Integration Cloud 6.6.0

10 Built-In Services



If you omit index or contentID, getEnvelopeStream generates the MIME message from the entire
contents of the mimeData. If you use index or contentID to select a body part that does not exist in
mimeData, contentwill be null.

getEnvelopeStream automatically inserts the MIME-Version and Message-IDmessage headers into the
MIME message it puts into envStream.

getMimeHeader
WmPublic. Returns the list of message headers from a specified MIME object.

Input Parameters

DocumentMIME object whose message headers you want to retrieve.
(This IData object is produced by createMimeData).

mimeData

Output Parameters

Document Conditional. An IData object containing the message
headers. Key names represent the names of the header fields. The
value of a key represents the value of the header fields.

mimeHeader

For example, if the original message contained the following
message header fields:
Message-ID: <002e01c0f150$6f33010a@sgx.com>
From: "Purch01@GSX.com" <Purch01@GSX.com>To:
<EXPEst@exprint.com>
MIME-Version: 1.0
Content-Type: text/xml
X-Doctype: RFQ
X-Severity: 0

getMimeHeaderwould return the following:

ValueKey

<002e01c0f150$6f33010a@sgx.com>Message-ID

"Purch01@GSX.com"
<Purch01@GSX.com>

From

<EXPEst@exprint.com>To

1.0MIME-Version

text/xmlContent-Type

RFQX-Doctype

0X-Severity

Integration Cloud 6.6.0 537

10 Built-In Services



Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

getNumParts
Returns the number of body parts in the specified MIME object.

Input Parameters

DocumentMIME object whose parts you want to count. (This IData
object is produced by createMimeData).

mimeData

Output Parameters

String The number of body parts in the MIME object.numParts

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

getPrimaryContentType
Returns the top-level portion of a MIME object's Content-Type value.

Input Parameters

DocumentMIMEobjectwhose Content-Type youwant to discover. (This
IData object is produced by createMimeData).

mimeData

Output Parameters

StringMessage's top-level Content-Type. For example, if
the message's Content-Type header were:

primContentType

Content-Type: multipart/mixed

primContentTypewould contain:
multipart
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Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

getSubContentType
Returns the sub-type portion of a MIME object's Content-Type value.

Input Parameters

DocumentMIME object whose sub-type you want to discover. (This
IData object is produced by createMimeData).

mimeData

Output Parameters

StringMessage's sub-type. For example, if the message's
Content-Type header were:

subContentType

Content-Type: multipart/mixed

subContentTypewould contain:
mixed

Usage Notes

This service operates on the MIME object (mimeData) produced by createMimeData.

mergeHeaderAndBody
Concatenates the contents of the header and body mapped to the input.

You can use this service to reassemble the message into its original form so that it can be used as
input to the createMimeData service (or any other service that requires the entire http response
as an InputStream).

Input Parameters

Document IData object containing themessage headers. (The
message headers are returned in the lines document inside
the header output parameter).

headerLines

Document IData object containing the body of the message.
This document must contain the body of the message in one
of the following keys:

body
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DescriptionKey

byte[ ]Optional. Body of the
message.

bytes

java.io.InputStream
Optional. The body of the
message.

stream

Output Parameters

java.io.InputStream InputStreamcontaining the reassembled tapmessage.stream

Usage Notes

Use this service to merge the Headers and Body to get the original MIME message.

Storage Services

Use Storage services to insert, retrieve, update, and remove entries from a data store.

When using the storage services, keep in mind that the short-term store is not intended to be used
as a general-purpose storage engine. Rather, it is primarily provided to support shared storage of
application resources and transient data in Integration Cloud. It is recommended not to use the
short-term store to process high volumes, large data records, or to permanently archive records.

Note:
User specific data which may be considered as personal data will be stored and retained till the
retention period defined in Execution Results.

Note:
These services are a tool for maintaining state information in the short-term store. It is up to the
developer of the Integration tomake sure that the Integration keeps track of its state and correctly
handles restarts.

Locking Considerations

The following sections describe in general how the storage services handle locking requests.

Entry Locking

To maintain data integrity, the short-term store uses locking to ensure that multiple threads do
not modify the same entry at the same time. For insertions and removals, the short-term store sets
and releases the lock. For updates, the clientmust set and release the lock. Using locking improperly,
that is, creating a lock but not releasing it, can cause deadlocks in the short-term store.

The following guidelines can help you avoid short-term store deadlocks:
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Release locks in the thread through which they were set. In other words, you cannot set a lock
in one thread and release it in another. The safest way to do this is to release each lock in the
Integration that acquired it.

Unlock entries before the Integration completes. Entries remain locked until released using a
put or an explicit unlock. To accomplish this, always pair a call to get or lock with a call to put
or unlock so that every lock is followed by an unlock. In addition, use a try-catch pattern in
your Integration so that an exception does not prevent the Integration from continuing and
releasing the lock.

Data Store Locking

When a storage service locks an entry, the service also implicitly locks the data store in which the
entry resides. This behavior prevents another thread from deleting the entire data store and the
entries it containswhile your thread is workingwith the entry.When the locked entry is unlocked,
the implicit lock on the data store is also released.

Be careful when explicitly unlocking data stores. Consider the following example:

1. User_A locks an item. This creates two locks: an explicit lock on the entry, and an implicit lock
on the data store.

2. User_A later unlocks the data store explicitly while still holding the lock on the entry.

3. User_B locks, then deletes the data store, including the entry locked by User_A in the first
step.

When User_A explicitly unlocked the data store in step 2, User_B was able to delete the entry the
User_A was working with.

Automatic Promotion to Exclusive Lock

If a storage service tries to acquire an exclusive lock on an object, but finds a shared lock from the
same thread already in place on the object, the service will try to promote the lock to an exclusive
lock.

If a storage service that requires an exclusive lock encounters a shared or exclusive lock held by
another thread, it will wait until the object becomes available. If the object remains locked for the
period specified by the waitlength parameter passed by the service, the service will fail.

Sample Integration for Checkpoint Restart

The following diagram shows how to create checkpoint restarts into your Integrations. It explains
the logic of an Integration and shows where the various storage services are used to achieve
checkpoint restarts.
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The following Storage services are available:
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Package and DescriptionElement

Inserts a new entry into a data store.add

Deletes a data store and all its contents. Any data in the data store
is deleted. If the data store does not exist, the service takes no
action.

deleteStore

Retrieves a value from a data store and locks the entry and the
data store on behalf of the thread that invoked the service.

get

Obtains a list of all the keys in a data store.keys

Locks an entry and/or data store on behalf of the thread invoking
this service.

lock

Inserts or updates an entry in a data store. If the key does not exist
in the data store, the entry is inserted.

put

Removes an entry from a data store.remove

Unlocks an entry or a data store.unlock

add
Inserts a new entry into a data store.

If the key already exists in the data store, the service does nothing.

Input Parameters

StringName of the data store in which to insert the entry.storeName

String Key under which the entry is to be inserted.key

Document Value to be inserted.value

Output Parameters

String Flag indicatingwhether the entrywas successfully added. A value
of:

result

true indicates that the new entry was inserted successfully.

false indicates that the entry was not inserted (usually because an
entry for key already exists).

String Error message generated while inserting the new entry into the
data store.

error
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deleteStore
Deletes a data store and all its contents. Any data in the data store is deleted. If the data store does
not exist, the service takes no action.

Input Parameters

StringName of the data store to delete.storeName

String Optional. Length of time, in milliseconds, that you want to wait
for this data store to become available for deletion if it is already locked
by another thread.

waitLength

Output Parameters

StringNumber of data store entries that were deleted. If the store does
not exist, this value is 0.

count

Usage Notes

This service obtains an exclusive lock on the data store, but no locks on the individual entries in
the data store. If this service finds a shared lock from the same thread on the data store, the service
will automatically promote the lock to an exclusive lock. The exclusive lock prevents other threads
from acquiring locks on the data store or entries within the data store during the delete operation.

get
Retrieves a value from a data store and locks the entry and the data store on behalf of the thread
that invoked the service.

Important:
This service does not automatically release the lock on the data store or entry after performing
the get operation, so you need to ensure that the lock is released by calling the put or unlock
services. If you do not release the lock, Integration Cloud will release the lock at the end of the
Integration execution.

Input Parameters

StringName of the data store fromwhich youwant to retrieve the entry.storeName

String Key of the entry whose value you want to retrieve.key

String Optional. Length of time, in milliseconds, that you want to wait
for this entry to become available if it is already locked by another thread.

waitLength
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String Optional. Type of lock you want to place on the entry. Set to:lockMode

Exclusive to prevent other threads from reading or updating the
entry while you are using it. The service also obtains a shared lock
on the data store. An exclusive lock on an entry allows you tomodify
the entry.

Read is obsolete. If this value is specified, the service obtains a shared
lock.

Share to prevent other threads from obtaining an exclusive lock on
the entry. The service also obtains a shared lock on the data store. A
shared lock on an entry allows you to read, but not modify, the entry.
This is the default.

Output Parameters

Document Retrieved entry. If the requested entry does not exist, the
value of this parameter is null.

value

Usage Notes

If you request an exclusive lock and the service finds a shared lock from the same thread on the
entry, the service will automatically promote the shared lock on the entry to an exclusive lock.

When this service locks an entry, it also acquires a shared lock on the associated data store to
prevent another thread from deleting the data store, and the entries it contains, while your thread
has the entry locked.

When storing and retrieving the flow state in the short-term store for checkpoint restart purposes,
ensure that the value of key is unique to the transaction.

keys
Obtains a list of all the keys in a data store.

Input Parameters

StringName of the data store from which you want to obtain a list of
keys.

storeName

Output Parameters

String List Keys for the data store specified in storeName.keys
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lock
Locks an entry and/or data store on behalf of the thread invoking this service.

Important:
When you lock an entry or data store using this service, you must release the lock by using a
put or an explicit unlock. If you do not release the lock, Integration Cloud will release the lock
at the end of the Integration execution.

Important:
Be careful when releasing locks with the unlock service. If you release a lock on a data store,
another thread can obtain a lock on the data store and delete it, and the entries it contains, even
if your thread still has locks on one or more of the entries.

Input Parameters

StringName of the data store containing the entry.storeName

String Optional. Key of the entry that you want to lock.key

If key is not supplied and you request:

A shared lock, the service obtains a shared lock on the data store,
allowing other threads to read and modify entries, but not to delete
them.

An exclusive lock, the service obtains an exclusive lock on the data
store, preventing other threads from locking the data store and the
entries, thereby preventing those threads from reading, modifying,
or deleting the entries or the data store.

If both storeName and key are specified and you request:

A shared lock, the service obtains a shared lock on the data store and
the entry.

An exclusive lock, the service obtains a shared lock on the data store
and an exclusive lock on the entry.

String Optional. Length of time, in milliseconds, that you want to wait
for this entry to become available if it is already locked by another thread.

waitLength

StringOptional. Type of lock youwant to place on the entry or data store.
Set to:

lockMode

Exclusive to prevent other threads from obtaining a lock on the data
store or entry.

An exclusive lock on an entry allows you to modify the entry, and
prevents other threads from reading or modifying the entry.
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An exclusive lock on a data store also locks the entries in the data
store. In addition, an exclusive lock on a data store allows you to
delete the data store.

Read is obsolete. If this value is specified, the service obtains a shared
lock.

Share to prevent other threads from obtaining an exclusive lock on
an entry or a data store. A shared lock on an entry allows you to read,
but not modify, the entry. A shared lock on a data store prevents
another thread from deleting the data store. This is the default.

Output Parameters

None.

Usage Notes

If you have not specified a key, and your Integration does not invoke put or unlock, or your
Integration throws an exception before invoking put or unlock, the entire data store remains locked.

If the key does not exist in the data store at the time your Integration executes, the lock service
inserts the key with an empty value and takes the lock on the entry.

If you request an exclusive lock on an entry, the service obtains an exclusive lock on the entry and
a shared lock on the data store. If this service finds a shared lock from the same thread on the
entry, the service will automatically promote the shared lock on the entry to an exclusive lock.

If you request a shared lock on an entry, the service obtains a shared lock on the entry and a shared
lock on the data store.

If you request a shared lock on an entry or a data store and this service finds an exclusive lock
from the same thread, the existing exclusive lock will be reused. The exclusive lock will not be
demoted to a shared lock.

If you request an exclusive lock on a data store, and this service finds a shared lock from the same
thread on the data store, the service will automatically promote the shared lock on the data store
to an exclusive lock.

put
Inserts or updates an entry in a data store. If the key does not exist in the data store, the entry is
inserted.

If the requested entry is not currently locked by the thread that invoked this service, the put service
will automatically attempt to lock the entry for the duration of the put operation.

The service obtains an exclusive lock on the entry and a shared lock on the data store. If the service
finds a shared lock from the same thread on the entry, the service will automatically promote the
shared lock to an exclusive lock.
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This service releases the lock when the put operation has completed.

Input Parameters

StringName of the data store into which you want to insert or update
the entry.

storeName

Document Value to be inserted or updated.value

String Optional. Length of time, in milliseconds, that you want to wait
for this entry to become available if it is already locked by another thread.

waitLength

If the wait length expires before a lock is obtained, the service fails and
throws an exception.

This parameter is used onlywhen your service did not explicitly lock the
entry beforehand.

String Key where you want to insert or update the entry.key

Output Parameters

String Error message generated while inserting the new entry into the
data store.

error

Usage Notes

When storing and retrieving the flow state in the short-term store for checkpoint restart purposes,
ensure that the value of key is unique to the transaction.

remove
Removes an entry from a data store. This service obtains an exclusive lock on the entry and a
shared lock on the data store.

Input Parameters

StringName of the data store from which to remove an entry.storeName

String Key of the entry that you want to remove.key

String Optional. Length of time, in milliseconds, that you want to wait
for this entry to become available for deletion if it is already locked by
another thread.

waitLength
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Output Parameters

String Flag indicating whether the entry was successfully removed. A
value of:

result

true indicates that the entry was removed successfully.

false indicates that the entry was not removed (usually because an
entry for key does not exist).

unlock
Unlocks an entry or a data store.

When an Integration retrieves an entry using the get service, the entry is locked to prevent
modification by other users before the Integration completes. The entry remains locked until the
lock owner invokes a put service. To unlock a servicewithout using the put service, use the unlock
service.

In addition, if an Integration uses the lock service to lock an entry or data store, you must use the
unlock or put service to release the lock.

Important:
Be careful when releasing locks with this service. If you release a lock on a data store, another
thread can obtain a lock on the data store and delete it, and the entries it contains, even if the
original thread still has locks on one or more of the entries.

Input Parameters

StringName of the data store in which to unlock an entry.storeName

String Optional. Key of the entry that you want to unlock. If key is not
supplied, the lock will be removed from the data store specified in
storeName, but any locks on entries in the data store will remain.

key

Output Parameters

None.

String Services

Use String services to perform string manipulation and substitution operations.

The following String services are available:
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DescriptionService

Replaces HTML character entities with native characters.HTMLDecode

ReplacesHTML-sensitive characterswith equivalentHTML
character entities.

HTMLEncode

Decodes a Base-64 encoded string into a sequence of bytes.base64Decode

Converts a sequence of bytes into a Base64-encoded String.base64Encode

Converts a sequence of bytes to a String.bytesToString

Concatenates two strings.concat

Returns the index of the first occurrence of a sequence of
characters in a string.

indexOf

Returns the length of a string.length

Looks up a given key in a hash table and returns the string
to which that key is mapped.

lookupDictionary

Builds a single string by concatenating the elements of a
String List.

makeString

Formats an array of strings into a given message pattern.messageFormat

Formats a number into a given numeric pattern.numericFormat

Converts an object to string representation using the Java
toString() method of the object.

objectToString

Pads a string to a specified length by adding pad characters
to the beginning of the string.

padLeft

Pads a string to a specified length by adding pad characters
to the end of the string.

padRight

Replaces all occurrences of a specified substring with a
substitute string.

replace

Converts a string to a byte array.stringToBytes

Returns a substring of a given string.substring

Tokenizes a string using specified delimiter characters and
generates a String List from the resulting tokens.

tokenize

Converts all characters in a given string to lowercase.toLower

Converts all characters in a given string to uppercase.toUpper

Trims leading and trailing white space from a given string.trim
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DescriptionService

Decodes a URL-encoded string.URLDecode

URL-encodes a string.URLEncode

Agiven string is not exactlymatched against a set of strings.
If the match is above similarityThreshold, it returns the

fuzzyMatch

matchedValue. If more than one string has not exactly
matched, then the first matched string is returned.

Determineswhether the contents of a string can be converted
to a float value.

isNumber

Determines whether a string consists entirely of
alphanumeric characters (in the ranges A–Z, a–z, or 0–9).

isAlphanumeric

Checks a string for a null or a blank value.isNullOrBlank

Determineswhether a string follows a specified date pattern.isDate

Replaces a pipeline variable with its corresponding value.substitutePipelineVariables

Performs a case-sensitive comparison of two strings, and
indicates whether the strings are identical.

compareStrings

HTMLDecode
Replaces HTML character entities with native characters.

Specifically, the service:

With...Replaces this HTML
character entity...

>&gt;

<&lt;

&&amp;

"&quot;

Input Parameters

String An HTML-encoded String.inString
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Output Parameters

StringResult fromdecoding the contents of inString. AnyHTMLcharacter
entities that existed in inStringwill appear as native characters in value.

value

HTMLEncode
Replaces HTML-sensitive characters with equivalent HTML character entities.

Specifically, this service:

With...Replaces this native
language character...

&gt;>

&lt;<

&amp;&

&quot;"

&#39‘

These translations are useful when displaying text in an HTML context.

Input Parameters

String The character you want to encode in HTML.inString

Output Parameters

StringResult fromencoding the contents of inString. AnyHTML-sensitive
characters that existed in inString, for example, > or &, will appear as the
equivalent HTML character entities in value.

value

base64Decode
Decodes a Base-64 encoded string into a sequence of bytes.

Input Parameters

String A Base64-encoded String to decode into bytes.string

552 Integration Cloud 6.6.0

10 Built-In Services



Output Parameters

byte[ ] The sequence of bytes decoded from the Base64-encoded String.value

String Optional. Specifies the encoding method. Default value is ASCII.encoding

base64Encode
Converts a sequence of bytes into a Base64-encoded String.

Input Parameters

byte[ ] Sequence of bytes to encode into a Base64-encoded String.bytes

String Optional. Flag indicating whether to retain or remove the line
breaks. Set to:

useNewLine

true to retain the line breaks. This is the default.

false to remove the line breaks.

String Optional. Specifies the encoding method. Default value is ASCII.encoding

Output Parameters

String Base64-encoded String encoded from the sequence of bytes.value

Usage Notes

By default, the base64Encode service inserts line breaks after 76 characters of data, which is not the
canonical lexical form expected by implementations such as MTOM. You can use the useNewLine
parameter to remove the line breaks.

bytesToString
Converts a sequence of bytes to a String.

Input Parameters

byte[ ] Sequence of bytes to convert to a String.bytes

StringOptional. Name of a registered, IANA character set (for example,
ISO-8859-1). If you specify an unsupported encoding, the system throws
an exception.

encoding
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To use the default encoding, set encoding to autoDetect.

String Optional. Flag indicating whether or not the byte order mark
(BOM) characters in the input sequence of bytes are removed before
converting the byte array to string. Set to:

ignoreBOMChars

true to remove the byte order mark (BOM) characters before
converting the input sequence of bytes to string, if the byte array
contains BOM characters.

false to include the byte order mark (BOM) characters while
converting the input sequence of bytes to string. The default is false.

Output Parameters

String String representation of the contents of bytes.string

concat
Concatenates two strings.

Input Parameters

String String to which you want to concatenate another string.inString1

String String to concatenate to inString1.inString2

Output Parameters

String Result of concatenating inString1with inString2 (inString1 +
inString2).

value

indexOf
Returns the index of the first occurrence of a sequence of characters in a string.

Input Parameters

String String in which you want to locate a sequence of characters.inString

String Sequence of characters to locate.subString
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String Optional. Index of inString from which to start the search. If no
value is specified, this parameter contains 0 to indicate the beginning of
the string.

fromIndex

Output Parameters

String Index of the first occurrence of subString in inString. If no
occurrence is found, this parameter contains -1.

value

length
Returns the length of a string.

Input Parameters

String String whose length you want to discover.inString

Output Parameters

String The number of characters in inString.value

lookupDictionary
Looks up a given key in a hash table and returns the string to which that key is mapped.

Input Parameters

java.util.HashtableHash table that uses String objects for keys and values.hashtable

String Key in hashtablewhose value you want to retrieve.key

Note:
The key is case sensitive.

Output Parameters

String Value of the string to which key is mapped. If the requested key
in hashtable is null or if key is not mapped to any value in hashtable, the
service returns null.

value
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makeString
Builds a single string by concatenating the elements of a String List.

Input Parameters

String List Strings to concatenate.elementList

String String to insert between each non-null element in elementList.separator

Output Parameters

String Result from concatenating the strings in elementList. Strings are
separated by the characters specified in separator.

value

messageFormat
Formats an array of strings into a given message pattern.

Input Parameters

StringMessage that includes "placeholders" where elements from
argumentList are to be inserted. The message can contain any sequence

pattern

of characters. Use the {n}placeholder to insert elements from argumentList,
where n is the index of the element that you want to insert. For example,
the following pattern string inserts elements 0 and 1 into the message:
Test results: {0} items passed, {1} items failed.

Note:
Do not use any characters except digits for n.

String List Optional. List of strings to use to populate pattern. If
argumentList is not supplied, the service will not replace placeholders in
patternwith actual values.

argumentList

Output Parameters

String Result from substituting argumentList into pattern. If pattern is
empty or null, this parameter is null.

value
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numericFormat
Formats a number into a given numeric pattern.

Input Parameters

String The number to format.num

String A pattern string that describes the way in which num is to be
formatted:

pattern

Indicates...This symbol...

A digit.0

A digit. Leading zeroes will not be shown.#

A placeholder for a decimal separator..

A placeholder for a grouping separator.,

A separation in format.;

The default negative prefix.-

That numwill be multiplied by 100 and shown
as a percentage.

%

Any character used as a prefix or suffix (for
example, A, $).

X

That special characters are to be used as literals
in a prefix or suffix. Enclose the special characters
within '' (for example, '#').

'

The following are examples of pattern strings:

DescriptionPattern

Use commas to separate into groups of three
digits. The pound sign denotes a digit and the

#,###

comma is a placeholder for the grouping
separator.

Use commas to separate into groups of four
digits.

#,####

Show digits before the decimal point as needed
and exactly two digits after the decimal point.
Prefix with the $ character.

$#.00
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Show digits before the decimal point as needed
and exactly one digit after the decimal point.

'#'#.0

Prefix with the # character. The first character in
a pattern is the dollar sign ($). The pound sign
denotes a digit and the period is a placeholder
for decimal separator.

Output Parameters

Stringnum formatted according to pattern. If pattern is an empty (not null)
string, the default pattern of comma separators is used and the number
of digits after the decimal point remains unchanged.

value

objectToString
Converts an object to string representation using the Java toString() method of the object.

Input Parameters

Object The object to be converted to string representation.object

Output Parameters

String String representation of the input object converted using the Java
toString() method of the object.

string

padLeft
Pads a string to a specified length by adding pad characters to the beginning of the string.

Input Parameters

String String that you want to pad.inString

String Characters to use to pad inString.padString

String Total length of the resulting string, including pad characters.length
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Output Parameters

StringContents of inStringpreceded by asmanypad characters as needed
so that the total length of the string equals length.

value

Usage Notes

If padString is longer than one character and does not fit exactly into the resulting string, the
beginning of padString is aligned with the beginning of the resulting string. For example, suppose
inString equals shipped and padString equals x9y.

Then valuewill contain...If length equals...

shipped7

x9yshipped10

x9x9yshipped12

If inString is longer than length characters, only the last length characters from inString are returned.
For example, if inString equals acct1234 and length equals 4, value will contain 1234.

padRight
Pads a string to a specified length by adding pad characters to the end of the string.

Input Parameters

String String that you want to pad.inString

String Characters to use to pad inString.padString

String Total length of the resulting string, including pad characters.length

Output Parameters

StringContents of inString followed by asmany pad characters as needed
so that the total length of the string equals length.

value

Usage Notes

If padString is longer than one character and does not fit exactly into the resulting string, the end
of padString is aligned with the end of the resulting string. For example, suppose inString equals
shipped and padString equals x9y.
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Then valuewill contain...If length equals...

shipped7

shippedx9y10

shippedx9y9y12

If inString is longer than length characters, only the first length characters from inString are returned.
For example, if inString equals 1234acct and length equals 4, value will contain 1234.

replace
Replaces all occurrences of a specified substring with a substitute string.

Input Parameters

String String containing the substring to replace.inString

String Substring to replace within inString.searchString

StringCharacter sequence that will replace searchString. If this parameter
is null or empty, the service removes all occurrences of searchString from
inString.

replaceString

String Optional. Flag indicating whether searchString is a regular
expression.When regular expressions are used to specify a search string,

useRegex

replaceStringmay also contain interpolation fields (for example, "$1") that
match parenthetical subexpressions in searchString.

Set to:

true to indicate that searchString is a regular expression.

false to indicate that searchString is not a regular expression. This is
the default.

Output Parameters

String Contents of inStringwith replacements made.value

stringToBytes
Converts a string to a byte array.
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Input Parameters

String String to convert to a byte[ ].string

StringOptional. Name of a registered, IANA character set that specifies
the encoding to use when converting the String to an array of bytes (for
example: ISO-8859-1).

encoding

To use the default encoding, set this value to autoDetect. If you specify
an unsupported encoding, an exception will be thrown.

Output Parameters

byte[ ] Contents of string represented as a byte[ ].bytes

substring
Returns a substring of a given string.

Input Parameters

String String from which to extract a substring.inString

String Beginning index of the substring to extract (inclusive).beginIndex

String Ending index of the substring to extract (exclusive). If this
parameter is null or empty, the substringwill extend to the end of inString.

endIndex

Output Parameters

String Substring from beginIndex and extending to the character at
endIndex - 1.

value

tokenize
Tokenizes a string using specified delimiter characters and generates a String List from the resulting
tokens.

This service does not return delimiters as tokens.

Input Parameters

String String you want to tokenize, that is, break into delimited chunks.inString
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StringDelimiter characters. If null or empty, the service uses the default
delimiters \t\n\r, where t, n, and r represent the white space characters
tab, new line, and carriage return.

delim

Output Parameters

String List Strings containing the tokens extracted from inString.valueList

toLower
Converts all characters in a given string to lowercase.

Input Parameters

String String to convert.inString

String Optional. Lowercase, two-letter ISO-639 code. If this parameter
is null, the system default is used.

language

String Optional. Uppercase, two-letter ISO-3166 code. If this parameter
is null, the system default is used.

country

StringOptional. Vendor and browser-specific code. If null, this parameter
is ignored.

variant

Output Parameters

String Contents of inString, with all uppercase characters converted to
lowercase.

value

toUpper
Converts all characters in a given string to uppercase.

Input Parameters

String String to convert.inString

String Optional. Lowercase, two-letter ISO-639 code. If this parameter
is null, the system default is used.

language

String Optional. Uppercase, two-letter ISO-3166 code. If this parameter
is null, the system default is used.

country
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StringOptional. Vendor and browser-specific code. If null, this parameter
is ignored.

variant

Output Parameters

String Contents of inString, with all lowercase characters converted to
uppercase.

value

trim
Trims leading and trailing white space from a given string.

Input Parameters

String String to trim.inString

Output Parameters

String Contents of inStringwith white space trimmed from both ends.value

URLDecode
Decodes a URL-encoded string.

Input Parameters

String URL-encoded string to decode.inString

Output Parameters

String Result from decoding inString. If inString contains plus (+) signs,
they will appear in value as spaces. If inString contains %hex encoded
characters, they will appear in value as the appropriate native character.

value

URLEncode
URL-encodes a string.

Encodes characters the same way that data posted from a WWW form is encoded, that is, the
application/x-www-form-urlencodedMIME type.
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Input Parameters

String String to URL-encode.inString

Output Parameters

String Result from URL-encoding inString. If inString contains
non-alphanumeric characters (except [-_.*@]), they will appear in value

value

as their URL-encoded equivalents (% followed by a two-digit hex code).
If inString contains spaces, they will appear in value as plus (+) signs.

fuzzyMatch
Agiven string is not exactlymatched against a set of strings. If thematch is above similarityThreshold,
it returns thematchedValue. If more than one string has not exactly matched, then the first matched
string is returned.

Input Parameters

String (Required) Text to be matched. Text should not be empty or
null.

inString

String [ ] (Required) Array of strings, which are used for matching.
If the string array value is either empty or null, it is not used for
matching.

matchData

String (Optional) If the inexact match score is above the given
threshold, then service output contains the matchedValue parameter.

similarityThreshold

Default value is 0.65. Valid values should be between 0.0 and 1.0.
Value 0.0 represents nomatch and value 1.0 represents an exactmatch.

String (Optional) The algorithm used for an inexact match. Default
value is Levenshtein. Supported algorithms are Levenshtein and
JaroWinkler.

algorithm

Output Parameters

String (Optional) If the inexact match is above similarityThreshold,
then the returned value contains the matched string.

matchedValue

String (Optional) If the inexact match is above similarityThreshold,
then it contains a similarity score. It provides themeasure of how close

similarity

the match is. The returned value can be between 0.0 and 1.0. Value
0.0 represents no match and value 1.0 represents an exact match.
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Usage Notes

Search the web for more information about Levenshtein and JaroWinkler algorithms.

isNumber
Determines whether the contents of a string can be converted to a float value.

Input Parameters

String Optional. String to be checked for conversion to float.inString

Output Parameters

String Indicateswhether or not inString can be converted to a float value.isNumber

true indicates that inString can be converted to a float value.

false indicates that inString cannot be converted to a float value.

The service returns false if inString is not specified.

isAlphanumeric
Determines whether a string consists entirely of alphanumeric characters (in the ranges A–Z, a–z,
or 0–9).

Input Parameters

String Optional. String to be checked for alphanumeric characters.inString

Output Parameters

String Indicates whether or not all the characters in inString are
alphanumeric.

isAlphanumeric

true indicates that all the characters in inString are alphanumeric.

false indicates that not all the characters in inString are alphanumeric.

The service returns false if inString is not specified.
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isNullOrBlank
Checks a string for a null or a blank value.

Input Parameters

String Optional. String to be checked for a null or a blank value.inString

Output Parameters

String Indicates whether or not inString has a null or a blank value.isNullorBlank

true indicates that inString has either a null or a blank value.

false indicates that inString contains a value that is not null.

Note:
If inString is not specified, the service considers the string to be blank
and returns true.

isDate
Determines whether a string follows a specified date pattern.

Input Parameters

StringOptional. String to be checked for adherence to the specified date
pattern.

inString

String Date format for specifying the inString parameter (for example,
yyyyMMdd HH:mm:ss.SSS).

pattern

For more information about the pattern strings that can be specified for
the date, see the “Pattern String Symbols” section.

Output Parameters

String Indicateswhether or not inString follows the specified date pattern.isDate

true indicates that inString follows the specified date pattern.

false indicates that inStringdoes not follow the specified date pattern.

The service returns false if inString is not specified.
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Usage Notes

The service returns an error if both inString and pattern are not specified.

You can specify any random string (for example, 111212) as both inString and pattern. The service
returns true if the same user-defined string is specified as both inString and pattern. This is because
the java.text.SimpleDateFormat class parses the user-defined input string and pattern to a valid
date when the particular input values are identical.

substitutePipelineVariables
Replaces a pipeline variable with its corresponding value.

Input Parameters

StringOptional. String containing the pipeline variable to replace. Specify
the name of the pipeline variable between the % symbols (for example,
%phone%).

inString

Output Parameters

String Contents of inStringwith the pipeline variable replaced.value

Usage Notes

The service returns an error if inString is not specified.

If inString does not contain any variable between the % symbols, or contains a value other than the
pipeline variable between the % symbols, the service does not perform any variable substitution
from the pipeline.

If you want to include the % symbol in the output, you can specify it as \% in inString. To specify
the value of the pipeline variable as a percentage in the output, append \% after the variable name
in inString. For example, suppose a pipeline variable revenueIncreasePercent has a value of 100.

Then valuewill contain...If inString equals...

100%%revenueIncreasePercent%\%

The service cannot be used for substitution of global variables.

compareStrings
Performs a case-sensitive comparison of two strings and indicateswhether the strings are identical.
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Input Parameters

StringOptional. String to compare against inString2. This input variable
can be null.

inString1

StringOptional. String to compare against inString1. This input variable
can be null.

inString2

Output Parameters

String Indicates whether or not inString1 and inString2 are identical.isEqual

true indicates that inString1 and inString2 are identical.

false indicates that inString1 and inString2 are not identical.

Note:
If both inString1 and inString2 are null, the service considers the strings
to be identical and returns true.

Flow Services

Use Flow services to perform utility-type tasks.

The following Flow services are available:

DescriptionService

Removes all fields from the pipeline. You may optionally
specify fields that should not be cleared by this service.

clearPipeline

Obtains detailed information about the last error that was
trapped within an Integration.

getLastError

Obtains detailed information about the current logged-in
user session. Also provides the current Integration name
and the execution result reference identifier.

getSessionInfo

Gets information about the HTTP request, received by
Integration Cloud.

getHTTPRequest

Sets the HTTP response information to be returned by
Integration Cloud.

setHTTPResponse

Counts the number of documents processed by an
Integration. Details about the processed documents can be
viewed in the Execution Results screen.

countProcessedDocuments
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DescriptionService

Logs a message, which can be viewed in the Execution
Results screen.

logCustomMessage

Causes the currently executing Integration to pause for the
specified number of seconds.

sleep

clearPipeline
Removes all fields from the pipeline. You may optionally specify fields that should not be cleared
by this service.

Input Parameters

String List Optional. Field names that should not be cleared from the
pipeline.

preserve

Output Parameters

None

getLastError
Obtains detailed information about the last error that was trapped within an Integration.

Input Parameters

None

Output Parameters

Document. Information about the last error, which contains details of
the time, error, user, block, and call stack information.

lastError

DescriptionKey

String. Date and time the event occurred, in the
format yyyy/MM/dd HH:mm:ss.SSS

time

String. Optional. Error message of the exception.error

String. Optional. Error message in the language
that corresponds to the server locale.

localizedError
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String. User who executed the Integration.user

Document. Contains the following fields:block

DescriptionKey

String. Integration, Operation, or Service name.name

String. Application, Integration, or Service.type

String. Optional. Account andApplication name
if the Block Type is “Application”.

details

Document List. The call stack information
describing where the error occurred including

callStack

details of the block. Each document represents a
block on the call stack. The first document in the
list represents the block that threw the error and
the last document in the list represents the top
level block. It contains the following fields:

DescriptionKey

String. Integration, Operation or Service name.name

String. Application, Integration, or Service.type

String. Optional. Account andApplication name
if the Block Type is “Application”.

details

Usage Notes

You can use this service in the catch section of the try-catch block. Each execution of an Integration
or a service (whether the Integration or the service succeeds or fails) updates the value returned
by getLastError. Consequently, getLastError itself resets the value of lastError. Therefore, if the
results of getLastError will be used as input to subsequent Integrations, map the value of lastError
to a variable in the pipeline.

If a map has multiple transformers, then a subsequent call to getLastError will return the error
associated with the last failed transformer in the map, even if it is followed by successful
transformers.

getSessionInfo
Obtains detailed information about the current logged-in user session. Also provides the current
Integration execution result reference identifier.
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Input Parameters

None

Output Parameters

Document Returns information about the current logged-in user session. Also
provides the current Integration name and the execution result reference identifier.

$session

DescriptionKey

String Tenant Identifier.tenantId

String The stage ID where the current
integration resides.

stageId

Document Returns user details.user

DescriptionKey

StringName of the
user who is

name

executing the
service.

String The name of the Integration.integrationName

Note:
If IntegrationAhas a referenced Integration
B, and if the getSessionInfo service is called
in Integration B, then integrationNamewill
be A but if Integration B is executed
independently, then integrationNamewill
be B.

String Returns the current Integration
execution result reference identifier. For

executionResultReference

example, you can pass the identifier to an
on-premises operation and trace the
Integration execution.

getHTTPRequest
Gets information about the HTTP request, received by Integration Cloud.
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Parameters

Document Contains the header fields from the HTTP request.headers

String URL used by the client to invoke the service.requestURL

StringHTTP method used by the client to request the top-level service. Possible
values are GET, PUT, POST, PATCH, and DELETE.

method

setHTTPResponse
Sets the HTTP response information to be returned by Integration Cloud.

Parameters

Document Optional. Contains the header fields to be returned in the HTTP
response.

headers

String Optional. HTTP status code to be returned to the client.responseCode

The response codes and phrases are defined in https://tools.ietf.org/html/
rfc7231#section-6. If you provide a value for responseCode that is not listed in
RFC 7321, Section 6, you must also provide a value for reasonPhrase.

StringOptional. HTTP reason phrase to be returned to the client. If no reason
is provided, the default reason phrase associated with responseCodewill be

responsePhrase

used. You must provide a reasonPhrase for any responseCode that is not listed
in RFC 7321, Section 6.

String Optional. Response to be returned to the client, specified as a string.responseString

byte[ ]Optional. Response to be returned to the client, specified as a byte array.responseBytes

java.io.InputStreamOptional. Response to be returned to the client, specified
as an InputStream.

responseStream

countProcessedDocuments
Counts the number of documents processed by an Integration. Details about the processed
documents can be viewed in the Execution Results screen.

Input Parameters

StringOptional valid values are "success" or "fail". Set status to "success" to
count the number of successfully processed documents, else set it to "fail".
Default value is "success".

status
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String Optional. Increment the number of documents processed by an
Integration. Every time the service is used, successful or failed documents
are incremented by the given value. Default value is 1.

incrementBy

Output Parameters

None

Usage Notes

To increment the number of documents processed by a list, use the sizeOfList service in the List
service block.

logCustomMessage
Logs a message, which can be viewed in the Execution Results screen.

Input Parameters

StringCustommessage to be logged, which can be viewed in the Execution
Results screen.

message

Output Parameters

None

sleep
Causes the currently executing Integration to pause for the specified number of seconds.

Input Parameters

String The number of seconds to pause the currently executing Integration.
The value must be an integer between 1 second and 60 seconds.

seconds

Output Parameters

None

Hashtable Services

Use Hashtable services to create, update, and obtain information about the hashtable.
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The following Hashtable services are available:

DescriptionService

Checks for the existence of a hashtable element.containsKey

Creates a hashtable object.createHashtable

Gets the value for a specified key in the hashtable.get

Lists all the keys stored in the hashtable.listKeys

Adds a key/value pair in the hashtable.put

Removes a key/value pair from the hashtable.remove

Gets the number of elements in the hashtable.size

containsKey
Checks for the existence of a hashtable element.

Input Parameters

java.util.HashtableHashtable in which to check for the existence of a hashtable
element.

hashtable

StringHashtable element to be checked for.key

Output Parameters

String Indicates whether the specified hashtable element exists. A value of:containsKey

true indicates that the element exists.

false indicates that the element does not exist.

createHashtable
Creates a hashtable object.

Input Parameters

None.

574 Integration Cloud 6.6.0

10 Built-In Services



Output Parameters

java.util.Hashtable The new hashtable object.hashtable

get
Gets the value for a specified key in the hashtable.

Input Parameters

java.util.HashtableHashtable from which to retrieve the specified value.hashtable

String Key of the hashtable element whose value is to be retrieved.key

Output Parameters

Object Value of the input hashtable element.value

listKeys
Lists all the keys stored in the hashtable.

Input Parameters

java.util.HashtableHashtable from which the keys are to be listed.hashtable

Output Parameters

String[] List of keys stored in the input hashtable.keys

put
Adds a key/value pair in the hashtable.

Input Parameters

java.util.HashtableHashtable to which the key/value pair is to be added.hashtable

String Key of the element to be added to the hashtable.key

Object Value of the element to be inserted into the hashtable.value
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Output Parameters

java.util.HashtableHashtable object after the insertion of the key/value pair.hashtable

remove
Removes a key/value pair from the hashtable.

Input Parameters

java.util.HashtableHashtable from which to remove the key/value pair.hashtable

String Key of the hashtable element to be removed.key

Object Value of the hashtable element to be removed.value

Output Parameters

java.util.HashtableHashtable object after the key/value pair is removed.hashtable

Object Value of the hashtable element that was removed. Returns null if the
input key is not found in the hashtable.

value

size
Gets the number of elements in the hashtable.

Input Parameters

java.util.HashtableHashtable from which the number of elements stored in it
is to be retrieved.

hashtable

Output Parameters

StringNumber of elements in the hashtable.size

Flat File Services

Use Flat File services to convert data bytes, data stream, and data string to a document and vice
versa.

The following Flat File services are available:
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DescriptionService

Converts delimited data bytes (byte array) to a document.delimitedDataBytesToDocument

Converts delimited data stream to a document.delimitedDataStreamToDocument

Converts delimited data string to a document.delimitedDataStringToDocument

Converts a document to delimited data bytes (byte array
object).

documentToDelimitedDataBytes

Converts a document to a delimited data stream.documentToDelimitedDataStream

Converts a document to a delimited data string.documentToDelimitedDataString

delimitedDataBytesToDocument
Converts delimited data bytes (byte array) to a document.

This service will convert the following delimited data from byte array:

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Note:
Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

to a document that looks like: (useHeaderRowForFieldNames=true)

or to a document that looks like: (useHeaderRowForFieldNames=false)
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Input Parameters

java.lang.Byte[ ]. Delimited data in bytes (Byte array) to convert to a document.delimited
DataBytes

StringOptional. The delimiter to use for separating entries in delimitedDataBytes.
Default is comma (,).

fieldQualifier

String Optional. The character to use for quoted elements. Default is double
quote (").

textQualifier

String Optional. Consider first line as header row and use the delimited data of
this line as property names in the output document. Set to:

useHeader
RowFor
FieldNames

true. The delimited data of first line will be used as the property name in the
output document. This is the default.

false. column1, column2...columnN will be used as the property name in the
output document.

String Optional. The encoding to use while parsing the delimited data.encoding

Output Parameters

Document. Document resulting from the conversion of delimitedDataBytes. This
document contains document array rows[] corresponding to the delimited data.

document

delimitedDataStreamToDocument
Converts delimited data stream to a document. The permissible size of the content stream is based
on your tenancy. The permissible size of the content stream is based on your tenancy.

This service converts the following delimited data in a stream:

"Date","Pupil","Grade"
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"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Note:
Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

to a document that looks like: (useHeaderRowForFieldNames=true)

or to a document that looks like: (useHeaderRowForFieldNames=false)

Input Parameters

java.io.InputStream. Delimited data in an input stream to convert to a document.delimited
DataStream

StringOptional. The delimiter to use for separating entries in delimitedDataStream.
Default is comma (,).

fieldQualifier

String Optional. The character to use for quoted elements. Default is double
quote (").

textQualifier

String Optional. Consider first line as header row and use the delimited data of
this line as property names in the output document. Set to:

useHeader
RowFor
FieldNames
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true. The delimited data of first line will be used as the property name in the
output document. This is the default.

false. column1, column2...columnN will be used as the property name in the
output document.

String Optional. The encoding to use while parsing the delimited data.encoding

Output Parameters

Document. Document resulting from the conversion of delimitedDataStream. This
document contains document array rows[] corresponding to the delimited data.

document

delimitedDataStringToDocument
Converts delimited data string to a document.

This service will convert the following delimited data string:

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Note:
Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

to a document that looks like: (useHeaderRowForFieldNames=true)

or to a document that looks like: (useHeaderRowForFieldNames=false)
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Input Parameters

String. Delimited string to convert to a document.delimited
DataString

StringOptional. The delimiter to use for separating entries in delimitedDataString.
Default is comma (,).

fieldQualifier

String Optional. The character to use for quoted elements. Default is double
quote (").

textQualifier

String Optional. Consider first line as header row and use the delimited data of
this line as property names in the output document. Set to:

useHeader
RowFor
FieldNames

true. The delimited data of first line will be used as the property name in the
output document. This is the default.

false. column1, column2...columnN will be used as the property name in the
output document.

String Optional. The encoding to use while parsing the delimited data.encoding

Output Parameters

Document. Document resulting from the conversion of delimitedDataString. This
document contains document array rows[] corresponding to the delimited data.

document

documentToDelimitedDataBytes
Converts a document to delimited data bytes (byte array object).

This service will convert the following document:
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To bytes (byte array object) containing the following delimited data:
(useHeaderRowForFieldNames=true)

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Note:
Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

To the byte (byte array object) containing the following delimited data:
(useHeaderRowForFieldNames=false)

"column1","column2","column3"

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

Input Parameters

Document. Document to be converted to delimited data bytes (byte array object).
This document contains a document array rows[] corresponding to the delimited
data.

document

StringOptional. The delimiter to use for separating entries in delimitedDataBytes.
Default is comma (,).

fieldQualifier

String Optional. The character to use for quoted elements. Default is double
quote (").

textQualifier
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String Optional. The first line in the output delimited data delimitedDataBytes
will be constructed using the property names in the input document array
document\rows[]. Set to:

useField
NamesFor
HeaderRow

true. Property names in the input document array document\rows[] will be
used as the first row in the output delimitedDataBytes.

false. column1, column2...columnNwill be used as the first row in the output
delimitedDataBytes.

String Optional. The encoding to use while parsing the delimited data.encoding

Output Parameters

Object. Delimited data byte array object resulting from the conversion of a
document.

delimited
DataBytes

documentToDelimitedDataStream
Converts a document to a delimited data stream.

This service will convert the following document:

To the stream containing the following delimited data: (useHeaderRowForFieldNames=true)

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Note:
Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

or to the stream containing the following delimited data: (useHeaderRowForFieldNames=false)

"column1","column2","column3"
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"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Note:
Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

Input Parameters

Document. Document to be converted to delimited data stream. This document
contains a document array rows[] corresponding to the delimited data.

document

StringOptional. The delimiter to use for separating entries in delimitedDataStream.
Default is comma (,).

fieldQualifier

String Optional. The character to use for quoted elements. Default is double
quote (").

textQualifier

String Optional. The first line in the output delimited data delimitedDataStream
will be constructed using the property names in the input document array
document\rows[]. Set to:

useField
NamesFor
HeaderRow

true. Property names in the input document array document\rows[] will be
used as the first row in the output delimitedDataStream.

false. column1, column2...columnNwill be used as the first row in the output
delimitedDataStream.

String Optional. The encoding to use while parsing the delimited data.encoding

Output Parameters

java.io.InputStream. Delimited data stream resulting from the conversion of a
document.

delimited
DataStream

documentToDelimitedDataString
Converts a document to a delimited data string.

This service will convert the following document:
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To the string containing the following delimited data: (useHeaderRowForFieldNames=true)

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

To the string containing the following delimited data: (useHeaderRowForFieldNames=false)

"column1","column2","column3"

"Date","Pupil","Grade"

"25 May","Bloggs, Fred","C"

"25 May","Doe, Jane","B"

"15 July","Bloggs, Fred","A"

Here the fieldQualifier = Comma(,) and textQualifier= double quote(")

Input Parameters

Document. Document to be converted to delimited data string. This document
contains document array rows[] corresponding to the delimited data.

document

StringOptional. The delimiter to use for separating entries in delimitedDataString.
Default is comma (,).

fieldQualifier

String Optional. The character to use for quoted elements. Default is double
quote (").

textQualifier

String Optional. The first line in the output delimited data delimitedDataString
will be constructed using the property names in the input document array
document\rows[]. Set to:

useField
NamesFor
HeaderRow

true. Property names in the input document array document\rows[] will be
used as the first row in the output delimitedDataString.
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false. column1, column2...columnNwill be used as the first row in the output
delimitedDataString.

String Optional. The encoding to use while parsing the delimited data.encoding

Output Parameters

String. Delimited data byte string resulting from the conversion of a document.delimited
DataString

JSON Services

Use JSON services to convert JSON content into a document and to convert a document into JSON
content.

The following JSON services are available:

DescriptionService

Converts a document to JSON bytes (byte array).documentToJSONBytes

Converts a document to a JSON stream.documentToJSONStream

Converts a document to a JSON string.documentToJSONString

Converts JSON content in bytes (byte array) to a document.jsonBytesToDocument

Converts content from the JSON content stream to a
document.

jsonStreamToDocument

Converts content from the JSON string to a document.jsonStringToDocument

documentToJSONBytes
Converts a document to JSON bytes (byte array).

Input Parameters

Document. The document to be converted to JSON bytes (byte array).document

Output Parameters

Object. JSON bytes (byte array) resulting from the conversion of a document.jsonBytes
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documentToJSONStream
Converts a document to a JSON stream.

Input Parameters

Document. The document to be converted to a JSON stream.document

Output Parameters

java.io.InputStream. JSON stream resulting from the conversion of a document.jsonStream

documentToJSONString
Converts a document to a JSON string.

Input Parameters

Document. The document to be converted to a JSON string.document

String. Formats the jsonString output parameter for human readability by adding
carriage returns and indentation to the JSON content. Set to:

prettyPrint

true to format the jsonString output field for human readability

false to leave the jsonString output field in its unformed state

The service will not add any additional carriage returns or indentation to the
JSON content.

Output Parameters

Object. JSON string resulting from the conversion of a document.jsonString

jsonBytesToDocument
Converts JSON content in bytes (byte array) to a document.

Input Parameters

java.lang.Byte[]. JSON content in bytes (byte array) to convert to a document.jsonBytes
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String. Optional. Converts real numbers from jsonBytes to either a Float or Double
Java wrapper type. Set to:

decodeReal
AsDouble

true to convert real numbers to Double Java wrapper types

false to convert real numbers to Float Java wrapper types

Default value is true.

String. Optional. Converts integers from jsonBytes to either a Long or Integer
Java wrapper type. Set to:

decodeInteger
AsLong

true to convert integers to Long Java wrapper types

false to convert integers to Integer Java wrapper types

Default value is true.

Output Parameters

Document. Document resulting from the conversion of jsonBytes.document

jsonStreamToDocument
Converts content from the JSON content stream to a document. The permissible size of the content
stream is based on your tenancy.

Input Parameters

java.io.InputStream. JSON content in an input stream to convert to a document.jsonStream

String. Optional. Converts real numbers from jsonStream to either a Float or
Double Java wrapper type. Set to:

decodeReal
AsDouble

true to convert real numbers to Double Java wrapper types

false to convert real numbers to Float Java wrapper types

Default value is true.

String. Optional. Converts integers from jsonStream to either a Long or Integer
Java wrapper type. Set to:

decodeInteger
AsLong

true to convert integers to Long Java wrapper types

false to convert integers to Integer Java wrapper types

Default value is true.
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Output Parameters

Document. Document resulting from the conversion of jsonStream.document

jsonStringToDocument
Converts content from the JSON content string to a document.

Input Parameters

String. JSON content string to convert to a document.jsonString

String. Optional. Converts real numbers from jsonString to either a Float orDouble
Java wrapper type. Set to:

decodeReal
AsDouble

true to convert real numbers to Double Java wrapper types

false to convert real numbers to Float Java wrapper types

Default value is true.

String. Optional. Converts integers from jsonString to either a Long or Integer
Java wrapper type. Set to:

decodeInteger
AsLong

true to convert integers to Long Java wrapper types

false to convert integers to Integer Java wrapper types

Default value is true.

Output Parameters

Document. Document resulting from the conversion of jsonString.document

Transaction Services

Use Transaction services only in conjunctionwithDatabaseApplication operations. These services
are applicable when the Database Application account is of type Transactional.

The following Transaction services are available:

DescriptionService

Commits an explicit transaction.Transaction:commit

Rolls back an explicit transaction.Transaction:rollback
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DescriptionService

Manually sets a transaction timeout interval for implicit and
explicit transactions.

Transaction:setTimeout

Starts an explicit transaction.Transaction:start

Transaction:commit
Commits an explicit transaction.

Input Parameters

Document Information for each commit request.commitTransactionInput

DescriptionKey

StringThe name of an explicit transaction that
you want to commit. The transactionName

transactionName

must have been previously used in a call to
Transaction:start.

This value must be mapped from the most
recent Transaction:start that has not previously
been committed or rolled back.

Output Parameters

None.

Usage Notes

This service must be used in conjunction with the Transaction:start service. If the transactionName
parameter was not provided in a prior call to Transaction:start, a run-time error will be returned.

Transaction:rollback
Rolls back an explicit transaction.

Input Parameters

Document List Information for each rollback request.rollbackTransactionInput

DescriptionKey
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String The name of an explicit transaction
that you want to roll back. The

transactionName

transactionNamemust have been previously
used in a call to Transaction:start.

This value must be mapped from the most
recent Transaction:start that has not
previously been committed or rolled back.

Output Parameters

None.

Usage Notes

This servicemust be used in conjunctionwith the Transaction:start service. If the given transactionName
parameter was not provided in a prior call to Transaction:start, a run-time error will be returned.

Transaction:setTimeout
Manually sets a transaction timeout interval for implicit and explicit transactions.

Input Parameters

Integer The number of seconds that the implicit or explicit transaction
stays open before the transaction manager marks it for rollback.

timeoutSeconds

Output Parameters

None.

Usage Notes

You must call this service before you call the Transaction:start service.

If the execution of a transaction takes longer than the transaction timeout interval, all transacted
operations are rolled back.

Transaction:start
Starts an explicit transaction.
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Input Parameters

Document Information for each start transaction request.startTransactionInput

DescriptionKey

StringOptional. Specifies the name of the
transaction to be started. If you leave this

transactionName

parameter blank, theDatabaseApplication
will generate a name for you. In most
implementations it is not necessary to
provide your own transaction name.

Output Parameters

Document Information for each start transaction request.startTransactionOutput

DescriptionKey

String The name of the transaction the
service just started.

transactionName

Usage Notes

This service is intended for use with the Transaction:commit or Transaction:rollback service. The
transactionName value returned by a call to this service can be provided to Transaction:commit (to
commit the transaction) or Transaction:rollback (to roll back the transaction).

XML Services

Use XML services to convert a document to XML content and XML content to a document.

The following XML services are available:

DescriptionService

Converts a document to XML content bytes, as a byte array
object.

documentToXMLBytes

Converts a document to XML stream, as a
java.io.InputStream object.

documentToXMLStream

Converts a document to XML content string.documentToXMLString

Converts XML content bytes (byte array) to a document.xmlBytesToDocument

Converts an XML node to a document.xmlNodeToDocument
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DescriptionService

Converts an XML content stream to a document.xmlStreamToDocument

Converts an XML string to a document.xmlStringToDocument

Converts a String, byte[], or InputStream containing anXML
document to an XML node.

xmlStringToXMLNode

Returns information about an XML node.getXMLNodeType

Queries an XML node.queryXMLNode

documentToXMLBytes
Converts a document to xml content bytes, as a byte array object. This service will recurse through
a given document and build an XML representation from the elements within it. Key names are
turned into XML elements, and the key values are turned into the contents of those elements.

This service will convert the following document:

To XML document bytes (byte array object), whose content looks like:
<?xml version="1.0" ?>
<tns:AcctInfo>
xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA><street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
</address>
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<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state><postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>
</address>
<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
<serialNum>20010404K</serialNum>
</tns:AcctInfo>

Input Parameters

Document. Document that is to be converted to XML.Note
that if you want to produce a valid XML document (one

document

with a single root node), document must contain only one
top-level document that is, a single document. The name
of that document will serve as the name of the XML
document's root element. If you need to produce an XML
fragment, for example, a loose collection of elements that
are not encompassed within a single root element, then
document can contain multiple top level elements.

Document. Optional. Namespaces associated with any
namespace prefixes that are used in the key names in

nsDecls [ ]

document. Each entry in nsDecls represents a namespace
prefix/URI pair, where a key name represents a prefix and
the value of the key specifies the namespace URI. For
example, to define the URIs associated with two prefixes
called GSX and TxMon, you would set nsDecls as follows:

For each prefix specified in nsDecls, this service generates
an xmlns attribute and inserts it into the top-most element
of the resulting XML String. For example, if nsDecls had
the two keys shown above, this service would insert the
following attribute into the root element of the XMLString:

xmlns:gsx="http://www.gsx.com"

xmlns:TxMon="http:www.acrtrak/txMonitor"

Alternatively, you can declare a namespace by including
an @xmlns key in document. If you were not using the @
character to designate attributes, use the correct attribute
prefix in your code.

Parameters for nsDecls [ ] are:
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prefix: Key name.

uri: Key value.

String. Optional.addHeader

Flag specifying whether the header element <?xml
version="1.0"?> is to be included in the resultingXMLString.

Set to:

true to include the header. This is the default.

false to omit the header. Omit the header to generate an
XML fragment or to insert a custom header.

String Optional. Prefix that designates keys containing
attributes. The default prefix is "@".

attrPrefix

For example, if you set attrPrefix to ATT_ and document
contained the following element:

documentToXMLByteswould convert the ATT_currency key to
the attribute, currency=dollars, in the <tx> element as
shown below:
<tx currency=dollars>
<acct>cash</acct>
<amt>120.00</amt>
</tx>

StringOptional. Flag indicatingwhether to HTML-encode
the data. Set this parameter to true if your XML data

encode

contains special characters, including the following: < > &
" '

Set to:

true to HTML-encode the data.

For example, the string expression 5 < 6would be
converted to <expr>5 &lt; 6</expr>, which is valid.

If you do not want a leading & (ampersand) character
encodedwhen it appears as part of a character or entity
reference, set preserveRefs to true.

false to not HTML-encode the data. This is the default.

For example, the string expression 5 < 6would be
converted to <expr>5 < 6</expr>, which is invalid.
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String Optional. Flag indicating whether the leading &
(ampersand) of a well-formed entity or character reference

preserveRefs

is left as & or further encoded as &amp;when the data is to
be HTML-encoded (encode is set to true).

Set to:

true to preserve the leading & (ampersand) in an entity
or character referencewhen the serviceHTML-encodes
the data.

false to encode the leading & (ampersand) as &amp;
when the & appears in an entity or character reference.
This is the default.

The service ignores the value of preseveRefswhen encode is
set to false.

StringOptional. Flag indicatingwhether the service throws
an exceptionwhen document containsmultiple root elements
or illegal XML tag names. Set to:

enforceLegalXML

true to throw an exception if documentwould produce
anXMLString containingmultiple root elements and/or
illegal XML tag names.

false to allow the resulting XML String to contain
multiple root elements and/or illegal XML tag names.
You would use this setting, for example, to create an
XML fragment composed of multiple elements that
were not all enclosed within a root element. This is the
default.

Output Parameters

Object. XML content bytes (byte array) produced from document.xmlBytes

Usage Notes

If you are building a Document that will be converted to an XML String, keep
the following points in mind:

If you want to generate a simple element that contains only a character value,
represent it with a String element in the document as shown below:
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If you want to generate an element that contains children, represent with a
document in the document as shown below:

If you want to generate a simple element that contains a character value and one
ormore attributes, youmust represent it as a document that has one key for each
attribute and a key named *body that contains the element's value.

For example, if you want to produce the following element:

<phoneNumcc=011>216-741-7566</phoneNum>, youwould include the following
in document:

To include namespaces, ensure that you do the following:

Include the appropriate namespace prefix in the key names in document. For
example, to produce an element called acctNum that belongs to a namespace
that is represented by the "GSX" prefix, you would include a key named
GSX:acctNum in document.

Define theURIs for the prefixes that appear in document. You can do this through
nsDecls or by including an @xmlns key in the element where youwant the xmlns
attribute to be inserted.

documentToXMLStream
Converts a document to xml stream, as a java.io.InputStream object. This service will recurse
through a given document and build an XML representation from the elements within it. Key
names are turned into XML elements and the key values are turned into contents of those elements.

This service will convert the following document:
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To an XML document stream, whose content looks like:
<?xml version="1.0" ?>
<tns:AcctInfo>
xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA>
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
</address>
<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>
</address>
<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
<serialNum>20010404K</serialNum>
</tns:AcctInfo>

Input Parameters

Document. Document that is to be converted to XML. Note that if
youwant to produce a valid XMLdocument (onewith a single root

document

node), document must contain only one top-level document that
is, a single document. The name of that document will serve as the
name of the XML document's root element. If you need to produce
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an XML fragment, for example, a loose collection of elements that
are not encompassed within a single root element, then document
can contain multiple top level elements.

Document. Optional. Namespaces associatedwith any namespace
prefixes that are used in the key names in document. Each entry

nsDecls [ ]

in nsDecls represents a namespace prefix/URI pair, where a key
name represents a prefix and the value of the key specifies the
namespace URI. For example, to define the URIs associated with
two prefixes called GSX and TxMon, you would set nsDecls as
follows:

For each prefix specified in nsDecls, this service generates an xmlns
attribute and inserts it into the top-most element of the resulting
XMLString. For example, if nsDecls had the two keys shown above,
this service would insert the following attribute into the root
element of the XML String:

xmlns:gsx="http://www.gsx.com"

xmlns:TxMon="http:www.acrtrak/txMonitor"

Alternatively, you can declare a namespace by including an@xmlns
key in document. If youwere not using the @ character to designate
attributes, use the correct attribute prefix in your code.

Parameters for nsDecls [ ] are:

prefix: Key name.

uri: Key value.

String. Optional.addHeader

Flag specifying whether the header element <?xml version="1.0"?>
is to be included in the resulting XML String.

Set to:

true to include the header. This is the default.

false to omit the header. Omit the header to generate an XML
fragment or to insert a custom header.

String Optional. Prefix that designates keys containing attributes.
The default prefix is "@".

attrPrefix

For example, if you set attrPrefix to ATT_ and document contained
the following element:
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documentToXMLStreamwould convert the ATT_currency key to the
attribute, currency=dollars, in the <tx> element as shown below:
<tx currency=dollars>
<acct>cash</acct>
<amt>120.00</amt>
</tx>

StringOptional. Flag indicatingwhether toHTML-encode the data.
Set this parameter to true if your XML data contains special
characters, including the following: < > & " '

encode

Set to:

true to HTML-encode the data.

For example, the string expression 5 < 6would be converted
to <expr>5 &lt; 6</expr>, which is valid.

If you do not want a leading & (ampersand) character encoded
when it appears as part of a character or entity reference, set
preserveRefs to true.

false to not HTML-encode the data. This is the default.

For example, the string expression 5 < 6would be converted
to <expr>5 < 6</expr>, which is invalid.

StringOptional. Flag indicatingwhether the leading & (ampersand)
of a well-formed entity or character reference is left as & or further

preserveRefs

encoded as &amp;when the data is to be HTML-encoded (encode is
set to true).

Set to:

true to preserve the leading & (ampersand) in an entity or
character reference when the service HTML-encodes the data.

false to encode the leading& (ampersand) as &amp;when the
& appears in an entity or character reference. This is the default.

The service ignores the value of preseveRefswhen encode is set to
false.

String Optional. Flag indicating whether the service throws an
exceptionwhen document containsmultiple root elements or illegal
XML tag names. Set to:

enforceLegalXML
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true to throw an exception if documentwould produce an XML
String containing multiple root elements and/or illegal XML
tag names.

false to allow the resulting XML String to contain multiple
root elements and/or illegal XML tag names. You would use
this setting, for example, to create an XML fragment composed
of multiple elements that were not all enclosed within a root
element. This is the default.

Output Parameters

java.io.InputStream. XML content stream produced from document.xmlStream

Usage Notes

If you are building a Document that will be converted to an XML String, keep
the following points in mind:

If you want to generate a simple element that contains only a character value,
represent it with a String element in document as shown below:

If you want to generate an element that contains children, represent with a
document in the document as shown below:

If you want to generate a simple element that contains a character value and one
ormore attributes, youmust represent it as a document that has one key for each
attribute and a key named *body that contains the element's value.

For example, if you want to produce the following element:

<phoneNum cc=011>216-741-7566</phoneNum>

You would include the following in document:

To include namespaces, ensure that you do the following:

Include the appropriate namespace prefix in the key names in document. For
example, to produce an element called acctNum that belongs to a namespace
that is represented by the "GSX" prefix, you would include a key named
GSX:acctNum in document.
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Define theURIs for the prefixes that appear in document. You can do this through
nsDecls or by including an @xmlns key in the element where youwant the xmlns
attribute to be inserted.

documentToXMLString
Converts a document to xml content string. This service will recurse through a given document
and build an XML representation from the elements within it. Key names are turned into XML
elements, and the key values are turned into the contents of those elements.

This service will convert the following document:

To an XML document string, whose content looks like:
<?xml version="1.0" ?>
<tns:AcctInfo>
xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA>
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
</address>
<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>
</address>
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<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
<serialNum>20010404K</serialNum>
</tns:AcctInfo>

Input Parameters

Document. Document that is to be converted to XML. If you
want to produce a valid XML document (one with a single root

document

node), document must contain only one top-level document
that is, a single document. The name of that documentwill serve
as the name of the XML document's root element. If you need
to produce an XML fragment, for example, a loose collection of
elements that are not encompassedwithin a single root element,
then document can contain multiple top level elements.

Document. Optional. Namespaces associated with any
namespace prefixes that are used in the key names in document.

nsDecls [ ]

Each entry in nsDecls represents a namespace prefix/URI pair,
where a key name represents a prefix and the value of the key
specifies the namespace URI. For example, to define the URIs
associatedwith two prefixes calledGSX and TxMon, youwould
set nsDecls as follows:

For each prefix specified in nsDecls, this service generates an
xmlns attribute and inserts it into the top-most element of the
resulting XML String. For example, if nsDecls had the two keys
shown above, this service would insert the following attribute
into the root element of the XML String:

xmlns:gsx="http://www.gsx.com"

xmlns:TxMon="http:www.acrtrak/txMonitor"

Alternatively, you can declare a namespace by including an
@xmlns key in document. If you were not using the @ character
to designate attributes, use the correct attribute prefix in your
code.

Parameters for nsDecls [ ] are:

prefix: Key name.

uri: Key value.

String. Optional.addHeader

Flag specifying whether the header element <?xml
version="1.0"?> is to be included in the resulting XML String.
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Set to:

true to include the header. This is the default.

false to omit the header. Omit the header to generate an XML
fragment or to insert a custom header.

String Optional. Prefix that designates keys containing
attributes. The default prefix is "@".

attrPrefix

For example, if you set attrPrefix to ATT_ and document contained
the following element:

documentToXMLStringwould convert the ATT_currency key to the
attribute, currency=dollars, in the <tx> element as shownbelow:
<tx currency=dollars>
<acct>cash</acct>
<amt>120.00</amt>
</tx>

String Optional. Flag indicating whether to HTML-encode the
data. Set this parameter to true if your XMLdata contains special
characters, including the following: < > & " '

encode

Set to:

true to HTML-encode the data.

For example, the string expression 5 < 6would be converted
to <expr>5 &lt; 6</expr>, which is valid.

If you do not want a leading & (ampersand) character
encoded when it appears as part of a character or entity
reference, set preserveRefs to true.

false to not HTML-encode the data. This is the default.

For example, the string expression 5 < 6would be converted
to <expr>5 < 6</expr>, which is invalid.

String Optional. Flag indicating whether the leading &
(ampersand) of a well-formed entity or character reference is

preserveRefs

left as & or further encoded as &amp;when the data is to be
HTML-encoded (encode is set to true).

Set to:
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true to preserve the leading & (ampersand) in an entity or
character reference when the service HTML-encodes the
data.

false to encode the leading & (ampersand) as &amp; when
the & appears in an entity or character reference. This is the
default.

The service ignores the value of preseveRefswhen encode is set
to false.

StringOptional. Flag indicating whether the service throws an
exception when document contains multiple root elements or
illegal XML tag names. Set to:

enforceLegalXML

true to throw an exception if documentwould produce an
XML String containingmultiple root elements and/or illegal
XML tag names.

false to allow the resulting XML String to contain multiple
root elements and/or illegal XML tag names. Youwould use
this setting, for example, to create an XML fragment
composed of multiple elements that were not all enclosed
within a root element. This is the default.

Output Parameters

Object. XML document string produced from document.xmlString

Usage Notes

If you are building a Document that will be converted to an XML String, keep
the following points in mind:

If you want to generate a simple element that contains only a character value,
represent it with a String element in document as shown below:

If you want to generate an element that contains children, represent with a
document in the document as shown below:
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If you want to generate a simple element that contains a character value and one
ormore attributes, youmust represent it as a document that has one key for each
attribute and a key named *body that contains the element's value.

For example, if you want to produce the following element:

<phoneNum cc=011>216-741-7566</phoneNum>

You would include the following in document:

To include namespaces, ensure that you do the following:

Include the appropriate namespace prefix in the key names in document. For
example, to produce an element called acctNum that belongs to a namespace
that is represented by the "GSX" prefix, you would include a key named
GSX:acctNum in document.

Define theURIs for the prefixes that appear in document. You can do this through
nsDecls or by including an @xmlns key in the element where youwant the xmlns
attribute to be inserted.

xmlBytesToDocument
Converts XML content bytes (byte array) to a document. This service transforms each element and
attribute in XML content bytes to an element in a Document.

This service will convert XML bytes containing the following XML content:
<?xml version="1.0" ?>
<tns:AcctInfo>
xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA>
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
</address>
<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>
</address>
<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
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<serialNum>20010404K</serialNum>
</tns:AcctInfo>

To a Document that looks like:

Input Parameters

Object. XML content bytes that is to be converted to a document.xmlBytes

Document. Optional. Namespace prefixes to use for the conversion. This
parameter specifies the prefixes that will be used when namespace-qualified

nsDecls [ ]

elements are converted to key names in the resulting document object. For
example, if you want elements belonging to a particular namespace to have the
prefix GSX in the resulting document, for example, GSX:acctNum, you would
associate the prefix GSX with that namespace in nsDecls . This is important
because incoming XML documents can use any prefix for a given namespace,
but the key names expected by a target servicewill have a fixed prefix.Namespace
prefixes in nsDecls also define the prefixes used by the arrays, documents,
documentTypeName, and collect parameters. Each entry in nsDecls represents
a namespace prefix/URI pair, where a key name represents a prefix and the value
of the key specifies the namespaceURI. For example, to define theURIs associated
with two prefixes called GSX and TxMon, you would set nsDecls as follows:

Parameters for nsDecls [ ] are:

prefix: Key name.

uri: Key value.

Integration Cloud 6.6.0 607

10 Built-In Services



String Optional. Flag indicating whether or not Integration Cloud keeps
undeclared namespaces in the resulting document. An undeclared namespace
is one that is not specified as part of the nsDecls input parameter.

preserveUn 
declaredNS

Set to:

True to preserve undeclared namespaces in the resulting document. For each
namespace declaration in the XML document that is not specified in the
nsDecls parameter, Integration Cloud adds the xmlns attribute as a String
variable to the document. Integration Cloud gives the variable a name that
beginswith "@xmlns" and assigns the variable the namespace value specified
in the XML document. Integration Cloud preserves the position of the
undeclared namespace in the resulting document.

False to ignore namespace declarations in the XML document that are not
specified in the nsDecls parameter. This is the default.

StringOptional. Flag indicating whether or not Integration Cloudmaintains the
position of namespaces declared in the nsDecls parameter in the resulting
document.

preserveNS 
Positions

Set to:

True to preserve the position of namespaces declared in nsDecls in the resulting
document. For each namespace specified in the nsDeclsparameter, Integration
Cloud adds the xmlns attribute to the document as a String variable named
"@xmlns:NSprefix" where "NSprefix" is the prefix name specified in nsDecls.
Integration Cloud assigns the variable the namespace value specified in the
XML document. This variable maintains the position of the xmlns attribute
declaration within the XML document.

False to not maintain the position of the namespace declarations specified in
nsDecls in the resulting document. This is the default.

Output Parameters

Document. Document representation of nodes and attributes in node.document

Usage Notes

Following are examples of XML documents and the documents that xmlBytesToDocumentwill
produce:

DocumentXML Document
<myDoc><e1>e1Value</e1>
</myDoc>
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<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>e1Value
</e1></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1
e1Attr="attrValue">
e1Value</e1></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>e1Value
</e1><e2>e2Value</e2></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>e1Value1
</e1><e2>e2Value</e2><e1>e1Value2
</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>
<myDoc><e1 e1Attr="attrValue1">e1Value1
</e1><e2>e2Value</e2><e1 e1Attr=
"attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>
<myDoc><e1 e1Attr="attrValue1">
e1Value1
</e1><e2>e2Value</e2><e1
e1Attr="attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>
<myDoc><e1 e1Attr="attrValue1">e1Value1
</e1><e2>e2Value</e2><e1 e1Attr=
"attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>
<myDoc><e1 e1Attr="attrValue1">e1Value1
</e1><e2><e3>e3Value</e3>
<e4 e4Attr="attrValue4"e4Attrb=
"attrValue4b">
e4Value</e4></e2></myDoc>
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<?xml version="1.0" encoding="UTF-8"
standalone="no"?><tns:AcctInfo>
xmlns:tns="http://localhost/
DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance">
<myDoc>
<e1>e1Value</e1></myDoc>
<myDoc xsi:type="tns:DerivedDoc">
<e1>e1Value</e1><e2>
e2Value</e2></myDoc>
</tns:AcctInfo>

xmlNodeToDocument
Converts an XML node to a document.

This service transforms each element and attribute in the XML node to an element in a Document.
For example:

This service would convert this XML document...
<?xml version="1.0" ?>
<tns:AcctInfo>

xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" >
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA>

<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>

</address>
<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>

<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>

</address>
<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
<serialNum>20010404K</serialNum>

</tns:AcctInfo>
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To a document that looks like this...

Note that:

The XML version attribute is converted to an element named @version.

The resulting document is given the same name as the XMLdocument's root element (AcctInfo
in the example above) and is a child of the document variable that this service returns.

Simple elements (such as <name> and <rep> in the example above) are converted to String
elements.

Complex elements (that is, elements with children, such as <address> in the example above)
and simple elements that have attributes (such as <acctNum> and <phoneNum>) are converted to
documents. Note that keys derived from attributes are prefixed with a "@" character to
distinguish them from keys derived from elements. Also note that when a simple element has
an attribute, its value is placed in an element named *body.

Repeated elements (such as <serialNum>) can be collected into arrays using the makeArrays
and/or arrays parameters. See makeArrays and arrays below for additional information about
producing arrays.

While creating a document, the xmlNodeToDocument service assigns a value of emptyString to
the fields that are empty in the document.
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Input Parameters

XML node that is to be converted to a document.node

This parameter supports the following types of input:

com.wm.lang.xml.Node

org.w3c.dom.Node

String Optional. Prefix that is to be used to designate keys
containing attribute values. The default is "@". For example, if

attrPrefix

you set attrPrefix to ATT_ and node contained the following
element:
<tx currency=dollars>
<acct>cash</acct>
<amt>120.00</amt>
</tx>

xmlNodeToDocument would convert the currency attribute as
follows:

StringListOptional.Names of elements that are to be generated
as arrays, regardless of whether they appear multiple times in

arrays[]

node. For example, if arrays contained the following values for
the XML document shown in the example in the description
for this service:
rep
address

xmlNodeToDocument would generate element rep as a String List
and element address as a Document List.

Important:
If you include namespace prefixes in the element names that
you specify in arrays, you must define the namespaces
associated with those prefixes in nsDecls.

String Optional. Flag indicating whether you want
xmlNodeToDocument to automatically create an array for every
element that appears in nodemore than once. Set to:

makeArrays

true to automatically create arrays for every element that
appears more than once in node. This is the default.

false to create arrays for only those elements specified in
arrays.

612 Integration Cloud 6.6.0

10 Built-In Services



DocumentOptional. Elements that are to be placed into a new,
named array (that is, a "collection"). Within collect, use key

collect

names to specify the names of the elements that are to be
included in the collection. Then set the value of each key to
specify the name of the collection in which you want that
element placed. For example, if youwanted to place the <name>
and <rep> elements in an array called originator, you would
set collect as follows:

ValueKey

originatorname

originatorrep

If the set of elements in a collection are all simple elements, a
String List is produced. However, if the set is made up of
complex elements, or a combination of simple and complex
elements, a Document List is produced. When this is the case,
each member of the array will include a child element called
*name that contains the name of the element from which that
member was derived.

Youmay optionally include namespace prefixes in the element
names that you specify in collect; however, if you do, you must
define the namespaces associatedwith those prefixes in nsDecls.

Important:
You cannot include an element in more than one collection.

Document Optional. Namespace prefixes to use for the
conversion. This parameter specifies the prefixes that will be

nsDecls

usedwhen namespace-qualified elements are converted to key
names in the resulting Document. For example, if you want
elements belonging to a particular namespace to have the prefix
GSX in the resultingDocument (for example, GSX:acctNum), you
would associate the prefixGSXwith that namespace in nsDecls.
(This is important because incoming XML documents can use
any prefix for a given namespace, but the key names expected
by a target service will have a fixed prefix.)

Namespace prefixes in nsDecls also define the prefixes used by
the arrays, documents, and collect parameters.

Each entry in nsDecls represents a namespace prefix/URI pair,
where a key name represents a prefix and the value of the key
specifies the namespace URI.

For example, to define the URIs associated with two prefixes
called GSX and TxMon, you would set nsDecls as follows:
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String List Optional. Names of any simple elements that are
to be generated as documents instead of Strings. The document

documents[]

produced for each element specified in documents[]will have
the same name as the source element from which it is derived.
It will contain a String element named *body that holds the
element's value.

For example, if documents[] contained the Strings name and rep
and the source document contained the following:
.
.
.
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
.
.
.

xmlNodeToDocument would produce the following:

Note:
If you include namespace prefixes in the element names that
you specify, youmust define the namespaces associatedwith
those prefixes in nsDecls.

String Optional. Flag specifying how mixed-content elements
(elements containing both text values and child elements) are

mixedModel

to be converted. The following is an example of amixed-content
element:
<comment>
This job is <status>pending</status>. Estimated
completion date is <edc>Feb 14, 2000</edc>.
</comment>

Set to:

true to place top-level text in an element named *body. This
setting would produce the following Document for the
<comment> element shown above:
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false to omit top-level text and include only the child
elements frommixed-content elements. This settingwould
produce the followingDocument for the <comment> element
shown above:

String Optional. Flag indicating whether or not Integration
Cloudkeeps undeclared namespaces in the resulting document.

preserveUndeclaredNS

An undeclared namespace is one that is not specified as part
of the nsDecls input parameter.

Set to:

True to preserve undeclared namespaces in the resulting
document. For each namespace declaration in the XML
document that is not specified in the nsDecls parameter,
Integration Cloud adds the xmlns attribute as a String
variable to the document. Integration Cloud gives the
variable a name that begins with "@xmlns" and assigns the
variable the namespace value specified in the XML
document. Integration Cloud preserves the position of the
undeclared namespace in the resulting document.

False to ignore namespace declarations in the XML
document that are not specified in the nsDecls parameter.
This is the default.

String Optional. Flag indicating whether or not Integration
Cloud maintains the position of namespaces declared in the
nsDecls parameter in the resulting document.

preserveNSPositions

Set to:

True to preserve the position of namespaces declared in
nsDecls in the resulting document. For each namespace
specified in the nsDecls parameter, Integration Cloud adds
the xmlns attribute to the document (IData) as a String
variable named "@xmlns:NSprefix" where "NSprefix" is the
prefix name specified in nsDecls. Integration Cloud assigns
the variable the namespace value specified in the XML
document. This variablemaintains the position of the xmlns
attribute declaration within the XML document.
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False to not maintain the position of the namespace
declarations specified in nsDecls in the resulting document.
This is the default.

Output Parameters

DocumentDocument representation of the nodes and attributes in node.document

Examples

Following are examples of XML documents and the documents that xmlNodeToDocument would
produce.

Output from xmlNodeToDocumentXML Document
<myDoc>
<e1>e1Value</e1>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?>
<myDoc>
<e1>e1Value</e1>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?>
<myDoc>
<e1 e1Attr="attrValue">e1Value</e1>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?>
<myDoc>
<e1>e1Value</e1>
<e2>e2Value</e2>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?>
<myDoc>
<e1>e1Value1</e1>
<e2>e2Value</e2>
<e1>e1Value2</e1>
</myDoc>
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Output from xmlNodeToDocumentXML Document
<?xml version="1.0"
encoding="UTF-8"?>
<myDoc>
<e1 e1Attr="attrValue1">e1Value1</e1>

<e2>e2Value</e2>
<e1 e1Attr="attrValue2">e1Value2</e1>

</myDoc>

Note:
This example assumes that makeArrays is set
to true. Note that e1was created as a document
list, which holds both <e1> elements from the
XML document.

<?xml version="1.0"
encoding="UTF-8"?>
<myDoc>
<e1 e1Attr="attrValue1">e1Value1</e1>

<e2>e2Value</e2>
<e1 e1Attr="attrValue2">e1Value2</e1>

</myDoc>

<?xml version="1.0"
encoding="UTF-8"?>
<myDoc>
<e1 e1Attr="attrValue1">e1Value1</e1>

<e2>e2Value</e2>
<e1 e1Attr="attrValue2">e1Value2</e1>

</myDoc>

<?xml version="1.0"
encoding="UTF-8"?>
<myDoc>
<e1 e1Attr="attrValue1">e1Value1</e1>

<e2>
<e3>e3Value</e3>
<e4 e4Attr="attrValue4"
e4Attrb="attrValue4b">e4Value
</e4>
</e2>
</myDoc>
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Output from xmlNodeToDocumentXML Document
<?xml version="1.0" encoding="UTF-8"
standalone="no"?>
<tns:AcctInfo>

xmlns:tns="http://localhost/Derived
Address/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" >

<myDoc> <e1>e1Value</e1>
</myDoc>
<myDoc xsi:type="tns:DerivedDoc">

<e1>e1Value</e1>
<e2>e1Value</e2>
</myDoc>

</tns:AcctInfo>

xmlStreamToDocument
Converts an XML content stream to a document. This service transforms each element and attribute
in the XML content stream to an element in a Document.

This service will convert the XML stream containing the following XML content:
<?xml version="1.0" ?>
<tns:AcctInfo>
xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA>
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
</address>
<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>
</address>
<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
<serialNum>20010404K</serialNum>
</tns:AcctInfo>

To a Document that looks like:
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Input Parameters

java.io.InputStream. XML content stream that is to be converted to a document.xmlStream

Document. Optional. Namespace prefixes to use for the conversion. This
parameter specifies the prefixes that will be used when namespace-qualified

nsDecls [ ]

elements are converted to key names in the resulting document object. For
example, if you want elements belonging to a particular namespace to have the
prefix GSX in the resulting document, for example, GSX:acctNum, you would
associate the prefix GSX with that namespace in nsDecls . This is important
because incoming XML documents can use any prefix for a given namespace,
but the key names expected by a target servicewill have a fixed prefix.Namespace
prefixes in nsDecls also define the prefixes used by the arrays, documents,
documentTypeName, and collect parameters. Each entry in nsDecls represents
a namespace prefix/URI pair, where a key name represents a prefix and the value
of the key specifies the namespaceURI. For example, to define theURIs associated
with two prefixes called GSX and TxMon, you would set nsDecls as follows:

Parameters for nsDecls [ ] are:

prefix: Key name.

uri: Key value.

String Optional. Flag indicating whether or not Integration Cloud keeps
undeclared namespaces in the resulting document. An undeclared namespace
is one that is not specified as part of the nsDecls input parameter.

preserveUn 
declaredNS

Set to:
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True to preserve undeclared namespaces in the resulting document. For each
namespace declaration in the XML document that is not specified in the
nsDecls parameter, Integration Cloud adds the xmlns attribute as a String
variable to the document. Integration Cloud gives the variable a name that
beginswith "@xmlns" and assigns the variable the namespace value specified
in the XML document. Integration Cloud preserves the position of the
undeclared namespace in the resulting document.

False to ignore namespace declarations in the XML document that are not
specified in the nsDecls parameter. This is the default.

StringOptional. Flag indicating whether or not Integration Cloudmaintains the
position of namespaces declared in the nsDecls parameter in the resulting
document.

preserveNS 
Positions

Set to:

True to preserve the position of namespaces declared in nsDecls in the resulting
document. For each namespace specified in the nsDeclsparameter, Integration
Cloud adds the xmlns attribute to the document as a String variable named
"@xmlns:NSprefix" where "NSprefix" is the prefix name specified in nsDecls.
Integration Cloud assigns the variable the namespace value specified in the
XML document. This variable maintains the position of the xmlns attribute
declaration within the XML document.

False to not maintain the position of the namespace declarations specified in
nsDecls in the resulting document. This is the default.

Output Parameters

Document. Document representation of nodes and attributes in node.document

Usage Notes

Following are examples of XML documents and the documents that xmlStreamToDocumentwill
produce:

DocumentXML Document
<myDoc><e1>e1Value</e1>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>
e1Value</e1></myDoc>
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<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc>
<e1 e1Attr="attrValue">
e1Value</e1></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc>
<e1>e1Value</e1><e2>e2Value</e2>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>
e1Value1</e1><e2>
e2Value</e2><e1>
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2>e2Value</e2>
<e1 e1Attr="attrValue2">e1Value2
</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2>
e2Value</e2><e1 e1Attr="attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2>e2Value</e2>
<e1 e1Attr="attrValue2">
e1Value2</e1>
</myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1
</e1><e2><e3>e3Value</e3>
<e4 e4Attr=
"attrValue4"e4Attrb="attrValue4b">
e4Value
</e4></e2></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><tns:AcctInfo>
xmlns:tns="http://localhost/
DerivedAddress/
schema.xsd"xmlns:xsi="http://www
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.w3.org/
2001/XMLSchema-instance"><myDoc>
<e1>e1Value</e1></myDoc>
<myDoc xsi:type="tns:DerivedDoc">
<e1>e1Value</e1><e2>e2Value</e2>
</myDoc>
</tns:AcctInfo>

xmlStringToDocument
Converts an XML string to a document. This service transforms each element and attribute in the
XML string to an element in a Document.

This service will convert the following XML string:
<?xml version="1.0" ?>
<tns:AcctInfo>
xmlns:tns="http://localhost/DerivedAddress/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<name>Midwest Extreme Sports</name>
<rep>Laura M. Sanchez</rep>
<acctNum type=platinum>G97041A</acctNum>
<phoneNum cc=011>216-741-7566</phoneNum>
<address country=USA>
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
</address>
<address country=USA xsi:type="tns:DerivedAddress">
<street1>10211 Brook Road</street1>
<city>Cleveland</city>
<state>OH</state>
<postalCode>22130</postalCode>
<landMark>Besides Ohio River-Bank Square</landMark>
<telNo>001222555</telNo>
</address>
<serialNum>19970523A</serialNum>
<serialNum>20001106G</serialNum>
<serialNum>20010404K</serialNum>
</tns:AcctInfo>

To a Document that looks like:
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Input Parameters

String. XML string that is to be converted to a document.xmlString

Document. Optional. Namespace prefixes to use for the
conversion. This parameter specifies the prefixes that will

nsDecls [ ]

be usedwhen namespace-qualified elements are converted
to key names in the resulting document object. For example,
if you want elements belonging to a particular namespace
to have the prefix GSX in the resulting document, for
example, GSX:acctNum, you would associate the prefix
GSX with that namespace in nsDecls . This is important
because incoming XML documents can use any prefix for
a given namespace, but the key names expected by a target
service will have a fixed prefix. Namespace prefixes in
nsDecls also define the prefixes used by the arrays,
documents, documentTypeName, and collect parameters.
Each entry in nsDecls represents a namespace prefix/URI
pair, where a key name represents a prefix and the value
of the key specifies the namespace URI. For example, to
define the URIs associated with two prefixes called GSX
and TxMon, you would set nsDecls as follows:

Parameters for nsDecls [ ] are:

prefix: Key name.

uri: Key value.
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StringOptional. Flag indicatingwhether or not Integration
Cloud keeps undeclared namespaces in the resulting

preserveUndeclaredNS

document. An undeclared namespace is one that is not
specified as part of the nsDecls input parameter.

Set to:

True to preserve undeclared namespaces in the resulting
document. For each namespace declaration in the XML
document that is not specified in the nsDeclsparameter,
Integration Cloud adds the xmlns attribute as a String
variable to the document. Integration Cloud gives the
variable a name that begins with "@xmlns" and assigns
the variable the namespace value specified in the XML
document. Integration Cloud preserves the position of
the undeclared namespace in the resulting document.

False to ignore namespace declarations in the XML
document that are not specified in the nsDecls
parameter. This is the default.

StringOptional. Flag indicatingwhether or not Integration
Cloud maintains the position of namespaces declared in
the nsDecls parameter in the resulting document.

preserveNSPositions

Set to:

True to preserve the position of namespaces declared
in nsDecls in the resulting document. For each
namespace specified in the nsDecls parameter,
Integration Cloud adds the xmlns attribute to the
document as a String variable named "@xmlns:NSprefix"
where "NSprefix" is the prefix name specified in nsDecls.
Integration Cloud assigns the variable the namespace
value specified in the XML document. This variable
maintains the position of the xmlns attribute declaration
within the XML document.

False to not maintain the position of the namespace
declarations specified in nsDecls in the resulting
document. This is the default.

String List Optional. Names of elements that are to be
generated as arrays, regardless of whether they appear

arrays [ ]

multiple times. For example, if arrays contained the
following values for the XML document shown in the
example in the description for this service:
rep
address
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xmlStringToDocument would generate element rep as a String
List and element address as a Document List.

Important:
If you include namespace prefixes in the element names
that you specify in arrays, you must define the
namespaces associated with those prefixes in nsDecls.

String Optional. Flag indicating whether you want
xmlStringToDocument to automatically create an array for every
element that appears more than once. Set to:

makeArrays

true to automatically create arrays for every element
that appears more than once. This is the default.

false to create arrays for only those elements specified
in arrays.

Output Parameters

Document. Document representation of nodes and attributes in node.document

Usage Notes

Following are examples of XML documents and the documents that xmlStringToDocumentwill
produce:

DocumentXML Document
<myDoc><e1>e1Value</e1>
</myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>
e1Value</e1></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc>
<e1 e1Attr="attrValue">
e1Value</e1></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>
e1Value</e1><e2>e2Value</e2>
</myDoc>
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<?xml version="1.0" encoding="UTF-8"
standalone="no"?><myDoc><e1>e1Value1
</e1><e2>e2Value</e2><e1>
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2>e2Value</e2>
<e1 e1Attr="attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2>e2Value</e2>
<e1 e1Attr="attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2>e2Value</e2>
<e1 e1Attr="attrValue2">
e1Value2</e1></myDoc>

<?xml version="1.0"encoding="UTF-8"?>

<myDoc><e1 e1Attr="attrValue1">
e1Value1</e1><e2><e3>e3Value
</e3><e4 e4Attr="attrValue4"
e4Attrb=
"attrValue4b">e4Value</e4>
</e2></myDoc>

<?xml version="1.0" encoding="UTF-8"
standalone="no"?><tns:AcctInfo>
xmlns:tns="http://localhost/
DerivedAddress/
schema.xsd"xmlns:xsi="http:
//www.w3.org/2001/
XMLSchema-instance"><myDoc>
<e1>e1Value</e1></myDoc>
<myDoc xsi:type="tns:DerivedDoc">
<e1>e1Value</e1><e2>e2Value
</e2></myDoc>
</tns:AcctInfo>

xmlStringToXMLNode
Converts a String, byte[], or InputStream containing an XML document to an XML node.
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AnXMLnode is a representation of an XMLdocument that can be consumed by IntegrationCloud.

Input Parameters

String Optional. String containing the XML document to convert to an
XML node.

xmldata

Note:
If you specify xmldata, do not specify $filedata or $filestream.

byte[ ] Optional. byte[ ] containing the XML document to convert to an
XML node.

$filedata

Note:
If you specify $filedata, do not specify xmldata or $filestream.

java.io.InputStreamOptional. InputStreamcontaining theXMLdocument
to convert to an XML node.

$filestream

Note:
If you specify $filestream, do not specify xmldata or $filedata.

StringOptional. Character encoding inwhich text is represented. Specify
UTF-8 for XML files and ISO-8859-1 for HTML files. To have the parser

encoding

attempt to detect the type of encoding, specify autoDetect (which is the
default, if encoding is not specified).

StringOptional. Flag specifying whether the input document is XML or
HTML. (xmlStringToXMLNodemust know this so that it can parse the
document correctly.) Set to:

isXML

autoDetect to parse the document based on its type. When you use
this option, xmlStringToXMLNode detects the document's type based on
its document type declaration as indicated by a <!DOCTYPE...\> or
<?XML...\> tag. If it cannot determine the document type, it parses it
as HTML. This is the default.

true to parse the document as XML.

false to parse the document as HTML.

Output Parameters

com.wm.lang.xml.NodeXMLnode representation of the XMLdocument
in xmlData. This object can be used as input to webMethods services that
consume XML nodes.

node
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Usage Notes

The input parameters xmldata, $filedata, and $filestream are mutually exclusive. Specify only one
of the preceding parameters. Integration Cloud checks the parameters in the following order:
$filedata, $filestream, and xmldata, and uses the value of the first parameter with a value.

getXMLNodeType
Returns information about an XML node.

Input Parameters

com.wm.lang.xml.Document XML node about which you want
information.

rootNode

Output Parameters

StringConditional. System identifier, as provided by theDTD associated
with rootNode. If rootNode does not have a system identifier, this value is
null.

systemID

StringConditional. Public identifier, as provided by the DTD associated
with rootNode. If rootNode does not have a public identifier, this value is
null.

publicID

String URI of the XML namespace to which rootNode's root element
belongs.

rootNamespace

StringConditional. Namespace prefix of root element in rootNode, if any.rootNSPrefix

String Conditional. Local name (excluding the namespace prefix) of the
root element in rootNode, if any.

rootLocalName

queryXMLNode
Queries an XML node.

The fields parameter specifies how data is extracted from the node to produce an output variable.
This output variable is called a "binding," because the fields parameter binds a certain part of the
document to a particular output variable. At run time, this service must include at least one fields
entry. The service must include at least one entry in fields. The result of each query you specify in
fields is returned in a variable whose name and type you specify.
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Input Parameters

The XML node that you want to query. This parameter supports the
following types of input:

node

com.wm.lang.xml.NodeXML node that youwant to query. An XML
node can be produced by xmlStringToXMLNode or an XML content
handler.

DocumentOptional.Namespaces associatedwith anynamespaceprefixes
used element to specify elements in fields/query. Each entry in nsDecls

nsDecls

represents a namespace prefix/URI pair, where a key name represents a
prefix and the value of the key specifies the namespace URI.

For example, to define the URIs associated with two prefixes called GSX
and TxMon, you would set nsDecls as follows:

Document List Optional. Parameters describing how data is to be
extracted from node. Each document in the list contains parameters for a
single query, as follows:

fields

DescriptionKey

StringName to assign to resulting value.name

StringObject type that the query is to yield. The
following shows the allowed values for
resultType.

resultType

Corresponding Data
Type

Underlying Value

ObjectObject

Object ListObject[]

DocumentRecord

Document ListRecord[]

StringString

String ListString[]

String TableString[][]

StringQuery identifying the data to be extracted
from node.

query
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String Query language in which query is
expressed. Valid values are WQL and XQL.

queryType

String Code indicating what you want
queryXMLNode to do when the result is null. Set to
one of the following:

onnull

continue to indicate that all result values are
acceptable for this query (including null).

fail to indicate that the service should fail
if the result of this query is null and continue
in all other cases.

succeed to indicate that the service should
continue if the result of this query is null and
fail in all other cases.

Document List Parameters that support
recursive execution of bindings. Each fields list

fields[]

defines bindings for one level of the output with
the top level being the pipeline and the first level
downbeing contents of a document or document
list in the pipeline.

Output Parameters

Document Results from the queries specified in fields. This service returns one element
for each query specified in fields. The specific names and types of the returned elements
are determined by the fields/name and field/resultType parameters of the individual queries.

Usage Notes

If queryXMLNode fails, it throws an exception. Common reasons for queryXMLNode to fail include:

A variable that has no query string assigned to it.

A syntax error in a query string.

A query fails the “Allows Null” test.

The node variable does not exist or it is null.

IO Services

Use IO services to convert data between byte[ ], characters, and InputStream representations.
These services are used for reading and writing bytes, characters, and streamed data to the file
system. These services behave like the corresponding methods in the java.io.InputStream class.
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These services can be invoked only by other services. Streams cannot be passed between clients
and the server, so these services will not execute if they are invoked from a client.

The following IO services are available:

DescriptionService

Converts a byte[ ] to java.io.ByteArrayInputStream.bytesToStream

Creates a byte[ ] from data that is read from an InputStream.streamToBytes

Creates a string from data that is read from an InputStream.streamToString

Converts a string to a binary stream.stringToStream

bytesToStream
Converts a byte[ ] to java.io.ByteArrayInputStream.

Input Parameters

byte[ ] The byte array to convert.bytes

String Optional. The maximum number of bytes to read and convert. If
length is not specified, the default value for this parameter is the length
of the input byte array.

length

String Optional. The offset into the input byte array from which to start
converting. If no value specified, the default value is zero.

offset

Output Parameters

java.io.ByteArrayInputStream An open InputStream created from the
contents of the input bytes parameter.

stream

Usage Notes

This service constructs stream from the byte array using the constructor ByteArrayInputStream(byte[
]). This constructor does not make a copy of the byte array, so any changes to byteswill be reflected
in the data read from the stream.

streamToBytes
Creates a byte[ ] from data that is read from an InputStream.
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Input Parameters

java.io.InputStream The InputStream that you want to convert.stream

Output Parameters

byte[ ]The bytes read from stream.bytes

Usage Notes

This service reads all of the bytes from stream until the end of file is reached, and then it closes the
InputStream.

streamToString
Creates a string from data that is read from an InputStream.

Input Parameters

java.io.InputStream The InputStream to convert to a string.inputStream

StringOptional. Name of a registered, IANA character set (for example,
ISO-8859-1). If you specify an unsupported encoding, the system throws
an exception. If no value is specified the encoding will be UTF-8.

encoding

Output Parameters

String Data read from inputStream and converted to a string.string

stringToStream
Converts a string to a binary stream.

Input Parameters

String The string object to be converted.string

StringOptional. Name of a registered, IANA character set, for example,
ISO-8859-1. If you specify an unsupported encoding, the system throws
an exception. If no value is specified, the encoding will be UTF-8.

encoding
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Output Parameters

java.io.ByteArrayInputStream An open InputStream created from the
contents of string.

inputStream

Utils Services
Contains utility services.

The following Utils services are available:

DescriptionService

Generates a random Universally Unique Identifier (UUID).generateUUID

generateUUID
Generates a random Universally Unique Identifier (UUID).

Input Parameters

None.

Output Parameters

String A randomly generated Universally Unique Identifier (UUID).UUID
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Overview

A Document Type contains a set of fields used to define the structure and type of data in a
document. You use a document type to specify the input or output parameters for an Integration.

Note:
Users who have the required project permissions under Settings  > Project Permissions can
create, update, and delete a document type.

Document types provide the following benefits:

Using a document type as the input or output signature for an Integration reduces the effort
required to build an Integration.

Using a document type to build document or document list fields reduces the effort and time
needed to declare input or output parameters or build other document fields.

Document types improve accuracy because there is less possibility to introduce a typing error
while typing field names.

Document types make future changes easier to implement because you make a change in one
place (the Document Type) rather than everywhere the document type is used.

You use document types to define the input or output parameters for an integration. Input and
output parameters are the names and types of fields that the integration requires as input and
generates as output. These parameters are also collectively referred to as a signature. For example,
an integration takes two string values, an account number (AcctNum ) and a dollar amount
(OrderTotal ) as inputs and produces an authorization code (AuthCode ) as the output. If you
have multiple integrations with identical input parameters but different output parameters, you
use a document type to define the input parameters rather than manually specifying individual
input fields for each integration.

Document Types page

The Document Types page lists all the document types. The Name column in the Document
Types page displays the name of the document type. You can select a document type and click
the document type name linkunder theName column tomodify the document type. TheDocument
Types page by default shows a basic view of all the document types. Click Show Advanced View
to view the Used In column, which displays in which project and where the document type is
used in the format project name/referenced asset name. You can click the Used In icon to get more

information. Click the icon to delete or copy a document type or the icon to edit a document
type.
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Creating a Document Type

You can create a document type from the Document Types page by clicking the Add New
Document Type option in the following ways:

Build from scratch: Create an empty document type and define the structure of the document
type yourself by inserting fields to define its contents and structure.

Build from XML schema: Create a document type from a source file, such as an XML Schema.
The structure and content of the document type will match that of the source file.

Integration Cloud also allows you to create document types for already created RESTApplications
from theProjects > <Select a Project> > Applications > REST Applications > Document Types
page or from the Request Body and Response Body panels while creating a REST Application.

Document types created for a RESTApplication do not appear in theProjects > <Select a Project>
> Document Types page but appears in the Document Types panel for the selected REST
Application. Document types for REST Applications are used in the Request Body and Response
Body of an Action.

Creating Document Types from Scratch

To add or edit a Document Type from scratch

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Document
Types. The Document Types page appears.

Note:
You can create document types for already created REST Applications from the Projects >
<Select a Project> > Applications > REST Applications > Document Types link or from
the Request Body and Response Body panels while creating a REST Application.

Integration Cloud 6.6.0 637

11 Document Types



From the Document Types page, you can add, edit, delete, or copy a document type.

2. To edit an existing document type, select a document type from the Document Types page
and click the Edit icon . Select a field to view the Field Properties panel.

3. To create a new document type from scratch, from theDocument Types page, clickAdd New
Document Type > Build from scratch.

4. Provide a name and description of your document type. Required fields are marked with an
asterisk on the page.

5. Click Load XML to generate a document type from the XML structure or click Load JSON to

generate a document type from the JSON structure. Use the Required option
to mark all the fields as optional. By default, all the fields are marked as mandatory. If a field
ismandatory, then youmust pass a value for that fieldwhen running an Integration.Mandatory
fields are marked with an asterisk on the screen.

6. Click the icon to add a new field. You can update the field properties by using the Field
Properties window.

Provide the Name and Type of the field in order to define the structure and content of the
document type. A field can be a String, Document, Document Reference, Object, Boolean,
Double, Float, Integer, Long, or Short. In the Field Properties panel, if you select the Type as
Document Reference, then in the Document Reference dialog box, all the shared projects
and their document references appear along with the document references available in the
current project. See “Sharing Assets across Projects” on page 98 for more information.

Fields are used to declare the expected content and structure of Integration signatures, document
contents, and pipeline contents. In addition to specifying the name and type of a field, and
whether the type is an Array, you can set properties that specify an XML Namespace and
indicate whether the field is required at runtime by selecting the Required option. Select the
Content Type you can apply to String, String list, or String table variables. See “About Variable
Constraints” on page 642 for information.

You can copy a field from the fields panel by clicking the icon. Depending on the context,

you can either paste the field or the field path by clicking the icon. For example, if you copy
a field and paste the field in the Set Value window in an Integration, the field path will be
pasted. If you copy an array item, the path that is pasted includes the item index. For example,
if the item that is copied is A/B/C[10], then the pasted path will also include the item index
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[10]. But if it is pasted in the document tree, it will appear as an array, like A[ ]. If there are
multiple fields with the same name in a document, and one of the occurrences of such a field
is copied, then the path when pasted will contain the occurrence number in brackets, for
example, the path will be A/B/C(5) if the copied element C is the 5th occurrence under field B.

Note:
You cannot modify or paste the child fields of a Document Reference.

Note:
When defining a document type, avoid adding identically named fields to the document.
In particular, do not add identically named fields that are of the same data type.

You can assign an XML namespace and prefix to a field by specifying a URI for the XML
namespace property and by using the prefix:fieldName format for the field name. For example,
suppose a field is named eg:account and the XML namespace property is set to
http://www.example.com. The prefix is eg, the localname is account, and the namespace name
is http://www.example.com.

Keep the following points in mind when assigning XML namespaces and prefixes to a field:

The field name must be in the format: prefix:fieldName

You must specify a URI in the XML namespace property.

Do not use the same prefix for different namespaces in the same document type, input
signature, or output signature.

7. Click Apply after you have entered the details and constraints for each field, and then click
Save to save the Document Type.

Note:
When you edit a document type, any change is automatically propagated to all integrations
that use or reference the document type.

The new document type appears in the Document Types page.

Creating Document Types from an XML Schema Definition

Keep the following point inmindwhen creating a document type from anXMLSchemaDefinition:

You can specifywhether Integration Cloud enforces strict, lax, or no contentmodel compliance
when generating the document type. Content models provide a formal description of the
structure and allowed content for a complex type. The type of compliance that you specify can
affect whether Integration Cloud generates a document type from a particular XML Schema
definition successfully. Currently, Integration Cloud does not support repeatingmodel groups,
nested model groups, or the any attribute. If you select strict compliance, Integration Cloud
does not generate a document type from anyXML schema definition that contains those items.

To create a document type from an XML Schema definition
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1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Document
Types. The Document Types page appears.

From the Document Types page, you can add, edit, delete, or copy a document type.

2. To edit an existing document type, select a document type from the Document Types page
and click the Edit icon .

3. To create a new document type from an XML Schema Definition, from the Document Types
page, click Add New Document Type > Build from XML schema.

4. Provide a name of your document type. Required fields are marked with an asterisk on the
page.

5. On the Specify the location of the XML schema file panel, under  XML schema source, do
one of the following to specify the source file for the document type:

To use an XML Schema definition that resides on the Internet as the source, select URL.
Then, type theURL of the resource. (TheURL you specifymust beginwith http: or https:.)

To use an XML Schema definition that resides on your local file system as the source, select
File. Then click Browse and select the file. The maximum file upload size is 5 MB.

6. Click Next and on the Select schema-related processing options panel, under Content
model compliance, select one of the following to indicate how strictly Integration Cloud
represents content models from the XML Schema definition in the resulting document type.

To...Select...

Generate the document type only if Integration Cloud can represent the
contentmodels defined in theXMLSchemadefinition correctly.Document

Strict

type generation fails if IntegrationCloud cannot accurately represent the
content models in the source XML Schema definition.

Currently, Integration Cloud does not support repeating model groups,
nested model groups, or any attribute. If you select strict compliance,
Integration Cloud does not generate a document type from any XML
schema definition that contains those items.

When possible, generate a document type that correctly represents the
content models for the complex types defined in the XML schema

Lax

definition. If Integration Cloud cannot correctly represent the content
model in the XML Schema definition in the resulting document type,
IntegrationCloud generates the document type using a compliancemode
of None.

When you select lax compliance, Integration Cloud will generate the
document type even if the content models in the XML schema definition
cannot be represented correctly.
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To...Select...

Generate a document type that does not necessarily represent ormaintain
the content models in the source XML Schema definition.

None

7. If you select strict or lax compliance, next to Preserve text position, do one of the following
to specify whether document types generated will contain multiple *body fields to preserve
the location of text in instance documents.

Select the Preserve text position check box to indicate that the document type generated
preserves the locations for text in instance documents. The resulting document type contains
a *body field after each field and includes a leading *body field. In instance documents for
this document type, Integration Cloud places text that appears after a field in the *body.

Clear the Preserve text position check box to indicate that the document type generated
does not preserve the locations for text in instance documents. The resulting document
type contains a single *body field at the top of the document type. In instance documents
for this document type, text data around fields is all placed in the same *body field.

8. If you want Integration Cloud to use the Xerces parser to validate the XML Schema definition,
select the Validate schema using Xerces check box.

Note:Integration Cloud automatically uses an internal schema parser to validate the XML
Schema definition. However, the Xerces parser provides stricter validation than the internal
schema parser. As a result, some schemas that the internal schema parser considers to be
valid might be considered invalid by the Xerces parser.

9. ClickNext and on the Select root nodes panel, under  Select root nodes, select the elements
that you want to use as the root elements for the document type. The resulting document type
will contain all of the selected root elements as top-level fields in the generated document type.
To select multiple elements, press the CTRL key while selecting elements.

10. Click Finish.

Integration Cloud creates the document type.

Notes

If you have selected strict compliance and Integration Cloud cannot represent the content
model in the complex type accurately, Integration Cloud does not generate any document
type.

If you have selected lax compliance and indicated that Integration Cloud should preserve
text locations for content types that allow mixed content (you selected the Preserve text
position check box), Integration Cloud adds *body fields in the document type only if the
complex type allows mixed content and Integration Cloud can correctly represent the
contentmodel declared in the complex type definition. If IntegrationCloud cannot represent
the content model in a document type, Integration Cloud adds a single *body field to the
document type.
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If the XML schema definition contains an element reference to an element declaration
whose type is a named complex type definition (as opposed to an anonymous complex
type definition), Integration Cloud creates a document type for the named complex type
definition only if it is referred multiple times in the schema.

Integration Cloud uses the prefixes declared in the XML Schema or the ones you specified
as part of the field names. Field names have the format prefix:elementName or
prefix:@attributeName.

If the XMLSchemadoes not use prefixes, IntegrationCloud creates prefixes for each unique
namespace and uses those prefixes in the field names. Integration Cloud uses “ns” as the
prefix for the first namespace, “ns1” for the second namespace, “ns2”.

If the XML Schema definition contains a user-specified namespace prefix and a default
namespace declaration, both pointing to the same namespace URI, Integration Cloud uses
the user-specified namespace prefix and not the default namespace.

If the namespace prefix in the XML Schema as well as the default namespace point to the
same namespace URI, Integration Cloud gives preference to the user-specified namespace
prefix over the default namespace.

About Variable Constraints

You apply content constraints to variables in the document types that youwant to use as blueprints
in data validation. Content constraints describe the data a variable can contain. At validation time,
if the variable value does not conform to the content constraints applied to the variable, the
validation engine considers the value to be invalid.

When applying content constraints to variables, do the following:

Select a content type - A content type specifies the type of data for the variable value, such as
string, integer, boolean, or date. A content type corresponds to a simple type definition in a
schema.

Set constraining facets - Constraining facets restrict the content type, which in turn, restrict
the value of the variable to which the content type is applied. Each content type has a set of
constraining facets. For example, you set a length restriction for a string content type, or a
maximum value restriction for an integer content type.

For example, for a String variable named itemQuantity, specify a content type that requires the
variable value to be an integer. You could then set constraining facets that limit the content of
itemQuantity to a value between 1 and 100.

The content types and constraining facets described in this appendix correspond to the built-in
data types and constraining facets in XML Schema. The World Wide Web Consortium (W3C)
defines the built-in data types and constraining facets in the specification XML Schema Part 2:
Datatypes (http://www.w3c.org/TR/xmlschema-2).
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Applying Constraints to a Variable

You apply content constraints to variables in the document types that youwant to use as blueprints
in data validation.

To apply constraints to a variable

1. Select a document type from the Document Types page and click Edit. Select a field to view
the Field Properties panel.

You apply constraints to variables in document types declared on the Input/Output tab. If the
selected variable is a String or String list and you want to specify content constraints for the
variable, then do the following:

If youwant to use a content type that corresponds to a built-in simple type in XML schema,
in the Content type list, select the type for the variable contents. To apply the selected
type to the variable, click Save.

2. Repeat this procedure for each variable to which you want to apply the constraints in the
document type and click Save.

Content Types

The following table identifies the content types you can apply to String or String list variables.
Each of these content types corresponds to a built-in simple type defined in the specificationXML
Schema Part 2: Datatypes.

DescriptionContent Types

A Uniform Resource Identifier Reference. The value of anyURI may
be absolute or relative.

anyURI

Constraining Facets

enumeration, length, maxLength, minLength, pattern

Note:
The anyURI type indicates that the variable value plays the role of
a URI and is defined like a URI. webMethods Integration Server
does not validate URI references because it is impractical for
applications to check the validity of a URI reference.

Base64-encoded binary data.base64Binary

Constraining Facets

enumeration, length, maxLength, minLength, pattern

True or false.boolean
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DescriptionContent Types

Constraining Facets

pattern

Example
true, 1, false, 0

A whole number whose value is greater than or equal to –128 but
less than or equal to 127.

byte

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
-128, -26, 0, 15, 125

A calendar date from the Gregorian calendar. Values need to match
the following pattern:

date

CCYY-MM-DD

Where CC represents the century, YY the year, MM the month, DD
the day. The pattern can include a Z at the end to indicate Coordinated
Universal Time or to indicate the difference between the time zone
and coordinated universal time.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

1997-08-09 (August 9, 1997)

A specific instant of time (a date and time of day). Values need to
match the following pattern:

dateTime

CCYY-MM-DDThh:mm:ss.sss

Where CC represents the century, YY the year, MM the month, DD
the day, T the date/time separator, hh the hour, mm the minutes, and
ss the seconds. The pattern can include a Z at the end to indicate
Coordinated Universal Time or to indicate the difference between
the time zone and coordinated universal time.

Constraining Facets
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DescriptionContent Types

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

2000-06-29T17:30:00-05:00 represents 5:30 pm Eastern Standard
time on June 29, 2000. (Eastern Standard Time is 5 hours behind
Coordinated Universal Time.)

A number with an optional decimal point.decimal

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
8.01, 290, -47.24

Double-precision 64-bit floating point type.double

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example
6.02E23, 3.14, -26, 1.25e-2

A length of time. Values need to match the following pattern:duration

PnYnMnDTnHnMnS

Where nY represents the number of years, nMthe number ofmonths,
nD the number of days, T separates the date and time, nH the number
of hours, nM the number of minutes and nS the number of seconds.
Precede the duration with a minus (-) sign to indicate a negative
duration.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

P2Y10M20DT5H50M represents a duration of 2 years, 10months, 20 days,
5 hours, and 50 minutes
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DescriptionContent Types

Sequence of whitespace-separated ENTITY values declared in the
DTD. Represents the ENTITIES attribute type from the XML 1.0
Recommendation.

ENTITIES

Constraining Facets

enumeration, length, maxLength, minLength

Name associatedwith an unparsed entity of the DTD. Represents the
ENTITY attribute type from the XML 1.0 Recommendation.

ENTITY

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

A number with a fractional part.float

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example
8.01, 25, 6.02E23, -5.5

A specific day that recurs every month. Values must match the
following pattern:

gDay

---DD

Where DD represents the day. The pattern can include a Z at the end
to indicate Coordinated Universal Time or to indicate the difference
between the time zone and coordinated universal time.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

---24 indicates the 24th of each month

A Gregorian month that occurs every year. Values must match the
following pattern:

gMonth

--MM

Where MM represents the month. The pattern can include a Z at the
end to indicate Coordinated Universal Time or to indicate the
difference between the time zone and coordinated universal time.
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Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

--11 represents November

A specific day and month that recurs every year in the Gregorian
calendar. Values must match the following pattern:

gMonthDay

--MM-DD

Where MM represents the month and DD represents the day. The
pattern can include a Z at the end to indicate Coordinated Universal
Time or to indicate the difference between the time zone and
coordinated universal time.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

--09-24 represents September 24th

A specific year in the Gregorian calendar. Values must match the
following pattern:

gYear

CCYY

Where CC represents the century, and YY the year. The pattern can
include a Z at the end to indicate Coordinated Universal Time or to
indicate the difference between the time zone and coordinated
universal time.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

2001 indicates 2001

A specific month and year in the Gregorian calendar. Values must
match the following pattern:

gYearMonth

CCYY-MM

Integration Cloud 6.6.0 647

11 Document Types



DescriptionContent Types

Where CC represents the century, YY the year, and MM the month.
The pattern can include a Z at the end to indicate Coordinated
Universal Time or to indicate the difference between the time zone
and coordinated universal time.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example

2001-04 indicates April 2001

Hex-encoded binary data.hexBinary

Constraining Facets

enumeration, length, maxLength, minLength, pattern

A name that uniquely identifies an individual element in an instance
document. The value for ID needs to be a valid XML name. The ID

ID

datatype represents the ID attribute type from the XML 1.0
Recommendation.

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

A reference to an element with a unique ID. The value of IDREF is
the same as the ID value. The IDREF datatype represents the IDREF
attribute type from the XML 1.0 Recommendation.

IDREF

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

Sequence ofwhite space separated IDREFsused in anXMLdocument.
The IDREFS datatype represents the IDREFS attribute type from the
XML 1.0 Recommendation.

IDREFS

Constraining Facets

enumeration, length, maxLength, minLength

A whole number with a value greater than or equal to -2147483647
but less than or equal to 2147483647.

int

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits
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Example
-21474836, -55500, 0, 33123, 4271974

A positive or negative whole number.integer

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
-2500, -5, 0, 15, 365

Language identifiers used to indicate the language in which the
content is written. Natural language identifiers are defined in IETF
RFC 1766.

language

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

A whole number with a value greater than or equal to
-9223372036854775808 but less than or equal to 9223372036854775807.

long

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
-55600, -23, 0, 256, 3211569432

XML names that match the Name production of XML 1.0 (Second
Edition).

Name

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

Non-colonizedXMLnames. Set of all strings thatmatch theNCName
production of Namespaces in XML.

NCName

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

An integer with a value less than or equal to –1.negativeInteger

Constraining Facets
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enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
-255556, -354, -3, -1

Anymixture of name characters. Represents theNMTOKENattribute
type from the XML 1.0 Recommendation.

NMTOKEN

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

Sequences of NMTOKENS. Represents the NMTOKENS attribute
type from the XML 1.0 Recommendation.

NMTOKENS

Constraining Facets

enumeration, length, maxLength, minLength

An integer with a value greater than or equal to 0.nonNegativeInteger

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
0, 15, 32123

An integer with a value less than or equal to 0.nonPositiveInteger

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits, whiteSpace

Example
-256453, -357, -1, 0

Represents white space normalized strings. Set of strings (sequence
of UCS characters) that do not contain the carriage return (#xD), line
feed (#xA), or tab (#x9) characters.

normalizedString

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

Example
MAB-0907
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An integer with a value greater than or equal to 1.positiveInteger

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
1, 1500, 23000

Awhole number with a value greater than or equal to -32768 but less
than or equal to 32767.

short

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
-32000, -543, 0, 456, 3265

Character strings in XML. A sequence of UCS characters (ISO 10646
and Unicode). By default, all white space is preserved for variables
with a string content constraint.

string

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

Example
MAB-0907

An instant of time that occurs every day. Values must match the
following pattern:

time

hh:mm:ss.sss

Where hh indicates the hour, mm the minutes, and ss the seconds.
The pattern can include a Z at the end to indicate Coordinated
Universal Time or to indicate the difference between the time zone
and coordinated universal time.

Constraining Facets

enumeration, maxExclusive, maxInclusive, minExclusive,
minInclusive, pattern

Example
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18:10:00-05:00 (6:10 pm, Eastern Standard Time) Eastern Standard
Time is 5 hours behind Coordinated Universal Time.

Represents tokenized strings. Set of strings that do not contain the
carriage return (#xD), line feed (#xA), or tab (#x9) characters, leading
or trailing spaces (#x20), or sequences of two or more spaces.

token

Constraining Facets

enumeration, length, maxLength, minLength, pattern, whiteSpace

A whole number greater than or equal to 0, but less than or equal to
255.

unsignedByte

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
0, 112, 200

A whole number greater than or equal to 0, but less than or equal to
4294967295.

unsignedInt

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
0, 22335, 123223333

A whole number greater than or equal to 0, but less than or equal to
18446744073709551615.

unsignedLong

Constraining Facets

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
0, 2001, 3363124

A whole number greater then or equal to 0, but less than or equal to
65535.

unsignedShort

Constraining Facets

652 Integration Cloud 6.6.0

11 Document Types



DescriptionContent Types

enumeration, fractionDigits, maxExclusive, maxInclusive,
minExclusive, minInclusive, pattern, totalDigits

Example
0, 1000, 65000

Customizing a String Content Type

Instead of applying an existing content type or simple type to a String or String list, you can
customize an existing type and apply the new,modified type to a variable. You customize a content
type or simple type by changing the constraining facets applied to the type.

When you customize a type, you actually create a new content type. Designer saves the changes
as a new content type. The constraining facets you can specify depend on the content type. Note
that content types and constraining facets correspond to datatypes and constraining facets defined
in XMLSchema. Formore information about constraining facets for a datatype, see the specification
XML Schema Part 2: Datatypes (http://www.w3.org/TR/xmlschema-2/).

To customize a content type

1. Select the variable to which you want to apply a customized content type.

2. In the Constraints category on the Properties view, click the Content type browse button and
then do one of the following to select the content type you want to customize:

In the Content type list, select the content type you want to customize.

If you want to customize a simple type from an IS schema, click Browse. In the Browse
dialog box, select the IS schema containing the simple type. Then, select the simple type
you want to customize and apply to the variable. Click OK.

3. Click Customize. Designer makes the constraining facet fields below the Content type list
available for data entry (that is, changes the background of the constraining facet fields from
grey to white). Designer changes the name of the content type to contentType_customized.

4. In the fields below the Content type list, specify the constraining facet values you want to
apply to the content type.

5. Click OK. Designer saves the changes as a new content type named contentType_customized.

Note:
The constraining facets displayed below theContent type list depend on the primitive type
from which the simple type is derived. Primitive types are the basic data types from which
all other data types are derived. For example, if the primitive type is string, Designer displays
the constraining facets enumeration, length, minLength, maxLength, and pattern. For
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more information about primitive types, refer to XML Schema Part 2: Datatypes at http://
www.w3.org/TR/xmlschema-2/.
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Overview

Reference data is data that defines the set of permissible values to be used by other data fields. It
is a collection of key-value pairs, which can be used to determine the value of a data field based
on the value of another data field. For example, the value of a status field in an Application can
be “Canceled” and that needs to be interpreted as “CN” in another Application. If you have the
required project permissions under Settings  > Project Permissions, you can create, update,
or delete a Reference Data.

Integration Cloud allows you to upload Reference Data from a text file containing tabular data
separated by a character, for example, a comma, semicolon, and so on. The uploaded file should
not have an empty column heading or space in the first row, and the first row cannot be empty.

Note:
See this video on how to upload Reference Data, access the uploaded Reference Data in an
Orchestrated Integration, and view the input and output parameters.

The ReferenceData block appears under Services in theOrchestrated Integrationworkspace, only
after you have created a ReferenceData. See ReferenceData Signature for information on the Input
and Output parameters. The Reference Data is also available in Point-to-Point Integrations while
transforming data. You can access the uploaded Reference Data in Orchestrated Integrations as a
list of documents by using the Reference Data block and providing an appropriate name. You
can filter the documents returned into the pipeline by the Reference Data block.

You can create a Reference Data only in the Development stage but can view, edit, delete, and
download the Reference Data in all stages. The Status column in the Reference Data table displays
Configured if the Reference Data is available in the current stage (Stage in view) and displays
Not Configured if the Reference Data is not available in the current stage but available in any
other stage. You can Delete or Download a Reference Data if the Reference Data is available in
the current stage. You can Edit a Reference Data in all stages. The Download option allows you
to download the previously uploaded Reference Data, edit it, and then upload the modified file.
In this way you can upload different sets of data in different stages.

You can pull an Integration only if the Integration is consistent in the source stage, that is, all
references of the Integration are present in the source stage. While pulling an Integration from the
source stage to the target stage, if the same Reference Data is not available in the target stage, then
you must configure the Reference Data in the target stage. If the same Reference Data is available
in the target stage with a signature mismatch, for example, the number of columns or the column
names are not the same, then you can either reconfigure the Reference Data or skip the
reconfiguration. If the Reference Data is already available in the target stage and the signature is
same as in the source stage, then it will not be copied from the source stage to the target stage
while pulling the Integration.

Note:
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If a Reference Data is in the Development stage, the Reference Data can be deleted even it is
referenced or used in an Integration. Integrations using the deleted Reference Data will be in
an inconsistent state.

If a Reference Data is in a stage other than the Development stage, the Reference Data can be
deleted only if it is configured in that stage and not used in any Integration.

Add Reference Data

To add or edit a Reference Data

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Reference
Data. The Reference Data page appears.

2. To edit an existing Reference Data, select a configured Reference Data from the Reference

Data page and click the Edit icon .

3. To create a new Reference Data, from the Reference Data page, click Add New Reference
Data. You can create a Reference Data only in the Development stage.

The Upload Reference Data page appears.

4. Provide a name and description of your Reference Data. Required fields are marked with an
asterisk on the page.

5. For Reference Data File, click Browse and select the file. Only a text file having tabular data
is supported. The maximum file size you can upload is 1 MB. Further, the file should not have
an empty column heading or space in the first row and the first row cannot be empty. This is
because the first row of data is read as column headings.

6. Click Next to define and preview the Reference Data. Select the field separator and the text
qualifier.

7. Determine the encoding of the Reference Data file and from the File Encoding drop down list,
select the same encoding. Click Load Preview to preview the data. If you select an incorrect
encoding, garbage characters will appear in the preview pane.

8. Click Next to review the Reference Data and then click Finish to create the Reference Data.

The new Reference Data appears in the Reference Data page with the status as Configured.

Note:
The Reference Data block appears under Services only after you have created a Reference
Data and the ReferenceData servicewill be availablewhile creating anOrchestrated Integration.

Integration Cloud 6.6.0 657

12 Reference Data



The Reference Data is also available in Point-to-Point Integrations while transforming data.

Reference Data Signature

Reference Data signature is derived from the column names of the uploaded text file. You can
filter the Reference data by providing an appropriatematchCriteria. The output of ReferenceData
is a list of documents that match the specified matchCriteria.

Note:
The root element in the output of Reference Data created from version 2.1.0 has the same name
as the Reference Data.

Input Parameters

DocumentCriteria onwhich documents from theReferenceDatawill bematched.matchCriteria

Parameters for matchCriteria are:

path: Column names of the Reference Data.

compareValueAs: Optional. Allowed values are string, numeric, and datetime.
The default value is string.

datePattern: Optional. Pattern will be considered only if compareValueAs is of
type datetime. Default value is MM/dd/yyyy hh:mm:ss a.

joins: List of join criteria.

Each join criteria consists of:

operator: Allowed values are equals, doesNotEqual, greaterThan,
greaterThanEqual, lessThan, lessThanEqual, equalsIgnoreCase, contains,
doesNotContain, beginsWith, doesNotBeginWith, endsWith, doesNotEndWith.

value: Optional. Allowed values are string, numeric, and datetime. The default
value is string.
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joinType: Specifies the way two joins can be linked. Values are “and” or “or”.
Default value is “and”.

Output Parameters

Document List List of documents that match the retrieve criteria.<Reference Data
Name>

In the following example, the flat file contains “Type”, Our Type”, and Marketer” as headers and
has one or more data rows.

Type,Our Type,Marketer

Existing - Growth,Growth,HUNT & SONS INC

The following graphic illustrates the generated Reference Data signature:
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Overview

The Dashboard allows you to view and monitor Integration executions and performance details.
The Execution Results page allows you to view the audit trail of all the executions that happened
in a stage for an Integration or for all Integrations for a project or for all projects. You can also
create Alert Rules and send email messages to selected users for one or more Integrations based
on Integration execution results. The Reports page provides you information about the number
of times an Integration is run for the specified time frame. TheClear Storage Locks page provides
you information on how to clear locks on integrations.

Dashboard

TheDashboardprovides a centralized and intuitiveway to viewandmonitor Integration executions
and performance details. To view the Dashboard, click Monitor > Dashboard.

You can identify and diagnose problems for those Integrations that are available in the active
stage. To select another active stage, click Stages > Change Stage To View. You can view the
Dashboard if the access profile assigned to you is also specified for that stage in the Manage
Stages page. Further, you must be able to access the stages to view the dashboard.

The Dashboard displays the following details:

When was the Dashboard last refreshed.

Options to select the Invocation channel, Project, and Integration to view the execution details.

Total number of documents processed by an Integration or for all Integrations in the active
stage. Documents processed appear only if the Integration invokes the
countProcessedDocuments service to count the number of documents processed by the
Integration. See the countProcessedDocuments service available in the Flow block under the
Services category for more information.
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Number of completed and failed Integration executions that happened during the selected
time period in the active stage.

Number of Integration executions that have completed with errors during the selected time
period in the active stage.

Completed Integration executions, failed Integration executions, and Integration executions
that completed with errors displayed in a pie chart, along with the Success Rate, that is, the
percentage of completed Integration executions compared to the total Integration executions,
during the selected time period in the active stage.

Number of in-progress Integration executions in the active stage. You can click on the
In-Progress Executions number to view the in-progress Integration execution details in a
table. You can terminate in-progress Integration executions from the in-progress Integration
execution details table as well as from the Execution Results details page. The Terminate audit
log entry is created. You can terminate an in-progress Integration execution if you have the
Execute Integration permission. To terminate an in-progress execution from the Execution
Results details page, click the Terminate option available in the Execution Results details page.

Note:
The Terminate option is available only if the current logged in user has the Execute
Integration permission and the Integration status is in-progress.

To terminate in-progress Integration executions from the in-progress Integration execution
details table, select the in-progress integrations you want to terminate and then click the
Terminate option available above the in-progress Integration execution details table.
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The status of the terminated in-progress integration executions appears.

Note:
The Terminate option is available only if the current logged in user has the Execute
Integration permission and the Integration status is in-progress.

Restart or resume an Integration execution.

Successful Integration executions, failed Integration executions, and Integration executions
that completed with errors displayed in a bar chart along with clickable links, for the selected
time period in the active stage. You can click the Integration execution links available above
the bar charts to display the relevant Integration execution details in the table. You can also
point to each bar in the chart to view the date and time when the Integration executed and the
result of the Integration execution.

Name of the Integration, stage name,when the Integration started, the Integration run duration,
documents processed details, result of the Integration execution (Completed Successfully,
Failed, Completed with errors), and the Integration execution message displayed in a tabular
format. TheDocuments Processed columndisplays the total number of documents processed
by an integration, the number of documents processed successfully, and the success percentage.
Values in this column appear only if the Integration invokes the countProcessedDocuments
service to count the number of documents processed by the Integration. Formore information,
see the countProcessedDocuments service available in the Flow block under the Services
category.

If you click a rowon the table, you can view the execution information aswell as the operations
details for the Integration . See Execution Results for more information.

Execution Results

The Execution Results page allows you to view the audit trail of all the Integration executions
that happened in the current stage, during a specified time period, for a selected project or for all
projects. You can also restart or resume an Integration execution, specify the number of days to
retain the entries, and download the entries.

You can also restart or resume an Integration execution from the Monitor > Dashboard page.

The following table provides information on when you can restart or resume an Integration
execution:
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ResumableRestartableExecution Result Status

NoYesCompleted Successfully

NoYesCompleted with Errors

YesYesFailed

NoNoIn-Progress

Note:
To view execution results, ensure that the Access Profile of the user is assigned to the current
stage.

To view the execution results

1. From the IntegrationCloud navigation bar, clickProjects > <Select a Project> > Integrations.

The Integrations page appears.

2. From the Integrations page, select the Integration for which you want to view the execution
results.

3. Click the Integration link to view the Integration Overview page. You can click Edit to modify
the Integration, click Delete to delete the Integration from this page, or click Run Now to
execute the Integration. You can also see the last five execution results in the Last 5 Execution
Results tab.

You can also access the Execution Results by clicking Monitor > Execution Results.

4. On the Execution Results page, select the Invocation channel, a project, an Integration, and
the time period for which you want to view the execution results. Select All Invocations, All
Projects, and All Integrations if you want to view the execution details of Integrations based
on all the invocation channels, for all integrations, and in all projects in the active stage, for
the specified time period. The Custom Range option allows you to set a time period to view
the results. The default time period is for the last 24 hours (24h).

Execution results are displayed in a tabular form. You can filter the results in the table by
clicking on the status filter circles available on the top-right corner above the table. The numbers
inside the status circles indicate the sum of the execution counts for that status.

All - All operations of an Integration, which have Completed Successfully, Failed, and
Completed with errors are displayed.

Completed Successfully - All operations of an Integration that completed successfully
while executing are displayed.
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Failed - Exceptions occurred while executing an operation in an Integration.

Completed with errors - Exceptions occurredwhile executing an operation in an Integration
and caught by the try-catch block in an orchestrated Integration.

5. In the Execution Results page, click Download Results to download the execution results, or
click Modify Retention Period and specify the number of days to retain the execution result
entries. You can retain entries up to 30 days. Entries whose age exceeds the specified retention
period are deleted. Default value of the Retention Period is 30 days.

Note:
User specific data which may be considered as personal data will be stored and retained till
the retention period defined in Execution Results.

6. On the Execution Results page, click an Integration in the table to view more information
about the selected Integration execution. The Execution Details page appears.

In the Execution Details page, the Documents row displays the total number of documents
processed by the integration, the number of documents processed successfully, the number
of documents that did not process successfully, and the success percentage. Values in this row
appear only if the Integration invokes the countProcessedDocuments service to count the
number of documents processed by the Integration. See the countProcessedDocuments service
in the Flow block under the Services category for more information. You can also terminate
in-progress Integration executions from the Execution Results details page. The Terminate
option is available only if you have the Execute Integration permission and the Integration
status is in-progress. TheExecution Information sectiondisplayswhen the Integration execution
was started, when it ended, the duration of the execution, who executed the Integration,
through which channel the Integration was executed, for example, Scheduler, User Interface,
and REST Interface, and so on, the execution result reference, that is, the Integration execution
result reference identifier, and the business data details.

7. The Execution Results page also provides information about operations for the selected
Integration. Click Show Everything to view all information about the operation execution
including business data and custom messages. Click Only Business Data to view only the
logged business data information. ClickOnly Custom Messages to viewonly custommessages.
You can filter the results in the table by clicking on the status filter circles on the top-right
corner of the Operations table. Click on the All (blue) circle to view operation information,
business data, and custom messages. Click on the Successful (green) circle to view only
successful operation information and business data. Click on the Failed (red) circle to view
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only failed operation information and business data. Custom messages appear only if you
have set up log messages. See the logCustomMessage service in the Flow block under the
Services category for more information on how to set up custom messages in an Integration.

8. In the Execution Results page, select a row and click Restart to edit the input data and restart
the Integration execution from the beginning, even though the previous execution has been
successful. When an Integration is restarted, the Audit Log entry displays "Restart".

Click Resume to edit the input data for failed operations and execute the failed and not yet
executed operations.When an Integration is resumed, the Audit Log entry displays "Resume".

Note:
You can also restart or resume an Integration execution from the Monitor > Dashboard
page.

The "Restart/Resume" capability is available only if you have the required license for restarting
and resuming Integrations. Youmust also have the Integration execution (Execute) permission
if you want to restart or resume an execution.

You must select the Enable executions to be restartable option in the Integration Details
page in order to enable Integration executions to be restartable or resumable. See Integration
Details for more information.

Alert Rules

Integration Cloud allows you to create alert rules and send email messages to selected users for
one or more Integrations, including the Integrations used in REST APIs and SOAP APIs, based
on the execution results (Failed, Completedwith Errors, or Completed Successfully) for the current
stage. All executions that have occurred within the specified time period and have alert rules
configured are sent as email messages to specified users.

Note:
Email messages are sent only if there are executions that match the alert rules.

To create a new alert rule

1. From the Integration Cloud navigation bar, clickMonitor > Alert Rules. TheAlert Rules page
appears. You can edit, delete, activate, or deactivate an existing alert rule from this page.

2. From the Alert Rules page, click Add New Alert Rule to create a new alert rule.

The Add New Alert Rule page appears.

3. On the Add New Alert Rule page, provide a name and description for the alert rule and
complete the following fields. Required fields are marked with an asterisk on the page.
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DescriptionField

On the All Assets panel, select the Integrations,
including the Integrations used in REST APIs and

For following Integrations

SOAP APIs that you want this alert rule to apply.
The selected Integrations, including the Integrations
used in REST APIs and SOAP APIs will appear in
the Selected Assets panel.

Select the Integration execution results.when their executions have

Failed - Exceptions occurred while executing an
operation in an Integration.

Completed with Errors - Exceptions occurred
while executing an operation in an Integration
and caught by the try-catch block in an
orchestrated Integration.

Completed Successfully - All operations of an
Integration that completed successfully while
executing.

Click the icon and select the active users towhom
you want to send email alerts. Alerts will be sent to

send an email message to the
following users

the email address specified in the Basic tab of the
user's profile (Settings  > Users > User Profile >
Basic > Email).

4. Click Save and Activate to save and enable the new alert rule.
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The new alert rule appears in the Alert Rules page. You can disable an alert rule by selecting
the alert rule and clicking Mark As > Inactive. You can also enable the alert rule by selecting
the alert rule and clicking Mark As > Active.

5. On the Alert Rules page, click Modify Alert Frequency Period to specify the alert frequency
period to send email messages. If you do not want to receive email alerts for Integration
executions, open the alert rule for editing, and remove your username from the user's list.

Reports

The Reports page provides you information about the number of times an Integration is run for
the specified time frame. The report shows the count for the currently active stage and the reports
data is collected daily, at the end of day.

By default, the data shown on the Reports page is for all the Integrations run across all projects.
When the reports data is collected initially, it is compiled for the number of days as specified in
the retention period on the Execution Results page. Default value of the retention period is 30
days.

A zero countmaymean that either the integration is not executed for thatmonth, or the integration
execution had occurred earlier than the value specified in the retention period. This is applicable
only during the initial period.

Note:
The data you see on the Reports page depends mainly on two factors:

When you view the data
When data collection ends

The Reports page displays data collected till the day before yesterday. Daily around 9:10 PM,
data collection starts. The time when data collection ends depends on the volume of data and
for how long Integration Cloud takes to collect the data.

Example

Let us assume that the current date and time is 18th October, 9 PM. If you view the Reports page
now at 9 PM, data collection is yet to start for today (it will start at 9:10 PM), and so the Reports
page will show the integration execution counts that have occurred till 16th October 11:59 PM.
If the data collection starts at 9:10 PM today and ends by 11 PM, then after 11 PM, the Reports
page will show the integration execution counts till 17th October 11:59 PM.

You can know when the data collection has completed from the entries in the Audit Log:

Type: IntegrationResults History
Operation: Update
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To view the reports

1. From the Integration Cloud navigation bar, click Monitor > Reports. The Reports page
appears.

2. Select the time frame for which you want to view the report. You can set from the following
options:

1m - Show data for 1 month from the current system date.

3m - Show data for 3 months from the current system date.

6m - Show data for 6 months from the current system date.

12m - Show data for 12 months from the current system date.

Custom Range - In the Set Custom Range dialog box, set the Start date and End date
for the time range.

3. To download the report, click Download Reports. Currently, you can download reports in
the following formats:

Note:
The downloaded report also shows the stage for which you have run the report.

PDF

CSV

PDF (detailed) - In addition to the details provided in PDF format, here you can view how
many times in each month an Integration has run.

CSV (detailed) - In addition to the details provided in CSV format, here you can view how
many times in each month an Integration has run.

Clear Storage Locks

If the environment goes down while an integration is running, the lock taken on the integration
will not be automatically removed immediately. So any scheduled executions for the same
integration will be skipped.

The following scenarios describe the actions you need to take to clear the locks.

Scenario 1

While scheduling an integration, if you have selected the Prevent concurrent executions option,
then before each execution, a lock will be taken on the integration. If the Integration Server goes
down when the scheduled integration is in progress, then the lock will not be automatically
removed. This will cause any further scheduled executions for the same integration to be skipped.
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In this case, go to Monitor > Clear Storage Locks and clear the lock on the integration. The
IntegrationNamewill appear in theKey column and ScheduledIntegrationwill appear under Storage
Context in the Clear Storage Locks page.

The next scheduled integration will be invoked successfully. If you do not clear the lockmanually,
Integration Cloud will automatically remove the integration locks periodically.

Scenario 2

If you have added the Storage add and lock services in an integration, you have taken a lock on the
entry. This lock will get automatically unlocked when the integration execution completes.

Scenario 3

If you have added the Storage add and lock services in an integration, you have taken a lock on the
entry. After taking the lock and before the execution has completed, if Integration Server goes
down, and then if you want to re-run the Integration, the integration execution will stop at the
Storage lock step as the earlier lock is not removed. Then if you want to clear the lock, go to the
Clear Storage Locks page and clear the lock on the storage entry. The current integration execution

Integration Cloud 6.6.0 671

13 Monitor



will immediately start running after the lock is cleared. If you do not clear the lock manually,
Integration Cloud will automatically remove the integration locks periodically.

Scenario 4

You have an integration that may run for a few hours, say for example, more than three hours,
and the integration has taken a lock either by using the Storage add and lock services or by using
thePrevent concurrent executions option in the scheduler. Now even if the integration is running,
Integration Cloud will automatically remove the integration lock after the periodic schedule for
removing locks. To prevent this scenario, contact Support.
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Overview

Integration Cloud allows you towrite integration logic to integrate different types of applications.
This logic can be exposed to the external world using REST APIs.

These REST APIs can be created by using an existing set of Integrations (from scratch) or by using
a file containing the Open API specification (formerly known as the Swagger specification) as a
template.

A REST API consists of many Resource Operations and each Resource Operation has a Path, one
or more HTTP Methods, and an associated Integration.

A REST Resource Operation can be tried out from the Swagger screen of a REST API. When the
Resource Operation is invoked using the HTTPMethod, the associated Integration gets executed.

Note:
Users who have the required project permissions under Settings  > Project Permissions can
create, update, delete, and execute REST APIs.

Note:
If you have created a REST API by using a file containing the Open API specification (formerly
known as the Swagger specification) as a template (Build with Swagger approach), and have
now uploaded a new file, Integrations and Document Types that are created are now based on
the new Swagger file.

Creating REST APIs from scratch

To create a REST API from scratch

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
REST APIs.

The REST APIs page appears.

2. From the REST APIs page, clickAdd New REST API, select Build from scratch, and then click
OK.

3. Complete the following fields and click Save.

The new REST API appears in the REST APIs page.

Specify...In this field...

Type a name for the REST resource using any
combination of letters, numbers, and/or underscore
characters.

Save As

Provide a title for the REST API.Swagger Title
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Specify...In this field...

Type an optional description for the REST API.Description

A version number. The value is typically 1.0. You need
to change the version number if you want to modify and
republish the REST API.

Version

Select the MIME types that the API consumes.Consumes

Select theMIME types that the API produces. TheMIME
types you select here will be part of the Swagger

Produces

definition and will appear in the Responses section of
the Swagger editor. While executing the REST API, you
can choose the format in which you want to view the
response.

You must specify an Accept header in the REST client,
else the default response will conform to the Content
Type text/html.

4. Click Save.

The REST API is created and appears in the REST APIs page. When you create a REST API,
Integration Cloud uses the general information that you supplied to populate the Overview
page in the RESTAPI. You can click Edit to change the information in theOverview page. The
name cannot be modified.

5. In the Resources page, click Add New Resource to add a Resource to the REST API. Type a
Path, select aMapped Integration that youwant to invokewith this path, and select theHTTP
Methods that can be used to invoke this Integration with this path. You can also provide a
description for each method in the Operation Summary field. You can add more Resource
Operations, if needed. You can modify a REST resource even if the resource has an operation
with a deleted integration mapped to the operation.

6. Click Save and Continue to add parameters and responses and then click Save and Finish.
See “Modifying Resource Operations” on page 676 for information on how to modify a REST
Resource Operation.

7. To run an Integration with a certain path andmethod, go to the REST APIs page, select a REST
API, and click the REST API link. The REST API details page appears.

8. Go to the Swagger page from the REST API details page. Click Authorize and type your
Integration Cloud user name and password to authorize access to your APIs. Select the path
and method pair and click Try it out. If required, pass the parameters and click Execute.

Responses will be displayed on the pane.
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Modifying Resource Operations

To modify a REST Resource Operation

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
REST APIs.

The REST APIs page appears.

2. Click on the link of a REST API that has been created from scratch, go to the Resources page,
select a resource operation, and then click the Edit icon.

Modifying the Path

On the Resources page, select a resource operation and then click the Edit icon. Change the
path. If you modify the path, the Integration will run on the new path. To run the Integration,
for a givenmethod, go to the Swagger page, clickAuthorize and type your Integration Cloud
user name and password to authorize access to yourAPIs, and click Try it out that corresponds
to the new path and method pair.

Modifying the HTTP Methods

On the Resources page, select a resource operation and then click the Edit icon. Select new
HTTP Methods with respect to which you want to expose the given Integration. To run the
integration now, go to the Swagger page, click Authorize and type your Integration Cloud
user name and password to authorize access to yourAPIs, and click Try it out that corresponds
to the path and one of the new methods that was selected.

Changing the mapped Integration
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On the Resources page, select a resource operation and then click the Edit icon. Choose a new
Mapped Integration from the drop-down list. Note that you can modify a REST resource
even if the resource has an operation with a deleted integration mapped to the operation. To
run the new Integration, go to the Swagger page, click Authorize and type your Integration
Cloud user name and password to authorize access to your APIs, and click Try it out that
corresponds to the Integration method and path pair.

Modifying an existing Integration

Select an Integration in the Integrations page that is exposed in a REST API and click the Edit
icon. Change the input signature and output signature of the Integration. Now go to the REST
APIs page, select a REST API, and click on the REST API link. Go to the Resources page.
Identify any method and path pair that corresponds to the Integration whose signature was
modified. Then go to the Swagger page and navigate to the method and path pair that was
identified. You can see that the parameters have changed and they now correspond to the new
Integration input signature. Note that the responses have also changed and they correspond
to the output signature of the Integration. Click Authorize and type your Integration Cloud
user name and password to authorize access to your APIs, and then click Try it out, supply
the new parameter values, and run the Integration.

Changing Parameter Types

On the Resources page, select a resource operation and then click the Edit icon. Click Save
and Continue. Parameters corresponding to the Integration appears.

If the parameter type is body, you cannot change its type.

If the parameter type is formdata, you can change it to a header or a query parameter.

If the parameter type is header, you can change it to a query or formdata parameter.

If the parameter type is query, you can change it to a form or a header parameter.

Adding Responses

On theResources page, select a resource operation and then click theEdit icon. ClickContinue.
You will see the responses corresponding to the output signature of the Integration in the
panel. You can add more response codes, if needed.

Note:
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Click Back to Definition to go back to the REST Resource Operation definition page.

3. A “scope” on page 84 defines the services the client can access on behalf of the resource owner
and consists of one or more services. If access is granted for a scope, then access is granted for
all the services in that scope.When a request is made, Integration Cloud verifies that the scope
is defined for a client. The client is allowed to access only the service URLs that are specified
for the scope.

For a Resource Path withMethod, clickOAuth Scopes to view the OAuth Scopes that contain
the REST Resource path with Method.

In theOAuth Scopesdialog box, clickAdd URL to Another Scope. In theAdd REST Resource
Path to OAuth Scope dialog box, select Add To Existing Scope to add the REST Resource
path with Method to an existing scope or select Add New Scope to create a new scope and
add the REST Resource path with Method to that new scope.

Creating REST APIs with Swagger

To create a REST API using a Swagger file

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
REST APIs.

The REST APIs page appears.

2. From the REST APIs page, click Add New REST API, select Build with Swagger, and then
click OK.

In the New REST API page, complete the following fields. Required fields are marked with
an asterisk on the screen.

To...Select...

Type a name for the REST API using any combination of
letters, numbers, and/or the underscore character.

Save As

SelectURL and enter theURL for the Swagger document.
The URL should begin with https://.

Swagger Source

OR

Select File and clickBrowse to select a Swagger document
on your local file system. Swagger documents must be
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To...Select...

in either JSON formatwith a .json file extension or YAML
format with a .yaml or .yml file extension.

Click Save.

Note the following points after you click Save:

The REST API is created based on the Swagger definition that is uploaded or the Swagger
definition that is referred to by the given URL.

Integrations are generated based on the Operation IDs in the Swagger file. One Integration
is created for each Operation ID in the Swagger file. A Swagger file cannot have two
Operation IDs that are similar.

Resource Operations are created for a unique path in the Swagger file.

3. To view the Swagger definition, from the REST APIs page, click the REST API link. The
Overview page provides general information on the REST API. The Resources page allows
you to view the resource operations. The Swagger page allows you to view the Swagger
definition.

You can use Access Control Lists (ACLs) to control the execution permission of a REST API.
Integration Cloud associates the default ACL, Default, to a REST API when the REST API is
created using a Swagger file. Click Permissions to associate the REST API with another ACL.

Note:
The ACLwill be enforced only if an Integration acts as a top-level Integration. For example,
if Integration A has Integration B and Integration C as sub-Integrations, then the ACL if
associated, will be enforced only on Integration A.

4. To edit the Integration, go to theResources page, select a ResourceOperation, expand its path,
and click on the integration link. The Integrationwill be open for editing in the Edit Integrations
page. Add necessary blocks and perform mappings.

Note:
You will not be able to modify the Input/Output signature of the Integration because the
signature is derived from the Swagger definition.

5. To run the Integration with the given path and method, go to the Swagger page for the REST
API, click Authorize and type your Integration Cloud user name and password to authorize
access to your APIs, and then click Try it out.

Copying REST APIs

Integration Cloud allows you to create a copy of a REST API from the REST APIs page. You can
copy a REST API if you have the required permissions.
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To copy a REST API

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
REST APIs. The REST APIs page appears.

2. Select a REST API, click on the ellipses icon and select Copy.

The Copy dialog box appears.

3. By default, in the Select Project field, the current project is selected. To copy the REST API
to another project, select a different project from the Select Project drop-down list.

Note:
Ensure that you create any account or reference data associated with this REST API in the
target project.

4. Type a new name in the Copy As field.

5. Click Copy. The system creates a copy of the REST API with the new name and it appears in
the REST APIs page of the target project.

If you create a RESTAPI by using a file containing theOpenAPI specification (formerly known
as the Swagger specification) as a template, a copy of the RESTAPI (including its dependencies
namely its Integrations,Document Types, andResources) is created.All resources anddocument
types are renamed as per the new name. When Integrations encapsulated by the copied REST
API are modified, the changes are reflected only in the copied REST API and not in the REST
API fromwhich it was copied. This is because, if you have created a REST API using the Build
with Swagger approach, each REST API has its own set of Integrations.

If you create a REST API by using an existing set of Integrations (Build from scratch), a copy
of the REST API is created. You can type a new name at the time of copying and a REST API
with the new name is created. The same REST APIs that are referred to in the original REST
API are also referred to in the copied REST API. If the Integration to which it is referred is
modified in the copied RESTAPI, then the changeswill reflect in the original RESTAPI because
both the REST APIs refer or point to the same Integration. However, if another path with a
different Integration is added to the copied REST API, this does not show in the original REST
API.

Exporting REST APIs

IntegrationCloud allows you to export RESTAPIs from theREST APIs page. The export capability
is available only if you have the required license for exporting REST APIs. You can export REST
APIs from one tenant and import those REST APIs to another tenant. Ensure that you have the
Export Assets permission to export REST APIs.
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When aRESTAPI is exported, all its dependencies (Integrations, Document Types, andResources)
are exported. Integrations referred to by the REST API, their dependencies, and all dependant
Document Types of the referred Integrations are also exported.

Note:
If assets used by a REST API are deleted, you will not be able to export the REST API.

To export REST APIs

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
REST APIs. The REST APIs page appears.

2. Select the REST APIs from the REST APIs page and click Export. If the REST APIs you are
exporting use Reference Data, Document Types, SOAP, or REST Applications, then those
Applications including the Reference Data and Document Types will also be exported along
with the REST APIs.

The Confirm Export dialog box appears.

3. Click Export to export the REST APIs. The REST APIs will be downloaded as a zip file to your
default download folder. The zip file size must not be greater than 50 MB. Do not modify the
contents of the exported zip file. If youmodify the contents of the zip file, the RESTAPIs cannot
be imported back to Integration Cloud.

Importing REST APIs

Integration Cloud allows you to import REST APIs from the REST APIs page. You can import
REST APIs from a zip file that was earlier exported from Integration Cloud. You can export REST
APIs from one tenant and import those REST APIs to another tenant. You can import REST APIs
provided you have the Create Integration permission.

Note:
If you want to import a REST API that has an on-premises Application, before importing the
RESTAPI, ensure that you upload the same on-premisesApplication to IntegrationCloud. Else,
you will not be able to import the REST API.

To import REST APIs

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
REST APIs. The REST APIs page appears.

2. Click Import REST APIs.

The Import REST APIs page appears.

3. Click Browse and select the zip file that contains the exported REST APIs. The zip file size
must not be greater than 50MB. The RESTAPIs available in the zip filewill appear in the pane.
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4. Select the REST APIs that you want to import and then click Import.

The REST APIs appear in the REST APIs page.

Note:
While importing a REST API, the REST API including its dependencies are imported. If
there is a REST API with the same name, you will be asked to provide a new name. If you
have Integrations that have the same name as those referred to by the REST API, you will
be asked whether you want to override those integrations. If you choose to override, then
the Integrations in your current tenantwill be removed. If youwant to retain the Integrations,
you can cancel importing the REST API. If you want to retain your current Integrations and
also import the REST API, create a copy of your Integrations by providing another name
and then override your current Integrations at the time of import of the REST API.
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Overview

Web services are building blocks for creating open, distributed systems.Aweb service is a collection
of functions that are packaged as a single unit and published to a network for use by other software
programs. For example, you could create a web service that checks a customer’s credit or tracks
delivery of a package. If you want to provide higher-level functionality, such as a complete order
management system, you could create a web service that maps to many different Integrations,
each performing a separate order management function.

A SOAP API defines a web service and it encapsulates all the information of a web service. The
SOAPAPI contains themessage formats, data types, transport protocols, and transport serialization
formats that should be used between the consumer (requester) and the provider of theweb service.
In essence, the SOAP API represents an agreement governing the mechanics of interacting with
that service.

Integration Cloud allows you towrite integration logic to integrate different types of applications.
This logic can be exposed to the external world using SOAPAPIs. A SOAPAPI is a service provided
to external users.

Note:
Users who have the required project permissions under Settings  > Project Permissions can
create, update, delete, and execute SOAP APIs.

An operation is the WSDL element that exposes some functions of a web service and defines how
data is passed back and forth. A SOAP API exposes one or more Integrations as operations, so
each operation in a SOAP API corresponds to an Integration. The input for the Integration
corresponds to the request body for the operation. The output of the Integration is the response
body for the operation.

Using a SOAP client, you can invoke the SOAP operation externally by using either Basic
Authentication or 2-way SSL. When the SOAP operation is invoked, the associated Integration
gets executed.

You can create SOAP APIs by using an existing set of Integrations (from scratch) or by using a
WSDL file:

Build from scratch: You can create a SOAP API from an existing Integration. In this case, you
specify the protocol and the use and style for the operations when creating the SOAPAPI. The
Integration becomes an operation in the SOAPAPI. IntegrationCloud uses the existing service
signature as the input and output messages for the operation. You can add operations to a
SOAP API or delete operations from a SOAP API that is created from scratch.

BuildwithWSDL: You can create a SOAPAPI from an existingWSDL document. In this case,
Integration Cloud uses the operation definitions from the WSDL to generate an Integration
for each operation in the WSDL. You cannot add operations to a SOAP API created from a
WSDL.
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Creating SOAP APIs from scratch

When you create a SOAPAPI from scratch, you select one ormore Integrations to use as operations.
The operation signature becomes the input and output messages for the operations in the WSDL
document. However, Integration Cloud allows constructs within operation signatures that cannot
be represented in certain web service use/style combinations. When adding an Integration to or
creating a SOAP API from scratch, Integration Cloud verifies that the operation signature can be
represented in the use/style specified for the SOAP API. If an operation signature does not meet
the use/style signature requirements, IntegrationCloudwill not add the Integration as an operation.
Or, in the case of creating a SOAP API from scratch, Integration Cloud will not create the SOAP
API.

Following is a list of operation signature restrictions and requirements for each use/style. Note
that this list may not be exhaustive.

Signature Restrictions for Document - Literal

*body fields are not allowed at the top level

@attribute fields (fields starting with the “@” symbol) are not allowed at the top level

String table fields are not allowed

Signature Restrictions for RPC - Literal

*body fields are not allowed at the top level

@attribute fields (fields starting with the “@” symbol) are not allowed at the top level

String table fields are not allowed

List fields (String List, Document List, Document Reference List, and Object List) are not allowed
at the top level

Duplicate field names (identically named fields) are not allowed at the top level

Top-level fields cannot be namespace qualified

Top-level field names cannot be in the format prefix:localName

Signature Restrictions for RPC - Encoded

* body fields are not allowed

@attribute fields are not allowed (fields starting with the “@” symbol)

Top-level fields cannot be namespace qualified

Top-level field names cannot be in the format prefix:localName
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To create a SOAP API from scratch

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
SOAP APIs.

The SOAP APIs page appears.

2. From the SOAP APIs page, click Add New SOAP API, select Build from scratch, and then
click OK.

3. Complete the following fields and click Save.

The new SOAP API appears in the SOAP APIs page.

DescriptionField

Type a name for the SOAP API using any combination
of letters, numbers, and/or underscore character.

Name

Whether SOAP messages for this SOAP API should use
SOAP 1.1 or SOAP 1.2 message format.

SOAP Version

Select the Integration to use as an operation. The
operation signature becomes the input and output
messages for the operation in the WSDL document.

Select Integration

AWSDL document describes a web service and aWSDL
binding describes how the service is bound to a SOAP

Use and style for
operations

messaging protocol. AWSDLSOAPbinding can be either
a document style binding or a Remote Procedure Call
(RPC) style binding. A SOAP binding can also have a
literal or an encoded use.

Select the use/style for operations in the SOAP API:

Document - Literal

RPC - Literal

RPC - Encoded

Select this option if you want Integration Cloud to
validate all the SOAP API objects and properties against
the WS-I requirements before creating the SOAP API.

Enforce WS-I Basic Profile
1.1 compliance

Integration Cloud automatically uses an internal schema
parser to validate the schemas associated with the XML

Validate schema using
Xerces

Schema definition. Select this option if you want
IntegrationCloud to also use the Xerces parser to validate
the schemas associatedwith the XML Schema definition.
However, the Xerces parser provides stricter validation.
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DescriptionField

As a result, some schemas that the internal schema parser
considers to be valid might be considered invalid by the
Xerces parser.

The Attachment Enabled option is displayed when you
edit the SOAP API. If attachments are enabled for the

Attachment Enabled

SOAP API, instances of XML-type base64Binary are
transported using MIME attachments, which improves
the performance of large binary payload transport.
Integration Cloud supports SOAP attachments only for
SOAP APIs that specify style/use of RPC-Literal or
Document-Literal.

4. Click Save.

The Integration becomes an operation in the SOAP API. Integration Cloud uses the existing
operation signature as the input and outputmessages for the operation. You can add operations
to a SOAP API created from scratch.

5. To add operations, on the Operations page, click Add New Operation.

The Add New Operation dialog box appears.

6. In the Add New Operation dialog box, type a name for the WSDL operation, select an
Integration, and then click Add.

The new operation appears on the Operations page. Using a SOAP client, you can invoke the
SOAP operation externally by using either Basic Authentication or 2-way SSL.When the SOAP
operation is invoked, the associated Integration gets executed.

Creating SOAP APIs with WSDL

You can create a SOAP API from a WSDL document accessed through a URL or by selecting a
WSDL file. You can specify whether Integration Cloud enforces strict, lax, or no content model
compliance when generating document types from the XML Schema definition contained or
referenced in the WSDL document. Content models provide a formal description of the structure
and allowed content for a complex type. The type of compliance that you specify can affectwhether
IntegrationCloudgenerates a document type fromaparticular XMLSchemadefinition successfully.

Do not create a SOAP API from a WSDL that specifies RPC - Encoded, contains attributes in its
operation signature, and/or has complex type definitions with mixed content. Integration Cloud
might successfully create a SOAPAPI from suchWSDLs but the SOAPAPImay exhibit unexpected
runtime behavior.

To create a SOAP API with WSDL
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1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
SOAP APIs.

The SOAP APIs page appears.

2. From the SOAP APIs page, clickAdd New SOAP API, select Build with WSDL, and then click
OK.

The New SOAP API page appears.

3. Provide a name of your SOAP API and complete the following details. Required fields are
marked with an asterisk on the screen.

To...Select...

Specify the SOAP API Source.SOAP API Source

URL - SelectURL if you want to specify the URL of theWSDL.
TheWSDL URL should beginwith http:// or https://. The URL
is used to retrieve theWSDL for the SOAPAPI. Enter theUser
Name and Password if authentication is required to access
the WSDL URL.

File - Select File and then click Browse if you want to select
the WSDL from your local file system. The size of the WSDL

file cannot exceed 5 MB. Click the icon beside the Browse
button if you want to add separate elements of a service
definition after import, such asWSDLs or XSDs, to the primary
WSDL. Ensure that you add the primary WSDL as the first
WSDL, and then add separate elements of the service
definition, for example, dependent WSDLs and XSDs to the
primary WSDL. If you upload a new file, Integrations and
Document Types that are created are now based on the
uploaded file.

In Content model compliance, select one of the following to
indicate how strictly IntegrationCloud enforces contentmodel

Content model compliance

compliance when creating document types from the XML
Schema definition in the WSDL document.

Strict - Generate the document type only if Integration
Cloud can represent the content models defined in the
XML Schema definition correctly. Document type
generation fails if Integration Cloud cannot accurately
represent the content models in the source XML Schema
definition. Currently, Integration Cloud does not support
repeating or nested model groups. If you select strict
compliance, Integration Cloud does not generate a
document type from any XML schema definition that
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contains those items. If IntegrationCloud cannot generate
a document type that complies with the content model in
the XML schema definition in the WSDL document,
Integration Cloud will not generate the SOAP API.

Lax - When possible, generate a document type that
correctly represents the content models for the complex
types defined in the XML schema definition from the
WSDL document. If Integration Cloud cannot correctly
represent the contentmodel in the XMLSchemadefinition
in the resulting document type, Integration Cloud
generates the document type using a compliancemode of
None.When you select Lax compliance, IntegrationCloud
will generate the document type even if the contentmodels
in the XML schema definition cannot be represented
correctly.

None - Generate a document type that does not necessarily
represent or maintain the content models in the source
XML Schema definition.

Select this option if you want Integration Cloud to validate
the SOAP API objects and properties against the WS-I

Enforce WS-I Basic Profile 1.1
compliance

requirements before creating the SOAPAPI. TheEnforce WS-I
Basic Profile 1.1 compliance option specifies whether the
SOAPAPI enforces compliancewith theWS-I Basic Profile 1.1,
a set of guidelines for using web services specifications to
maximize interoperability (including guidance for such core
web services specifications such as SOAP,WSDL, andUDDI).

As an example, using the RPC-Encoded style and use is not
supported by the WS-I profile. If a SOAP API makes use of
the RPC/Encoded style, and Enforce WS-I Basic Profile 1.1
compliance is enabled, Integration Cloud will indicate that
the SOAP API is not compliant.

Enforcing WS-I compliance also affects the contents and
signature for operations in the SOAP API.

IntegrationCloud automatically uses an internal schemaparser
to validate the schemas associated with the XML Schema

Validate schema using Xerces

definition. Select this option if you want Integration Cloud to
also use the Xerces parser to validate the schemas associated
with the XML Schema definition. However, the Xerces parser
provides stricter validation. As a result, some schemas that
the internal schema parser considers to be valid might be
considered invalid by the Xerces parser.
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The Attachment Enabled option is displayed when you edit
the SOAP API. If attachments are enabled for the SOAP API,

Attachment Enabled

instances of XML-type base64Binary are transported using
MIME attachments, which improves the performance of large
binary payload transport. Integration Cloud supports SOAP
attachments only for SOAP APIs that specify style/use of
RPC-Literal or Document-Literal.

4. Click Save to create the SOAP API.

The SOAP API details page appears where you can edit the SOAP API.

5. Click the Operations tab to go to the Operations page. Integration Cloud uses the operation
definitions from the WSDL to generate an Integration for each operation in the WSDL. You
cannot add operations to a SOAP API created from a WSDL.

6. Click the WSDL tab to go to the WSDL page.

On the WSDL page, you can view the WSDL document associated with the SOAP API.

The displayed WSDL document contains all the information to invoke the operations
described in the WSDL.

For a SOAP API created from a WSDL that contains relative URIs that are anonymously
addressable, Integration Cloud replaces any relative URIs with an absolute URI using the
base URI of the WSDL file.

Copying SOAP APIs

Integration Cloud allows you to create a copy of a SOAP API from the SOAP APIs page. You can
copy a SOAP API if you have the required permissions.

To copy a SOAP API

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
SOAP APIs. The SOAP APIs page appears.

2. Select a SOAP API, click the ellipses icon , and select Copy.

The Copy dialog box appears.

3. By default, in the Select Project field, the current project is selected. To copy the SOAP API
to another project, select a different project from the Select Project drop-down list.

Note:
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Ensure that you create any account or reference data associated with this SOAP API in the
target project.

4. Type a new name in the Copy As field.

5. Click Copy. The system creates a copy of the SOAP API with the new name and it appears in
the SOAP APIs page of the target project.

If you create a SOAP API by using a WSDL file, a copy of the SOAP API (including its
dependencies namely its Integrations, Document Types, and Operations) is created. When
Integrations encapsulated by the copied SOAP API are modified, the changes are reflected
only in the copied SOAP API and not in the SOAP API from which it was copied. This is
because, if you have created a SOAP API using the Build with WSDL approach, each SOAP
API has its own set of Integrations.

If you create a SOAP API by using an existing set of Integrations (Build from scratch), a copy
of the SOAP API is created. You can type a new name at the time of copying and a SOAP API
with the new name is created. The same integrations that are referred to in the original SOAP
API are also referred to in the copied SOAP API (provided it is copied in the same project). If
the referred Integration is modified in the copied SOAP API, then the changes will reflect in
the original SOAPAPI because both the SOAPAPIs refer or point to the same Integration (This
does not happen when the Build from scratch SOAPAPI is copied to a different project as the
referenced integrations are also copied to the target project). However, if another operation
with a different Integration is added to the copied SOAPAPI, this does not show in the original
SOAP API.

Exporting SOAP APIs

IntegrationCloud allows you to export SOAPAPIs from the SOAP APIspage. The export capability
is available only if you have the required license for exporting SOAP APIs. You can export SOAP
APIs from one tenant and import those SOAP APIs to another tenant. Ensure that you have the
Export Assets permission to export SOAP APIs.

When a SOAPAPI is exported, all its dependencies (Integrations, Document Types, andOperations)
are exported. Integrations referred to by the SOAP API, their dependencies, and all dependant
Document Types of the referred Integrations are also exported.

Note:
If assets used by a SOAP API are deleted, you will not be able to export the SOAP API.

To export SOAP APIs

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
SOAP APIs. The SOAP APIs page appears.

2. Select the SOAP APIs from the SOAP APIs page and click Export. If the SOAP APIs you are
exporting use Reference Data, Document Types, REST, or SOAP Applications, then those
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Applications including the Reference Data and Document Types will also be exported along
with the SOAP APIs.

The Confirm Export dialog box appears.

3. Click Export to export the SOAP APIs. The SOAP APIs will be downloaded as a zip file to
your default download folder. The zip file size must not be greater than 50MB. Do not modify
the contents of the exported zip file. If you modify the contents of the zip file, the SOAP APIs
cannot be imported back to Integration Cloud.

Importing SOAP APIs

Integration Cloud allows you to import SOAP APIs from the SOAP APIs page. You can import
SOAPAPIs from a zip file that was earlier exported from Integration Cloud. You can export SOAP
APIs from one tenant and import those SOAP APIs to another tenant. You can import SOAP APIs
provided you have the Create Integration permission.

Note:
If you want to import a SOAP API that has an on-premises Application, before importing the
SOAP API, ensure that you upload the same on-premises Application to Integration Cloud.
Else, you will not be able to import the SOAP API.

To import SOAP APIs

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > APIs >
SOAP APIs. The SOAP APIs page appears.

2. Click Import SOAP APIs.

The Import SOAP APIs page appears.

3. Click Browse and select the zip file that contains the exported SOAP APIs. The zip file size
must not be greater than 50 MB. The SOAP APIs available in the zip file will appear in the
pane.

4. Select the SOAP APIs that you want to import and then click Import.

The SOAP APIs appear in the SOAP APIs page.

Note:
While importing a SOAP API, the SOAP API including its dependencies are imported. If
there is a SOAP API with the same name, you will be asked to provide a new name. If you
have Integrations that have the same name as those referred to by the SOAP API, you will
be asked whether you want to override those integrations. If you choose to override, then
the Integrations in your current tenantwill be removed. If youwant to retain the Integrations,
you can cancel importing the SOAPAPI. If youwant to retain your current Integrations and
also import the SOAP API, create a copy of your Integrations by providing another name
and then override your current Integrations at the time of import of the SOAP API.
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Manage Stages

Stages provide safe environments for development and testing that are separated from the
production environment. They allow assets to migrate from one environment to another
environment. When you set up a stage, an environment is created for testing and executing the
Integrations.

Integration Cloud provides ways to manage the Integration development life cycle. The typical
life cycle of an Integration development involves creating Integrations, testing them, and making
themproductionworthy. Each of these activities can be termed as different stages of an Integration
development life cycle. To aide these activities, Integration Cloud provides you with Stages.

A predefined set of stages is allowed, each representing an activity in the Integration life cycle
development. They are:

Development

Test

Pre-Live

Live

By default, every user gets a Development Stage. In the Development Stage, you can create, update,
delete, or view Integrations. You will not be able to create new assets in other stages. In other stages,
Integrations can be pulled from a preceding stage or deleted. Further, Integrations can be pulled
into a stage only from a preceding stage.

Note:
You can access a stage only if your Access Profile is assigned to the stage. See “Apply Access
Profiles to a Stage” on page 695 for more information.

Adding and deleting stages

You can add stages only in the following order:

Live

Test

Pre-Live

You can delete stages only in the following order:

Pre-Live

Test

Live

Note:
Users who have the Stages Administer permission under Settings  > Access Profiles >
Administrative Permissions > Functional Controls > Stages can add or delete stages.
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Apply Access Profiles to a Stage
The typical life cycle of an Integration development involves creating Integrations, testing them,
and making them production worthy. Each of these activities can be termed as different stages of
an Integration development.

Every stage can be assigned a number of Access Profiles and users who are assigned the required
Access Profiles can perform activities on that stage. For example, if in an Access Profile, Execute
Integrations permission is granted, the user assigned with that Access Profile can execute
Integrations on the stages to which the Access Profile is assigned. If the Access Profile needs to
perform scheduling activity on the Live stage, the Access Profile needs to have access to that stage
as well. The Development stage can be accessed by everyone.

Click Add New Stage to add the next stage. Multiple boundary arrows indicate that more stages
can be added.

Click Delete to delete a stage. You cannot delete the Development stage.

Note:
When a stage is deleted, everything it contains is erased and cannot be recovered.

To apply Access Profiles to a stage

1. From the Integration Cloud navigation bar, click Stage in view > Manage. All stages added
including the Development stage are displayed. Initially, before any other stages are added,
the Development stage is displayed.

2. Click Access Profiles and select the Access Profiles you want to apply to the stage.

Note:
By default, the Administrator and Regular User Access Profiles are associated with the
Development Stage. If you have created a newAccess Profile, ensure that the Access Profile
you have created is associated with the Development Stage.

3. Click Apply.

The Access Profiles are applied to the selected active stage.

Note:
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When an Integration is pulled, all its dependentswill also be pulled and copied to that stage.

Deploy Assets

This page displays all the assets under the relevant projects that are available in the current stage
and the previously selected stage. Click theChange Stage To View link to deploy assets to another
stage.

Note:
Users who have the Assets Deploy permission under Settings  > Access Profiles >
Administrative Permissions > Functional Controls > Assets can deploy assets.

After you change the current stage to any other stage other than theDevelopment stage, theDeploy
page gets populated with the relevant assets selected in the Select Asset Type drop-down list.

You can select an asset that was in the earlier stage (left panel) and click Pull to pull the asset to
the current stage (right panel). The assets are categorized under projects. If an asset is pulled and
if the associated project is not present in the current stage, the project along with the asset will be
available in the current stage.

You can pull an asset only if the asset is consistent in the source stage (left panel), that is, all
references of the asset are present in the source stage. The pulled asset can be deleted from the
current stage (right panel).

Note:
You can access a stage only if your Access Profile is assigned to that stage.

Change Stage To View

This page allows you to change the current stage. Only active and accessible stages appear in the
drop-down list for selection in the Stage to view field.

Note:
You can access a stage only if your Access Profile is assigned to that stage.
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After you change the current stage and click Submit, assets and services will be displayed in the
user interface pages only for the selected current stage.

The Stage In View label on the navigation bar displays the current stage.
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Overview

Keystores and truststores are files that function as repositories for storage of keys and certificates
necessary for SSL authentication, encryption/decryption, and digital signing/verification services.
Keystores and truststores provide added layers of security and ease of administration, compared
to maintaining the keys and certificates in separate files.

Integration Cloud stores its private keys and SSL certificates in keystore files and the trusted roots
for the certificates in truststore files. Keystores and truststores are secure fileswith industry-standard
file formats.

If you want to run services that submit HTTPS requests to other resources on the Internet, your
server will be acting as a client andwill receive certificates from these resources. In order for these
transactions towork, your servermust have copies of their public keys and signingCA certificates.

To identify a particular keystore or truststore file, or private key within a keystore, aliases are
used. The use of aliases simplifies keystore and truststore management, because you do not need
to enter path information when specifying a keystore, truststore, or the private key.

Note:
You can add, edit, or view keystore and truststore aliases and partner’s self-signed certificates
from Projects > <Select a Project> > Keys & Certificates and can use them to secure your
ApplicationAccounts. SomeApplications, including customRESTApplications allow two-way
SSL authentication by providing keystore and truststore aliases in the Account Configuration
section. Users who have the Administer permission under Settings  > Access Profiles >
Administrative Permissions > Functional Controls > Advanced Security can add, edit, and
delete Keystores, Truststores, and Partner Certificates.

To add aKeystore, from the IntegrationCloud navigation bar, click Projects > <Select a Project>
> Keys & Certificates > Keystores > Add Keystore.

To add a Truststore, from the IntegrationCloud navigation bar, clickProjects > <Select a Project>
> Keys & Certificates > Truststores > Add Truststore.

To add a Partner Certificate, from the Integration Cloud navigation bar, click Projects > <Select
a Project> > Keys & Certificates > Partner Certificates > Add Certificate.

Add Keystore

IntegrationCloud allows you to upload aKeystore file to store SSL certificates and keys. AKeystore
file contains one or more pairs of a private key and signed certificate for its corresponding public
key. From this screen, you can create aliases for the Keystore, so that they can be referenced while
creating an Account for an Application.

To add a Keystore

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Keys &
Certificates > Keystores > Add Keystore.
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2. Provide a name and description for the Keystore file.

3. In the Type field, select the Keystore file format. The default file format is JKS. You can also
usePKCS12, a commonly used, standardized, certificate file format that provides a high degree
of portability.

4. In the Provider field, select the provider from the list of available providers. The corresponding
provider will be available in the provider list for a selected Keystore type.

5. Click Browse to select the Keystore file.

6. In the Passphrase field, enter the passphrase for the Keystore file. The passphrase must have
been defined at the time the Keystore was created.

7. Click Next to protect the Key Aliases with passphrases. A key alias is a label for specific key
within a Keystore. Enter a passphrase for each Key Alias found in the Keystore file, and then
click “Finish” to upload the Keystore file.

The uploaded Keystore file can be used while creating an Account for an Application.

Add Truststore

Integration Cloud allows you to upload a Truststore file, which contains the trusted root of the
certificate or signing authority (CA). From this screen, you can create aliases for the Truststore, so
that they can be referenced while creating an Account for an Application.

To add a Truststore

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Keys &
Certificates > Truststores > Add Truststore.

2. Provide a name and description for the Truststore file.

3. In the Type field, select the Truststore file format. The default file format is JKS. You can also
usePKCS12, a commonly used, standardized, certificate file format that provides a high degree
of portability.

4. In the Provider field, select the provider from the list of available providers. The corresponding
provider will be available in the provider list for a selected Truststore type.

5. Click Browse to select the Truststore file.

6. In the Passphrase field, enter the passphrase for the Truststore file. The passphrase must have
been defined at the time the Truststore was created and is used to protect the contents of the
Truststore.
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7. Click Save to upload the Truststore file.

The uploaded Truststore file can be used while creating an Account for an Application.

Add Partner Certificate

Integration Cloud allows you to upload the Partner’s certificate which contains its public key. The
Partner’s certificate with the public key is required to encrypt outbound request messages and
verify the signature of inbound messages.

From this screen, you can create aliases for Partner Certificates, so that they can be referenced
while creating an Account for an Application.

To add a Partner Certificate

1. From the Integration Cloud navigation bar, click Projects > <Select a Project> > Keys &
Certificates > Partner Certificates > Add Certificate.

2. Provide a name and description for the Partner Certificate file.

3. Click Browse to select the Partner Certificate file.

4. Click Save to upload the Partner Certificate file.

The uploaded Partner Certificate can be used while creating an Account for an Application.
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Overview

Integration Cloud allows you to package existing webMethods Integration Server services as
images or repositories and upload them on Integration Cloud using the Docker CLI. Docker is an
open-source technology that allows you to deploy applications to software containers. A Docker
container is an instance of a Docker image, where the Docker image is the application, including
the file system and runtime parameters. To facilitate running webMethods Integration Server in
a Docker container, webMethods Integration Server provides a script to use to build a Docker
image and then push the resulting Docker image to a Docker registry hosted in Integration Cloud.
You can store Docker images in a registry on Integration Cloud and manage those Docker images
from the Integration Cloud user interface. Images or a repository are versioned or labeled using
tags, that is, a tag is a label applied to an image or a repository. Tags help you to distinguish various
images or repositories.

Note:
Integration Cloud documentation assumes that you are familiar with Docker technology. An
in-depth discussion of Docker and container technology is beyond the scope of this document.
For information on using webMethods Integration Server with Docker, see the webMethods
Integration Server Administrator’s Guide.

Images are read-only templates from which containers are instantiated, that is, a container is a
runtime instance of an image. A container also consists of an execution environment and a standard
set of instructions. After uploading an image on Integration Cloud, you can create and launch
services from the image/tag to the desired active stage, specify the number of containers and the
container port for each service, and see details of the running instances. A service can contain one
or more containers and is defined as a named group of containers created out of a single image
tag.

Note:
Universal Messaging (UM) can also be run as a container in Integration Cloud. For creating the
UM Docker images supported by Integration Cloud, you must run the Integration Cloud UM
script to modify the base image before it is uploaded into Integration Cloud.

You can access containers if you have the Settings  > Access Profiles > Administrative
Permissions > Container > Access permission. You can administer containers if you have the
Settings  > Access Profiles > Administrative Permissions > Container > Administer
permission. On the Settings  > Access Profile > Container tab, enter the names of the
webMethods Integration Server Access Control List (ACL) groups separated by a comma, for
example, Administrators, Developers, and so on. Users who are assigned to this Access Profile
will also be now part of the webMethods Integration Server container user group (s) and can
perform tasks allowed for those user groups. Note that Integration Cloud Administrator profiles
are not automatically assigned to the webMethods Integration Server Administrators ACL group.
If you do not map an Access Profile to an webMethods Integration Server group, you will not be
able to invoke webMethods Integration Server services.

Note:
Enabling theCSRF security featurewill prevent CSRF attacks. EnableCSRF Guard and configure
the CSRF guard settings in webMethods Integration Server Administrator before you create
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the Docker image and upload it to Integration Cloud. See the webMethods Integration Server
Administrator’s Guide on the Software AG Documentation website at http://
documentation.softwareag.com for information on how to enable CSRF Guard.

You can use the Docker Command Line Interface (CLI) to perform the following tasks:

Log in to the system: #docker login -u <username> -p <password>
https://<subdomain>.<domain.com>/, for example, docker login -u x@x.com -p test123
https://john.wmic1.com/.

Tag an image or repository: #docker tag <imagename>:<tagname>
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example, #docker
tag is_912:withkeystore john.wmic1.com/john/development/is_912:withkeystore2.

Push or upload an image or repository: #docker push <subdoamin.wmis.com>/<subdomain>/<stage
name>/<image-name>:<tag-name>, for example, #docker push
john.wmic1.com/john/development/is_912:withkeystore2.

Pull or download an image or repository: docker pull <subdoamin.wmis.com>/<subdomain>/<stage
name>/<image-name>:<tag-name>, for example, #docker pull
john.wmic1.com/john/development/is_912:withkeystore2.

Managing Repositories

Images or repositories are read-only templates from which containers are instantiated. The
Repositories screen allows you to view, delete, and add repositories for the active stage. You can
select a repository and click Delete to delete a repository or click Add New Repository to add a
repository. In the Add New Repository screen, select the Deployment Stage and enter the
Repository Name. If a stage is not enabled to access containers, contact Support to enable the
stage.

To view the details of a tag from the Repositories screen

1. Select a repository and then click the repository link under the Name column.

The Image Tags screen is displayed. A list of all image tags is displayed along with their
names.

2. From the Image Tags screen, you can select an image tag and delete it or add a new service
for the tag. See “Viewing Tag Details” on page 706 for more information.

3. Click the Commands tab to view and copy the commands on how to log in, tag images, push
images, or pull images.

Log in to the system: #docker login -u <username> -p <password>
https://<subdomain>.<domain.com>/, for example, docker login -u x@x.com -p test123
https://john.wmic1.com/.
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Tag an image or repository: #docker tag <imagename>:<tagname>
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example,
#docker tag is_912:withkeystore john.wmic1.com/john/development/is_912:withkeystore2.

Push or upload an image or repository: #docker push
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example,
#docker push john.wmic1.com/john/development/is_912:withkeystore2.

Pull or download an image or repository: docker pull
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example,
#docker pull john.wmic1.com/john/development/is_912:withkeystore2.

Viewing Tag Details
This screen displays details of all the tags for a repository. You can delete an image tag or add a
new service. You can also click the Commands tab to view and copy commands on how to log in,
tag images, push images, or pull images.

To view the image tag details

1. From the Integration Cloud navigation bar, click Containers > Repositories.

2. Select a repository and then click on the repository link. The Image Tags screen appears. A
list of all Docker image tags is displayed along with their names.

From the Image Tags screen, select a tag and then click Delete to delete the image tag if it is
not used by any service or click Add New Service to create a new service for the image tag.
In the New Service window, specify the Service Name, the Volume Name, and the number
of Docker Containers to instantiate.

3. From the Image Tags screen, select an image tag and click on the image tag link to view the
Image Tag details screen. The Image Tag details screen displays the deployment stage of the
image tag including the image tag label details. The image tag label details are as follows:

Image Type - Mandatory field. Indicates the type of image, for example, webMethods
Integration Server or Universal Messaging.

Description, Build Number, and Version - Optional fields you had defined while creating
the image.

Pushed At - System generated value. Date and time when the Docker image was pushed
to the repository.

Size - System generated value. Indicates the size of the Docker image.

Exposed Port -Mandatory field. The port you had definedwhile creating the image. Ensure
that the exposed port is the same as defined on your application, that is, on webMethods
Integration Server or Universal Messaging.
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The Image Tag details screen also displays when the screen was last refreshed, used and
available containers for the displayed active stage, and information on all services created for
the tag. You can edit, delete, start, stop, or add a new service from the Image Tag details screen.
Click on a service link to view the service details screen. See Managing Services for more
information.

4. The Commands screen allows you to view and copy the commands on how to log in, tag
images, push images, or pull images:

Log in to the system: #docker login -u <username> -p <password>
https://<subdomain>.<domain.com>/, for example, docker login -u x@x.com -p test123
https://john.wmic1.com/.

Tag an image or repository: #docker tag <imagename>:<tagname>
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example,
#docker tag is_912:withkeystore john.wmic1.com/john/development/is_912:withkeystore2.

Push or upload an image or repository: #docker push
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example,
#docker push john.wmic1.com/john/development/is_912:withkeystore2.

Pull or download an image or repository: docker pull
<subdoamin.wmis.com>/<subdomain>/<stage name>/<image-name>:<tag-name>, for example,
#docker pull john.wmic1.com/john/development/is_912:withkeystore2.

Managing Services

The Services screen displays details of all services in the active stage, the repository name and tag
name, status of the service, and number of Docker containers instantiated for a tag. You can start
a service, stop a service, edit a service, delete a service, add a new service, refresh the screen, and
view details on when the screen was last refreshed.

Note:
You can also add a new service for a specified image tag from the Containers > Repositories
> Click a repository link > Image Tags screen.

From the Services screen, select a service and then click the link to view the Service details screen.
In the Service details screen, you can add or remove docker containers for the service for the
selected repository and image tag.

The ServiceDetails screen provides information on the service status (Stopped, Pending, Running),
the repository, Deployment stage, and the image tag. You can start a service if it is in a stopped
state. TheDocker Containers pane in the ServiceDetails screen displays information on the docker
containers, their status, and the Admin URL, which is the webMethods Integration Server
Administrator URL. You can modify Docker containers to instantiate by clicking Manage
Containers, or click theAdmin URL link to log intowebMethods Integration Server Administrator.
In the Exposed Services pane, you can view the Exposed Docker Services. The exposed Docker
service URL can be used to execute the webMethods Integration Server Administrator service
running in the Docker container.
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Note:
Enabling theCSRF security featurewill prevent CSRF attacks. EnableCSRF Guard and configure
the CSRF guard settings in webMethods Integration Server Administrator before you create
the Docker image and upload it to Integration Cloud. See the webMethods Integration Server
Administrator’s Guide on the Software AG Documentation website at http://
documentation.softwareag.com for information on how to enable CSRF Guard.

Note:
You can now invoke services exposed bywebMethods Integration Servers running in theDocker
Containers from Integrations. For more information, see the On-Premises Applications section
and also the Configuring On-Premise Integration Servers for webMethods Cloud document.

To add a new service, from the Containers > Services screen, click Add New Service. The New
Service screen appears. In the New Service screen, enter the following fields:

Repository - Select a repository.

Image Tag - Select an image tag.

Service Name - Enter a valid service name. The service name can contain only alphanumeric
characters and should not be more than 16 characters.

Volume Name - Enter the storage volume name. The Volume name is displayed only for
Universal Messaging (UM) docker images and represents the data volume for the docker
container to persist the container data.

Docker Containers - Enter the number of containers to instantiate for the service.

Click Save to create a new service.

To stop a service, from the Services screen, select a service that is in Running state and then click

Stop. Click and refresh the screen to view the latest service status.

To delete a service, from the Services screen, select a service that is not in Running state and then
click Delete.

To start a service that is in Stopped state, select a service and then click Start. The launch service
screen appears. Specify the number of Docker Containers to instantiate for the selected service

and then click Start. Click and refresh the screen to view the latest service status.
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Overview

End to End Monitoring is a cloud offering by Software AG . It is your interface to view the flow
of a business transaction in a unifiedmanner from start to finish acrosswebMethods cloud systems.
Not just that, it allows you to monitor a business transaction and identify any error that occurs
during a business transaction along with the details of the application and the time at which the
error occurred.

To know more, check out “User Journey ” on page 728.

Architecture
The section explains how End to End Monitoring helps a user to get the details of a business
transaction.

Let us consider an example, where a customer is requesting for an address change with his bank
using a banking application. Here, the banking application is represented as a Third-party system.
Following actions take place when the customer wants to change the address:

710 Integration Cloud 6.6.0

19 End-to-End Monitoring



1. Customer raises an address change request using the client application. Client application is
accessible using any device.

2. The request makes an API call to API gateway where the user is validated. Any policy
enforcement required happens here.

3. After successful validation, an Integration service call is made to webMethods Integration
Cloud. For example, in this case let us say that the Integration service call made to update the
customer record is updateaddress.

4. The Integration service call authenticates the user with the bank and updates the record in the
database of the bank.

5. On successful update of the record, a confirmation message is sent to the client application as
a response.

The Role of End to End Monitoring

End to EndMonitoring tracks the business transaction from start to finish and provides details of
the transaction. A graphical representation of a business transaction flow is as follows. For more
information, see “Business Transaction Details page” on page 725.

General Data Protection Regulation (GDPR) Considerations
From a GDPR perspective, the following considerations are to be noted:

As part of the rule creation and group creation, the application collects and stores the user ID
and email address of the user in the Elastic Search database. The user ID and email address
may be personal data or personally identifiable information.

Note:
The user ID is the ID using which the user logs into webMethods Integration Cloud.

The user does not have an option to delete this personal data or personally identifiable
information from the Elastic Search database. However, if a tenant is deleted, then the user
related data is also deleted.

End to End Monitoring does not store any log information in the database.
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Working with End to End Monitoring

This section provides information about the various features of End to End Monitoring.

Dashboard for End to End Monitoring
The dashboard for End to EndMonitoring gives you a collective viewof all the business transactions
carried out within your cloud platform. The default Dashboard view includes the transaction
widgets and the default All Transactions group. The All Transactions group contains all the
transactions within the application and cannot be deleted.

Note:
When you perform sorting, the All Transactions group remains on the top of the list.

An example of the dashboard that shows theAll Transactions group alongwith the customgroups
created by an end user is as follows:

- An alert icon to notify you of any new transaction notifications.

- User help that includes the help content for this application.

- Use the link provided here to log off from the application.

Time range - Below is the drop-down list for time range selection. By default, it is set to half
an hour prior from the current system time. For example, if current system time is 3:30 PM,

then the time range shows as 3 PM to 3 30 PM. Click next to the time range to select a
specific duration.

Note:
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The time zone is set automatically based on the system time.

Transaction widgets - Following widgets are available on the dashboard:

Overall - This is a summary of all the transactions processed based on the following
parameters:

Failed

Success

An example of the Overall widget is as follows:

Network View - This is a graphical representation of all the transactions across all the
supported nodes. It shows the transactions flowing through each runtime as well as the
status of each runtime for the selected time range.

An example of Network View is as follows:

Top 5 Groups by Error Rate - This is a graphical representation which shows the top 5
groups based on the error rate. The values are displayed in percentage. TheAll Transactions
group is excluded from this widget. An example of this widget is as follows:
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Top 5 Rules Violated - This is a graphical representation which shows the top 5 rules that are
violated the maximum number of times. It is a Pi chart that shows a count for the number of
times these rules are violated. An example of this widget is as follows:

Help Topics - This provides you quick access to the help content for some of the commonly
used topics.

All groups - This lists all the transaction groups you create using the application and also the
default All Transactions group. At the group level, you can see the following parameters for
the selected time range:

Note:
You can customize the parameters to view by clicking next to Create Group.

Name - Name of the group.

Total transactions - The total number of transactions for each group.

Avg. time (ms) - Average time of execution for all the transactions within a group.

Error rate (%) - The rate of error in percentage for all the transactions within a group.

Success rate (%) - The rate of success in percentage for all the transactions within a group.

Create group - Select this option to create a customgroup of transactions. Formore information,
see “Creating a Group of Transactions” on page 714.

Search by name - Search for a transaction group by typing its name in the search box.

Creating a Group of Transactions
Creating a group of transactions allows you to categorize the transactions based on your
requirements.

To create a group of transactions

1. On the Dashboard page, click Create Group.

2. In the Create group dialog box, provide the following details:

DescriptionParameter

Type a name for this group.Group Name
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DescriptionParameter

Note:
The group name cannot be edited after you save this form.

Group the transactions on the basis of their status. It can be a
combination of:

Status

Success

Failed

Group the transactions on the basis of the application from where
the business flow starts. You can choose one or more products when

Starts with

creating the group. For example, you can have a group where you
have one transaction starting from webMethods API Gateway and
another transaction starting from Integration Cloud. You can select
from the following:

webMethods API Gateway

Integration Cloud

webMethods.io B2B

Group the transactions on the basis of their execution time in
milliseconds. You can select from the following:

Duration (ms)

- Select this operator to group the transactions that have an
execution timewhich is lesser than or equal to the value specified
here.

- Select this operator to group the transactions that have an
execution time which is greater than or equal to the value
specified here.

- Select this operator to group the transactions that have an
execution time which is between the values specified here. For
example, if you specify 20 and 30 (ms), then both the values 20
and 30 are also taken into consideration.

Group the transactions on the basis of the product(s) involved in a
business transaction. Use the drop-down list to select one or more

Product(s) involved

products. The group includes all the transactions for the selected
product. If you select more than one product, it will list the
transactions for the standalone products along with the transactions
that involve both the products. For example, if you select
webMethods API Gateway and Integration Cloud, the group will
include the following:

all transactions that involve only Integration Cloud
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DescriptionParameter

all transactions that involve only webMethods API Gateway

all transactions that involve both Integration Cloud and
webMethods API Gateway.

Group the transactions on the basis of their names. Click + to add
more than one entry.

Transaction name(s)

Note:
Click X to remove the added names.

Group the transactions on the basis of an error message. Click + to
add more than one entry.

Error Message(s)

3. Click Save.

Viewing the Transactions List

1. On the Dashboard page, select the group for which you want to view the transactions. On the
Transactions list page, you will see all the transactions for the selected time frame and the set
filter(s).

2. Click on the top-right corner of the screen to open the Show Columns dialog box.

3. Select the parameters for which you want to view the transaction details and click Save. The
transactions list shows the following parameters:

4. You can also filter the transactions from this page. For more information, see “Filtering the
Business Transactions” on page 717

DescriptionParameter

Status of the transaction. Currently, we have the following states:Status

- Transaction successful.

- Transaction failed.

Name of the transaction. This name is based on the starting point
of the transaction. For example, if the transaction starts from

Name

webMethods API Gateway, then this name would be the name
of the API.

Total time taken by the transaction to complete.Duration (ms)

716 Integration Cloud 6.6.0

19 End-to-End Monitoring



DescriptionParameter

The application from which the transaction starts. For example,
webMethods Integration Cloud.

Started from

Start time for the transaction. The time zone is set based on the
system time.

Started on

Message with which the transaction failed. The message
displayed here pertains to the first component inwhich the error
occurs.

Error message

This is a unique identifier for the transaction.Trace ID

Editing a Transactions Group

1. On the Dashboard page, select in the row for the transaction that you want to edit.

Note:
Editing a transaction group impacts all the rules associated with it.

2. Make the necessary changes and click Update.

Deleting a Group

1. On the Dashboard page, select in the row for the transaction that you want to delete.

Note:
Deleting a transaction group deletes all the rules and the rule violations associated with it.

2. Click Delete.

On successful deletion, you will see a confirmation message on the screen.

Filtering the Business Transactions
You can filter the business transactions within any group to view a custom set of transactions.

Note:
Filters that were set during group creation are already applied when you open the group.

To filter the transactions

1. On the Transactions list page, click as shown in the following example:

Integration Cloud 6.6.0 717

19 End-to-End Monitoring



2. In the Filter dialog box, you can choose from the following filters:

Note:
Filters set during group creation are greyed out and not available for selection.

DescriptionValue

Select the transaction status. You can select from the following and
click Save:

Status

Success - Lists all the completed business transactions.

Failed - Lists all the failed transactions.

Type the name of the business transaction and click Save. To addmore
than one transaction name, click +

Name

Select from the following operators using the drop-down list and
provide a valid time in milliseconds:

Duration

- Select this operator to filter the transactions that have an
execution time which is lesser than or equal to the value specified
here.

- Select this operator to filter the transactions that have an
execution timewhich is greater than or equal to the value specified
here.

Select this operator to group the transactions that have an
execution time which is between the values specified here. For
example, if you specify 20 and 30 (ms), then both the values 20 and
30 are also taken into consideration.
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DescriptionValue

Filter the transactions on the basis of the application from where the
business flow starts. Select the checkbox next to the product. You can
select more than one product.

Starts with

Filter the transactions based on the error message with which it failed.
Type the error message and click Save. For example, server not found.

Error message

You can filter based onmore than one errormessage by clicking + next
to the error message box.

Filter the transactions based on the products that are involved with
this transaction. Select the checkbox next to the product and click Save.
You can select more than one product.

Product(s) involved

Filter the transactions based on this unique identifier associated with
a transaction. Enter the trace ID and click Save. You can filter based
on more than one Trace ID by clicking + next to the trace ID box.

Trace ID

3. The applied filters show up on the top of the page as shown in the following example:

You can close a particular filter by selecting the filter and clickingX adjacent to the filter name.

4. After you apply the filters and retrieve the list of transactions, you can further sort the list by
clicking the column headings. Sort in ascending or descending order by toggling the column
header.

Alert
The Alert page lists all the Rule violations and the Rule list. From the Alert page, you can create
Rules. These rules are a set of conditions.When these conditions aremet by a group of transactions,
the rule violation occurs. You can configure a rule such that it triggers an alert in the form of an
on-screen notification or email or both. The rules that you create are applicable to all the transactions
of a groupwith which it is associated. For information on creating a rule, see “Creating a Rule” on
page 720

Notification Alerts

Notifications for End to End Monitoring are currently shown on the top-right corner of your

application screen. For example, when there are two new rule violations, you will see .

Integration Cloud 6.6.0 719

19 End-to-End Monitoring



Email Alerts

When you create a rule, you have an option to be notified through an email. Whenever a group
violates the conditions defined in a rule, youwill receive system generated emails with the details
of the violation.

Rule Violations

This includes a list of all the rules that are violated by the transactions in a group. For more
information, see “Working with Rule Violations” on page 723.

Rule List

This includes the list of all the rules that you create in the application. It also lists all the pre-defined
rules available with the application. For more information on pre-defined rules, see “Default
Rules” on page 722.

Viewing Alerts

To view the alerts

1. Click at the top of the screen to open the Rule violations pane. Here, you will see a list of
all the new rule violations along with the older ones.

If there are new rule violations, you will see a number with . For example, two new rule
violations are indicated by at the top of the screen.

2. In the Rule violations pane, click View all to go to the Rule violations section of the Alert page.

3. In the Rule violations tab, you will see all the rules violations listed in a table format.

Creating a Rule

The application triggers alerts when a group of transactions violates the conditions defined in a
rule associated with it.

To create a rule

1. On the Alert page, click Rule list.

2. Select Create rule.

Note:
The application provides you a set of default rules. For more information, see “Default
Rules” on page 722
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3. In the Create rule dialog, provide the following details:

In the General Information section, provide the details for the following and click Next.

DescriptionValue

Provide a name for the rule.Name

Note:
You cannot change the rule name once you save the rule.

Provide a meaningful description for the rule.Description

Select the group from the drop-down list.Group

Note:
Currently, you can associate a rule only to a single group.
However, a group can be associated with multiple rules.

In the Rule Expression section, provide the details for the following and click Next.

DescriptionValue

This is the key performance index. Select from the following
options:

KPI

Error count

Error rate

Average response time

The time range on the basis ofwhich this rule should trigger
an alert when violated. Select from the following options:

Time range

In last 30 mins

In last 1 hour

In last 12 hours

In last 24 hours

Select the operator on the basis of which this rule should
trigger an alert when violated. Select from the following
options:

Operator

Less than (<) - lesser than the value specified in theValue
field.

Greater than (>) - greater than the value specified in the
Value field.
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DescriptionValue

Equals to (=) - equal to the value specified in the Value
field.

Note:
Value could be a number, percentage, or time and changes
on the basis of the KPI you select.

This field varies on the basis of your selection in the KPI
field. The value field changes on the basis of the KPI you
select:

Value

For Error count, it is set to Value(number).

For Error rate, it is set to Value(%).

For Average response time, it is set to Value(ms).

In the Action section, select your notification preference and click Next. You can select
either or both of the following options:

DescriptionValue

Select this option to get on-screen app notifications.Show app notification

Select this option to subscribe for email alertswhenever
a group violates a rule. Provide the recipient email

Send email

address. You can enter more than one email address
separated by a comma.

In the Summary section, verify all the details provided by you and click Save.

Default Rules

The application provides you with a set of pre-defined rules. By default, these rules are disabled.
These pre-defined rules are as follows:

Note:
Other than the Name, you can modify all the other values as per your requirements.
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Send
email

Show
app
notification

ValueOperatorTime
Range

KPIGroupDescriptionName

FalseTrue100
(ms)

>In last 1
hour

Average
response
time

All
Transactions

The average
response time for all
transactions in last 1
hour is greater than
1000 ms.

Average
response
time is out of
compliance

FalseTrue10>In last 1
hour

Error
count

All
Transactions

The error count for
all transactions in
last 1 hour is more
than 100.

Error count
is out of
compliance

FalseTrue10%>In last 1
hour

Error
rate

All
Transactions

The error rate for all
transactions in last 1
hour exceeds 10%.

Error rate is
out of
compliance

Working with Rule Violations

The Rule violations page provides details of all the violations. Use this page to search for specific
violations and to view all the violations within the various groups for a specified duration. The
following table provides you details of all the actions possible in the Rule violations page:

DescriptionAction

Use this drop-down list to filter all the violations on the basis
of duration or status. The values include:

Show all

All open

All closed

Last 1 hour

Last 12 hours

Today

Yesterday

Last 7 days

This is the refresh button. Click this to refresh the list of rule
violations. It shows the time when the list was last refreshed.

This is the columnview settings button. Click this to customize
the columns you want to view for the rule violations.
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DescriptionAction

Select this drop-down list to filter the rule violations on the
basis of group name. You also get a search boxwhen you click
this drop-down list. Use this search box to type a group name
that you want to search.

Note:
You can select more than one group.

Type a rule name in this search box to filter all the rule
violations on the basis of rule name.

Search by name

To sort the rule violations, click on the header row of any column. You can sort in both ascending
and descending order.

Working with Rule List

The application lists all the rules that you create in the Rule list page. The following table provides
you details of all the actions possible in the Rule violations page:

DescriptionAction

Use this action button to create a new rule. For more
information, see “Creating a Rule” on page 720.

Create rule

To edit a rule, click this action button on the row of the
corresponding rule.

Note:
You cannot modify the rule name.

To delete a rule, click this action button on the row of the
corresponding rule.

Select this toggle button in the Status column to enable or

disable a rule. indicates that a rule is enabled and

indicates that a rule is disabled.

Note:
When you use this button, you will see corresponding
system messages on screen to indicate if a rule is enabled
or disabled successfully.

This is the columnview settings button. Click this to customize
the columns youwant to view for the listed rules. In the Show
Columns dialog, select the columns you want to view and
click Save.
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DescriptionAction

Select this drop-down list to filter the rules on the basis of
group name. You also get a search box when you click this
drop-down list. Use this search box to type a group name that
you want to search.

Note:
You can select more than one group.

Type a rule name in this search box to filter the rules on the
basis of rule name.

Search by name

To sort the rules, click on the header row of any column. You can sort in both ascending and
descending order.

Business Transaction Details Page
The business transaction details page provides the following information about the transaction:

DescriptionParameter

Transaction name.Name

Distinct identifier for the transaction generated internally by the application.Trace ID

Status of the transaction.Status

Time at which the transaction started.Start period

Time at which the transaction ended.End period

Total time taken by the transaction to execute. This includes the time taken by
the transaction to process within each component and any network latency to
or from the client. For more information, see “ Duration” on page 725

Duration (ms)

Duration

Duration is the total time taken by a transaction from the time a client initiates a request to the
time a response is received by the client.

Let us consider the following scenario where the duration for a transaction to complete is 200ms.
In the following image, 200ms is the time difference between INT22 and INT11. The time taken
by the transaction within the API component which is 50ms is already taken into account as part
of this 200ms value. End to EndMonitoring records the duration only from the time a client request
enters the first component of the cloud platform (INT11) and the time the response exits the last
component of the cloud platform (INT22).

Note:
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The application does not note the time the client sends the request (T1) and the time the client
receives the response (T2), as this happens outside the Software AG environment.

Business Flow Map

This provides a logical representation of the business flow showing the path taken by the transaction
through the various cloud components. Also, the processing time for the transaction within each
component is visible.

A legend is available to identify the status of a transaction. An example of a business flow is as
follows:

TheBusiness FlowMapalso showsdetailswhen there is a cross-domain transaction.A cross-domain
transaction is one where the client makes a call to a supported component in one tenant and then
the call moves to a component in another tenant. For example, let us consider the following image.
Here, a client calls an Integration Cloud instance in one tenant and then the transaction moves to
call another Integration Cloud instance in a different tenant. When you select the component, you
can view the corresponding tenant name in the component details pane. In the following example,
the second Integration Cloud instance is highlighted along with its tenant name.

726 Integration Cloud 6.6.0

19 End-to-End Monitoring



Viewing the Transaction Details

To view the transaction details

1. On the Application dashboard, select the transaction group for which you want to view the
details.

2. On the Business Transaction Details page, click the component from the business flow map
for which you want to view the details.

The details open in a separate pane and includes the following information:

DescriptionField

Provides the name of the tenant where the transaction happened.Tenant name

Provides the status of the transaction. Status can be:Status

Success

Failed

Provides the reason for the error to occur. If a transaction is successful, then
this parameter is not visible.

Cause of
failure

Time spent by the transaction within this component.Processing
time

Phase at which the failure has occurred during the execution of a transaction.
Stage represents an activity in the life cycle of the transaction. Possible stages
are:

Stage

Development

Live

Test

Pre-Live

Note:
Stage is visible only if you are viewing the details for Integration Cloud.

Click thisURL to open the details of theAPI or the integration that is associated
with the business transaction. For an Integration, you are redirected to the

More details...

instance of webMethods Integration Cloud in a new tab and for an API, you
are redirected to the instance of webMethods API Gateway in a new tab. The
More Details link also show the product-specific details for the products
involved in a cross-product transaction even if the tenant for that productwas
configured in a different domain or a custom domain.
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User Journey

Summary

This section provides details about the journey of a user using End to End Monitoring. It is used
to view the end-to-enddetails of a business transaction as itmoves through the variouswebMethods
applications.

Actors

As part of this user journey, we have two actors here who play their respective roles:

Jim -A SoftwareAG customerwho owns an enterprise calledXYSsales and sellsmanyproducts
on his business platform. To run his business better, he uses products like webMethods API
Gateway andwebMethods IntegrationCloud.XYSsales has a large customer basewhere every
day new customers create their accounts on his business platform.

Hayley - A prospective customer of Jim. She wants to create an account in XYSsales.

Challenge

Jim reviews many business transactions in a day. These transactions move across the various
Software AG applications. Reviewing the transactions helps Jim identify areas of improvement
and any errors. In this scenario, XYSsales uses both webMethods API Gateway and webMethods
Integration Cloud. Jim can view the details of the transactions within the individual systems. For
example, on an API execution, he can view its details using the logs in API Gateway. In the same
manner,when an Integration is run, he can view its details using the logs inwebMethods Integration
Cloud. However, if an API calls an Integration in webMethods Integration Cloud, the log
information does not tell Jim which Integration in webMethods Integration Cloud corresponds to
which API execution in webMethods API Gateway.

To summarize, Jim is unable to correlate the information when a business transaction traverses
through multiple systems. He is unable to view the end to end details of a business transaction.
We are helping Jim solve this problem by introducing End to End Monitoring.

Hayley sends a request to create a user account using a client application. This triggers a business
transaction. Jim wants to view the complete flow of this business transaction. He wants to know
the details from the time Hayley sent the request to the time she received the response.

Preconditions

As part of the prerequisites, Jim performs the following actions:

Creates a connection from XYSsales to webMethods Integration Cloud by creating an account
in webMethods Integration Cloud.

Creates an Integration called CreateAccountinXYSsales in webMethods Integration Cloud.
He exposes this Integration as a REST endpoint such that any client can access it.
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Creates an API called APItoCreateAccountinXYSsales in webMethods API Gateway. This allows
him to make a connection with the REST endpoint created in the earlier step.

Basic Flow

When Hayley sends a request to create a user account in XYSsales using the client application,
following events take place:

1. The client application calls the REST API APItoCreateAccountinXYSsales. The system applies all
the policies defined for this API at this stage of the transaction.

2. After successful authentication ofHayley's account credentialswithwebMethodsAPIGateway,
the API invokes the Integration CreateAccountinXYSsaleswhich is the REST endpoint.

3. The Integration is run and it creates the user account for Hayley in XYSsales. On successful
creation of the account, the system sends a confirmation message as a response to Hayley
through the client application.

4. Jim can view the details of the API execution through the Analytics tab of the webMethods
API Gateway cloud instance as shown here:
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5. Jim can also view the details of the integration using the Monitor tab of the webMethods
Integration Cloud instance as shown here:

How does Jim Monitor the Transactions?

1. Jim logs into webMethods Integration Cloud.

2. He selects End to End Monitoring from the App Switcher as shown here:

3. Jim opens the Dashboard of End to End Monitoring to view all the transaction groups. By
default, the duration selected for view is Last 30 mins . Jim views the following details:
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4. He selects the group XYSsales which lists all the transactions associated with his enterprise.

5. He selects the transaction which he wants to view.

6. On the business transaction details page, he can view all the information for that business
transaction as shown here:

7. On the business transaction details page, he can get more details for each component of the
transaction by selecting the component from the Business flow map. When he selects the
component, the details are shown in a new pane. For example, Jim selects the Integration
Cloud component and he can view the details as shown in the following image:
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8. Jim selects theMore details..URL to open the webMethods Integration Cloud instance. Here,
he finds information about the integration thatwas executed as part of this business transaction
as shown in the following image:

9. This completes the user journey for Jim.
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Overview

TheCloudDeployment section is applicable only if you are an existing tenant andhave already
provisioned Cloud Deployment.

Note:
See the article on Software AG TECHcommunity website to get started on Cloud Deployment.

A Solution consists of packages bundled together into one coherent service. It is a logical
combination ofwebMethods Integration Server packages,Adapter packages, Services,webMethods
CloudStreams packages, and webMethods Integration Server and Universal Messaging
configuration assets or configurations.

Note:
After deploying the configurations, due to webMethods Integration Server restart, the assets
will appear after a short delay.

Integration Cloud Integrations can invoke Cloud Deployment webMethods Integration Server
services for the same tenant. Using the predefined Cloud Deployment Application available in
Integration Cloud, you can select the solution webMethods Integration Server services that you
want to invoke from Integration Cloud.

The following figure provides a high-level overview of the process involved in deploying
on-premises webMethods Integration Server packages and configuration assets to Integration
Cloud.
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With Software AG Designer, you can deploy the webMethods Integration Server packages or
configuration assets that you have created, verified, and tested on on-premises webMethods
Integration Server or UniversalMessaging to IntegrationCloud.When you initiate the deployment
from Software AG Designer, webMethods Integration Server packages and configuration assets
are built from webMethods Integration Server and Software AG Command Central respectively,
and are published to the Asset Repository available in Software AG Designer. After performing
variable substitutions to make the on-premises configuration data compatible, you can publish
the packages and configurations to an asset repository provisioned for the tenant on Integration
Cloud.

User Interface elements

The following table describes the various user interface elements that appear on the Cloud
Deployment workspace:

DescriptionIconPage Elements

Access the home page.webMethods Cloud Deployment

View and create solutions,
deploy solutions to

Solutions

environments, view the
Asset Repository, and
manage webMethods
Integration Server
instances.

View the overall status of
the solutions, landscapes,

Monitoring

systemand runtime alerts,
KPI graphs of the
runtimes, service
executions of the
webMethods Integration
Server instances,
availability of the run
times, alert status of the
solutions, and logs.

View the overall run-time
availability for all the

Runtime availability

solutions in the last 24
hours. The doughnut
chart displays the periods
of availability (green
color), unavailability (red
color), and maintenance
(yellow color).
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DescriptionIconPage Elements

The usage statistics shows
the CPU and Memory

Usage Statistics

usage for all solutions in
environments.

The CPU bar shows the
maximum CPU that is
licensed for the tenant.
The colored part of the bar
shows how much of the
allowed CPU is currently
used by the tenant.

The Memory bar shows
the memory in Gb that is
licensed for the tenant.
The colored part of the bar
shows how much of the
allowed memory is
currently used by the
tenant.

Add a database to your
subscription. This enables

Database

you to configure, store,
and monitor your
database directly in the
cloud instead of using
external systems.

Total number of solutions
created. View the Solution

Solutions section

List page by clicking the
Details link and the
Monitoring Dashboard by
clicking the Monitoring
link.

Number of service
executions and their

Service Executions section

status in the last 24 hours
for all the solutions that
are currently available in
the selected Default
Environment. To view the
Services page under
Monitoring, click the
service execution link.

736 Integration Cloud 6.6.0

20 Switch to Cloud Deployment



DescriptionIconPage Elements

Number of currently open
alerts and their severity.

Active Alerts section

Click on the links to go to
the Alerts page.

Click to view and link
environments.

Default Environment

Access Help topics,
Software AG

Help

TECHcommunity,
Licensing capabilities, and
the About page. The
About page displays the
version information,
Global Support
information, Copyright
information, Impressum
and Privacy Policy, and
the release readme.

Name of the logged in
user, profile information

Profile

of the logged in user, and
Logout option.

When was the last login,
important and other

Last Login, Notifications, andHelp
topics

notifications, what is new
in this release, and
context-sensitive help
topics.
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Solutions

A Solution consists of packages bundled together into one coherent service. It is a logical
combination ofwebMethods Integration Server packages,Adapter packages, Services,webMethods
CloudStreams packages, and webMethods Integration Server and Universal Messaging
configuration assets or configurations.

Note:
After deploying the configurations, due to webMethods Integration Server restart, the assets
will appear after a short delay.

Integration Cloud Integrations can invoke Cloud Deployment webMethods Integration Server
services for the same tenant. Using the predefined Cloud Deployment Application available in
Integration Cloud, you can select the solution webMethods Integration Server services that you
want to invoke from Integration Cloud.

Creating Solutions

The Solution List page displays the solutions created in Integration Cloud.

Note:
Youmust have the required permissions under Settings  > Access Profiles > Administrative
Permissions > Functional Controls > Solution to create, update, or delete Solutions.

Note:
You must first create a solution in Integration Cloud before deploying the on-premises assets
and configurations.

All solutions created are initially copied to the Development stage. You can create a new solution
in any stage, for example, development, test, live, and prelive. Further, you cannot modify the
solution name and clustering details after it is created. You can configure the solution in subsequent
stages but after you configure a solution in a stage, you cannot modify the solution again in that
stage. In a stage, you can configure only those solutions that are marked as Not Configured.

To create a solution

1. Switch to the Cloud Deployment perspective.
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As soon as you register, Cloud Deployment capability is enabled by default for all tenants. By
default, 3 CPU core and 6 GB memory are allocated for all tenants. When you access Cloud
Deployment for the first time using the application launcher, you need to start provisioning.

After provisioning, your setup will be complete, and you can launch Cloud Deployment.

Note:
Solutions created using a trial account are deactivated daily. After you log in, you need to
reactivate the solutions. All assets will be available after a short delay.

2. After you launch Cloud Deployment, from the Cloud Deployment navigation bar, click
Solutions > Solution List.

The Solution List page appears.

3. From the Solution List page, click Create New Solution to create a solution. You can create
a solution in any stage.

4. Select the landscape model that best represents your environment. The available designs are
anwebMethods Integration Serverwith a Terracotta server, anwebMethods Integration Server
with Universal Messaging and a Terracotta server, or webMethods Integration Servers with
UniversalMessaging and a Terracotta stripe. Your packages, assets, configurations, and services
are deployed automatically onto the selected landscape.
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5. Click OK.

6. In theNew Solution page, fill in the solutionName, the solutionDescription, the name of the
webMethods Integration Server and Universal Messaging instances, number of CPU Cores,
andMemory characteristics of the hardware to support each service in the solution landscape.

Note:
You can also select the webMethods Integration Server and Universal Messaging icons to
highlight the sections in the New Solution page. Terracotta is available only when
webMethods Integration Server runs in a clusteredmode. Further, clustering and Terracotta
options are not available in the Development stage.

The Version list box lists all the available major versions. The solution will be created based
on the availableFixversion.webMethods Integration Server packages such asWmCloudStreams
andWmJDBCAdapter will appear in the Packages group box based on the Fix version. Select
the Packages you want to enable. After you save the solution, you will not be able to change
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the major Version. You can change only the number of CPU Cores, Memory, Fix version if
available, and Packages.

You can deploy CloudStreams provider packages, CloudStreams connector services,
CloudStreams connection, and CloudStreams connector listeners to a solution in Cloud
Deployment only if you have selectedWmCloudStreams as the package optionwhile creating
the solution.

On the Landscape page, select the Cluster Type as Stateless if the group of webMethods
Integration Servers function in a manner similar to a cluster but are not part of a configured
cluster. A stateless cluster of webMethods Integration Servers does not use a Terracotta Server
Array. Select Stateful to add the Terracotta section. The Terracotta icons will be activated.

TheHot Fix list box lists all available fixes that include enhancements to versions.Hot fix field
is optional. Selecting None option will remove the hotfixes applied on the solution, and the
solution will point to the base fix version. Typically, hotfixes are created for specific tenants.

Note:
After creating a solution, if you modify the package list options in the Packages group box
and save the solution, due to webMethods Integration Server restart, the assets will appear
after a short delay.

Updating products to a higher fix version in a solution

You can update any product in a solution to the available higher fix version after you create
the solution. The Update Available option appears if a higher fix version is available for any
of the products in the solution. The latest fix version appears in the Fix drop-down list. For
example, if you have selected Fix 3 ofwebMethods Integration Serverwhile creating a solution,
and if Fix 4 is now available, you can select Fix 4 and save the solution.

Note:
While configuring a solution in a higher stage, the fix version of the products in the solution
will be taken from the lower stage. If a solution is updated in a lower stage, you will be
given an option to update the solution in the higher stage, to the fix versions of the products
in the lower stage.

For example, if you configure a solution in a higher stage (Test stage) and then go back to a
lower stage (Development stage), and If a higher fix version is available for a product in the
Development stage, you can click Update Available, and in the Edit Solution screen, you can
select the higher fix version for the product in the solution. Now if you go to the higher stage
(Test), the Update Available option will appear in the Test stage. You can update products in
a solution at every stage, to the fix versions of the products in the solution available in the
immediate lower stage. Note that after you update or update the products in the solution, the
products in the solution will not be accessible for sometime.

Updating products to a higher version in a solution

You can update any product in a solution to the available higher version after you create the
solution. The Update Available option appears if a higher version is available for any of the
products in the solution. The latest version appears in theVersion drop-down list. For example,
if you have selected 10.3 of webMethods Integration Server while creating a solution, and if
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10.5 is now available, you can select version 10.5 and save the solution. Further, if you update
to v10.5, the latest available fix for v10.5 will be automatically selected.

Note:
While configuring a solution in a higher stage, the version of the products in the solution
will be taken from the lower stage.

If a higher version is available for a product in a stage, you can click Update Available, and
in the Edit Solution screen, you can select the higher version for the product in the solution.

The Schedule option appears if you select a higher version available for any of the products
in the solution. Click Schedule to schedule the update process by specifying the date and time
on which you want the update process to execute. Once the solution is scheduled for update,
you can click Cancel Schedule to cancel the schedule or click Modify Schedule to modify the
schedule. If the update process is scheduled, the status of the solution on the Solution List
page displaysUpdate scheduled. The status of the solution on the Solution List page displays
Update in progress if the scheduled update process is under way.

Note:
After a solution is updated successfully, ensure that you clickConfirm Updatewithin seven
days to complete the update process or clickRollback to rollback the solution to the previous
version. After seven days, except for theConfirm Update andRollback options, the solution
page will not be available. If you rollback, the status of the solution on the Solution List
page displays Rollback in progress until the solution is rolled back to the previous version.

7. The Tracing list box appears only if you have the App Dynamics capability and if you are
currently using AppDynamics to trace end to end business flows. It allows you to trace logs
after you create or update a solution for anwebMethods Integration Server runtime. Currently,
tracing support is provided only for the webMethods Integration Server runtime. Select
AppDynamics from the drop-down list to provide the AppDynamics tracing support and
upload a valid Controller XML and Config XML file containing the Appdynamics details. You
can update the controller file for each webMethods Integration Server runtime. You also have
the option to download the controller and config files and then upload the files aftermodifying
them.

Note:
If you select AppDynamics tracing and provide a valid controller file, the tracing data will
appear on the AppDynamics cloud application.

Let us see an example of how the tracing data appears on Appdynamics when you create a
solution in Cloud Deployment.

a. Go to https://www.appdynamics.com/ and register in AppDynamics.

b. On the Overview > Applications panel, click Get Started.
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c. On the Getting Started wizard, click Java under the Applications panel.

d. Download the Java Agent Installer.
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e. Go to the ver<xxx> > conf folder on your local system and view the controller-info.xml and
app-agent-config.xml files.

f. Open the controller-info.xml file and provide the following values:

<application-name>MyApplication</application-name

<node-name>AppIS</node-name>

g. Log in to Integration Cloud and switch to Cloud Deployment using the App switcher.

h. Create a new solution inCloudDeployment and selectAppDynamics from the drop-down
list to provide the AppDynamics tracing support. Upload the controller-info.xml and
app-agent-config.xml files, and save the solution.

i. Log in to AppDynamics. Your application, that is, MyApplication appears on the
Applications panel.

j. Click on MyApplication and view the service execution status and execution logs.
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8. Click Save to save the solution.

The new solution is created and appears in the Solution List page. You cannot modify the
solution after the solution is created. You can configure the solution in subsequent stages but
once a solution is configured in a stage, you cannot modify the solution again in that stage.

Note:
You can now deploy the solution to the next stage.

Deactivate, Activate, and Delete a solution

Click the icon and select Deactivate to deactivate a solution. All packages and assets will

be permanently deleted and cannot be recovered. Click the icon and select Activate to
activate an inactive solution.

Click the icon and selectDelete to permanently delete the solution. If a solution is configured
in a subsequent stage, it will be permanently deleted from the current stage and cannot be
recovered. Further, if you delete the solution, you will not be able to promote assets from the
current stage.
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Exploring Solutions
The solution details page allows you to view the packages, assets, configurations and services for
different runtimes in the solution, deploy the solution to another stage, view the Asset Repository,
and manage the solution, that is, view the landscape, configure webMethods Integration Server
service access settings, administer the webMethods Integration Server, or restart the webMethods
Integration Server instances.

Note:
You can create a new solution in any stage. You can configure the solution in subsequent stages
but after you configure the solution in a stage, you cannot modify it again in that stage.

To view the Solution Explorer

1. Switch to the Cloud Deployment perspective.

2. From the Cloud Deployment navigation bar, click Solutions > Solution List.

The Solution List page appears listing all the solutions.

3. Click on an existing solution. The Solution Explorer page appears.

Solution Explorer
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The following table provides a high-level overview of the Solution Explorer page:

DescriptionComponent

View the Packages, Folders, Assets, and Services for
webMethods Integration Server, Adapters, webMethods

“Assets” on page 747

CloudStreams packages, and configurations for the
Universal Messaging runtime.

Deploy the solution to another stage.“Deploy” on page 757

View the Asset Repository which displays the contents
of the on-premises packages published to Integration
Cloud.

“Asset Repository” on page 756

View the landscape, configure webMethods Integration
Server service access settings, administer thewebMethods

“Manage” on page 762

Integration Server, or restart thewebMethods Integration
Server instances.

Assets

Apackage is a container that is used to bundle services and related elements, such as specifications,
webMethods Integration Server document types, webMethods Integration Server schemas, and
triggers. When you create a folder, service, webMethods Integration Server document type, or
any element, you save it in a package.
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Note:
To view and access webMethods Integration Server packages in Integration Cloud, you must
assign any custom user groups created in webMethods Integration Server, which are assigned
to Access Profiles in the Solution Permissions page, to the following Access Control Lists in
webMethods Integration Server:

Administrators ACL
Developers ACL
Replicators ACL

The following figure depicts the package structure in a solution.

Packages are designed to hold all of the components of a logical unit in an integration solution.
For example, you might group all the services and files specific to a particular marketplace in a
single package. All the components that belong to a package reside in the package’s subdirectory.

Note:
Click the arrow beside a folder or package to view its contents.

Downloading assets

You can download user deployed packages and configurations from theAsset page. To download

assets, point to an asset, click the ellipses icon, and then click Download. The assets will be
zipped and downloaded to your local storage space.

Note:
You cannot downloaddefault packages such as packages that comewithwebMethods Integration
Server installation, for example, Default, WmART, WmCloud, WmJDBCAdapter, WmPublic,
and so on.
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Services

Services are method-like units of logic that operate on documents. You build services to carry out
work such as extracting data from documents, interacting with back-end resources (for example,
submitting a query to a database or executing a transaction on a mainframe computer), and
publishing documents. Adapters and other add-on packages provide additional services that you
use to interact with specific resources or applications. The service editor allows you to view and
run the services.

Service Signature

Input and output parameters are the names and types of fields that the service requires as input
and generates as output. These parameters are also collectively referred to as a signature. You
declare a signature for all types of services: flow services, Java services, and services written in
other supported programming languages.

For a flow service, the input side describes the initial contents of the pipeline. In other words, it
specifies the variables that this flow service expects to find in the pipeline at run time. The output
side identifies the variables produced by the flow service and returned to the pipeline. An
webMethods Integration Server document type can also be used to define the input or output
parameters for a service.

Click Test to run the service after providing the data to pass into the service.

Service Editor

Use the service editor to view the services. The source code, properties, inputs, and outputs are
read only. The editor has the following tabs:

Source tab contains the code or flow for the service.

Input/Output tab contains the input and output signature of the service.

Logged Fields tab indicates the input and output parameters for which the data is logged.
You define the data to pass into the service by defining the input parameters on the lower
panel of the editor.

Load pipeline for testing services
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The pipeline is the general term used to refer to the data structure in which input and output
values are maintained for a service in Software AG Designer. The pipeline holds the input and
output for a service. The pipeline startswith the input to the service and collects inputs and outputs
from subsequent services.When a service runs, it has access to all data in the pipeline at that point.

When you run a service in Software AG Designer, you can click Save and save the pipeline data
as an XML document to your local file system. After you deploy the service, you can click the
Load Data option in the service editor to select the XML file, and load or update the pipeline data
to test the service.

Note:
Integration Cloud Integrations can now invoke Cloud Deployment webMethods Integration
Server services for the same tenant. A new pre-defined Application, Cloud Deployment, is
added in Integration Cloud. Using this Application, you can select the solution webMethods
Integration Server services that you want to call from Integration Cloud.

Note:
See thewebMethods Service Development Help,webMethods Integration Server Administrator’s Guide,
and the webMethods Adapter for JDBC Installation and User’s Guide for detailed descriptions of all
the services and document types including Adapter services.

Displaying the API details of an executable service

After deploying assets, on the Asset explorer page, click the API Details option to view the API
details of the service such as the HTTPMethod, URL, Input structure, and the parameters that are
required to invoke this service from an external system, for example, a REST client. You can copy
the required API details to execute the service from the external system.

TheAPI Details option appears only for executable services. Some examples of executable services
are Adapter services, Flow services, Java services, Flat File Schema, and Map services.

You will be able to execute a Flat File Schema by using only the SoapUI tool. You must specify the
following settings in the SoapUI tool:

Set the following query parameters in the Request section:

skipWhiteSpace = true

encoding = UTF8

file = file:file1

In theAttachments section, browse for the source file and update the following column values:

Name = file1

ContentID = file
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Support for GraphQL Assets

Overview

GraphQL is a query language designed to build client applications by providing a flexible syntax
and system for describing their data requirements and interactions. Using GraphQL service, you
query a specific data to the server and get the response in a predictable way.

You candeployGraphQLassets,which are developedusing SoftwareAGDesigner and on-premises
webMethods Integration Server, to Cloud Deployment. You choose from predefined solution
landscapes to deploy your on-premises assets from Software AG Designer.

Let us see an example of how we deploy GraphQL assets which are developed using Software
AG Designer and on-premises webMethods Integration Server to Cloud Deployment.

Preconditions

Create a GraphQL Schema

Create a GraphQL schema using SDL (Schema Definition Language). A sample schema is shown
below:
type Query {
dog: Dog
findDog(complex: ComplexInput): Dog
booleanList(booleanListArg: [Boolean!]): Boolean
arguments: Arguments
human: Human
pet: Pet
name: String!
Name: String!
catOrDog: CatOrDog

}
enum DogCommand { SIT, DOWN, HEEL }
type Dog implements Pet {
name: String!
nickname: String
barkVolume: Int
doesKnowCommand(dogCommand: DogCommand!): Boolean!
isHousetrained(atOtherHomes: Boolean): Boolean!
owner: Human

}
interface Sentient {
name: String!

}

Implementing GraphQL Descriptor in Integration Server and Designer

You use the Service Development perspective to create a new GraphQL descriptor based on the
schema.

In the Designer perspective, select File > New > GraphQL Descriptor.
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In the New GraphQL Descriptor dialog box, select the folder in which you want to create the
GraphQL descriptor.

In the Element name field, type a name for the GraphQL descriptor using any combination
of letters, numbers, and/or the underscore character.

Click Next.

In the Select the GraphQL Schema Location wizard, browse and select the schema file.

Note:
Ensure that the format of the schema file is .txt, .json, .graphql, or .graphqls.

Click Finish.

Designer creates the GraphQL descriptor and displays the details in the GraphQL descriptor
editor.

Build Resolver Services for the GraphQL Descriptor

Integration Server creates the following assets when you import a GraphQL schema:

A GraphQL descriptor with the name as provided by the user.

When you create a GraphQL descriptor using the above GraphQL schema with name Gq, then
Designer creates folders with name types and resolvers under Gq folder like this:

All the document types are created under the types folder and all the resolver services are created
under the resolvers folder.

If you import the above schema in Integration Serverwith nameGq, then Integration Server creates
the resolver services for Query operation under Gq_/resolvers/Query folder, and the resolver
services for Mutation operation under Gq_/resolvers/Mutation folder.
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The resolver will have the input/output signature set.

Deploy Assets to Cloud Deployment

Using Designer, you deploy your on-premises Integration Server GraphQL packages and assets
to CloudDeployment. Before deploying the packages and assets, youmust configure a connection
to Integration Cloud.

Before you configure a connection to Integration Cloud, ensure that the following criteria are met:

A valid URL exists to connect to Integration Cloud.

A valid user account is created on Integration Cloud.

To add a connection configuration for Integration Cloud

In Designer, select Window > Preferences.

In the preferences navigation tree, select Software AG >Integration Cloud.

Click Add.

In the Add connection configuration dialog box, enter the following information:

DescriptionField

The name to use for the Cloud Deployment connection
configuration.

Name

Note:
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DescriptionField

The name cannot contain control characters, special
characters, and characters outside of the basic ASCII
character set, such as multi-byte characters.

URL of the Cloud Deployment host to which Designer is
to connect. For example,
https://<sub-domain>.<domain-name>.<domain-suffix>.

URL

The user name for an account on Cloud Deployment.User

The password for the specified User.Password

Indicates whether the password for the specified user
account should be saved in Eclipse secure storage. Cloud

Save password (in the Eclipse
secure storage)

Deployment uses this password from the Eclipse secure
storage whenever user authorization is required. If you
want to save the password in Eclipse secure storage, select
this check box.

A connection configuration is now added to the Connections page with the specified details.

To deploy assets to Cloud Deployment

1. In Package Navigator view, select the Integration Server package that you want to deploy to
Cloud Deployment.

2. Right-click the GraphQl package and click Deploy to Cloud.

Verify the Deployed Assets in Cloud Deployment

After publishing theGraphQLpackages to an asset repository provisioned for the tenant onCloud
Deployment, you can view and access the webMethods Integration Server packages in Cloud
Deployment. The solution details page allows you to view the packages, assets, and services for
GraphQL runtimes in the solution.

To view the GraphQl packages in the Solution Explorer:

1. Switch to the Cloud Deployment perspective.

2. From the Cloud Deployment navigation bar, click Solutions > Solution List.

3. Click on an existing solution. The Solution Explorer page appears.
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The Solution List page appears listing GraphQL solutions.

Displaying the API details of an executable service

After deploying assets, on the Asset explorer page, click the ellipses icon to view theAPI details
of the service such as the HTTPMethod and URL that are required to invoke this service from an
external system. You copy the required API details to execute the service from the external client.

Service Execution from External Client

To execute the service from a third party tool, let us use Postman as the GraphQL client. So in this
example, when we open the GraphQL client, and invoke the URL as shown below, we get the

Integration Cloud 6.6.0 755

20 Switch to Cloud Deployment



output as per the fields passed in the query.

Asset Repository

The Asset Repository page (Cloud Deployment > Solutions > Asset Repository) displays the
list of all solutions and the user-created assets. You can also view the asset type, version of the
assets, and services. Before deploying packages and configurations from Software AG Designer,
you must create a solution in Integration Cloud to which you want to deploy the configuration
assets. Software AG Designer deploys the assets and configurations to the Asset Repository in
Integration Cloud.

Asset Repository for all solutions

The following figure depicts the Asset Repository structure for all solutions.

Asset Repository for a selected solution
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The Asset Repository page for a solution (Cloud Deployment > Solutions > Select a Solution
> Asset Repository) displays the assets for the selected solution, including the asset type and
version of the assets.

The following figure depicts the Asset Repository structure for a selected solution.

Downloading packages and assets

You can download user deployed packages and configurations from the Asset Repository page.
You can either download individual packages or the whole repository for each product. To

download assets, point to an asset or product and click the icon. The assets including ACDL
files will be zipped and downloaded to your local storage.

Deploy

After publishing the assets and configurations that reside within on-premises runtimes or
repositories to webMethods Integration Cloud, you can promote them from the previous stage to
the current stage. Within a tenant, you can promote assets from a solution to another solution,
from a previous stage to the current stage, for the same runtime type. You can promote assets if
the source runtime version is lesser than or same as the target runtime version.

If you are in the Development stage, click the Change Stage To View link to change the stage.
Only active and accessible stages appear in the drop-down list for selection in the Stage to view
field. Select a different stage other than Development and click Submit.

In the next stage, select a solution and then click Deploy. Select a runtime instance. All solutions
of the previous stage will be listed on the left panel. The right panel will list all the assets of the
selected solution in the current stage for the selected runtime instance.

Note:
Youwill not be able to promote assets from a higher version solution to a lower version solution.
For example, if you have a v10.4 solution in the source stage and a v10.3 solution in the current
stage, you will not be able to promote the v10.4 assets to the current stage.
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Note:
You can access a stage only if your Access Profile is assigned to the stage.

Click on a solution and select the runtime package folder. Then click on the runtime instance. The
assets of the solution corresponding to the selected runtime instance will appear. Select the assets
and then click Promote to promote the assets to the current stage (right panel).

After you click Promote, the Promote Assets dialog box appears for the selected asset.

Select an asset and change the values for the variable substitution properties, if needed. The variable
substitution properties appear for the selected asset, only if the asset has properties. If there are
any similar type of assets for which youwant the same values, then select the Show similar assets
to apply values option. Then select the assets in the lower panel. ClickApply to apply the property
values to the selected assets. The changed values will be applied to all the selected similar assets
during promotion.

On the Promote dialog box, you can type a message to describe the promotion. The promotion
message will appear on the History page.

Click Simulate Promote to check the consistency of the assets and their dependencies. If there
are dependencies, then for a successful promotion, you have to select all the dependent assets.
Select Save and Promote to save the variable substitution and promote the assets to the next
stage.

On the Deploy page, click Rollback to rollback all promoted assets to their previous state.

You can type a message to describe the rollback. The rollback message will appear on the History
page.

Deleting assets

On the Deploy page, you can delete an asset from the current stage (right panel). The asset will
be deleted from the asset repository in that stage as well as from the runtime.

Note:
Currently you can delete only webMethods Integration Server packages and not webMethods
Integration Server and Universal Messaging configurations.
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History

The History page shows the Trace ID, that is, the tracking ID, which is automatically generated
on every successful or unsuccessful promotion, rollback, or deletion, the Deployment, Rollback,
or Deletion Action, Date when the asset was promoted, rolled back, or deleted, the User who
promoted, rolled back, or deleted the asset, and the commit Message for the selected instance.
You can click on a Trace ID to see the Track History for the specific action.

The Track History window displays the following details:

Timestamp - The date and time when the log was generated.

Product - The product that was promoted or rolled back.

Log Level - Information on whether the log type is an Error, Info, or Debug.

Message - Log or status message.

Note:
Promotion, rollback, or deletion details appear only for the current stage.

Capability

The Capability ( > Licensing) page allows you to view the status of some of the system
capabilities, based on your license offering.
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You can view the details of the following capabilities in Integration Cloud:

DescriptionField

Total number ofApplications that can be utilized by the tenant.Allowed application
count

If Yes, then on-premises applications can be uploaded from
on-premises systems.

On-premises
connection

Maximum number of active users allowed for the tenant.Max allowed users

Maximum number of staging environments allowed for the
tenant.

Allowed number of
stages

Integrations can be restarted and resumed.Integration restart
and resume

Integrations can be imported and exported.Integration import
and export

If Yes, then the account is a trial account.Trial account

The trial period end date. This field appears only if the account
is a trial account.

Trial end date

You can view the details of the following capabilities in Cloud Deployment:

DescriptionField

Maximum number of CPU cores allowed across all active
solutions and all stages for the tenant. You will not be able to
create additional solutions if you exceed this capability.

Max allowed cores

Maximummemory capacity allowed across all active solutions
and all stages for the tenant. You will not be able to create
additional solutions if you exceed this capability.

Max allowed memory

Maximum number of staging environments allowed for the
tenant.

Allowed number of
stages

If Yes, then the account is a trial account.Trial account

The trial period end date. This field appears only if the account
is a trial account.

Trial end date

Usage

The Usage page allows you to view the current usage of CPU cores and Memory (GB) for all the
active solutions in all the stages.
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To access this page, from the Cloud Deployment navigation bar, click and select Licensing >
Usage.

Copying Solutions

The Solution List page allows you to copy solutions in any stage. Copying solutions allows you
to have a back up of your solution before you make any changes and deploy your solution to
production. This reduces the risk of not having a back up in case youwant to revert to the original
solution.

Note:
If you have the required permission under Settings  > Access Profiles > Administrative
Permissions > Functional Controls > Solution, you can copy, update, and delete solutions.

To copy a solution

1. Switch to the Cloud Deployment perspective.

2. From the Cloud Deployment navigation bar, click Solutions > Solution List.

The Solution List page appears.

3. On a solution, click > Create a copy.

4. On the Create a copy page, fill in the new solution Name.

You can choose to copy solutions using the same configuration and services in the solution
landscape by clicking the Create with original configuration option or modify the

Integration Cloud 6.6.0 761

20 Switch to Cloud Deployment



configuration and services in the solution landscape by clicking the Create with modified
configuration option.

5. SelectCreate with modified configuration and specify additional configuration of the solution,
if necessary. Then click Configure to save the configuration details.

The new solution is created and appears on the Solution List page.

Note:
You can now deploy the new solution to the next stage.

Deactivate, Activate, and Delete a solution

Click the icon and select Deactivate to deactivate a solution. All packages and assets will
be permanently deleted and cannot be recovered. SelectActivate to activate an inactive solution.
Select Delete to permanently delete a solution.

Managing Solutions

TheManage options allow you to view the solution landscape, configurewebMethods Integration
Server service access settings, administer the webMethods Integration Server, or restart the
webMethods Integration Server instances.

Landscape

The Landscape page displays the landscape configuration for the selected solution.

Note:
You cannot modify the solution landscape configuration in the Development stage after the
solution is created. You can configure the solution in subsequent stages but after a solution is
configured, the solution cannot bemodified again in that stage. Further, clustering andTerracotta
options are not available in the Development stage.
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Note:
In a stage, you can configure only those solutions that are marked as Not Configured.

To view the landscape configuration for a solution

1. Switch to the Cloud Deployment perspective.

2. From theCloudDeployment navigation bar, click Solutions > Solution List > Select a solution
> Manage > Landscape.

3. On the Landscape page, you can view the landscape configuration design, landscape solution
name and description, and the landscape components. For each landscape component, you
can view the landscape component name, product type, whether the landscape component is
in a ready state, and the number of CPU cores and memory characteristics of the hardware to
support each service in the solution.

4. Terracotta is available only when webMethods Integration Server runs in a clustered mode.
Further, clustering and Terracotta options are not available in the Development stage.

On the Landscape page, select the Cluster Type as Stateless if the group of webMethods
Integration Servers function in a manner similar to a cluster but are not part of a configured
cluster. A stateless cluster of webMethods Integration Servers does not use a Terracotta Server
Array. Select Stateful to add the Terracotta section. The Terracotta icons will be activated.

Service Access Settings

The Service Access Settings page allows you to configure the webMethods Integration Server
services to be called externally over HTTPS. The services will be available to consumers based on
the Allow All and Deny All access modes.

To configure service access settings

1. Switch to the Cloud Deployment perspective.
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2. From theCloudDeployment navigation bar, click Solutions > Solution List > Select a solution
> Manage > Service Access Settings.

3. On the Service Access Settings page, configure the webMethods Integration Server services
to be called externally over HTTPS. Required fields are marked with an asterisk on the screen.

DescriptionField

The base URL is a part of the complete service URL, for
example,

Base URL

https://wmic1.saglive.com/integration/

clouddeployment/service/

development/test/tt54/invoke/pub.*

An alias for the solution in the base URL. The alias name
for a solution is unique in that particular stage. For

Solution Alias

example, if the completed service URL is
https://wmic1.saglive.com/

integration/clouddeployment/service/development/

test/tt54/invoke/pub.*

then the Solution Alias is test, the webMethods
Integration Server instance is tt54, and the service URL
is /invoke/pub.*.

Select the solution webMethods Integration Server
instance where the services need to be configured.

Select Integration Server

Ensure that the access mode of the services are properly
set.

Access Mode

Select Deny All if you want to deny most of the services
to be invoked and allow a few. Then click ADD to add
services to the Allowed Services table. In the Add
Service window, the Base URL is a part of the complete
service URL. In the Service URL field, type the
webMethods Integration Server Service URL. The Base
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DescriptionField

URL and the Service URL together forms the complete
service URL.

SelectAllow All if youwant to allowmost of the services
to be invoked and deny a few. ClickADD to add services
to the Denied Services table. In the Add Service
window, the Base URL is a part of the complete service
URL. In the Service URL field, type the webMethods
Integration Server Service URL. The Base URL and the
Service URL together forms the complete service URL.

Note:
You can update the service URL by clicking the Edit
icon beside the service URL in the services table.

The services will be available to be invoked from a
software application, for example, a REST client, after
you add the services to the table.

For example, the Service URL /invoke/pub.math:addInts
has the following components:

Directive - Invoke

Namespace of the service - pub.math:addInts

Note:
You can match all services to be allowed or denied by
typing * at the end of the Service URL. For example,
if you have two services, service url1:
/invoke/pub.date:formatDate and service url2:
/invoke/pub.date:getCurrentDate /invoke/, then
instead of typing two entries, you can provide only
one entry, service url: /invoke/pub.date.*. All services
matching pub.date will be allowed or denied.

Administration

Use this page to manage a solution webMethods Integration Server Administrator instance.

ThewebMethods Integration ServerAdministrator is anHTML-based utility you use to administer
thewebMethods Integration Server. It allows you tomonitor server activity, manage user accounts,
make performance adjustments, and set operating parameters. You can run the webMethods
Integration Server from any browser-equipped workstation on your network. When you click
Administration, your browser displays the Statistics screen.
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The Title bar displays the name of the host machine where webMethods Integration Server is
running, the name of the webMethods Integration Server instance, and the name of the user
currently logged into the webMethods Integration Server instance .

The Navigation panel on the left side of the page displays the names of menus from which you
can select a task. To start a task, click a subject in theNavigation panel. The server displays a screen
that corresponds to the task you select.

Note:
Click Help to view the Help system, which provides information about the features and
functionality of webMethods Integration Server.

To view the Administration page

1. Switch to the Cloud Deployment perspective.

2. From theCloudDeployment navigation bar, click Solutions > Solution List > Select a solution
> Manage > Administration.

The webMethods Integration Server Administrator page appears.

Restart

Restart the server when you need to stop and reload the server. You should restart the server
when:
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You make certain configuration changes. Some configuration changes require the server to be
restarted before they take effect.

If you encounter an operational problem or the server is in an inconsistent state.

To restart the server

1. Switch to the Cloud Deployment perspective.

2. From theCloudDeployment navigation bar, click Solutions > Solution List > Select a solution
> Manage > Restart.

Note:
webMethods Integration Servers running in a clustered mode cannot be restarted. Further,
restarting servers will terminate all active sessions.

3. Click Restart.

Monitoring Solutions

The Monitoring part of Cloud Deployment enables you to monitor the health and availability of
the solutions and run-time instances, alerts and alert statuses. You receive an email whenever
there is a condition that might affect the solution.

Themonitoring of a new solution starts automatically 10minutes after the creation of the solution.
The data of the solution is collected and analyzed every 60 seconds.

You can access the monitoring pages from the left-side navigation menu of the Monitoring main
page.

You can filter the information onmostMonitoring pages based on time. To specify the time-range,
select a value in the time-range selector.

The following table describes the options in the time-range selector.

DescriptionOption

Displays the information for the last 12 hours.12h

Default. Displays the information for the last 24 hours.24h
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DescriptionOption

Displays the information for the last 2 days.2d

Displays the information for the last week.1w

Displays the information for the last 2 weeks.2w

Displays the information for the last 3 weeks.3w

Displays the information for the last 4 weeks.4w

To navigate to the Monitoring main page, log in to Integration Cloud, switch to the Cloud
Deployment perspective, and select Monitoring in the Cloud Deployment navigation bar.

Dashboard

On the Dashboard page, you can view:

The health of the solutions

The number of the alerts that have been raised for all the solutions

The landscape view of the solutions, and the number of alerts for all run-times that are part
of the solutions

The following table provides more information about the panes on the Dashboard page.

DescriptionPane

Shows the following information about the health of the solutions
for the selected time range:

Overall KPI Status

Total number of solutions

The number of healthy solutions

The number of unhealthy solutions

The health of the solutions, as a percentage value calculated
by the formula (Number of healthy solutions / total number
of solutions) * 100

A healthy solution is a solution without any open critical alerts.

An unhealthy solution is a solution which has at least one open
critical alert.

To see more information about the KPI status of the solutions,
click More Details.
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DescriptionPane

Shows the total number of open and resolved alerts that have
been raised for all solutions for the selected time-range, and the
number of alerts from each type: critical, warning, or information.

Alerts

To see more details about the alerts, click More Details.

For more information about the alert types, see “Alert Types” on
page 776.

Displays the topology of the solutions and the number of alerts
for each run-time type since the solution has been activated.

Landscapes

TheUpdate in progress link indicates that the solution is under
maintenance. ClickUpdate in progress to seemore details about
the update.

By default, the page displays information for the last 24 hours. To view the information for a
different time period, use the time-range selector. For more information about the time-range
selector, see “Monitoring Solutions” on page 767.

Solutions
On the Solutions page, you can check the health of the run-time instances from all the solutions.
For each run-time instance, you can view the current data, and the data for the last 24 hours.

The health metrics are grouped into three categories:

Memory - indicate the memory utilization of a run-time.

Uptime - indicate the availability of a run-time.

Failures- indicate failures of the run-time

The following table describes the icons on the Solutions page.

DescriptionIcon

Normal health of the run-time instance.

The health of the run-time instance is deteriorating. Take preventive
measures.

There are critical issues with the health oh the run-time instance. Your
urgent attention is needed.

The run-time instance is not available.
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Note:
If the solution uses an Integration Server cluster, the number of Integration Server instances is
indicated in brackets after the Integration Server instance name.

During a solution update, the Solutions page does not display status icons for the run-time instances
from the solution. To view more details about the solution update, click Update in progress.

To viewmore details about a run-time instance on theRuntime page, click the name of the run-time
instance.

Runtimes
On the Runtimes page, you can view the graphs for monitored KPIs for the selected run-time
instances from all the solutions.

The example image shows the graph for the Used Memory KPI. The horizontal lines below the
graph represent the severity and duration of the alerts thatwere raised for the KPI. The information
alerts are displayed in blue, the warning alerts are in orange, and the critical alerts are in red.

The following table describes the meaning of the alert lines from the example graph for the Used
Memory KPI.

DetailsTime Period

Until 2:05 h, there had been an open information alert.1
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DetailsTime Period

At 2:05 h, the severity of the information alert was changed
to warning.

2

An information alert existed during that period.3

A warning alert existed during that period.4

You can change the value in the Solutions drop-down field to load the information about the
run-time instances from a specific solution.

You can use the Integration Server, Universal Messaging, and Terracotta tabs to view the
information related to the selected solution and runtime.

By default, the page displays information for the last 24 hours. To view the information for a
different time period, use the time-range selector. For more information about the time-range
selector, see “Monitoring Solutions” on page 767.

The following table describes the monitored Integration Server KPIs.

DescriptionName

The total used memory for the Java VM.Used Memory

The number of active service threads.Service Threads

The number of active licensed sessions.Sessions

The number of the current stateful HTTP sessions.Stateful Sessions

The following table describes the monitored Universal Messaging KPIs.

DescriptionName

The amount of free memory that the Realm Server has
within the JavaVM. This indicates the difference between

Free Memory

what the Java VM has currently allocated and what the
Realm Server has used.

Total number of events published on this realm from the
time it started.

Published Events

Total number of events that this realm has sent to clients
from the time it started.

Subscribed Events

The following table describes the monitored Terracotta KPIs.
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DescriptionName

Shows the amount of off-heap memory that is currently
used.

Off-Heap Used Memory

Shows the total number of live objects in the cluster,
mirror group, server, or clients. If the trend for the total

Live Objects

number of live objects goes up continuously, clients in
the cluster will eventually run out of memory and
applications might fail. Upward trends indicate a
problem with application logic, garbage collection, or
the tuning of one or more clients.

Viewing Adapter KPIs

On the Runtimes page, you can view the KPIs for the adapters that are installed on the Integration
Server instances.

1. Navigate to the Runtimes page.

2. Select a solution.

3. On the Integration Server tab, select an Integration Server instance.

4. Click Connectivity KPIs.

5. On the Adapters tab, select an Adapter.

The Adapter KPIs are displayed.

The following table describes the monitored Adapter KPIs:

DescriptionName

The number of connection pools in the adapter and how
many of them are currently enabled.

Connections

The number of adapter notifications (polling
notifications) and how many of them are currently
enabled.

Notifications

Note:
You can view Adapter KPIs only for the current time.

Viewing Connector KPIs

On theRuntimespage, you can view theKPIs for the connectors that are installed on the Integration
Server instances.
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1. Navigate to the Runtimes page.

2. Select a solution.

3. On the Integration Server tab, select an Integration Server instance.

4. Click Connectivity KPIs.

5. Click the Connectors tab.

6. Select a provider.

7. Select a connector.

The Connector KPIs are displayed.

The following table describes the monitored Connector KPIs:

DescriptionName

The number of connection pools in the connector and
how many of them are currently enabled.

Connections

The number of connector listeners and how many of
them are currently enabled.

Listeners

Note:
You can view Connector KPIs only for the current time.

Services
On the Services page, you can view the number of successful and failed service executions of the
Integration Server instances from the solutions.

The Services page consists of the Service Executions pane and the History pane.

DescriptionPane

Shows the following information about the service executions of
the Integration Server instances for the selected time range:

Service Executions

Total number of service executions

The number of successful service executions

The number of failed service executions
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DescriptionPane

The successful service execution, as a percentage value
calculated by the formula (Number of successful service
executions / total number of service executions) * 100

Shows a chart with the history of successful (green) and failed
(red) service executions.

History

Hovering over the green and red bars displays the total number
of successful and failed service executions, correspondingly.

The numbers of service executions on the Services page includes the public and internal services
of the Integration Server instance and their child services.

You can change the value in the Solutions drop-downfield to view the information about a specific
solution, or the information for all solutions.

By default, the page displays information for the last 24 hours. To view the information for a
different time period, use the time-range selector. For more information about the time-range
selector, see “Monitoring Solutions” on page 767.

Uptime

On theUptime page, you can view time lines that represent the availability of all run-time instances
of the solutions.

The color of the time lines changes based on the status of the run-time instances.

The following table describes the meaning of the different colors.

Indicates thatTime line color

the run-time instance was available during the indicated time
period.

green

the run-time instance was unavailable during the indicated time
period.

red

the run-time instance did not exist during the indicated time
period.

grey

at least one node from the cluster is unavailable.blue

a solution update is in progress (under maintenance).yellow

Note:
If the solution uses an Integration Server cluster, the number of Integration Server instances is
indicated in brackets after the Integration Server instance name.
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By default, the time line displays the availability of the instances during the last 24 hours. To view
the information for a different time period, use the time-range selector. For more information
about the time-range selector, see “Monitoring Solutions” on page 767.

Alerts
The alert is a notification that a rule is violated.

On the Alerts page you can:

View the number of critical, warning, and information alerts for all the solutions for the selected
time range

Filter the alerts by solution, runtime, severity, and status

Configure the rules by adjusting the alert threshold values

Configure the summary of the alerts

Configure the recipient email for the alerts. Formore information about configuring the alerts,
see “Configuring the Alerts” on page 777.

By default, the Alerts page displays the number of alerts (critical, warning, and information) for
all the solutions, and detailed information about the alerts in a tabular format.

Note:
If the duration of the rule violation is less than the time interval at which the rule is evaluated,
the alert does not appear on the Alerts page. For more information about the interval, see
“Configuring the Alerts” on page 777.

If you deactivate a solution, the Alerts page will not display the alerts for the solution.

If you activate a solution, the Alerts page will display both the historical alerts for the solutions
that had been raised before the deactivation of the solution, and the alerts that were raised after
the activation of the solution.

When a solution update starts, the existing active alerts for the solution are set to resolved. During
the update period, no alerts are generated for the solution. You can disregard any email alerts that
you receive during the upgrade period.

The following table describes the information that is displayed in the table on the Alerts page.

DescriptionColumn

Name of the solution.Solution

Run-time type.Runtime

Integration Server

Universal Messaging

Terracotta

Integration Cloud 6.6.0 775

20 Switch to Cloud Deployment



DescriptionColumn

Name of the run-time instance.Instance

Date and time when the alert was raised.Start Date

Date and time when the alert was resolved. The field is
empty if the alert is still active.

Resolved On

Description of the alert.Message

Status of the alert.Status

The alert is inactive.

The alert is active.

Note:
The Alerts page might not display the alerts for all nodes from a cluster. For example, if you
monitor an Integration Server cluster with two Integration Server instances, and both instances
have alerts for the same property with different severity, the Alerts page will show the alert of
lower severity only, as explained in the following table.

Visibility on the Alerts pageAlert typeIntegration Server instance

YesInformation. Free memory is
low.

Integration Server instance 1

NoWarning. Free memory is low.Integration Server instance 2

You can view all alerts for all the nodes from the cluster in the email alerts.

By default, the page displays information for the last 24 hours. To view the information for a
different time period, use the time-range selector. For more information about the time-range
selector, see “Monitoring Solutions” on page 767.

Alert Types

The following table provides more information about the alert types.

Note:
Warning alerts and information alerts are not available for KPIs that monitor the availability of
a run-time instance.

Color CodingDescriptionAlert Severity

redA condition exists that is critical for the system performance.Critical
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Color CodingDescriptionAlert Severity

orangeA condition exists that might deteriorate the system performance.Warning

blueA condition exists thatmight evolve into awarning or critical alert.Information

Configuring the Alerts

You can change the default threshold values and the recipient email for the system alerts. Threshold
values determine when a rule is violated and when the system raises an alert.

To configure the system alerts

1. Navigate to the Alerts page.

2. Select the CONFIGURATION tab.

The Configuration page shows information about the alerts for all solutions. The following
table describes the columns in the form.

DescriptionColumn

Alert Name.Name

Integration Server, Universal Messaging, or Terracotta.Runtime

The icon activates the configuration view for the alert.Action

3. Click the Edit this rule icon in the Action column for the alert that you want to configure.

A formwith the configuration details for the alert rule is displayed. The following table describes
the fields in the form.

DescriptionField

The KPI's boundary values. When the value of the KPI is
outside the range that is specified by these boundary values,
the alert is raised.

Threshold

You can configure the threshold values of critical alerts by
adjusting the ends of the red line.

You can configure the threshold values of warning alerts by
adjusting the ends of the orange line.

You can configure the threshold values of information alerts
by adjusting the ends of the blue line.
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DescriptionField

Note:
The Threshold field is read-only for KPIs that monitor the
availability of a runtime instance.

Integration Server, Universal Messaging, or Terracotta.Runtime

Summary of the alert.Summary

The scrape interval. The scrape interval is the frequency at
which the system collects the data. The scrape interval is 60
seconds for all rules. Read-only.

Interval

Note:
The alert does not appear immediately when the
corresponding rule violation occurs.

The time delay from the actual time of the rule violation to
the system alert is the following:

up to 70 seconds for run-time availability rules of critical
severity
up to 420 seconds for run-time availability rules of
information severity
up to 180 seconds for the rest of the rules

The system will not send an alert if the rule violation
condition is resolvedduring the correspondingdelay period.

Email of the user who will receive the alerts.Email on alert

Note:
The email is used for all rules. In case there are alerts, the
system sends emails once every 10minutes. The email alerts
always display UTC time.

To configure more than one email, use comma-separated
values.

4. In the Threshold field, change the default threshold value(s) for the alert.

5. In the Email on Alert field, type the email(s) of the user(s) who will receive the email alerts
for all rules.

Note:
The email(s) are stored in the local alertManager.yaml file. When you delete a tenant, the
related information is deleted automatically.

6. Click Apply.
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Alert Actions

You can take actions and resolve the problems with the solutions that caused the alerts. The
following table relates the alert with the probable cause of the problem, and the recommended
actions that you can take to resolve the problem.

Action to Resolve the
Alert

Probable CauseAlert Name

Allocate more memory
to the solution.

The memory usage is
reaching the
configured
thresholds.

ISFreeMemoryLow

If the memory usage
is continuously
reaching 95% and
above, and you do
not observe any flaw
in your application,
then probably there is
another
memory-intensive
application.

Try one of the following:The solution uses too
many sessions and

ISRuntimeSessionUsageHigh

Stop some
unnecessary services,
if any

there might not be
free sessions for new
requests.

Increase the
maximumnumber of
active licensed
sessions

Move some of the
workload to another
solution

Move some of the
workload to another
solution.

The number of the
current statefulHTTP
sessions is high.
There might not be

ISRuntimeStatefulSessionUsageHigh

enough bandwidth
for new sessions.

Try one of the following:Integration Server is
down.

ISRuntimeUnavailable

If the Integration
Server went down
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Action to Resolve the
Alert

Probable CauseAlert Name

because of a high
workload, create an
Integration Server
cluster.

If the Integration
Server went down
because of
insufficient memory
and you also get a
memory alert,
allocate more
memory for
Integration Server.

Stop adding data or
delete some data from
the heap-off memory.

Theheap-offmemory
has reached the
threshold because of
toomuch stored data.

TCOffHeapMemoryLow

Restart the Terracotta
server. For greater safety

The Terracotta server
went down, or there

TCRuntimeUnavailable

and security, start withwas a humanmistake
the server that was shut
down last.

(for example,
somebody shut down
the Terracotta server).

Restart the Universal
Messaging server. If the

The Universal
Messaging server is
down.

UMRuntimeUnavailable

problempersists, contact
the Software AG Global
Support.

Increase the memory
allocated to Universal
Messaging.

The memory usage is
reaching the
configured
thresholds.

UMFreeMemoryLow

If the memory usage
is continuously
reaching 95% and
above, and you do
not observe any flaw
in your application,
then probably there is
another
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Action to Resolve the
Alert

Probable CauseAlert Name

memory-intensive
application.

Logs

On the Logs page, you can view the logs of the run-time instances in the solutions for a selected
time period.

To view the logs for all the instances from a specific solution, select the solution in the solutions
drop-down list.

To view the logs for a specific run-time instance in a solution, select the run-time instance in the
run-time instance drop-down list.

By default, the page displays the logs for the last 24 hours. To view the logs for a different time
period, use the time-range selector. For more information about the time-range selector, see
“Monitoring Solutions” on page 767.

You can view logs message statistics and logs details, such as log timestamp and message text.
You can change the type of log details that you see by adding or editing filters as described in the
Kibana documentation.

Database

For optimal performance, you can add aMySQLdatabase to your CloudDeployment subscription.
This enables you to configure, store, and monitor your database directly in the cloud instead of
using external systems. The database endpoint can be shared by multiple solutions deployed by
the tenant.

Creating a Database

To create a database instance in the cloud

1. On the home page in Cloud Deployment, under Database, click Learn more, and then click
Start database setup.

2. On the Database setup details screen, do the following:
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a. In the Database instance identifier field, specify a name for the database.

Important:
Each Software AG Cloud tenant can create only one database instance.

b. In theCreate DB master username andDB master password fields, specify the username
and password that you will use to access the database.

Note:
The master user has full privileges on the database. For more information on database
privileges, see the MySQL documentation.

c. Select Encrypt database if you want to enable the encryption of database data and click
Continue. Note that you cannot change the encryption settings after the database is created.

When the database configuration is complete, you are redirected to the home page of Cloud
Deployment where the Database element shows that the database server is running.

Connecting a Solution to the Database
After you create the database instance in the cloud, you can connect one or more solutions to it.

To connect a solution to the database instance in the cloud

1. Enable thewMJDBCAdapter package for the solution. Formore information, see the Solutions
chapter in Cloud Deployment.

2. In SoftwareAGDesigner, deploy to the cloud the on-premiseswebMethods Integration Server
packages that you want to include in the solution.
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a. In the Package Navigator view, right-click any of the packages that you want to include
and select Deploy to Cloud.

b. In the Publish Assets to Integration Cloud dialog box, select all packages that you want to
include in the solution and click Next.

c. In the webMethods Integration Server Packages Variable Substitution dialog box, do the
following for each of the packages that have JDBC connections:

Enable the State after Deployment property.

In the user, password, and serverName fields, specify the username, password, and
host name of the database instance in the cloud.

Note:
You can see the host name of the database in the DB instance endpoint field on the
Database page in Cloud Deployment.

d. In the Select the Integration Cloud Solution dialog box, select the solution that you want
to connect to the database and click Finish.

Securing the Connection Between a Solution and the Database

To secure the connection between a solution and the database

1. Import the Amazon RDS Root CA certificate as a trusted certificate in a Java keystore. For
more details on the certificate, see the Amazon Relational Database Service documentation.

2. Copy the truststore to the config directory of any of the packages you deploy to the solution.

3. In the web administration interface of the on-premises webMethods Integration Server, go to
Adapters > WebMethods Adapter for JDBC > Connections. In the Other Properties field
of the JDBC adapter connection, specify:

sslMode=VERIFY_IDENTITY;
trustCertificateKeyStoreUrl=file:packages/<package>/config/<truststore>;
trustCertificateKeyStorePassword=<password>

where package is the name of the package that contains the truststore, truststoreis the name of
the keystore that contains the trusted certificate, and password is the password to the truststore.

4. In Software AG Designer, deploy the updated packages to the cloud.

Note:
AmazonRelational Database Service currently does not support authentication that uses a client
certificate.
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Monitoring the Database
After you create the database instance in the cloud, you can monitor its status on the Database
page in Cloud Deployment.

On the Database dashboard of the Database page, you can view the following elements:

DescriptionElement

CPU usage in percentage.DB CPU usage

The allocated storage space and the storage space used by the
database.

DB storage size

Shows if the database server is running. You can start or stop the
server at any time by clicking Start server or Stop server.

DB server status

In the Configuration details section of the Database page, you can view the following fields:

DescriptionField

The size of the database, based on your license offering.DB instance

The name of the database.DB instance identifier

The host and port that you can use to access the database.DB instance endpoint

The list of external IPs that can access the database.Allowed IPs

Software AG recommends using the database only from
applications in Software AG Cloud. By default, you can access
the database only in the cloud. For administrative purposes you
can enable access to the database from external IPs.

To add external IPs, click Edit and type each IP on a new row.
The supported IP format is Classless Inter-Domain Routing
(CIDR) block format, xxx.xxx.xxx.xxx/yy. If you specify only
xxx.xxx.xxx.xxx, mask /32 is automatically added.

Cloud Deployment CLI

The Cloud Deployment CLI performs tasks such as managing a solution, monitoring the status
of all runtimes in a solution, promoting assets from one stage to another, and so on. The CLI
supports the following modes:

Interactive Mode: To start the CLI in interactive mode, run the following command:
wmcc-cli --mode interactive

Normal Mode: To start the CLI in normal mode, run the following command:
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wmcc-cli <commands> [options]

Install Cloud Deployment CLI

Overview

You install the Cloud Deployment CLI (wmcc-cli) using the NPM registry. This section describes
tasks such as installing the Cloud Deployment CLI and specifying credentials to connect to Cloud
Deployment.

Actors

Administrators

Before you begin

Before you install wmcc-cli from the NPM registry, do the following:

Install the NodeJS runtime environment version 10.13 or later on your computer along with
NPM (Node's package manager).

The Cloud Deployment CLI is available for the following operating system environments:

Windows

Linux

macOS

Open a command line interface and type the following command to install wmcc-cli:
npm install -g wmcc-cli

Specify the credentials to connect to Cloud Deployment

To connect to CloudDeployment, youmust configure the credentials in one of the followingways:

Specify the credentials in config.json file.

Create a config.json file under %appdata%/wmcc-cli/ location forWindows or /home/wmcc-
cli/ in Linux.

Add new profiles in the config.json file.

The following is an example of default and referenced profile in the configuration file.
{

"default": {
"url": "https://{subdomain}.webmethodscloud.com",
"userName": "userName",
"password": "password”

},
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"someotherProfile": {
"url": "https://{subdomain}.webmethodscloud.com",
"userName": "userName",
"password": "password”

}
}

Bydefault, the 'default' settings are read from the configuration file. To enable the referenced
profile, run the following command:
wmcc-cli –profile someotherProfile

Specify credentials as runtime arguments.

When you start the CLI, credentials are passed as a runtime argument. For example:
wmcc –-mode interactive –-url <url> –-userName <userName>
--password <password>

Note:
Runtime arguments will have the highest priority. However, If runtime arguments are not
passed, then the default profile from %appdata%/wmcc-cli/config.json is used.

Cloud Deployment CLI Reference
The following table describes the commands you use to perform various scenarios in the CLI
interface.

Commands for viewing alerts in Cloud Deployment

Run the following command to view alerts.
alert list [options]

where the options are:

Description--Name

Filter the alerts that belong to a particular solution.--solutionName <solutionName>

Filter the alerts that belong to a particular stage. Supported
values are development, test, live, prelive.

--stageName <stageName>

Filter the alerts by name .--alertName <alertName>

Filter the alerts by Instances / Node name in a solution.--runtime <runtime>

Filter the alerts based on the severity. Default supported
values are info, warning, and critical.

--severity <severity>

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <view>
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Description--Name

Example:
alert list –-severity critical

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <json>

Example:
alert list –-severity critical –-view json

Note:
JSON output format loads complete information that
contains additional field than the table output format.

Commands for listing the assets in LAR

Run the following command to list all the assets available in the LAR.
asset-repo list-assets <solutionName> <nodeName> <stageName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <view>

Example:
asset-repo list-assets DemoSoln IS development

Commands for creating solutions

Run the following command to create solutions.
solution create [options] <stagename>

where the options are:

Description--Name

Provide the name of the file that contains the input data.--inputFile <fileName>
solution create --inputFile
/home/etc/createSolution.json
<stagename>
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Description--Name

The file must contain a valid solution name, the name of the
webMethods Integration Server and Universal Messaging
instances, number of CPUCores, andMemory characteristics
of the hardware to support each service in the solution.

Example 1 : Creating Type 1 solution without cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Demo",
"description": "Demo Solution",
"solutionType": 1,
"productDefinitions": {
"IS": [{
"name": "IS",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams

.enabled=true",
"packages.WmJDBCAdapter.enabled=true"]

}
}]
}

}
}
}

Example 2: Creating Type 1 solution with stateful cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Demo",
"description": "Demo Solution",
"solutionType": 1,
"productDefinitions": {
"IS": [{
"name": "IS",
"replicaCount": "2",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"dependencies": ["DB","tc"],
"clusterType": "stateful",
"isClustered": true,
"statefulCluster": true,
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Description--Name
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.enabled=true"]
}
}],
"TERRACOTTA": [{

"name": "tc",
"isClustered": true,
"statefulCluster": false,
"replicaCount": "2",
"enabled": true,
"resources": {
"limits": {
"cpu": "1",
"memory": "4"

}
},
"version": "10.4",
"env": {
"packages": [],
"monitoringTools": []
}
}]
}
}

}
}

Example 3: Creating Type 1 solution with stateless cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Demo",
"description": "Demo Solution",
"solutionType": 1,
"productDefinitions": {
"IS": [{
"name": "IS",
"replicaCount": "2",
"dependencies": ["DB"],
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"clusterType": "stateless",
"isClustered": true,
"statefulCluster": false,
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.enabled=true"]
}
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Description--Name
}]
}

}
}
}

Example 4: Creating Type 2 solution without cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Solution2",
"description": "sample solution",
"solutionType": 2,
"productDefinitions": {
"IS": [{
"name": "IS",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams

.enabled=true",
"packages.WmJDBCAdapter.enabled=true"]

}
}],
"UNIVERSALMESSAGING": [{
"name": "UM",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4"

}]
}

}
}
}

Example 5: Creating Type 2 solution with stateful cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Solution2",
"description": "sample solution",
"solutionType": 2,
"productDefinitions": {
"IS": [{
"name": "IS",
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Description--Name
"clusterType": "stateful",
"replicaCount": "2",
"isClustered": true,
"statefulCluster": true,
"dependencies": ["DB", "UM", "tc"],
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.enabled=true"]
}
}],
"UNIVERSALMESSAGING": [{
"name": "UM",
"clusterType": null,
"isClustered": false,
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4"
}],
"TERRACOTTA": [{

"name": "tc",
"isClustered": true,
"resources": {
"limits": {
"cpu": "1",
"memory": "4"

}
},
"version": "10.4",
"env": {
"packages": [],
"monitoringTools": []
}
}]
}
}

}
}

Example 6: Creating Type 2 solution with stateless cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Solution2",
"description": "sample solution",
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Description--Name
"solutionType": 2,
"productDefinitions": {
"IS": [{
"name": "IS",
"replicaCount": "2",
"clusterType": "stateless",
"dependencies": ["DB","UM"],
"isClustered": true,
"statefulCluster": false,
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.enabled=true"]
}

}],
"UNIVERSALMESSAGING": [{
"name": "UM",
"clusterType": null,
"isClustered": false,
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4"

}]
}

}
}
}

Example 7: Creating Type 3 solution without cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Solution3",
"description": "Sample Solution",
"solutionType": 3,
"productDefinitions": {
"IS": [{
"name": "IS1",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
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Description--Name
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.
enabled=true"]

}
}, {
"name": "IS2",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages":

["packages.WmCloudStreams.enabled=true",
"packages.WmJDBCAdapter.enabled=true"]

}
}],
"UNIVERSALMESSAGING": [{
"name": "UM",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4"
}]
}
}

}
}

Example 8: Creating Type 3 solution with stateful cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Solution3",
"description": "Sample Solution",
"solutionType": 3,
"productDefinitions": {
"IS": [{
"name": "IS1",
"isClustered": true,
"replicaCount": "2",
"statefulCluster": true,
"dependencies": ["UM", "DB", "tc1"],
"clusterType": "stateful",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
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Description--Name
},
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.enabled=true"]
}

}, {
"name": "IS2",
"isClustered": true,
"statefulCluster": true,
"replicaCount": "2",
"dependencies": ["UM", "DB", "tc2"],
"clusterType": "stateful",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages": ["packages.WmCloudStreams.

enabled=true", "packages.WmJDBCAdapter.enabled=true"]
}

}],
"UNIVERSALMESSAGING": [{
"name": "UM",
"isClustered": false,
"statefulCluster": false,
"clusterType": null,
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4"

}],
"TERRACOTTA": [{
"name": "tc1",
"isClustered": true,
"resources": {
"limits": {
"cpu": "1",
"memory": "4"

}
},
"version": "10.4",
"env": {
"packages": [],
"monitoringTools": []
}

}, {
"name": "tc2",
"isClustered": true,
"resources": {
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Description--Name
"limits": {
"cpu": "1",
"memory": "4"

}
},
"version": "10.4",
"env": {
"packages": [],
"monitoringTools": []
}
}]
}
}

}
}

Example 9: Creating Type 3 solution with stateless cluster.
{
"integration": {
"landscapeDefinition": {
"solutionName": "Solution3",
"description": "Sample Solution",
"solutionType": 3,
"productDefinitions": {
"IS": [{
"name": "IS1",
"isClustered": true,
"replicaCount": "2",
"statefulCluster": false,
"dependencies": ["UM", "DB"],
"clusterType": "stateless",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4",
"env": {
"packages":

["packages.WmCloudStreams.enabled=true",
"packages.WmJDBCAdapter.enabled=true"]

}
}, {
"name": "IS2",
"isClustered": true,
"statefulCluster": false,
"replicaCount": "2",
"dependencies": ["UM", "DB"],
"clusterType": "stateless",
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
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Description--Name
},
"version": "10.4",
"env": {
"packages":

["packages.WmCloudStreams.enabled=true",
"packages.WmJDBCAdapter.enabled=true"]

}
}],
"UNIVERSALMESSAGING": [{
"name": "UM",
"isClustered": false,
"statefulCluster": false,
"clusterType": null,
"resources": {
"limits": {
"cpu": "1",
"memory": "2"

}
},
"version": "10.4"

}]

}
}
}
}

Commands for listing the solutions for a particular stage

Run the following command to list solutions for a particular stage.
solution list <stageName> [options]

where the valid stage name value includes development, test, prelive, and live.

Example:
solution list development --view json

Commands for getting the solution and runtimes for a particular stage

Run the following command to get the solution and all runtimes for a particular stage.
solution get <solutionName> <stageName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>
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Description--Name

Example:
solution get DemoSoln development

Commands for deleting the solution for a particular stage

Run the following command to delete the solution for a particular stage.
solution delete <solutionName> <stageName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
solution delete DemoSoln development

Commands for activating or deactivating the solution for a particular stage

Run the following command to activate and deactivate a solution for a particular stage.
solution update-status <solutionName> <stageName> <actionName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
solution update-stats DemoSoln development
deactivate

Allowed stage names are development, test, live,
prelive.

Allowed action names are activate or deactivate

Commands for getting the status of all pods in a solution

Run the following command to get the status of all pods in a solution.
solution get-status <solutionName> <stageName> [options]
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where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
solution get-status DemoSoln development

Commands for getting the license information for a particular tenant

Run the following command to get the license information for a particular tenant.
tenant get-license-info [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
tenant get-license-info

Commands for getting the total CPU and memory utilization details for a particular
tenant

Run the following command to get the total CPU and memory utilization details for a particular
tenant.
tenant get-utilization-details [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
tenant get-license-info

Commands for listing all the users

Run the following command to list all the users.

798 Integration Cloud 6.6.0

20 Switch to Cloud Deployment



user list [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
tenant get-license-info

Commands to get a particular user

Run the following command to get the user information.
user get <userId> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

--view <viewType>

Example:
user get <ID details>

Commands for promoting Integration Server and Universal Messaging configurations
from one stage to another

Run the following command to promote Integration Server andUniversalMessaging configurations
from one stage to another.
runtime promote-configuration <fromSolutionName> <fromNodeName>
<fromStageName> [toSolutioName] [toNodeName] [options]

Note:
If toSolutionName and toNodeName are provided as part of your command, then the CLI
performs the cross solution promotion. However, if toSolutionName and toNodeName are not
available, then the configurationwill be promoted to higher stage on the sameIntegration Server
or Universal Messaging node.

where the options are:

Description--Name

Properties file to perform variable substitution.--propFile <fileName>
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Description--Name

Example:Use the following command for promotion across
same instance:
runtime promote-configuration DemoSoln IS
development

Example: Use the following command for cross solution
promotion:
runtime promote-configuration DemoSoln IS
development
DemoSoln1 IS1

Promotes the configuration from the solution DemoSoln
IS node to DemoSoln1 and IS1 node.

Commands for promoting Integration Server packages from one stage to another

Run the following command to promote Integration Server packages from one stage to another.
runtime promote-packages <fromSolutionName> <fromNodeName> <fromStageName>
[toSolutioName] [toNodeName] [options]

Note:
If toSolutionName and toNodeName are provided then the CLI performs the cross solution
promotion. If toSolutionName and toNodeName are not available, then the packages will be
promoted to higher stage on the same Integration Server instance.

where the options are:

Description--Name

Promotes only specified packages.--include <comma separatedpackages
names>

Example:
--include package1,package2,package3

Promotes all the packages other than the packages specified
in the options.

--exclude <commaseparatedpackages
names>

Example:
--exclude package1,package2,package3

Provide properties file to perform variable substitution.--propFile <fileName>

Examples:

Use the following command for promotion across same
instance:
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Description--Name
runtime promote-packages DemoSoln IS development
-- propFile /home/etc/var_sub.properties

Use the following command for cross solution promotion:
runtime promote-packages DemoSoln IS development
TestSoln IS2

Use the following command to replace a property in a
specific composite asset.
<propertyName>/<compositeAssetName>

Note:
The replacement properties should be in the following
format:

<propertyName>/<compositeAssetName>/<assetName>

Example for replacing properties of a package:

activatePkgOnInstall/TestODataService=false

where TestODataService is the package name whose
property activatePkgOnInstall" is assigned with value
"false".

Example for replacing properties of a service of a
package:

serverName/TestODataService/JDBC_Connection
.ODataService=localhost

where JDBC_Connection.ODataService is a service under
package TestODataService, whose parameter serverName
is assigned with value localhost

Commands for printing the list of exposed services

Run the following command to print the list of exposed services.
runtime get-exposed-is-serices <solutionName> <nodeName> <stageName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
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Description--Name
runtime get-exposed-is-services DemoSoln IS
development

Commands for listing all the queues

Run the following command to list all the queues in the Universal Messaging instance.
um list-queues <solutionName> <nodeName> <stageName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
um list-queues DemoSoln UM development

Commands for getting the queue information

Run the following command to retrieve pushed, popped, and memory usage of the queue.
um get-queue <solutionName> <nodeName> <stageName> <queueName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
um get-queue DemoSoln UM development dummyQueue

Commands for getting the queue details

Run the following command to retrieve the queue details.
um get-queue-details <solutionName> <nodeName> <stageName> <queueName> [options]

where the options are:
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Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
um get-queue-details DemoSoln UM development
dummyQueue

Commands for listing all the channels in the Universal Messaging instance

Run the following command to list all the channels in a Universal Messaging instance.
um list-channels <solutionName> <nodeName> <stageName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
um list-channels DemoSoln UM development

Commands for getting the channel information

Run the following command to get the channel information.
um get-channel <solutionName> <nodeName> <stageName> <channelName> [options]

where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
um get-channel DemoSoln UM development dummyChannel

Commands for getting the channel details

Run the following command to get the channel details.
um get-channel-details <solutionName> <nodeName> <stageName> <channelName>
[options]
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where the options are:

Description--Name

By default, outputs the response in a table viewmode. The
CLI supports both table and JSON output format.

-view <viewType>

Example:
um get-channel-details DemoSoln UM development
dummyChannel
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